# Table Of Contents

Table Of Contents ........................................................................................................................... 2
Cobalt Help System 8.1 ................................................................................................................ 33
COBALT HELP SYSTEM ........................................................................................................... 34
   This Manual - Using the Help system ...................................................................................... 35
      Help System - Change Language .......................................................................................... 36
      Help - Search Function ......................................................................................................... 36
      Help System - Favourites ...................................................................................................... 37
      Help System - Console Keys ................................................................................................ 37
      Help Companion over WIFI ................................................................................................. 38
News In This Version ................................................................................................................... 39
   News in Cobalt 8.2 ................................................................................................................ 39
   News in Cobalt 8.1 ................................................................................................................ 39
   News in Cobalt 8.0 ................................................................................................................ 39
   News in Cobalt 7.3 ................................................................................................................ 40
   News in Cobalt 7.2 ................................................................................................................ 40
   News in Cobalt 7.1 ................................................................................................................ 40
   Coming to Cobalt from Congo ................................................................................................. 42
   This Manual - Terminology ...................................................................................................... 43
Disclaimer ..................................................................................................................................... 44
GETTING STARTED .................................................................................................................. 45
General Info .................................................................................................................................. 46
   Interface Specification ............................................................................................................ 46
Setup Guide ............................................................................................................................... 48
Installation guidelines ............................................................................................................... 50
Key Syntaxes ............................................................................................................................. 51
Cobalt Terminology ................................................................................................................... 52
Control Hierarchy ..................................................................................................................... 54
   Playbacks - Introduction ....................................................................................................... 54
   Control Hierarchy - Master Playbacks .................................................................................. 55
   Control Hierarchy - Main Playback ...................................................................................... 55
   Control Hierarchy - Highest Takes Precedence .................................................................... 55
Software & Update ..................................................................................................................... 56
<table>
<thead>
<tr>
<th>Tab - Console Mimic</th>
<th>83</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab - Designer Summary</td>
<td>84</td>
</tr>
<tr>
<td>Tab - Selected Live</td>
<td>86</td>
</tr>
<tr>
<td>Tab - Master View</td>
<td>87</td>
</tr>
<tr>
<td>Tab - Time Code</td>
<td>88</td>
</tr>
<tr>
<td>Tab - Device Controls Tab</td>
<td>89</td>
</tr>
<tr>
<td>Parameters tabs: All, Focus, Color, Beam, U1, U2, U3</td>
<td>90</td>
</tr>
<tr>
<td>Virtual controls tabs: ColorMixer and GelPicker</td>
<td>90</td>
</tr>
<tr>
<td>Tab - Direct Selects (DS)</td>
<td>93</td>
</tr>
<tr>
<td>Cobalt Direct Selects - Types of Data</td>
<td>94</td>
</tr>
<tr>
<td>Cobalt Direct Selects - Special Functions</td>
<td>96</td>
</tr>
<tr>
<td>Cobalt Direct Selects - Bank and Page</td>
<td>97</td>
</tr>
<tr>
<td>Cobalt Direct Selects - Arrange, Copy/Move/Delete/Text</td>
<td>97</td>
</tr>
<tr>
<td>Cobalt Direct Selects - Add/Replace</td>
<td>98</td>
</tr>
<tr>
<td>Cobalt Direct Selects - Console Keys in Combination</td>
<td>98</td>
</tr>
<tr>
<td>Cobalt Direct Selects - Direct Mode</td>
<td>98</td>
</tr>
<tr>
<td>Tab - Beat Boss</td>
<td>100</td>
</tr>
<tr>
<td>Beat Boss List</td>
<td>101</td>
</tr>
<tr>
<td>Tab - Help</td>
<td>102</td>
</tr>
<tr>
<td>Tab - Direct Selects Flow (8.1)</td>
<td>103</td>
</tr>
<tr>
<td>Tab - Color Picker (8.2)</td>
<td>104</td>
</tr>
<tr>
<td>Color Picker - Color spaces (8.2)</td>
<td>104</td>
</tr>
<tr>
<td>Color Picker - Controls (8.2)</td>
<td>105</td>
</tr>
<tr>
<td>Color Picker - Gel Picker (8.2)</td>
<td>107</td>
</tr>
<tr>
<td>Color Picker - Spectrum Tools (8.2)</td>
<td>107</td>
</tr>
<tr>
<td>Color Picker - Tinting Tools (8.2)</td>
<td>109</td>
</tr>
<tr>
<td>Editors And Lists</td>
<td>110</td>
</tr>
<tr>
<td>Navigating In Lists</td>
<td>111</td>
</tr>
<tr>
<td>Editing In Lists</td>
<td>111</td>
</tr>
<tr>
<td>Sort By Column</td>
<td>112</td>
</tr>
<tr>
<td>Change The List View</td>
<td>112</td>
</tr>
<tr>
<td>Drag and Drop</td>
<td>113</td>
</tr>
<tr>
<td>Drag and Drop - Replacing Data</td>
<td>117</td>
</tr>
<tr>
<td>Context Menus</td>
<td>119</td>
</tr>
<tr>
<td>Dialogues</td>
<td>121</td>
</tr>
<tr>
<td>Power-up Procedure</td>
<td>122</td>
</tr>
<tr>
<td>Reset The System</td>
<td>123</td>
</tr>
<tr>
<td>Reset The Console Facepanel</td>
<td>123</td>
</tr>
<tr>
<td>Check The Output</td>
<td>124</td>
</tr>
</tbody>
</table>
Output Control ........................................................................................................................ 125

Grand Master ........................................................................................................................ 125
B.O. Mode............................................................................................................................. 126
Freeze Mode.......................................................................................................................... 126

Copy, Cut & Paste .................................................................................................................. 127
Copy, Cut & Paste Attributes ............................................................................................... 127

Entering Texts ........................................................................................................................ 128
The TEXT Key ..................................................................................................................... 128

Mute & Solo........................................................................................................................... 129
Mute & Solo - MUTE .......................................................................................................... 129
Mute & Solo - SOLO .......................................................................................................... 130

Lock Console ..................................................................................................................... 132
Misc Soft Key Page ............................................................................................................ 133
Cleaning the Cobalt Console ............................................................................................ 135
S1-S3 Soft Key Pages (8.1) ................................................................................................. 136

About ..................................................................................................................................... 137
About - Cobalt .................................................................................................................... 138
About - Play ....................................................................................................................... 140

Dimmer/Device Feedback Log ............................................................................................ 141
Sensor3 & Sensor+ Dimmer Feedback ............................................................................... 142

Files ....................................................................................................................................... 143
Files - Introduction ............................................................................................................. 144
Files in a network named Saved year-mm-dd (8.1) ............................................................ 145

New ...................................................................................................................................... 146
Open ..................................................................................................................................... 151
Save & Save as...................................................................................................................... 152
Creating Subfolders For Files ............................................................................................. 154
Delete a Play ......................................................................................................................... 154

Save Copy to......................................................................................................................... 155
Import from........................................................................................................................... 156
Import Organizer - Functions ............................................................................................ 156
Import - Types of items to import ...................................................................................... 158
Import Items With Dependencies ....................................................................................... 159
Import From Other Lighting Control Systems ................................................................. 160

Export to Expert diskette ................................................................................................. 164
Default Play wizard .......................................................................................................... 165
Print ..................................................................................................................................... 166
Training Projects..................................................................................................................... 168
  Training Projects - Open Project (8.0)................................................................................ 168
  Training Projects - The Camera (8.0).................................................................................. 169
  Training Projects - Hints (8.0) ............................................................................................ 169
  Training Projects - Demo Theatre (8.0) .............................................................................. 170
  Training Projects - Demo Concert (8.0) ............................................................................. 170
Copy Log files to USB............................................................................................................ 176
Exit to System Settings ........................................................................................................... 177
System Settings - General (8.0) .......................................................................................... 178
System Settings - Sessions (8.0) .......................................................................................... 180
System Settings - Network (8.0) .......................................................................................... 181
  Network - Console .............................................................................................................. 184
  System Settings - Output Protocols .................................................................................. 185
  Network - Interface Protocols ............................................................................................ 186
  Network - DCHP Service .................................................................................................... 187
  Network - Update Service .................................................................................................. 188
  Network - Time Service ...................................................................................................... 188
  Network - DMX Input ........................................................................................................ 189
System Settings - Monitor ...................................................................................................... 190
System Settings - Update ........................................................................................................ 192
  Update Software................................................................................................................... 193
System Settings - USB RFR ................................................................................................... 194
System Settings - Utilities....................................................................................................... 195
  File Manager Utilities ......................................................................................................... 196
  Verify Hard Disk Utilities .................................................................................................... 197
  Facepanel Test Utilities ....................................................................................................... 197
  Network Configuration Applications (GCE, NCE, Concert etc) ........................................ 198
  Backup and Restore System Settings ................................................................................ 199
  Backup and Restore User Template Library ....................................................................... 199
  Deep Clear Utilities ............................................................................................................. 199
Exit to Welcome Screen (8.0).................................................................................................. 200
Power Off (Quit) ..................................................................................................................... 202
  Power Loss .......................................................................................................................... 202
General Settings .................................................................................................................... 203
Play Settings.......................................................................................................................... 204
  Play Settings - Introduction ................................................................................................. 205
  Play Settings - Basic ............................................................................................................ 206
  Play Settings - Channels ..................................................................................................... 207
    Channel Settings ................................................................................................................. 208
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Play Settings - Main Playback</td>
<td>209</td>
</tr>
<tr>
<td>Crossfade Settings</td>
<td>209</td>
</tr>
<tr>
<td>Play Settings - Masters</td>
<td>212</td>
</tr>
<tr>
<td>Master Settings</td>
<td>212</td>
</tr>
<tr>
<td>Play Settings - System</td>
<td>213</td>
</tr>
<tr>
<td>System Settings</td>
<td>213</td>
</tr>
<tr>
<td>Play Settings - Attribute</td>
<td>215</td>
</tr>
<tr>
<td>Attribute Settings</td>
<td>216</td>
</tr>
<tr>
<td>Play Settings - MIDI</td>
<td>218</td>
</tr>
<tr>
<td>Direct Mode MIDI</td>
<td>220</td>
</tr>
<tr>
<td>Play Settings - Show Control</td>
<td>222</td>
</tr>
<tr>
<td>Show Control Settings</td>
<td>222</td>
</tr>
<tr>
<td>Console Settings</td>
<td>224</td>
</tr>
<tr>
<td>Sound Settings</td>
<td>227</td>
</tr>
<tr>
<td>DMX Settings</td>
<td>228</td>
</tr>
<tr>
<td>Network (8.0)</td>
<td>229</td>
</tr>
<tr>
<td>Network - Introduction (8.0)</td>
<td>230</td>
</tr>
<tr>
<td>Network - Functions</td>
<td>232</td>
</tr>
<tr>
<td>Network - Server/Backup (8.0)</td>
<td>233</td>
</tr>
<tr>
<td>Network - Server takeover, loss and return (8.0)</td>
<td>234</td>
</tr>
<tr>
<td>Network - Multiconsole Sessions (8.0)</td>
<td>235</td>
</tr>
<tr>
<td>Multiconsole Sessions - Global Functions (8.0)</td>
<td>235</td>
</tr>
<tr>
<td>Multiconsole Sessions - Local Functions (8.0)</td>
<td>236</td>
</tr>
<tr>
<td>Multiconsole Sessions - Patching, Users and Partitions (8.0)</td>
<td>236</td>
</tr>
<tr>
<td>Multiconsole Sessions - Status (8.0)</td>
<td>237</td>
</tr>
<tr>
<td>Multiconsole Sessions - Start and Join a Session (8.0)</td>
<td>237</td>
</tr>
<tr>
<td>Multiconsole Session - Leave or Shut Down (8.0)</td>
<td>238</td>
</tr>
<tr>
<td>Network nodes</td>
<td>239</td>
</tr>
<tr>
<td>Net3/ACN Device List</td>
<td>240</td>
</tr>
<tr>
<td>Screens (8.0)</td>
<td>241</td>
</tr>
<tr>
<td>Record Screens (8.0)</td>
<td>243</td>
</tr>
<tr>
<td>Load screen</td>
<td>245</td>
</tr>
<tr>
<td>Delete or Rename Screens - Screens List (8.0)</td>
<td>247</td>
</tr>
<tr>
<td>User List</td>
<td>249</td>
</tr>
<tr>
<td>User List - Columns</td>
<td>249</td>
</tr>
</tbody>
</table>
Create a User Login ............................................................................................................ 250
Change User ............................................................................................................................ 251
Event List .................................................................................................................................... 252
Event List - Introduction ......................................................................................................... 253
Event List - Action Macros ..................................................................................................... 254
  Action Macro Rules ............................................................................................................ 254
  Cobalt Action Macros (8.2) ................................................................................................. 254
  Serial COM data ................................................................................................................. 256
  MIDI Data ............................................................................................................................ 257
  UDP data ............................................................................................................................. 257
Event List - Events .................................................................................................................. 259
  Triggers for Events ............................................................................................................. 260
Macro List ................................................................................................................................... 261
  Macros - Record & Playback .............................................................................................. 262
Action Macro List ................................................................................................................... 263
Patching ....................................................................................................................................... 264
Patch - Introduction ................................................................................................................ 265
  Flexible Patching (7.1) ...................................................................................................... 265
Patch by Channel/Dimmer ...................................................................................................... 266
  Output Editor - Formats .................................................................................................... 267
  Output Editor - Patch By Channel ..................................................................................... 270
  Output Editor - Patch By Dimmer ...................................................................................... 271
  Output Editor - Dimmer Check Mode ............................................................................... 273
  Output Editor - Channel Check Mode ............................................................................... 273
Import Template Wizard ......................................................................................................... 274
  User Library ....................................................................................................................... 276
Patch Wizard ........................................................................................................................... 277
  Patch Dimmer(s) .............................................................................................................. 277
  Patch Device(s) ................................................................................................................. 278
  Set/Clear patch or rename ............................................................................................... 279
  Clone Device(s) in Patch (8.0) ......................................................................................... 280
Device List .................................................................................................................................. 283
  Device Settings - Columns & Functions .......................................................................... 284
  Device Settings - Patching ................................................................................................. 285
  Edit/Change a Device ....................................................................................................... 286
>Settings and Tools - Patching ............................................................................................... 287
Opening Focused Organizer Tabs ................................................................. 324
Execute from the Organizer ................................................................. 325
Drag and Drop in the Organizer ................................................................. 325
Organizer (2 tabs) ...................................................................................... 328
Groups .............................................................................................................. 329
Group functionality ........................................................................................ 330
Record a Group........................................................................................... 331
Groups - Record ......................................................................................... 332
900-groups ................................................................................................. 332
Groups - Select Channels ........................................................................... 333
Groups - Select Channels Context Menu ................................................... 333
Groups - Fetch Intensities .......................................................................... 335
Groups - List ................................................................................................ 336
Group List - Columns & Functions ............................................................. 337
Groups - Load To Playbacks ........................................................................ 338
Presets .......................................................................................................... 339
Presets - Introduction .................................................................................. 340
Record a Preset Live ................................................................................... 341
Presets - Record .......................................................................................... 342
The Recording Popup ................................................................................ 342
Record Presets - Live Tab .......................................................................... 346
Record Presets - Field A Only .................................................................... 346
Record Preset - Do not add to Sequence .................................................... 346
Record All Attributes for selected channels ............................................... 347
Record Directly To A Master ...................................................................... 348
Record Selected Channels To Any Preset .................................................. 348
Setting a Master as the General Record Target ......................................... 349
Presets - Update ......................................................................................... 351
Presets - List ............................................................................................... 352
Preset List Channel View .......................................................................... 353
Preset List - Columns ................................................................................ 354
Preset List - Functions ............................................................................... 355
Presets - Load To Playbacks ...................................................................... 356
Quick-load Presets to Masters ................................................................. 356
Presets - Copy ............................................................................................ 357
Presets - Select Channels ........................................................................................................ 358
Presets - Select Channels Context Menu ............................................................................. 358
Presets - Fetch Intensities .................................................................................................... 359
Presets - Channel Editor Wizard .......................................................................................... 360
    Channel Editor Wizard - Type Of Change ..................................................................... 361
    Channel Editor Wizard - Value ...................................................................................... 362
    Channel Editor Wizard - Include If 0% .......................................................................... 362
Presets - Auto-Save ............................................................................................................. 363
Presets - Times ..................................................................................................................... 364
Presets - Compare Mode ..................................................................................................... 365
Presets - Delete ................................................................................................................... 366
Presets - Renumber ............................................................................................................. 367
Presets - Import & Undo ...................................................................................................... 369
    Presets - Multiple Import & Undo ................................................................................. 370
Sequences ............................................................................................................................ 373
    Sequences - Introduction ............................................................................................... 374
        Record a Sequence Live .......................................................................................... 375
    Sequences - In The Main Playback ............................................................................... 376
    Sequences - List .............................................................................................................. 377
        Sequences List - Insert/Delete/Load ......................................................................... 377
        Sequences List - Columns ......................................................................................... 378
    Sequences - Sequence List ............................................................................................. 379
        Sequence List Channel View .................................................................................. 380
        Sequence List Functions .......................................................................................... 381
        Sequence List - Columns ......................................................................................... 382
        Sequence and Preset texts ...................................................................................... 384
    Sequences - Crossfade Movefade & Lockfade ................................................................ 385
    Sequences - Times ........................................................................................................... 387
        Sequence Times - Set To A or B ................................................................................ 387
        Sequence Times - Main Times (in/out/delay/wait) .................................................... 388
        Sequence Times - Channel Times ............................................................................. 389
        Sequence - Channel Time Editor ............................................................................. 390
        The Time Editor Popup ............................................................................................. 391
        The Times Soft Key Page ......................................................................................... 394
        Sequence Times - FCB Times ................................................................................... 395
        Sequence Times - Parameter Times .......................................................................... 395
        Sequence Times - WAF Alert Times .......................................................................... 395
        Sequence Times - WAF Wait & Followon Times ....................................................... 395
    Sequences - Crossfade Profiles ..................................................................................... 397
Sequences - Insert Step........................................................................................................... 398
  Insert A Sequence Step - In any playback ........................................................................... 398
  Insert A Sequence Step Directly In The Main Playback .................................................... 398
  Insert A Sequence Step - In The List .................................................................................. 398
Sequences - Delete Step.......................................................................................................... 400
  Delete a sequence step directly in the main playback......................................................... 400
Sequences - Links.................................................................................................................... 401
  Sequence Step Links - Master Playbacks ........................................................................... 401
  Sequence Step Links - Shortcut .......................................................................................... 402
  Sequence Step Links - Master Pages .................................................................................. 402
  Sequence Step Links - Another Step................................................................................... 402
Sequences - Load.................................................................................................................... 404
Sequences - Build & Modify Modes ...................................................................................... 405
  Sequence - Build Sequence Mode ...................................................................................... 405
  Sequence - Modify Sequence Mode ................................................................................... 406
Sequences - Block Values....................................................................................................... 407
Sequences - Track List............................................................................................................ 409
Sequences - Chase Mode....................................................................................................... 410
  Chase - Introduction ........................................................................................................... 411
  Chase - Playback View ....................................................................................................... 412
  Chase - Playback Modes .................................................................................................... 413
  Chase - Set Rate .................................................................................................................. 414
  Chase - BPM & Tap Tempo ............................................................................................... 415
    Set BPM Numerically ....................................................................................................... 415
    Set BPM using Tap Tempo ............................................................................................. 415
  Chase - Wizard................................................................................................................... 416
    Chase Wizard - Functions ............................................................................................... 418
Sequences - Split Fade ........................................................................................................... 419
Sequences - Drag And Drop ............................................................................................... 420
  Drag and Drop a Sequence Step ....................................................................................... 420
  Drag and Drop Device Attributes ..................................................................................... 423
Sequences - Section Markers................................................................................................. 426
  Jump Between Section Markers......................................................................................... 429
Sequences - Cues .................................................................................................................... 430
  Cue Sequence Attribute Editor ......................................................................................... 434
Sequences - Loop Mode ......................................................................................................... 435
Channels - Check Mode.......................................................................................................... 475
Channels - Balance Mode .................................................................................................... 476
  Balance Mode Key............................................................................................................ 477
Channels - Scale channel levels.......................................................................................... 478
  Clear Scale Values .......................................................................................................... 480
Channels - Used & Unused.................................................................................................. 481
Channels - Group Wheel Mode ........................................................................................... 482
Channels - Rem Dim .......................................................................................................... 484
Channels - Soft key page ................................................................................................... 485
Channels - Next & Last Mode ............................................................................................. 487
Channels - Select Functions (8.2) ..................................................................................... 489
  Select - Sub-selection Functions ....................................................................................... 490
  Channels - Random Select ................................................................................................. 491
Channels - Find Highest Level ............................................................................................ 492
Live ............................................................................................................................................. 493
  Live - Introduction .............................................................................................................. 494
    Select the Live Tab ......................................................................................................... 494
    Selecting channels with mouse ...................................................................................... 495
    Channel viewing formats ............................................................................................... 496
    Channel View Zoom ...................................................................................................... 497
    Channel Information - Info Box ..................................................................................... 498
    Multiple Live Tabs ........................................................................................................ 498
Editing in Live ........................................................................................................................ 500
  Record in Live .................................................................................................................. 501
Channel Symbols .................................................................................................................... 502
  Channel Information - Important Level Modes ............................................................... 504
  Channel Information - Fade indications .......................................................................... 505
Blind ............................................................................................................................................ 506
  Blind - Introduction .......................................................................................................... 507
    Select the Blind Tab ........................................................................................................ 507
    Editing In Blind ............................................................................................................... 509
      Record and copy in Blind ............................................................................................. 509
Track List .................................................................................................................................. 511
  Track - Introduction ......................................................................................................... 512
  Track - Lists ..................................................................................................................... 514
    Track List - Functions .................................................................................................... 515
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Track List - Show Levels &amp; Attributes</td>
<td>516</td>
</tr>
<tr>
<td>Track - Channels</td>
<td>517</td>
</tr>
<tr>
<td>Track Channels - In Sequences</td>
<td>517</td>
</tr>
<tr>
<td>Track To Wizard</td>
<td>518</td>
</tr>
<tr>
<td>Track Channels - In Presets</td>
<td>518</td>
</tr>
<tr>
<td>Track Channels - Groups</td>
<td>518</td>
</tr>
<tr>
<td>Track Channels - Palettes</td>
<td>519</td>
</tr>
<tr>
<td>Track Channels - In The Play</td>
<td>520</td>
</tr>
<tr>
<td>Track - Presets</td>
<td>521</td>
</tr>
<tr>
<td>Track - Palettes</td>
<td>524</td>
</tr>
<tr>
<td>Track - Track Editing</td>
<td>525</td>
</tr>
<tr>
<td>Track Editing - Intensities</td>
<td>525</td>
</tr>
<tr>
<td>Track Editing - Update Attributes</td>
<td>526</td>
</tr>
<tr>
<td>Track Editing - Unblock Attributes</td>
<td>527</td>
</tr>
<tr>
<td>Parked</td>
<td>528</td>
</tr>
<tr>
<td>Park - Introduction</td>
<td>529</td>
</tr>
<tr>
<td>Park - Parking values</td>
<td>530</td>
</tr>
<tr>
<td>Park - Edit Parked Values</td>
<td>532</td>
</tr>
<tr>
<td>Park - Un-parking Values</td>
<td>533</td>
</tr>
<tr>
<td>Park - Parked Items List</td>
<td>535</td>
</tr>
<tr>
<td>&gt;Settings and Tools - Channels</td>
<td>536</td>
</tr>
<tr>
<td>Channel Database</td>
<td>537</td>
</tr>
<tr>
<td>Set Channel Texts For The Database</td>
<td>537</td>
</tr>
<tr>
<td>Auto Groups - From Database and Templates</td>
<td>540</td>
</tr>
<tr>
<td>Channel Database - Import Text File Wizard</td>
<td>540</td>
</tr>
<tr>
<td>Import Text File - LightWright</td>
<td>541</td>
</tr>
<tr>
<td>Import Text File - Excel</td>
<td>542</td>
</tr>
<tr>
<td>Magic Sheets (8.0)</td>
<td>544</td>
</tr>
<tr>
<td>Magic Sheets - Introduction (8.0)</td>
<td>545</td>
</tr>
<tr>
<td>Magic Sheets - Create New (8.0)</td>
<td>548</td>
</tr>
<tr>
<td>Magic Sheets - Editor (8.0)</td>
<td>549</td>
</tr>
<tr>
<td>Magic Sheets Editor - Object Editing (8.0)</td>
<td>550</td>
</tr>
<tr>
<td>Magic Sheets Editor - Object Colors (8.0)</td>
<td>551</td>
</tr>
<tr>
<td>Magic Sheets Editor - Object Target (8.0)</td>
<td>552</td>
</tr>
<tr>
<td>Magic Sheets Editor - Array, Align &amp; Distribute Objects (8.0)</td>
<td>555</td>
</tr>
<tr>
<td>Magic Sheets Editor - Texts (8.0)</td>
<td>556</td>
</tr>
<tr>
<td>Magic Sheets - Layout Toolbar (8.0)</td>
<td>557</td>
</tr>
<tr>
<td>Magic Sheet - Arrow Tools for Edit Mode (8.0)</td>
<td>557</td>
</tr>
<tr>
<td>Magic Sheet - The Zoom Tools (8.0)</td>
<td>558</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>---------</td>
<td>------</td>
</tr>
<tr>
<td>Device Control - Align</td>
<td>595</td>
</tr>
<tr>
<td>Device Control - Fan</td>
<td>596</td>
</tr>
<tr>
<td>Fan Settings</td>
<td>597</td>
</tr>
<tr>
<td>Device Control - Fetch/Copy</td>
<td>598</td>
</tr>
<tr>
<td>Device Control - Highlight Mode</td>
<td>599</td>
</tr>
<tr>
<td>Device Control - Flip</td>
<td>600</td>
</tr>
<tr>
<td>Device Control - Device Control Tab</td>
<td>601</td>
</tr>
<tr>
<td>Device Control - Select Changed</td>
<td>602</td>
</tr>
<tr>
<td>Device Control - Device Mode</td>
<td>603</td>
</tr>
<tr>
<td>Device Mode Settings and Device Mode Page List</td>
<td>604</td>
</tr>
<tr>
<td>Device Views</td>
<td>606</td>
</tr>
<tr>
<td>Device Views - Introduction</td>
<td>607</td>
</tr>
<tr>
<td>Device Views - Live</td>
<td>608</td>
</tr>
<tr>
<td>Device Views - Filtering</td>
<td>610</td>
</tr>
<tr>
<td>Device Views - Editing</td>
<td>611</td>
</tr>
<tr>
<td>Device Views - Presets</td>
<td>613</td>
</tr>
<tr>
<td>Preset Attribute Editor - Columns</td>
<td>614</td>
</tr>
<tr>
<td>Preset Attribute Editor - Times</td>
<td>615</td>
</tr>
<tr>
<td>Device Views - Data</td>
<td>616</td>
</tr>
<tr>
<td>Device Recording</td>
<td>617</td>
</tr>
<tr>
<td>Device Recording - Introduction</td>
<td>618</td>
</tr>
<tr>
<td>Device Recording - Modes</td>
<td>619</td>
</tr>
<tr>
<td>Changed mode</td>
<td>619</td>
</tr>
<tr>
<td>Active Mode &amp; Mark</td>
<td>621</td>
</tr>
<tr>
<td>Active Mode &amp; Attribute Tracking</td>
<td>621</td>
</tr>
<tr>
<td>Device Recording - All Attributes</td>
<td>623</td>
</tr>
<tr>
<td>Device Recording - Delete</td>
<td>624</td>
</tr>
<tr>
<td>Device Recording - Cue Only</td>
<td>626</td>
</tr>
<tr>
<td>Device Palettes</td>
<td>627</td>
</tr>
<tr>
<td>Device Palettes - Introduction</td>
<td>628</td>
</tr>
<tr>
<td>Device Palettes - Record</td>
<td>629</td>
</tr>
<tr>
<td>Each Device or Each Device Type</td>
<td>629</td>
</tr>
<tr>
<td>Record A Focus Palette</td>
<td>630</td>
</tr>
<tr>
<td>Record A Color Palette</td>
<td>631</td>
</tr>
<tr>
<td>Record A Beam Palette</td>
<td>632</td>
</tr>
<tr>
<td>Record An All Palette</td>
<td>633</td>
</tr>
<tr>
<td>Device Palettes - Update</td>
<td>635</td>
</tr>
<tr>
<td>Device Palettes - UPDATE direct key</td>
<td>636</td>
</tr>
</tbody>
</table>
User Masks - Functions ...................................................................................................... 671

>Settings & Tools ................................................................................................................... 673

Scroller Rolls ...................................................................................................................... 674

Scroller Rolls Editor - Columns ......................................................................................... 674
Create a Scroller Roll ........................................................................................................ 675
Assign A Scroller Roll ........................................................................................................ 676
Calibrate Individual Scroller Rolls .................................................................................. 677
Scroller Fan override ........................................................................................................... 678

Effects ......................................................................................................................................... 679

Effects - Introduction .............................................................................................................. 680
Try out the effects in a Demo Play ..................................................................................... 681

Effects - Functions ...................................................................................................................... 683

Effects - Views ........................................................................................................................ 684
Effects in Tabs ...................................................................................................................... 685

Effects - Command syntax ...................................................................................................... 687
Select and activate effects ................................................................................................... 687
Select channels from effect ................................................................................................. 688
Home functions for effects ................................................................................................. 689
Load an effect to a master ................................................................................................... 689
Effects - Soft Key Page ....................................................................................................... 690

Effects - Edit ........................................................................................................................... 691
Effects - Record ...................................................................................................................... 692
Effects - Channel Distribution Wizard ............................................................................... 693
Live Effects ............................................................................................................................. 695
Effect Playbacks .................................................................................................................... 696
Create an Effect Playback ................................................................................................... 696

Effect Overview ...................................................................................................................... 698
Chase Effects ........................................................................................................................ 699

Create a Chase ....................................................................................................................... 700
Copy a chase effect ................................................................................................................ 701
Control a Chase Effect ......................................................................................................... 701
Chase Tap Tempo ................................................................................................................ 702
Chase Beat Boss ................................................................................................................... 702

Chase Effect Parameters ...................................................................................................... 704

Chase Editor ........................................................................................................................... 705
Chase Editor - Functions .................................................................................................... 706
Chase Step Editor ................................................................................................................ 707
Chase Step Editor - Functions ............................................................................................. 708
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content Effects</td>
<td>709</td>
</tr>
<tr>
<td>Create a Content Effect Playback</td>
<td>711</td>
</tr>
<tr>
<td>Control Content Effects</td>
<td>711</td>
</tr>
<tr>
<td>Content Effect Parameters</td>
<td>712</td>
</tr>
<tr>
<td>Content Effect Beat Boss</td>
<td>715</td>
</tr>
<tr>
<td>Content Effect Return To Parameter</td>
<td>716</td>
</tr>
<tr>
<td>Series List</td>
<td>717</td>
</tr>
<tr>
<td>Series List - Functions</td>
<td>718</td>
</tr>
<tr>
<td>Series Step Editor</td>
<td>719</td>
</tr>
<tr>
<td>Series Step Editor - Functions</td>
<td>720</td>
</tr>
<tr>
<td>Content Effect Modes</td>
<td>721</td>
</tr>
<tr>
<td>What mode do I use?</td>
<td>721</td>
</tr>
<tr>
<td>Content Effect Times</td>
<td>723</td>
</tr>
<tr>
<td>Dynamic Effect</td>
<td>724</td>
</tr>
<tr>
<td>Waveforms - Dynamic Templates &amp; Tables</td>
<td>724</td>
</tr>
<tr>
<td>Create a Dynamic Effect Playback</td>
<td>725</td>
</tr>
<tr>
<td>Control a Dynamic Effect</td>
<td>725</td>
</tr>
<tr>
<td>Dynamic Effect Parameters</td>
<td>726</td>
</tr>
<tr>
<td>Dynamic Templates</td>
<td>728</td>
</tr>
<tr>
<td>Dynamic Effect Library - Columns &amp; Functions</td>
<td>728</td>
</tr>
<tr>
<td>Dynamic Template Editor - Create</td>
<td>728</td>
</tr>
<tr>
<td>Dynamic Template Editor - Functions</td>
<td>729</td>
</tr>
<tr>
<td>Dynamic Tables</td>
<td>730</td>
</tr>
<tr>
<td>Table Editor</td>
<td>730</td>
</tr>
<tr>
<td>Live Dynamics (old)</td>
<td>732</td>
</tr>
<tr>
<td>Live Dynamic Effects - Columns</td>
<td>733</td>
</tr>
<tr>
<td>Old Dynamic Effects</td>
<td>734</td>
</tr>
<tr>
<td>Dynamics - Base Value</td>
<td>735</td>
</tr>
<tr>
<td>Dynamics - Start</td>
<td>736</td>
</tr>
<tr>
<td>Start Dynamics By Number</td>
<td>736</td>
</tr>
<tr>
<td>Start Dynamics From The Effect Library Tab</td>
<td>736</td>
</tr>
<tr>
<td>Start Dynamics From The Effect Library Node</td>
<td>737</td>
</tr>
<tr>
<td>Start Dynamics From The Direct Selects</td>
<td>737</td>
</tr>
<tr>
<td>Start Dynamics With Direct Mode</td>
<td>737</td>
</tr>
<tr>
<td>Dynamics - Control</td>
<td>738</td>
</tr>
<tr>
<td>Clear Dynamics Soft Keys</td>
<td>738</td>
</tr>
<tr>
<td>Dynamic Wheels - Size, Rate, Offset &amp; Delay</td>
<td>739</td>
</tr>
</tbody>
</table>
Keep Dynamics In Next Preset ........................................................................................... 739
Set Distance In % ................................................................................................................ 739
Dynamics - Stop.................................................................................................................. 740
Stop Dynamics Manually ................................................................................................ 740
Activate A Dynamic Stop Table ..................................................................................... 741
Delete A Dynamic From Running Dynamics ................................................................. 741
Fade In A Preset In The Main Playback ........................................................................... 742
Load a new Sequence to the Main Playback ..................................................................... 742
Dynamics - Record .............................................................................................................. 743
Record Changed Dynamics .............................................................................................. 743
Record Dynamics To Another Preset .............................................................................. 743
Record Dynamics To A Master ........................................................................................ 743
Record Keep Dynamics (New Base Value) ...................................................................... 744
Dynamics - Preset Dynamics Editor ................................................................................... 745
Dynamics - Size & Rate ...................................................................................................... 746
Size .................................................................................................................................... 746
Size Channel ...................................................................................................................... 746
Rate .................................................................................................................................... 747
Rate Channel ...................................................................................................................... 747
Dynamics - Relations & Distance ...................................................................................... 748
Offset Relation .................................................................................................................. 748
Offset Relation - Dynamics Display .................................................................................. 748
Delay Relation & Distance ............................................................................................... 749
Delay Relation & Distance - Dynamics Display ............................................................... 749
Dynamics - Loop Count ..................................................................................................... 750
Dynamics - Fade ................................................................................................................ 751
Dynamics - Form ............................................................................................................... 752
Dynamics - Fetch From A Preset ..................................................................................... 753
Dynamics - Playing Back ................................................................................................. 754
Dynamics - Store Running To Library ............................................................................ 755
Image Effects ..................................................................................................................... 756
Create an image effect playback ...................................................................................... 757
Control image effects ....................................................................................................... 757
Image effect parameters ................................................................................................. 758
Animation effects ............................................................................................................. 759
Effect layouts (8.0) .......................................................................................................... 760
Create a new effect layout (8.0) ...................................................................................... 760
Copy an effect layout ...................................................................................................... 761
Connect an Effect Layout with a Pixel Grid (8.0) ............................................................ 761
Master Settings From the Console ...................................................................................... 804
Masters - Commands .............................................................................................................. 805
  Select masters and set levels ........................................................................................... 805
  Master single field editor ............................................................................................... 805
  Select channels in a master ............................................................................................ 806
  Mask in masters .............................................................................................................. 807
  Masters - Clear ................................................................................................................. 807
Masters - Times ...................................................................................................................... 809
  Set In-Wait-Out times for a Master ................................................................................... 809
  Master settings for times ............................................................................................... 809
  Flash On Time .................................................................................................................. 810
Masters - Channels ................................................................................................................ 811
  Load channels to masters ............................................................................................... 811
  Master Settings for channels ......................................................................................... 812
Masters - Presets .................................................................................................................... 814
  Load a preset to a master ............................................................................................... 815
  Record a preset to a master ......................................................................................... 815
  Master settings for presets ............................................................................................ 818
Masters - Groups ..................................................................................................................... 821
  Load a group to a master ............................................................................................... 821
  Master settings for groups ............................................................................................ 821
Masters - Effects ..................................................................................................................... 824
  Load an effect to a master ............................................................................................... 824
  Master settings for effects .............................................................................................. 825
Masters - Palettes .................................................................................................................... 827
  Load palettes to masters ............................................................................................... 827
  Play back palettes from a master ................................................................................... 828
Masters - Sequences ................................................................................................................ 829
  Load a sequence to a master .......................................................................................... 829
  Record a sequence to a master ...................................................................................... 830
  Master settings for sequences ....................................................................................... 830
  Dual Fader mode for Sequences .................................................................................... 832
Masters - Chase mode sequences .......................................................................................... 835
  Load a chase sequence to a master ................................................................................ 836
  Master settings for chase mode sequences ..................................................................... 836
Masters - Dynamics ................................................................................................................ 839
Load a dynamic template to a master ............................................................... 839
Masters - Magic Sheets (8.0) ........................................................................... 840
   Load a Magic Sheet to a master ............................................................... 840
Masters - Attribute parameters ................................................................. 841
   Load a parameter to a master .............................................................. 841
Masters - Console keys.................................................................................. 842
   Load a console key to a master ........................................................... 843
Masters - Macros ............................................................................................ 844
   Load a macro to a master ................................................................... 844
Masters - Drag and Drop Data ..................................................................... 845
   Drag and Drop Master Links ................................................................ 846
Masters - Swap upper/lower ....................................................................... 848
Masters - Select Playback Range ................................................................. 849
Masters - Fader Modes .................................................................................. 850
   Fader Mode - Masters .......................................................................... 851
   Fader Mode - Two Scene Masters ....................................................... 852
      Fading Two Scene Masters .............................................................. 853
      Create new looks in Blind and record to masters.............................. 853
   Fader Mode - Expanded Masters ......................................................... 855
   Fader Mode - Expanded Effects ............................................................ 857
   Fader Mode - Expanded Sequences ...................................................... 859
Masters - Beat Boss ...................................................................................... 861
   Master View .......................................................................................... 862
      Master View - Formats ................................................................. 863
Master List ...................................................................................................... 865
   Master list - Columns & Functions (8.0) ............................................. 866
Masters - Content ......................................................................................... 868
Master Pages .................................................................................................. 869
   Master Pages - Introduction ................................................................. 870
   Master Pages - Record (8.0) ................................................................. 871
   Master Pages - Functions ..................................................................... 872
   Master Pages - List ................................................................................. 873
      Master Pages List - Columns .......................................................... 873
      Master Pages List - Functions ......................................................... 874
   Master Pages - Editor ........................................................................... 875
      Master Page - Columns ................................................................. 875
Master Pages - Times .............................................................................................................. 878
  Master Page Times - In, Out, Wait ..................................................................................... 878
  Master Page Times - Page Time ......................................................................................... 878
  Master Page Times - BPM .................................................................................................. 879
Independents ............................................................................................................................... 880
  Independents - Introduction .............................................................................................. 881
  Using the Independents ....................................................................................................... 882
  Independent Modes ............................................................................................................. 884
  Independents Tab ................................................................................................................ 885
Remote Controls ..................................................................................................................... 886
  Clear Remotes ..................................................................................................................... 886
  Remote Control List ........................................................................................................... 887
CONSOLE KEYS ...................................................................................................................... 889
  Console Key Quick Help ..................................................................................................... 890
    Console Key - ? ................................................................................................................ 890
    Console Key - <-- (Disp Mode) ..................................................................................... 890
    Console Key - @LEVEL .................................................................................................. 890
    Console Key - A .............................................................................................................. 891
    Console Key - ALIGN ................................................................................................. 891
    Console Key - ALL ........................................................................................................ 891
    Console Key - Arrow Keys ........................................................................................... 892
    Left Arrow .................................................................................................................... 892
    Right Arrow .................................................................................................................. 892
    Up Arrow ....................................................................................................................... 892
    Console Key - ATTRIB ................................................................................................. 892
    Console Key - B .............................................................................................................. 893
    Console Key - BALANCE ............................................................................................... 893
    Console Key - BANK ..................................................................................................... 893
    Console Key - BEAM ...................................................................................................... 893
    Console Key - BLIND ...................................................................................................... 894
    Console Key - BROWSER ............................................................................................. 894
    Console Key - C/ALT ...................................................................................................... 894
    Console Key - CAPTURE .............................................................................................. 895
    Console Key - CH ONLY MODE ................................................................................... 895
    Console Key - CHANNEL ............................................................................................... 896
    Console Key - CHANNEL SET ..................................................................................... 896
    Console Key - CHAN DELAY .......................................................................................... 896
    Console Key - CHAN TIME ............................................................................................ 896
    Console Key - CHASE .................................................................................................... 897
    Console Key - CHECK + ............................................................................................... 897
    Console Key - CHECK - ............................................................................................... 897
    Console Key - CLEAR CHANGED .................................................................................. 897
Console Key - Cobalt Encoder ................................................................. 898
Console Key - COLOR .............................................................................. 898
Console Key - COLUMN .......................................................................... 898
Console Key - COMPARE ........................................................................ 899
Console Key - CONNECT .......................................................................... 899
Console Key - COPY/CUT ........................................................................ 899
Console Key - CURSOR ........................................................................... 900
Console Key - DATA ................................................................................. 900
Console Key - DELAY ................................................................................ 900
Console Key - DELETE ............................................................................... 900
Console key - DEVICE ............................................................................. 901
Console Key - Direct Select Pages ............................................................ 901
Console Key - EFFECT ............................................................................... 901
Console Key - EFFECT OVERVI ................................................................. 902
Console Key - ESC .................................................................................. 902
Console Key - FADER MODE ................................................................. 902
Console Key - FAN .................................................................................. 902
Console Key - FCB DELAY ...................................................................... 903
Console Key - FCB TIME ......................................................................... 903
Console Key - FLASH .............................................................................. 903
Console Key - FLASH MODE ................................................................. 904
Console Key - FLIP .................................................................................. 904
Console Key - FOCUS .............................................................................. 904
Console Key - FOCUS MODE ................................................................. 904
Console Key - FORMAT ............................................................................ 905
Console Key - GO .................................................................................... 905
Console Key - GO (Master Playback) ....................................................... 905
Console Key - GO BACK .......................................................................... 906
Console Key - GO BACK (Master Playback) ........................................... 906
Console Key - GOTO ................................................................................ 906
Console Key - GROUP ............................................................................ 906
Console Key - GROUP WHEEL MODE ..................................................... 906
Console Key - HIGHLIGHT ....................................................................... 907
Console Key - HOME ATTRIB ................................................................. 907
Console Key - ID ..................................................................................... 908
Console Key - IN ..................................................................................... 908
Console Key - INDEPENDE 7,8,9 .............................................................. 908
Console Key - INSERT ............................................................................. 908
Console Key - INV GROUP ....................................................................... 909
Console Key - JUMP TO B ...................................................................... 909
Console Key - LAMP CONTROL .............................................................. 909
Console Key - LAST ............................................................................... 910
Console Key - LEARN ALERT ................................................................. 910
Console Key - LEARN MACRO ............................................................... 910
Console Key - LEARN PROFILE .............................................................. 910
Console Key - LEFT ................................................................. 911
Console Key - LIVE ............................................................................... 911
Console Key - LOAD ........................................................................ 911
Console Key - LOCAL MENU ............................................................ 912
Console Key - LOCK ........................................................................ 912
Console Key - MACRO ........................................................................ 912
Console Key - MARK ......................................................................... 912
Console Key - MASK ......................................................................... 913
Console Key - MASTER ....................................................................... 913
Console Key - MASTER KEYS ............................................................. 913
Console Key - MASTER PAGE ............................................................ 914
Console Key - MINUS ......................................................................... 914
Console Key - MINUS PERCENT (-%) .................................................. 914
Console Key - MODIFY ................................................................. 915
Console Key - MODIFY SEQ ............................................................. 915
Console Key - MUTE ........................................................................ 916
Console Key - NEXT ......................................................................... 916
Console Key - NOTE .......................................................................... 916
Console Key - Numerical Keypad ........................................................ 916
Console Key - ON/FETCH ................................................................. 917
Console Key - ORGANIZER ............................................................... 917
Console Key - OUT ........................................................................... 917
Console Key - OUTPUT ....................................................................... 918
Console Key - PAGE .......................................................................... 918
Console Key - Page+ ......................................................................... 918
Console Key - Page- ......................................................................... 918
Console Key - PAUSE ........................................................................ 919
Console Key - PAUSE (in Master Playback) ......................................... 919
Console Key - PALETTE (Alt P) ............................................................ 919
Console Key - PARAMETER ............................................................... 919
Console Key - PARK .......................................................................... 920
Console Key - PASTE ........................................................................ 920
Console Key - PLAYBACK ................................................................. 920
Console Key - PLAYLIST ................................................................. 921
Console Key - PLUS ......................................................................... 921
Console Key - PLUS PERCENT (+%) .................................................... 921
Console Key - PRESET ...................................................................... 922
Console Key - PRINT SCREEN .......................................................... 922
Console Key - RANDOM ................................................................. 922
Console Key - RANGE ....................................................................... 923
Console Key - REM DIM .................................................................... 923
Console Key - RECORD ..................................................................... 923
Console Key - REFRESH .................................................................... 924
Console Key - RELEASE .................................................................... 925
Console Key - RIGHT (DispSel) ......................................................... 925
Console Key - SAVE ............................................................................................................ 925
Console Key - SAVE COPY .................................................................................................. 925
Console Key - SCALE .......................................................................................................... 926
Console Key - SELECT ......................................................................................................... 926
Console Key - SELECT 2ND .............................................................................................. 926
Console Key - SELECT 3RD .............................................................................................. 926
Console Key - SELECT ALL ............................................................................................... 927
Console Key - SELECT CHANGE ...................................................................................... 927
Console Key - SELECT NTH ............................................................................................. 927
Console Key - SERIES ...................................................................................................... 927
Console Key - SETUP ........................................................................................................ 928
Console Key - SET CHANGED ........................................................................................... 928
Console Key - SEQ ............................................................................................................ 928
Console Key - SEQ + ......................................................................................................... 929
Console Key - SEQ - ......................................................................................................... 929
Console Key - >> (Master Playback) .................................................................................. 929
Console Key - << (Master Playback) .................................................................................. 929
Console Key - SOLO ......................................................................................................... 930
Console Key - START ......................................................................................................... 930
Console Key - SWAP ......................................................................................................... 930
Console Key - TAB ............................................................................................................ 930
Console Key - TAP ............................................................................................................. 931
Console Key - TEXT .......................................................................................................... 931
Console Key - THRU .......................................................................................................... 931
Console Key - TIME ......................................................................................................... 932
Console Key - TRACK ......................................................................................................... 932
Console Key - TYPE ......................................................................................................... 933
Console Key - U1-U3 ......................................................................................................... 933
Console Key - UNPARK ..................................................................................................... 933
Console Key - UPDATE ..................................................................................................... 934
Console Key - UPDATE PALETTE ..................................................................................... 934
Console Key - WAIT ......................................................................................................... 934
Console Key - WIZARD ..................................................................................................... 934
Soft Key Menu - Channels ................................................................................................. 935
Soft Key Menu - Device ..................................................................................................... 935
Soft Key Menu - Effect ..................................................................................................... 935
Soft Key Menu - Learn ..................................................................................................... 935
Soft Key Menu - Misc. ....................................................................................................... 936
Soft Key Menu - Select ..................................................................................................... 936
Soft Key Menu - Times ..................................................................................................... 936
Soft Key Menu - Wheel Keys .......................................................................................... 936
Console Key - FIND .......................................................................................................... 937

Console Key Shortcuts .................................................................................................... 938

Shortcuts - Select Channels ........................................................................................... 939
Shortcuts - Channel Levels ................................................................. 940
Shortcuts - Channel Modes .............................................................. 941
Shortcuts - Select Nth Functions .................................................... 941
Shortcuts - Channel Views .............................................................. 942
Shortcuts - HELP .......................................................................... 942
Shortcuts - Channels Only Mode ................................................... 943
Shortcuts - General Editing Keys .................................................. 944
Shortcuts - Spreadsheet Editing .................................................... 944
Shortcuts - Navigation Keys (8.0) .................................................. 945
Shortcuts - Master Playbacks ......................................................... 945
Shortcuts - Masters & Channels ..................................................... 946
Shortcuts - Master Pages (8.0) ........................................................ 947
Shortcuts - Devices To Home Position ........................................ 948
Shortcuts - Device Attribute Editors ............................................. 948
Shortcuts - Device Masking ............................................................ 948
Shortcuts - Device Palette Recording .......................................... 950
Shortcuts - Device Palette Activating ......................................... 951
Shortcuts - Device Palette Updating ............................................ 951
Shortcuts - Device Palette Specials .............................................. 952
Shortcuts - Device Palette Views (8.0) .......................................... 952
Shortcuts - Device Palettes In Masters ....................................... 953
Shortcuts - Device Align & Fetch .................................................. 953
Shortcuts - Patch & Outputs .......................................................... 954
Shortcuts - Track ........................................................................ 955
Shortcuts - Presets ...................................................................... 956
Shortcuts - Groups ...................................................................... 957
Shortcuts - Live & Blind ................................................................. 958
Shortcuts - Record Functions ....................................................... 959
Shortcuts - Update Functions ....................................................... 959
Shortcuts - Channel Text Wizard ................................................ 960
Shortcuts - Main Playback ............................................................ 960
Shortcuts - Sequence Editor ......................................................... 961
Shortcuts - Direct Selects ............................................................... 961
Shortcuts - Notes ........................................................................ 962
Shortcuts - Capture & Release ...................................................... 962
Shortcuts - Dynamics (old) ........................................................... 964
Shortcuts - Times ........................................................................ 966

ACCESSORIES ................................................................................ 967

Accessories - Keyboard ................................................................. 968
  Keyboard - Numerical Input on a Notebook .............................. 968
  Keyboard - Standard Functions .............................................. 968
  Console Keys in a Keyboard - Hotkeys (8.0)............................. 969
  Keyboard - Level Wheel ............................................................ 972
  Keyboard - CH Step ................................................................. 972
Direct Selects - Record & Update ................................................................. 1054
Congo Jr/Kid - Soft Key Pages ................................................................. 1056
  Master Soft Key page for Congo Jr/Kid ............................................... 1056
Congo Jr/Kid - Main Playback ................................................................. 1058
  Congo Jr/Kid - Master Display Keyboard ........................................... 1059
  Master Fader Mode Switch (Master Playback Wing) ....................... 1060
Congo Jr/Kid - Fader Wings ................................................................. 1061
  Master Playback Wing ..................................................................... 1061
  Universal Fader Wings ................................................................. 1063
EXAMPLES ......................................................................................... 1064
  Example: Build a chase effect .......................................................... 1065
  Example: Patch by Output .............................................................. 1066
  Example: Patch by Channel ............................................................ 1067
  Example: Record in the Main Sequence ........................................... 1068
  Example: Clear and Reset Patch ....................................................... 1069
  Example: Using a Beat Boss for a chase effect ................................. 1070
  Example: Select all running effects .................................................. 1071
INDEX .............................................................................................. 1072
Cobalt Help System 8.2

Hold ? and press any key to get a short help. To exit press ESC.

Options

- News in this software version
- Workflow in Cobalt
- This Manual - Using The Help System
- Keyboard Hotkeys
- Troubleshooting and support

Help Companion - scan the QR code (below) in your online help system

This revision: 20181029
COBALT HELP SYSTEM

This is the manual for the Cobalt Family.

This manual covers Cobalt20, Cobalt10, Cobalt Nomad Cobalt Lightserver, Congo Jr, Congo Kid, Client and Offline editor.

The introduction contains the following sections

- This Manual - Using the Help System
- ***News In This Version***
- This Manual - Terminology
- Disclaimer

There is an appendix for running Cobalt in Congo hardware. 
(See Cobalt in Congo)
This Manual - Using the Help system

To open the help system, press the HELP key in the Programming Section. Hold help key and press any other key for quick help.

1. Previous/Next visited page
2. Home
3. Previous/Next chronological page
4. Search Function
5. Set Favorite
6. Set to Normal or to auto-follow Keys or Tabs

In the Browser you can display the table of contents. The right arrow expands a topic and the left arrow jumps to the parent and closes. Press MODIFY or tap to open a topic.

You can set up a Help Tab (see Tab - Help) If there is a help dock available, using HELP would open content.
Help System - Change Language

The help system is available in a number of languages.

The displayed language is selected in the System Settings.

Help - Search Function

Click on the magnifying glass in HELP or press FIND in the console to get the search function.

![Cobalt Help Search](image)

Enter one or more keywords to search for. Note that '*' and '?' wildcards are supported.

Search results for: Scroller

21 results found.

3 pages of results.

1. **Scroller Fan override**
   Scroller Rolls are defined in the Scroller Roll Editor. It is opened from
   the Browser (Browser Devices Settings & Tools Scroller Roll... 7 Jul 2017

2. **RFR Scroller Calibration**
   Remote Control - RFR Radio Remote The RFR Radio Remote provides bi-
   directional remote control with a hardware designed for stage environment. All...
   7 Jul 2017

Tap to go to a link.
Help System - Favourites

Tap on the NOTE symbol in the Help tab. A dialog allows you to enter a descriptive text for the chapter you are tagging as a favourite.

To delete a Note - focus it in the Browser and press DELETE. (See The Browser)

Help System - Console Keys

Navigating in the help can be done as a paper manual (next or last page) and as a web browser (previous page).

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next</td>
<td>Down Arrow</td>
<td>Steps to the next page.</td>
</tr>
<tr>
<td>Previous</td>
<td>Up Arrow</td>
<td>Steps to the previous page.</td>
</tr>
<tr>
<td>Last visited page</td>
<td>Left Arrow</td>
<td>Steps to the last visited page.</td>
</tr>
</tbody>
</table>
Help Companion over WIFI

If you have a console and a touch pad or smartphone connected on the same wireless network, from 7.3 you can browse to an external help system web page that can be completely synchronized with key presses or selected screens in the software. You can activate it by scanning the QR code in the first help page.
News In This Version

This chapter presents the news and changes in new versions of the software. Here are a few sections that may be of help and interest for you, depending on where you are coming from.

News in Cobalt 8.2

These are the Key Enhancements in v8.2. Search for "8.2" in the Help system to find all changes and updates.

New feature

- **Color Picker:**
  A major part of the Color Picker functionality of Eos has been ported into Cobalt. There is a new Color Picker tab. This opens a new view where a multitude of different color control panels can be selected, allowing you to control color in all kinds of color systems. There are also various types of gel selection controls. See Tab - Color Picker.

Improvements

- **Magic sheets**
  Save, Save to USB and Blackout are now accessible in Magic Sheets as Button->Console Button subtypes.
  Added Print screen capability (print to file). See Magic Sheets Editor - Object Target
- **Soft keys**
  Added Reverse soft key to reverse the channel selection. See Select - Sub-selection Functions
- **Action Macro**
  The START command now has an optional time parameter. See Cobalt Action Macros

News in Cobalt 8.1

These are the Key Enhancements in v8.1. Search for "8.1" in the Help system to find all changes and updates.

- New Tab - Direct Selects Flow
- New Soft Key Pages S1-S3 with 10 user definable console functions in each.
- New Palette times in Magic Sheets.
- New way of loading Magic Sheets from the Browser list
- New functionality of CITP with Media Servers.

News in Cobalt 8.0

These are the Key Enhancements in v8.0. Search for "8.0" in the Help system to find all changes and updates.
- New Screen Areas
- New Tab Selector
- New Magic Sheets
- New Networking and multiple console architecture
- New Clone function in the Patch Wizard

**News in Cobalt 7.3**

These are the Key Enhancements in v7.3. Search for "7.3" in the Help system to find all changes and updates.

- New and expanded OSC commands. See Receive OSC Input.
- Expanded columns in Track List to 100. See Track List.
- Select master range for master #. See Masters - Select Playback Range. See Console Key - Range.
- Master Flash Solo mode can include Main Playback. See Flash Settings.

**News in Cobalt 7.2**

These are the Key Enhancements in v7.2. Search for "7.2" in the Help system to find all changes and updates.

- Cue sequences. Read here >>
- Setting a Record Target other than the Main Playback. Read here >>
- Direct Selects and console keys. Read here >>
- Beat Boss function for chase and content effects. Read here >>
- Find highest level for a channel. Read here >>
- The new help dock. Read here >>
- New Action Macros. Read here >>
- Up to four DMX ports. Read here >>
- Action Macros in the Direct Selects dock. Read here >>
- Examples in the help system. Read here >>
- Device Mode Pages. Read here >>
- Arrange functions in the DS dock. Read here >>
- Cobalt Programming Wing. Read here >>

**News in Cobalt 7.1**

These are the Key Enhancements in v7.1. Search for "7.1" in the Help system to find all changes and updates.

- Improved Import Template Wizard with search filter. Read here >>
- Flexible Patching. Read here >>
- DMX Settings moved into Browser. Read here >>
- A User Library for collecting often-used, new or modified device templates. Read here >>
• Improved handling of multi-cell and compound devices. Read here >>
• Arrange function in the direct selects dock (copy/move). Read more >>
• Content and Dynamic effects now use the group numbers as index number.
• There is a new chapter about how to try the effects in the Demo Plays. Read more >>
• Improved Mark performance on sensitive devices (LEDs lit at DMX 1)
• Updated Extended Library
• Support of Cobalt 10 hardware
• Support of Nomad universal dongle on Macintosh computers (Intel only)
• Bug Fixes
Coming to Cobalt from Congo

Your main difference will be that Cobalt is so much faster. Making a transition from Congo to Cobalt is simple. All of your old shows are compatible, and 100% of the functionality you are used to. However, you will find that some things are handled differently by the hardware, and in ways that eliminate hundreds of key presses in a session.

Two big differences are the Direct Select Tab that replaces the Direct Select key sections in Congo with many more options and built in screen faders, and the Device Control Tab that provides you with direct access to every parameter in a device. From version 8.0 and forward also all the Networking and multiple console architecture is different. There are a lot of brand new features such as the Magic Sheets that bring the former Channel Layouts to a new level. The Screen Areas that allow you to store complex and useful screen setups and the new Tab Selector system that comes with this. Keep most of your muscle memory and system architecture intact and explore these new and powerful features with an open mind.
This Manual - Terminology

This manual is intended for use with the Cobalt lighting control system by ETC.

The on-line manual and the paper manual are the exact same document.

In order to be specific about where features and commands are found, the following naming and text conventions will be used:

- Cobalt processor (hardware): the computer used to run the Cobalt applications.
- Cobalt Facepanel (hardware): the control console hardware. This is also referred to simply as the "Facepanel".
- Cobalt software: the application that gives you the functionality of the Cobalt system controlled from the Facepanel.
- Commands in the Browser Tab are indicated like this: Browser >Files >New.
- Console keys in general are indicated in all CAPS. For example RECORD.
- Console keys in tables are have a button outline like this:

  [RECORD]

- When a key is held and another key is pressed at the same time is written like this: RECORD & MASTER
- References to other parts of the manual are indicated as underlined hyperlinks. When viewing this manual electronically, click on the reference to jump to that section of the manual.
Disclaimer

We do everything possible to guarantee the reliability of this system.

Please don't load other software onto your Cobalt lighting console. ETC has tested the configuration of this system to guarantee its best performance. Additional software or unauthorized changes within the operating system may significantly affect the performance of this lighting control system. In the worst case, ETC may require that the hard disk be reimaged back to factory default settings to return a system to an operational state.

We highly recommend that you save your play data frequently while programming and that you back up important data to portable media often.

Please contact your ETC representative with questions or concerns.

See Troubleshooting.
GETTING STARTED

Getting Started is about understanding the basic terminology and workflow.

- General Info
- Workflow In Cobalt
- Troubleshooting

NOTE
If you are new to Cobalt, we recommend you spend half an hour on the Workflow in Cobalt.
General Info

This chapter describes the key syntaxes, basic software and control terminology.

This chapter contains the following sections

- System Overview
- Setup Guide
- Installation Guidelines
- Key Syntaxes
- Cobalt Terminology
- Control Hierarchy
- Software & Update

Interface Specification

For more information, see the Setup Guide >>

- Two individually configurable ethernet ports, 802.3 af-compliant POE
- ETCNet2™, Net3™ (powered by ACN), sACN and ArtNet output protocols
- Two DMX512a/RDM ports
- Contact closure triggers via D-Sub connector
- Three female IEC connectors
- Three active Display Port-to-DVI adapters. If passive adapters are used, only two may be used at a single time. A third adapter must be an active adapter. Displays using an active adapter have a max resolution of 1920x1200. Optional single- or multi-touch screen control
- USB 2.0 multipurpose (11 ports)
- Client PC via ethernet (requires Client Dongle)
- Net3 radio focus remote (rfr) via USB or ethernet
- Phone remote
- OSC open Sound Control via ethernet
- UDP event triggering via ethernet
- ARFR for android devices and irfr for apple iOS devices via wireless ethernet
- MIDI in/out (MIDI timecode, MIDI notes, MIDI Show Control (MSC))
- MIDI timecode, MIDI Show Control through Net3 Show Control Gateway
- SMPTE timecode through net3 Show Control Gateway
- Contact closure (12 analog inputs, 12 SPDT contact outputs, RS-232) through Net3 I/o Gateway
ELECTRICAL

- AC input (100 - 240V at 50/60 Hz)
- Maximum power consumption (including external monitors) approximately 6.3A 120/240V

DIMENSIONS

**PHYSICAL**

<table>
<thead>
<tr>
<th>Cobalt Dimensions*</th>
<th>Cobalt Weights*</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>MODEL</strong></td>
<td><strong>HEIGHT (MAX)</strong></td>
</tr>
<tr>
<td></td>
<td>inches</td>
</tr>
<tr>
<td>COBALT 20</td>
<td>15.5</td>
</tr>
</tbody>
</table>

*Weights and dimensions typical. Cobalt 20 is shipped in a carton on a pallet. The shipping weight is the combined weight of the console on the pallet.
Setup Guide

This setup guide provides identification of the inputs and outputs on the Cobalt 10 and Cobalt 20 control desks and related hardware systems, as well as provides important information regarding initial setup and use.

Cobalt 20

1. Desk Lamp
2. Vents: Make sure to keep these vents clear of any obstructions.
3. Switched Outlets
4. Hard Power Switch (I = on, O = off)
5. Desk Lamp
6. Desk lamp controls
7. DMX512A/RDM ports
8. MIDI Ports (1x In, 1x Out)
9. Remote Trigger
10. Phone Remote
11. Dual-Mode Display Port Output. There are three ‘active’ Display Port-to-DVI adapters. If ‘passive’ adapters are used, only two may be used at a single time. A third adapter must be an ‘active’ adapter. Displays using an ‘active’ adapter have a max resolution of 1920x1200
12. Audio Line Out (Audio Line In reserved for future development)
13. USB ports. These ports cannot be used for charging devices such as cell phones.
14. Ethernet IEEE 802.3af (compatible power sourcing ports)
15. IEC Power Input and fuse. For continued protection against risk of fire, replace only with same type and rating of fuse.

For connector pins, see Connectors >>

Cobalt 10
The Cobalt 10 has the same connectors and specifications, except there are no switched outlets (3).
Cobalt Light Server, Congo Kid & Congo Jr
The Cobalt Light Server, Congo Kid & Congo Jr have the same connectors for everything except monitors, and there are two ethernet connectors instead of three.

These systems support up to 2 monitors using the following combinations:

<table>
<thead>
<tr>
<th>Physical Port</th>
<th>Display Port</th>
<th>DVI</th>
<th>VGA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Port</td>
<td>Yes</td>
<td>Yes with Adapter</td>
<td>Yes with Active Adapter</td>
</tr>
<tr>
<td>DVI-I Port</td>
<td>No</td>
<td>Yes</td>
<td>Yes with Adapter</td>
</tr>
<tr>
<td>DVI-D Port</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

Multitouch monitors need to be Windows 7 or 8 Compatible.
Installation guidelines

Equipment required to run this system

- Cobalt20, Cobalt10, Cobalt Nomad, Net3 RVI, Client software
- Power cables
- Up to three external DVI multi touch monitors.
- DMX512 or Ethernet cable(s) to external equipment

Connect the monitor signal cable(s) from the back of the console to the monitor(s), and then connect the power cables to a 230/110V outlet and start all units. After approximately 30 seconds Cobalt should be running.

See Power-up Procedure.
Key Syntaxes

There are mainly **two kinds of keys** in the console: keys with a fixed function, and softkeys in the screens.

Keys in the Cobalt can behave in the following ways

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direct</td>
<td><em>Will perform a function directly when it is pressed.</em></td>
<td>GO and PAUSE in the Main Playback</td>
</tr>
<tr>
<td>Numerical Prefix</td>
<td><em>Requires a numerical entry (0-9) before it is pressed.</em></td>
<td>(#) RECORD to store a preset with that number</td>
</tr>
<tr>
<td>Combination</td>
<td><em>Will change the function of another key if it is held down while pressing that key.</em></td>
<td>Hold C/Alt and press PLAYBACK to clear the Main Playback</td>
</tr>
</tbody>
</table>

Some keys can combine all three ways of working. An example of this is the PRESET key

- Pressing PRESET with no numerical prefix opens the Preset List with all presets.
- A number and PRESET selects the channels of that specific preset.
- A number and holding PRESET while pressing a Master Key will load preset (#) to that Master.

**NOTE**

*Hold down the ? (HELP) key, and press any key to get help on it.*
Cobalt Terminology

It can be easier to understand Cobalt if you are familiar with the basic terminology.

Channels (terminology)

A Channel is the control handle used to call anything controlled by Cobalt. Regardless if it is a dimmer channel, a moving device, a smoke machine or something else it will always correspond to a channel number in the Patch. A channel will control nothing unless it is patched. You can start with a patch 1:1.

To select a channel and set a level, enter the number and move the level wheel.

See Channels

Attributes (terminology)

Any type of device that has more than intensity (color, movement etc) is called a device and the control of non-intensity parameters, for example a moving device or a scroller, are called attributes. These are patched to the controls of Cobalt when the Template corresponding to that device is assigned to a control channel in the Patch.

See Moving Devices

Patch (terminology)

Patch is where outputs are assigned to channels, either directly in the case of dimmers or using a Template in the case of devices. All settings pertaining to outputs, channels and devices are also adjusted within the patch.

See Patch

Groups (terminology)

Frequently used combinations of channels can be stored in up to 999 Groups, for quick recall from the keypad or a remote focusing system.

See Groups
**Presets (terminology)**

The basic building block combining channel intensities, device parameters and referenced data such as palettes is stored in a Preset. The combination of a Preset and a Sequence Step is the equivalent of a "Cue" in many other systems. The advantage here is that Presets can be reused in any Sequence, with different times. A Preset can be played back from any of the 80 Master Playbacks as well.

See [Presets](#)

**Sequences (terminology)**

Lists of Presets are called Sequences, that can be crossfaded, move faded or lock faded in consecutive order from a Master or Crossfade Playback. A Sequence can be played back in Chase mode.

See [Sequences](#)

**Effects (terminology)**

An effect is a repetitive content that runs in a loop and where you can affect speed of playback and other things. Effects are run in effect playbacks, very similar to channel handles for moving devices.

There are four types of effects.

- Chase Effects - intensity only, step based with tap tempo.
- Content Effects - very powerful content based effects that can be reused with new data.
- Dynamic Effects - Wave-form effects to provide movements.
- Image Effects - a text or an image source is mapped to a channel layout.

There is a backwards compatible older style of chase effect which is a mode for a sequence.

See [Effects](#)
**Control Hierarchy**

The control hierarchy is this

- **Intensity** is handled with highest-takes-precedence (HTP) logic, meaning the highest output level will be the "winner" and have control of those channels.
- **Attributes** are handled using last-takes-precedence (LTP) logic, meaning the last instruction given to the attribute will be the winner.
- There is a **Grand Master** and **Inhibit Masters** that can subtract from the output.
- There is a **Capture mode** which can override HTP control of intensities.
- Masters can be set to "own" attributes of devices, overriding all other LTP controls.
- Masters can be set to an **Exclusive Mode**, which takes the content of the master out of "normal" control in the rest of the system.

**Playbacks - Introduction**

Intensities and parameters can be played back from the following playbacks.

- The main playback (A/B) and Live field
- The 80 master playbacks
- The Independents
- The Blind field
- The Freeze field

The following functions can affect the playback of an intensity or parameter

- Capture Mode
- Exclusive Mode
- Inhibit Mode
- Balance Mode
- Park
- Scale
- Mute
- Solo

**SUMMARY**

Cobalt has a main theatrical playback, plus 80 Master Playbacks. All of them are capable of running a sequence or chase. The main difference is that the theatrical playback has a large amount of different manual controls for crossfades.

- The Live and Blind fields are central to the concept of Cobalt - being able to work in both at the same time.
- The Independents are a special set of masters, designed for control of special channels you want to keep separate from the rest of the system.
- The Direct Selects are used for quick selection and assignment of data suitable for single-button action like group selects, palettes, screen layouts and such. They are extremely powerful.
Control Hierarchy - Master Playbacks

Light output from the Masters is added to the output on a Highest Takes Precedence basis. Device attributes are controlled by Last Takes Precedence.

- Any master set to Inhibit Mode will subtract the assigned channels from the output similar to the function of the Grand Master.
- Any master set to Exclusive Mode will be the only master controlling the assigned channels, and they are masked from recording.

See Master Playbacks

Control Hierarchy - Main Playback

Light output from the Main Playback is added to the output on a Highest Takes Precedence basis. Device attributes are controlled by Last Takes Precedence.

The Main Playback consists of two faders, one for the active channels (A), and one for the channels in the next step (B). A and B also interact on a Highest Takes Precedence basis, with the addition that channels that exist in both faders are calculated so all crossfades are dipless. As a result, even if both faders are at 0%, common channels will remain on stage.

From 8.0 there is an option of choosing one of 9 additional multi-user Main Playback's to facilitate networking with different sequence content in the Main Playback.

See Main Playbacks

Control Hierarchy - Highest Takes Precedence

You can output light from all Masters and the Main Playback at the same time. But what happens if you have faded in Preset 1 on the Main Playback and it's up on a Master too?

- The answer is that the highest intensity level of a channel "takes precedence" whenever it's output from more than one place in the system.

If the "Highest" level for a channel is generated from one of the Masters it is displayed in yellow, if it is generated from the Main Playback it is white.
Software & Update

We constantly update the Cobalt software with new features, bug fixes and changes. Check www.etcconnect.com periodically to see if there's a more recent version than the one you are currently working with.

Software versions come in two types: Beta release and Official release. Beta releases are test versions, which are not meant for use on real Plays. Once Beta releases are tested and proven reliable, they become official releases.

The Cobalt software is owned and manufactured by ETC.

To update the software see System Settings - Update.

Version Information

You can see which version you have in About Cobalt (Browser >About>About Cobalt).
Workflow in Cobalt

The workflow in Cobalt can be divided into five steps

1. **Patch**
   Before you can control a dimmer or device it has to be patched to a channel. See [Patch (workflow)](#).

2. **Control**
   Control is how you select channels, set levels and control parameters. See [Control (workflow)](#).

3. **Record**
   To be able to playback something it has to be recorded. See [Record (workflow)](#).

4. **Playback**
   There is a main playback and 40 master playbacks. See [Playback (workflow)](#).

5. **Edit**
   When recorded information needs to be adjusted there are many tools for editing. See [Edit (workflow)](#).

### Patch (workflow)

There are various approaches to patching, which depend on your situation. Very often conventional lights are patched in one universe, and moving devices in another, in order to simplify troubleshooting. The main work with patching is the planning involved before approaching the console.

#### Patching Conventional Lights

There are three basic approaches to patching conventional lights

**Patch 1:1**

You can choose the option "Patch 1:1" when you open a new play, or you can set the Patch 1:1 in the Patch Wizard.

See [Patch Wizard](#).
Patch by channel
Patch by channel is easy and fast in the Output editor. It can be done live or blind. You can start with a cleared patch or with a 1:1 patch.
See Patch by Channel/Dimmer.

Patch by dimmer
Patch by dimmer is easy and fast in the Output Editor. It can be done live or blind. You can start with a cleared patch or with a 1:1 patch.
See Patch by Channel/Dimmer.

NOTE
To clear the Patch, see the Patch Wizard.
To get an overview of the current patch, see the Channels List.

Patching Moving Devices
To patch a moving device, scroller, color mixing device or media server you need to load a template for this device. This can be imported with the Import Template Wizard or from another play. You can also create custom templates in the Template Editor.
See Import Template Wizard.

There are two approaches to patching single or multiple moving devices

Patch Wizard
In the Patch Wizard it is easy to patch single devices, and multiple devices that have consecutive addresses. It's possible to add a channel offset to a template as well.
See Patch Wizard.

Device List
If you are patching single devices, or multiple devices with irregular addresses the Device List is a great tool. It's also great for changing address or universe, and for adjusting individual parameters like pan, tilt and scroller calibration.
See Device List.

Control (workflow)

Controlling channels, levels and moving device parameters is very straightforward. The default setting is to work in "Live" which is the sum of all playbacks. Intensities are added to live in the A field of the main playback.

Command Syntax
The whole command structure of Cobalt is designed to get you from point A to point B with as few keystrokes as possible. Basically, there is no function or feature that involves more than two key presses (besides numbers).
The structure is simple

- Press a key
- Hold a key and press another key.

When a number is required, simply enter it before either of the key combinations above.

See Channels - Command Syntax.

**Channel "handles"**
Regardless if a lighting instrument is a conventional light, or some kind of moving device, the intensity function of this device is assigned a unique Channel number in the patch.

*Example*

- Enter a number and move the level wheel to select the channel and change the intensity.

When you select this channel, all parameters are automatically mapped to the controls of the console. All parameters are divided into three groups that have a dedicated key in the console.

- FOCUS (pan/tilt)
- COLOR (color mixing and color wheels)
- BEAM (gobos, shutters, iris, zoom, prism etc)

*Example*

- If a selected channel has a scroller, press COLOR. The scroller can be controlled from one of the four parameter wheels by number (frame) or continuously.
- If a selected channel is a moving device press FOCUS to get pan and tilt functions on the parameter wheels.

See Devices - Control.

The easiest way to control a device is from the Device Controls tab where all functions are mapped and accessible at the same time. See Device Control Tab.

**NOTE**
If you are looking for a "RELEASE" function you are probably used to working with a console that has a "programmer". There is no programmer in Cobalt, instead you work directly in any playback.

**Record (workflow)**

1. Patch
2. Control
3. Record
4. Playback
5. Edit
If you press RECORD in LIVE, the default record target is the next free Preset, of the Sequence in the Main Playback. You can record to any other target as well, using the various recording functions. See Presets - Record.

What is recorded?

Intensities
The default setting is that all intensities on stage are stored. Conventional lights and moving devices alike.

Moving Devices
Before you start recording moving devices, you need to make two decisions in the default settings for attributes (parameters).

- What parameters do I want to record? (active (default), changed, popup, all ). See Device Recording - Modes.
- How do I want parameters to be executed? (Auto Mark (default), On Go, In B). See Device Playback - Go OnGo or GoInB.

Where is it recorded?

Presets - the basic building block
Light intensities and moving device parameters are stored in Presets. A Preset is referenced data that can be played back on its own in a master or the main playback. It can also play back as the content of a sequence step or content effect. A preset can contain absolute data (values) or referenced data (palettes).

See Presets.
See Sequences.

Other types of record targets
Besides presets there are Groups for organising channel selection and Palettes for referencing moving device data. See Groups.
See Devices - Palettes.

Playback (workflow)

There is a Main Playback, and eighty Master Playbacks. The Main Playback is used for theatre style sequential playback of any Preset or Sequence.

The Master Playbacks can play back

- Single channels
• Groups
• Palettes
• Parameters
• Presets
• Sequences
• Console keys

See Masters.

Playing back Presets and the main sequence.

• As soon as a preset is recorded you can play it back in the Main Playback or any of the 80 Master Playbacks.
  See Presets - Load To Playbacks.
• All presets that have been recorded in Live have been added to the Sequence of the Main Playback as Steps with default fade times (5s). They can be played back with or without this default time, or manually.
  See Main Playback.

Rules for playback

• Intensities will play back following HTP (Highest Takes Precedence) between all playbacks.
• Attributes are LTP (Latest Takes Precedence). As soon as they are triggered they will move to this position. They are never owned by a playback.

Exceptions

• CAPTURE will override all normal playback features and "hold" the values of intensities and/or attributes.
  See Capture.
• There is a PARK feature to park any intensity or parameter at a fixed value.
  See Parked.
• There is an exclusive mode for the Independents and Master Playbacks, that will "remove" the intensity of the assigned channels from the normal functionality of the console.
  See Independent Modes.
• There is an INHIBIT mode for the independents and Master Playbacks, that allow you to filter the maximum output of an intensity channel.
  See Independent Modes.
• There is a FREEZE mode that will maintain a static DMX output so you can work completely blind.
  See Output Switch.

Selecting and playing back from the Direct Selects

A powerful and simple interface for playing back information is the Direct Selects Tab. Open by clicking on a "+" sign in a screen area and select Direct Selects. You will have four types of play objects pre-selected: Group, Focus, Color, Beam. Click on a group to activate, then on a Focus, Beam or Color palette to activate that. By pressing TYPE you can change to any other type of object for fast access and playback. See Direct Selects.
Edit (workflow)

Once a Play is recorded you will want to edit and adjust data. Most of the functionality in Cobalt is about editing. Here is where basic data is edited.

Groups

- Channels, intensities and text is edited in the Groups list. See Groups - List.

Presets

- Intensities, text and FCB timing data are edited in the Preset List. See Preset - List.
- Attributes and individual attribute times are edited in the Preset Attribute editor. See Device Views - Presets.

Sequences

- Presets, In/Out/Delay/Wait times, text, Attribute Move, Time Code, Macros and Notes are edited in the Sequence editor. See Sequences - Sequence List.
- Channel Times are edited in the Channel Time editor. See Sequences - Times.
- Master Links are edited in the Master Link editor. See Sequences - Links.
- General playback mode (Sequence/Chase) and chase parameters are set in the Sequences list. See Sequences - List.

Additional editing features

- It's possible to track and edit intensities and parameters in a lot of different ways with the Track function. See Track - Track Editing.
- To edit channel intensities in the main playback there is a Channel Editor Wizard. See Presets - Channel Editor Wizard.
Troubleshooting

When you run into a problem with this system there are few probable reasons (system hardware, system software, operating issue, surrounding equipment).

You may find the answer here, if not, ETC has 24/7 support >>

This chapter contains the following sections

- Troubleshooting - FAQ
- Troubleshooting - Crashes & Bugs
- Troubleshooting - Reset
- Troubleshooting - Help from ETC Technical Services
Troubleshooting - FAQ

Here are some situations that you may run into. If these don't solve the issue, contact support at ETC Technical Services 24/7.

Troubleshooting - Console Keys do not respond

<table>
<thead>
<tr>
<th>Console is not responding to key presses</th>
</tr>
</thead>
</table>

If a key gets mechanically stuck it will seem like the console is not responding - however mouse and keyboard will still work.

- Try pressing ESC twice and test again.

Troubleshooting - Lights Are Not Responding

<table>
<thead>
<tr>
<th>Lights (dimmers, devices) are connected and they are not responding.</th>
</tr>
</thead>
</table>

- Have you reset the console properly? See Reset the system.
- Is the device powered properly?
- Is the device set to receive the protocol you have set the board to transmit?
- Is the device receiving a signal from the console?
- Is the device set to the right channel address?
- Is there a light source connected to the device?
- Is it a lamp failure?
- Is the device circuit breaker thrown?

If nothing works you may want to use a DMX tester to check that there is DMX at the receiving devices.

Troubleshooting - Flickers

<table>
<thead>
<tr>
<th>A Dimmer/device with start address below ~200 flickers or drops out at semi-regular intervals.</th>
</tr>
</thead>
</table>

- Turn off RDM at the DMX port it is plugged into using system settings/GCE.
  If this stops flicker then device is not fully compliant with the DMX spec, inform supplier so they can fix.
• Check termination by connecting device directly to a DMX output with no other devices connected.

Troubleshooting - External Touchscreen

Touching one selects something on the other screen.

Touchscreens can't match the touch and screen automatically, they have to be told which is which.

• Recalibrate and ensure to select the right screen.
Troubleshooting - Crashes & Bugs

All software-based products run the risk of a crash regardless of testing procedures. In the unlikely event it happens, please help us to eliminate problems with crashes and bugs by reporting them to us.

To make it easier and faster to solve problems with the Cobalt software, it is important that problems are reported in a proper and complete way.

First, it is important to define what a Crash means. To a developer, a crash means that the application crashes with some kind of error message. Most crashes can be intercepted to make it possible to save play data and to present a proper crash message. These are known as "handled crashes". Handled crashes produce an error message and also produce what is known as a "Dump file" containing important information about the console state when the crash occurred. In addition, a "Recovery File" is produced and is offered on a restart so that you can recover any data you programmed but had not saved before the crash.

When you have restarted, please connect your USB stick to the console and use the BROWSER>FILES>COPY LOG AND DUMP FILES TO USB command to copy a ".zip" archive of a number of files to that USB stick. Please email that ".zip" file, a copy of your play file and a detailed description of what you were doing at the time of the crash to cobalt@etcconnect.com.

If the application hangs or misbehaves, this is not regarded as a crash (it may still be a serious problem however).

- If the application seems to hang, please check the following things:
  - Was the hour glass constantly on in the upper corner? If so, this is a real hang-up. The system should only be in this state for 30 seconds before a log file is created. Please follow the directions above to send the log file to us.
  - Does anything work? Mouse, keyboard, some buttons etc? If an external keyboard is connected, is anything pressing down a key like a script or a headset?
  - Was it possible to press ESC to unlock this state? (It is possible, in some very special situations, that a key could be "forgotten" in the down state, which blocks other keys. ESC should always fix this.)
  - Does it say "Keyboard override" in the upper right corner? If so, there is probably a text cell open for editing somewhere on screen.

Is there a focused tab (with the orange frame)? In rare situations the focus gets lost, meaning there is no tab focused, which can be confusing since some things don't do what you expect. If there is no focused tab, click on one using the mouse or trackball or enter a tab number and press TAB.

If you need to report a problem, please try to include as much information you can about:

- the software version number
- the configuration (standalone, server/backup, other connected devices on the network, etc)
- the situation the problem occurred in (what did the user do when it happened, open editors, special conditions etc)
- any other information that you think could be useful
If we get this information from the start, it makes it easier for us to provide a fast and professional service.

What to do after a crash?

In most cases your play will have been saved (recover.asc). In this case you got a popup explaining this and returned to the login screen.

- Log in again.

If you don't return to the login screen, which is extremely unlikely you need to restart the console.

- Press Esc if the front panel seems frozen.
- Try resetting the console using the reset button on the back, in the middle.
- If none of these efforts work, contact your local ETC Support.

Making a crash or bug report

If you have the possibility, try to reproduce the problem by repeating your actions. If you can send us a description of how to repeat the problem we are likely to solve it rapidly.

Crash or bug report
Date =
Your Name =
Phone/fax/mail =
Cobalt Software version = "4.1" (bottom left corner of the main screen, or About Cobalt in the Browser)

Description (example):

1. I was trying to edit a Preset on stage.
2. I started a crossfade
3. I got a crash with a message = "FILE main.cpp LINE 37" or "Offset: 12345678"
4. It is repeatable following 1 & 2.

Please fax the bugs reports to Cobalt BUG REPORT at +49 8024 990-300 or preferably e-mail them to Cobalt@etcconnect.com

An Error Popup Appears - copy log

If you get an error popup we have saved your show data and created two files (log and dmp) that can be saved to a USB memory if there is one connected to the console.

Mail these file to us. It can help us solve your problem very fast.

1. Make sure there is a USB memory in one of the USB slots.
2. Open the Browser and select "Copy Log files to USB"

3. Mail both files (log & dmp) to Cobalt@etcconnect.com

NOTE
This has to be done directly. The dmp file is a temporary file that will be overwritten if anything happens later. BOTH files are needed to solve the problem. Thank you for your help.
Troubleshooting - Reset

There is a hard power switch in the back of the console and a soft power switch in the top right corner of the frontpanel.

To make a soft reset, hold the power key in the top right corner of the frontpanel for five seconds.

In order to reset the console completely, turn off the power, count to five and then turn back on.
Troubleshooting - Help from ETC Technical Services

Emergency service is available from all ETC offices outside of normal business hours.

If you are having difficulties, your most convenient resources are the references given in this manual and the Help system. To search more widely, try the ETC website at www.etcconnect.com/community. If none of these resources is sufficient, contact ETC Technical Services directly at one of the offices identified below.

When calling for help, please have the following information handy

- Console model and serial number (located on back panel)
- Software version (is located beneath the Cobalt logo on Screen 1)
- Dimmer manufacturer and installation type
- Moving light information (manufacturer, mode, data cable type)
- Other components in your system (Unison®, other consoles, etc.)

ETC Technical Services - United Kingdom

Electronic Theatre Controls Ltd.
Technical Services Department
26-28, Victoria Industrial Estate
Victoria Road, London W3 6UU
England
Tel: +44 (0)20 8896 1000
service@etceurope.com

ETC Technical Services - Americas

Electronic Theatre Controls Inc.
Technical Services Department
3031 Pleasant View Road
Middleton, WI 53562
800-775-4382 (USA, toll-free)
+1-608 831-4116
service@etcconnect.com

ETC Technical Services - Asia

Electronic Theatre Controls Asia, Ltd
Technical Services Department
Room 1801, 18/F, Tower I
Enterprise Square
9 Sheung Yuet Road
Kowloon Bay, Kowloon, Hong Kong
+852 2799 1220
service@etcasia.com

ETC Technical Services - Germany

Electronic Theatre Controls GmbH
Technical Services Department
Ohmstrasse 3
83607 Holzkirchen, Germany
+49 (80 24) 47 00-0
techserv-hoki@etcconnect.com
GENERAL FUNCTIONS

These are important functions that apply in general and don't belong to a specific chapter or node of the Browser.

These are the chapters

- Cobalt Console Facepanel
- Cobalt Screens
- Power up procedure
- Output Control
- Copy, Cut & Paste
- Entering Texts
- Display Lists
- Mute & Solo
- Lock Console
- Direct Selects
- Cleaning The Cobalt Console
Cobalt Console Facepanel

1. Touch Screens
2. Independents
3. Power & USB slot
4. Screen Keys
5. Device control
6. Output control
7. Master playbacks
8. Programming section
9. Main playback
Programming Section

This is where most of the programming is done. Numerical entries, opening editors, recording and setting times. Some of the areas are grouped by functionality and sometimes referred to in this help system.

1. Play objects
2. Core editing keys often used in combination with other keys (MODIFY, ESC, INSERT, DETELE and arrow keys)
3. Screen navigation (in combination with the arrow keys)
4. Time functions
5. Channel and level entries
6. Level wheel
7. Live and Blind fields and screen formatting (in combination with arrow keys and level wheel)
**Cobalt Screens (8.0)**

Cobalt systems can support three external monitors/touch screens besides the two built in touch screens.
In addition to this each section of five master playbacks share a smaller touch screen.

Screens can be navigated with tap and gestures, mouse and console keys.

- A status bar is available at the top of all screens.
- All screens can have a multi-section layout containing tabs.

**Screen Functions (8.0)**

Screens can be set up any way you want. These are some basic functions.

**Screen 1**

1. Server status, Play name
2. Status area for temporary modes that affect output
3. Volume, screen and direct buttons for console mimic, layouts and the Browser
4. A tab area
5. Tab information area
6. Info area about selected tab or channel
7. **Soft key pages**
8. A screen split from the layout tool
9. Software version
10. Numerical input
11. Level of currently selected channel
12. Channel control - which field channels are controlled in currently
13. Record target
14. Message field for system warnings/information
15. Output status indications

**Soft Key Pages**

In the right side of screen 2 (screen 1 in software versions) there are soft keys.

![Soft Key Page Diagram]

This is the top level.
The back arrow will bring you one level back "up" to the top level, from wherever you are.
The Browser

Press BROWSER to select the Browser dock.

The Browser dock gives you direct access to all functions and data in Cobalt.
Browser Controls

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the Browser</td>
<td>[BROWSER]</td>
<td>The Browser is focused. Press again to close or open it.</td>
</tr>
<tr>
<td>Move up/down in a list</td>
<td>[Arrow Keys]</td>
<td>Up and down arrows move in all open lists.</td>
</tr>
<tr>
<td>Open a sublist</td>
<td>[Right Arrow]</td>
<td>The right arrow opens a sublist under a closed node.</td>
</tr>
<tr>
<td>Jump to top sublist</td>
<td>[Left Arrow]</td>
<td>The left arrow jumps to the top of a sublist, and closes that node if pressed again.</td>
</tr>
<tr>
<td>Open an editor</td>
<td>[MODIFY]</td>
<td>Opens the editor of the object selected in the Browser.</td>
</tr>
<tr>
<td>Collapse the Browser</td>
<td>C/Alt &amp; [BROWSER]</td>
<td>All open nodes are collapsed.</td>
</tr>
<tr>
<td>Open Context menu</td>
<td>[SELECT]</td>
<td>Opens the context menu</td>
</tr>
<tr>
<td>Track item</td>
<td>[TRACK]</td>
<td>Tracks the selected preset or palette in the Sequence loaded to the Main Playback.</td>
</tr>
</tbody>
</table>
Browser Functions - LOAD

Use MODIFY and LOAD to activate selected items from the lists in the Browser. This key is only in Congo Sr, Jr and Kid. It can be assigned to a Magic Sheet or master.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open an editor</td>
<td>MODIFY</td>
<td>Opens the editor of the object selected in the Browser.</td>
</tr>
<tr>
<td>Activate a palette</td>
<td>LOAD</td>
<td>Activates palette # for the selected channel(s).</td>
</tr>
<tr>
<td>Load a Group</td>
<td>LOAD</td>
<td>Loads the selected Group to the active Channel View.</td>
</tr>
<tr>
<td>Load a sequence to the main playback</td>
<td>LOAD</td>
<td>Loads the selected sequence to the Main Playback*</td>
</tr>
<tr>
<td>Load a Preset to the active channel view</td>
<td>LOAD</td>
<td>Loads the selected Preset</td>
</tr>
<tr>
<td>Load a Group to a master</td>
<td>LOAD &amp; Master_key</td>
<td>Loads the selected Group to a master.</td>
</tr>
<tr>
<td>Load a sequence to a master</td>
<td>LOAD &amp; Master_key</td>
<td>Loads the selected sequence to a master.</td>
</tr>
</tbody>
</table>

*Its possible to expand items like Sequences to see linked information for each step, and to open the corresponding editor by pressing MODIFY.
Tabs (8.0)

Press TAB to select and step through all open tabs in all screens.

All data and editors are opened in a tab. Tabs are opened in the currently selected screen section. You can split a screen into different sections from the screen section function in the top right corner of a screen. Two tabs are default locked from being closed: LIVE and MAIN PLAYBACK.

When you press the "+" sign in the top left corner of every screen section you will get the Tab Selector.
1. Tab header
   - Touch a tab to activate.
   - Every tab is assigned a number when opened. # TAB selects this tab.

2. Tab header context menu
   - Open (new) tab
   - Maximize tab
   - Setup tab
   - Tab help
3. Tab Parameter Setup (depends on tab)

- Include Channel View in Pool: See Live - Live Tab.
- Lock tab from closing (See Tab Setup & Lock)

Auto close tab mode

In Cobalt Console Settings you can activate a mode that will close the previous tab when a new tab is opened, to keep down the number of tabs at all times.

See Console Settings..

Navigating The Tabs with console keys

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toggle open tabs</td>
<td>TAB</td>
<td>Steps through all open tabs in all screens</td>
</tr>
<tr>
<td>Select Tab #</td>
<td># TAB</td>
<td>Selects the tab with that number</td>
</tr>
<tr>
<td>Move</td>
<td>TAB &amp; Right Arrow TAB &amp; Left Arrow</td>
<td>Moves the selected tab to another screen or screen section in a split screen view.</td>
</tr>
<tr>
<td>Close</td>
<td>ESC</td>
<td>Closes any selected tab except Live, Playback and those locked.</td>
</tr>
<tr>
<td>Reset all</td>
<td>C/Alt &amp; TAB</td>
<td>Closes all tabs except Live, Playback and locked.</td>
</tr>
<tr>
<td>Reset all (including locked)</td>
<td>C/Alt &amp; TAB</td>
<td>Resets to default screen layout.</td>
</tr>
</tbody>
</table>
Tab Setup and Lock

It is possible to lock a tab from closing when you press ESC.

- Hold SETUP and press TAB to open.

Include Channel View in Pool refers only to Live Views. See Live - Live Tab.

Split/Full Screen

Tabs are opened in the currently selected screen section. You can split a screen into different sections from the screen section function in the top right corner of a screen.
**Tab - Console Mimic**

The Console Mimic dock gives you the user interface of the physical console.

Symbol in the Tab Selector:

- Click on a button or fader to press or move. Pressed button is indicated with a yellow background.
- Hold CTRL and click on a button to "hold" it so you can press another button after. Please note that this is not the same as holding CTRL and pressing a key in a keyboard - since CTRL is used as a shift key there.
- Combine the Console Mimic and keyboard or console commands, for example hold RECORD and press a Direct Select button.
- Hold FORMAT and use the level (or mouse) wheel to zoom.

**NOTE**

Important Limitation - because the mimics are within Cobalt, when dialog boxes open on top of Cobalt all other Cobalt controls are unavailable, including the console mimic. For data entry and navigation of dialogs, physical console keys, alpha keyboard/mouse or an attached X-Keys panel must be used.
Tab - Designer Summary

The designer summary provides playback information at a glance that is intended to be useful for the lighting designer.

Symbol in the Tab Selector:

There are three formats that can be toggled with the FORMAT key or context menu:

- Main playback & selected (channels)
- Selected (channels)
- Main playback

1. Main Playback

- Palette information for A or B depending on what is selected in the Crossfade Settings, see Play Settings - Crossfade. The Palette section only shows palette info for palettes that have been executed by the main playback, as part of the sequence. The box to the left indicates with Red background in the playback info block that a crossfade is running.
- The number of Devices in the next fade
- The total duration of the step in A or B, plus In/Out/Delay times for intensity and Focus, Color, Beam.
- Timecode in and the next timecode step.
- Recording mode for moving devices
- If times are set to A or B
2. Selected

- Active palettes
- Channel database texts
- Dimmers address, curves and device address (single channels only)
- The previous level
- The current level
- A command line view of the last key presses
**Tab - Selected Live**

The Selected Live tab shows all currently selected channels and effect playbacks. This is the view that will show effect playbacks and channels together.

Symbol in the Tab Selector:
**Tab - Master View**

The Master View shows all masters. You can view and select masters, set levels and drag channels and presets to them. See [Master View](#).

Symbol in the Tab Selector
Tab - Time Code

The Time Code tab provides a summary of the important time code features and information.

Symbol in the Tab Selector

To the right, use the screen buttons to select **Internal** or **External** time code source.

Enable BU (BackUp) clock will set the internal clock to take over if the external source is lost.

**Console Time code Settings**

- LEARN activates learn mode. See [MIDI - Time Code](#)
- Auto Locate activates auto location. See [MIDI - Time Code](#)
Tab - Device Controls Tab

As soon as a device is selected, all non-intensity parameters are available in the Device Controls. In the ALL tab parameter values will be fetched from the first device in the selection that has such a parameter defined. This works both for decimal channels where the parameter values of the sub channels are shown when the the whole channel is selection. It also works when selecting different types of devices at the same time.

Symbol in the Tab Selector

Mouse: left-click and drag to change values of a parameter, or enter a numerical value and click. Touch screen: touch and drag to change values of a parameter, or enter a numerical value and touch.

Device Controls Tabs

The Device Controls tab contains tabs that offer controls for the raw parameters of devices or effects and tabs that contain “virtual” controls that affect the output of devices through tools designed to make controlling things like color mixing systems easier or more consistent.

Raw control

- All parameters
- Focus
• Color
• Beam
• U1, U2, U3

Virtual control

• Color Mixing tab
• Gel Picker

NOTE
When more than one device is selected, all parameters are displayed for all selected devices. You can use Next/Last to access individual parameters within the current selection.
(See Channels - Next & Last Mode)

Parameters tabs: All, Focus, Color, Beam, U1, U2, U3

The F/C/B and U1-U3 tabs mimic the mapping of the physical encoders on Cobalt consoles, but can display all of the parameters in a category on one screen simultaneously. The F/C/B tabs display parameters assigned to each of those categories and the U1-U3 pages show parameters in a user defined order.
(See Device Control - U1-U2-U3)

The All tab shows all the raw parameters of the selected device(s) or effect playbacks in one screen simultaneously, grouped by parameter category.

Virtual controls tabs: ColorMixer and GelPicker

The Color Mixer tab includes controls that are routed through a generic Hue-Saturation color space so that devices with differing color mixing systems can be controlled simultaneously, or so that fixtures with color systems including more than RGB or CMY can be controlled more easily.
The color wheel indicates the current setting of the selected device channel or the first channel in a grouping. Some of the fixture templates within the Cobalt library also include color calibration data. In this case, a black line is drawn on the color wheel when that device is selected. This line indicates the valid color space for the fixture type. Colors outside of the black line are not achievable by the color mixing system of that device.

The Hue and Saturation controls will move the dot in the color wheel either around the wheel from one color to the next (Hue) or along the radius of the wheel where the dot is currently located (Saturation).

The closer the dot gets to the center of the circle, the closer to white the color system is moving – approaching a saturation of zero. Away from center indicates deeper color – approaching full saturation.

The RGB and CMY Saturation controls allow you to adjust the color by adding or decreasing the amount of a color area within the Hue/Sat space. As you move around the wheel, the RGB and CMY controls will indicate equivalent mixes for those two color spaces.

In the image below, you see a patched Source Four LED Lustr+ with a 7-color mixing system selected with the Mac300 device with a CMY mixing system. Both channels are selected at the same time and when you make adjustments within the tab, both devices will react to create a similar color. In the screen below you can see both lights are set to a light cyan color. In the CMY saturation tools, this color contains no magenta at all.

As an example, if we increase the level of magenta saturation, both fixtures will shift to a more purple color in output, and the other color saturation handles will adjust to reflect the new mixed color. The dot on the color wheel will also move to the new color position. All of the controls in this tab are interconnected and will move as you change the colors.

You can see that the color mixing systems of the two devices are very different, but they are adjusted by Cobalt to create the desired color automatically. Raising the Red Saturation control could perform a number of different adjustments - increasing the red circuit in an RGB system, or increasing both Magenta and Yellow in a CMY system, for example. The virtual tools allow you to mix colors without having to work in all the native color spaces of the devices in your rig.

Please note, if you have devices that have been calibrated, it may not be possible to drag the RGB/CMY Saturation controls to “full”, depending on the current color mix of the device(s). As you
can see in the images above, the selected device cannot create colors at the very edges of the color wheel. The color wheel is showing its concept of “full saturation” for all colors. If a device cannot create that saturation level of a color, the adjustment handles will stop at the maximum saturation that light can create. The maximum saturation level may be different depending on the other colors in the mix.

Also, it is possible that devices may be able to create colors using raw controls that the generalized HueSaturation system won’t allow. If you want to control the raw parameters of the fixtures, please use the Color tab instead.

THE GEL PICKER
The GelPicker tab includes buttons that correspond to the color filter manufacturers in the Cobalt library. To use this tab, simply type the number of the color filter you want and then press the manufacturer button to apply it.

There is also a GelPicker tab in the Browser (Browser>Devices) that includes all manufacturers/gel numbers in one spreadsheet view with a color chip for each color. (See Gel Picker)
**Tab - Direct Selects (DS)**

The Direct Select Tab gives you fast direct access to all kinds of show content in four user definable matrix sections.

Symbol in the Tab Selector

The Direct Selects tab contains sets of buttons that can be assigned provide direct access to a number of different data types:

- record targets, like groups and palettes
- parameter ranges for devices, like color wheels, gobo wheels, strobe, etc.
- recall objects, like screen layouts, sections and masks
- control handles, like channels, masters and effects

The Direct Select tab

1. Tap to select User Page 1-5 of Direct Selects.
2. The Special Functions allow you to record data directly, and set the current selection to 0/Mark/Full/Home and deselet. (See Cobalt Direct Selects - Special Functions)
3. Toggle to full screen mode.
4. The quick jump buttons display the types of data assigned to each of the direct select blocks, and allow you to pull a block of direct selects to the top of the tab quickly. Each block can be
configured independently for type, number of rows displayed, and which bank/page is currently displayed.

5. Select type of content in each block. (See Cobalt Direct Selects - Types of Data)
6. Arrange functions for copying and moving items. See also Add/Replace.
7. Select Bank. (See Cobalt Direct Selects - Bank and Page)
8. Select Page. (See Cobalt Direct Selects - Bank and Page)
9. Tap the Rows+ button to increase the number of buttons displayed up to 5 rows/50 buttons. Tap once more to return to 2 rows/20 buttons.
10. Tap the Matrix button to access the 10x10 view. Tap the Rows+ button to return to the normal view.
11. The blocks of direct select buttons may be displayed with 2, 3, 4 or 5 rows of 10 buttons each, or as a full 10x10 matrix.

Full mode

Cobalt Direct Selects - Types of Data

Every Direct Select block can be set to contain the following types of data by pressing TYPE.
Focus, Color, Beam and All palettes
Tap a palette button to activate this palette for the selected channels.
(See Device Palettes)

Group
Tap a Group to select the channels of this group. Groups that are selected are flagged as yellow, meaning all channels of this group are selected. Orange means that only some channels are selected. White means no channels in this group are selected.
(See Groups)

Auto Group
Tap an Auto Group to select the channels of this group. Auto Groups are automatically created from types of templates in the Device Patch and labels in the Channel Database.
(See Auto Groups)

PresetSel
Tap the preset number in a DS button to select the channels with intensity in that preset. This allows you to use presets as groups for channel selection. The numbers and labels of recorded presets will be displayed in numerical order.
(See Preset List).

Channel
Tap a channel to select or add/subtract to the current selection. Double tap to select and clear the previous selection. Hold finger and slide to change level. This set of buttons will display the channel name and leave empty buttons if channels have been renamed to zero. This is to keep the panel logical and to allow you to find channel numbers easily.
(See Channels)

Effect
Tap an effect to select or add/subtract to the current selection. Double tap to select and clear the previous selection. Hold finger and slide to change level. Displays all effect playbacks created in this play.
(See Effect Playbacks)

Level
Tap to set a pre-defined intensity levels in steps of 5% to the currently selected channel(s) and/or effect(s).

Parameter
Tap to select a parameter to set a value. Use this setting to assign a parameter with ranges to the DS block. To set the data type properly, first select a channel with the desired parameter name and find the encoder page containing that parameter. Then set the DS block to the Parameter type, and then press the wheel key for that parameter. As channels are selected that have ranges on that parameter name, these range names will populate the DS buttons live.

Gels
Type a gel number then tap the manufacturer DS button to apply that gel to selected device channels with color mixing systems.
(See Gel Picker)
Mask
Tap to apply a recorded parameter mask state to the console.
(See Mask)

Section
Tap to jump to a section marker within the sequence on the main playback.
(See Sections)

Master
Tap the master button and without lifting your finger, slide your finger up and down to adjust the output level of that master. Use the direct select keys like master faders, especially useful with Cobalt Nomad or when you want to adjust a master you don’t currently have assigned to a fader.
(See Masters)

Screen
Tap so activate any recorded Screen setting.
(See Screens)

Client
Tap to enable/disable connected clients. Displays connected clients.

Cobalt Direct Selects - Special Functions

Along the top of the DS tab there are some special function keys.

RecordDS
Allows you to record DS types directly within the DS tab. Select the Type of direct select you wish to record, press RecordDS and then press the DS button you want to store to.

0%, Mark, Full
These are buttons to quickly set intensity levels to selected channels directly from the DS tab. For additional intensity levels, use a DS block with the data type “Level”.

HomeAll
This button when double-tapped will send selected device channels to their default levels, as defined in the fixture templates or as recorded to the HOME ATTRIB key.

ClearSel
Deselects all currently selected channels/effects/masters.
Cobalt Direct Selects - Bank and Page

Every block of direct selects can be arranged by bank and page within this bank.

Bank
Sets the block of direct selects to a range of that data type, based on the current number of buttons displayed multiplied by five pages. For example, with 20 buttons displayed, a bank equals 100 possible objects. With 50 buttons displayed, a bank equals 250 objects. The bank is subdivided into pages for quick access to additional objects.

Page
One fifth of a bank. Used for quick access to additional objects when you don’t want to use large portions of the screen for direct selects of a given type. The page buttons indicate the data object numbers – so when a Page buttons shows “Page 51-100” it indicates that you are jumping to show groups (or whatever data type) 51-100.

Cobalt Direct Selects - Arrange, Copy/Move/Delete/Text

Arrange mode is supported for Palettes, Groups and Action Macros.

For a DS block with Palette/Group/Action Macro content, the Arrange button is shown.

1. Press it to enter selection mode where you pick the source items.
2. When there are items selected, the Copy and Move buttons will be active and can be pressed to specify a target. If there are conflicts, a warning dialog is presented. TEXT opens a text dialogue and DELETE a delete dialogue. You cannot add text labels to unrecorded item.

On Move, Palette references in presets will be updated to refer to the new palette number. Group references in effects will be updated.

You will stay in arrange mode until Arrange is pressed again, to exit.
Cobalt Direct Selects - Add/Replace

For Groups there are two modes

- Add - every new group that is selected is added to or subtracted from the previous selection
- Replace - every new group that is selected will replace all previous selections

Holding CH or ALL in combination with a DS-group or palette to select included or active channels will follow ADD/REPLACE.

Cobalt Direct Selects - Console Keys in Combination

A number of physical console buttons can be pressed in combination with DS tab buttons.

- UPDATE - to update Palettes
- RECORD - to record Palettes and Groups
- CH - Hold CH and press a Palette or Group to select all channels involved
- ALL - Hold ALL and press a Palette or Group to select all channels involved with a level above 0%
- TEXT - Hold TEXT and press a DS item to overwrite the text
- DELETE - Hold DELETE and press a DS item to delete

CH/ALL will follow Add/Replace mode

Cobalt Direct Selects - Direct Mode

One of the very fast and unique functions of Cobalt. A large number of keys can be held to enter temporary Direct Mode for the Direct Selects. As long as the key is held it is possible to access the first forty items belonging to this key category.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Activate Direct Mode</td>
<td>Hold a function key (see below)</td>
<td>Direct Select display shows all recorded</td>
</tr>
<tr>
<td>2. Select Direct Select screen key (1-40) OR Direct Select key 1-10 in Congo Jr/Kid</td>
<td>Direct Select key</td>
<td>When the key is pressed that item is activated.</td>
</tr>
</tbody>
</table>
### Keys that enter Direct Mode when held

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>FOCUS</td>
<td>Focus Palettes.</td>
</tr>
<tr>
<td>COLOR</td>
<td>Color Palettes.</td>
</tr>
<tr>
<td>BEAM</td>
<td>Beam Palettes.</td>
</tr>
<tr>
<td>PALETTE</td>
<td>All Palettes.</td>
</tr>
<tr>
<td>Wheel Parameter</td>
<td>Any wheel parameter can be pressed to get direct access to all range positions. This includes scrollers. Including range tables</td>
</tr>
</tbody>
</table>
Tab - Beat Boss

Beat Boss is a master tempo that can be set to any chase or content effect with an individual rate.

Symbol in the Tab Selector

![Beat Boss](image)

There is a Beat Boss tab with 9 Beat Bosses. The BPM is set to 120 at 50%, 240 at the top and 0 at the bottom.

A master can be set to control a Beat Boss. The slider function will change the value, the top key can be used to set a specific value or to tap a specific BPM. See Masters - Beat Boss.
Beat Boss List

There is a list of beat bosses in Browser/Effects (Browser>Effects>Beat Bosses) where a descriptive name can be given.
**Tab - Help**

You can open a Help Tab from the Tab Selector (from the + sign) or by pressing HELP (?).

Symbol in the Tab Selector

There are two auto-help modes.

- If “Follow Keys” is active, pressing buttons will update the help using the normal help topic names.
- If “Follow Screen” is active, help will update when new tabs are opened or existing tabs are focused.
**Tab - Direct Selects Flow (8.1)**

The Direct Selects Flow Tab gives you the same information and functions as the Direct Select tab, with the only difference that there is only one type of data, and the screen will reflow at all times to fit the width of the current tab. See Tab - Direct Selects.

Symbol in the Tab Selector

Click on the cog wheel to choose packed/unpacked format.

The tab for each instance remember

- content type
- packed mode
- zoom level
**Tab - Color Picker (8.2)**

The color picker can be opened from the Home Screen or by using TAB.

With the color picker open, you have the choice between six different Color Spaces, a Gel Picker and Spectrum Tools.

These options are found by clicking on the display configuration tool (PANELS) in the upper right corner of the color picker display.

**NOTE**
The color and gel pickers are based on using a 5000K (daylight) source.

**Color Picker - Color spaces (8.2)**

There are six color spaces that you can choose to work in. All of these spaces are connected. So it doesn't matter which space you wish to work in, the console will translate the information to work with your fixtures.

When the color picker is first opened, the CIE xy color space and the gel picker will open by default. You can select other color spaces and tools by clicking on the display configuration tool (PANELS) in the upper right corner of the color picker display.

**NOTE**
Multiple color picker tabs with different color spaces can be opened at the same time. Multiple color spaces can be opened on the same tab.
The available color spaces are:

For the CIE xy (CIE 1931) and CIE uv (CIE 1976), the triangle represents the RGB space as defined by the PLASA standard E1.54. Fixtures that comply to that standard can achieve any color within the triangle. The cone represents the color spectrum that we can see.

**Color Picker - Controls (8.2)**

Each color space has three virtual encoders, a vertical encoder with a {?] button, and a "brightest version" button (with an arrow) at the top of the vertical encoder.

The encoders will change based on the color space selected. Double tapping in a virtual encoder will cause it to jump to the location of your finger.
Tapping anywhere in the color space will cause the crosshair to move to that location. Press and hold, then move your finger to fade the crosshair toward that location.

The button at the top of the vertical encoder will create the brightest version of the selected color. Press the {?} button to display labels on all of the controls.

For the RGB and CMY color spaces, you can change which color control is on the vertical encoder. Touch the label of the virtual encoder to change which color control is located on the vertical encoder. In the following graphics, Red is on the vertical encoder in the first one and green is on the vertical encoder in the second one. This is also indicated by the highlighted encoder name.

For the HS Wheel the vertical encoder is always brightness. For the HSB color space, you can change the vertical encoder between Hue, Saturation, and Brightness.
Color Picker - Gel Picker (8.2)

When the gel picker is opened up with a CIE xy, CIE uv, and/or HS Wheel, dots will display on the color space. These dots represent the gels in the currently selected gel book. Hovering over a dot with a mouse will display the gel's name and a color swatch.

**NOTE**
Gel dots will be hidden when the view is too small to show them properly.

The following buttons are also available:

[SORT HUE] - takes the selected gel library and sorts it by hue instead of by gel number.
[SIMILAR] - will show gels that are in the same selected area of the color picker.
[NONE] - deselects all selected gels.
[STANDARD COLORS] - shows a range of White Point from 2700K to 6500K. Also shown are colors located around the E1.54 RGB space triangle and variations of those colors at 25% increments.

Color Picker - Spectrum Tools (8.2)

The Spectrum option is found by clicking on PANEL in the upper right corner of the color picker display.

This option displays all the color parameters across the color spectrum, and allows for individual control of each parameter. Press a color point to move it.

This display is a good visual of what the fixture is outputting.

The following screenshots show a 7 color fixture. This display will change based on the type of fixture being used.
NOTE
The grey line shows the composite color of the fixture. If multiple fixtures are selected, the grey line represents the first channel selected.

With the Gel Picker open and a gel selected, a dotted line will appear in the Spectrum display. That line represents the selected gel. Click on the X next to the label to remove the dotted line.

Clicking on HOLD COLOR POINT allows you to adjust individual emitters and to create a new metamer while the other emitters will automatically adjust to hold the color selected. This can only be used with fixtures that have more than three color parameters.


**Color Picker - Tinting Tools (8.2)**

In the Tint panel, you are able to control various aspects of the color with +/- buttons.

The Tinting Tools option is found by clicking on PANELS in the top right corner of a Color Picker tab.

Tint allows you to easily adjust color regardless of the color space that you're working in.

You can increase or decrease the saturation and brightness. You can make a color warmer or cooler, and you can add or remove colors.

![Tinting Tools](image)
Editors And Lists

Most editors are lists. Some have a channel view on top that works just like any channel view. The list part works pretty much like a standard spreadsheet application.

1. Channel view on top
2. List
3. Hints about functions for the currently selected cell

You can

- edit all cells (except those that are dimmed)
- select and edit multiple cells at the same time
- sort information by column
- move columns around
- resize a list by dragging the divider, or holding COLUMN and using the level wheel
**Navigating In Lists**

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step or scroll around</td>
<td>Arrows and wheel</td>
<td>Use arrow keys, or hold an arrow key and use the level wheel to speed scroll in any direction</td>
</tr>
</tbody>
</table>

**Editing In Lists**

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit the selected cells</td>
<td>MODIFY</td>
<td>Entering a value and press MODIFY. If it is a dropdown just press MODIFY. If it is a text cell, press MODIFY, enter a text and press MODIFY to exit.</td>
</tr>
<tr>
<td>Insert a new item</td>
<td>INSERT</td>
<td>Inserts a new item with the next free number. If you enter a number first, the inserted item will have that number.</td>
</tr>
<tr>
<td>Delete selected item(s)</td>
<td>DELETE</td>
<td>Deletes the selected items (cannot be undone).</td>
</tr>
<tr>
<td>Select all items in a column</td>
<td>COLUMN</td>
<td>Selects all cells in a column from the current cell down.*</td>
</tr>
<tr>
<td>Select multiple cells</td>
<td>SELECT &amp; Arrow keys</td>
<td>Hold Select and use Right and Down arrows to select multiple cells.*</td>
</tr>
<tr>
<td>Select multiple cells in any column or order</td>
<td>CTRL and Click (Keyboard &amp; trackball)</td>
<td>Hold CTRL and use the cursor to select multiple cells.*</td>
</tr>
</tbody>
</table>

* When you enter a value and press MODIFY it is applied to all selected cells.
## Sort By Column

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort from low to high</td>
<td>COLUMN &amp; Up Arrow</td>
<td>The list is sorted by this column from low to high.*</td>
</tr>
<tr>
<td>Sort from high to low</td>
<td>COLUMN &amp; Down Arrow</td>
<td>The list is sorted by this column from high to low.*</td>
</tr>
</tbody>
</table>

* These changes are temporary, they will be lost if the tab is closed and opened again.

## Change The List View

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move a column</td>
<td>COLUMN &amp; Side Arrows</td>
<td>The selected column is moved left/right depending on which arrow you press*</td>
</tr>
<tr>
<td>Resize a column</td>
<td>COLUMN &amp; Wheel</td>
<td>The column is resized</td>
</tr>
<tr>
<td>Resize the list section</td>
<td>TAB &amp; Wheel</td>
<td>The list section is resized*</td>
</tr>
</tbody>
</table>

* These changes are temporary, they will be lost if the tab is closed and opened again.
**Drag and Drop**

In most places of the Cobalt screen interface you can use a mouse or trackball to drag content to other locations and drop there. This is the same as doing a copy/paste or cut/paste command with key presses.

Please note that there are two options for drag-and-drop editing within Cobalt - editing within the same play and using drag/drop to import data from another play - this can be an older version of the current play to perform UNDO actions, or another play entirely.

Usually there is a dialogue box to allow you a choice of results when dragging and dropping.

**Examples**

- *In the Browser, click and hold a preset in the preset node and drag it to a channel view and drop there to replace the content of that channel view with the preset.*
- *In a Sequence Editor, click and hold a sequence step and drag it to another sequence step and drop there for a dialogue with options of actions (copy/move). See Sequence - drag and drop data.*
- *In a Master View, click and hold the content of one master, then drag and drop to another to move around. See Masters - Drag and Drop Data.*

**Dragging a preset from the Browser to Live**

1. Click, hold and drag a preset from the Browser to Live.
2. Drop over Live - the content in Live will be replaced by the levels of the channels in that Preset.
NOTE
There is no warning, the content of Live will be replaced by the intensity content of the Preset dropped.

Dragging sequence steps

1. Open the main playback Sequence Editor (MODIFY and PLAYBACK).
2. Click, hold and drag a sequence step to another sequence step, then drop.
3. You will now get a dialogue with the following options:

This dialogue allows you to COPY or MOVE the selected step.
COPY = Makes a copy of the source and inserts it into the sequence after the target step.
MOVE = Moves the source and inserts it into the sequence after the target step.

If you select the Advanced tab by pressing left arrow, you get the following options:

The first option allows you to define where you want to copy/move the step to.

- After the target step (default)
- Before the target step
- Replace the target step

The second option "Create Between" allows you to create a new step with a new preset number and insert (after/before).

NOTE
For more info, see: Sequence - drag and drop data.
Drag and Drop - Replacing Data

If you drag a Sequence, Preset or Palette and drop it on another node of the same kind, you will get the option of replacing the node you are dropping data on. This feature works both within the same play and in the Import From Organizer.

![Drop Interface](image)

- **Conflict**: The preset already exists. Overwrite?
- **Source**
  - **Import**: Preset 100.0
  - **Target**
  - **Presets**
Select operation and options

**Conflict:** The preset already exists. Overwrite? [ ]
Renumber preset to 1.0

Source
**Preset 1.0**
Target
Presets
Channels
1 2 8 11 12 3074
Context Menus

Press LOCAL MENU to open a context menu for the focused screen/object.

In most places of the Cobalt screen interface there is a context sensitive menu that offers the functions that apply most to the part of the interface you have focused at the moment.

It can also be opened by pressing SELECT twice, or by right clicking with a mouse or trackball. This works in the following views:

- Channel View
- Attribute View
- Editors
- Browser
- Organizer

Examples

- Press BROWSER to select the Browser. Select any node with the arrows and press SELECT twice to open the appropriate Context Menu.
- Press PRESET to open the Preset List. Select any cell with the arrows and press SELECT twice to open the appropriate Context Menu.
- Working with a mouse? Right-Click to open the Context Menu!
In a Channel View it looks like this:

You can choose any of the functions with the arrow keys and press MODIFY to confirm.

In the Playback tab over a preset it looks like this:
**Dialogues**

All dialogues are opened on the currently focused screen.

Example of the Save New Play dialogue

- To close a dialogue press ESC.
- To change dialogue tab, use the right/left arrows.
- To change settings use the up/down arrows to navigate inside a tab.
- Press MODIFY to open a dropdown menu.
- Enter a number and press MODIFY for numerical entries.
- Press MODIFY to toggle a checkbox option.
- To enter a text, press MODIFY to activate text entry, enter text, press MODIFY to terminate.
## Power-up Procedure

For best performance, power-up your system in the following order.

No output will be sent until the startup show file has been loaded.

<table>
<thead>
<tr>
<th>Action</th>
<th>Hardware</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Turn on external hub(s) or switch(es)</td>
<td>Power switches</td>
<td>The displays will light up with the Cobalt logo. The screens will load the login screen.</td>
</tr>
<tr>
<td>2. Turn on the console and monitor(s)</td>
<td>Power and/or reset switch on console and monitors.</td>
<td></td>
</tr>
<tr>
<td>3. Start the Cobalt software</td>
<td>MODIFY</td>
<td>You can select start option with mouse or console keys (trackball or arrow keys).</td>
</tr>
<tr>
<td>4. Choose starting Play</td>
<td>MODIFY or ESC</td>
<td>A popup will give the choice of the last play (or recovery) or a new play. See New.</td>
</tr>
<tr>
<td>5. Turn on any ETCNet2 Nodes and accessories such as Remote Focus units</td>
<td>Power switches</td>
<td>You should be able to control the outputs now*</td>
</tr>
</tbody>
</table>

*See Console Key - OUTPUT

**NOTE**
In a network with multiple Cobalt Systems online, allow the main system to fully start-up before starting the other systems. This will ensure that your network configures correctly.
Reset The System

When you open a new (empty) Play, you can choose to set the patch 1:1. This chapter is a checklist for resetting the frontpanel and checking the output.

This chapter contains the following sections

- Reset The Console Facepanel
- Check The Output

Before you start, make sure you have loaded a new (empty) Play. See Load a New (empty) Play

Reset The Console Facepanel

To get light you have to make sure the console is reset properly.

Output mode and Grand Master.

<table>
<thead>
<tr>
<th>Action</th>
<th>Console</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Enable output</td>
<td>Set Output Mode Switch to ON</td>
<td>![Feedback Image]</td>
</tr>
<tr>
<td></td>
<td>Set Grand Master to Full.</td>
<td></td>
</tr>
</tbody>
</table>

Main Playback crossfaders (bottom right corner of the console).
Check The Output

After loading a new Play the patch is set 1:1 and the output protocol will be set to DMX512 on both output connectors in the back of the console.

If you enter a number and move the level wheel, a dimmer should respond - providing there is one connected.

If nothing happens, see [Lights Are Not Responding](#).
Output Control

The Grand Master and the three-position switch in the top right corner of the console facepanel offer output control that overrides every output from the console. The "ON" Position in the middle is the default mode for normal operation of the console.

Grand Master

The Grand Master is located in the top right corner of the console facepanel.

<table>
<thead>
<tr>
<th>Console</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grand Master</td>
<td>Will scale the total output of all intensities (only) when below 100%, except channels controlled by the Independents and/or Masters in Exclusive mode. A red Level Indication will appear on the top of all screens.</td>
</tr>
</tbody>
</table>

NOTE
Attributes are not affected by the Grand Master.
B.O. Mode

A Black Out will take out all intensities.

<table>
<thead>
<tr>
<th>Action</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>B.O.</td>
<td>A Black Out of all intensity outputs, except those controlled by the Independents in Exclusive mode. A red B.O. Indication will appear on the top of all screens.</td>
</tr>
</tbody>
</table>

Freeze Mode

When the Output Mode switch is set to FREEZE, the output is "frozen" and will remain static until the switch is set back to ON.

When the switch is set back to ON the output is loaded to the A field of the Main Playback. The Sequence will also reposition to where it was when you activated Freeze.

<table>
<thead>
<tr>
<th>Action</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate Freeze</td>
<td>All outputs will be &quot;frozen&quot;, including moving devices. You can work with all functions without affecting the output*</td>
</tr>
<tr>
<td>Deactivate Freeze</td>
<td>The &quot;frozen&quot; output of Freeze is loaded to the A field of the Main Playback**</td>
</tr>
</tbody>
</table>

*The complete output, including all Master Playbacks is loaded to Freeze.

**If all Masters are down when you exit Freeze, there is no change in the output on stage.

NOTE
If you set the Output mode switch to FREEZE before you start the application, the output will not be updated until you move the switch to on. This makes it possible to start without output and prepare the correct light before activating it on stage.

This is indicated at the top of the screens with the text "FREEZE".
Copy, Cut & Paste

The COPY/CUT and PASTE keys in the programming section are general keys, and can be used to cut and paste for example Sequence Steps, Groups, Presets and Device Templates.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>COPY/CUT</td>
<td>The currently selected object is copied.</td>
</tr>
<tr>
<td>Cut</td>
<td>COPY/CUT</td>
<td>The currently selected object (devices excluded) is cut.</td>
</tr>
<tr>
<td>Paste</td>
<td>PASTE</td>
<td>The last copied or cut object is pasted.</td>
</tr>
</tbody>
</table>

NOTE
When you paste a Sequence step in the Sequence Editor, it will be inserted before the currently focused step.

When you paste a Preset in the Preset Editor, you will overwrite the content of the currently focused preset. This applies to Groups as well.

Texts can be copied with the shortcut CTL-C from a keyboard.

Copy, Cut & Paste Attributes

In the Preset List it's possible to copy, cut and paste attributes for the selected channels from any step to any other step.

1. Open the Preset List.
2. Go to the Attributes Column.
3. Select channel(s) to copy or cut from.
4. Press COPY to copy, press COPY again to CUT (see the confirmation in the message bar at bottom of the screen).
5. Move to the attributes column for the Preset you wish to copy to.
6. Press PASTE

NOTE
Attributes with the value "0" will not be pasted.
# Entering Texts

Almost every item in a Play can be labeled with a text.

The texts are entered from a keyboard, and there is a special TEXT key that can be used to quickly edit the text of a Sequence Step, or a Preset/Group in a Master.

Numbers and decimal point can be entered from the numerical keypad of the console(s).

**IMPORTANT NOTE**

If you have an external keyboard with a NUM LOCK key connected you have to activate NUM LOCK for the numerical keypad in Cobalt to work. This is because the numerical keypad on the external keyboard and Cobalt's keypad are linked.

## The TEXT Key

Press MODIFY in the text cell of a spreadsheet to activate text input, since the keys of an external keyboard otherwise simulate functions keys of the console.

It is also possible to activate text input directly to specific items using the TEXT key in the Programming Section.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preset in A</td>
<td>TEXT</td>
<td>A popup for setting text to the step in A appears.</td>
</tr>
<tr>
<td>Preset in B</td>
<td>TEXT A</td>
<td>A popup for setting text to the step in B appears.</td>
</tr>
<tr>
<td>Preset in B</td>
<td>B</td>
<td></td>
</tr>
<tr>
<td>Master</td>
<td>TEXT A</td>
<td>A popup for setting text to a Preset or Group in Master # appears.</td>
</tr>
<tr>
<td></td>
<td>Master Key</td>
<td></td>
</tr>
<tr>
<td>Cell in a spreadsheet</td>
<td>MODIFY</td>
<td>Text entry is activated for the text cell.</td>
</tr>
</tbody>
</table>

**NOTE**

In keyboard override mode, level and mouse wheels are blocked to prevent unintentional changes.
Mute & Solo

Mute & Solo allow you to treat all Playbacks (masters and Main Playback) as you would in a sound console - being able to temporarily Mute or Solo the content of any Playback.

- Muting a Playback will temporarily stop all output from this Playback without changing data or fader level.
- Soloing a Playback will temporarily mute all Playbacks except this one, without changing data or fader levels.

In effect this is the same functionality that is found in a sound console. It allows you to quickly isolate the lights from any Playback, for editing or for playback purposes.

Mute and Solo are soft keys in the Misc soft keys.

Mute & Solo - MUTE

Mute is a Soft Key.

Hold MUTE and press a Playback key to activate/deactivate.
<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mute a Master playback #</td>
<td>MUTE &amp; Master key</td>
<td>The Muted status is indicated in the Master Display of the console and in the Master View.</td>
</tr>
<tr>
<td>Mute Main Playback</td>
<td>MUTE &amp; PLAYBACK</td>
<td>The Mute status is indicated in the Playback tab.</td>
</tr>
<tr>
<td>Un-mute a Master playback #</td>
<td>MUTE &amp; Master key</td>
<td>The master is no longer muted.</td>
</tr>
<tr>
<td>Un-mute Main Playback</td>
<td>MUTE &amp; PLAYBACK</td>
<td>The main playback is no longer muted.</td>
</tr>
<tr>
<td>Clear all Muted playbacks</td>
<td>C/Alt &amp; MUTE</td>
<td>All Muted Playbacks are reset.</td>
</tr>
</tbody>
</table>

**NOTE**

MUTE will not change any data or fader levels.

In Congo Jr/Kid the MUTE key is a soft key in the Misc Soft Key Page.

---

**Mute & Solo - SOLO**

SOLO is a Soft Key.
Hold SOLO and press a Playback key to activate/deactivate.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solo a Master playback #</td>
<td>SOLO &amp; Master key</td>
<td>The Solo status is indicated in the Master Display of the console and in the Master View.</td>
</tr>
<tr>
<td>Solo Main Playback</td>
<td>SOLO &amp; PLAYBACK</td>
<td>The Solo status is indicated in the Playback tab.</td>
</tr>
<tr>
<td>Un-solo a Master playback #</td>
<td>SOLO &amp; Master key</td>
<td>The master is no longer soloed.</td>
</tr>
<tr>
<td>Un-solo Main Playback</td>
<td>SOLO &amp; PLAYBACK</td>
<td>The main playback is no longer soloed.</td>
</tr>
<tr>
<td>Clear all Soloed playbacks</td>
<td>C/Alt &amp; SOLO</td>
<td>All Soloed playbacks are reset.</td>
</tr>
</tbody>
</table>

**NOTE**
SOLO will not change any data or fader levels.
The keyboard equivalent of SOLO is Alt Y.
In Congo Jr/Kid the SOLO key is a soft key in the [Misc Soft Key Page](#).
Lock Console

Press LOCK in the programming section to lock the console, enter a pin code to lock and unlock.

- SETUP & [LOCK] to setup the PIN code
- ESC & C/ALT locks older Congo consoles

The following mouse actions are blocked

- Screen actions from layouts
- Drag and drop
- Double clicking in editors.
Misc Soft Key Page

The Miscellaneous Soft Key Page is selected with the soft key MISC.
These are the functions
(Solo, Mute and Park are described in the chapters: SOLO, MUTE, PARK)

<table>
<thead>
<tr>
<th>Function</th>
<th>Softkey</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Play back Macro #</td>
<td><code>[#] Macro</code></td>
<td>Macro # is played back. See MACROS.</td>
</tr>
<tr>
<td>Learn Macro #</td>
<td><code>[#] Learn Macro</code></td>
<td>Macro # is recorded. See MACROS.</td>
</tr>
<tr>
<td>Print Screen</td>
<td><code>Print Screen</code></td>
<td>Prints the current screen to a node called PRINTOUTS. See Print.</td>
</tr>
<tr>
<td>Playlist mode</td>
<td><code>Playlist</code></td>
<td>The Playlist is activated. See The Playlist.</td>
</tr>
<tr>
<td>UnPark</td>
<td><code>UnPark</code></td>
<td>Is used in combination with other keys to unpark channel values. See Park.</td>
</tr>
<tr>
<td>Suspend auto-times in Main Playback</td>
<td><code>Modify Seq</code></td>
<td>When on, links and wait/followon times are not activated during playback.</td>
</tr>
<tr>
<td>Remote Control List</td>
<td><code>Remote Ctrs</code></td>
<td>Opens the Remote Control List. See Remotes List.</td>
</tr>
<tr>
<td>Clear all remote levels</td>
<td><code>Clear All Levels</code></td>
<td>Clears all levels set by remotes. See Remote Controls.</td>
</tr>
</tbody>
</table>
Cleaning the Cobalt Console

Do not spray liquids directly onto the screens or console facepanel!

Clean the touch screens with a microfiber cloth or with a lint-free cloth dampened with glass cleaner.

The metal facepanel and wrist rest may be dusted with a microfiber cloth or with a lint-free cloth dampened with glass cleaner. The metal surface of the console has an anodized treatment that is durable and scratch resistant. It will show markings from fingernails, though, if they are scratched along the surface (near the master playback faders, for example). These are surface markings only and are easily wiped away with a microfiber cloth.

It is not recommended to use cleaning cloths that release fibers easily as the fibers may stick to the edges of some of the console keys.
S1-S3 Soft Key Pages (8.1)

The S1-S3 Soft Key Pages are selected with the soft keys S1-S3.

Each page gives you ten user definable console buttons for fast access.

To open the editor for each of the keys, hold SETUP and press S1-S3. Press MODIFY in the Function column for a dropdown to select any of the Cobalt button functions. The settings are stored in the show file separately for each user. See Change user.
About

The About node shows you a summary of the system and a summary of the currently loaded play.

About Node

This chapter contains the following sections:

- About - Cobalt...
- About - Play...
- Demos
- Dimmer/Device Feedback Log
About - Cobalt

About Cobalt shows you a summary of your system configuration - this information is often only used in case of technical support.

SOFTWARE AND OUTPUTS

- **Software Version**: The version and revision of the Cobalt software installed.
- **Qt Library**: Qt is a supporting tool that is used by Cobalt. Only for support.
- **Dongle number**: This is your unique software number that is required when you upgrade your system size.
- **Console Firmware Version**: Shows the version of the Cobalt Sr face panel firmware. Only for support.
- **IO Firmware Version**: Shows the version of the I/O board firmware. Only for support.
- **Channels**: The number of channels your system can run. If your system is downgraded in the System Settings the downgrade number is shown.
- **Outputs**: The number of outputs your system is upgraded to run. The maximum is 6144 (12 DMX universes). Contact your ETC dealer for upgrade information.

ROLE

- **Possible roles**: These are the possible roles your dongle permits: Server, Backup and/or Client.
• **Name**: System name
• **Current Role**: The currently active role

**NETWORKING**

• **Net**: The logical network this console is active on.
• **IP**: IP address of this system.
• **Enabled network protocols**: A summary of enabled protocols and the current Universe Map for each of them.
• **Network DMX input**: Shows if this is active.
• **ACN Library Info**: Shows information about Advanced Control Network libraries in use.

**FILE PATHS**

• **FileServer path**: If a FileServer path has been defined, it is shown here.
• **USB path**: This is the drive-letter the system is looking for a USB drive under. If Cobalt cannot find a connected USB memory, you can check here to see that it corresponds with the drive letter assigned by Windows.
About - Play

This is a summary of your play. The same information is included in your printouts.
**Dimmer/Device Feedback Log**

The Dimmer/Device feedback log (Browser > About) will show all logged dimmer feedback messages from:

- RDM
- CEM3
- FDX
- CEM+
- Dimstat

**Features**

- The Active column shows if the error is active or if it has been cleared. You can also reset a known error (to get rid of the indication on the channel) by toggling the Active field.
- Select one or more rows in the Dimmer Feedback Log and press DELETE to remove them from the list.
- If general dimmer errors are active, there is a warning sign in the title bar (see below).

In the Header bar on top of the screens, the warning sign indicator will show dimmer and/or other faults in the format: General Errors/Dimmer Errors. Active errors are marked with red. A column “Type” will show the source of the error.
Sensor3 & Sensor+ Dimmer Feedback

These devices will show up in the “Net3/ACN Device List” (Browser > General Settings > Network > Net3/ACN Device List).

Channel Display
When a channel is patched to an output that is associated with a Sensor3 or Sensor+ dimmer then that channel will indicate the state of that dimmer.

When the associated dimmer has an error or warning then the channel display will include a small warning sign as part of the display.

If a channel is selected, the number of active dimmer errors for the channel will be shown in the Info box below the Browser.
Files

The files node is where you can open, save, export and import show files. You can also save a default show, copy log files to a USB memory - and exit the system.

Files Node

This chapter contains the following sections

- Files - Introduction
- New
- Open
- Save
- Save copy to USB
- Save as...
- Import from...
- Export ASCII Light Cues to USB
- Default Play Wizard
- Print...
- Training projects
- System shutdown
- Quit

- Copy Log files to USB
- System Shutdown
- Exit to System Settings
- Exit to Welcome Screen
- Power off (Quit)
Files - Introduction

Make sure you save your information at all times. If the current Play has been altered since it was last saved, the name is displayed in yellow instead of white. If over 30 minutes have passed without saving, the time stamp will turn red.

All file handling can be done from the File node (BROWSER > File). There is a SAVE and SAVE TO key in the frontpanel.

This system has a hard drive as the primary storage. You can also use a USB memory stick, an external USB drive, Floppy or a File Server on the network. For alternative Play Paths see Login Settings - General Functions.
<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>MODIFY</td>
<td>Opens a popup asking you to confirm. See <strong>Load a new (empty) Play.</strong></td>
</tr>
<tr>
<td>Open...</td>
<td>MODIFY</td>
<td>See <strong>Open a Play.</strong></td>
</tr>
<tr>
<td>Save</td>
<td>MODIFY</td>
<td>Saves the current play. Opens a popup asking you to press MODIFY to confirm.</td>
</tr>
<tr>
<td>Save as...</td>
<td>MODIFY</td>
<td>See <strong>Save a Play</strong></td>
</tr>
<tr>
<td>Import from...</td>
<td>MODIFY</td>
<td>See the <strong>Import Wizard.</strong></td>
</tr>
</tbody>
</table>

**NOTE**

USB memory is the main external storage media.

The Floppy drive (option) is mainly an interface for importing shows from other systems using floppy such as Pronto, Safari, Expression, Strand 500-series etc. If your system does not have a floppy drive, connect one with USB or move the files to a USB memory stick. On more information about importing shows files see **IMPORT WIZARD.**

Sub folders are shown at the start of the file list with the name in [brackets].

---

**Files in a network named Saved year-mm-dd (8.1)**

When a system is leaving a network session early it will automatically generated save files, and if a new file is received and there are unsaved local changes.

File names will be in the format "**Saved year-mm-dd xxxx.csf**"
New

When you want to clear the console to start with a new play, you use the "New" command (Browser >Files >New).

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the Browser</td>
<td>[BROWSER]</td>
<td>The Browser is selected on the left side of screen 1. If the Browser already was selected - it will be closed. Press Browser again to reopen.</td>
</tr>
<tr>
<td>2. Go to &quot;Files&quot; at the top</td>
<td>Arrow keys</td>
<td>Files is marked in orange</td>
</tr>
<tr>
<td>3. Open the File node</td>
<td>Right arrow</td>
<td>Opens a subtree of functions.</td>
</tr>
<tr>
<td>4. Select &quot;New&quot;</td>
<td>Down arrow</td>
<td>New is marked in orange</td>
</tr>
<tr>
<td>5. Load a new play</td>
<td>[MODIFY]</td>
<td>Opens a dialogue - see below</td>
</tr>
</tbody>
</table>

If the current play has unsaved changes this dialogue will open;
After which this one will open:

**Unsaved changes**

Play in memory contains unsaved changes. Save?

- **Save**
- **Don't save**
- **Cancel**

If the current play has unsaved changes and has never been saved this dialogue will open instead:

**New**

There are no unsaved changes. It is safe to go ahead.

- **Start with 1:1 patch**
  - 1:1 patch
- **Start with no patch**
  - No patch

**Cancel**
New Play Patch Options
These are the most important settings that you need to consider when starting a new Play in Cobalt.

First there is a dialogue asking you about the patch options for the new play. There is an option to use a default patch, a channel-to-dimmer patch 1:1, to start with No patch. See Patch.

Then there will be a dialogue asking you to select the most important settings for the new play
General Settings
These settings affect default times and master recording in Live.

- **Set times to** - Options are A and B to set which sequence step will receive timing commands made live.
  See [Sequences - Times](#).

- **Enable Remote Controls** - When checked, allows remote controls to interact with the lighting system.
  See [Play Settings - System](#).

---

### General Settings

**Set times to**
- Options are A and B to set which sequence step will receive timing commands made Live.

**Enable Remote controls**
- When checked, allows remote controls to interact with the lighting system.

**Default Go Time**
- Default: 5

**Default Out Time**
- Default: 

**Default In Time**
- Default: 

---

### Moving device settings

*These settings are important for recording moving devices*

- **Record Attribute mode**
  - Active

- **Sequence attribute playback default**
  - AutoMark

---

### Master settings

*These settings are important for masters*

- **Exclude Int. from Record**
  - Default: 

- **Enable Flash key**
  - Default: 

---

[Let's begin!](#)
- **Default Go Time** - Sets the time used by sequence steps with no other recorded timing data. See Play Settings - Crossfade.

- **Default out Time** - Sets the out-fade time to be recorded to sequence steps. See Play Settings - Crossfade.

- **Default In Time** - Sets the in-fade time to be recorded to sequence steps. See Play Settings - Crossfade.

### Moving Device Settings
These settings affect how moving devices are recorded and played back.

- **Record Attribute mode** - See Device Recording - Modes.
- **Sequence attribute playback default** - See Device Play Back - Attrib Move.

### Master Settings
These settings are important for the general behavior of masters and master flash keys.

- **Exclude Int. from Record** - Excludes the intensities from masters when pressing Record (default is off).
- **Enable Flash key** - Sets Flash keys to be active (default is on).
Open

When you want to open a play, you use the "Open..." command (Browser >Files >Open).

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the Browser</td>
<td>[BROWSER]</td>
<td>The Browser is selected on the left side of screen 1*</td>
</tr>
<tr>
<td>2. Go to &quot;Files&quot; at the top</td>
<td>Arrow keys</td>
<td>Files is marked in orange</td>
</tr>
<tr>
<td>3. Open the File node</td>
<td>Right arrow</td>
<td>Opens a subtree of functions.</td>
</tr>
<tr>
<td>4. Select &quot;Open&quot;</td>
<td>Down arrow</td>
<td>Open is highlighted.</td>
</tr>
<tr>
<td>5. Open this node</td>
<td>Right arrow</td>
<td>Opens a subtree of media choices.</td>
</tr>
<tr>
<td>6. Select Media</td>
<td>Down arrow</td>
<td>Selected media (Floppy, Play Archive (HD) or USB) is highlighted.</td>
</tr>
<tr>
<td>7. Open media archive</td>
<td>Right arrow</td>
<td>A subtree is opened with all plays in the selected Media**</td>
</tr>
<tr>
<td>8. Load the selected play</td>
<td>[MODIFY]</td>
<td>Opens a popup. If there are changes in your current play you will be asked to save</td>
</tr>
<tr>
<td>9. Confirm (or don’t)</td>
<td>[MODIFY]</td>
<td>Use arrow key to select your choice and MODIFY to confirm it. The selected Play is loaded.</td>
</tr>
</tbody>
</table>

*If the Browser already was selected, it will be closed. Press BROWSER again to reopen.

**If Floppy, File Server or USB files are not shown you can update this node by clicking on it.
Save & Save as...

Press SAVE to save the play. You can also press CTRL-S on a keyboard.

Depending on if the current play was saved or not you will either get the "Save" dialogue:

![Save dialogue]

or the "Save as" dialogue:

![Save as dialogue]
*It is possible to set up a file server by specifying the file server path in the Login Settings. See Login Settings, General Functions.

To save using the Files node in the Browser:

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Open the Browser</td>
<td><strong>BROWSER</strong></td>
<td>If it was already selected it will be closed. Press again to open.</td>
</tr>
<tr>
<td>2. Go to Files</td>
<td>Down Arrow</td>
<td>Files is highlighted</td>
</tr>
<tr>
<td>3. Expand subnodes</td>
<td>Right arrow</td>
<td>Subnodes are expanded.</td>
</tr>
<tr>
<td>4. Select Save as</td>
<td>Down Arrow</td>
<td>&quot;Save as...&quot; is highlighted</td>
</tr>
<tr>
<td>5. Confirm</td>
<td><strong>MODIFY</strong></td>
<td>A dialogue is opened (see below). Choose target drive Play Archive (Hard drive in console), USB (if inserted) or Floppy (if connected).</td>
</tr>
</tbody>
</table>
Creating Subfolders For Files

You can create sub-folders for files with the INSERT command in the context menu (press SELECT SELECT or the INSERT console key) for the Play Archive node in Browser >File >Save as... >Play Archive.

![Context Menu for Play Archive]

Delete a Play

You can delete a Play file by selecting it in the browser and pressing DELETE.
Save Copy to...

Press SAVE COPY in the programming section to save a copy of the play directly to a USB memory stick or file server. For example, this can be used to create a backup copy of the show. BROWSER >Files >Save Copy. Simply connect your USB memory stick and select this option.

NOTE
You have the option of saving revisions 1-9 of a play every time you store it with the same name on the same USB memory if you use the Save... option to save to USB.
Import from...

You can import part of any play into your current play, if you want to reuse color palettes, presets, groups or if you want to reload a previous version of an object such as a preset from an earlier version of the same play.

You can also import lists from Excel, LightWright or WYSIWYG. See Channel Database - Import Text File Wizard.

This chapter describes the import functions. Parts about drag and drop are referred to the chapter about Drag and Drop. See Drag and Drop.

Import from other lighting systems
If you are importing a play, or parts of a play from a different lighting system see exceptions and notes in this chapter.

1. Open the play - any play in Standard ASCII Light Cues format (name.asc or name.alq) can be opened directly.
2. Save the play as a normal Cobalt play.
3. Use this import Organizer to import parts of these plays.

CAUTION
We strongly advise you to save your Play before using the Import Organizer, since it can alter your Play greatly.

Up to version 7.2 we advice you to avoid using the Import Organizer if decimal channels are used due to a known bug that will be fixed in the next version.

Import Organizer - Functions
The basic functionality of the Import Organizer is that you can use drag and drop (mouse) or copy and paste (keys) to copy any type of data from an external play to the one in memory.
Importing single items
When you want to import a single item you have a choice of using drag and drop, or the copy/paste function.

Drag & Drop

1. Click and hold on the single item you want to import in the Organizer (import from) tab.
2. Drag the item to the same position in the Organizer tab and let go.
3. Confirm what kind of action you are doing in the drag and drop dialogue. See Drag And Drop.

Copy/Paste

1. Use the arrows to select the single item you want to import in the Organizer (import from) tab.
2. Press COPY
3. Select the Organizer tab (TAB) and use the arrows to select the node you wish to import this item to.
4. Press PASTE
5. Confirm what kind of action you are doing in the drag and drop dialogue. See Drag And Drop.

Importing multiple items
When you want to import multiple items, you do it in the exact same way as when importing single items. The difference is in how you select which items to import.

Select the top node to import all items of the same kind, like Sequence, Presets, Groups etc...
Hold SHIFT (keyboard) or SELECT and click to select a range of multiple items of the same kind. Hold SELECT and use arrows in console.

Hold CTRL (keyboard) and click to select multiple items of the same kind in a random order. This is only possible with mouse/trackball and keyboard.

**Import - Types of items to import**

Here are some examples of items that can be imported from any play to the one in memory using the import function:

- Sequences
- Sequence steps
Import Items With Dependencies

Many items in a Play are dependent on other items. For example, if you want to import a Focus Palette, it will be dependent on the specific device that is stored within it and the template of that device. To make it simple, there is an intelligent function under the hood that finds these dependencies and imports all related items for you.

These are the four situations with dependencies:

1. When you import a patch with devices, you will also import the device templates
2. When you import a palette, you will also import the related patch, devices and templates
3. When you import a preset, you will also import all related palettes, patch, devices and templates
4. When you import a sequence, you will also import all related presets, patch, devices, palettes and templates

Every time you make an import with dependencies you will first get a drop dialogue
And after this you will get a dialogue confirming the dependencies that have been imported as well.

**Import From Other Lighting Control Systems**

Importing a show from another lighting system is easy, as long as it is saved in the Standard ASCII Light Cues format.

Basically the easiest way to get the information into Cobalt is to
1. Open the play - any play in Standard ASCII Light Cues format (name.asc or name.alq) can be opened directly.
2. Save the play as a normal Cobalt play.
3. Use the import Organizer in this chapter to import parts of these plays.

Check each system for specific conversion rules. The ASCII Light Cues format is quite old and contains standard definition of simple play data like dimmer patch, cues for intensity information, groups and submasters. More complex data, like moving light data and effects, is not defined in the standard. Some control systems' ASCII files contain data not included in the standard, some not. Cobalt can get differing amounts of data from these ASCII show files. Systems with expanded capabilities are described below.

NOTE
Due to some difference in play structure some play data may not be transferred.

**Import from - ETC Express/Expression/Emphasis**

Only ASCII light cue format is supported (files ending ".asc"). Export this using Expression Offline or within Emphasis. See the Express(ion) and Emphasis manuals for more details.

- Group keywords are now treated as real Groups and not as presets not in the sequence.
- Parameter Definitions are imported.
- Templates are imported.
- Devices are imported.
- Support for translation of parameter values from channel levels (the Emphasis style) to attribute parameters (the Cobalt style).

**Import from - GrandMa**

Cobalt can read GrandMA alq files. The tracking cues of GrandMA will be converted to full cues.

**Import from - Strand**

The following applies when opening a show with data from a Strand System. Strand ASCII Light Cues files that ends with .alq can be opened directly.

**Patch**
Patch 1 is always used.

**Submaster content**
If a submaster contained attributes on the Strand system, the attributes are not transferred to Cobalt, only the intensities.

**Palette references**
In the Strand system, attribute information stored in groups can be used as palettes and referred to in
presets. Strand groups that are referenced from presets are converted to All Palettes and a reference to
the palette is stored in the Cobalt Preset.

**Groups**
Groups that are not referenced from other presets, are stored as Cobalt groups to avoid mix-up with
preset numbers. In Strand plays groups may contain attributes - this is not supported in Cobalt.

**Parts**
Parts are translated to Channel Times. Strand consoles can store channels and values overlapping in
Part cues in a way so sometimes it isn’t possible to translate this properly to Channel Times. Strand
consoles can store attribute information in the Parts. This is not supported on the Cobalt side.

**NOTE**
Since a Cobalt Palette cannot store intensity values, a Strand group that gets
converted to an All Palette will lose its intensity information.

In the Strand system, intensities in a preset can also reference a group. This is
currently not supported in Cobalt. All such values will be set to 99% to
indicate that they have to be updated manually.

**Import from - Avab VLC Safari**

Most data from a Safari VLC play 3.5 or higher in ASCII format can be imported into Cobalt. See
local manual for export instructions to this format.

- Indexed parameter numbers (like Shutters) are remapped to new Cobalt parameter numbers
to preserve the corresponding data.
- Palette references in sequences are handled.
- Scroller Roll references in Palettes are handled.

These are ASCII Safari show file reading improvements in 6.3

- Additional palette types (4 and 5) are merged into Beam palettes. Note: If there is a
  corresponding Beam palette, its existing name will be kept. If there is no corresponding beam
  palette, the VLC palette name will be used.
- Sequences above 1 are read.
- VLC Effects are translated to Chase Sequences with numbers offset by 10 (similar to Presto
  import).

**NOTE**
Due to some difference in play structure some play data may not be
transferred.

**Import from - Avab Expert**

Expert plays can be read directly from a floppy drive or as ASCII plays from a USB, See local manual
for export instructions to this format.
The way Expert plays are read has changed completely to be able to read more data. Using an external utility, the Expert binary file format is translated into ASCII Light Cues and opened just like any other file.

- Loading an Expert play is done from Browser >File >Open. When a diskette with an Expert.pla file is detected, you get the option of converting it when you double click on it.
- An "Export to Expert" diskette command in the Browser allows you to export a Cobalt play to Expert format.

**NOTE**

There are still some parts of the play that aren’t imported. More will come.

There are five parts in an expert play (pla, eff, ren, gl & set). All five are needed.
Export to Expert diskette

This option allows you to export the current play to a floppy disc in Avab Expert play format.

1. Connect an external floppy drive
2. Insert an empty floppy
3. Select Export to Expert diskette and press MODIFY
**Default Play wizard**

The Default Play Wizard (Browser>Files>Default Play Wizard) allows you to store various parts of your current show as a default file. The data in the default file will be offered when you start with a New Play. It is easy to create a default play using the Import Organizer to pull in data from other plays.

![Default Play Wizard](image)

*The data you select below will be stored in a Default Play file. During startup or when making New, you will be able to select this file as a starting point.*

- All Palettes
- Focus Palettes
- Color Palettes
- Beam Palettes
- Groups
- Master Pages
- Magic Sheets
- Scroller Rolls
- Content Effects
- Image Effects

*The Default Play is called DEFAULT and will show up in the Browser.*

*(Using the Save button below will overwrite an existing Default Play file.)*
Print

You can print play data to pdf files, sorted in different ways and in different formats. These files are copied to a USB memory and printed from any standard computer.

Patch and Channel Database can be exported to a comma separated text file, suitable for spreadsheet or database programs like Excel.

Screens can be printed with the PRINT SCREEN function in the Misc Soft Key Menu.

1. Open the Printout Wizard (BROWSER >Files >Print...)

This popup will appear

2. Select what to print to pdf (or select Print to Text)

- All
- Sequences & Presets
- Sequences
- Presets
- Groups
- Palettes
- Device List
- Channel Database (only those with texts)
- Channel List (only patched channels)
- Output List (only patched outputs)
3. Choose if you want to include attributes or not.

4. Choose if you want to sort by Channel, by level or by difference.

5. Choose if you want to print All channels or just those that are changed (more compact).

6. Press EXECUTE to confirm, two things will happen:
   - The print file will be stored under the print node in a node called PRINTOUTS.
   - If a USB memory is inserted before pressing EXECUTE, the files will be copied to it, in a folder called PRINTOUTS.

This popup will appear and show the name of the file consisting of the play name followed by the name of the printout and the date and time stamp. If a USB memory is connected, it will be copied there as well.
Training Projects

This is visualisation plug-in for training purposes. The projects are created in a third-party software called Capture and supplied by ETC. The idea is not to run large shows with processor-heavy visualisation inside Cobalt. It is meant as a training tool that allows you to understand functions like Dynamic Effects without having a rig.

NOTE
The training projects will work in consoles and under Windows - currently not in Mac.

Training Projects - Open Project (8.0)

Opening a Training Project

1. Go to the Browser (BROWSER)
2. Navigate with the arrow keys to the File > Open > Play Archive > Demo Plays node
3. Open the file Demo Theatre or Demo Concert (this will close the online help - open again and continue)
4. Navigate with arrow keys to the File > Training Projects node.
5. Open the file Demo Theatre.c2p or Demo Concert.c2p.
6. You will get a visualisation tab like this

The play loaded will correspond to this training project.
### Training Projects - The Camera (8.0)

There is a camera (viewing angle) that allows you to zoom, pan and rotate the "stage". There are some default functions connected to the FORMAT key of Cobalt. If you have no facepanel: to move the camera position you need to use Arrow keys or F4 (for Format) from the keyboard and the level wheel from the Console mimic (click and drag level wheel with mouse).

#### Default functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom</td>
<td>[FORMAT] &amp; Wheel</td>
<td>The view is zoomed in/out from the camera.</td>
</tr>
<tr>
<td>Pan stage right</td>
<td>Right Arrow &amp; Wheel</td>
<td>Stage is panned to the right around the camera</td>
</tr>
<tr>
<td>Pan stage left</td>
<td>Left Arrow &amp; Wheel</td>
<td>Stage is panned to the left around the camera</td>
</tr>
<tr>
<td>Tilt stage up</td>
<td>Up Arrow &amp; Wheel</td>
<td>Stage is tilted up around the camera</td>
</tr>
<tr>
<td>Tilt stage down</td>
<td>Down Arrow &amp; Wheel</td>
<td>Stage is tilted down around the camera</td>
</tr>
</tbody>
</table>

### Training Projects - Hints (8.0)

The Training Project is a simple way of getting to know some of the moving light functionality of Cobalt, and to understand Dynamics.

In the corresponding Cobalt Play: Demo Theatre and Demo Concert there are samples of Magic Sheets that can be used together with the Plug-in. If you are running one monitor and split the screens you will have a view like this.
Training Projects - Demo Theatre (8.0)

Demo Theatre showfile is a small and simple theatre stage with colormixing fixtures and moving lights. This showfile is suitable for trying out sequences, timings, controlling moving lights, recording and using and updating palettes, effects and so on.

The Channel Database in patch includes texts for the channels, so AutoGroups on Direct selects can be used to select channels based on the info in the patch.

Sequence 2 has some presets with different timings and Notes explaining them.

There are presets and Sequences on the masters for programming help and busking a show.

There are multiple Magic Sheets in the showfile with different types of Magic Sheets. Change Magic Sheets with # FORMAT (F4 on keyboard)

Training Projects - Demo Concert (8.0)

Demo Concert has a bigger lighting rig that is ideal for learning about effects. It contains both spot and wash type moving lights as well as a 10 by 10 matrix of LEDs which are both suitable playgrounds for playing with effects of different types and their timings.

Here are a few examples with Effect Playbacks.

Direct select page 3: has Effect Playbacks and Groups, plus All Palettes and Beam Palettes on the Direct Selects so it is easy to work with the effects and devices at the same time.
Content Effects. Try on one of the Content Effect Playbacks, channels E1-E5. Below are examples of Effect Parameter values that will produce one kind of effect. Feel free to try adjusting the settings to create new effects.

Stabs
Note: Do not turn on the fixtures first, as the effect includes intensity changes.

RGB series
Note: Turn on fixtures first, SolaWashes in this case. This effect does not include intensity.

Fly in
Do not turn on the fixtures first, as the effect includes intensity changes.
Try changing the Set/Group, GrpParts, GrpDistribution
Also try changing the GrpParts to 8 and shortening the StepTime to be about 0.5 seconds and the lights will overlap. Notice that with GrpParts at 4 and StepTime at 0.5 there is not enough time for the fixtures to move to the background state (pointing out with no light output).

CanCan

Try changing the Attack, Sustain and Release times on this effect. Sustain and Release are used in Break mode effects.

Intensity Series on LED Array
Try changing GrpParts, GrpDistribution, StepTime, Attack, Sustain and Release. Zero time on Sustain and Release will essentially create a Ramp effect. Attack time defines the "angle" of the ramp. Zero time for Attack and Sustain, but 1 second or so will create an Inverted Ramp effect.

Image effects: Select E16 and activate Palette 11. This will display the text "Cobalt V8" scrolling from right to left in the LED Array.
This effect consists of the static text "Cobalt V8" and it is mapped to the intensity of the LED array. The scrolling is achieved by using the Effect: ScrollX and Eff.Size & Eff.Speed parameters.

**Image effect: PacMan**
Here the PacMan symbol moves from left to right again thanks to the ScrollX Effect. The image is mapped to the Color mix of the LED Array, so you will need to set the LED Array channels to full to see the output.

The image has been created in the built-in image editor. Try creating your own. You'll find it in **Browser > Effect > Image Effects > Effect Images**...
Copy Log files to USB

This function will copy the log files that are automatically stored in case of a program termination to a USB memory so you can email them to ETC for analysis.

1. Put in USB memory
2. Select Copy Log Files to USB

See Troubleshooting - Crashes & Bugs
Exit to System Settings

The System Settings is where you configure time, nationality, output, network, protocols and software update/upgrade.

The Cobalt System Settings are opened from the Welcome Screen, or from the Browser (Browser >Files >Exit To System Settings). If you start an offline system all of the options will not be available, since they relate to the hardware of a console.

- System Settings - General
- System Settings - Sessions
- System Settings - Network
- System Settings - Monitor
- System Settings - Update
- System Settings - RFR
- System Settings - Utilities
System Settings - General (8.0)

These are the general System Settings.

System Name
This specifies the name this Cobalt console will use to identify itself on the network to other devices. It is displayed at the top of each screen.

Time & Date
Set time, date and Time Zone for this system.

Preferred Language
Select a language with MODIFY and confirm with MODIFY.

Preferred Help Language
Select a language with MODIFY and confirm with MODIFY.

Keyboard
Language settings for the keyboard.

Locale
This will change the way dates are entered.
**Share Play Archive**
This is the default location to save show files. The full path must be typed in and specified in a legal Windows format.

**Example**
- D:\congo\backup (internal path/folder)
- \anders\playfolder (external server name/folder)
- \192.168.1.1\plays (external IPaddress/folder)

**Channel Downgrade**
Reduces the number of control channels in a system.

**Swap 0 & C**
Swap the physical location of the numerical keypads 0 and C buttons (do so in the console as well physically).
System Settings - Sessions (8.0)

Each server in a session with multiple server systems requires a logical network of its own. There are ten networks, 0-9. In each of these networks you can set a name, and the EDMX, sACN and ArtNet mapping.

Sessions will be shown on the start screen in alphabetical order. To create a new Session click ADD - assign a name. To copy an existing one press CLONE and rename.

In a setup with several systems in the same network, such as for example a television studio, you can assign names to the networks belonging to each studio.

HINT
If you want to turn the protocol off for a specific universe, set it to zero.
System Settings - Network (8.0)

These are specific network settings.

NET3 SERVICES
Net3 Services are a suite of services that provide infrastructure support for a Net3/ACN network. Those services are a dynamic IP address server, a network time server and a file server. Each of these services are described below. Unchecking this box acts to disable all of the Net3 Services. Checking the box only enables services selected to be active.

DCHP Service
Clicking in the enable box for PORT 172 will activate the Net3 settings for Address or Time Server, or TFTP (file transfer for software distribution).

Address Service (DHCP)
Net3 Services uses a DHCP (Dynamic Host Configuration Protocol) address server. DHCP is a TCP/IP protocol that dynamically assigns an IP address to a network device when it requests one. This
is a small and simple DHCP server that is intended to be used on non-routed networks. It will not serve IP addresses across a router.

**CAUTION:** There should only be a single DHCP server active on a network. It is possible to start more than one DHCP server on a single network (nothing is built-in to DHCP servers to prevent this from happening). If this occurs, it will result in unstable conditions and possibly result in network communications failures.

Clicking in the enable box will start the DHCP server in the Cobalt console. It will use the settings below to determine which IP addresses it gives out.

- **First Address** - This sets the starting IP address for the range of IP addresses that the DHCP server will hand out.
- **Number of Addresses** - This sets how many IP addresses the DHCP server will give out. A setting of 500 means it will give out IP addresses to the first 500 devices that ask for an IP address.
- **Subnet Mask** - This sets the logical network size vs. the device address. ETC’s default is 255.255.000.000 (class B). This is the subnet mask that the DHCP server will give to network devices.
- **Enable Routed Network** - This specifies the IP address of a router if one is present on your network. This is the gateway IP address that the DHCP server will send to network devices to use. **If you are on a flat or non-routed network**, the Gateway IP address should match the IP address of the device. In order to configure this DHCP server to send out matching gateway IP addresses, **configure this gateway IP address to match the First Address field**. Then the DHCP server will give out a gateway IP address that matches the IP address.
- **Learn Network Devices...**
  Makes a refresh of all ACN network devices.

**Update Service (TFTP)**
Clicking in the enable box for PORT 1/2 will start the TFTP (Trivial File Transfer Protocol) server.

- **Update File Path** - This sets the directory where files are to be served through TFTP. This must be the full path to the directory, including drive letter. For example: C:\etc\nodesbin

**Time Service (SNTP)**
Clicking in the enable box will start the SNTP (Simple Network Time Protocol) service. You determine if the service is running as a client (receiving time messages) or as a server (sending time messages) during the installation process. See [Network - Time Service](#).

**IP SETTINGS**
These are the settings that determine the method to get an IP address and/or the actual IP address information that Cobalt uses for network communication.
Preferred IP address
This tells Cobalt which network adapter it should use for communication with the lighting system. In consoles and Light Servers, there is only one network adapter so the Automatic (default) setting is fine. When Cobalt is run offline or on a Client PC, there may be more than one network connection on that PC (such as on laptops with both wired and wireless connections). In these cases you may need to tell Cobalt specifically which network connection to use to communicate with the lighting system or a connected visualization software application.

Use DHCP
Clicking in the enable box will set Cobalt to get its IP address dynamically from a DHCP server. While the console is starting, it will ask for an IP address from a DHCP server. If one responds, it will use the assigned IP address.

If no DHCP server is available, Cobalt will default to a self-generated link-local IP address in the range of 169.254.x.y. The IP address used by Cobalt in this configuration may change dynamically as needed. A change should typically only occur when there are changes to the network configuration or to resolve an IP address conflict.

Enabling or disabling the DHCP setting will require you to reboot Cobalt for the new setting to take effect.

- **IP address**
  - If DHCP is disabled, you set the Cobalt IP address here. This is a static IP address and will remain set until changed by a user.
  - If DHCP is enabled, this field will display the IP address that is being used by the console (whether it is served via DHCP or a self-generated link-local IP address).

- **Subnet mask**
  - If DHCP is disabled, you set the Cobalt subnet mask here. This is a static setting and will remain set until changed by a user.
  - If DHCP is enabled, this field will display the subnet mask that is being used by the console (whether it is served via DHCP or a self-generated link-local IP address).

- **Gateway**
  - If DHCP is disabled, you set the Cobalt gateway IP address here. This is a static gateway IP address and will remain set until changed by a user.
  - If DHCP is enabled, this field will display the gateway IP address that is being used by the console (whether it is served via DHCP or a self-generated link-local IP address).
Network - Console

- **Obtain an IP Automatically** - Clicking in the enable box will set Cobalt to get its IP address dynamically from a DHCP server. While the console is starting, it will ask for an IP address from a DHCP server. If one responds, it will use the assigned IP address.

If no DHCP server is available, Cobalt will default to a self-generated link-local IP address in the range of 169.254.x.y. The IP address used by Cobalt in this configuration may change dynamically as needed. A change should typically only occur when there are changes to the network configuration or to resolve an IP address conflict. Enabling or disabling the DHCP setting will require you to reboot Cobalt for the new setting to take effect.

- **IP address**
  - If DHCP is **disabled**, you set the Cobalt IP address here. This is a static IP address and will remain set until changed by a user.
  - If DHCP is **enabled**, this field will display the IP address that is being used by the console (whether it is served via DHCP or a self-generated link-local IP address).

- **Subnet mask**
  - If DHCP is **disabled**, you set the Cobalt subnet mask here. This is a static setting and will remain set until changed by a user.
  - If DHCP is **enabled**, this field will display the subnet mask that is being used by the console (whether it is served via DHCP or a self-generated link-local IP address).

- **Gateway**
  - If DHCP is **disabled**, you set the Cobalt gateway IP address here. This is a static gateway IP address and will remain set until changed by a user.
  - If DHCP is **enabled**, this field will display the gateway IP address that is being used by the console (whether it is served via DHCP or a self-generated link-local IP address).

- **Physical Address** - This is the address of the computer. On a typical ETC lighting network, the default settings for IP address of the Ethernet connection for Cobalt is:

  IP address: 10.101.84.101
Subnet Mask: 255.255.0.0
Default Gateway: 10.101.1.1

This addressing scheme should allow a Cobalt console to communicate with other ETC equipment via Ethernet without requiring any changes to these settings. If more than one Cobalt console of the same type are to be connected to the network, ensure that the default addressing has been changed on consoles #2 and above.

**Default IPs for all Cobalt family products**

- 10.101.84.101 (Cobalt 20 console)
- 10.101.82.101 (Congo/Cobalt Light Server)
- 10.101.79.101 (Cobalt Nomad)
- 10.101.80.101 (Congo Console)
- 10.101.81.101 (Congo jr)
- 10.101.83.101 (Congo Kid)

**System Settings - Output Protocols**

This is where you activate different output protocols.

- **Streaming ACN (E1.31)**
  This is a broadcast protocol, like DMX over ethernet, designed to be simple. Check this feature if you are using devices or nodes receiving streaming ACN. Priority is fetched from the setting above. In Offline mode, Streaming ACN is sent on priority 1. Visualisation software such as Capture require sACN tor CITP.

- **ETCNet2**
  **Priority**: An ETCNet2 source can have a priority of 20-1. 1 is highest, and 20 is lowest. This parameter decides the priority status of this system if there are multiple sources (for example Cobalt and Unison). Sources with the same priority share on an HTP level. If there are different priorities, the highest one will "win". The system name that is exposed on Net2 is “Cobalt “ + the system name. See ETCNet2 documentation.

- **Server/Backup Use Same Priority**
  This setting inhibits the Cobalt Backup unit from activating at a higher priority than the server. Normally, the backup will activate at a higher priority to ensure that the system is being controlled by only one server. In some systems, however, control is shared by the Cobalt server and other consoles or architectural lighting control in such a way that having the backup jump a priority can cause unexpected behavior of the system. In those systems, it may be desired to force the backup to activate at the same priority as the server.
• **ArtNet**
  - Check this feature if you are using devices or nodes receiving ArtNet.
  
  **Address**: Choose network and IP address if more than one is available.

**Enable Output in Offline Mode**
In Offline Mode output will be sent at a slower than normal pace to enable the use of external visualisers.

**NOTE**
When the software is started in Offline mode there is no DMX output unless the output box is checked.

**Network - Interface Protocols**

- **ACN (E1.17)**
  This needs to be enabled if you have units with bi-directional communication, like for example the Net3 I/O Gateway. This also includes Net3 DMX/RDM Gateways because the RDM communication is passed via ACN to the console.

  ACN has to be enabled for:
  - Sensor+ dimmer feedback
  - Sensor3 power control system feedback
  - RDM via ETC Net3 Gateways
  - Net3 Show Control Gateways
  - Net3 I/O Gateways
  - Net3 RFR (the steel one)
  - DMX Input via sACN

- **FDX2000 Feedback**
  Error reporting for the FDX2000 dimming system

- **Dimstat Feedback**
  Activates Dimstat feedback.

- **WIFI Remote**
  Activate to use iRFR Classic and aRFR Classic

- **UDP Strings**
  Sets the network card for UDP Strings. See [Play Settings - Show Control](#).
Network - DCHP Service

Net3 Services uses a DHCP (Dynamic Host Configuration Protocol) address server. DHCP is a TCP/IP protocol that dynamically assigns an IP address to a network device when it requests one. This is a small and simple DHCP server that is intended to be used on non-routed networks. It will not serve IP addresses across a router.

**CAUTION:** There should only be a single DHCP server active on a network. It is possible to start more than one DHCP server on a single network (nothing is built-in to DHCP servers to prevent this from happening). If this occurs, it will result in unstable conditions and possibly result in network communications failures.

- **Enable** - Clicking in the enable box will start the DHCP server in the Cobalt console. It will use the settings below to determine which IP addresses it gives out.

- **First IP Address** - This sets the starting IP address for the range of IP addresses that the DHCP server will hand out.

- **Number of Addresses** - This sets how many IP addresses the DHCP server will give out. A setting of 500 means it will give out IP addresses to the first 500 devices that ask for an IP address.

- **Subnet Mask** - This sets the logical network size vs. the device address. ETC’s default is 255.255.000.000 (class B). This is the subnet mask that the DHCP server will give to network devices.

- **Routed** - This specifies the IP address of a router if one is present on your network. This is the gateway IP address that the DHCP server will send to network devices to use. If you are on a flat or non-routed network, the Gateway IP address should match the IP address of the device. In order to configure this DHCP server to send out matching gateway IP addresses, configure this gateway IP address to match the First Address field. Then the DHCP server will give out a gateway IP address that matches the IP address.

- **Learn Network Devices** - Record the current IP addresses of connected network devices. Use this to ensure DHCP-assigned devices keep the same IP address when they next request an IP.
Network - Update Service

- **Update Service (TFTP)**
  Clicking in the enable box will start the TFTP (Trivial File Transfer Protocol) server.

- **Update File Path** - This sets the directory where network device firmware files are to be served through TFTP. This must be the full path to the directory, including internal drive letter. The default is: C:\etc\nodesbin

Network - Time Service

- **Time Service (SNTP) Enable**
  Enabling this starts the SNTP (Simple Network Time Protocol) service.
  The console can run either as a client (receiving time messages) or as a server (sending time messages).

- **ETC Net2 Time**
  Only use if you have Legacy Unison dimmers.

- **External Time Server**
  Cobalt can also get the current time from an external NTP server

- **External Server IP**:
  If External Time Server is enabled, enter the IP address of the Time Server here, eg if you have a local server that is to be the definitive source of the current time for the console.
Network - DMX Input

You can activate DMX input for one DMX universe (selectable) though an ETC node from an EDMX or sACN universe and map it to a channel which will be the start channel for that universe. When DMX input is activated, master playback 20 will act as a master for the DMX input.
System Settings - Monitor

Max physical monitors
Select the number of physical monitors you want to run your system with. If you are running an offline version you can choose virtual screens.

Monitor 1
Check this enable box to change Placement (left/middle/right) or Mode (resolution).

Monitor 2
Check this enable box to change Placement (left/middle/right) or Mode (resolution).

Show Advanced Options
If you have a custom widescreen monitor with specific coordinates, you can use the Advanced Options.
**Identify**
Click here to identify all monitors with a number.

**Apply**
Click here to apply the current monitor settings with a time-out option to return to the previous settings.
**System Settings - Update**

You can **update** software, and **upgrade** the number of *outputs* your system supports.

- To update the software you need a USB memory stick with the latest congo.exe file from www.etcconnect.com that is inserted in a USB port before activating this tab.
- To upgrade the outputs you need an upgrade code from your ETC retailer.
Update Software

In a Congo Jr or Server you will need a mouse to do this. In the big Cobalt you can use the touch screen.

<table>
<thead>
<tr>
<th>Function</th>
<th>Action</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Download latest software</td>
<td><a href="http://www.etcconnect.com">www.etcconnect.com</a></td>
<td>Save the file &quot;congo.exe&quot; on a USB memory stick</td>
</tr>
<tr>
<td>2. Put USB in Cobalt</td>
<td>&quot;Exit to System Settings&quot; node in the browser</td>
<td>-</td>
</tr>
<tr>
<td>3. Exit to Settings</td>
<td>&quot;Exit to System Settings&quot; node in the browser</td>
<td>You will open the system settings.</td>
</tr>
<tr>
<td>4. Go to Update</td>
<td>click on Update</td>
<td></td>
</tr>
<tr>
<td>5. Select software in dropdown</td>
<td>click on Software Update dropdown</td>
<td>The Software Update dropdown is activated.</td>
</tr>
<tr>
<td>6. Select INSTALL</td>
<td>click on INSTALL</td>
<td></td>
</tr>
<tr>
<td>7. Confirm Update Software</td>
<td>Follow the steps in the installation wizard</td>
<td>You will get an installation wizard to confirm all steps.</td>
</tr>
<tr>
<td>End update</td>
<td>Click on OK</td>
<td>Reboots console, and returns to the Welcome screen showing updated version.</td>
</tr>
</tbody>
</table>
System Settings - USB RFR

You can set HF (frequency) and Network ID (group) for each RFR remote. Simply make sure they correspond to your remote settings. You can also update the firmware of your RFR base unit and remote. For more information see Remote Control - RFR Radio Remote.

For the remote to work both base station and console need to be set to the same HF and Network ID.
System Settings - Utilities

These are some useful utilities for file handling.

**BACKUP SHOW ARCHIVE**
Will copy all shows in the archive including backup plays to a USB memory.

**COPY LOG FILES TO USB...**
Copies console log files to a USB stick. Please provide these to ETC Technical Services in the event of finding an issue in your console.

**PERIPHERAL TEST**
Allows you to test peripheral wings and accessories. Used together with advice from ETC Technical Services.
**I/O TEST…**
Opens a terminal window and runs a script to find what modules are attached and working.

**UPDATERATOR...** *(not in image above)*
Is a software for updating Firmwares. Used together with advice from ETC Technical Services.

**File Manager Utilities**

The file manager utility is found in the Utilities tab of the System Settings *(Browser>Files>Exit To System Settings)*

![File Manager Utility](image)

**FILE MANAGER**
This opens a file manager utility for copying and/or moving files between Cobalt and a USB memory or file server.
Verify Hard Disk Utilities

Verify Hard Disk is found in the Utilities tab of the System Settings (Browser>Files>Exit To System Settings).

VERIFY HARD DISK
Technical Services request that you do this as part of fault-finding and sometimes repairing disk issues. Select the appropriate drive letter and click START..

Facepanel Test Utilities

The Facepanel test utility is found in the Utilities tab of the System Settings (Browser>Files>Exit To System Settings). It allows you to check that all buttons and faders work properly in a console.

FACEPANEL TEST
Opens a test screen for the facepanel.
When finished click on the X in the top right corner.

**Network Configuration Applications (GCE, NCE, Concert etc)**

The Network Configuration Applications are found in the Utilities tab of the System Settings (Browser>Files>Exit To System Settings)

This is where you can configure your Net3 Gateways and ETC Networks. To be able to configure nodes from the console NCE and/or Concert (that has replaced GCE) have to be installed, which they are default. You may want to update Concert. Download the latest Concert from the ETC website, put it on a USB stick in the same folder as Cobalt installers and install it in the same way as you update the Cobalt software.

Please check the corresponding manuals for these products.
Backup and Restore System Settings

Backup and restore system settings are found in the Utilities tab of the System Settings (Browser>Files>Exit To System Settings).

**BACKUP SETTINGS**
Creates a backup of your system settings in case you need to reimage the system.

**RESTORE SETTINGS**
Allows you to restore settings from a backup.

**IMPORT CONGO SETTINGS**
Allows you to restore settings saved in an older Congo system.

Backup and Restore User Template Library

Backup and Restore the user template library are found in the Utilities tab of the System Settings (Browser>Files>Exit To System Settings).

**BACKUP USER TEMPLATE LIBRARY**
Allows you to create a backup of your user template library.

**RESTORE USER TEMPLATE LIBRARY**
Allows you to restore a user template library from a backup.

Deep Clear Utilities

Deep Clear is found in the Utilities tab of the System Settings (Browser>Files>Exit To System Settings).

It deletes the Last Saved (play) Data and internal caches.
Exit to Welcome Screen (8.0)

Press MODIFY to exit to the Welcome Screen. From here you can start as Server, Backup or Offline. You can open System Settings and Quit.

In the message box you will be notified:

- If there are Cobalts with different software versions running on the same network.
- If the same sACN or Net2 universe is mapped to multiple Cobalt universes.

1. Date and time.
2. Software version
3. Network Settings
4. Start Offline
5. Available Sessions (See below)
6. System settings (See Exit to System Settings)
7. Quit
**Session Start/Join buttons**

All Session buttons display the name of the Session.

- Sessions you can Start or Join are Cobalt blue.
- A "running" Session also shows the name of the loaded showfile in italics across the bottom.
- Sessions that you can't Join are dark red.

There are two possible reasons for this:

A) Software version doesn't match.
- Instead of the word "Join", the title will show the required software version.

B) The Session is full (Max. 7 members)
- The title becomes "Full".
**Power Off (Quit)**

Always shut down your system correctly with the Exit function (BROWSER >File >Power Off).

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Open the Browser</td>
<td>BROWSER</td>
<td>If it was already selected it will be closed. Press again to open.</td>
</tr>
<tr>
<td>2. Go to Files</td>
<td>Down Arrow</td>
<td>Files is highlighted</td>
</tr>
<tr>
<td>3. Open subnodes</td>
<td>Right arrow</td>
<td>Subnodes are opened</td>
</tr>
<tr>
<td>4. Select Power Off</td>
<td>Down Arrow</td>
<td>Power Off is highlighted</td>
</tr>
<tr>
<td>5. Confirm Power Off</td>
<td>MODIFY</td>
<td>You will get a popup asking you to confirm, and exit the system.</td>
</tr>
</tbody>
</table>

**NOTE**
The current play will be saved to a temporary file called "SAVED.ASC". This file is loaded automatically the next time the Cobalt is powered up.

---

**Power Loss**

ETC recommends use of an external UPS (Uninterruptible Power Supply) to ensure the possibility to save your data and perform a proper shutdown of the Cobalt system in the event of an external power loss. The console and the monitor with the Browser should be connected to the UPS.

**NOTE**
The current play will be saved to a temporary file called "SAVED.ASC". This file is loaded automatically the next time the Cobalt is powered up.

Always make sure to save a backup to an external media like a USB device. It is your only protection against an internal hardware failure.
General Settings

The General Settings node contains all the settings for the play, the console, networking, printing, tab areas etc.

General Settings Node

This chapter contains the following sections

- Play Settings
- Console Settings
- DMX Settings
- Network
- Print Wizard
- Screens (5.0)
- Dock Areas
- User List
- Event List
- Macro List
Play Settings

The Settings define default times and values, the behaviour of recording functions, and attribute behaviour in faders during playback.

This chapter contains the following sections

- Play Settings - Introduction
- Play Settings - Let's Begin
- Play Settings - Channel
- Play Settings - Main Playback
- Play Settings - Master
- Play Settings - Effects
- Play Settings - System
- Play Settings - Attribute
- Play Settings - Show Control
Play Settings - Introduction

Press SETUP in the programming section to open system settings. You can also open a local settings popup for any key by holding SETUP and pressing that key (for example GO or RECORD)

The system settings popup contains the following sections

- **LETS BEGIN** > A summary of the most important settings.
- **CHANNELS** > Configure default values and select Command Syntax.
- **CROSSFADE** > Configure default times, fader modes and fade direction.
- **MASTERS** > Configure Flash and fade on time and Auto-save master pages.
- **EFFECTS** > Configure "Remember Effect Parameters".
- **SYSTEM** > Configure Auto-save, rubberband, beep, remote etc.
- **ATTRIBUTES** > Configure default times and recording modes.
- **MIDI** > Midi Settings
- **SHOW CONTROL** > Configure Midi, Show Control and Time Code.
Play Settings - Basic

The Basic settings are a cross selection of settings from all tabs that are very important to fill in before starting to work with a new show. See New.
**Play Settings - Channels**

Press SETUP and use the right/left arrows to select the **Channel Settings** tab.

- Use the down arrow to select a cell.
- Use MODIFY or # MODIFY to change values.
### Channel Settings

The Channel Settings are general for all Channel Views.

<table>
<thead>
<tr>
<th>Function</th>
<th>Explanation</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID Level</td>
<td>The level used by the ID function (hold CHANNEL and press @LEVEL)</td>
<td>100%</td>
</tr>
<tr>
<td>Step Level</td>
<td>The Level applied when pressing @LEVEL without any value</td>
<td>70%</td>
</tr>
<tr>
<td>Step % Value</td>
<td>The Level applied when pressing the +/-% keys</td>
<td>5%</td>
</tr>
<tr>
<td>Release Time</td>
<td>Default release time for Captured channels</td>
<td>3**</td>
</tr>
<tr>
<td>Slower level wheel response</td>
<td>Reduces the response speed of the level wheel</td>
<td>Off</td>
</tr>
<tr>
<td>Use REM DIM as Balance</td>
<td>Sets the function of the REM DIM key to BALANCE</td>
<td>Off***</td>
</tr>
<tr>
<td>Channel Database Texts</td>
<td>Sets a text header for the Channel Database texts</td>
<td>***</td>
</tr>
</tbody>
</table>

** See Channels - Capture Mode
***See Channels - Balance Mode
****See Channel Database
Play Settings - Main Playback

Press SETUP and use the right/left arrows to select the Crossfade Settings tab.

- Use the down arrow to select a cell.
- Use MODIFY or # MODIFY to change values.

Crossfade Settings

The Crossfade Settings are general for the Main Playback.

Timing settings
### Function

<table>
<thead>
<tr>
<th>Function</th>
<th>Explanation</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default GO Time</td>
<td>The Time used by the GO key when no times have been assigned to a crossfade</td>
<td>5</td>
</tr>
<tr>
<td>Default Go Back Time</td>
<td>The Time used by the GO BACK key when pressed independent of any ongoing fades.</td>
<td>2</td>
</tr>
<tr>
<td>Default Out/In Time</td>
<td>Causes the specified time(s) to be automatically recorded into all new sequence steps, which will be used instead of the Default GO time.</td>
<td></td>
</tr>
</tbody>
</table>

### Playback mode settings

<table>
<thead>
<tr>
<th>Function</th>
<th>Explanation</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify Sequence</td>
<td>Deactivate all Auto-times, Master Links and other Autostart items for all Sequences.</td>
<td>Off</td>
</tr>
<tr>
<td>Build Sequence</td>
<td>Presets recorded in LIVE will automatically added into the Sequence of the A/B Playback. They will always be stored in the Preset List</td>
<td>On</td>
</tr>
<tr>
<td>Crossfade both ways</td>
<td>Crossfaders make a crossfade both up and down (instead of only up).</td>
<td>Off</td>
</tr>
<tr>
<td>Set times to</td>
<td>Times are set directly to the Sequence Step in the A field, or the B field</td>
<td>B</td>
</tr>
<tr>
<td>GOTO jumps to</td>
<td>GOTO fades to Preset numbers, or Sequence Step numbers</td>
<td>Preset</td>
</tr>
</tbody>
</table>
### Specific playback settings

<table>
<thead>
<tr>
<th>Function</th>
<th>Explanation</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable PB Rubberband</td>
<td>Disables attributes from the faders of the Main Playback.</td>
<td>Off</td>
</tr>
<tr>
<td>Always start Dynamics on Go</td>
<td>Sets Dynamics to start on Go regardless of other settings.</td>
<td>Off</td>
</tr>
<tr>
<td>Don't loop Sequence</td>
<td>At the end of a Sequence it will not restart at step 1.</td>
<td>Off</td>
</tr>
<tr>
<td>Don't advance Playback</td>
<td>Crossfades will not advance any sequence steps automatically.</td>
<td>Off</td>
</tr>
<tr>
<td>Show sequence numbers</td>
<td>Display of Sequence Steps in the Playback tab.</td>
<td>On</td>
</tr>
<tr>
<td>Designer summary shows data from</td>
<td>Designer summary shows data from A or B</td>
<td>A</td>
</tr>
<tr>
<td>Solo affects Main PB</td>
<td>Allows Flash Solo mode on masters to affect also the output from the Main PB.</td>
<td>Off</td>
</tr>
<tr>
<td>Auto-stop Dynamics in PB</td>
<td>Loading a new Sequence to the Main Playback stops all running Dynamics started from the current Sequence.</td>
<td>Off</td>
</tr>
<tr>
<td>Alert Alarm Time</td>
<td>The time at which the warning (yellow and beep) will be issued before the Alert time is finished.</td>
<td>5</td>
</tr>
<tr>
<td>Beep on Alert</td>
<td>Audio Alert warning.</td>
<td>On</td>
</tr>
</tbody>
</table>
Play Settings - Masters

These are the global settings for the whole play. There are a lot of individual master settings as well. (See Masters - Settings)

Press SETUP and use the right/left arrows to select the Master Settings tab.

- Use the down arrow to select a cell.
- Use MODIFY to toggle a setting.

Expanded Master Settings

Master Settings

The Master Settings are general for the Master Playbacks.

<table>
<thead>
<tr>
<th>Function</th>
<th>Explanation</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto-Update master page</td>
<td>Changes to a Master Page are stored automatically.</td>
<td>On</td>
</tr>
<tr>
<td>Exclude Int. from Record (6.1)</td>
<td>Excludes all master intensities from record actions in Live</td>
<td>Off</td>
</tr>
<tr>
<td>Enable Flash key (6.1)</td>
<td>Enables Flash mode to momentary (on) in all consoles and wing panels with physical flash keys.</td>
<td>On</td>
</tr>
</tbody>
</table>
**Play Settings - System**

Press SETUP and use the right/left arrows to select the **System Settings** tab.

- Use the down arrow to select a cell.
- Use MODIFY to toggle a setting.

![Play Settings - System](image)

**System Settings**

The System Settings are general for the behaviour of the console. They are divided into User Settings and Global Settings.

**User Settings**

<table>
<thead>
<tr>
<th>Function</th>
<th>Explanation</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beep</td>
<td>An audio &quot;beep&quot; warning when illegal commands are performed AND when a crossfade is completed</td>
<td>On</td>
</tr>
</tbody>
</table>
**Global Settings** - for every system in a Session

<table>
<thead>
<tr>
<th>Function</th>
<th>Explanation</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Remote Controls</td>
<td>Activate Radio remote focus units and remote trigger.</td>
<td>On</td>
</tr>
<tr>
<td>Allow recording from remote</td>
<td>Allow recording/updates from remote(s)</td>
<td>Off</td>
</tr>
<tr>
<td>Remotes use separate fields</td>
<td>Remotes will work in a separate remote field</td>
<td>Off</td>
</tr>
<tr>
<td>Auto-save on Record</td>
<td>Saves the Play after each time you press RECORD.</td>
<td>Off</td>
</tr>
</tbody>
</table>
Play Settings - Attribute

Press SETUP and use the right/left arrows to select the Attribute Settings tab.

- Use the down arrow to select a cell.
- Use MODIFY or # MODIFY to change values.
Attribute Settings

The Attribute settings affect recording and control of moving device parameters.

Recording and control functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Explanation</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sequence attribute playback default</td>
<td>Record attributes to move &quot;live&quot; (GoOnGo), when the positions are loaded for the next Crossfade (GoInB) or Auto Move.</td>
<td>Auto Mark*</td>
</tr>
<tr>
<td>Record Attribute mode</td>
<td>There are different modes for recording Attributes. See Device Recording - Modes. See Attribute Move in Sequence List - Functions.</td>
<td>Active</td>
</tr>
<tr>
<td>Attribute Editor default</td>
<td>The default setting for entering values in the Attribute Editors: Palettes or %.</td>
<td>Palette</td>
</tr>
<tr>
<td>Default Attribute time</td>
<td>Sets a time for all moving device changes during programming.</td>
<td>3 seconds</td>
</tr>
<tr>
<td>Time: Use % as default</td>
<td>Times are set as % of the In-time of a crossfade, or in seconds.</td>
<td>Off (seconds)</td>
</tr>
<tr>
<td>Coarse/Fine 16 bit control</td>
<td>When checked, holding down the Wheel Key gives 'fine' control on the parameter wheel. When unchecked, moving the wheels slowly gives fine control. See Device Templates - 16 bit control.</td>
<td>Off (8 bits)</td>
</tr>
<tr>
<td>Override scroller fan value</td>
<td>Override the fan of all patched scrollers with fan control.</td>
<td>0%</td>
</tr>
<tr>
<td>Sort devices by type</td>
<td>Specifies if attribute views should be sorted by channel number or by device type</td>
<td>Off</td>
</tr>
</tbody>
</table>

*You can change this separately for each Sequence Step in the Sequences - Sequence List.
## Time settings

<table>
<thead>
<tr>
<th>Function</th>
<th>Explanation</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>F-Del</td>
<td>A default delay time in seconds or % (of the In time), used when recording Preset with Attributes.</td>
<td>0 seconds</td>
</tr>
<tr>
<td>C-Del</td>
<td>See above</td>
<td>0 seconds</td>
</tr>
<tr>
<td>B-Del</td>
<td>See above</td>
<td>0 seconds</td>
</tr>
<tr>
<td>F-Time</td>
<td>A default time in seconds or % (of the In time), used when recording Preset with Attributes.</td>
<td>100%</td>
</tr>
<tr>
<td>C-Time</td>
<td>See above</td>
<td>100%</td>
</tr>
<tr>
<td>B-Time</td>
<td>See above</td>
<td>100%</td>
</tr>
</tbody>
</table>
Play Settings - MIDI

Press SETUP and use the right/left arrows to select the MIDI Settings tab.

- Use the down arrow to select a cell.
- Use MODIFY or # MODIFY to change values.

**Standard MIDI**

All keys and faders can send notes and controllers when this is activated in the MIDI Settings. You can use MIDI notes and controllers to remote control any key or fader of the Console. The Cobalt can also be set to activate a specific crossfade when receiving a Program Change command through MIDI. See MIDI.
<table>
<thead>
<tr>
<th>Function</th>
<th>Explanation</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direct mode</td>
<td>Midi [Direct Mode]</td>
<td>On</td>
</tr>
<tr>
<td>MIDI Channel</td>
<td>The MIDI channel used by Cobalt</td>
<td>1</td>
</tr>
<tr>
<td>Keys</td>
<td>All keys are sent as notes.</td>
<td>Off</td>
</tr>
<tr>
<td>Faders</td>
<td>All faders are sent as controllers.</td>
<td>Off</td>
</tr>
<tr>
<td>Program Change</td>
<td>Jumps to sequence step #</td>
<td>-</td>
</tr>
</tbody>
</table>

**MIDI Show control**

Cobalt supports sending and receiving of MIDI Show Control (MSC) commands. See [MIDI - MIDI Show Control](#).

<table>
<thead>
<tr>
<th>Function</th>
<th>Explanation</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Activates reception of MSC.</td>
<td>Off</td>
</tr>
<tr>
<td>Device ID</td>
<td>Sets a Device ID for this Cobalt.</td>
<td>1</td>
</tr>
</tbody>
</table>

**Time Code**

Every sequence step can be triggered both manually, and by a specific MIDI Time Code time on the MIDI port. See [MIDI - Time Code](#).

<table>
<thead>
<tr>
<th>Function</th>
<th>Explanation</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Code</td>
<td>MIDI Times Code reception is on.</td>
<td>Off</td>
</tr>
<tr>
<td>Learn mode</td>
<td>Activate learn mode for setting Time Code to Sequence Steps.</td>
<td>Off</td>
</tr>
<tr>
<td>Auto-locate step</td>
<td>Sets if Time Code should auto-locate steps or not.</td>
<td>Off</td>
</tr>
<tr>
<td>Enable Backup clock</td>
<td>Enables the backup clock</td>
<td>Off</td>
</tr>
<tr>
<td>Internal clock start</td>
<td>Sets a start time for the internal clock.</td>
<td>--.--.--.--</td>
</tr>
</tbody>
</table>
Direct Mode MIDI

Direct Mode is designed to allow you to connect any MIDI equipment to Cobalt and be able to make it work, providing it is sending the corresponding MIDI commands.

<table>
<thead>
<tr>
<th>Notes</th>
<th>MIDI Channel</th>
<th>Start at number</th>
<th>End at number</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master 1-20</td>
<td>1</td>
<td>0</td>
<td>19</td>
<td>20</td>
</tr>
<tr>
<td>Flash 1-20</td>
<td>1</td>
<td>20</td>
<td>39</td>
<td>20</td>
</tr>
<tr>
<td>Page+/Page-, block 1</td>
<td>1</td>
<td>40</td>
<td>41</td>
<td>2</td>
</tr>
<tr>
<td>Master 21-40</td>
<td>2</td>
<td>0</td>
<td>19</td>
<td>20</td>
</tr>
<tr>
<td>Flash 21-40</td>
<td>2</td>
<td>20</td>
<td>39</td>
<td>20</td>
</tr>
<tr>
<td>Page+/Page-, block 2</td>
<td>2</td>
<td>40</td>
<td>41</td>
<td>2</td>
</tr>
<tr>
<td>Master 41-60</td>
<td>3</td>
<td>0</td>
<td>19</td>
<td>20</td>
</tr>
<tr>
<td>Flash 41-60</td>
<td>3</td>
<td>20</td>
<td>39</td>
<td>20</td>
</tr>
<tr>
<td>Page+/Page-, block 3</td>
<td>3</td>
<td>40</td>
<td>41</td>
<td>2</td>
</tr>
<tr>
<td>Master 61-80</td>
<td>4</td>
<td>0</td>
<td>19</td>
<td>20</td>
</tr>
<tr>
<td>Flash 61-80</td>
<td>4</td>
<td>20</td>
<td>39</td>
<td>20</td>
</tr>
<tr>
<td>Page+/Page-, block 4</td>
<td>4</td>
<td>40</td>
<td>41</td>
<td>2</td>
</tr>
<tr>
<td>Direct Select 1-40 (Congo hardware)</td>
<td>1</td>
<td>50</td>
<td>89</td>
<td>40</td>
</tr>
<tr>
<td>Direct Select Page 1-5 (Congo hardware)</td>
<td>1</td>
<td>90</td>
<td>94</td>
<td>5</td>
</tr>
<tr>
<td>Independent 7-9</td>
<td>1</td>
<td>100</td>
<td>102</td>
<td>3</td>
</tr>
<tr>
<td>GO, Pause, GoBack</td>
<td>1</td>
<td>103</td>
<td>105</td>
<td>3</td>
</tr>
<tr>
<td>Refresh</td>
<td>1</td>
<td>106</td>
<td>106</td>
<td>1</td>
</tr>
</tbody>
</table>

**Controllers**

<table>
<thead>
<tr>
<th>Note</th>
<th>MIDI Channel</th>
<th>Start at number</th>
<th>End at number</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master 1-20</td>
<td>1</td>
<td>0</td>
<td>19</td>
<td>20</td>
</tr>
<tr>
<td>Master 21-40</td>
<td>2</td>
<td>0</td>
<td>19</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>-------</td>
<td>-------</td>
<td>-------</td>
<td>-------</td>
</tr>
<tr>
<td>Master 41-60</td>
<td>3</td>
<td>0</td>
<td>19</td>
<td>20</td>
</tr>
<tr>
<td>Master 61-80</td>
<td>4</td>
<td>0</td>
<td>19</td>
<td>20</td>
</tr>
<tr>
<td>Crossfade A, B</td>
<td>1</td>
<td>100</td>
<td>101</td>
<td>2</td>
</tr>
<tr>
<td>Speed Control A, B</td>
<td>1</td>
<td>102</td>
<td>103</td>
<td>2</td>
</tr>
<tr>
<td>GrandMaster</td>
<td>1</td>
<td>104</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Independent 1-6</td>
<td>1</td>
<td>110</td>
<td>115</td>
<td>6</td>
</tr>
</tbody>
</table>

**Program Change**

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Page, block 1</td>
<td>1</td>
<td>0-127</td>
<td>128</td>
</tr>
<tr>
<td>Page, block 2</td>
<td>2</td>
<td>0-127</td>
<td>128</td>
</tr>
<tr>
<td>Page, block 3</td>
<td>3</td>
<td>0-127</td>
<td>128</td>
</tr>
<tr>
<td>Page, block 4</td>
<td>4</td>
<td>0-127</td>
<td>128</td>
</tr>
<tr>
<td>Jump in main playback</td>
<td>5</td>
<td>0-127</td>
<td>128</td>
</tr>
</tbody>
</table>

**MSC**

Extend to allow control of all masters.
Play Settings - Show Control

Press SETUP and use the right/left arrows to select the Show Control Settings tab.

- Use the down arrow to select a cell.
- Use MODIFY or # MODIFY to change values.

Show Control Settings

The Show Control Settings are general for the system.

OSC

Open Sound Control (OSC) is a content format for messaging among computers, sound synthesizers, and other multimedia devices. See OSC Functionality.

<table>
<thead>
<tr>
<th>Function</th>
<th>Explanation</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate</td>
<td>Activate OSC</td>
<td>Off</td>
</tr>
<tr>
<td>Input Port</td>
<td>The Input Port Cobalt listens to</td>
<td>8000</td>
</tr>
<tr>
<td>Output Port</td>
<td>The Output port Cobalt sends to</td>
<td>7000</td>
</tr>
<tr>
<td>Output IPs</td>
<td>The Output IP(s) Cobalt sends to, add multiple and separate with semicolon &quot;.&quot;.</td>
<td>-</td>
</tr>
</tbody>
</table>
UDP Strings

UDP (User Datagram Protocol) is a communications protocol where messages are exchanged between computers in a network that uses the Internet Protocol (IP). See [UDP data](#).

In Cobalt UDP allows you to use the Ethernet network to:

- Receive Cobalt specific Action Macros directly from another unit, without having to first create a trigger and event.
- Send any proprietary string of data to another unit that can receive commands over UDP

<table>
<thead>
<tr>
<th>Function</th>
<th>Explanation</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Port</td>
<td>The Input Port Cobalt listens to</td>
<td>0</td>
</tr>
<tr>
<td>Output Port</td>
<td>The Output port Cobalt sends to</td>
<td>0</td>
</tr>
<tr>
<td>Output IPs</td>
<td>The Output IP(s) Cobalt sends to, add multiple and separate with semicolon ;</td>
<td>0</td>
</tr>
</tbody>
</table>
**Console Settings**

The Console Settings are set from the node Console Settings in the Setup node of the Browser. (Browser > General Settings > Console Settings).

You can set the values from 0-100%. They will take effect immediately and are NOT related to different play files.

### Console Parameter settings

<table>
<thead>
<tr>
<th>General</th>
<th>Cobalt</th>
<th>Congo Jr/Kid</th>
<th>Wing modules</th>
</tr>
</thead>
<tbody>
<tr>
<td>RDM Discovery Enabled</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>At mode</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>At mode: Point style</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Auto-close tab mode</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Backup priority</td>
<td></td>
<td></td>
<td>5</td>
</tr>
</tbody>
</table>

**At Mode**
Sets At Mode for the console. An indicator will show that it is active, in the status bar at the bottom of all screens.

**At Mode point style**
This allows you to enter levels "5.5" for 55 and then ".6" for turning that into 56.

**Auto Close Tab Mode**
When this is checked you will close the previous tab when opening a new one, to keep the number of tabs down.

See [RDM Functionality](#).
See [Channels - Command Syntax](#)
Key Backlighting in Cobalt

![Console Parameter settings](image)

- **Function keyboard**
  - Backlight: 25%

- **Encoder intensity**
  - Intensity: 25%

- **LED intensity**
  - Intensity: 25%

- **Display backlight**
  - Backlight: 25%

- **Screen backlight**
  - Backlight: 78%

- **Littlights**
  - Intensity: 50%
Displays Lighting

Congo Hardware console settings
Sound Settings

The volume of the internal speaker is set by holding SETUP and moving the level Wheel. You will see the result in the value next to the loudspeaker symbol in the top right corner of the monitor screens.

This will take effect immediately and is NOT related to different play files.

You can also right-click on the speaker to open a context menu for setting sound levels.
**DMX Settings**

DMX Settings for up to four DMX ports. Each port uses a universe number (instead of start address). Only connected ports will be displayed, marked with “internal” or “gadget”.

The main reason for changing output speed is that you are controlling older equipment that isn't compatible with full speed DMX.

- Start address
- Speed = Maximum, Fast, Medium, Slow
- RDM = on/off

![DMX Settings Interface](image)
This chapter covers the network features including multiconsole sessions.

This chapter contains the following sections:

- Network - Introduction
- Network - Functions
- Network nodes
Network - Introduction (8.0)

A physical network can contain any number of logical networks - each logical network is referred to as a Session. All consoles in a Session will share play and global resources.

A Cobalt Session will always have an active Server, which will be the first console started. Every other output-capable device (consoles, ETCnomad/Puck) that joins the Session will be a potential backup. Should the server stop, the backup with the lowest number will take over and maintain control.
General Facts

- Only the Server transmits output data
- All systems running Cobalt software can join a Session with other devices, this includes Cobalt 20, Cobalt 10, Cobalt Light Server, ETCnomad, ETCnomad Puck and the older hardware such as th Congo Jr, Congo Kid and Congo Light Server.

**NOTE**

A backup can only back up within its channel and output limitations.

See System Settings - Networking.
Network - Functions

These are the general network functions.

This chapter contains the following sections

- Network - Server/Backup
- Network - Multiconsole Sessions
Network - Server/Backup (8.0)

When more than one console is used in the same Session the first will be Server, outputting data actively, and the other will be backup that takes over in the event that communication with the server is lost. A Backup only starts sending data to the lighting system once it has taken over and become Server.

Multi-console systems (server/backup) should be connected to each other through an Ethernet switch and should use ETC Net3 DMX/RDM Gateways (or similar) for DMX output. It is not recommended to use a crossover cable or local DMX in backup systems. All backup devices can also be used as active programming/playback stations.

Server/Backups
When communication with the Server is lost, the next Cobalt in the system (lowest backup number) is automatically converted to the Server role.

ETCNet2
You can connect to ETC nodes with a Switch (avoid routers, they tend to complicate things). Cobalt consoles/Client PCs should be given IP addresses in the 10.101.201.101+ range when used with ETCNet2. Please see the ETCNet2 v4 Planning Guide for information on configuring an ETCNet2 network.

<table>
<thead>
<tr>
<th>Console</th>
<th>IP Address 1</th>
<th>IP Address 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cobalt Nomad</td>
<td>10.101.79.101</td>
<td>10.101.79.253</td>
</tr>
<tr>
<td>Congo jr Console</td>
<td>10.101.81.101</td>
<td>10.101.81.253</td>
</tr>
<tr>
<td>Congo Light Server</td>
<td>10.101.82.101</td>
<td>10.101.82.253</td>
</tr>
<tr>
<td>Congo Kid</td>
<td>10.101.83.101</td>
<td>10.101.83.253</td>
</tr>
<tr>
<td>Cobalt 20 Primary NIC</td>
<td>10.101.84.101</td>
<td>10.101.84.253</td>
</tr>
<tr>
<td>Cobalt 10 Primary NIC</td>
<td>10.101.87.101</td>
<td>10.101.87.253</td>
</tr>
<tr>
<td>Cobalt LS Primary NIC</td>
<td>10.101.88.101</td>
<td>10.101.88.253</td>
</tr>
</tbody>
</table>
ETC recommends that ETCNet2 systems should be in the 10.101.x.y range - "Primary" NIC.

**Network - Server takeover, loss and return (8.0)**

If consoles in any segment of a Session lose contact with consoles in any other segment, each segment will select a new Server. If segments then rejoin the network, the Session must rapidly detect which segment is the leader and rejoin it, with all other Servers becoming Backups.

There are three possible situations:

**No activity** has occurred in any segment.

- There is no show data to resolve.
- The lowest-numbered Server stays as Server, all higher number Servers return to the Backup state

**Activity has occurred in only one segment**

- The inactive Server becomes a Backup.
- Consoles enter the “Catching” state and catch up to the rest of the Session

**Activity has occurred in more than one segment**

- The Server with the most recent Session activity remains Server
- All others become a Backup
- All consoles enter the Catching state and sync their activity.

If changes were made to the same object in two segments, the older changes are lost in both cases. If a network switch is lost, many Consoles in the Session will then become isolated from each other. Some of these may be able to see each other, while others do not.
Network - Multiconsole Sessions (8.0)

Every console has a Default Session. All consoles within a Session share the same Play data. Hitting “Save” in any console causes all consoles to save the Play to their local hard disk. Save actions shall have no noticeable effect on connected consoles other than to delay loading or quitting until a save is completed.

You may create any number of individual multiconsole Sessions in the same network. Each additional console can access and work independently with the data of the Play in the Server. Playback controls are shared (See Multiple Users - Global Functions).

All Sessions set up in a network are shown and synchronized at the Welcome Screen.

- All consoles on a network list all the Sessions that it can Join.
- A console started in Offline mode does not communicate with any other console and does not join a Session.

A Session contains the following data:

- The user-defined name
- An optional password
- DMX mapping between the console patch universes (1-32) and all supported Ethernet-based lighting protocols.

A Session may be Inactive (no consoles are in the Session), Active with one or more consoles connected, or Full (when 7 consoles are connected to the Session.)

A software version may be displayed for any given Session, indicating the software version of the current Server. All consoles in a Session must be using the same software version.

Multiconsole Sessions - Global Functions (8.0)

All Play data is Global and stored in every console. All Session members track recorded changes from any member.

All Session members track changes from any member

- Content on all Playbacks.
- Temporary’ content of A, B, Blind and Master fields
- Changes in fully blind tabs are not distributed until Record/Update occurs.

Multiple Main Playbacks

Nine (9) additional “main playbacks” allow independent playback of a "console-local" sequence from multiple consoles (every user can choose which main playback field 1-9 to assign to their main playback) (hold SETUP & PLAYBACK). Additional main playbacks are filtered through the partitioning system.
Channels controlled from a different main playback will have a green level.

Master Playbacks
The 80 master fields are global.

Partitioning
Within a Session, partitions can be used to subdivide channel control, recording and Main Playback functions.

- Partitions are conceptually Filters that filter out all channels not included in the partition.
- Updating and recording presets will record values for all recordable channels in the partition and will not affect channels that are outside of the partition.

Freeze/Blackout & Grand Master
Freeze is activated locally and will freeze all outputs. Blackout and Gand Master will do the same. They are all global.

Inputs/Outputs
To ensure seamless operation it is recommended in a multiconsole system (multiuser or with a backup) that a network is used to distribute DMX and to interface to other I/O and show control protocols.

Multiconsol Session - Local Functions (8.0)

Basically everything is local except the global features described above. See Multiple Users - Global Functions. There are some special cases:

Capture
Each user has its own Capture mode, but all captures channels are handled on a global system level on a first come, first served basis. This means that if a channel can be controlled from two consoles and one of them has Captured it - it is "owned" by this console until released.

Group Wheel Mode
Group Wheel mode is local for each console - just like all other channel control functions.

Multiconsol Session - Patching, Users and Partitions (8.0)

To set up a multiconsol Session in a system it is important to do things in a specific order. It is also important to structure the working method of the Users since they will all be sharing the same system.
**Patch First!**

Start by patching the whole system, with devices and everything. See Patch. Basically you can connect several clients directly after patching, to a Server, or Server/Backup system - and each user can access the whole system in parallel with the other users.

**Option: Define Partitions**

You can define Partitions that can be activated for different users. The Partitions can be helpful to avoid one user affecting channels of another user. Make sure you do this BEFORE activating Partitions or User Logins other than the default ones. See Partitions.

**Option: Define Users**

If necessary, define User Logins for different work stations. The User Logins may be of help when different users try to access the Server - partly because there are personal settings, and partly because Partitions can be set to default and automatically be activated when a specific User logs in. See User Login.

**Multiconsole Sessions - Status (8.0)**

The number of connected consoles/devices are displayed in the lower right corner status indication of screens.

**Multiconsole Sessions - Start and Join a Session (8.0)**

To start output from a console a Session has to be joined. There is a default Session in every system and more can be created in System Settings. The first Console to join an Inactive Session makes it Active and sets the Software Version. The first Console to load a play file in a Session sets the Play file.

**Starting a Session**

The first console to Join an Inactive Session must start this Session.

1. The Software Version is set, and the Session status is now Active.
2. The user is asked which Play to load (Last, Play Archive or New).

**Joining a Session**

1. Select the Session you wish to Join. If the Software Version is not compatible, your are warned and cannot join the session.
2. If the Session has a password, your must enter it.
3. Your console then begins the process catching the Session.

- The most recent play file “sequence point” is downloaded from an existing Console.
- Changes are downloaded in the order they occurred and applied to this snapshot.
- The console catching up will adds ongoing changes to the end of the queue, to be processed when it reaches them.
• Once the Console has caught up, it is assigned a Backup Number.

Multiconsole Session - Leave or Shut Down (8.0)

Any user can ask to Shut Down or Leave the Session. After doing this, you may Power Off or return to the Welcome Screen.

Shutting Down a Session
The console Shutting Down the Session will request all other consoles to Leave the Session. The other consoles will have an opportunity to cancel the shutdown. In this case the Session does not shut down and stays Active.

Leaving a Session
If a console is the last to Leave the Session, it shall Shut Down the Session. When the console Leaves the Session, it shall save a copy of the show file and will show in a start dialog that it left the session early last.
**Network nodes**

This node shows all Cobalt devices on the network, including the one you are working on, which is indicated with a * before the name.

You can see the role, IP address and logical network in the Info area. See [System Settings](#).

```
<table>
<thead>
<tr>
<th>Network</th>
</tr>
</thead>
<tbody>
<tr>
<td>Network nodes (1)</td>
</tr>
<tr>
<td>Net3/ACN Device List</td>
</tr>
</tbody>
</table>
```
**Net3/ACN Device List**

Lists all Net3 Devices in the network, and allows some editing. Cobalt servers and backups will automatically connect to discovered CEM3s as it does with CEM+s when it is configured to do so. Cobalt console will attempt re-connect CEM3s when a network disconnect occurs as it does with CEM+s.

Press MODIFY to open the Net3/ACN Device List

<table>
<thead>
<tr>
<th>Device</th>
<th>Name</th>
<th>Status</th>
<th>Manufacturer</th>
<th>Model</th>
<th>Config</th>
<th>IP</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Cobalt</td>
<td>Active</td>
<td>ETC</td>
<td>RFR Host</td>
<td></td>
<td>10.211.55.3</td>
</tr>
</tbody>
</table>

**HINTS (5.1)**

RFR BaseStation and RFR Handheld devices are shown in the list. RFR Host is shown as active.
**Screens (8.0)**

You can store all screen settings including screen areas, zoom and channel format into 100 screen memories.

The screen areas are set up with the screen browser in the top right hand corner of every screen. Select a screen area layout and it will be activated immediately. No tabs are closed. To open a tab in an empty area press the "+" sign in the top left corner. See Tabs. To record the areas and tabs in all screens use the Record Screen function in the Direct Selects, hold RECORD and press one of the screen select buttons in the console, or use the RECORD option in this tab. See Screens.

The first six are accessible by the screen buttons between the touch screens. To record hold RECORD and press one of the buttons - the current screens are stored to that button. Button 1 (top left) is default and cannot be overwritten. You can also record screens in the Screen tab. See Record Screens (8.0).
When you press a screen key, all screens will change to the stored layout and format.

These Screens can be accessed from the Browser (Browser>General Settings>Screens) and the Direct Selects. Screens can also be recorded in the Direct Selects. (See Cobalt Direct Selects: Special Functions)

You can resize all areas using mouse or trackball on the divider lines - with a touch screen you can activate Resize handles by selecting "Resize" in the middle section. Click again on the resize symbol in the top right corner of the screen to finish.
Record Screens (8.0)

Screens can be recorded directly to the screen keys in the consoles, in the screen tab and in the Direct Selects.

To the screen keys

1. Hold RECORD and press a SCREEN KEY.
2. You will get a popup where you can name the screen.

In the screen tab

1. Open the screen tab (click on the symbol in the top right corner of all screens)
2. Click on the RECORD symbol. All recordable screen symbols will be highlighted and you can select an existing one or NEW.
3. You will get a popup where you can name the screen.
In the Direct Selects

1. Open the Direct Selects tab
2. Click on TYPE and select SCREENS for a section
3. Click on RecordDS
4. Click on any Screen button to record the current screens. If it is a new one, you will get a chance to name it.
Load screen

You can load a screen from the Screen Keys in the consoles, from the screen tab, from the Direct Selects or from the Browser. To load from the Browser, select the screen and press MODIFY or double click.
Delete or Rename Screens - Screens List (8.0)

Open the screen list in the Browser > General Settings > Screens... to see, rename and delete screens.

This is the list
Select a screen and press DELETE. You will get a popup allowing you to confirm.

You can rename Screens also in the Direct Selects, like any other Direct Select content - Hold TEXT and click on the button.
User List

User logins allow you to keep personal settings for Direct Selects, Screens and Notes, within the same Play as other users.
See Direct Selects, and Notes.

It's also possible to connect Partitions to User Logins, which makes it possible to have a User Login with a predefined set of channels that can be accessed by that user.
See Partitions.

You can view, edit and create new Users in the User List (Browser >General Settings >User List).

User List - Columns

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>User</td>
<td></td>
<td>The ID of each Partition. Cannot be changed.</td>
</tr>
<tr>
<td>Name</td>
<td>[MODIFY]</td>
<td>Press MODIFY to activate and end text input. This text is shown in the top of the screens.</td>
</tr>
<tr>
<td>Default Partition</td>
<td>[MODIFY]</td>
<td>Toggles the Default Partition on/off. This is the partition that will be activated when this User logs in.</td>
</tr>
<tr>
<td>Allowed Partitions</td>
<td>[MODIFY]</td>
<td>Opens the User Partition List where it is possible to toggle the permission for each Partition on/off *</td>
</tr>
</tbody>
</table>

* Please note that the Default Partition has to be set to On in the User Partition List as well - this is done automatically.
NOTE
The default Users "Default" and "View" are defined to allow access to the full system.

Create a User Login

User Logins are created in the User List.

1. Open the User List (BROWSER >General Settings >User List).
2. Press INSERT to create a new User.
3. Select the Name cell and press MODIFY to enter a text label.
4. Select Default Partition (press MODIFY in the Default Partition cell)

Allowed Partitions
When a new user is created, the Default Partition is set to ALL, and all Partitions are set as Allowed. You can disallow Partitions for a User by pressing MODIFY in the Allowed Partitions cell - opening the User Partition List.
**Change User**

User Login is activated from the command Change User in the Browser. If no User has been logged in, the Default User will be logged in when a Play is opened.

1. Select the node Change User and press MODIFY (BROWSER > General Settings > Change User). You will get a popup where you can choose from all defined Users.

![Change User popup]

2. The User is activated and indicated in the top left corner of all screens:

![User activation]

Any Partitions associated to this User will be activated. See [Partitions](#).

**NOTE**
The last used login name will be remembered in each station and used for the next startup.
Event List

An Event combines a Trigger with an Action Macro.

Action Macros are a powerful way of creating commands inside Cobalt and to control external devices.

Triggers can start Cobalt commands from external inputs like the COM port (unison macros for example).

This chapter contains the following sections

- Event List - Introduction
- Event List - Action Macros
- Event List - Events
Event List - Introduction

An Event is a combination of a Trigger and an Action Macro. An Action Macro can be defined also directly in the step of a Sequence.

Action Macro
An Action Macro consists of a string of characters forming a line of commands. These commands can be used to trigger internal actions (Go, Pause etc) or external devices (DVD players, computers etc) with serial & MIDI commands.

Trigger
A Trigger is used only to trigger an Action Macro. This can be done from the local Com or MIDI ports, Closure or through a Net3 node.

Event
An Event is created when a Trigger is combined with an Action Macro.

NOTE
The COM port of Cobalt has to be activated to receive Triggers. See System Settings - Com Port.
**Event List - Action Macros**

An Action is a kind of Macro that consists of a string of characters forming a line of commands. These commands can be internal (Cobalt) or external (COM port serial communication with DVD player, computers etc). Action Macros can be entered directly in the Sequence Action Macro column (see [Sequence List - Columns](#)). Action Macros can be linked to Triggers in the Event list.

In the **Playback View** Action Macros are shown with the "*" character or the word "Action Macro" depending on format.

See also [Serial Com Data](#) and [MIDI Data](#).

**Action Macro Rules**

The rules for all Action Macros are very strictly defined. There is no warning if your formatting is wrong.

- An Action Macro starts with an action type (for example COM, MIDI, GO, RELAY). The commando is followed by a list of parameters, separated by commas.
- Parameters in <> are optional.
- Multiple commands can be entered in the same Action Macro, separated by a semicolon ; character.

**Cobalt Action Macros (8.2)**

These are the available Cobalt Action Macros. Some have changed from over the years. Please note that existing Action Macros using the changed commands will not be converted automatically. They have to be manually updated to work as expected. To access Action Macros from the Direct Selects tab see [Action Macro List](#).

Remember the RULES.
<table>
<thead>
<tr>
<th>Function</th>
<th>Command</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master START (8.2)</td>
<td>START Mx &lt;,target&gt; &lt;,time&gt;</td>
<td>Moves Master x to 'target' percent in 'time' seconds. From 8.2 if you do not specify a time, the time of the master will be used.</td>
</tr>
<tr>
<td>Master GO</td>
<td>Go Mx &lt;,preset&gt; &lt;,time&gt;</td>
<td>Mx,preset,time. If Preset is omitted, a simple GO command is made, otherwise a GOTO (preset) is executed. If Time is set, it will replace sequence timing.</td>
</tr>
<tr>
<td>Playback GO</td>
<td>Go PB &lt;,preset&gt; &lt;,time&gt;</td>
<td>As per Go Mx but in the Main Playback.</td>
</tr>
<tr>
<td>Master PAUSE</td>
<td>Pause Mx</td>
<td>Pause fade on master.</td>
</tr>
<tr>
<td>Playback PAUSE</td>
<td>Pause PB</td>
<td>Pause fade on playback.</td>
</tr>
<tr>
<td>Run Macro #</td>
<td>Macro x</td>
<td>Executes macro x</td>
</tr>
<tr>
<td>Change Page #</td>
<td>Page x&lt;,y&gt;</td>
<td>Selects page x on bank y (1=lower bank 1-20), (2=upper bank 21-40).</td>
</tr>
<tr>
<td>Relay Status</td>
<td>Relay Groupx,Relayx,ON/OFF</td>
<td>Sets the status of relay 1-24, in relay group #. Group 0 is local to the console.</td>
</tr>
<tr>
<td>UDP String</td>
<td>UDP &lt;String&gt;</td>
<td>Sends an UDP string to the port and IP defined in System Settings.</td>
</tr>
<tr>
<td>COM</td>
<td>COM grp,data*</td>
<td>Sends COM data to a port. Grp = 0 is local Grp &gt;0 us a serial port in ACN.</td>
</tr>
<tr>
<td>MIDI</td>
<td>MIDI grp,data*</td>
<td>Sends MIDI data to a port. Grp = 0 is local Grp &gt;0 us a serial port in ACN.</td>
</tr>
<tr>
<td>OSC</td>
<td>OSC &lt;String&gt;</td>
<td>Sends an OSC string to the OSC devices defined in System Settings.</td>
</tr>
<tr>
<td>Load Sequence to master playback (7.2)</td>
<td>LOADSEQUENCE Mx,s</td>
<td>Loads sequence s to master playback x</td>
</tr>
<tr>
<td>Load Sequence to main playback (7.2)</td>
<td>LOADSEQUENCE PB,s</td>
<td>Loads sequence s to the main playback</td>
</tr>
<tr>
<td>Set screen backlight (7.2)</td>
<td>SCREENBACKLIGHT x</td>
<td>x is a value between 1-10. Only works on built in Cobalt screens.</td>
</tr>
<tr>
<td>Restore screen backlight (7.2)</td>
<td>SCREENBACKLIGHT restore</td>
<td>Only works on built in Cobalt screens</td>
</tr>
<tr>
<td>Load Screen Layout (7.2)</td>
<td>SCREENLAYOUT x</td>
<td>Load screen layout with index x (there are no id numbers on screen layouts).</td>
</tr>
<tr>
<td>Execute Action Macro (7.2)</td>
<td>ACTIONMACRO x</td>
<td>Execute action macro x</td>
</tr>
</tbody>
</table>
NOTE
*Data, is a special format that allows ASCII and Hex code to mix.

Every byte is represented by one or two characters.

One character = ASCII
Two characters = HEX

"1 2 3 0D 0A" sends ASCII characters 1, 2, 3 followed by a Carriage return (0D in Hex) and Line feed (0A in Hex)

Examples
Observe that there is no space before or after a comma.

Go M3,100 (Master 3 GOTO Preset 100 in default time)

Go PB,1 (Goto Step 1 in the sequence of the Main Playback)

Relay 1,2,ON (Set relay 2 in group 1 to ON)

See also OSC Functionality

Serial COM data

In an Action Macro, this data is started with the word COM. Two parameters are used after the COM type.

- Group number (group 0 is the local console) followed by a comma.
- The parameter values (hexadecimal or ASCII)

RULES

- You can mix ASCII and hexadecimal values.
- The data bytes are separated by a space character.
- A hex byte is always written as two hexadecimal characters (like AE) followed by a space.
- An ASCII character is written as a single character followed by a space.
- Carriage return is written 0D.
- Line feed is written 0A.
- Tab is written 09.

Examples

COM 1 ,ee 0e 00 00 40 M a c r o 1 . E X E C 00 00 (ETC Unison system example string)

COM 1 ,41 42 43 sends a serial string with three bytes (all values in hex)

COM 1 ,P L A Y 1 sends a serial string with the value PLAY1 (ASCII data)
COM 1 ,P L A Y 1 0D sends a serial string with the value PLAY1 followed by Carriage Return.

MIDI Data

You can send an arbitrary data string on the console MIDI port, or through MIDI on a Net3 Gateway.

In an Action, this data is started with the word MIDI followed by port, comma and data.

RULES

When specifying data for a MIDI port trigger or Action, you enter the string with hexadecimal values.

- Group number (group 0 is the local console) followed by a comma.
- The data bytes are separated by a space character.
- A hex byte is always written as two hexadecimal characters (like 7E) followed by a space.
- Basically any type of MIDI message can be sent from an Action Macro. Note On, Note Off, Program Change and System Exclusive (including Midi Show Control) messages are most frequently used.

Examples

MIDI 0, 90 24 40 sends a Note On message to the console output on Channel 1 for note 24 (36 in decimal) with a velocity of 40 (64 in decimal)

MIDI 1, 80 24 00 sends a Note Off message on group 1 in a Net3 Gateway on Channel 1 for note 24.

More examples for the local console port

MIDI 0, F0 7F 01 02 01 01 F7 sends a Midi Show Control (System Exclusive) command: GO

MIDI 0, F0 7F 01 02 01 31 30 F7 sends a Midi Show Control (System Exclusive) command: GOTO Cue 10

MIDI 0, C0 10 sends a Program Change message (on channel 1) for program 10 (16 in decimal)

UDP data

UDP (User Datagram Protocol) is a communications protocol where messages are exchanged between computers in a network that uses the Internet Protocol (IP). UDP is an alternative to the Transmission Control Protocol (TCP) and, together with IP, is sometimes referred to as UDP/IP.

In Cobalt UDP allows you to use the Ethernet network to:

- Receive Cobalt specific Action Macros directly from another unit, without having to first create a trigger and event.
- Send any proprietary string of data to another unit that can receive commands over UDP
Receiving Action Macros over UDP
For Cobalt to receive Action Macros you need to set a receive port in the Play Settings - Show Control (Browser > General Settings > Play Settings) and make sure that the incoming Action Macro text strings are written by the rules for Cobalt Action Macros explained in that chapter. An incoming Action Macro is processed the instant it is received.

Sending UDP Strings
For Cobalt to send Action Macros a send port and IP address have to be set up in the Play Settings - Show Control (Browser > General Settings > Play Settings) and the text string you send needs to be written according to the specifications of the receiving device.
**Event List - Events**

To trigger an Action Macro from an external input an Event has to be created and a Trigger has to be defined. This is done in the Event List.

For each type of trigger (input), an Event list needs to be created. This is to allow for future expansion of both internal ports and network ports.

1. Open the Event List

   ![Event List Table]

   Insert an item (INSERT) and define a Trigger (you can add a description).

2. Open the editor by pressing MODIFY in the first column.

   ![Event List Editor]

   Available choices: Modify Insert Delete
3. Use INSERT to insert a new line. Define the Trigger and Action string using the formats described in Actions & Events - Actions. You can add a description as well (recommended). Press MODIFY in TEST EXECUTION to run an event.

**Triggers for Events**

An Event is a way to link a Trigger to an Action Macro. A Trigger can be serial communication received on a COM or MIDI port of the console. Note that COM x,' and 'MIDI x,' are not required in Triggers.

- **Local Com-port** - See Serial COM data
- **Local MIDI-port** - See MIDI and Serial MIDI data
- **Net3 I/O Node Com-port**
- **Net3 I/O Node Closure** - You can specify the closure input (1-24) and if you want to trigger on close of open state. Note: Closure input are using the analog inputs of the physical node but has only two states, on and off.
- **Net3 I/O Node Analog** - You can specify an analog input (1-24), a trigger value and the direction.
- **Local Closure** - You can define triggers and actions for the external trig inputs in the same way as for Net3 I/O node closures. If a trigger is defined for an input, the default action (Go, Pause, Go Back and Master 40) won’t be carried out. See Connectors

**Group Numbers**

Using Group numbers, you can set up a system where Cobalt listens to several different I/O nodes (or local ports) and reacts with different actions. Group 0 applies to local serial and MIDI ports, Group 1-x applies to network ports and has to match the group configured in the node.
Macro List

A Macro is basically a series of key presses and actions that are stored under a number for random playback.

NOTE 7.3
If you have used Cobalt master/flash/encoder buttons in a button macro, you would need to re-record these when brought into 7.3 due to internal changes to button mapping.

- Macros can be recorded and played back in real time or fast.
- Macros can be linked to a sequence or chase step.
- Each Macro can have a text label.
- Macros can not be edited.
- There is an indication in the top right corner when a Macro is being played back.

The Macro List is opened by holding MODIFY and pressing MACRO. In the list it is possible to toggle between real-time and fast playback - and set a text label.
Macros - Record & Playback

Macros are recorded with the LEARN MACRO soft key of the Misc Soft key page in the consoles.

![Diagram showing Misc Soft Key page with Learn Macro highlighted]

Record a Macro

1. Select the Misc Soft Key page.

2. Enter a number and press LEARN MACRO. As long as recording is going on the text "Recording macro" is displayed in the top right corner of the screens.

   ![Recording macro]

3. Click on **Recording Macro** in the top right corner of the screens to end recording.

Playback a Macro

Enter the number and press MACRO. As long as the Macro is being played back the text "Playing macro" is displayed in the top right corner of the screens.

![Playing macro]
**Action Macro List**

The Action Macro list (Browser>General Settings>Action Macro List) allows you to create Action Macros that are available in the Direct Select tab (DS) as screen buttons. For information on how to create an Action Macro see Event List - Action Macros.

Each Action Macro will appear on the DS button with the corresponding number when the content type Action Macro is selected. If you rearrange in the DS dock the Action Macros will be rearranged in the list, since the number corresponds to a button.
Before you can control a channel or moving device, it needs to be patched.

Patching Node

This chapter contains the following sections

- Patch - Introduction
- Patch by Channel/Dimmer
- Import Template Wizard
- Patch Wizard
- Device List
- RDM Device List
- Clear Offline RDM devices
- Settings and Tools
  - Channel List
  - Output List
  - Parked
  - Templates...
  - User Templates
  - Parameter Definitions
  - Dimmer Curve List

See RDM Functionality

>Settings and Tools - Patching
Patch - Introduction

Patch is where outputs are assigned to channels, either directly in the case of dimmers or using a Template in the case of devices. All settings pertaining to outputs, channels and devices are also adjusted within the patch.

Before you can control a dimmer or device it has to be patched to a channel. When opening a new play you can choose to set the Patch 1:1 or cleared. There are many ways to patch. These are the available options.

Patch by channel or output
Depending on how you mount your rig you may want to patch by output (not knowing which output is connected to which light) or by channel (having a plot). Both are done easily in the Output Editor. See Patch by Channel/Dimmer.

- To edit Channel scale factor, fade curve, park status or rename, see the Channel List.
- To edit Output scale factor, fade curve & park status, see the Output List.
- To clear the patch see the Patch Wizard.

Patch multiple moving devices
Before you can patch a moving device, you need to import the template using the Import Template Wizard. See Import Template Wizard.

Once a template is imported, you can adjust it and patch single or multiple devices using either the Patch Wizard, or the Device List. See Patch Wizard. See Device List.

- To adjust individual devices, such as inverting or swap pan/tilt. Scroller roll & calibration. Change template, channel or address. See Device List.

Channel Database
The channel database allows you to tag each channel handle with up to four texts. These texts will create auto-groups. See Channel Database.

Flexible Patching (7.1)

You can patch within up to 32 universes (12 with Congo). You are free to patch dimmers or devices to any of these universes. The universe map decides which actual universes on the network they are transmitted to. You should be able to use sACN universe numbers up to 9999.

- Output values above the maximum allowed output count are now forced to 0%
- The system counts all patched outputs and shows a title bar indicator “Output limit reached”.
- About Cobalt: Shows the total amount of outputs, how many that are used and how many that remains.
**Patch by Channel/Dimmer**

Press OUTPUT in the [programming section](#) to open the Output Editor. (BROWSER >Patching >Patch by Channel/Dimmer)

From here you can patch by channel or by dimmer.

1. Select by Output or by Channel.
2. View Outputs in different formats (All, patched, unpatched, selected)
3. Universe number
4. Output number
5. Levels are shown in 8 bits (0-255). Changing Levels are shown with a blue background for going up.
6. Levels are shown with a green background going down
7. Number of the channel this output is patched to
8. Unpatched outputs
9. A device is held together with a color, and all parameter names are shown for each output.

(See Patch - Introduction)

**Output Editor - Formats**

The currently selected format is indicated in the top right corner. You can toggle between these formats by pressing FORMAT, or from the context menu (touch or click on the current format title).

- All outputs
- Patched
- Un-patched
- Selected

**Level of detail**
Compact level of detail (Hold FORMAT and press down/up arrow).
High level of detail
Zoom Out
Hold FORMAT and move the level Wheel to zoom out/in. When you zoom out you will see all available universes.
Output Editor - Patch By Channel

As soon as a channel is selected, the Output Editor is automatically in channel mode. Select a single channel or a range of channels to patch to Outputs. Use 0 MODIFY to unpatch.

Patch a single channel

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select channel</td>
<td># CHANNEL</td>
<td>Channel is selected.</td>
</tr>
<tr>
<td>2. Patch to output</td>
<td># MODIFY</td>
<td>A popup will ask if you want to replace existing output(s)*</td>
</tr>
<tr>
<td>3. Confirm</td>
<td>MODIFY</td>
<td>Patch is complete.</td>
</tr>
</tbody>
</table>
Patch a channel range

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select channel range</td>
<td>Channel</td>
<td>Channels are selected</td>
</tr>
<tr>
<td></td>
<td>functions</td>
<td></td>
</tr>
<tr>
<td>2. Patch to output(s)</td>
<td>[#] MODIFY</td>
<td>A popup will ask if you want to patch a range of outputs starting at #</td>
</tr>
<tr>
<td>3. Confirm</td>
<td>MODIFY</td>
<td>Patch is complete.</td>
</tr>
</tbody>
</table>

Output Editor - Patch By Dimmer

As soon as an output is selected, the Output Editor is automatically in outputmode. Select a single output or a range of outputs to patch to channels. Use 0 MODIFY to unpatch.

Patch a single output

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select output</td>
<td>[#] OUTPUT</td>
<td>Output is selected. You can use the format output.universe.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2. Patch to channel</td>
<td>[#] MODIFY</td>
<td>A popup will ask if you want to replace existing channel*</td>
</tr>
<tr>
<td>3. Confirm</td>
<td>MODIFY</td>
<td>Patch is complete.</td>
</tr>
</tbody>
</table>
Patch an output range

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select output range</td>
<td>Output functions</td>
<td>Outputs are selected</td>
</tr>
<tr>
<td>2. Patch to channel(s)</td>
<td>[#] MODIFY</td>
<td>A popup will ask if you want to patch all to one channel or as a range*. Use 0 to unpatch selected outputs.</td>
</tr>
<tr>
<td>3. Confirm</td>
<td>MODIFY</td>
<td>Patch is complete.</td>
</tr>
</tbody>
</table>

*
Output Editor - Dimmer Check Mode

Dimmer Check mode is a fast way to check the outputs consecutively.

1. Select first output with # OUTPUT

2. Set a level for checking with # @ LEVEL (a level is given between 0-255. 128 = 50%)

3. Press + or - to use this level and step to the next/previous Output. Levels that are higher than zero are restored automatically as they are passed by.

4. Deselect the last output to leave channel check mode (0 OUTPUT). Or, simply set that output to a level of 0% (0 @ LEVEL or use the wheel)

Output Editor - Channel Check Mode

Channel Check mode is a fast way to check the channels consecutively in the output editor.

1. Select first output with # CH

2. Set a level for checking with # @ LEVEL (a level is given between 0-255. 128 = 50%)

3. Press + or - to use this level and step to the next/previous patched channel. Levels that are higher than zero are restored automatically as they are passed by. Channels that are not patched will not be lit.

4. Deselect the last channel to leave channel check mode (0 CHANNEL or C/ALT CH). Or, simply set that channel to a level of 0% (0 @ LEVEL or use the wheel)
**Import Template Wizard**

Before you can patch a moving device you need to import or create the corresponding template.

- To import from the libraries, use the Import Template Wizard in the Browser (Browser > Patching > Import Template Wizard).
- User templates from other Plays are imported with the Import Wizard. See Import Wizard.
- Custom templates can be created from scratch with the Templates Editor.
- You can save and import user templates to the User Library.

1. **Open Import Template Wizard from Browser > Patching > Import Template Wizard**

   ![Import Template Wizard](image)

   The imported template(s) will be added to the Template List but you have to assign them manually using the Patch Device or Device List commands.

   To import a template from a play, use the Import Organizer instead.

   **Imported Templates**
   - Scroller, Scroller Speed & Fan, VL 2500 Spot, VL 2500 2 Wash, RGB

2. Select Library (Extended, Standard or User - see NOTE below).

3. Filter by manufacturer or model, press Import Selected Template. The imported Template is added to the "Templates" node of the Browser > Patching.

   **Using the Filter:** The tree is refreshed when you stop typing. If you type several words, the tree will show nodes that match all words in manufacturer or model fields combined.
Devices with calibrated color data are indicated - this means they will be possible to use with the Gel Picker and calibrated Color Picker even if they have more than three color emitters.

It is possible to select the tree view when focused by pressing MODIFY (similar to how we enter a text field). You can then navigate inside the tree view with the arrow keys. Leave the tree view by pressing MODIFY again.

**NOTE**

*Standard or Extended Library?*

There are two default libraries of templates - standard (smaller) and extended (larger) - both are accessed from the Import Template Wizard. We recommend that you first check the extended library (default).

The standard library is the one that's been in Cobalt from the start. All templates are hand-made. The Extended library is data we get from the Carallon subscription service and is made by crunching a lot of data. The templates are as good as Carallon (with some work from ETC) can make them, but they have not all been tested with real lights or adjusted.
User Library

The User Library is where you can store all templates you create, and/or imported templates that you have modified, and wish to be able to use in other shows by importing them with the Import Template Wizard.

See User Templates.
**Patch Wizard**

The Patch Wizard is opened from the Browser (Browser >Patching >Patch Wizard). See [Navigating - Browser](#).

There are four sections

- Patch Dimmer - patch one, or a range of dimmers
- Patch Device - patch one, or a range of devices
- Set/Clear - clear or reset a range/all outputs, devices or renaming.
- Clone - will copy all matching parameter data from a source channel, providing target channel is patched to a template first.

**Patch Dimmer(s)**

Enter the number of dimmers, the desk channel, DMX address and universe. If you check Replace existing dimmers, these will be unpatched automatically.
Patch Device(s)

Select a template from the list, or open the Import Template Wizard. See Import Template Wizard. Importing a template will add it to the list in this dropdown.

Enter the number of devices, desk channel, DMX address and universe. When the device type and number of devices are specified the required block of outputs is indicated in italic over the DMX Address (see image). The first free DMX address and output offset is suggested too.

If you check Replace existing dimmers (default), they will be unpatched automatically. If you are patching scrollers, you can select a scroller roll. You can assign a scroller roll later as well, from the device settings list.

Output Offset allows you to set an offset from the first attribute of each moving device to achieve a specific numbering for the start addresses.
NOTE
Patched devices are automatically set to default values.
See Home Positioning.

NOTE
As soon as a moving device is patched, the channel symbol in the channel views will get an extra field for moving device information.

Set/Clear patch or rename

You can reset (1:1) or clear the dimmer patch, the moving device patch, or the renaming system for any channel range from # to #. If you check "Apply To All" you don't need to specify a range. Unpatch All clears channel, device and name patch.
These are the options in the Clear wizard tab

See Renaming Channels

NOTE
Checking Apply To All clears everything up to the total system limits regardless of any prior downgrade of channels/outputs.

Clone Device(s) in Patch (8.0)

Clone allows you to copy all data from a single source channel to a selection of other channels to increase the number of fixtures in a show, for example "yesterday I had 8 back lights, now I have 10" - and get the base data into them quickly.

In the example above this is done by copying the data from one of the original 8 backlights into the 2 newly patched additional channels. The Clone feature copies all palette, preset and cue data from the source channel to the new channels. If the source channel is included in a group, the new channels are added at the intensity level of the source channel. From this point you can edit at will.
Example

1. Open Patch Wizard
2. Activate Clone tab
3. Select target channels (they shall already have templates assigned in the Device List).
4. Select source channel
5. Press Execute

The parameter data from the source channel is cloned to the parameters of the target channels.

The clone function requires that the target channels are patched with an appropriate template and configured before cloning. Best results are obtained when the target channels use the same template as the source channel.

Cloning to a different fixture type
Cloning will copy all matching parameter data from a source channel to target channels across the play file. Parameters are matched by name. Cloning copies raw DMX values, so some editing may still be needed after cloning. Parameters that do not match between source channel and target channels will be hidden.
The Clone function requires that the target channels be patched with appropriate template and configured before cloning.

Cloning will copy all matching parameter data from source channel to target channels across the play file - parameter names must use the same name and number in the parameters definition list to be copied properly.

Parameters that do not match between source and target will be hidden.

Specify a source channel below and the target channel(s) above

Source channel

Execute
**Device List**

Hold MODIFY and press DEVICE to open the Device List where you can view and edit moving device settings. (BROWSER >Patching >Device List).

See [Introduction To Patching](#)

Remaining outputs are indicated in the hint text line at the bottom.
## Device Settings - Columns & Functions

<table>
<thead>
<tr>
<th>Column</th>
<th>Input</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item</td>
<td>No input</td>
<td>The number of this item - cannot be edited here.</td>
</tr>
<tr>
<td>Channel</td>
<td>0-3072</td>
<td>The number of the desk channel this device is assigned to.</td>
</tr>
<tr>
<td>Template</td>
<td>Dropdown menu</td>
<td>Shows the device template - dropdown to change. Use the Import Template Wizard to import templates.</td>
</tr>
<tr>
<td>Device Address</td>
<td>#.#</td>
<td>Shows the device address - change by address.universe. You can change universe by &quot;.universe&quot;</td>
</tr>
<tr>
<td>Inv. Pan</td>
<td>Off/On</td>
<td>You can invert pan for this device on the input (manual control) or output (stored data)</td>
</tr>
<tr>
<td>Inv. Tilt</td>
<td>Off/On</td>
<td>You can invert tilt for this device on the input (manual control) or output (stored data)</td>
</tr>
<tr>
<td>Swap Pan/Tilt</td>
<td>Off/On</td>
<td>Swap pan/tilt for this device.</td>
</tr>
<tr>
<td>Scroller Roll</td>
<td>Dropdown menu</td>
<td>Shows the assigned scroller roll - dropdown to change. See Scroller Rolls.</td>
</tr>
<tr>
<td>Calibration Editor</td>
<td><strong>MODIFY</strong></td>
<td>Press MODIFY to open the Calibration Editor for a specific scroller roll. See Calibrate Individual Scroller Rolls.</td>
</tr>
</tbody>
</table>
Device Settings - Patching

It is possible to Patch devices directly into the Device Settings tab. You can use any channel selection to patch fast.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert a new Device</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete the selected Device</td>
<td>DELETE</td>
<td></td>
</tr>
<tr>
<td>Insert the current channel selection as devices</td>
<td>INSERT</td>
<td></td>
</tr>
<tr>
<td>Change template for multiple devices</td>
<td>SELECT</td>
<td></td>
</tr>
<tr>
<td>Change address for multiple devices</td>
<td>SELECT</td>
<td></td>
</tr>
<tr>
<td>Unpatch a device</td>
<td>0 MODIFY</td>
<td></td>
</tr>
</tbody>
</table>

A new Device is inserted.
The selected Device is deleted. You can only delete one device at a time.
The current channel selection is inserted as Devices.
Use SELECT to select multiple cells. Select a new template from the dropdown and press MODIFY *
Use SELECT to select multiple cells. Enter a start address and press MODIFY.
In the Address cell you can unpatch the currently selected devices by entering 0.

*If a template isn't available, use the Import Template Wizard to import it. See Import Template Wizard.

NOTE
When you patch a template with multiple parts, separate devices will be created for the various parts and decimal channel numbers will be assigned. Changing the start address of the base channel will update the sub devices accordingly.
Edit/Change a Device

You can exchange one moving device with another in the Device List. All parameters that are similar will continue functioning.

<table>
<thead>
<tr>
<th>Function</th>
<th>Where</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Device Type*</td>
<td><strong>Device Settings</strong>,</td>
<td>Press MODIFY to get a dropdown with all templates. Select a new device template.</td>
</tr>
<tr>
<td></td>
<td>Template column</td>
<td></td>
</tr>
<tr>
<td>Change Device Address</td>
<td><strong>Device Settings</strong>, Device Address column</td>
<td>Enter a new device address with address.universe. You can change universe only by &quot;.universe&quot;</td>
</tr>
<tr>
<td>Change Device Channel</td>
<td><strong>Device Settings</strong>, Device Channel column</td>
<td>Enter a new device channel.</td>
</tr>
<tr>
<td>Delete Device</td>
<td><strong>Device Settings</strong></td>
<td>Press DELETE in any row.</td>
</tr>
</tbody>
</table>

* All play information that can be read by the replacement device template will be used. You can swap back to the first device at anytime later. This is useful if you have to replace one type/brand of Moving Device with another.
>Settings and Tools - Patching

These are the settings and tools for Patching.

This chapter contains the following sections

- Channel List
- Output List
- Parked
- Templates
- User Templates
- Parameter Definitions
- Dimmer Curve List
Channel List

Hold MODIFY and press CHANNEL to open the Channel List. You can view and edit dimmer outputs, scaling and constant ch level in the Channel List (BROWSER >Patching >Settings & Tools >Channel List).

See Patch - Introduction for more information.

### Channel List

<table>
<thead>
<tr>
<th>Channel</th>
<th>Dimmer Address</th>
<th>Device</th>
<th>Device Address</th>
<th>Scale</th>
<th>Park</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1.1</td>
<td>Revolution</td>
<td>31.1 (-61)</td>
<td>100 %</td>
<td>---</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>2.1</td>
<td></td>
<td>----</td>
<td>100 %</td>
<td>---</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>3.1</td>
<td></td>
<td>----</td>
<td>100 %</td>
<td>---</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>4.1</td>
<td>Revolution</td>
<td>62.1 (-92)</td>
<td>100 %</td>
<td>---</td>
<td>4</td>
</tr>
<tr>
<td>5</td>
<td>5.1</td>
<td></td>
<td>----</td>
<td>100 %</td>
<td>---</td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td>6.1</td>
<td></td>
<td>----</td>
<td>100 %</td>
<td>---</td>
<td>6</td>
</tr>
</tbody>
</table>

**Channel Info: Pipe Front**

**NOTE**
When a step is selected, the corresponding channel and output are selected in the Live and Output Editor tabs
# Channel List - Columns & Functions

<table>
<thead>
<tr>
<th>Column</th>
<th>Input</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel</td>
<td>No input</td>
<td>The number of this Channel - cannot be edited here (see Output List).</td>
</tr>
<tr>
<td>Dimmer Address</td>
<td>#.#</td>
<td>Enter the address, followed by decimal point and then DMX universe. You can change the universe by entering &quot;,.#&quot;</td>
</tr>
<tr>
<td>Dimmer Address</td>
<td>MODIFY</td>
<td>Opens an Output Editor for adding multiple outputs or editing.</td>
</tr>
<tr>
<td>Device</td>
<td>No input</td>
<td>Shows the device template - cannot be edited here (see Device Settings).</td>
</tr>
<tr>
<td>Device Address</td>
<td>#.#</td>
<td>Enter the address, followed by decimal point and then DMX universe. You can change the universe by entering &quot;,.#&quot; (see Device Settings).</td>
</tr>
<tr>
<td>Scale</td>
<td>0-200%</td>
<td>Sets the scaling factor for the intensity of this channel.</td>
</tr>
<tr>
<td>Park</td>
<td>0-100%</td>
<td>Shows the level a channel is parked at. Set a level with # MODIFY and remove with C &amp; MODIFY. See Park.</td>
</tr>
<tr>
<td>Name</td>
<td>0-6144</td>
<td>Enter the number and press MODIFY to change a channel name (see Renaming Channels).</td>
</tr>
</tbody>
</table>
## Channel List - Select & Patch Channels

It is possible to select and patch channels to outputs directly with a Command Syntax in this list (this does not work in At Mode).

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a channel</td>
<td>[#] CHANNEL</td>
<td>The channel is selected in the list and in the Live tab.</td>
</tr>
<tr>
<td>Add a channel to this selection</td>
<td>[#] +</td>
<td>The channel is added to the current selection.</td>
</tr>
<tr>
<td>Add a range of channels to this selection</td>
<td>[#] THRU</td>
<td>The channel range is added to the current selection.</td>
</tr>
<tr>
<td>Patch a range of outputs to this selection</td>
<td>[#] MODIFY</td>
<td>The output range is patched to the current selection. A popup will warn if outputs are in use already. Once the current channel is patched the next channel is auto-selected so you can continue entering # MODIFY, # MODIFY... to continue patching.</td>
</tr>
</tbody>
</table>
**Patch - Rename Channels**

Hold MODIFY and press CHANNEL to open the Channel List.

You can change the number used to access your instruments, without altering your Patch. This is useful when you want to keep your addresses and dimmer assignments as they are, but you want to change the numbering to fit the numbering of a Plot. Renaming is done in the Name column of the Channel List (BROWSER >Patching >Channel List)
### Change a channel name

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change name</td>
<td># MODIFY</td>
<td>Enter a new name and press MODIFY. If the name exists you will get a warning <em>message</em> about this.</td>
</tr>
<tr>
<td>Change names</td>
<td># MODIFY</td>
<td>Select several cells, enter a start name and press MODIFY.</td>
</tr>
<tr>
<td>Remove selected channel(s) from all channel views</td>
<td>0 MODIFY</td>
<td>If a Name is set to zero, the channel will disappear from all channel views and cannot be accessed until given a name.*</td>
</tr>
<tr>
<td>Clear all channel names</td>
<td>Patch Wizard</td>
<td>All Channel Renames can be cleared from the Patch Wizard.</td>
</tr>
<tr>
<td>Set names 1:1</td>
<td>Patch Wizard</td>
<td>The Rename function can be reset from the Patch Wizard.</td>
</tr>
</tbody>
</table>

*It will not disappear from Channel Layouts.
Output List

Hold MODIFY and press OUTPUT to open the Output List. This is an extremely useful tab for troubleshooting and patching dimmers.

You can view and edit desk channel, scaling and curve for outputs in the Output List (BROWSER >Patching >Output List >Universe #).

See Patch - Introduction
NOTE
The Output List is divided into DMX universes. Open each from the Browser >Patching >Output List >Universe #

Output List - Columns & Functions

<table>
<thead>
<tr>
<th>Column</th>
<th>Input</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output (EDMX)*</td>
<td>No input</td>
<td>The number of this Output (and EDMX) - cannot be edited here.</td>
</tr>
<tr>
<td>Channel</td>
<td>0-3072</td>
<td>Enter the number, followed by MODIFY.</td>
</tr>
<tr>
<td>Proportion</td>
<td>0-100%</td>
<td>Sets a proportional scaling factor for the intensity of this output.</td>
</tr>
<tr>
<td>Curve</td>
<td>dropdown</td>
<td>Shows the output curve. See Dimmer Curves.</td>
</tr>
<tr>
<td>Device Info</td>
<td>No Input</td>
<td>Shows the moving device template and parameter assigned to this output. Cannot be edited - see Device Settings.</td>
</tr>
<tr>
<td>Park</td>
<td>0-100%</td>
<td>Shows the level an output is parked at. Set a level with # MODIFY and remove with C &amp; MODIFY. See Park.</td>
</tr>
</tbody>
</table>

*Output Lists show EDMX numbers in ( ) after the offset.port numbers in the first column. This is a direct translation of EDMX values calculated using the EDMX Start value in the Settings dialog (Cobalt output 1.1 = the EDMX Start number, and all subsequent outputs are calculated from there).

Output List - Select & Patch Outputs

It is possible to select outputs directly with a Command Syntax in this list (only in RPN mode).

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select output</td>
<td># OUTPUT</td>
<td>The output is selected in the list and in the Live tab.</td>
</tr>
<tr>
<td>Add output</td>
<td># +</td>
<td>The output is added to the current selection.</td>
</tr>
<tr>
<td>Add a range</td>
<td># THRU</td>
<td>The output range is added to the current selection.</td>
</tr>
<tr>
<td>Patch to channel</td>
<td># MODIFY</td>
<td>The output selection is patched to channel #.</td>
</tr>
</tbody>
</table>
Parked

Hold PARK and press a channel, parameter group (FOCUS, COLOR, BEAM) or parameter key to park at a fixed value.

Hold UNPARK and press a channel, parameter group (FOCUS, COLOR, BEAM) or parameter key to unpark.

Parking an output or attribute means it will remain fixed at the parked value regardless of all other functionality.
1. When an intensity or parameter is parked there is a PARK indication at the top of every screen.
2. Channels that have parked parameters are dimmed.
3. Parameter cells that are parked are dimmed.

**Park - Parked Items List**

The Parked Items list shows all parked channels, intensities and attributes. Individual items can be unparked by selecting the appropriate row and pressing [DELETE]. See Parked.
A Template maps the functions of a Device to the Device controls of Cobalt. This chapter is about creating and editing Templates.

This chapter contains the following sections

- Templates - Introduction
- Templates - List
- Templates - Editor
- Templates - Create
- Templates - Type LTP or HTP
- Templates - Type 8/16 Bit Control
- Templates - Snap Or Fade
- Templates - Ranges
- Templates - Mode Tables
- Templates - Fade With Intensity
- Templates - Scroller Rolls
- Templates - Import Template Wizard
Templates - Introduction

A template maps the attributes of a moving Device to the controls and functions of Cobalt. Most common devices and scrollers already have templates in the library, ready to use.

General Facts

- Templates can be edited or created at any time.
- Templates are stored to and imported from Plays.
- Change a Template during a show and all similar parameters will continue functioning.
- Table ranges can be set to control modes in devices such as the x.Spot from High End.
- Color mix can follow intensity to dim mixing devices such as the Nesys Quadra.
- Trim the 16bit resolution to finetune control of 16bit parameters.
- Extensive scroller handling with roll libraries and individual calibration per unit.
- Assign any device parameter to a Master and store in a Master Page.
**Templates - List**

The Template List is opened from the BROWSER (Browser >Patching >Settings and Tools >Templates).

![Template List](image)

**Template List - Columns & Functions**

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Template</td>
<td>MODIFY</td>
<td>The ID of each Template. Press MODIFY to open the Editor</td>
</tr>
<tr>
<td>Manufacturer</td>
<td>MODIFY</td>
<td>Manufacturer name. Press MODIFY to activate and end text input.</td>
</tr>
<tr>
<td>Name</td>
<td>MODIFY</td>
<td>Template name. Press MODIFY to activate and end text input.</td>
</tr>
<tr>
<td>Parameters</td>
<td>MODIFY</td>
<td>The number of DMX channels it uses. Press MODIFY to open the Editor.</td>
</tr>
<tr>
<td>Comment</td>
<td>MODIFY</td>
<td>Press MODIFY to activate and end text input.</td>
</tr>
<tr>
<td>Time Stamp</td>
<td>MODIFY</td>
<td>Date and time</td>
</tr>
<tr>
<td>Import Wizard</td>
<td>WIZARD</td>
<td>Opens the Import Template Wizard.</td>
</tr>
</tbody>
</table>
Templates - Editor

The Template Editor is opened from the Item or Parameter cell in the Template List (Browser >Patching >Templates). Open an existing one directly in this node as well (Browser >Patching >Templates >xxxx).
Template Editor - Columns & Functions

Press INSERT to insert a new Parameter. These are the functions in the columns.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter</td>
<td>[MODIFY]</td>
<td>Opens a dropdown. Select parameter.</td>
</tr>
<tr>
<td>DMX</td>
<td># [MODIFY]</td>
<td>Set DMX offset (1-256).</td>
</tr>
<tr>
<td>Type</td>
<td>[MODIFY]</td>
<td>Set HTP (intensity) or LTP 8/16bits.</td>
</tr>
<tr>
<td>Default</td>
<td>[MODIFY]</td>
<td>The default value that is used when patched, and by HOME ATTRIB.</td>
</tr>
<tr>
<td>Highlight</td>
<td>[MODIFY]</td>
<td>The value used in Highlight mode.</td>
</tr>
<tr>
<td>Snap</td>
<td>[MODIFY]</td>
<td>Set Snap or Fade.</td>
</tr>
<tr>
<td>Invert</td>
<td>[MODIFY]</td>
<td>Invert the values of a parameter.</td>
</tr>
<tr>
<td>Ranges</td>
<td>[MODIFY]</td>
<td>Opens the Range Editor for subranges such as gobo positions.</td>
</tr>
<tr>
<td>Tables</td>
<td>[MODIFY]</td>
<td>Opens the Table Editor for table functions.</td>
</tr>
<tr>
<td>Low DMX</td>
<td># [MODIFY]</td>
<td>Set the low resolution DMX offset for 16 bit parameters</td>
</tr>
<tr>
<td>Fine Step</td>
<td>[MODIFY]</td>
<td>See 16 Bit Control - Fine Step</td>
</tr>
<tr>
<td>Fade with int</td>
<td>[MODIFY]</td>
<td>The parameter will follow the intensity of this Device.</td>
</tr>
</tbody>
</table>
Templates - Create

1. Open the Template List from the Browser (Browser > Patching > Templates)

2. Press INSERT to select a new Template at the end of the list.

3. Enter a name in the text column (press MODIFY to activate and MODIFY to store).

4. Press MODIFY in the first column.
This will open the Template Editor, which will be empty.

5. Use INSERT to create as many steps as the Moving Device has control channels.

6. Edit the columns for each step to fit the specification of the Moving Device. Start with Parameter.
7. Continue with DMX channel within the device. These two are the most important. See the rest of this chapter and the manual of the device to specify the rest.
Templates - Type LTP or HTP

Each parameter in a Template can be set to LTP (Latest Takes Precedence) or HTP (Highest Takes Precedence).

- HTP8 is used for 8 bit intensity parameters
- HTP16 is used for 16 bit intensity parameters*
- LTP8 is used for 8 bit parameters
- LTP16 is used for 16 bit parameters*

This is set in the Template Editor.
See [Device Templates - Editor](#).

*Observe that the DMX offset of a parameter has to be incremented by 2, if the previous parameter is set to 16-bit resolution.
See [Device Templates - 16 bit Control](#)
Templates - Type 8/16 bit control

Some Devices have parameters that require 16 bit control. Usually this is Pan, Tilt (LTP16) or intensity (HTP16). This is set in Type cell of the Template Editor.

- HTP/LTP 8 bit - normal 8 bit control
- HTP/LTP 16 bit - 16 bit control

16 Bit Control And Wheel Behaviour

The functionality of "Coarse/Fine 16 bit control" is set in the Attribute Setup. Hold SETUP and press ATTRIB.
On = The wheel controls the Coarse part of the 16-bit value. Hold the wheel key down and move the wheel to control the Fine part of the 16-bit value.

Off (default) = The wheel will control Coarse when moved fast, and Fine when moved slowly.
16 Bit Control - Fine Step

Devices with 16 bit control rarely use all 16 bits. Therefore it is possible to fine tune the resolution of this parameter in the cell Fine Step in the Template Editor.

<table>
<thead>
<tr>
<th></th>
<th>Highlight</th>
<th>Snap</th>
<th>Invert</th>
<th>Ranges</th>
<th>Tables</th>
<th>Low DMX</th>
<th>Fine step</th>
<th>Fade with Int</th>
<th>OSC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>---</td>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>---</td>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>4</td>
<td>4</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Available choices: Modify Insert Delete

Full 16 bit control, which few Devices use (generally Media Servers, for example Catalyst) require this value to be set to 1 (default = 4).
Templates - Snap or Fade

Snap or Fade is defined in the Template Editor (Browser >Patching >Templates >xxxx).

When set to Snap it will not be affected by times. It will move at the beginning of each repositioning.

When set to Linear the parameter will fade on times. See Devices - Times.

Press modify in the Parameter cell to toggle On/Off.
Templates - Ranges

The Template Range Editor makes it possible to define (and edit) ranges, subranges and positions (for colors, gobos etc) in Templates.

This editor is opened by pressing MODIFY in the Range column of the Template Editor.

This is the range editor for the Strobe parameter in a Mac 300™

There is a Range Wizard to create ranges. See Template Range Wizard.
Template Range Editor - Columns

<table>
<thead>
<tr>
<th>Function</th>
<th>Value</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min</td>
<td>0-255</td>
<td>This is the start value for a sub range*. The same value for Min and Max will be treated like a position (for a color or gobo for example). The Min value can be entered in the Min% column as well.</td>
</tr>
<tr>
<td>Max</td>
<td>0-255</td>
<td>This is the end value for a sub range*. The Max value can be entered in the Max% column as well.</td>
</tr>
<tr>
<td>Min%</td>
<td>0-100</td>
<td>The Min value can be entered as % here instead of bits (0-255) in Min.</td>
</tr>
<tr>
<td>Max%</td>
<td>0-100</td>
<td>The Max value can be entered as % here instead of bits (0-255) in Max.</td>
</tr>
<tr>
<td>Text</td>
<td></td>
<td>This text is displayed in all editors, and in with the Parameter Wheels.</td>
</tr>
<tr>
<td>Centered</td>
<td>On/Off</td>
<td>When On, selecting a range will set the output to the middle of the given range. Parameter values are displayed relative to this centre position with +/- steps. This can be useful for speed, rotation or index parameters for wheels, with a stop position in the middle.</td>
</tr>
</tbody>
</table>

*Values between positions (start=stop) cannot be set with the wheel, unless they are specified as subranges.

Template Range Wizard

Press WIZARD in the Template Range Editor. This Wizard simplifies entering a number of evenly spread ranges, for example frames, between 0-255. This is useful to create positions for a scroller, or a gobo/color wheel.

1. Open the Template Range Editor. See Device Template - Ranges.

2. Press WIZARD.
3. Enter the number of ranges you wish to create and press MODIFY.

4. Step to Centered and Snap Positions with arrow keys. Use MODIFY to toggle.
   - Centered = The middle value of a range is always output when selected
   - Snap Positions = Fixed positions (Start = Stop)

5. Select EXECUTE and press MODIFY (previously existing ranges will be overwritten).
Templates - Mode Tables

ModeTables make it possible to control multiple mode devices such as, for example, the High End x.Spot™.

- A set of ranges are defined for a parameter.
- The Table defines which range is used for one parameter based upon the Range setting of another parameter.

In the High End x.Spot™ there are Mode parameters (color mode) that affect the function of another parameter (color wheel). When a mode is set by selecting a Range on one function, the corresponding Table Range will be assigned to the other parameter.

If there are both Range Tables and Ranges defined for a parameter, the Range Table will be used if there is a corresponding range, otherwise the normal Ranges will be used.

Define A Mode Range Table

1. Define the ranges for the different "modes" of the Device. See Device Templates - Ranges.

2. Define Range Tables for these modes in the corresponding function parameter. Start by opening the Range Table editor by pressing MODIFY in the Tables column of the Template Editor.

This is the Template Mode Range Table editor for Gobo in a High End x.Spot™ Color parameter.
3. Use INSERT* to create a Range Tables. These are the options.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter</td>
<td>MODIFY</td>
<td>Opens a dropdown. Select the mode parameter that activates this Range Table.</td>
</tr>
<tr>
<td>Range</td>
<td>MODIFY</td>
<td>Opens a dropdown. Select the range position in the mode parameter that activates this Range Table.</td>
</tr>
<tr>
<td>Ranges</td>
<td>MODIFY</td>
<td>Opens the Range Editor for defining these ranges.</td>
</tr>
</tbody>
</table>

*When you make INSERT for additional Range Tables, the parameter will be copied from the first defined Range Table.
Templates - Fade With Intensity

Fade with Intensity can be set in the Template Editor. This is useful for controlling a softlight or LED fixture with color mix coming from colored fluorescents, that also are light sources. It makes it possible to mix a color and fade the intensity of the result without changing the Hue (color mix result).

This example is from a Color Kinetics™ LED ColorBlast.

When On, the parameter will be scaled through the intensity channel of the device. Also, the types of fixtures where color = intensity will be able to be controlled by the Grand Master and Black Out key when set up with an Intensity parameter.
User Templates

All user templates, new or modified, that are in the User Library are displayed in the User Templates node (Browser >Patching >Settings & Tools >User Templates). This is where you can add templates from your current show file to the User Library, and/or delete user templates from the User Library. See User Library.

- Use INSERT to select a template from the show file to store into the User library.
- Use DELETE to delete a template from the library.

When inserting templates, the system will automatically include part templates that are used by the template you specify.

![User Template library](image)

Available choices: Modify Insert Delete
Parameter Definitions

Parameter types are defined in the first cell or the Template Editor.

Each parameter is used differently. For example, Pan and Tilt automatically belong to Focus Palettes, and are mapped to the trackball in Parameter mode.

Press MODIFY in the Parameter cell to open the dropdown. Select with arrow keys (or use the first letter from the keyboard) and press MODIFY to confirm.

The Parameters are picked from the Parameter Definition Editor. Parameters can be added to this list if necessary. See Parameter Definition Editor.

Parameter Definition Editor

The complete Parameter Definition Editor contains all to this point known parameters. (Browser >Patching >Settings & Tools >Parameter Definitions)
<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter</td>
<td>Parameter ID - cannot be changed.</td>
</tr>
<tr>
<td>Name</td>
<td>The name is used for controlling the parameter. WARNING - Changing an existing name could alter the complete functionality of all Templates</td>
</tr>
<tr>
<td>Palette</td>
<td>The Group defines which Palette and parameter group a parameter will belong to*</td>
</tr>
</tbody>
</table>

*Palette and parameter Groups

<table>
<thead>
<tr>
<th>Group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>INT</td>
<td>All intensities belong to INT.</td>
</tr>
<tr>
<td>FOCUS</td>
<td>Focus parameters</td>
</tr>
<tr>
<td>COLOR</td>
<td>Color parameters</td>
</tr>
<tr>
<td>BEAM</td>
<td>Beam parameters</td>
</tr>
<tr>
<td>AUX 1</td>
<td>Control parameters</td>
</tr>
<tr>
<td>AUX 2</td>
<td>Control parameters</td>
</tr>
</tbody>
</table>
**Dimmer Curve List**

The Dimmer Curve List contains a set of default curves that can be assigned to dimmers in the Output Setup. It is also possible to create user-specific dimmer curves. (Browser > Patching > Settings & Tools > Dimmer Curve List)

When you open a new show, some default curves are loaded (contained in the file CURVES.DEF).
Patch - Dimmer Curve Editor

It is possible to create any kind of curve in the Dimmer Curve Editor.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Open the Dimmer Curve List</td>
<td>Browser &gt; Patching &gt; Dimmer Curve List</td>
<td>The Dimmer Curve List is opened.</td>
</tr>
<tr>
<td>2. Insert a New Curve</td>
<td>INSERT</td>
<td>A new curve is inserted. You can name it in the Text cell.</td>
</tr>
<tr>
<td>3. Open the Dimmer Curve Editor</td>
<td>MODIFY</td>
<td>Press MODIFY in the Dimmer Curve cell to open the editor.</td>
</tr>
</tbody>
</table>

Dimmer Curve Editor (example: On/Off Curve)

<table>
<thead>
<tr>
<th>Percent</th>
<th>Output</th>
<th>Interpolation</th>
</tr>
</thead>
<tbody>
<tr>
<td>0%</td>
<td>0%</td>
<td></td>
</tr>
<tr>
<td>5%</td>
<td>5%</td>
<td></td>
</tr>
<tr>
<td>10%</td>
<td>15%</td>
<td></td>
</tr>
<tr>
<td>15%</td>
<td>22%</td>
<td></td>
</tr>
<tr>
<td>20%</td>
<td>28%</td>
<td></td>
</tr>
<tr>
<td>25%</td>
<td>33%</td>
<td></td>
</tr>
<tr>
<td>30%</td>
<td>37%</td>
<td></td>
</tr>
<tr>
<td>35%</td>
<td>41%</td>
<td></td>
</tr>
<tr>
<td>40%</td>
<td>44%</td>
<td></td>
</tr>
<tr>
<td>45%</td>
<td>48%</td>
<td></td>
</tr>
<tr>
<td>50%</td>
<td>52%</td>
<td></td>
</tr>
<tr>
<td>55%</td>
<td>55%</td>
<td></td>
</tr>
<tr>
<td>60%</td>
<td>59%</td>
<td></td>
</tr>
</tbody>
</table>

Available choices: Modify Insert Delete

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>4. Insert a position</td>
<td>INSERT</td>
<td>A position is inserted. You can set percent, Output and if this step should use interpolation to the next step.</td>
</tr>
</tbody>
</table>
INTERPOLATION
When Interpolation is ON the values to this point will be calculated smoothly from the previous point. When Interpolation is OFF the value will be jumped to at this level.

NOTE
If a curve does not have a 0% and 100% rows, it will default to 0% = 0 output and 100% = 100 output
Main Show Data

The main show data is what you generate when you start recording. All data are under this node of the Browser, except effects, which have a node of their own.

Main Show Data Node

This chapter contains the following sections

- Groups
- Presets
- Sequences
- Playlist
- Groups/Palettes overview
- Settings & Tools - Main Show Data
Organizer (1 tab)

The ORGANIZER key opens the Organizer tab where you can view, edit and restructure all data in your show. The Organizer can be opened with focus on a specific type of data or with all show data visible at once.

There are three more ways to open it:

- Open from the Browser> Main Show Data> Organizer (1 tab)
- Press LOAD to open in any tab or spreadsheet cell (except from Browser)
- From a context menu in any List (SELECT SELECT)

Most things in the Organizer can be edited.
There are two main working methods in the Organizer

- Drag and drop with mouse
- Context Menus (SELECT SELECT)

You can press TRACK for items like presets, groups, palettes to track use in the current Play.

**Opening Focused Organizer Tabs**

You can open an organizer tab with only one type of object focused by holding LOAD and pressing one of the following keys.

- PRESET
- GROUP
- SEQUENCE
- FOCUS
- COLOR
- BEAM
- PALETTE

Example of organizer focused on presets
Execute from the Organizer

In the Organizer there is a function that allows you to execute (play back) Sequence Steps, Groups and Presets in the Live field directly.

Right-click on the appropriate object to open the context menu and select Execute.

Drag and Drop in the Organizer

You can click, hold and drag items in the Organizer from one place to another. See Sequence - Drag and Drop.
Here are some examples of items that can be copied or moved by dragging and dropping:

- Sequences
- Sequence steps
- Channel Times
- Device Links
- Master Links
- Action Macros
- Presets
- Groups
- Palettes
- Templates
- Patch
- Devices
- Effects
- Master Pages
- Scroller Rolls
- Channel Layouts

If you drag and drop an item on top of a similar item, for example a Sequence Step, you get the option of creating a copy of this item or moving it.
There is also an advanced tab where you can choose if you want to create an extra step, an extra preset, before or after or replacing the step you dropped it on.
**Organizer (2 tabs)**

This is the same organizer as the 1 tab organizer, with the option of being able to move items between two windows, to make work simpler. (Browser >Main Show Data >Organizer (2 tabs).

Functionality, see Organizer (1 tab).
Groups

Groups are a way of recalling a channel selection with a single number. They are often used to speed up programming.

This chapter contains the following sections

- Groups - Introduction
- Groups - Record
- Groups - Select Channels
- Groups - Fetch Intensities
- Groups - List
- Groups - Load To Playbacks
Groups - Introduction

The GROUP key is used to record and recall Groups. Groups are used mainly for selecting lights, but may also be assigned to masters where they function like traditional intensity submasters.

You can store channel combinations into groups. The difference between a group and a Preset is that a group does not necessarily need levels for the channels involved, only the channels selected are stored regardless of how many other channels are active. Groups also do not contain moving light attributes.

Any currently selected channels and levels are stored in a group, under a single number and name.

For editing groups see Group List Functions.
Groups are accessible from the remotes. See Remote Control.

Group functionality

- Only selected channels are stored in a group.
- Each group will "remember" the order in which channels were selected to create the group.
- Groups are not automatically inserted into the Sequence in the Main Playback.
- Each group can have a text label.
- A group can be selected in the same way as a single channel
- A group can be loaded to a Master, a Direct Select section or a Magic Sheet.
Record a Group

Record a Group:

1. Select channels (setting levels is optional)
2. Hold RECORD and press GROUP - you will get a popup suggesting the next free group number
3. Press MODIFY - you have now recorded a group

Use this Group to select channels:

1. Enter 0 and press CHANNEL - no channels are selected
2. Enter the number of the group you just recorded and press GROUP - these channels should now be selected

or

1. Select GROUP as content type to a section of Direct Selects in the Direct Select tab.
2. Use the screen slider to select and bring the group up.

NOTE: If you are operating in the At Mode syntax you select a group by pressing GROUP followed by the group number.

Assign this Group to a master:

1. Enter the number of the Group
2. Hold GROUP and press a master key. This group is now assigned to this master. If the group has intensities stored they will apply when the master is raised. To select the channels in this group, press the master key.
Groups - Record

There are three ways to record a new group. Only selected channels are recorded. The selected channels can have a level, but it is not necessary.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>RECORD &amp; GROUP</td>
<td>You will get a popup where you confirm recording this group, and can write a text label.</td>
</tr>
<tr>
<td>Record as...</td>
<td># RECORD &amp; GROUP</td>
<td>You will get a popup where you confirm recording this group, and can write a text label.</td>
</tr>
<tr>
<td>Record with Direct Selects</td>
<td>RECORD &amp; direct select</td>
<td>You will get a popup where you confirm recording this group, and can write a text label.</td>
</tr>
</tbody>
</table>

NOTE
The order in which the channels were selected is stored with the group.

900-groups

900 groups is a remnant from the eighties, when consoles often never had more than 900 channels. To be able to access user definable channel groups from a remote control for focusing, an exception was made for these presets. In Cobalt groups 1-999 are available instead. If an play with 900-groups is imported they will be converted to Cobalt Groups.
Groups - Select Channels

You can add and subtract channels that are stored in Groups to/from the current channel selection.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select</td>
<td># GROUP</td>
<td>All channels in the specified Group are selected and can be controlled by wheel or with level functions.</td>
</tr>
<tr>
<td>Add</td>
<td># GROUP &amp; +</td>
<td>All channels in the specified Group are added to the current channel selection.</td>
</tr>
<tr>
<td>Subtract</td>
<td># GROUP &amp; -</td>
<td>All channels in the specified Group are subtracted from the current channel selection.</td>
</tr>
<tr>
<td>Select range</td>
<td># GROUP # GROUP &amp; THRU</td>
<td>All channels stored in every Group from # to # are selected.</td>
</tr>
</tbody>
</table>

At mode syntax

If your Cobalt is set to use At Mode for channel commands, groups are selected in the same way as channels once the GROUP key has been pressed. Press CHANNEL to return to channel selection.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select group mode</td>
<td>GROUP</td>
<td>From this point all select functions apply to groups.</td>
</tr>
<tr>
<td>Select group</td>
<td>#</td>
<td>Group # is selected</td>
</tr>
<tr>
<td>Add group</td>
<td>+ #</td>
<td>Group # is added to the current selection</td>
</tr>
<tr>
<td>Subtract group</td>
<td>- #</td>
<td>Group # is subtracted from the current selection</td>
</tr>
<tr>
<td>Add multiple group</td>
<td># THRU</td>
<td>Up to group # is added to the current selection</td>
</tr>
</tbody>
</table>

Groups - Select Channels Context Menu

You can select the channels of a Group in the Browser by opening the context menu and choosing SELECT CHANNEL(S).
### Groups - Fetch Intensities

Fetch intensities for all or specific channels from any Group.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy level</td>
<td># FETCH/ON &amp; GROUP</td>
<td>All selected channels are set to the levels stored in Group #.</td>
</tr>
<tr>
<td>Copy levels and channels</td>
<td># GROUP &amp; @LEVEL</td>
<td>All channels in the specified Group are selected and set to the levels in Group #.</td>
</tr>
<tr>
<td>Add proportionally</td>
<td># GROUP &amp; Level Wheel</td>
<td>Group # is faded in proportionally on the Level Wheel</td>
</tr>
</tbody>
</table>
Groups - List

Press GROUP to open the Groups List. You can view, edit and create new Groups directly in the Group List (GROUP or BROWSER >Main Show Data>Group).

If the content of a group is changed, the top header will be purple to indicate this. The channel order of the group is indicated in the far right column.
## Group List - Columns & Functions

These are the functions in the Group list.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open list</td>
<td><code>GROUP</code></td>
<td>The Group List is opened.</td>
</tr>
<tr>
<td>Open list at...</td>
<td><code># MODIFY &amp;</code></td>
<td>The Group list is opened and focused at the specified group.</td>
</tr>
<tr>
<td>Update changes</td>
<td><code>UPDATE</code> or</td>
<td>Updates all changes in the current group. There is a popup after the first key.</td>
</tr>
<tr>
<td></td>
<td><code>UPDATE</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td><code>RECORD</code></td>
<td></td>
</tr>
<tr>
<td></td>
<td><code>RECORD</code></td>
<td></td>
</tr>
<tr>
<td>Insert</td>
<td><code>INSERT</code></td>
<td>Inserts a new group with the next free number, with the channels that are selected.</td>
</tr>
<tr>
<td>Insert as...</td>
<td><code># INSERT</code></td>
<td>Inserts a new group with this number, with the channels that are selected.</td>
</tr>
<tr>
<td>Delete</td>
<td><code>DELETE</code></td>
<td>Deletes the selected group. Cannot be undone.</td>
</tr>
<tr>
<td>Set text</td>
<td><code>MODIFY</code></td>
<td>Press MODIFY in the text cell, enter the text and press MODIFY to exit.</td>
</tr>
</tbody>
</table>
Groups - Load To Playbacks

You can load Groups directly to any Playback.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key(s)</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load to master</td>
<td># GROUP &amp; Master Key</td>
<td>Group # is loaded to the Master Playback</td>
</tr>
<tr>
<td>Add to Live</td>
<td># GROUP &amp; LIVE</td>
<td>Group # is added to Live</td>
</tr>
<tr>
<td>Add to Blind</td>
<td># GROUP &amp; BLIND</td>
<td>Group # is added to Blind</td>
</tr>
</tbody>
</table>
Presets

A Preset is used to store intensities, attributes or attribute times for playback in a Sequence, Main- or Master Playback.

This chapter contains the following sections

- Presets - Introduction
- Presets - Record
- Presets - Update
- Presets - List
- Presets - Load To Playbacks
- Presets - Copy
- Presets - Select Channels
- Presets - Fetch Intensities
- Presets - Display List
- Presets - Channel Editor Wizard
- Presets - Auto-Save
- Presets - Times
- Presets - Compare Mode
- Presets - Delete
- Presets - Rename
Presets - Introduction

The basic building block in Cobalt is called a Preset. A preset can be played back on a master or as a step in a Sequence.

General Facts

- Channels, levels, attributes and Dynamic Effects are stored into Presets.
- Presets can be played back from the Master Playbacks, and the Main Playback one by one, or as part of a Sequence or Chase.
- You can store Presets with up to three decimals using Preset numbers 0.001-9999.999.
- Presets can be arranged in a list called a Sequence, with predefined fade times.
- Presets can be modified blind or live.
- Presets can be copied.
- Presets can be added together to create new Presets
- You can retrieve individual channel levels from recorded Presets with Fetch.
- When a Preset is recorded in the A playback, it is automatically placed in numerical order in a step of the Sequence in that playback.

NOTE

A Preset is a memory that can be reused in several Sequences or Playbacks at the same time. To delete it completely you have to go to the source of all Presets: the Preset List. See Presets - List.

This does NOT mean that the Preset number will disappear from the Sequence or from Master Pages, but it means that it will be an empty Preset with no channels or levels stored. It also means that the number of the Preset will be regarded as an unused Preset in the system.

When deleting a Preset in the Preset List you will get a checkbox option of deleting all related Sequence Steps.
Record a Preset Live

Record a preset in the A field (live):

1. Enter a number
2. Use the level wheel to set an intensity level
3. Press RECORD - you will get a popup suggesting the next free preset number
4. Press RECORD again - you have now recorded a preset

Try out this preset in the Main Playback (live):

1. Enter 0 and press GOTO - lights in A fade to zero
2. Enter the number of the preset you just recorded and press GOTO - it should now fade in

NOTE

The Main Playback and the Master Playbacks share intensities using HTP (Highest Takes Precedence) logic. Channels with intensities coming from Master Playbacks may not appear to fade in the Main Playback if the levels from the masters are the same or higher than those in the Main Playback.
Presets - Record

The RECORD key in the programming section allows you to record the output on stage, or part of it, to a Preset or a Cue in the Main Playback, or in a master. What you see in the active Channel View is what is recorded. Normally only changed moving device parameters are recorded. You can set any master or playback as the record target for the RECORD key, see Record Target.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record new</td>
<td>[RECORD]</td>
<td>Record the content of the selected Channel View to a new Preset or Cue in the Main Playback with the next free number. You will get a popup. See The Recording Popup</td>
</tr>
<tr>
<td>Record new #</td>
<td># [RECORD]</td>
<td>Records preset #. You will get a popup. See The Recording Popup</td>
</tr>
</tbody>
</table>

**NOTE**
You can define how moving device parameters are stored in the Record Settings. You can set the record target. Hold SETUP and press RECORD.

A recorded Preset is always added to the Preset List (Browser >Presets).

If there are moving devices defined and you are using "Changed" recording mode, the first preset in an empty sequence will ask you if you want to make a block cue.

The Recording Popup

The recording popup has Basic, Advanced, and Times tabs. The last used tab is saved as the default choice for the next record action. The Times tab will default back to the Advanced tab for the next record action.

In the Basic tab you can confirm recording a Preset (RECORD or MODIFY). You can also add a Preset or Sequence text and define the fade type.
In the **Advanced** tab, in addition to the options of the basic tab, you can set a Block flag for intensities, attributes, and keep Running Dynamics. It is also possible to toggle the GoOnGo flag and toggle Section Markers.
In the Times tab you can set fade and moving device times.
**Record Preset to PB S:1 Gokväll**

### Record new preset 501.5

**PB S:1 Gokväll**

<table>
<thead>
<tr>
<th>Delay Out</th>
<th>Out</th>
<th>Delay In</th>
<th>In</th>
</tr>
</thead>
</table>

**FCB-Times**

<table>
<thead>
<tr>
<th></th>
<th>F-Delay</th>
<th>C-Delay</th>
<th>B-Delay</th>
<th>F-Time</th>
<th>C-Time</th>
<th>B-Time</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>100%</td>
<td>100%</td>
<td>100%</td>
<td>100%</td>
<td>100%</td>
<td>100%</td>
</tr>
</tbody>
</table>

- See [Preset Times](#)
- See [Sequence Times](#)
- See [Moving Device Times](#)
Record Presets - Live Tab

When the channel control is set to the Live Tab, you will record the complete stage output. The Preset is automatically added to the sequence in the Main Playback.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Activate the Live tab</td>
<td>LIVE</td>
<td>The Channel Controls are mapped to the A field.</td>
</tr>
<tr>
<td>1a. Record the complete stage output to a new Preset with the next free number</td>
<td>RECORD</td>
<td>You will get a popup with the next free preset suggested. You can write a text label. The Preset is added to the sequence in the Main Playback.*</td>
</tr>
<tr>
<td>1b. Record a new Preset with a specific number</td>
<td>[#] RECORD</td>
<td>You will get a popup where you also can write a text label. The Preset is added to the sequence in the Main Playback</td>
</tr>
</tbody>
</table>

*This depends on the BUILD SEQ mode (softkey in the Playback soft key page of the Main Display).

Record Presets - Field A Only

There are a lot of options for recording presets. some are set in the Record Settings (hold SETUP and press RECORD). This is a summary of the rest.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record new</td>
<td>RECORD &amp; A</td>
<td>No output from the Master Playbacks will be recorded. The Preset is added to the sequence in the Main Playback. See The Recording Popup.</td>
</tr>
<tr>
<td>Record new #</td>
<td>[#] RECORD &amp; A</td>
<td>No output from the Master Playbacks will be recorded. See The Recording Popup. The Preset is added to the sequence in the Main Playback.</td>
</tr>
</tbody>
</table>

Record Preset - Do not add to Sequence

When a Preset is recorded, it is automatically added to the sequence in the Main Playback. It is possible to bypass this.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record selected to Preset #</td>
<td>[#] RECORD &amp; PRESET</td>
<td>The Preset is recorded and added to the Preset List, but not to the Sequence in the Main Playback.</td>
</tr>
</tbody>
</table>
Record All Attributes for selected channels

Depending on how attribute recording is set up only changed moving device parameters are recorded. You can record all parameters of the selected channels at any time with a shortcut (similar to a block cue). See Device Recording - Introduction.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record selected</td>
<td>RECORD &amp; ATTRIBUTES</td>
<td>Record all attributes for the selected channels to the currently loaded Preset in the A field. You will get a popup, see below.</td>
</tr>
<tr>
<td>Record selected to...</td>
<td># RECORD &amp; ATTRIBUTES</td>
<td>Record all attributes for the selected channels to Preset #. You will get a popup, see below.</td>
</tr>
</tbody>
</table>

This is the Record Attributes popup

![Record Attributes popup](image)

**NOTE**
Control parameters are normally not recorded. However, many fixtures have control on the Strobe parameter, which is recorded.
Record Directly To A Master

You can record the selected channels, or all channels with an intensity on stage directly to a Master. A preset will be created automatically if none is specified. If Attribute recording is set to Automatic, attributes will also be recorded. The time is default set to 100%. See Presets - Times.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record selected</td>
<td>[RECORD] &amp; Master Key</td>
<td>You will get a popup with the next free preset suggested**.</td>
</tr>
<tr>
<td>Record selected as...</td>
<td>[#] [RECORD] &amp; Master Key</td>
<td>You get the message &quot;Preset Recorded&quot; in the status bar.</td>
</tr>
</tbody>
</table>

*If no channels are selected - all channels in A are recorded.
**To separate the number series of Presets in Masters and in the Main Playback the suggested Preset number (if no number is entered) will be starting at Preset 801. After this the last used number when recording to this Master will be incremented.

NOTE
For a Master with a Sequence or Chase, a new preset is recorded to that Sequence or Chase.
For a Preset - all attributes are recorded, except those Masked by the Global Mask. For a Sequence step attributes are recorded in the same way as the sequence of the Main Playback.

Record Selected Channels To Any Preset

Record the selected channels, with attributes and dynamics, to a specified Preset. All moving device attributes for the selected channels will be recorded (not only changed attributes).

<table>
<thead>
<tr>
<th>Setting</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record selected</td>
<td>[CHANNEL] &amp; [RECORD]</td>
<td>You will get a popup where you confirm recording this Preset, and can write a text label.</td>
</tr>
<tr>
<td>Record selected to...</td>
<td>[#] [CHANNEL] &amp; [RECORD]</td>
<td>You will get a popup where you confirm recording this Preset, and can write a text label.</td>
</tr>
</tbody>
</table>
Setting a Master as the General Record Target

The default record target for the Record function is the Main Playback. All recording actions are assumed to relate to this playback.

You can set any other master playback (1-80) to be the record target. This is helpful when you work with multiple sequences on masters.

Setting a master as the general record target can be done in two ways:

In the Record Settings - Hold SETUP and press RECORD. 0 is the Main Playback, 1-80 are the masters.

C & RECORD will reset the general recording target to the Main Playback.

When you record to a Master using RECORD & MASTER KEY (see the checkbox "use this master as general recording target")
Record to master 2

Record new Preset 801.0
and insert into a new sequence

Preset text

Sequence content: Presets
Sequence number: 6
Sequence name
Sequence step text

Use master as general recording target

Record

Esc
# Presets - Update

The UPDATE key in the programming section updates the preset in the playback connected to the channel control. This can be Live, Blind, any Master Playback or a step in the Preset List.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
</table>
| Update  | ![UPDATE](image) | Updates changed levels and attributes to the currently loaded Preset.  
You will get a simpler version of the Recording popup. See The Recording Popup |

**NOTE**  
If you are in the Live field the Preset loaded to the A field of the Main Playback will be updated.
Presets - List

Press PRESET to open the Preset list, which is a spreadsheet view of all presets in your play. You can view, edit and create new Presets (blind) in the Preset List. (Browser >Main Show Data >Presets).

See Presets - Introduction.
See also Preset List - Functions.
1. Current **Channel View format**
2. **Settings**
3. **Channel view**
4. **Spreadsheet view**

### Preset List Channel View

The top part of the Preset list is a channel view where you can edit all the channel and attribute values directly.

Press ATTRIB to toggle to the attribute view between channels and attributes. In the attribute view you can use all the moving device controls to edit parameters.

![Preset List Channel View](image)

See [Navigating - Channel Views](#).

**NOTE**

You can only edit attributes with console functions (wheels and keys). If you want to edit attributes on the screen, move to the Attributes cell and press MODIFY to open the Preset Attribute Editor.
## Preset List - Columns

<table>
<thead>
<tr>
<th>Column</th>
<th>Input</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preset</td>
<td>No input</td>
<td>The number of this Preset - cannot be edited.</td>
</tr>
<tr>
<td>Text</td>
<td>ABCDE...</td>
<td>Press MODIFY to activate and end text input. This text is shown also in the Playback views.</td>
</tr>
<tr>
<td>Channels</td>
<td>No input</td>
<td>Shows how many channels/devices that are stored with an intensity in this Preset</td>
</tr>
<tr>
<td>Attributes</td>
<td>MODIFY</td>
<td>Shows how many moving devices are stored in this Preset. MODIFY opens the attribute editor.</td>
</tr>
<tr>
<td>Dynamics</td>
<td>MODIFY</td>
<td>Shows how many Dynamics are stored in this Preset. MODIFY opens the Dynamics editor.</td>
</tr>
<tr>
<td>Mask</td>
<td>MODIFY</td>
<td>Open the Mask editor where you can mask any parameter.</td>
</tr>
<tr>
<td>FCB-Time</td>
<td># MODIFY</td>
<td>Hold C and press MODIFY to enter a time in seconds instead of % of the main fade times.</td>
</tr>
<tr>
<td>FCB-Delay</td>
<td># MODIFY</td>
<td>Hold C and press MODIFY to enter a time in seconds instead of % of the main fade times.</td>
</tr>
<tr>
<td>Note</td>
<td>MODIFY</td>
<td>Opens the Note list for a note</td>
</tr>
</tbody>
</table>
## Preset List - Functions

These are the functions in the Preset list. See also [Copy, Cut & Paste](#).

<table>
<thead>
<tr>
<th>Setting</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open</td>
<td>PRESET</td>
<td>The Preset List is opened.</td>
</tr>
<tr>
<td>Open</td>
<td>MODIFY &amp; PRESET</td>
<td>The Preset List is opened.</td>
</tr>
<tr>
<td>Open at Preset #</td>
<td># &amp; MODIFY &amp; PRESET</td>
<td>The Preset list is opened and focused at the specified Preset.</td>
</tr>
<tr>
<td>Update focused Preset</td>
<td>UPDATE</td>
<td>Updates all changes in the current Preset.</td>
</tr>
<tr>
<td>Copy Preset</td>
<td># RECORD</td>
<td>Records a copy of the current Preset with this number.</td>
</tr>
<tr>
<td>Delete Preset</td>
<td>DELETE</td>
<td>Deletes the selected Preset. Cannot be undone. See <a href="#">Presets - Delete</a>.</td>
</tr>
<tr>
<td>Insert new Preset #</td>
<td># INSERT</td>
<td>Inserts a new Preset #, with the channels and levels from Live (A).</td>
</tr>
<tr>
<td>Insert new Preset with the next free number</td>
<td>INSERT</td>
<td>Inserts a new Preset with this number.</td>
</tr>
<tr>
<td>Edit a cell with a numeric value</td>
<td># MODIFY</td>
<td>Changes the value of the selected cell.</td>
</tr>
</tbody>
</table>
Presets - Load To Playbacks

You can load Presets directly to any Playback.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key(s)</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load to A</td>
<td># PRESET &amp; A</td>
<td>The Preset is loaded to the A field, replacing the content of that field.</td>
</tr>
<tr>
<td>Load to B</td>
<td># PRESET &amp; B</td>
<td>The Preset is loaded to the B field, replacing the content of that field.</td>
</tr>
<tr>
<td>Load to master</td>
<td># PRESET &amp; Master Key</td>
<td>Preset # is loaded to the Master Playback</td>
</tr>
<tr>
<td>Load to Live</td>
<td># PRESET &amp; LIVE</td>
<td>Preset # is loaded to Live</td>
</tr>
<tr>
<td>Load to Blind</td>
<td># PRESET &amp; BLIND</td>
<td>Preset # is loaded to Blind</td>
</tr>
</tbody>
</table>

Quick-load Presets to Masters

The direct functions allow you to load a series of recorded Presets to Masters, this is called quick-loading Presets to Masters.

1. Enter the number of the first Preset.
2. Hold down the PRESET key, and pull your finger over a range of Master Keys.

All existing consecutive Presets will be loaded.
Presets - Copy

Copy a Preset by recording it with a different Preset number. This can be done in any Playback, or directly in the Preset List. In the Preset List it can be done with the COPY function as well. See Preset List and Copy, Cut & Paste.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy preset</td>
<td><code>[</code> # <code>]</code> [RECORD]</td>
<td>Copies the preset in the channel view connected to the channel controls to a new number. You will get a popup. See The Recording Popup</td>
</tr>
</tbody>
</table>
Presets - Select Channels

You can add and subtract channels that are stored in Presets to/from the current channel selection.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select all</td>
<td>[#] PRESET</td>
<td>All channels with a level in the specified Preset are selected.</td>
</tr>
<tr>
<td>Add to current</td>
<td>[#] PRESET &amp; +</td>
<td>All channels with a level in the specified Preset are added to the current channel selection.</td>
</tr>
<tr>
<td>Subtract all</td>
<td>[#] PRESET &amp; -</td>
<td>All channels with a level in the specified Preset are subtracted from the current channel selection.</td>
</tr>
<tr>
<td>Select all over 0%</td>
<td>[#] PRESET &amp; ALL</td>
<td>All channels with a level in the channel control, that also have a level in the specified Preset, are selected.</td>
</tr>
<tr>
<td>Select all in a range</td>
<td>[#] PRESET &amp; THRU</td>
<td>All channels stored in every Preset from # to # are selected.</td>
</tr>
</tbody>
</table>

Presets - Select Channels Context Menu

You can select the channels of a Preset in the Browser by opening the context menu and choosing SELECT CHANNEL(S).
Presets - Fetch Intensities

Press ON/FETCH to set all selected channels to their last stored levels.

You can fetch intensities for all or specific channels and/or parameters from any Preset.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set last stored level</td>
<td>ON/FETCH</td>
<td>All selected channels are set to their last stored levels.</td>
</tr>
<tr>
<td>Copy level</td>
<td># ON/FETCH</td>
<td>All selected channels are set to the levels stored in Preset #.*</td>
</tr>
<tr>
<td>Copy levels and channels</td>
<td># PRESET @LEVEL</td>
<td>All channels in the specified Preset are selected and set to the levels in Preset #.</td>
</tr>
<tr>
<td>Add proportionally</td>
<td># PRESET @LEVEL</td>
<td>Preset # is faded in proportionally on the Level Wheel</td>
</tr>
</tbody>
</table>

HINT
You can fetch attribute values as well. See Device Control - Fetch/Copy.

*You can press # ON/FETCH & PRESET as well.
**Presets - Channel Editor Wizard**

The Channel Editor Wizard allows you to track intensity changes in all Presets with powerful arguments. Press WIZARD in any channel view to open the Channel Wizard.

**NOTE**
You cannot reverse or undo changes made with this Wizard. We therefore recommend you strongly to save your play before using this function.
Channel Editor Wizard - Type Of Change

You can perform the following actions through any range of Presets.

The parameter "Include All Channels" will affect channels with no level (0%) as well, and is necessary in some cases.

<table>
<thead>
<tr>
<th>Function</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Level</td>
<td>Set level #</td>
</tr>
<tr>
<td>Add Absolute</td>
<td>Adds # points to the current channel(s) intensity level - adding with a value of 5, 50% becomes 55%, 80% becomes 85%.</td>
</tr>
<tr>
<td>Subtract Absolute</td>
<td>Subtract # points from the current channel(s) intensity level.</td>
</tr>
<tr>
<td>Add percent</td>
<td>Adds a % of the current channel(s) intensity level - adding with a value of 10, 50% becomes 55%, 80% becomes 88%.</td>
</tr>
<tr>
<td>Subtract percent</td>
<td>Subtracts a % from the current channel(s) intensity level.</td>
</tr>
<tr>
<td>Swap channels</td>
<td>Change levels between the selected channel and the channel # in Argument.</td>
</tr>
<tr>
<td>Copy from channel</td>
<td>Copy all levels from channel value # to the selected channel(s).</td>
</tr>
<tr>
<td>Set min level</td>
<td>Sets a minimum level HTP with the current levels.</td>
</tr>
<tr>
<td>Set max level</td>
<td>Sets a maximum level to the current levels.</td>
</tr>
</tbody>
</table>
**Channel Editor Wizard - Value**

Depending on the type of change - the number here is the Value used. It can be a level or a channel number.

**Channel Editor Wizard - Include If 0%**

This parameter will allow the change to affect the channels with no level (0%) in the target Presets.
Presets - Auto-Save

Each time you record a preset or a group all changes to the play since the last RECORD or Save are stored in a play called AUTOSAVE.ASC.

This play is stored in the Play Archive (Browser >File >Open >Play Archive) and can be opened like any play.

<table>
<thead>
<tr>
<th>Function</th>
<th>Console</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Auto Save setting</td>
<td>SETUP &amp; RECORD</td>
<td>Opens a popup where you can set Auto-Save to ON.</td>
</tr>
</tbody>
</table>

NOTE
This is a feature that we recommend you to use with caution. Saving a large show can slow down the system temporarily.
Presets - Times

The timing information stored in a Preset, is the FCB times for device parameters. Other timing when used in a Sequence, such as channel times, in/delay/out times are stored in the Sequence Step. (See Device Times - Individual or FCB)

- The default setting for FCB times is 100% of the main In time
- The default setting for FCB delay times is 0 seconds. If you set FCB delay times in %, then that setting refers to main In time.

These times are executed when played back from a Sequence or from a Master Playback.

Hold SETUP & press ATTRIB to open the Time settings for Parameters.

You can set them in % or as absolute times in seconds. You can select what to default to in these Settings. Hold C/Alt and press MODI FY to set the opposite of what is currently selected.
Presets - Compare Mode

The COMPARE soft key allows you to temporarily toggle the current light in the active field with the recorded version of a preset in the active field. When Compare mode is active it is indicated in the top of all screens.

(Soft Key Pages are commands in the lower right corner of screen 2)

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compare to stored</td>
<td>COMPARE</td>
<td>The last stored version will be loaded. Press COMPARE to exit Compare mode.</td>
</tr>
<tr>
<td>Compare to preset</td>
<td># COMPARE</td>
<td>The selected preset will be loaded. Press COMPARE to exit Compare mode.</td>
</tr>
</tbody>
</table>
**Presets - Delete**

Presets are deleted from the Preset List (Browser >Main Show Data >Presets).

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete selected Preset.</td>
<td>[DELETE]</td>
<td>You will get a popup where you can choose to delete the corresponding Sequence Steps this Preset is used in as well.</td>
</tr>
</tbody>
</table>
Presets - Renumber

You can renumber presets in the organizer from the context menu in the Preset nodes.

1. Press SELECT or right click to open the context menu, then click Renumber.

2. Press MODIFY and click to open the Change Number dialog.
3. Enter a new preset number and press MODIFY to confirm.

**NOTE**
Changing the number of a Preset will not change any of the references, such as Master Links, Masters, Sequence Steps, Content Effects, that pointed to the previous number.
Presets - Import & Undo

If you need to import a preset from a previously saved version of your play, because you want to undo the current changes - it is done in the organizer.

1. Open the Import Organizer for the last saved version (name.001) in the Browser (Browser >Files >Import From >Play Archive)

2. Drag the previously saved version of the preset and drop on the same preset in the current play

3. In the Advanced dialogue, check the box "overwrite" (or save with a different number)
Presets - Multiple Import & Undo

You can import a range of presets from a previously saved version of your play.

1. Open the Import Organizer for the last saved version in the Browser (Browser >Files >Import From >Play Archive)

2. Use SELECT or SHIFT & arrow/mouse to select a range of presets in the previously saved play.

3. Drag and drop on preset node in the current play
4. In the Advanced dialogue, select the renumbering option "Keep original spacing and gaps" or "Convert to consecutive numbers" and enter a "start at" number for the first preset.

**Keep original spacing and gaps** will keep preset numbering as it was in the old play, using the start at value to create an offset. For example, if you drag in presets numbered 1, 1.5 and 3 into the current play with a start at value of 5, the new presets will be numbered 5, 5.5 and 8.
Convert to Consecutive Numbers will clean up decimals and gaps in the preset list - so dragging in the same three presets 1, 1.5 and 3 into the current play using this setting and a start at value of 5 will create presets 5, 6 and 7.
Sequences

A sequence is a list of presets that can be played back manually, with fade times, and as a chase.

This chapter contains the following sections

- Sequences - Introduction
- Sequences - In The Main Playback
- Sequences - List
- Sequences - Sequence List
- Sequences - Crossfade Movefade, Lockfade
- Sequences - Times
- Sequences - Insert Step
- Sequences - Delete Step
- Sequences - Links
- Sequences - Load
- Sequences - Build & Modify Modes
- Sequences - Block Values
- Sequences - Track List
- Sequences - Chase mode
- Sequences - drag and drop data
Sequences - Introduction

Press PLAYBACK in the Main Playback section to open the Playback tab. Theatrical style playback of a number of pre-recorded looks and times is called a "sequence" in Cobalt. (See Playback View)

A sequence is a list of sequence steps. There are two ways to create a sequence

- Preset steps (referenced data from a central and shared Preset List)
- Cue steps (unique data in each step)

Preset or Cue mode is selected as a default for your play in the Let's Begin dialog when you start a new play, and in the Play Settings dialog under Basic. You can chose either mode at any time when you create a new sequence.

A sequence step always contains a Preset or a Cue. Each time a Preset or a Cue is recorded in the Live tab a new Sequence step is created with that Preset in the Main Playback.
A Sequence Step consists of two main components

<table>
<thead>
<tr>
<th>Item</th>
<th>Contains</th>
<th>Read More</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sequence Step Data</td>
<td>Fade Times, Auto Times, Text, Master Link, Master Page Link, Macro Link, Automark flag for Attributes.</td>
<td>See Sequences - Sequence List</td>
</tr>
<tr>
<td>Preset or Cue</td>
<td>Intensities, Dynamics, Attributes and Attribute Times.</td>
<td>See Preset List or Cue List.</td>
</tr>
</tbody>
</table>

**General Facts**

- You can rearrange the order in a Sequence of Presets at any time.
- The same Preset can exist in several sequence steps, and sequences.
- A Cue is a unique step and can only exist once in the same sequence.
- You can set times to every channel and parameter in a sequence step.
- Sequences can be played back from the Main playback, or any Master Playback.
- You can create up to 999 sequences.
- You can link any Master Playback to a sequence step.
- You can trigger a Sequence with MIDI and Time Code.
- You can play back any Sequence in Chase (looped) mode with BPM and rate.
- A new play begins with Sequence 1 already loaded into the Main Playback, ready for creation by simply recording presets.
- Basically everything in Cobalt can be triggered from a sequence.

**Record a Sequence Live**

**Record a sequence in the Main Playback:**

1. Enter a number
2. Use the level wheel to set an intensity level
3. Press RECORD - you will get a popup suggesting the next free preset number
4. Press RECORD again - you have now recorded a preset or a cue, and it has been added as the first (or next) sequence step in the main playback
5. Repeat this procedure three times - you will have a sequence with three steps

**Play back this sequence on the Main Playback:**

1. Enter 0 and press GOTO - lights in A fade to zero
2. Press GO to fade through the sequence - the fade time is default set to 5 seconds

**NOTE**

The Main Playback and the Master Playbacks share intensities using HTP (Highest Takes Precedence) logic. Channels with intensities coming from Master Playbacks may not appear to fade in the Main Playback if the levels from the masters are the same or higher than those in the Main Playback.
Sequences - In The Main Playback

When you open a new play there is a default sequence (1) in the Main Playback. When you record a Preset or Cue in the Live field it will be added to the sequence in the Main playback.

These are the sequence functions for the Main Playback

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record a new step</td>
<td># RECORD</td>
<td>Each time a Preset or Cue is recorded in Live it is added as a new step to the sequence loaded to the Main Playback*</td>
</tr>
<tr>
<td>Edit step</td>
<td>MODIFY &amp; PLAYBACK</td>
<td>Opens the Sequence List for the sequence in the Main Playback. See Sequences - Sequence List.</td>
</tr>
<tr>
<td>Navigate</td>
<td></td>
<td>See Main Playback.</td>
</tr>
</tbody>
</table>

*Unless the mode Build Sequence is off. See Settings - Crossfade.
Sequences - List

Press SEQ in the programming section to open the Sequences List. You can insert and delete sequences, and change playback modes (normal/chase). (BROWSER >Main Show Data >Sequences...).

Sequences List - Insert/Delete/Load

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert</td>
<td>[#] INSERT</td>
<td>Sequence # is inserted into the list</td>
</tr>
<tr>
<td>Delete</td>
<td>DELETE</td>
<td>The selected sequence is deleted*</td>
</tr>
<tr>
<td>Load</td>
<td>Master Key</td>
<td>The selected sequence is loaded to this Master Playback.</td>
</tr>
</tbody>
</table>

*The Sequence is deleted, and all timing and text information. The Preset still exists in the Preset list and can be used again.
## Sequences List - Columns

<table>
<thead>
<tr>
<th>Column</th>
<th>Input</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sequence</td>
<td>[MODIFY]</td>
<td>The number of this Step- cannot be edited. Press MODIFY to open the Sequence List.</td>
</tr>
<tr>
<td>Text</td>
<td>[MODIFY]</td>
<td>Press MODIFY to activate and end text input. This text is shown in the top of the Playback views.</td>
</tr>
<tr>
<td>Mode</td>
<td>[MODIFY]</td>
<td>Toggles between Normal, Chase and Loop (7.3) mode.</td>
</tr>
<tr>
<td>Rate</td>
<td>[MODIFY]</td>
<td>Speeds up the playback by $#%$ (Chase mode).</td>
</tr>
<tr>
<td>Bounce</td>
<td>[MODIFY]</td>
<td>Sets playback to alternate continuously between forward and reverse (Chase mode).</td>
</tr>
<tr>
<td>Reverse</td>
<td>[MODIFY]</td>
<td>Sets Playback in the reverse direction only (Chase mode).</td>
</tr>
<tr>
<td>Single Shot</td>
<td>[MODIFY]</td>
<td>Sets Playback to one time (Chase mode).</td>
</tr>
<tr>
<td>BPM</td>
<td>[MODIFY]</td>
<td>Suppresses fade times and sets step time (wait) to BPM $#$ (Chase mode).</td>
</tr>
<tr>
<td>Master View:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show Step Numbers</td>
<td>[MODIFY]</td>
<td>Toggles how step numbers are shown for this sequence in Master Views.</td>
</tr>
<tr>
<td>Cue</td>
<td>[MODIFY]</td>
<td>Shows if this sequence is set to Presets or Cues (cannot be changed)</td>
</tr>
</tbody>
</table>
Sequences - Sequence List

Press # SEQ to open a Sequence List for any sequence. You can view, edit and delete sequence steps in a Sequence list (BROWSER > Sequence > #).

The currently active sequence step in the main playback is indicated with a brown background.

NOTE

You can open the Sequence List for the Main Playback by holding MODIFY and pressing PLAYBACK. This is not possible, however, in Tabs that use MODIFY for other functions.

It is possible to enter the number of a step/preset first to open the list with that step focused.
Sequence List Channel View

The top half of the Sequence List is a channel view. Press ATTRIB to toggle to the attribute view between channels and attributes. In the attribute view you can use all the moving device controls to edit parameters.

NOTE
You can only edit attributes with console functions (wheels and keys). If you want to edit attributes on the screen, move to the Preset cell and press MODIFY twice to open the Preset Attribute Editor.
## Sequence List Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open List</td>
<td># SEQ</td>
<td>The Sequence List is opened for seq #.</td>
</tr>
<tr>
<td>Go to Step</td>
<td>GOTO</td>
<td>Fades in the Main Playback to the selected step.</td>
</tr>
<tr>
<td>Insert a new Step</td>
<td># INSERT</td>
<td>Inserts a new step, with Preset #.</td>
</tr>
<tr>
<td>Edit Text</td>
<td>MODIFY</td>
<td>Opens the text cell for editing. The Cobalt keyboard is activated in Master Playback display four.</td>
</tr>
<tr>
<td>Delete selected Step(s)</td>
<td>DELETE</td>
<td>Deletes the selected Step. Cannot be undone.</td>
</tr>
<tr>
<td>Edit any value</td>
<td># MODIFY</td>
<td>Enter a new value and press MODIFY.</td>
</tr>
<tr>
<td>Move Step</td>
<td>Drag and drop</td>
<td>You can drag and drop a Sequence Step with the trackball to move it.</td>
</tr>
<tr>
<td>In time</td>
<td># IN</td>
<td>Sets an In time of # seconds directly to the focused step.</td>
</tr>
<tr>
<td>Out time</td>
<td># OUT</td>
<td>Sets an Out time of # seconds directly to the focused step.</td>
</tr>
</tbody>
</table>

**NOTE**

You can use COPY, CUT and PASTE to insert and delete steps in the Sequence List as well. See [Copy, Cut & Paste](#).
## Sequence List - Columns

### Part 1

<table>
<thead>
<tr>
<th>Column</th>
<th>Input</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step</td>
<td>No input</td>
<td>The number of this Step. Cannot be edited.</td>
</tr>
<tr>
<td>Preset</td>
<td>🔖</td>
<td>This is the number of the Preset in this step. It can be edited with the Preset Change Wizard.</td>
</tr>
<tr>
<td>DelayOut</td>
<td>🔖</td>
<td>Edit the delay out time.</td>
</tr>
<tr>
<td>Out</td>
<td>🔖</td>
<td>Edit the Out time.</td>
</tr>
<tr>
<td>DelayIn</td>
<td>🔖</td>
<td>Edit the Delay In time.</td>
</tr>
<tr>
<td>In</td>
<td>MODIFY</td>
<td>Edit the In time.</td>
</tr>
<tr>
<td>WFA *</td>
<td>MODIFY</td>
<td>Toggle time type between Wait, Followon and Alert.</td>
</tr>
<tr>
<td>WFA Time</td>
<td>🔖</td>
<td>Edit the (WFA) time.</td>
</tr>
<tr>
<td>Mode</td>
<td>MODIFY</td>
<td>Change fade mode. Select between crossfade (x) movefade (m) lockfade (l) and split fade (s).</td>
</tr>
<tr>
<td>Text</td>
<td>MODIFY</td>
<td>Press MODIFY to activate and end text input. This text is shown in the Playback views.</td>
</tr>
</tbody>
</table>

* You can toggle the time between two steps between Wait, Alert and Followon. See [Sequence Times - Alert Times](#) and [Sequence Times - WAF Wait & Followon Times](#)
## Part 2

<table>
<thead>
<tr>
<th>Column</th>
<th>Input</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attrib Move</td>
<td>MODIFY</td>
<td>Toggle between, AutoMark, GoOnGo and GoInB. Controls if moving devices will move on GO or when the step is loaded in B (next).</td>
</tr>
<tr>
<td>ChTime</td>
<td>MODIFY</td>
<td>Shows the number of channel times in this step. Opens the channel time editor.</td>
</tr>
<tr>
<td>MastLink</td>
<td>MODIFY</td>
<td>Shows the number of master links in this step. Opens the master link editor.</td>
</tr>
<tr>
<td>MastPage</td>
<td>#</td>
<td>Shows or edits which Master Page is linked.</td>
</tr>
<tr>
<td>Fade Curve</td>
<td>#</td>
<td>Shows or edits which Fade Curve is linked.</td>
</tr>
<tr>
<td>LinkToStep</td>
<td>#</td>
<td>Shows or edits which step this step is linked to.</td>
</tr>
<tr>
<td>TimeCode</td>
<td>#</td>
<td>View/Edit Time Code for this step</td>
</tr>
<tr>
<td>Note</td>
<td>MODIFY</td>
<td>Opens the editor for an existing Note</td>
</tr>
<tr>
<td>Block Tracking</td>
<td>MODIFY</td>
<td>Blocks tracking through this step</td>
</tr>
<tr>
<td>Macro</td>
<td>#</td>
<td>Sets this step to trigger Macro #.</td>
</tr>
<tr>
<td>Action Macro</td>
<td>MODIFY</td>
<td>Opens this cell for text input of an Action Macro - See <a href="#">Actions &amp; Events - Actions</a>.</td>
</tr>
<tr>
<td>Profile</td>
<td>DELETE</td>
<td>Shows if there is a profile on this step. Press DELETE to clear (no Undo).</td>
</tr>
<tr>
<td>Section Marker</td>
<td>MODIFY</td>
<td>Toggles Section Marker on/off.</td>
</tr>
</tbody>
</table>
Sequence and Preset texts

In the sequence list you can see and edit both the unique sequence step text and the text belonging to the preset occupying a sequence step.

- Go to the Text column and press MODIFY to edit the sequence step text.
- Go to the P-Text column and press MODIFY to edit the Preset text.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Text</th>
<th>P-Text</th>
<th>Attrib. Move</th>
</tr>
</thead>
<tbody>
<tr>
<td>X</td>
<td>First Step.</td>
<td>Block for Attributes</td>
<td>AutoMark</td>
</tr>
<tr>
<td>X</td>
<td>Blackout.</td>
<td></td>
<td>AutoMark</td>
</tr>
<tr>
<td>X</td>
<td>Red front.</td>
<td></td>
<td>AutoMark</td>
</tr>
<tr>
<td>X</td>
<td>Blue lights.</td>
<td></td>
<td>AutoMark</td>
</tr>
</tbody>
</table>
Sequences - Crossfade Movefade & Lockfade

When you press RECORD to record a new Preset in a Sequence you will get the option to store it as a Crossfade, a Movefade or a Lockfade. Each of these modes affects how channels in that Preset will be played back when a the next crossfade is started.

A Split Fade is a different fade type that is set in the Sequence List. See Sequence List - Columns.

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcut</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record a crossfade</td>
<td>RECORD</td>
<td>Normally a crossfade (x) is recorded. This means that all channel values are replaced when a new crossfade is started.</td>
</tr>
<tr>
<td>Record a Move Fade</td>
<td>+ &amp; RECORD</td>
<td>When a movefade (m) is followed by another movefade, only channels with new levels will be affected.</td>
</tr>
<tr>
<td>Record a LockFade</td>
<td>- &amp; RECORD</td>
<td>When a lockfade (l) is started, the channels involved will not be affected by anything until they have finished the fade they started. Stepping in the sequence will stop ongoing lock fades.</td>
</tr>
</tbody>
</table>

HINTS

- When you jump in the sequence with GOTO, the history of all fades will be executed to recreate the correct state after the jump.
- GOTO & B updates the current state (scanning backwards in the sequence accumulating Move/Lock fades).
- For a Lock fade, it is not possible to press PAUSE or GO BACK, since the nature is to "lock" the fade regardless of other playback controls.
- Stepping through the sequence with SEQ+/SEQ- or using GOTO will stop current Lock fades.
- If you start a move or lock fade on top of a crossfade, the crossfade now continues to run in the background and is also available for speed control on the display.
- Move and Lock fades are indicated with M and L in the Channel Views.
Sequences - Times

You can set times to a sequence step, and all channels and moving device parameters will follow that time.

You can also set individual times in seconds, or as a percentage of the in- and delay times for each channel and moving device parameter in a sequence step.

Times are set from, like this: 0.01 – 9.99 seconds to 49.59 minutes (0.1- 4959). It is possible to use hundreds of seconds as input during the first 10 seconds (v6.0)

When no time is set to a sequence step, the default time (5 seconds) will be used. Change this setting by holding SETUP and pressing A.

The easiest way to set times to ANY step of the sequence in the main playback is to use the TIME EDITOR. Enter the number of the step, hold MODIFY and press TIME. See The Time Editor Popup.

NOTE
Fade times of a Sequence Step are related to that step, not to the Preset occupying the Step. This makes it possible to use the same Preset with different fade times in other Steps or in the Masters.

To edit the times for a step open the Sequence List.

Sequence Times - Set To A or B

Times are set to A or B depending on what situation you are working in. The current setting is indicated with an arrow next to the times:

It is possible to toggle if times are set to A or B by holding TIME and pressing A or B.
Sequence Times - Main Times (in/out/delay/wait)

Times are set to the step in A (Active) or B (Next) depending on the setting for times (SETUP & TIME).

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>In time</td>
<td>[#] IN</td>
<td>A time is set for the incoming channels.</td>
</tr>
<tr>
<td>Out time</td>
<td>[#] OUT</td>
<td>A time is set for the outgoing channels.</td>
</tr>
<tr>
<td>In- and Out time</td>
<td>[#] TIME</td>
<td>A time is set for the in- and outgoing channels.</td>
</tr>
<tr>
<td>Delay In time</td>
<td>[#] DELAY &amp; IN</td>
<td>A delay time is set for the incoming channels.</td>
</tr>
<tr>
<td>Delay Out time</td>
<td>[#] DELAY &amp; OUT</td>
<td>A delay time is set for the outgoing channels.</td>
</tr>
<tr>
<td>Wait, Followon or Alert time *</td>
<td>Sequences - Sequence List</td>
<td>Enter the time in the WFA Time column of the Sequence List. You can toggle between Wait, Alert or Followon in the previous column</td>
</tr>
</tbody>
</table>

* A Wait or Followon time will automatically execute a crossfade to the Step it is assigned to. The difference is that a Wait time starts counting down after the END of the previous crossfade, while the Followon time starts counting down from the START of the previous crossfade. Wait times is the default setting. The Alert time will count down as a warning to the operator, but not execute the next fade. See Sequence Times - Alert Times.

See Times Soft Key Page.

You can view/edit the main times in the Sequence List.
Sequence Times - Channel Times

Times are set to the step in A (Active) or B (Next) depending on the setting for times (SETUP & TIME).

<table>
<thead>
<tr>
<th>Function</th>
<th>Soft Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the TIME soft menu page</td>
<td>TIMES (soft key)</td>
<td>The time soft key page is selected in the main display.</td>
</tr>
<tr>
<td>2. Set a channel time for the selected channels</td>
<td># CH TIME</td>
<td>A time is set for the selected channels. You can set a text label to the channel time group.</td>
</tr>
<tr>
<td>3. Set a channel delay time for the selected channels</td>
<td># CH DELAY</td>
<td>A time is set for the selected channels.</td>
</tr>
</tbody>
</table>

You can set channel times with two shortcuts as well.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key Shortcut</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel time</td>
<td># CHANNEL &amp; TIME or # TIME &amp; CHANNEL</td>
<td>A time is set for the selected channels. You can set a text label to the channel time group.</td>
</tr>
<tr>
<td>Channel delay</td>
<td># CHANNEL &amp; DELAY or # DELAY &amp; CHANNEL</td>
<td>A time is set for the selected channels.</td>
</tr>
</tbody>
</table>

This is what it looks like in a playback view, If no name is assigned, the channel numbers will be shown.
This is how the time is indicated in the live channel view, under the level.

NOTE
When Channel Times are activated, the first four Channel Times are shown on the Main Display over the 4 wheels. The status for each Channel Time is displayed over each wheel. Rate for each channel can be adjusted with the corresponding wheel and the Channel Time can be started/stopped with the corresponding wheel key.

Sequence - Channel Time Editor

press MODIFY in the ChTime column of the Sequence List to open the channel time editor. See Sequence List.

Here you can add a text to each channel time group. This text is shown in the graphical time line view of the Playback list.
Editing Channels in a Channel Time Group

1. Select the Group in the Channel Time Editor

2. Add or remove Channels.

3. Press UPDATE to store.

The Time Editor Popup

The Time Editor (also part of the Record popups Advanced tab) allows you to edit the times of any sequence step from a popup.

Press MODIFY and TIME to open the Time Editor popup for the step in A or B (see NOTE below). Enter the number of a step first to open it for any step.
NOTE
The Time Editor follows the setting of the "Times in A/B" parameter in the Cobalt Setup (SETUP or F11).

The WAF box allows you to toggle between Wait, Alert and Followon time for this step.

The first six existing Channel Times can be edited directly in the Channel Times tab.
The Times Soft Key Page

The Time Soft Key Page is selected with the soft key TIMES in the Main Display of the console.

These are the functions available. All times are set to the Main Playback.

<table>
<thead>
<tr>
<th>Function</th>
<th>Softkey</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel time</td>
<td>[#] CH TIME</td>
<td>Sets a channel time (#) to the selected channels.</td>
</tr>
<tr>
<td>Channel delay</td>
<td>[#] CH DELAY</td>
<td>Sets a channel delay time (#) to the selected channels.</td>
</tr>
<tr>
<td>Wait</td>
<td>[#] WAIT</td>
<td>Sets a Wait time (#) to the Preset in A (or B).</td>
</tr>
<tr>
<td>FCB time</td>
<td>[#] FCB Time</td>
<td>Sets FCB times (#) to the Preset in A (or B).</td>
</tr>
<tr>
<td>FCB delay</td>
<td>[#] FCB Delay</td>
<td>Sets FCB delay (#) to the Preset in A (or B).</td>
</tr>
<tr>
<td>Learn Alert *</td>
<td>Learn Alert</td>
<td>Activates Learn Alert Time mode.</td>
</tr>
<tr>
<td>Learn Profile</td>
<td>Learn Profile</td>
<td>Activates Learn Profile mode for the next crossfade.</td>
</tr>
</tbody>
</table>

* See Sequence Times - WFA Alert Times.
Sequence Times - FCB Times

FCB Times are set to the Preset of a Sequence Step. See Moving Device Times - FCB Time

Sequence Times - Parameter Times

Individual Moving Device Parameter times are set to the preset of a Sequence Step. See Moving Device Times - Parameter Time.

Sequence Times - WAF Alert Times

An Alert time will count down from the completion of the previous crossfade, and alert the operator as to when the next fade should be manually executed.

There is a Learn Mode that will record Alert times automatically as a show is played back in real time by an operator. This mode is activated with the soft key LEARN ALERT in the Times Soft Key page. See The Times Soft Key Page.

Time Limit
There is both a visual and an audio warning set to alert 5 seconds before the next fade. You can change this time limit in the Time Settings. See Settings - Crossfade.

Visual
The top part of the playback view will be green as long as the alert time is over 5 seconds. At 5 seconds it turns yellow and after completion it turns red.

The Alert time is edited in the Sequence List WFA and WFA Time columns. It can be toggled to be a Wait or Followon Time as well. See Sequence List - Columns. See also Sequence Times - WFA Wait & Followon Times.

Sequence Times - WAF Wait & Followon Times

It's possible to set a Wait or Followon time between each step of a Sequence.

395
**Wait**
A Wait time will execute the step *it is on*, # seconds after the completion of the previous fade.

**Followon**
A Followon time will execute the *next* step, # seconds after the start of the fade. The Followon time is displayed in the same way as the Alert Times. See [Sequence Times - WAF Alert Times](#).

The Wait and Followon times are edited in the Sequence List WAF and WAF Time columns. They can be toggled to be an Alert Time as well. See [Sequence List - Columns](#).
**Sequences - Crossfade Profiles**

You can record the movements of the A and B faders. When you start the crossfade the next time, the profile will be played back.

1. Start recording a profile by pressing the LEARN PROFILE soft key in the Times soft key page. See [Times Soft Key Page](#).

2. The recording will stop when both faders reach their end position at the same time.

A preview of the profile is shown in the timeline view.

The total time of A and B are separately stored as the Out and In times. If you change these times, the recorded profiles will be scaled on playback to play back in the new time.

A new column (Profile) is added in Sequence Editor. It shows a check mark when a profile has been recorded. You can press DELETE in this column to delete the profile.
Sequences - Insert Step

There are two ways of inserting a sequence step between two existing ones.

- Record a preset with a (decimal) number that fits between
- Insert any preset in the Sequence List (See Sequence List)

Insert A Sequence Step - In any playback

When you are working directly in a Playback and record a new preset, it is inserted numerically into the sequence of that Playback.

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcut</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert Step</td>
<td>1 . 5</td>
<td>Inserts between 1 and 2. A popup will ask you to confirm recording.</td>
</tr>
<tr>
<td>Confirm</td>
<td>RECORD</td>
<td>The preset is recorded between 1 and 2.</td>
</tr>
</tbody>
</table>

Insert A Sequence Step Directly In The Main Playback

You can insert a preset into the sequence of the main playback directly. This is not available with Cue Sequences.

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcut</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert before A</td>
<td># INSERT A</td>
<td>Preset # is inserted before the current step in A</td>
</tr>
<tr>
<td>Insert before B</td>
<td># INSERT B</td>
<td>Preset # is inserted before the current step in B</td>
</tr>
</tbody>
</table>

Insert A Sequence Step - In The List

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcut</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Open the Sequence list</td>
<td># SEQ</td>
<td>The List for sequence # is opened.</td>
</tr>
<tr>
<td>2. Move to the step you wish to insert a new step after</td>
<td>Arrow Keys</td>
<td>The selected step is highlighted in yellow.</td>
</tr>
<tr>
<td>3. Insert Preset #</td>
<td># INSERT</td>
<td>The preset is inserted after the selected step</td>
</tr>
<tr>
<td>NOTE</td>
<td>You can use COPY, CUT and PASTE to insert and delete steps in the Sequence List as well. See <a href="#">Copy, Cut &amp; Paste</a>.</td>
<td></td>
</tr>
<tr>
<td>-------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>NOTE</td>
<td>The Preset does not bring sequence texts, fade times or links from other sequence steps if it has been used earlier.</td>
<td></td>
</tr>
</tbody>
</table>
Sequences - Delete Step

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcut</th>
<th>Feedback</th>
</tr>
</thead>
</table>
| 1. Open the Sequence list        | [#] [SEQ]|[The List for sequence # is opened.]
| 2. Select the step you wish to delete | Arrow Keys | The selected step is highlighted in yellow. |
| 3. Delete the selected step      | [DELETE] | You will get a popup where you can choose to delete this step and the related Preset. |

**NOTE**
When you delete a Sequence Step all assigned times, links and texts are lost. The Preset of that step can still exist in the Preset List, and can be used again.

Delete a sequence step directly in the main playback

You can delete a sequence step in the main playback directly. The Preset is left intact in the Preset List.

<table>
<thead>
<tr>
<th>Function</th>
<th>Shortcut</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete step in A</td>
<td>[DELETE] &amp; A</td>
<td>The sequence step in A is deleted.</td>
</tr>
<tr>
<td>Delete step in B</td>
<td>[DELETE] &amp; B</td>
<td>The sequence step in B is deleted</td>
</tr>
</tbody>
</table>
Sequences - Links

A sequence step can have a link to Master fades, a Master Page, a different sequence step (see NOTE in this explanation), and a Macro.

All links are done in the Sequence List which can be opened with # SEQ or Browser >Main Show Data >Sequences >#.

Sequence Step Links - Master Playbacks

Master Links are loaded when the Sequence step is loaded to the B field. They are faded when GO is pressed or the crossfade faders are moved.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select MastLink column*</td>
<td>Arrow keys</td>
<td>The column is highlighted</td>
</tr>
<tr>
<td>2. Open Master Link List</td>
<td>[MODIFY]</td>
<td>The Master Link List is open.</td>
</tr>
<tr>
<td>3. Insert a link to Master #</td>
<td>[#] [INSERT]</td>
<td>Master # is linked, with its current content, and a target level of 100%.</td>
</tr>
</tbody>
</table>
*In the Sequences - List.

**NOTE**

All functions in the Master Link list are the same as in the View Masters list. The only differing one is Target, which is the level the Master will fade to. To load a Master for manual operation, set the target level to 0%.

Sequence Step Links - Shortcut

There is a shortcut for inserting a Master Link directly to the current Sequence Step in the Main Playback.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert link</td>
<td>[INSERT] &amp; [Master Key]</td>
<td>Master # is inserted as a link to the Step in A.</td>
</tr>
<tr>
<td>Insert link with target</td>
<td># [INSERT] &amp; [Master Key]</td>
<td>Master # is linked, with its current content, and a target level of 100 or 0% depending on earlier links.</td>
</tr>
</tbody>
</table>

Sequence Step Links - Master Pages

You can insert a link to a master page.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the MastPage column*</td>
<td>Arrow keys</td>
<td>The column is highlighted</td>
</tr>
<tr>
<td>2. Insert a link</td>
<td># [MODIFY]</td>
<td>Master Page # is linked. It will be loaded to Masters 1-20 when this step is loaded to the B (Next) playback.</td>
</tr>
</tbody>
</table>

*In the Sequence List.

Sequence Step Links - Another Step

**NOTE**

Links to another sequence step are used mainly to create playback loops. Links are NOT used to change a playback order in Cobalt - this is done by cutting and pasting a step in a different location. See Copy, Cut & Paste.
<table>
<thead>
<tr>
<th>Function</th>
<th>Column</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the LinkTo column*</td>
<td>Arrow keys</td>
<td>The column is highlighted</td>
</tr>
<tr>
<td>2. Insert a link to Sequence Step #</td>
<td># MODIFY</td>
<td>Sequence Step # is linked. When this step is faded in, the next step will be Step #.</td>
</tr>
</tbody>
</table>

*In the [Sequence List](#).
Sequences - Load

A Sequence can be loaded to the Main Playback, or any Master Playback. For information on how to control a Sequence once it is loaded, see Main Playback and Masters.

<table>
<thead>
<tr>
<th>Function</th>
<th>Keys</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load</td>
<td># SEQ &amp; PLAYBACK</td>
<td>Sequence # is loaded to the Main Playback. The light in A (Active) and B (Next) is not affected.</td>
</tr>
<tr>
<td>Load to master</td>
<td># SEQ &amp; Master Key</td>
<td>Sequence # is loaded to the Master Playback.</td>
</tr>
</tbody>
</table>

NOTE
Loading a non-existent Sequence to Playback will open a window asking if you wish to create that Sequence.

You can load a sequence directly from the Browser as well (LOAD is only available in Congo Jr and Kid).

<table>
<thead>
<tr>
<th>Function</th>
<th>Keys</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load</td>
<td>LOAD &amp; PLAYBACK</td>
<td>Sequence # is loaded to the Main Playback. The light in A (Active) and B (Next) is not affected.</td>
</tr>
<tr>
<td>Load to master</td>
<td>LOAD &amp; Master Key</td>
<td>Sequence # is loaded to the Master Playback.</td>
</tr>
</tbody>
</table>
Sequences - Build & Modify Modes

There are two modes that affect recording and playback of Sequences. Build Sequence and Modify Sequence.

The fastest way to toggle them on/off is with the context menu (right-click) on the header of the Playback Tab.

Both can be set in System Settings as well. See System Settings - Crossfade.

Sequence - Build Sequence Mode

This mode is set in the Crossfade Settings. See System Settings - Crossfade.

The default setting for this mode is ON. When ON every Preset recorded in the Live or A tab will automatically be added to the Sequence in the Main Playback (in numerical order). The only reason to set this mode to OFF is when a Preset recorded in Live or A should NOT be added to the sequence in the Main Playback.

NOTE
You can record a Preset without adding it to the Sequence in the Main Playback with a shortcut; # RECORD & PRESET

See Record Preset - Do not add to Sequence
**Sequence - Modify Sequence Mode**

Press MODIFY SEQ in the Misc Soft Key Page to toggle. See [Navigating - Misc Soft Key Page](#).

The default setting for this mode is OFF. When turned ON all crossfade in Sequences will disregard Wait and Followon Times, Master Links, Master Pages, Links and other linked information. It is a mode created for rehearsals where only the main lighting changes are advanced manually.

When activated there will be a popup explaining what this means for the user;
Sequences - Block Values

It is possible to set a block for all track editing functions for a step in the Advanced tab of the Recording Popup or later, in the Sequence List. See also Track - Track Editing.
A block is indicated in the Playback List with a B after the Preset and a line over the step. In this image step 4 is blocked.

<table>
<thead>
<tr>
<th>Step</th>
<th>Intensity</th>
<th>Channel</th>
<th>Device</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>3.0</td>
<td>Out: d2</td>
<td>ChT: 1 Dev: 2</td>
</tr>
<tr>
<td>4</td>
<td>3.2</td>
<td>B</td>
<td>Dev: 2</td>
</tr>
<tr>
<td>5</td>
<td>3.5</td>
<td></td>
<td>Dev: 4</td>
</tr>
<tr>
<td>6</td>
<td>3.7</td>
<td></td>
<td>Dev: 4</td>
</tr>
</tbody>
</table>

NOTE
Currently all intensities are blocked. To block the intensity for an individual channel set it to a different value from incoming or outgoing values (like 99% or 49%).
Sequences - Track List

It is possible to track edit intensities, channels, devices and attributes in Groups, Presets, Palettes and Sequences.

All tracking features are described in the chapter Track List. See Track List.
Sequences - Chase Mode

A chase is a sequence set to chase mode, which means it will constantly loop during playback. See Sequences.

This chapter contains the following sections

- Chase - Introduction
- Chase - Playback View
- Chase - Playback Modes
- Chase - Set Rate
- Chase - BPM & Tap Tempo
- Chase - Wizard
**Chase - Introduction**

A Sequence can be set to run in Chase mode. This means the Sequence will chase endlessly through all Steps on the predefined times. There are several parameters that can affect how it will run in Chase mode.

**General Facts**

- Chases are edited in the same way as Sequences.
- In addition to Sequences they have Rate and BPM.
- BPM can be set with TAP from the Master Playback.
- A Chase has playback modes such as Reverse, Bounce, Single Shot.
- You can link any chase to a sequence step using a Master Link.
- You can play back a chase from any playback, including the Main Playback.
Chase - Playback View

The Chase playback view is the same as the Sequence Playback view with some added indicators for chase mode.

The added chase indicators appear under the sequence name display in the top of the Playback view. The functions are described in The Sequences List Columns as well as the rest of this chapter.
Chase - Playback Modes

There are three modes that affect the playback of a chase.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Where</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reverse</td>
<td>Set in The Sequences List Columns</td>
<td>Reverses the chase direction.</td>
</tr>
<tr>
<td>Bounce</td>
<td>Set in The Sequences List Columns</td>
<td>Makes the chase reverse direction every second time.</td>
</tr>
<tr>
<td>Single Shot</td>
<td>Set in The Sequences List Columns</td>
<td>The chase will run one time and stop.</td>
</tr>
</tbody>
</table>
# Chase - Set Rate

You can set a rate 1-1000% for a Chase. It will scale all times proportionally.

<table>
<thead>
<tr>
<th>Action</th>
<th>Keys</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Open the Sequences list</td>
<td>SEQ</td>
<td>The Sequences List is opened.</td>
</tr>
<tr>
<td>2. Step to the Rate cell for a chase</td>
<td>Arrow Keys</td>
<td>The cell is highlighted.</td>
</tr>
<tr>
<td>3. Enter a new Rate</td>
<td># MODIFY</td>
<td>The Rate # is assigned to this Chase. All fade times are proportionally scaled.</td>
</tr>
</tbody>
</table>
Chase - BPM & Tap Tempo

You can set the tempo/speed to a chaser in BPM. This can be set numerically in the Sequences tab (Browser > Main Show Data > Sequences) or using the Tap Tempo function.

Set BPM Numerically

<table>
<thead>
<tr>
<th>Action</th>
<th>Keys</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Open the Sequences list</td>
<td>[SEQ]</td>
<td>The Sequences List is opened.</td>
</tr>
<tr>
<td>2. Step to the BPM cell for a chase</td>
<td>Arrow Keys</td>
<td>The cell is highlighted.</td>
</tr>
<tr>
<td>3. Enter a new BPM</td>
<td>[MODIFY]</td>
<td>The BPM # is assigned to this Chase.*</td>
</tr>
</tbody>
</table>

*The BPM parameter is only used for sequences in Chase mode. When the BPM parameter is set, it will override all programmed times. The In and Out times will be 0 s and the Wait time will be set according to the BPM parameter.

Set BPM using Tap Tempo

<table>
<thead>
<tr>
<th>Action</th>
<th>Keys</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Assign the chaser to a Master</td>
<td>[SEQ] &amp;</td>
<td>The Chase is assigned to the Master Playback.</td>
</tr>
<tr>
<td></td>
<td>Master Key</td>
<td></td>
</tr>
<tr>
<td>2. Tap the Tempo</td>
<td>TAP &amp;</td>
<td>Hold TAP and tap the Master Key at least twice.*</td>
</tr>
<tr>
<td></td>
<td>Master Key</td>
<td></td>
</tr>
</tbody>
</table>

*You have to tap at least 2 times in a row before the new tempo is activated. The tapping speed is translated to, and stored as the BPM parameter in the Sequence List. You can easily change it afterwards.
Chase - Wizard

The Chase Wizard can create a chase sequence from a channel selection. It is activated from within the Sequences List.

<table>
<thead>
<tr>
<th>Action</th>
<th>Keys</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Open the Sequences list</td>
<td>SEQ</td>
<td>The Sequences List is opened.</td>
</tr>
<tr>
<td>2. Open the Chase Wizard</td>
<td>WIZARD</td>
<td>The Chase Wizard is opened. The next free Sequence number is suggested.</td>
</tr>
<tr>
<td>3. Select channels and set levels</td>
<td>Channel functions</td>
<td>The current channel selection from Live is automatically loaded. Change if wanted to.</td>
</tr>
<tr>
<td>4. Fill in the Chase Wizard</td>
<td>Arrow Keys</td>
<td>See Chase Wizard - Functions</td>
</tr>
<tr>
<td>5. Execute the Chase Wizard</td>
<td>EXECUTE</td>
<td>The Wizard is closed, and the new Chase is added to the Sequences List.</td>
</tr>
</tbody>
</table>
This is the Chase Wizard

Step 1: Select the channels/levels to operate on in the Channel View
Step 2: Select options and Execute

- Number of steps: 4
- Channels per step: 1
- Step time: 0.1
- Chase number: 22
- Build: [ ]

Execute
## Chase Wizard - Functions

<table>
<thead>
<tr>
<th>Column</th>
<th>Input</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of steps</td>
<td>[# MODIFY</td>
<td>The number of steps the Chase shall have.</td>
</tr>
<tr>
<td>Channels per step</td>
<td>[# MODIFY</td>
<td>The number of channels you wish to have in each step.</td>
</tr>
<tr>
<td>Step time</td>
<td>[# MODIFY</td>
<td>Default wait time for each step. Can be edited after.</td>
</tr>
<tr>
<td>Chase number</td>
<td>[# MODIFY</td>
<td>The number this Chase will have. Next free is suggested.</td>
</tr>
<tr>
<td>Start at preset</td>
<td>[# MODIFY</td>
<td>The Preset number this Chase will use for the steps. It will start at Preset 800 by default.</td>
</tr>
<tr>
<td>Increment</td>
<td>[# MODIFY</td>
<td>You can set the Chase to use Presets with an increment of .1 here.</td>
</tr>
<tr>
<td>Build</td>
<td>MODIFY</td>
<td>Check if you want the Sequence Steps to continue adding new channels in each step to the previous ones.</td>
</tr>
</tbody>
</table>

**NOTE**
If you want to make changes in the Chase Sequence you just created, use the Sequence and Preset editors. It is a "normal" Sequence that has been created by the Chase Wizard.
**Sequences - Split Fade**

There is a setting in the Mode cell of each step in the Sequence List that allows you to set the fade mode to S (Split) in which there will be no dipless calculation between the crossfaders - allowing for a blackout by moving each fader to zero.

**Example**
There is a preset in A in which channels 1-10 are at 10.
In the next preset channels 5-10 will go from 10-100.

If the fade is Split, it will be like bringing one master down fading out channels 1-10, and then bringing in 5-10 to 100, with a "split" between them.

If the fade is not Split (default mode) the channels will go from 10 where they are, to 100, without a "dip" in the crossfade.

See [Sequences - Sequence List](#)
Sequences - Drag And Drop

There are many ways of moving around data in a sequence. Drag and drop is one of them. It can be useful if you want to reorganize the order of your sequence steps, or for example if you want to move an attribute link from one step to another.

NOTE
You cannot drag and drop steps in a Cue Sequence.

Drag and Drop a Sequence Step

Moving or copying a sequence step to another position can be done in all three Sequence views:

- Playback View
- Sequence List
- Organizer

Simply select the step you wish to move, click, hold and drag to another position and drop.

In the Playback View:
In the Sequence List:

![Sequence List Image](image1)

In the Organizer:

![Organizer Image](image2)
In all three cases you will get the following dialogue:

![Drop dialogue](image)

This dialogue allows you to COPY or MOVE the selected step.

COPY = Makes a copy of the source and inserts it into the sequence after the target step.
MOVE = Moves the source and inserts it into the sequence after the target step.

If you select the Advanced tab by pressing left arrow you get the following options:
The first option allows you to define where you want to copy/move the step to.

- After the target step (default)
- Before the target step
- Replace the target step

The second option "Create Between" allows you to create a new step with a new preset number and insert (after/before).

**Drag and Drop Device Attributes**

Moving and copying device links in a sequence can be done in the organizer, or in the main playback tab.

**Organizer**

1. Open the Organizer tab (Browser >Main Show Data >Organizer (1 tab)) and expand the sequence nodes.
2. Left-click, hold and drag the Devices node from step preset 200 to preset 201 and drop. This will give you a dialogue:
Your options are to either copy, or move the device link you just dragged.

**NOTE**

You can drag all devices, devices of the same type or just a single device depending on where you click when you drag.

**Main Playback Tab**

In the main Playback Tab, left-click, hold and drag devices in the device cell of a sequence step to another step and drop to get the same dialogue as when you drag and drop in the Organizer as described above.
**Sequences - Section Markers**

You can organize the contents of a sequence visually by setting section markers that will provide a blue heading. In addition to this you can jump between section markers.

The quickest way to apply or remove a section marker is using the context menu (right-click over a sequence step in the Playback tab).

You can see and set the section markers in the sequence editor as well - in the column at the far right.
AND you can set the section marker also when you record a new preset in the sequence from the Advanced Record dialogue.
Jump Between Section Markers

There are different ways to jump between section markers

<table>
<thead>
<tr>
<th>Function</th>
<th>Keys</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next marker to A</td>
<td>GOTO &amp; SEQ+</td>
<td>Step with next marker is loaded to A</td>
</tr>
<tr>
<td>Previous marker to A</td>
<td>GOTO &amp; SEQ-</td>
<td>Step with previous marker is loaded to A</td>
</tr>
<tr>
<td>Next marker to B</td>
<td>JUMPTOB &amp; SEQ+</td>
<td>Step with next marker is loaded to B</td>
</tr>
<tr>
<td>Previous marker to B</td>
<td>JUMPTOB &amp; SEQ-</td>
<td>Step with previous marker is loaded to B</td>
</tr>
<tr>
<td>Snap to next/previous marker</td>
<td>G &amp; up/down_arrows</td>
<td>From Keyboard: Snap to next/previous marker</td>
</tr>
</tbody>
</table>

You can set TYPE to Section in the Direct Selects as well.
Sequences - Cues

You can create a sequence with unique cues instead of the default presets. A preset is a referenced piece of data from the central preset list, a cue is a unique piece of data belonging to a specific sequence and step.

You can choose which of these you prefer to work with at any time and in any of these dialogues:

In the Let's Begin dialogue that is the first thing you see when you open a new show.
In the sequence tab of every record dialogue to a master (Hold RECORD and press master key).
In the Play Settings dialogue (press SETUP)
In the dialog that appears when you press INSERT in the Sequence List.

When the sequence is set to cues the playback view will look like this:
Cue Sequence Attribute Editor

When you are in a cue sequence there is a short command for opening the attribute editor for a cue. See Preset Attribute Editor.

# SEQ & ATTRIB
**Sequences - Loop Mode**

There are 3 modes that affect playback of Sequences. Normal, Chase and Loop. The mode of Loop is an addition to a normal sequence, only that there is no empty step between the last and the first when you reach the end.

You can toggle this is in the mode column of the Sequences List. See more in [Sequences List - Columns](#).
**Playlist**

The Playlist allows you to arrange the order in which sequences are loaded to the main playback.

1. Make sure you have some sequences to arrange in the playlist.
2. Open the Playlist editor

The Playlist is opened from Browser >Main Show Data >Playlist.

These are the functions in the Playlist.

<table>
<thead>
<tr>
<th>Function</th>
<th>Keys</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert</td>
<td># INSERT</td>
<td>Sequence # is inserted into the Playlist</td>
</tr>
<tr>
<td>Delete</td>
<td>DELETE</td>
<td>Sequence # is deleted from the Playlist</td>
</tr>
<tr>
<td>Load</td>
<td>GOTO</td>
<td>Loads the selected Sequence to the Main Playback from the next fade.</td>
</tr>
</tbody>
</table>

3. Activate Playlist Mode from the Misc Soft Key Page (see below).

**NOTE**
You can reset the Playlist to start from the top at anytime by holding C and pressing PLAYLIST in the Misc Soft Key Page.
The Playlist - Mode

The PLAYLIST allows you to activate Playlist mode for playback of a number of sequences in a predefined order in the main playback.

(Soft Key Pages are commands in the lower right corner of screen 2)

When it is active all Sequences in the Playlist will be loaded when the previous is finished, until the end. Every time a new Sequence is loaded this will be notified with a message on the main screen.
The Playlist - Activate and Use

Hold [<--] and press the softkey PLAYLIST in the Misc soft key page to activate the Playlist.

In the Main Playback tab.

The sequences will play back in the order they are stored in the Playlist until the end.

In the Direct Selects - you can arrange them here as well. See Direct Selects - Arrange.
Groups/Palettes Overview

This is an overview showing both Groups and Palettes of all types (Focus, Color, Beam, All) in the same tab.

Open from the Browser >Main Show Data >Group/Palette Overview.

- Press MODIFY to activate a selected item.
- Press TRACK to track a selected item.
- Press MODIFY to edit a name.
<table>
<thead>
<tr>
<th>#</th>
<th>Group</th>
<th>Text</th>
<th>Palette</th>
<th>Text</th>
<th>Focus</th>
<th>Text</th>
<th>Color</th>
<th>Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Key lights</td>
<td>Front R-O/W</td>
<td>1</td>
<td>Front L</td>
<td>1</td>
<td>O/W</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Back lights</td>
<td>Gr-Mag Look</td>
<td>2</td>
<td>Front C</td>
<td>2</td>
<td>Red</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Revolutions</td>
<td>Wall Orange</td>
<td>3</td>
<td>Front R</td>
<td>3</td>
<td>Yellow</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Sides Amber</td>
<td>Wash Stage</td>
<td>4</td>
<td>Mid L</td>
<td>4</td>
<td>Green</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Sides Cyan</td>
<td>Default view</td>
<td>5</td>
<td>Mid C</td>
<td>5</td>
<td>Blue</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Mac 300's</td>
<td>Top View</td>
<td>6</td>
<td>Mid R</td>
<td>11</td>
<td>OW</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Gobo lights</td>
<td>SL view</td>
<td>7</td>
<td>Back L</td>
<td>12</td>
<td>Red</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Cyclo lights</td>
<td>Back view</td>
<td>8</td>
<td>Back C</td>
<td>13</td>
<td>Green</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Available choices: Modify Track
>Settings & Tools - Main Show Data

These are the settings and tools for Main Show Data.

This chapter contains the following sections

- Fade Curves
- Notes Editor
- Delete Wizard
- Auto-create Palette Wizard
**Fade Curves**

It is possible to create and assign fade curves to each crossfade. It is possible to create any kind of curve in the Fade Curve Editor. The curves affect intensities, not Moving Device attributes.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Open the Fade Curve List</td>
<td>Browser &gt; Main Show Data &gt; Settings and Tools &gt; Fade Curves</td>
<td>The Fade Curve List is opened.</td>
</tr>
<tr>
<td>2. Insert a New Curve</td>
<td>INSERT</td>
<td>A new curve is inserted. You can name it in the Name cell.</td>
</tr>
<tr>
<td>3. Open the Fade Curve Editor</td>
<td>MODIFY</td>
<td>Press MODIFY in the Fade Curve cell to open the editor.</td>
</tr>
</tbody>
</table>

When you create a new play a set of standard fade curves are loaded.

**Fade Curve Editor** (example: fast Top Curve)
### Action

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>4. <em>Insert a position</em></td>
<td>INSERT</td>
<td>A position is inserted. You can set percent, Output and if this step should use interpolation to the next step.</td>
</tr>
</tbody>
</table>
**Sequence - Assign Fade Curves**

Assign curves to a sequence step in the Sequence Editor.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Open the Sequence Editor</td>
<td>[MODIFY] &amp;</td>
<td>The Sequence List is opened.</td>
</tr>
<tr>
<td>2. Move to the column &quot;Fade Curve&quot;</td>
<td>Arrow Keys</td>
<td>The cell is highlighted</td>
</tr>
<tr>
<td>3. Open the Fade Curve popup</td>
<td>[MODIFY]</td>
<td>The popup is opened. If no curves are defined it will only have &quot;No curve&quot;.</td>
</tr>
<tr>
<td>4. Select a Curve</td>
<td>Arrow keys</td>
<td>The selected curve is highlighted</td>
</tr>
<tr>
<td>5. Confirm</td>
<td>[MODIFY]</td>
<td>The popup is closed and the selected curve is assigned to this step.</td>
</tr>
</tbody>
</table>
**Notes Editor**

A NOTE allows you to add a comment and a color code to any Sequence Step, Group, Preset or Palette. All Notes are summarized in a list with a time and user stamp - and a direct link to the object the Note is attached to.

- All Notes are tagged with a time stamp, and the user login of the operator.
- Notes are shown in the Playback View with Flags.
- The color of these flags can be set in the Notes Editor.
- In the Notes Editor, it is possible to edit, delete and change color code for Notes.

**Notes - Create**

Pressing NOTE (for example in the Preset List) will produce the following popup

![Enter note for Preset 1.0](image)

Notes are created in the following lists by pressing NOTE.

- Playback view
- Sequence List
- Preset List
- Group List
- Focus Palette List
- Color Palette List
- Beam Palette List
- All Palette List

Press MODIFY to save. See [Notes - Editor](#).
Notes - Editor

Open the Notes Editor by holding MODIFY and pressing NOTE or from the Browser (Browser >Main Show Data >Settings and Tools >Note Editor).

You can change the color of the NOTE flag in the far right column of this editor.

Note Editor - Columns

These are the columns in the Note Editor.

<table>
<thead>
<tr>
<th>Column</th>
<th>Input</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>TimeStamp</td>
<td>MODIFY</td>
<td>The time stamp of this Note - Press MODIFY to open the editor for this object.</td>
</tr>
<tr>
<td>User</td>
<td>MODIFY</td>
<td>The user that created this Note - Press MODIFY to open the editor for this object.</td>
</tr>
<tr>
<td>Linked to</td>
<td>MODIFY</td>
<td>The object of this Note - Press MODIFY to open the editor for this object.</td>
</tr>
<tr>
<td>Note</td>
<td>MODIFY</td>
<td>The Note text. MODIFY opens the text for editing.</td>
</tr>
<tr>
<td>Color</td>
<td>MODIFY</td>
<td>The color popup (only for the playback tab). Press MODIFY to open and select. Press MODIFY to close*</td>
</tr>
</tbody>
</table>

*The color flag is shown for Notes in the Playback View, and the text is shown to the left of the graphical view of the crossfade.
Note Editor - Delete

Notes are deleted in the Note Editor.

1. Open the editor. See Notes - Editor.

2. Select the Note with arrow keys.

3. Press DELETE. The Note is deleted.
Delete Wizard

The Delete Wizard allows you to delete bulk data in your play.

It is opened from the Browser > Main Show Data > Settings and Tools > Delete Wizard.

There are two tabs.

- Delete All (of a type of data)
- Delete Partial (a type of data from # of that data)

Delete All
Delete Partial

Please use this Wizard carefully. You may remove a lot of data very easily and the operation cannot be undone!

Delete What
Start at
Stop at

Presets
Nothing
Groups
Preset
Main sequence
Other sequences
All Palettes
Focus Palettes
Color Palettes
Beam Palettes

Execute
**Auto-create Content Wizard...**

This wizard allows you to generate palettes and groups for each range for selected parameters in the currently selected devices. Ranges with the same name will be merged together in the same palette. You can specify the starting number for newly generated palettes.

Open in the Browser from Browser >Main Show Data>Settings and Tools >Auto-create Content Wizard...

**Auto-create Palettes from Ranges**
For example, if you choose parameter 1 to be a gobo wheel, beam palettes will be created for each gobo, with the name of the gobo starting at beam palette 101.

![Auto-create Content Wizard](image)

**Auto-create Groups from Auto-groups**
Auto-create Content Wizard

This wizard will generate groups from Auto-groups

Include Text A
Include Text B
Include Text C
Include Text D
Start at Group: 101

Execute
Channels

Every dimmer or device controlled from Cobalt is selected and controlled by its channel number.

Channels Node

This chapter contains the following sections

- Channels Functions
- Live View
- Blind View
- Track List
- Parked
- >Settings and Tools - Channels
 Channels - Introduction

A channel is the "handle" you call upon to control any dimmer or device connected to the system.

Dimmer channel formats.

Device channel formats

Channels are selected with the channel functions of the programming section. The Channel Control functions are mapped to any section of the console at any time - for example pressing LIVE connects to the A field of the Main Playback, pressing BLIND connects to the Blind field.

NOTE

Channel Control is not the same thing as a "programmer" where channels are "stolen" into the programmer and have to be "released" - instead the Channel Control is mapped to any Playback (A, B, Live, Blind, Masters), and controls the channels directly in that playback.

General Facts

- Channel levels can be set with the faders in Channels Only Mode
- Channels can be selected and set with a Command Syntax from the keypad
- Channel levels are set from 0-100%. 0% values are not displayed on the channel screen and 100% values are displayed as F, standing for "Full". The full resolution of DMX 512 is higher than 100 steps, its 256 steps called bits. Therefore there are functions for setting and changing levels in increments of bits (0-255).
- Channels are always controlled directly in a playback or an editor, and the current one is indicated in the small display "Channel Control" at the bottom of all screens.
- There is a Highlight mode, mainly used for focusing devices, that can also be used for conventional lights. (See Device Control -- Highlight Mode)
Channels - Functions

These are the channel functions.

This chapter contains the following sections

- Channels - Views
- Channels - Command Syntax
- Channels - Ch Only Mode
- Channels - 8 bit 256 Step Levels
- Channels - Capture Mode
- Channels - Clear Functions
- Channels - Check Mode
- Channels - Balance Mode
- Channels - Random Selection
- Channels - Scale Level
- Channels - Used & Unused
- Channels - Group Wheel Mode
- Channels - Rem Dim
- Channels - Next & Last Mode
- Channels - Select Functions
- Channels - Find Highest Level
Channels - Views

Channels (dimmers and devices) are displayed in channel views.

1. This is the Live tab in Channels mode
2. Settings - expand/compress level of detail, switch palette name or number
3. Live tab in Attributes mode for devices. Use context menu or ATTRIB to toggle
4. Context menu for format, if you click on a channel there are channel functions.

A Channel View like the Live Tab shows only channels, but a channel view can also be a part of editors like the Preset Editor, the Sequence Editor, Effect Editors etc.
If you right-click on a channel or hold LOCAL MENU and click on it, you will get the channel context menu with a selection of commonly used functions that can be applied to the currently selected channel(s).

Channel views can show channel intensities, palettes and attributes. They have different levels of detail and can be zoomed. For more information see Navigating - Channel Views and Live - Introduction.
Navigating - Channel Views

The FORMAT key is one of the main keys used to navigate in the Channel Views. The channel symbols and formats are described in another chapter. (See Channel Symbols)

- Hold FORMAT and use the level wheel to zoom
- Hold C & FORMAT to reset the zoom factor
- Press FORMAT to toggle channel formats
Hold FORMAT and press ALL to select the All Channels format directly
Hold FORMAT and use up/down arrow to select compact format (see below)
Enter a number and press FORMAT to select a Magic Sheet
Hold CHANNEL and press Arrow keys to page
Hold CHANNEL and move the level wheel to scroll (not in Magic Sheets)

The status bar in the top shows the current Preset in the Main Playback to the left and the selected format to the right. You can touch or click on the right side of the header bar to open a context menu with all formats as shown above.

Compact Channel Format

There is a compact channel format where relative intensity levels are shown with a white status bar.

- FORMAT & up arrow - compacts the format
- FORMAT & down arrow - expands the format
Channel View Formats - Selected

Only selected channels are shown. (Pressing FORMAT toggles through the formats.)

Channel View Format - Selected and non-zero

Selected and non-zero channels are shown. (Pressing FORMAT toggles through the formats.)

Hold FORMAT and press CHANNEL to select this format directly.
Channel View Format - Selected And Captured

Selected and captured channels are shown. (Pressing FORMAT toggles through the formats.)

Hold FORMAT and press CAPTURE to select this format directly. See Channels - Capture Mode.

Channel View Format - Used In Play

Only channels recorded in some way in this play are shown. (Pressing FORMAT toggles through the formats.)
Channel View Format - Magic Sheet (8.0)

The last selected Magic Sheet is shown. (# FORMAT selects Magic Sheet #.) If there are no Magic Sheets stored in the show, a dialogue to create one will appear.

Channel View Zoom

Hold FORMAT and use the wheel to Zoom in/out. (You can hold FORMAT (F4) and then right-click and drag with mouse as well).
NOTE
Hold C & FORMAT to reset the zoom factor.
Channels - Command Syntaces (RPN/At Mode)

Depending on where you come from you will be accustomed to some kind of command syntax. In Cobalt it is possible to do most of your design and programming without having to worry about this, since most functions are available directly on the screens. However, for traditional number crunching of lights and levels it makes a difference. There are two options. RPN and At Mode.

**RPN**
The default mode for entering commands in the system is simple to learn, requires few keystrokes and applies to all functions in the system. It is used a lot in HP calculators for speedy calculations and is called Reverse Polish Notation (RPN). Since RPN applies to everything in the system we recommend you spend the necessary 30 minutes to understand it. There's one single rule: enter the number first and press the function key after.

**AT MODE**
At Mode (also called (Direct Entry) is different in the way that ch numbers are entered directly, followed by a function (@ LEVEL for example) and the value of that function.

**NOTE**
At mode setting is set up and stored in the registry as a system setting. See Console Settings.
Select Channels

The fastest way to select a channel and set a level regardless of syntax is to enter the number of that channel and move the level wheel.

This is a table with the key entries for most channel commands. See also Multicell Devices.

<table>
<thead>
<tr>
<th>Channel</th>
<th>RPN</th>
<th>AT MODE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear selected channels</td>
<td>C/Alt</td>
<td>C/Alt</td>
</tr>
<tr>
<td>Select channel 1</td>
<td>1 CHANNEL</td>
<td>1</td>
</tr>
<tr>
<td>Add channel 2</td>
<td>2 +</td>
<td>+ 2</td>
</tr>
<tr>
<td>Add through 7</td>
<td>7 THRU</td>
<td>THRU 7</td>
</tr>
<tr>
<td>Subtract ch 3</td>
<td>3 -</td>
<td>- 3</td>
</tr>
<tr>
<td>Select all channels with a level</td>
<td>ALL</td>
<td>ALL</td>
</tr>
<tr>
<td>Select all channels at level #</td>
<td># ALL @LEVEL</td>
<td># ALL @LEVEL</td>
</tr>
<tr>
<td>Select all channels with a level in</td>
<td>ALL ALL</td>
<td>ALL ALL</td>
</tr>
<tr>
<td>any playback</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Invert the current channel selection</td>
<td>INV GROUP</td>
<td>INV GROUP</td>
</tr>
<tr>
<td>(of all channels with a level)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Step to the next ch</td>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>Step to the previous ch</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

NOTE
To complete a channel selection in At Mode without pressing the @ LEVEL key, use the decimal [.] key twice.

See Channels - Clear Functions
Selecting Decimal Channels (7.1)

<table>
<thead>
<tr>
<th>Channel</th>
<th>RPN</th>
<th>AT MODE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select complete device</td>
<td>1 [CHANNEL]</td>
<td>1</td>
</tr>
<tr>
<td>Select only base channel</td>
<td>1 . 0</td>
<td>1 . 0</td>
</tr>
<tr>
<td>Select only decimal channels</td>
<td>1 . 1</td>
<td>1 . 1</td>
</tr>
</tbody>
</table>

Set Channel Levels

Once a channel(s) is selected you can set levels in the following ways.

<table>
<thead>
<tr>
<th>Level Command</th>
<th>RPN</th>
<th>AT MODE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set to 50%</td>
<td>[5] [0] @LEVEL</td>
<td>@LEVEL 5 0</td>
</tr>
<tr>
<td>Set to 55%</td>
<td>[5] [5] @LEVEL</td>
<td>@LEVEL 5 5</td>
</tr>
<tr>
<td>Set to 100%</td>
<td>@LEVEL @LEVEL</td>
<td>@LEVEL @LEVEL</td>
</tr>
<tr>
<td>Set to 70%*</td>
<td>@LEVEL</td>
<td>@LEVEL 7 0</td>
</tr>
<tr>
<td>Set to 0%</td>
<td>@LEVEL @LEVEL @LEVEL</td>
<td>@LEVEL 0</td>
</tr>
<tr>
<td>Add 5%</td>
<td>+%</td>
<td>+%</td>
</tr>
<tr>
<td>Subtract 5%</td>
<td>-%</td>
<td>-%</td>
</tr>
<tr>
<td>Select ch # and add 5%</td>
<td># +%</td>
<td># +%</td>
</tr>
<tr>
<td>Select ch # and subtract 5%</td>
<td># -%</td>
<td># -%</td>
</tr>
<tr>
<td>Increase level by #%</td>
<td># . +%</td>
<td>not possible in at mode</td>
</tr>
<tr>
<td>Diminish level by #%</td>
<td># . -%</td>
<td>not possible in at mode</td>
</tr>
<tr>
<td>Revert to last used level (Undo)</td>
<td>[ON/FETCH] &amp; @LEVEL</td>
<td>[ON/FETCH] &amp; @LEVEL</td>
</tr>
</tbody>
</table>
*This is the Step Level value of the SETUP for the Level key. You can change it by holding SETUP and pressing @LEVEL.

NOTE
There is a function for setting the last recorded level, and for fetching levels from any recorded Preset.

See Presets - Fetch Intensities

Park Level

You can set a channel at a constant level. It will not be affected by any other controls (including the Grand Master).

See Park.
**Channels - Ch Only Mode**

The CH ONLY MODE key in the programming section allows a complete novice to get some lights on stage. It converts all 40 Playback faders to channel faders temporarily, actually turning the console into a single scene board.

<table>
<thead>
<tr>
<th>Action</th>
<th>Console</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Make sure the Grand Master is up</td>
<td>Grand Master</td>
<td>Otherwise there is no light output</td>
</tr>
<tr>
<td>2. Make sure the FREEZE switch is set to ON</td>
<td>Freeze Switch</td>
<td>Otherwise there is static, or no light output</td>
</tr>
<tr>
<td>3. Activate channel only mode</td>
<td>CH ONLY MODE</td>
<td>Channels 1-40 can be accessed from the Master faders now. Move fader 1 and you can see the value for channel 1 on the channel views.</td>
</tr>
<tr>
<td>You can select a channel range from the master buttons above/under the displays</td>
<td>Master buttons</td>
<td>The channels in each range are indicated in the displays.</td>
</tr>
</tbody>
</table>

The levels will remain when you exit Channel Only mode and can be used in the normal mode.

To exit Channels Only Mode, press again.
# Channels - 8 bit 256 Step Levels

You can work with 8 bit 256 step levels.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Increase 1 bit</td>
<td>, &amp; +%</td>
<td>As long as the decimal point is held, pressing +% will add one bit step to the selected channels</td>
</tr>
<tr>
<td>Decrease 1 bit</td>
<td>, &amp; -%</td>
<td>As long as the decimal point is held, pressing +% will subtract one bit step from the selected channels</td>
</tr>
<tr>
<td>Show 256 bit levels</td>
<td>[FORMAT] &amp; [LEVEL]</td>
<td>Toggles the view between decimal and 256 bit levels</td>
</tr>
</tbody>
</table>

**EXPLANATION**

Levels for channels controlling dimmers are traditionally set from 0-100%. The internal resolution of DMX 512 however, is about 2.5 times greater, from 0 to 255. You may want to use this higher accuracy when you are setting values for mechanical dimming devices.

The board will display the %-value rounded off to the closest value. (1.4% will be displayed as 1% and 1.6% will be displayed as 2%)

To convert between 0-100% and 0-255 raw DMX levels, you divide the % level with 0.39 (100/255=0.39). For example: 50% / 0.39 = 128 bit steps (actually 128.21)

The other way around you multiply by the same factor of 0.39. Example: 129 x 0.39 = 50.31%

**NOTE**

256 bit step levels are not displayed on the channel screen, but are stored with the show and exported in ASCII Light Cues.
**Channels - Capture Mode**

The CAPTURE key in the programming section allows you to capture a channel or device and control and record it regardless of where it is output from in the system. Captured levels are considered to be changed at all times and will be recorded into Presets accordingly. A Captured channel/device stays this way until released with the RELEASE key.

You can capture a channel/device by selecting the channel(s), holding CAPTURE and pressing CH or moving the level wheel, and you can activate Capture Mode (by pressing CAPTURE twice) in which any channel/device that is changed will be captured until release.

The channel number background of a captured channel is red.

RECORD will store the captured level.

It is possible to work in a permanent Capture mode, and there are functions for Capturing any part of a ch.

As soon as Capture is active for a channel or parameter, this is indicated at the top of all screens.
Permanent Capture Mode

While Capture mode is activated, all channels that are changed are automatically captured.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate</td>
<td>CAPTURE</td>
<td>Capture will light up. All channels that are selected and changed will remain at that level until released.</td>
</tr>
<tr>
<td>Deactivate</td>
<td>CAPTURE</td>
<td>Capture light goes off. Captured channels remain captured until released. Captured channels will have a red background for the channel number.</td>
</tr>
</tbody>
</table>
Capturing levels or parameters

Regardless if Capture mode is active or not, it is always possible to capture channels or part of channels. Capture mode is not toggled to a permanent active state by these commands (5.0).

**OBSERVE**

That all of these commands will affect the currently selected channels. If a number is entered first, only this channel will be affected.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intensity and parameters</td>
<td><code>CAPTURE CHANNEL</code></td>
<td>Captured channels will have a red background for the channel number.</td>
</tr>
<tr>
<td></td>
<td><code>CAPTURE @LEVEL</code></td>
<td>Level is captured until released.</td>
</tr>
<tr>
<td>Intensities</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parameters</td>
<td><code>CAPTURE ATTRIB</code></td>
<td>Parameters are captured until released.</td>
</tr>
<tr>
<td>Single Parameters</td>
<td><code>CAPTURE Wheel key</code></td>
<td>Parameters are captured until released.</td>
</tr>
<tr>
<td>Focus parameters</td>
<td><code>CAPTURE FOCUS</code></td>
<td>Parameters are captured until released.</td>
</tr>
<tr>
<td>Color parameters</td>
<td><code>CAPTURE COLOR</code></td>
<td>Parameters are captured until released.</td>
</tr>
<tr>
<td>Beam parameters</td>
<td><code>CAPTURE BEAM</code></td>
<td>Parameters are captured until released.</td>
</tr>
<tr>
<td>U1-U3 parameters</td>
<td><code>CAPTURE U1-U3</code></td>
<td>Parameters are captured until released.</td>
</tr>
</tbody>
</table>

Recording only Captured channels

You can record only captured channels.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record captured</td>
<td><code>RECORD &amp; CAPTURE</code></td>
<td>Levels and parameters of only captured channels are recorded.</td>
</tr>
</tbody>
</table>
## Releasing Captured Channels

Captured channels are released back to the sum of all playbacks, this can be done on time.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected</td>
<td>![RELEASE] &amp; ![CHANNEL]</td>
<td>The selected channel intensities are released, regardless if Capture is active or not.</td>
</tr>
<tr>
<td>Selected</td>
<td>![RELEASE] &amp; ![CHANNEL]</td>
<td>The selected channel intensities and attributes are released, regardless if Capture is active or not.</td>
</tr>
<tr>
<td>In # seconds</td>
<td>![RELEASE] #</td>
<td>The selected channels are released in the time #, regardless if Capture is active or not.</td>
</tr>
<tr>
<td>All</td>
<td>![RELEASE] ![RELEASE]</td>
<td>All captured channels are released, regardless if Capture is active or not.</td>
</tr>
<tr>
<td>Focus</td>
<td>![RELEASE] &amp; ![FOCUS]</td>
<td>Release captured Focus parameters</td>
</tr>
<tr>
<td>Color</td>
<td>![RELEASE] &amp; ![COLOR]</td>
<td>Release captured Color parameters</td>
</tr>
<tr>
<td>Beam</td>
<td>![RELEASE] &amp; ![BEAM]</td>
<td>Release captured Beam parameters</td>
</tr>
<tr>
<td>Single parameters</td>
<td>![RELEASE] &amp; ![Wheel key]</td>
<td>Release captured parameters</td>
</tr>
<tr>
<td>Grouped parameters</td>
<td>![RELEASE] &amp; ![U1–U3]</td>
<td>Release captured parameters</td>
</tr>
</tbody>
</table>
Channels - Clear Functions

The C/Alt key in the programming section is used in combination with other keys to quickly clear different playback areas of content.

These functions can be used to clear channels and levels

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear selected</td>
<td>C/Alt &amp; C/Alt</td>
<td>All channels in the contributing field of the channel view connected to the channel control are deselected.</td>
</tr>
<tr>
<td>Clear A</td>
<td>C/Alt &amp; LIVE</td>
<td>All channels in the A field are set to zero and deselected.</td>
</tr>
<tr>
<td>Clear all</td>
<td>C/Alt &amp; LIVE</td>
<td>All channels in all Playbacks are set to zero and deselected**</td>
</tr>
<tr>
<td>Clear Blind</td>
<td>C/Alt &amp; BLIND</td>
<td>All channels in the Blind field are set to zero and deselected.</td>
</tr>
<tr>
<td>Clear channel view</td>
<td>C/Alt &amp; CHANNEL</td>
<td>All channels in the Playback connected to the Channel Control are set to zero and deselected.</td>
</tr>
<tr>
<td>Clear and home</td>
<td>C/Alt &amp; CHANNEL</td>
<td>All channels in the Playback connected to the Channel Control are set to zero, deselected, homed and the changed flag is reset.</td>
</tr>
<tr>
<td>Clear selected</td>
<td>C/Alt &amp; @LEVEL</td>
<td>Selected channels in the Playback connected to the Channel Control are set to zero and deselected.</td>
</tr>
</tbody>
</table>

*Captured channels and Independent Channels in Exclusive mode are not cleared.
**Channels in Master Playbacks are restored by bringing the Master fader to zero and back up.
### Home Attribute functions

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear</td>
<td>C/Ait &amp; HOME_ATTRIB</td>
<td>Homes all attributes and clears all Dynamics.</td>
</tr>
<tr>
<td>Clear</td>
<td>C/Ait &amp; HOME_ATTRIB</td>
<td>Homes all attributes and clears all Dynamics and intensities.</td>
</tr>
</tbody>
</table>
Channels - Check Mode

The CHECK +/- keys in the programming section are used for stepping through a series of channels at any selected level. If a channel is already set to a level when checked it will cut back to the previous level when the next channel is checked.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select start channel and set a level</td>
<td>[#] Level Wheel</td>
<td>This level will be used by check mode.</td>
</tr>
<tr>
<td>2. Activate temporary check mode in up or down direction</td>
<td>CHECK+ CHECK-</td>
<td>The level is set to the next/previous channel.</td>
</tr>
<tr>
<td>3. Exit temporary check mode</td>
<td>C/Alt</td>
<td>Check mode is exited</td>
</tr>
</tbody>
</table>
## Channels - Balance Mode

The BALANCE key in the Soft Keys makes it possible to temporarily set all channels to 0% except a selection, to be able to work with that selection. The original output of the subdued channels is restored when Balance Mode is exited.

*(Soft Key Pages are commands in the lower right corner of screen 2)*

![Soft Key Pages Image]

As soon as balance mode is activated, it is indicated at the top of all screens.

### Action | Key | Feedback
--- | --- | ---
1. Select the channels to work with | | 
2. Activate Balance Mode | **BALANCE** | See Channel Command Syntax
   All other channels in the channel view will be set to 0% temporarily. You can now work with the selected channels.
3. Exit Balance Mode | **BALANCE** | The channel levels that were muted are restored.
NOTE
It is not possible to use RECORD when Balance mode is active.

Balance Mode Key

It is possible to set the REM DIM key to function as BALANCE instead. This is done in the System Settings.

See System Settings - Channel
Channels - Scale channel levels

The SCALE key in the Soft Keys makes it possible to apply a scaling factor to the intensity level of any channel/device.

(Soft Key Pages are commands in the lower right corner of screen 2)

When 100%, channels are controlled and played back at normal or recorded levels. Scale settings other than 100% will proportionally inhibit or boost the intensity output by the channel. For example, a channel scaled to 150% will play back 75% when actually recorded and played back at 50% by a preset.

Scaling is used in situations such as:

- When the light source is too bright due to temporary change of hanging position (100-0%)
- When you need to brighten part of a rig temporarily to adapt it for camera footage (100-200%).
- When a touring rig is adapted to a different stage size.

Scaling with the SCALE soft key

1. Hold the SCALE soft key in the Channels Soft key page of the main display. The channel view will show the scale levels.
2. Use the level wheel to set the scale level 0-200% for the selected channel(s).

No scale is shown as "---".

A channel with a scaled level gets a symbol next to the level, and the scale level is shown in the INFO area of the Browser when the channel is selected.
Scaling from the channel list

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Open the Channel List</td>
<td>MODIFY &amp; CHANNEL</td>
<td>The Channel List is opened and focused at the channel with that number.</td>
</tr>
<tr>
<td>2. Select the channel</td>
<td># CHANNEL</td>
<td>Channel is selected.</td>
</tr>
<tr>
<td>3. Move to the Scale column</td>
<td>Arrow keys</td>
<td></td>
</tr>
<tr>
<td>4. Set a Scale level</td>
<td># MODIFY</td>
<td>All levels of this channel will be multiplied by the Scale factor. A +/- symbol will be shown next to the level. Set 100% to remove the Scale factor.</td>
</tr>
</tbody>
</table>

Clear Scale Values

Clearing scales from channels is a key shortcut

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select channel(s)</td>
<td># CHANNEL</td>
<td>Channels to be unscaled</td>
</tr>
<tr>
<td>2. Clear scale</td>
<td>C/Alt &amp; SCALE</td>
<td>Scales are cleared.</td>
</tr>
</tbody>
</table>
Channels - Used & Unused

You can create a selection of channels based on if they are used or not in the sequence loaded to the Main Playback.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Open the Channel Selection Wizard</td>
<td>WIZARD &amp; CHANNEL</td>
<td>A popup with the Channel select wizard is opened.</td>
</tr>
<tr>
<td>2. Select UNUSED or USED MODIFY</td>
<td></td>
<td>This is a choice in the dropdown menu.</td>
</tr>
<tr>
<td>3. Select the Start and Stop ranges</td>
<td>Arrow keys</td>
<td>This is default set to the first and last step of the Sequence. Based on your choice all unused or used channels of the sequence loaded to the Main Playback are selected.</td>
</tr>
<tr>
<td>4. Execute the selection</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Channels - Group Wheel Mode

The GROUPWHEEL key in the Soft Keys makes it possible to assign a different/overlapping channel group to each wheel under the Main Display. All wheels interact inside the A field of the Live tab on a Latest Takes Precedence basis.

(Soft Key Pages are commands in the lower right corner of screen 2)

The Channels soft key page

With groups loaded

<table>
<thead>
<tr>
<th>Ch: 3074*</th>
<th>Ch: 2</th>
<th>Ch: 3*</th>
<th>Ch: 3*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lev : 100</td>
<td>Lev : 100</td>
<td>Lev : 100</td>
<td>Lev : 100</td>
</tr>
</tbody>
</table>
## Load channels

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load selected</td>
<td>PRESET &amp; Wheel Key</td>
<td>The selected channels are loaded as a channel group to the wheel.</td>
</tr>
<tr>
<td>Load selected</td>
<td>GROUP &amp; Wheel Key</td>
<td>The selected channels are loaded as a channel group to the wheel.</td>
</tr>
<tr>
<td>Load group</td>
<td># GROUP &amp; Wheel Key</td>
<td>The channels of Group # are loaded to the wheel.</td>
</tr>
<tr>
<td>Load selected</td>
<td>CHANNEL &amp; Wheel Key</td>
<td>The selected channels are loaded as a channel group to the wheel.</td>
</tr>
<tr>
<td>Load channel...</td>
<td># CHANNEL &amp; Wheel Key</td>
<td>The channel # is loaded to the wheel.</td>
</tr>
</tbody>
</table>

**NOTE**
The channels affected by a group wheel are updated when they are selected. This means that if the level has changed (by a crossfade or a manual change of some kind), the group wheel will now always catch up. The overflow/underflow information will therefore be lost if you are taking multiple channels over 100% or under 0%.

**NOTE**
In a client setup with multiple users each client will have individual settings for group wheel mode.
Channels - Rem Dim

The REM DIM key in the programming section will set all channels in the Channel Control to zero, except the currently selected channel(s).

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dim remaining</td>
<td>REM DIM</td>
<td>All channels in the Channel Control are set to zero, except the current selection.</td>
</tr>
</tbody>
</table>

**NOTE**
It is possible to set the REM DIM key to function as BALANCE. This is done in the System Settings. See System Settings - Channel
The CHANNELS soft key page provides a number of functions that are useful when working with channel intensities.

(Soft Key Pages are commands in the lower right corner of screen 2)
## Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Soft Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compare mode</td>
<td>Compare</td>
<td>Activates Compare mode. See <a href="#">Presets - Compare mode</a></td>
</tr>
<tr>
<td>Balance mode</td>
<td>Balance</td>
<td>Activates Balance mode. See <a href="#">Channels - Balance mode</a></td>
</tr>
<tr>
<td>Data</td>
<td>Data</td>
<td>Toggles if console displays and monitor screens display absolute device data or references to palettes.</td>
</tr>
<tr>
<td>Mark</td>
<td>Mark</td>
<td>Sets a Mark level to the selected device(s). See <a href="#">Active Mode &amp; Mark</a></td>
</tr>
<tr>
<td>Scale</td>
<td>Scale</td>
<td>Activates Scale when held. See <a href="#">Channels - Scale channel levels</a></td>
</tr>
<tr>
<td>Group Wheel Mode</td>
<td>Group Wheel mode</td>
<td>Activates Group Wheel mode. See <a href="#">Channels - Group Wheel Mode</a></td>
</tr>
</tbody>
</table>
**Channels - Next & Last Mode**

The NEXT and LAST keys in the [programming section](#) will sub-select singel channels in the current channel selection, in the order they were selected. The focused channel is mapped to intensity and parameter controls so you can adjust it individually. Press SELECT ALL to exit Next/Last mode.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate Next/Last</td>
<td>NEXT</td>
<td>The first channel in the current channel selection is marked as red, and mapped to the level and device controls. LAST can be used as well.</td>
</tr>
<tr>
<td>Step forward</td>
<td>NEXT</td>
<td>Channels are focused in the order they were selected. The focused channel is highlighted in red in the active Channel View*</td>
</tr>
<tr>
<td>Step backwards</td>
<td>LAST</td>
<td>Same as above, but backwards.</td>
</tr>
<tr>
<td>Leave Next/Last mode</td>
<td>SELECT ALL</td>
<td>All channels are selected again</td>
</tr>
</tbody>
</table>

*The currently focused channel is highlighted in red.*
NOTE
Next/Last and Highlight Mode are often used in combination for focusing single channels within a channel selection. See Highlight Mode

When you focus a channel with NEXT/LAST, it will be shown with number and name in the Information area of the Browser.
Channels - Select Functions (8.2)

The select functions allow you to select odds, evens, randoms and more from any channel selection.

(Soft Key Pages are commands in the lower right corner of screen 2)
Select - Sub-selection Functions

In all cases below - Press SELECT ALL to return to the original selection.

<table>
<thead>
<tr>
<th>Function</th>
<th>Soft Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Every 2nd</td>
<td>Select 2nd</td>
<td>Every second channel from the current channel selection is selected. Use NEXT/LAST to step.</td>
</tr>
<tr>
<td>Every 3rd</td>
<td>Select 3rd</td>
<td>Every third channel from the current channel selection is selected. Use NEXT/LAST to step.</td>
</tr>
<tr>
<td>Every # th *</td>
<td># Select Nth</td>
<td>Every # th channel from the current channel selection is selected. Use NEXT/LAST to step.</td>
</tr>
<tr>
<td>Random 2nd</td>
<td>RANDOM &amp; Select 2nd</td>
<td>Two random selections are created from the current selection. Use NEXT/LAST to step.</td>
</tr>
<tr>
<td>Random 3rd</td>
<td>RANDOM &amp; Select 3rd</td>
<td>Three random selections are created from the current selection. Use NEXT/LAST to step.</td>
</tr>
<tr>
<td>Random Nth</td>
<td>RANDOM &amp; Select Nth</td>
<td>Nth random selections are created from the current selection. Use NEXT/LAST to step**</td>
</tr>
<tr>
<td>Reverse (8.2)</td>
<td>REVERSE</td>
<td>Reverses the current channel selection order.</td>
</tr>
</tbody>
</table>

*If no number is entered, the last used number will be used.

**The last used Random selection # is used.
Channels - Random Select

It is possible to randomize the order of the channels within the current selection. This can be used to get a random order in a chase or with a Dynamic Effect.

<table>
<thead>
<tr>
<th>Action</th>
<th>Soft Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the channels you want to work with</td>
<td></td>
<td>See Channel Command Syntax</td>
</tr>
<tr>
<td>2. Select the Selects Soft Key Page</td>
<td>SELECT</td>
<td>This changes soft menu to the Select functions</td>
</tr>
<tr>
<td>3. Make a random selection</td>
<td>RANDOM</td>
<td>The channels are re-selected in a random order.</td>
</tr>
</tbody>
</table>

You can use the numbering functions that allow you to select every 2nd, 3rd or Nth together with the random function.

<table>
<thead>
<tr>
<th>Function</th>
<th>Soft Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Random 2nd</td>
<td>RANDOM &amp; SELECT 2nd</td>
<td>Every random 2nd is selected.</td>
</tr>
<tr>
<td>Random 3rd</td>
<td>RANDOM &amp; SELECT 3rd</td>
<td>Every random 3rd is selected.</td>
</tr>
<tr>
<td>Random Nth</td>
<td>RANDOM &amp; SELECT Nth</td>
<td>Every random Nth is selected.</td>
</tr>
</tbody>
</table>
Channels - Find Highest Level

Cobalt has 81 Playbacks (80 masters and a main playback) and any channel's intensity can be output from all of these at the same time. The highest level of output from any playback is the one that takes precedence on the output.

To find what field the highest intensity level of output for any channel is coming from, select the channel in a channel view and open the context menu (right click or LOCAL MENU). Select Find Highest Level (First selected) and the editor for that playback will be selected and opened.
Live

The Live tab is the most fundamental tab, where you can view and edit values for channels and devices "live".

This chapter contains the following sections

- Live - Introduction
- Editing in Live
- Channel Symbols
**Live - Introduction**

Live is the main Channel view where you can control and view the live output of all channels and devices. The Live tab shows all channel levels, no matter where they are output from. If you add channel intensities they will be output from the Active field of the Main Playback (A).

**NOTE**
The Live Tab cannot be closed with ESC unless it is unlocked. To unlock hold SETUP and press TAB when it is selected.

**Select the Live Tab**

Pressing LIVE selects the Live tab, which allows you to select and control channels and devices. (See [Channels - Views](#))
Selecting channels with mouse

Click on a channel to select or deselect it, and hold THRU and click on another channel to select a range. Double-click a channel to select just that channel.

Right-click in a channel view to open the context menu with channel functions
You can drag and drop channels between channel views, and to masters. All intensities will be copied.

Channel viewing formats

All channel views have a variety of viewing formats (selected, non-zero etc). The currently selected format is indicated in the top right corner of each Channel View. To read more about the viewing formats see Navigating - Channel views.

You can toggle through these formats by pressing FORMAT repeatedly:

- All channels
- Selected channels
- Selected and non-zero channels
- Selected and captured channels
- Selected and used in play channels* (see NOTE)
- Magic Sheet (if there is one defined)
- # FORMAT (select Magic Sheet)

You can activate the following of those formats directly by holding FORMAT and pressing a key

- All channels (FORMAT & ALL)
- All non-zero channels (FORMAT & CH)
- Captured channels (FORMAT & CAPTURE)
- Parked channels (FORMAT & PARK)
NOTE
SELECTED AND USED IN PLAY = Shows channels that are recorded in presets and Groups. If you select previously not recorded channels, they will be shown in this view. But, when you select this format the next time, a new scan through all groups and presets will be made and they will disappear again if they don’t have recorded levels.

Channel View Zoom

Hold FORMAT and use the wheel to Zoom in/out. (You can hold FORMAT (F4) and then right-click and drag with mouse as well).
Channel Information - Info Box

In the top right corner of the screen with the soft keys (under the screen and browser soft keys) there is an INFO box which will show information for the currently selected channel(s). It is possible to use NEXT/LAST to focus a single channel within a selection and get the channel info.

The following information is shown:

- Text A-D for the channel
- Template name.
- If a dimmer curve is assigned.
- The Dimmer/Device Addresses.
- Park status.
- More than one channel select is shown as “x channels selected”.
- If there are dimmer errors reported for a channel.

Multiple Live Tabs

It is possible to open several Live tabs. They can be set to operate individually, or linked to the same channel pool - synchronising to show as many channels as possible at all times.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open new</td>
<td>TAB &amp; LIVE</td>
<td>A new Live tab is opened.</td>
</tr>
</tbody>
</table>

Every Live tab that is supposed to be linked to the same channel pool needs to activate this feature.

1. Hold SETUP and press TAB (with the Tab in mind focused).
2. Check the box "Include Channel View in pool".
**Editing in Live**

All controls of the console are available for editing when Live is active.

Select channels and/or devices and you can

- Set/change intensities with level wheel or level keys
- Change parameters with parameter wheels
- Activate palettes with palette keys and/or direct selects

**Intensities = HTP**

Intensities are added to the output in the A field of the main playback. The levels are piled by Highest Takes Precedence (HTP) on top of the output from all playbacks.

**Override = Capture Mode**

If you want to control intensity or attributes of any channel regardless of where it is output from, use Capture Mode. Capturing a channel is similar to using a programmer, which means that the channel has to be released back to the playbacks or it will stay at the captured level. See [Capture Mode](#).

**Edit Attributes on screen**

Please note that Spreadsheet editing on screen is OFF as default. To activate this open the tab settings by holding SETUP and pressing TAB.
## Record in Live

### Recording
You can record in Live directly to the sequence in the main playback, directly to a master, or to Preset.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record Live</td>
<td>RECORD</td>
<td>A popup will ask you to confirm that the content of Live is recorded to the next free preset of the sequence in the main playback.</td>
</tr>
<tr>
<td>Record to a Master</td>
<td>RECORD &amp; Master Key</td>
<td>A popup will ask you to confirm that the selected channels are recorded to the next free preset in that Master Playback.</td>
</tr>
<tr>
<td>Update Preset</td>
<td>UPDATE</td>
<td>A popup will ask you to confirm updating the preset currently loaded to A.</td>
</tr>
</tbody>
</table>
Channel Symbols

In every Channel View there are channel and device symbols with indicators for basic modes and content.

### Basic indications

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Screen</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected and HTP</td>
<td><img src="image.png" alt="Image" /></td>
<td>A gold frame shows that a channel is selected. If a master is source the level is shown in yellow (channel 6). The top right corner shows the source of the current highest level*</td>
</tr>
<tr>
<td>Changed values</td>
<td><img src="image.png" alt="Image" /></td>
<td>A magenta background indicates that a level or parameter type has changed.</td>
</tr>
</tbody>
</table>

*Masters are 1-40, Main Playback is AB, Independents are displayed as "I", Capture as "C" and Remote fields are displayed as "Re".

You can choose different levels of detail as shown below by holding FORMAT and pressing the up/down arrows.

**Dimmer channel** formats
The channel number is on top, and the level is indicated with a level bar to the right of the number and/or a level in % 0-F under.

![Dimmer channel](image.png)

**Scroller channel** formats
Similar to dimmer channels, except there is additional information about the currently selected color.
Device channel formats
Similar to dimmer channels, except there is additional information about the device template and Focus, Color and Beam palettes and activity. If the device has color mixing there is a color preview to the left of the channel number showing the current mix.

You can toggle if palette names or number are shown by holding FORMAT and pressing left/right arrow.
## Channel Information - Important Level Modes

These are the different modes and functions that can "steal" or "filter" the levels and parameters of a channel or device.

<table>
<thead>
<tr>
<th>Function</th>
<th>Screen examples</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Captured</td>
<td><img src="image1" alt="Captured Screen Examples" /></td>
<td>A red background for the channel number indicates attributes are captured. A red background for the level indicates the level is captured.</td>
</tr>
<tr>
<td>Parked</td>
<td><img src="image2" alt="Parked Screen Examples" /></td>
<td>The background of all information is dimmed. &quot;PARK&quot; is indicated at the top of all screens.</td>
</tr>
<tr>
<td>Exclusive level</td>
<td><img src="image3" alt="Exclusive Level Screen Examples" /></td>
<td>A blue level indicates this level is set as exclusive to a master or independent.</td>
</tr>
<tr>
<td>Scaled level</td>
<td><img src="image4" alt="Scaled Level Screen Examples" /></td>
<td>A +/- sign after the level indicates it is scaled.</td>
</tr>
<tr>
<td>Inhibited level</td>
<td><img src="image5" alt="Inhibited Level Screen Examples" /></td>
<td>A red level indicates an inhibit master is limiting the level.</td>
</tr>
</tbody>
</table>
## Channel Information - Fade indications

Channel information for fades are only shown in the Live channel view and are all related to the sequence in the main playback.

<table>
<thead>
<tr>
<th>Function</th>
<th>Screen</th>
<th>Explanation</th>
</tr>
</thead>
</table>
| Fade direction   | ![Screen1](image1) | The arrow indicates what it will do on pressing GO, not necessarily what it is doing right now.  
Up = blue arrow  
Down = green arrow  
No indication means it is not changing. |
| Channel Times    | ![Screen2](image2) | Channel Time (T) and Delay (D) are indicated under the level |
| Move Fade        | ![Screen3](image3) | Channel Time (T) and Delay (D) are indicated under the level |
| Lock Fade        | ![Screen4](image4) | An "L" after the time indicates Lock Fade |
| Effects          | ![Screen5](image5) | En "E" (effect) or "D" (dynamics) is shown under the level |
| Device parameters| ![Screen6](image6) | White on grey = current  
White on purple = changed  
White on blue = Automarked  
Yellow = moving |
Blind

The Blind tab allows you to view and edit values for channels and devices blind.

This chapter contains the following sections

- Blind - Introduction
- Editing in Blind
**Blind - Introduction**

Blind is a channel tab where you can control any channels and devices blind.

- Create a look blind and load or record to any playback.
- Load the content of any playback to Blind, and load the content of Blind to any playback.
- Record the content of Blind.

**Select the Blind Tab**

Pressing BLIND will select the blind tab, and allow you to edit channels and devices without affecting the output.

The channel viewing formats, zoom and channel information are the same as for all channel views and Live - see Channel viewing formats.
**Editing In Blind**

Most normal controls of the console are available for editing in Blind.

**Select channels and/or devices** and you can

- Set/change intensities with level wheel or level keys

When the **attribute view is** open you can

- Change parameters with parameter wheels
- Activate palettes with palette keys and/or direct selects
- Use Fetch to copy attributes and levels from any existing preset

**Edit Attributes on screen**
Please note that Spreadsheet editing on screen is OFF as default. To activate this open the tab settings by holding SETUP and pressing TAB.

![Tab Parameter Setup](image)

**Record and copy in Blind**

**Recording**
You can record from Blind directly to a master, or to Preset.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record to a Master</td>
<td>RECORD &amp; Master Key</td>
<td>A popup will ask you to confirm that the content of Blind is recorded to that Master Playback.</td>
</tr>
<tr>
<td>Record Blind</td>
<td>RECORD</td>
<td>A popup will ask you to confirm that the content of Blind is recorded to the next free preset.</td>
</tr>
<tr>
<td>Update Preset</td>
<td>UPDATE</td>
<td>A popup will ask you to confirm updating the preset currently loaded to Blind.</td>
</tr>
</tbody>
</table>
Copy and load functions
There are shortcuts for quickly copying information to and from the Blind tab.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear</td>
<td>Ctrl &amp; BLIND</td>
<td>Clears all values in Blind</td>
</tr>
<tr>
<td>Copy Live to Blind</td>
<td>LIVE &amp; BLIND</td>
<td>All in Live is copied to Blind</td>
</tr>
<tr>
<td>Copy Blind to Live</td>
<td>BLIND &amp; BLIND</td>
<td>All in Blind is copied to Live</td>
</tr>
<tr>
<td>Load Preset</td>
<td># PRESET &amp; BLIND</td>
<td>Preset # is copied to Blind</td>
</tr>
<tr>
<td>Load Group</td>
<td># GROUP &amp; LIVE</td>
<td>Group # is copied to Blind</td>
</tr>
<tr>
<td>Try intensities</td>
<td>BLIND &amp; Wheel</td>
<td>The intensities in Blind are piled on top of the rest of the output.</td>
</tr>
</tbody>
</table>
Track List

It is possible to track intensities, channels, devices and attributes in Groups, Presets, Palettes and Sequences.

This chapter contains the following sections

- Track - Introduction
- Track - Channels
- Track - Lists
- Track - Presets
- Track - Palettes
- Track - Track Editing
Track - Introduction

Press TRACK to track the current channel selection in the sequence of the main playback.

It is possible to Track a channel/moving device selection with attributes through Play data (Presets, Groups, Palettes, Sequences. It is also possible from the Browser, to track Presets and Palettes.

A channel selection can be tracked

- In the Sequence of the Main Playback
- In the Sequence of a Master Playback
- In all Sequences
- In all Presets
- In all Groups
- In all Palettes (Focus, Color, Beam, All)
- In the Play (Sequences, Presets, Groups & Palettes)

From the Browser it is possible to track

- Where Presets are used (in Sequences)
- Where Palettes are used (Focus, Color, Beam, All)

To track an object press TRACK or open the context menu (SELECT SELECT or right-click).

NOTE
From 7.3 the number of channel columns that will be displayed as the result
of a search has been expanded from previously 30 to 100.

You can press MODIFY in the first column of any track list to open the corresponding editor for that item.

As long as a Track List is open the tracking commands UPDATE & @LEVEL and UPDATE & ATTRIB are blocked to avoid confusion.

IMPORTANT: Be careful using track editing or unblock wizard in a show where presets appear in multiple sequences or on masters as well as sequences, since the changes follow through in all places.
Track - Lists

Press TRACK to open the track list.

Any selection of channels/effect playbacks can be tracked. Once the Track List is opened you can

- View and edit levels directly.
- Select multiple cells by holding SELECT and using arrow keys.
- Press DELETE to delete the data in a cell.
- Enter a number and press MODIFY to set referenced data like palettes for parameters.
- Enter a number, hold C/ALT and press MODIFY to set absolute data for parameters.
- Use the WIZARD to select how far forward you want to track the value of the currently selected step.

NOTE

In all Track Lists with attributes (Seq, Preset, Palettes), both attributes and levels can be toggled on/off. See Track Channels - Show Levels & Attributes.

Open any editor directly by pressing MODIFY in that column.
### Track List - Functions

<table>
<thead>
<tr>
<th>Column</th>
<th>Action</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step</td>
<td>[MODIFY]</td>
<td>Opens the Sequence List focused at this Step.</td>
</tr>
<tr>
<td>Preset</td>
<td>[MODIFY]</td>
<td>Opens the Preset List focused at this Preset.</td>
</tr>
<tr>
<td>Text</td>
<td>No Input</td>
<td>Shows the Step Text.</td>
</tr>
<tr>
<td>Mode</td>
<td>[MODIFY]</td>
<td>Opens the Sequence List focused at this Preset.</td>
</tr>
<tr>
<td>Devices</td>
<td>[MODIFY]</td>
<td>Opens the Preset Attribute List for this Preset.</td>
</tr>
<tr>
<td>Channel/Device cells</td>
<td># [MODIFY]</td>
<td>Sets an intensity or reference data for the selected cells.</td>
</tr>
<tr>
<td>Channel/Device cells</td>
<td>DELETE</td>
<td>Delets intensity or data for the selected cells.</td>
</tr>
<tr>
<td>Parameter cells</td>
<td># C/Alt &amp; [MODIFY]</td>
<td>Sets absolute data for the selected parameter cells when the parameter editing default is set to Palettes. Sets a Palette number when the parameter editing default is set to absolute data.</td>
</tr>
<tr>
<td>Parameter cells</td>
<td>WIZARD</td>
<td>Track the level from the current cell forward to any step selected in the dropdown.</td>
</tr>
</tbody>
</table>
Track List - Show Levels & Attributes

In all Track Lists with attributes, the attributes and levels can be toggled on/off with the following functions.

<table>
<thead>
<tr>
<th>Function</th>
<th>Column</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Levels</td>
<td>FORMAT &amp; @LEVEL</td>
<td>The intensity column is toggled.</td>
</tr>
<tr>
<td>Focus attributes</td>
<td>FORMAT &amp; FOCUS</td>
<td>The Focus parameter columns are toggled.</td>
</tr>
<tr>
<td>Color attributes</td>
<td>FORMAT &amp; COLOR</td>
<td>The Color parameter columns are toggled.</td>
</tr>
<tr>
<td>Beam attributes</td>
<td>FORMAT &amp; BEAM</td>
<td>The Beam parameter columns are toggled.</td>
</tr>
<tr>
<td>Parameters</td>
<td>FORMAT &amp; Parameter Key</td>
<td>Specific parameter columns are toggled.</td>
</tr>
</tbody>
</table>

*Example* - show a single parameter (Prism, for example)
**Track - Channels**

The current channel selection can be tracked in Sequences, Chases, Presets, Groups and all kinds of Palettes (Focus, Color, Beam & All).

Once the channel(s) are selected there is a key combination of TRACK and some other key to activate the corresponding tracking tab.

You can delete attribute values by pressing DELETE in a cell. There is no undo for this. (5.0)

**Track Channels - In Sequences**

Track the current channel selection in a Sequence or Chase.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main Playback.</td>
<td>[TRACK]</td>
<td>Track List for Sequence in Main Playback is opened*</td>
</tr>
<tr>
<td>All Sequences</td>
<td>[TRACK] &amp; [SEQ]</td>
<td>Track List for all Sequences is opened</td>
</tr>
<tr>
<td>A Master Playback</td>
<td>[TRACK] &amp; [Master Key]</td>
<td>Track List for Sequence in Master Playback is opened providing the master setting is “Selected Channels”</td>
</tr>
</tbody>
</table>

*Track list for the Sequence of the Main Playback

![4. Track List (Main Playback)](image)
Track To Wizard

If you press WIZARD on a level in a sequence step, you will get a popup where you can select up to which Sequence Step the same level should be changed (= Tracked To).

![Track To Wizard](image)

Track Channels - In Presets

Track the current channel selection in all Presets.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Presets</td>
<td>TRACK &amp; PRESET</td>
<td>Track List for Presets is opened</td>
</tr>
</tbody>
</table>

See Track Channels - Show Levels & Attributes.

Track Channels - Groups

Track the current channel selection in all Groups.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Groups</td>
<td>TRACK &amp; GROUP</td>
<td>Track List for Groups is opened*</td>
</tr>
</tbody>
</table>
# Track Channels - Palettes

Track the current channel selection in Palettes (Focus, Color, Beam, All). See [Track Channels - Show Levels & Attributes](#).

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Focus Palettes</td>
<td>TRACK &amp; FOCUS</td>
<td>Track List for Focus Palettes is opened</td>
</tr>
<tr>
<td>Color Palettes</td>
<td>TRACK &amp; COLOR</td>
<td>Track List for Color Palettes is opened</td>
</tr>
<tr>
<td>Beam Palettes</td>
<td>TRACK &amp; BEAM</td>
<td>Track List for Beam Palettes is opened</td>
</tr>
<tr>
<td>All Palettes</td>
<td>TRACK &amp; PALETTE</td>
<td>Track List for All Palettes is opened</td>
</tr>
</tbody>
</table>

**Example:** *Track list for Focus Palettes*

![Track List Example](attachment:image.png)
**Track Channels - In The Play**

Track the current channel selection in Sequences, Presets, Groups and Palettes.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Play</td>
<td>[TRACK] &amp; [CHANNEL]</td>
<td>Track List for Play is opened*</td>
</tr>
</tbody>
</table>

*Track list for Play*
**Track - Presets**

A Preset can be tracked through the current Play. The TRACK function used in the Browser will produce a listing of all sequences and steps where that Preset is used in the current play.

**Track a Preset in the Browser**

Select the preset under the Preset Node in the Browser (F10) and press TRACK (F12) or use the context menu Track command (SELECT SELECT or right-click).

![Track list for tracking Preset 3.0 from the Browser:](image)
Track a Preset in the Organizer
Select the preset under the Preset Node in the Organizer tab and press TRACK (F12) or use the context menu Track command (SELECT SELECT or right-click).
NOTE
The Track command can only be used on objects within the current play and not in the Organizer (Import From) tab.
Track - Palettes

All types of Palettes can be tracked through the current Play. This is done by selecting the Palette in the Palette node of the Browser (F10) and pressing TRACK.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Open the &quot;Palettes&quot; node in the Browser</td>
<td>See Navigating - Browser</td>
<td>Palettes node is selected and opened</td>
</tr>
<tr>
<td>2. Open a Palette type (Focus, Color, Beam, All)</td>
<td>See Navigating - Browser</td>
<td>A Palette node is selected and opened</td>
</tr>
<tr>
<td>3. Select a Palette</td>
<td>See Navigating - Browser</td>
<td>A Palette is highlighted</td>
</tr>
<tr>
<td>4. Track this Palette</td>
<td>TRACK</td>
<td>Track List for Palette # is opened*</td>
</tr>
</tbody>
</table>

*Track list for tracking Color Palette 3.0 from the Browser.
Track - Track Editing

Track editing is a very powerful way to edit in a Sequence and very similar to how editing is done in a "tracking style console". It is used to save time when the same type of change is wanted in a series of Presets. There are some simple rules and they are described in this chapter.

Pressing TRACK opens the track list. Holding UPDATE and pressing @LEVEL or ATTRIB will initiate the track editing dialog.

Track Editing - Intensities

Intensity changes in a Preset (for all channels) can be tracked forward and/or backward. When an Intensity Block is set they will stop. This can be set in the Sequence List. See Sequences - Block Values.

1. Make level changes in a Preset
2. Hold UPDATE and press @LEVEL. A track popup will open.
3. Select forward, backward or both.
4. Confirm.
NOTE
Each channel will be tracked individually until the position where the level changes value. Dialog shows the number of channels that will be affected.

A step in the sequence set to Block Tracking will prevent levels from tracking through beyond that step (the step with the block is always tracked through). Both forwards and backwards.

To set a block on individual channels in a step – set the intensity to 1% higher or lower on those channels you wish to block.

Track Editing - Update Attributes

Attribute changes in a Preset (for all channels) can be updated to the Preset where they were last changed.

1. Make level changes in a Preset
2. Hold UPDATE and press ATTRIB. A track popup will open.

This dialog includes the possibility to track forwards/backwards/both directions like the intensity dialog.

Record if changed looks up the sequence on the main playback and finds the source of the tracked-in attribute(s) and makes the update in that preset.
Record if Active updates many presets, forwards, backwards or in both directions from the current preset, until a different value or a block instruction is encountered.

3. Confirm.

NOTE
If you have RECORD set to ACTIVE the console will insert data where required in previous and/or subsequent steps when this editing is used.

Track Editing - Unblock Attributes

If you have been recording all device parameters in every preset and wish to remove all redundant parameter values from the sequence in the main playback there is an Unblock function can be accessed by pressing WIZARD in the Sequence List.

1. Open the Sequence List for Sequence # by entering # SEQ.
2. Press WIZARD to open the unblock Wizard.

3. Make your selection and confirm. All redundant parameters will be deleted.
Parked

Park allow you to Park any part of a channel or device at a constant value. The Park status is stored with the play. Keyboard shortcut = Z.

This chapter contains the following sections

- Park - Introduction
- Park - Parking Values
- Park - Edit Parked Values
- Park - Un-parking Values
- Park - Parked Items List
**Park - Introduction**

The PARK key is used in combination with other keys to park data.

Park allows you to Park the output of any part of a channel or device at a constant value.

- Parked values are indicated with PARK in the Channel view and the Info box of the Browser when the channel is selected.
- A parked channel or parameter can still be altered and recorded blind.
- Park can be held and used with

  @LEVEL
  CH
  ATTRIB
  FOCUS
  COLOR
  BEAM
  U1-U3
  Wheel parameter keys.

- There is a softkey UNPARK for unparking parts of a channel or device.
- In *Live Attributes* PARK and UNPARK are used for **selected cells**.
- There is a PARK tab for viewing and clearing Parked values. MODIFY & PARK.
- Keyboard equivalent = Z

**NOTE**
Park replaces the Constant feature of older versions than 4.2.
Park - Parking values

The PARK key is used to park channels, parameter groups (F, C, B) or parameters.

The Parked status is indicated in the status part at the top of the screens in blue, in the Live channel view for each channel ("PARK") and in the attribute views (dimmed).

There is a Parked items list that is opened with MODIFY & PARK. You can hold PARK and press several different values consequently.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel</td>
<td>PARK &amp; CHANNEL</td>
<td>Park all values of the selected channel(s)</td>
</tr>
<tr>
<td>Level</td>
<td>PARK &amp; @LEVEL</td>
<td>Levels are parked.</td>
</tr>
<tr>
<td>Attributes</td>
<td>PARK &amp; ATTRIB</td>
<td>Attributes are parked.</td>
</tr>
<tr>
<td>Focus</td>
<td>PARK &amp; FOCUS</td>
<td>Focus parameters are parked.</td>
</tr>
<tr>
<td>Color</td>
<td>PARK &amp; COLOR</td>
<td>Color parameters are parked.</td>
</tr>
<tr>
<td>Beam</td>
<td>PARK &amp; BEAM</td>
<td>Beam parameters are parked.</td>
</tr>
<tr>
<td>U1-U3</td>
<td>PARK &amp; U1–U3</td>
<td>U1-U3 parameters are parked.</td>
</tr>
<tr>
<td>Parameter</td>
<td>PARK &amp; Wheel key</td>
<td>Single parameter is parked.</td>
</tr>
</tbody>
</table>

Cyan  Magenta  Yellow
---  ---  ---
17  79  74
17  79  74
17  79  74
17  79  74
NOTE
PARK applies to the selected cells when an Attribute View is open.
**Park - Edit Parked Values**

Parked values can be edited in the PARK column of the Channel and Output lists. Select the cell, enter a value and press MODIFY (or click).

**Channel List**  
Open by holding MODIFY and press CHANNEL. See Patch - Channel List.

![Channel List Image]

**Output List**  
Open from Browser (Browser >Settings & Tools >Output Lists >). See Patch - Output List.

![Output List Image]

Available choices: Modify Wizard Insert Delete
Park - Un-parking Values

The UNPARK key is used in combination with other keys to unpark values.

The Parked status is indicated in the Live channel view ("PARK") and in the attribute views (dimmed). The key UNPARK is also available in the Misc Soft Key Menu.

You can hold the soft key UNPARK (Misc) and press several different items consequently.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel</td>
<td>UN-PARK</td>
<td>Unpark entire Channel (Intensity and all</td>
</tr>
<tr>
<td></td>
<td>CHANNEL</td>
<td>parameters)</td>
</tr>
<tr>
<td>Level</td>
<td>UN-PARK</td>
<td>Levels are un-parked.</td>
</tr>
<tr>
<td></td>
<td>@LEVEL</td>
<td></td>
</tr>
<tr>
<td>Attributes</td>
<td>UN-PARK</td>
<td>Attributes are un-parked.</td>
</tr>
<tr>
<td></td>
<td>ATTRIB</td>
<td></td>
</tr>
<tr>
<td>Focus</td>
<td>UN-PARK</td>
<td>Focus parameters are un-parked.</td>
</tr>
<tr>
<td></td>
<td>FOCUS</td>
<td></td>
</tr>
<tr>
<td>Color</td>
<td>UN-PARK</td>
<td>Color parameters are un-parked.</td>
</tr>
<tr>
<td></td>
<td>COLOR</td>
<td></td>
</tr>
<tr>
<td>Beam</td>
<td>UN-PARK</td>
<td>Beam parameters are un-parked.</td>
</tr>
<tr>
<td></td>
<td>BEAM</td>
<td></td>
</tr>
<tr>
<td>U1-U3</td>
<td>UN-PARK</td>
<td>U1-U3 parameters are un-parked.</td>
</tr>
<tr>
<td>Parameter</td>
<td>UN-PARK</td>
<td>Single parameter is un-parked.</td>
</tr>
<tr>
<td></td>
<td>Wheel key</td>
<td></td>
</tr>
</tbody>
</table>

Unpark a parameter or parameter group

Hold UNPARK and press

FOCUS  COLOR  BEAM  U1  U2  U3  Wheel Keys

Un-park all values of the selected channels and devices
or

UNPARK & CHANNEL

There is a Parked items list that is opened with MODIFY & PARK where it is possible to un-park as well with DELETE. See Park - Parked Items List.
The Parked Items list shows all parked channels, intensities and attributes. Individual items can be unparked by selecting the appropriate row and pressing [DELETE]. See Parked.
Settings and Tools - Channels

These are the functions in the Settings and Tools node for Channels in the Browser.

This chapter contains the following sections:

- Channel Database & Autogroups
- Magic Sheets
- Channel Partitions
- Remote Controls
Channel Database

You can give each channel up to four text labels (ABCD). From these texts "auto-groups" are automatically created. The auto-groups are available from the Direct Selects.

Any moving device that is patched will automatically show up on the Name List as well, which allows you to select all "Stage Zooms" or "Scrollers" without creating any groups in advance.

The Channel Database is opened from the Browser (Browser >Channels >Settings & Tools >Channel Database).

Set Channel Texts For The Database

There are three ways of setting text to channels in the Channel Database (Browser >Patching >Channel Database).

Method 1
In the Channel Database cells directly

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set a text in a cell(s)</td>
<td>Select any cell(s) in the ABCD columns</td>
<td>Press MODIFY, enter a text and press MODIFY again to confirm.</td>
</tr>
</tbody>
</table>
**Method 2**  
*In the Channel Database with a Wizard*

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select text column</td>
<td></td>
<td>Cell is highlighted</td>
</tr>
<tr>
<td>2. Open the Wizard</td>
<td>WIZARD</td>
<td>Text Wizard is opened</td>
</tr>
<tr>
<td>3. Select channels</td>
<td>Channel functions</td>
<td>Channels appear in Text Wizard</td>
</tr>
</tbody>
</table>

**Set Text Wizard: C**

*Step 1: Select the channels/levels to operate on in the Channel View*  
*Step 2: Select options and Execute*  
Text: **Fresnel**

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>4. Enter Text</td>
<td>Text cell</td>
<td>Select text cell, Press MODIFY, enter a text and press MODIFY again to confirm.</td>
</tr>
<tr>
<td>5. Confirm</td>
<td>Execute button</td>
<td>Select Execute, Press MODIFY to confirm.</td>
</tr>
</tbody>
</table>
**Method 3**

*In any channel view*

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1. Select channels</strong></td>
<td>Channel functions</td>
<td>Channels are highlighted in yellow</td>
</tr>
<tr>
<td><strong>2. Open Text Wizard</strong></td>
<td>CHANNEL &amp; TEXT</td>
<td>Text Wizard is opened. You can set text ABCD and EXECUTE.</td>
</tr>
</tbody>
</table>
NOTE
You will not get a warning if you are overwriting existing texts.

Auto Groups - From Database and Templates

The Auto Groups are channel handles that are created automatically for any type of device patched in the device list, and for the different text tables assigned in the Channel Database.

For example, if you patch a moving device with the template "VL2500Spot", an autogroup with this name will appear in the Direct Selects for Auto Groups. Click to select all patched devices of this type. See Auto Groups in Cobalt Direct Selects - Types of Data.

In the same way, if the text label "Par64"is given in the channel database to a number of lights, an Auto Group will be created, and can be used to select all channels with this tag.

Click to select the channels, click and drag to set a level directly.

<table>
<thead>
<tr>
<th>Auto Group</th>
<th>Type</th>
<th>Auto Group</th>
<th>Type</th>
<th>Bank 1-100</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>RGB</td>
<td>VL2500 Spot</td>
<td>VL2500 Wash</td>
<td></td>
</tr>
<tr>
<td>Focus</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color</td>
<td>Par64</td>
<td>Zoom 15-30</td>
<td>Floor</td>
<td></td>
</tr>
<tr>
<td>Beam</td>
<td></td>
<td></td>
<td>Front</td>
<td>Side</td>
</tr>
</tbody>
</table>

NOTE
When you patch compound devices or multichannel devices with decimal channels, three Auto Groups will be created:

- All (base channels and subchannels)
- Only subchannels
- Only base channels

Channel Database - Import Text File Wizard

The Channel Database can import any comma or tab-delimited file and assign four text fields to the text fields (ABCD) of the database. This makes it possible to import data from programs like Lightwright, Excel, Word, Wysiwyg and such.

The file has to have the ending .txt and is opened from the Browser (Browser >File >Import from...).
Follow the instructions (1, 2, 3) and import the texts. You can save your mapping and reuse if you want to import a similar file later.

1. Select the delimiter used by the file you are importing.
2. Select which columns that should be mapped to the internal channel database fields.
3. If you want, choose to store the mappings under a given name for later reuse.

### Field description

<table>
<thead>
<tr>
<th>Setting</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text file format</td>
<td>Choose if the file you are importing is tab or comma delimited.</td>
</tr>
<tr>
<td>Map to columns</td>
<td>Channel numbers, and text to each column.</td>
</tr>
<tr>
<td>Use column headers in Channel Database</td>
<td>The source file headers will be displayed instead of TEXT A, B, C, D.</td>
</tr>
<tr>
<td>Use existing mapping</td>
<td>Use this mapping or select a previously stored mapping.</td>
</tr>
<tr>
<td>Save as new mapping</td>
<td>Save this mapping for later use.</td>
</tr>
<tr>
<td>Name for new mapping</td>
<td>Name for this mapping when saving.</td>
</tr>
</tbody>
</table>

### Import Text File - LightWright

It is easy to import Channel Database texts from LightWright. Here are some good things to know.

You can download the Lightwright demo from [http://www.mckernon.com](http://www.mckernon.com). The demo works fine and you can even save shows (it has a limit of 75 units). It also contains a demo show.

#### Export Format

In Lightwright, data can be exported to tab or comma separated *.txt files. We recommend tab separated files, since comma separated files can cause problems with data that includes commas. This is found under File > Export > Data. In this popup you can also select which data to export.

#### Uncheck Items

We suggest you select which items to export in the export popup mentioned above, or you will have an enormous amount of data to select from.

*Typical categories to include would probably be*

- Channel
- Dimmer
- Wattage
- Purpose
A suggestion for columns to import (besides Channels) into the Channel Database would be

- Text A= Purpose
- Text B= Position
- Text C= Color & Template
- Text D= Type & Wattage

Uncheck Parentheses
Lightwright seems to by default use parentheses (#) on channel numbers. So channel 1 in Lightwright is (1).
When you export the data from LightWright, in Export options, check the option "Strip channel parentheses ()". If you do not check this option, the channel will be exported with the parentheses and Cobalt will not understand that it is a channel number.

There is also a setting in Edit > Preferences, "Use parentheses () around channel numbers". By checking that box, it's also possible to get rid of the parentheses in the lists.

Export Devices as Channels
Check the option "For lights with attributes, export only the first row" in Export options. Otherwise it will export all of the attribute channels as separate channels for moving lights.

LIMITATIONS
If there are multiple items/units with the same channel number, only the item/unit data for the last item/unit will be imported. This is because the multiple units use the same channel number and one channel cannot contain different data's. In this case each unit has its own row in the exported file, so several rows have the same channel number.

If the Lightwright show includes several units patched to one channel, only the last Unit# will be imported.

Import Text File - Excel
It is easy to import Channel Database texts from an Excel file. Here are some good things to know.

If you have a nicely formatted list (check example below) and want to import this to the Channel Database, you need to make sure the table only has headers at the top, since these are recognized by the import tool. Save as a Tab delimited .txt file.
**Example - Data in Excel easy to import**

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Channel</td>
<td>Purpose</td>
<td>Position</td>
<td>Color</td>
<td>Watt</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>wash</td>
<td>1. truss</td>
<td>o/w</td>
<td>575W</td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>spot</td>
<td>1. truss</td>
<td>amber</td>
<td>750W</td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>else</td>
<td>SL</td>
<td>purple</td>
<td>600W</td>
</tr>
<tr>
<td>5</td>
<td></td>
<td>extra</td>
<td>floor</td>
<td>pink</td>
<td>50W</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td>aud</td>
<td>2. truss</td>
<td>red</td>
<td>750W</td>
</tr>
</tbody>
</table>
Magic Sheets (8.0)

Magic Sheets are user-created graphic displays that offer customizable interactive views for showing data and programming.

Magic Sheets replace the Channel Layouts of previous software versions. Previously stored Channel Layouts will be converted to Magic Sheets.

This chapter contains the following sections

- Magic Sheets - Introduction
- Magic Sheets - Create New
- Magic Sheets - Editor
- Magic Sheets - Layout Toolbar
- Magic Sheets - Object Libraries
- Magic Sheets - Object Target & Attributes
- Magic Sheets - Load and navigate
- Magic Sheets - List
Magic Sheets - Introduction (8.0)

Magic Sheets are user-created graphic displays that offer customizable interactive views for showing data and programming. Magic Sheet objects can be set to show data, such as channels and palettes, or can be representational graphics, such as scenic pieces, architecture or electrics. Magic Sheets replace the Channel Layouts of previous software versions. Previously stored Channel Layouts will be converted to Magic Sheets.

Magic Sheets are powerful for everyone in a lighting team

- A Lighting Designer may use them to lay out channel displays in a custom or specialized way.
- An Assistant Lighting Designer may use them to track data, keep up with labels, and help the Designer keep track of moves, marks, discrete timing, etc.
- A Programmer may use them to view and interact with certain portions of the rig, or to bring forward tools to make programming quicker.
- An Electrician may use them for specialty views, rig-specific layouts, or data regarding the health of fixtures.
- Non-Technical people can interact with Magic Sheets to accomplish tasks on the system without any programming knowledge, such as architectural or entertainment installations.
- Other Production Team members may use Magic Sheets for indication of rig status that pertains to their area of operation.
1. Workspace
2. Layout Toolbar
3. Object Libraries
4. Editor handle
5. Object color, target & attributes

General Facts

- # FORMAT is used to open a Magic Sheet in any channel view
- You can have up to 999 Magic Sheets
- The same channel can exist in several Magic Sheets
- Magic Sheets can contain any type of data besides channels
Navigating Magic Sheets

- Two-finger pinch or mouse wheel to zoom
- Two-finger drag and right-click to reposition
- Objects can be selected by dragging a frame around any part from right-to-left
- Objects can be selected by dragging a frame around the whole object from left-to-right
- The Layout Toolbar has zoom options for repositioning and centering and zooming to selection
**Magic Sheets - Create New (8.0)**

You can create a Magic Sheet in any channel view by entering a number # and pressing Format. This will give a dialog if the Magic Sheet doesn't exist.

You can create Magic Sheets in the Magic Sheet List (Browser>Channels>Setting&Tools>Magic Sheets...).

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Open the Magic SheetList.</td>
<td>Browser &gt; Channels &gt; Settings&amp;Tools &gt; Magic Sheets...</td>
<td>Opens the Magic Sheet list.</td>
</tr>
<tr>
<td>2. Create a new Magic Sheet</td>
<td># and INSERT</td>
<td>A new Magic Sheet is inserted.</td>
</tr>
<tr>
<td>3. Name Layout</td>
<td>MODIFY</td>
<td>Move to TEXT cell and press MODIFY. Give a name and press MODIFY to save and exit.</td>
</tr>
</tbody>
</table>

To load this Magic Sheet in a channel view see [Magic Sheets - Load & Navigate](#). To edit it click on the Editor Handle in that channel view, see [Magic Sheets - Editor](#).
**Magic Sheets - Editor (8.0)**

Once a Magic Sheet is selected in a Channel View using # FORMAT, the Editor is opened and closed by clicking on the Editor handle (4).

1. Workspace
2. Layout Toolbar
3. Object Libraries
4. Editor handle
5. Object color, target & attributes

Basically you open the Editor (4) to work in the workspace (1) selecting objects from the Object Libraries (3) using the tools in the Layout Toolbar (2). Once an object is placed in the workspace you can use the Object Targets (5) panel to set target, color and what information to show. You can group it to other objects and tie intensity and/or color to the frame or body.
NOTE
To use a Magic Sheet (or any other console function) you need to close the Editor first.

The only way to work in this editor is with a mouse/touchscreen and external keyboard. Commands from the console keypad are not recognized.

Magic Sheets Editor - Object Editing (8.0)

The easiest way to work with a Magic Sheet is with a mouse, you can manage most of the functions with a touchscreen as well. An object is basically following the rules you would expect in most simple drawing programs.

1. Choose simple arrow
2. Click in the Object Library on the rectangle
3. Click to place it somewhere in the workspace and use handles to modify

- Green Handle for proportional stretch
- Blue handles for edge stretch
- White dot handle for rotate
- Pink handles for individual point move
- Arrow keys move object

Mouse Navigation Tools

- Left click selects an object
- Right click and hold to pan or drag the display
- Use your mouse wheel to zoom in and out
[Shift] + mouse wheel provides a fine zoom of the magic sheet

Like in most graphical programs, selecting from left to right will open a blue window and any objects completely inside the box is selected. Selecting from the right opens a green window and any object that crosses the boundary line of is completely inside the window is selected.

To learn about all Objects see Magic Sheets - Object Libraries.

Magic Sheets Editor - Object Colors (8.0)

It is possible to set outline and body color for all objects. Every object with a channel target can link intensity and color to either of these. You can set line weight of outlines.

1. Select object.
2. Select the color tools
The color functions are the same for outline and background:

- Select a color from the color picker
- Use the slider to the right to change overall contrast to access more colors
- The currently selected color is shown under the slider
- Define a color with RGB values
- Link to Channel Color
- Link to Channel Intensity

For more functions see Magic Sheets - Object Color, Target & Attributes

Magic Sheets Editor - Object Target (8.0)

For an object to have any function when selected in a Magic Sheet it needs to have a target.

1. Select an object
2. Select target
The possible targets include

- Show data
- Console buttons
- Commands
- Zoom and Selection functions in the Magic Sheet

Depending on what type of target you choose the options you can set will be different. Most targets simply require a number as an ID. Note that when assigning decimal values to channel objects in the Magic Sheet, the increment value should be set to 0.01, not 0.1 as shown in the live view.

You may wish to select the text fields to show the channel target and ID information. For more information see Object Target & Attributes - Fields.
A console button will require that you choose the button in a dropdown.
Magic Sheets Editor - Array, Align & Distribute Objects (8.0)

There are different align options for a selection of objects.

1. Select objects
2. Click on the Align popup
3. Select Alignment or Distribution

Functions

- **Create Array** - allows you to create arrays of objects. First set the object target and target number. After placing one object of your choice, click on {Create Array} to open an additional window for choosing what array type you want to use.
  - **Rectangle** – to create a rectangular array of objects. You can define how many rows, columns, and the spacing
  - **Circle** – to create a circular array of objects. You can define the number or count of objects and the size of the circle.

- **Align Settings** - allows you to align objects either to the left, center, right, or top, middle, and bottom.
• **Align Rotation** - allows you to select multiple objects and align their rotation to the first object selected.

• **Distribute Horizontally** - allows you to distribute objects horizontally at an equal distance apart between two objects. Set the distance you would like by placing the first and last objects.

• **Distribute Vertically** - allows you to distribute objects vertically and evenly spaced. Set the distance you would like by placing the first and last objects.

• **Distribute Rotation** - allows you to distribute objects at an equal rotation between two objects (create a circle). Set the level of rotation you would like by placing the first and last objects at a rotation.

**Magic Sheets Editor - Texts (8.0)**

It is possible to set a user defined text to any object.

1. Select the object
2. Write the text in the Text: input box
3. Use the text tools to select color, font, size, bold, italic, underline and positioning
Magic Sheets - Layout Toolbar (8.0)

The Layout Toolbar includes four basic tools that affect editing of objects in general:

<table>
<thead>
<tr>
<th>Function</th>
<th>Symbol</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrows and Edit Modes</td>
<td>![Symbol]</td>
<td>Create and duplicate objects incrementally</td>
</tr>
<tr>
<td>Zoom tools</td>
<td>![Symbol]</td>
<td>Zoom functions</td>
</tr>
<tr>
<td>Array, align &amp; distribute tools</td>
<td>![Symbol]</td>
<td>Aligning, distributing and creating arrays of objects</td>
</tr>
<tr>
<td>Ordering/stacking tool</td>
<td>![Symbol]</td>
<td>Group and order objects</td>
</tr>
</tbody>
</table>

Magic Sheet - Arrow Tools for Edit Mode (8.0)

The **Arrow** tools for **Edit Mode**
- This tool will allow you to create new objects with a preselected target and autonumber them.

- **Grid Enabled** - toggles between a grid being displayed and no grid. With the grid enabled, the magic sheet will have a snap to grid behavior when placing objects. Hold SHIFT to override the snap.
- **Normal arrow** - allows for selecting and assigning objects from the object list.
• **Quick Layout** (arrow plus) - allows for placing more instances of a selected object. When finished, click the {Done} button or change to the normal arrow.

• **Quick Number** - used to quickly assign target numbers to objects. While in quick number mode, clicking on an object will assign the selected target and increment the target numbers.

• **Target** - used to specify object, starting target number, and increment for use in quick number mode.
  - Object - assigns the object from the list.
  - Start - assigns the starting target number.
  - Increment - assigns what increment the target numbers will use after the start number.

**Magic Sheet - The Zoom Tools (8.0)**

The **Zoom** tools
- These zoom options do exactly what they say.
Magic Sheet - Array, Align & Distribute (8.0)

The **Array, Align & Distribute** tool

See [Magic Sheets Editor - Array, Align & Distribute Objects](#)

Magic Sheet - Ordering/Stacking (8.0)

The **Ordering/Stacking** tool provides basic drawing functions for ordering and stacking objects in relation to each other.
Each magic sheet is made up of multiple layers. Objects can either be placed on their own or stacked on top of or beneath each other.

- **Group** - allows you to group objects together so they can be moved and rotated like a single object.
- **Ungroup** - removes grouping.
- **Send Backward** - will send an object back a layer.
- **Bring Forward** - will move an object up a layer.
- **Send to Bottom** - will send an object beneath all other objects.
- **Bring to Top** - will stack an object on top of all other objects.
### Magic Sheets - Object Libraries (8.0)

The Object Libraries provide access to symbols and objects, and you can import your own as well. For information on how to select, place and arrange objects in the Library, see Magic Sheets Editor - Object Editing.

<table>
<thead>
<tr>
<th>Function</th>
<th>Symbol</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object Types</td>
<td>![Symbol]</td>
<td>General and specific objects that can be tied to play data</td>
</tr>
<tr>
<td>Channel Objects</td>
<td>![Symbol]</td>
<td>Channel objects, user symbols can be imported</td>
</tr>
<tr>
<td>Import Images</td>
<td>![Symbol]</td>
<td>Import and use image files</td>
</tr>
<tr>
<td>Background settings</td>
<td>![Symbol]</td>
<td>Set a specific color/gradient/image for the live and blind background</td>
</tr>
</tbody>
</table>

### Magic Sheets - Object Types (8.0)

#### Objects

These are different object types and some are general shapes (like rectangles) while others have primary uses (like the clock) but they can all be assigned a target, for example a truss can activate a group of channels. For information on how to select, place and arrange objects in the Library, see Magic Sheets Editor - Object Editing.
<table>
<thead>
<tr>
<th>Function</th>
<th>Symbol(s)</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Button</td>
<td><img src="image" alt="Button Icon" /></td>
<td>A blank button that can be assigned to any target. Any other object can function as a button as well.</td>
</tr>
<tr>
<td>Channel icon</td>
<td><img src="image" alt="Channel Icon" /></td>
<td>Mirrors indicators from any channel view.</td>
</tr>
<tr>
<td>Fader</td>
<td><img src="image" alt="Fader Icon" /></td>
<td>Set any console fader as target.</td>
</tr>
<tr>
<td>Text</td>
<td><img src="image" alt="Text Icon" /></td>
<td>Places a text.</td>
</tr>
<tr>
<td>Clock</td>
<td><img src="image" alt="Clock Icon" /></td>
<td>A clock.</td>
</tr>
<tr>
<td>Line</td>
<td><img src="image" alt="Line Icon" /></td>
<td>Draws a line, can be used for fixture pipes or dividers between buttons for example.</td>
</tr>
<tr>
<td>Truss</td>
<td><img src="image" alt="Truss Icon" /></td>
<td>Places truss.</td>
</tr>
</tbody>
</table>
### Shapes

Places shapes. Can be used to make invisible buttons over background images.

<table>
<thead>
<tr>
<th>Free Shapes</th>
<th>Create free form objects with or without fill. Press ESC (external keyboard) to finish.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Free Line/arrow</td>
<td>Create free form lines or multi form arrows. Press ESC (external keyboard) to finish.</td>
</tr>
<tr>
<td>Pixel Grid</td>
<td>Set target to an Effect Layout to create a pixel grid for image effects. See Effect Libraries.</td>
</tr>
<tr>
<td>Media Server</td>
<td>Set target to a media server</td>
</tr>
</tbody>
</table>

**Magic Sheets - Channel Objects (8.0)**

**Channel Symbols**
For information on how to select, place and arrange objects in the Library, see Magic Sheets Editor - Object Editing.
Magic Sheets - Import Images (8.0)

Import images
For information on how to select, place and arrange objects in the Library, see Magic Sheets Editor - Object Editing.
Images from the third tab can be imported into magic sheets to be used as background images or as icons. You can use a graphics image file as a background or icon. The following is a list of accepted image formats: .bmp, .gif, .ico, .jpg, .pbm, .pgm, .png, .ppm, .svg, .svgz, .tga, .tiff, .xbm, and .xpm.

- The maximum image size allowed is 1920 x 1920.
- You will need to have the images on a USB drive to import them into the desk.
- Once an image has been imported, it is saved with the show file.

To import an image:
Step 1: Click on the import image icon. A separate window will open displaying any found USB drives.
Step 2: Select the appropriate drive.
Step 3: Navigate to the file you use to upload.
Step 4: Click on the file and then press ‘Ok’. It will now appear in the images tab.

Click on an image to select it. To use as an icon, drag and drop the image onto the magic sheet. You will be able to resize it.
Background images need to be set in the background settings tab. You can also adjust the background settings there.

**Magic Sheets - Background Settings (8.0)**

You can set a solid color, gradient or image as a background for a Magic Sheet.
Solid – use Red, Green and Blue to select a color or click on the small square next to ‘Red’ to open a color picker, complete with saturation bar on the right. Note the X closes the color picker.

Gradient – select top and bottom colors and display will scale between the two colors

Image -- click on the image icon to select a background image, set width, height and opacity, options for inverted or normal. Currently accepts image files: jpg, tif, bmp, png.
Magic Sheets - Object Target & Attributes (8.0)

Any object can be set to any target in the Object Target panel. This is also where you can define the information shown and how that information is aligned, and where you can connect intensity and color to outline or body of a channel object.

Select any object(s) and choose targets and attributes:

- Color
- Font
- Target
- Text
- Command
- Fields
- Scroller
- Field 1-6
- Position
- Size
- Rotation
- Items
Object Target & Attributes - Line & Color (8.0)

You can customize objects and fixture symbols in numerous ways found in the Object Properties area.

- Color - the object’s outline line weight, outline and fill colors can be adjusted here.
- The object’s outline and fill colors can be linked to channel color or linked to channel intensity.
Object Target & Attributes - Fields (8.0)

Up to six different fields of custom information can be displayed per objects.

Fields can display the following data for objects where this is relevant:

- Target ID
- Fixture Type
- Target Name
- Label
- Text A, B, C, D (from the channel database)
- Intensity
- Intensity Bar
- Color Swatch
- FCB Summary
- Focus
- Color
- Beam
- Status

The Font (Abc) icon allows the means to adjust the font type, size, color and style (bold, italic, underline) of each individual field. Used also to change the size and color of an intensity bar.

The alignment of the each field can be set by selecting a position on the grid of the Alignment icon next to the font icon.
Magic Sheet - Palette times (8.1)

You can execute any type of palette in a Magic Sheet with a time by entering a fresh number before clicking on that palette.

For a button or object to be a palette, set the target, see Magic Sheets Editor - Object Target.
# Magic Sheets - Load & Navigate (8.1)

These are the functions to load and navigate a Magic Sheet in a channel view.

<table>
<thead>
<tr>
<th>Function</th>
<th>Action</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load</td>
<td><img src="image" alt="FORMAT" /></td>
<td>Magic Sheet # is loaded in the currently selected Channel View.</td>
</tr>
<tr>
<td>Load from Browser (8.1)</td>
<td><img src="image" alt="MODIFY" /></td>
<td>The selected MS is loaded in the currently selected Channel View. You can also double-click.</td>
</tr>
<tr>
<td>Zoom</td>
<td>Two-finger pinch or mouse wheel</td>
<td>Zoom in Magic Sheet.</td>
</tr>
<tr>
<td>Move</td>
<td>Two-finger pinch or right-click and drag</td>
<td>Reposition Magic Sheet.</td>
</tr>
<tr>
<td>Zoom functions</td>
<td>In the layout tools under the magnifying glass</td>
<td><img src="image" alt="Zoom Functions" /></td>
</tr>
</tbody>
</table>
Magic Sheets - List (8.0)

This list is used to create a Magic sheet for editing with the edit functions - see Magic Sheet - Editor. Enter a number (#) and press INSERT to create a Magic Sheet in the Magic Sheet list (Browser >Channels >Settings & Tools >Magic Sheet).

The Magic Sheet will be created and can be selected in any Channel View by # FORMAT

Magic Sheet List - Columns & Functions (8.0)

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Magic Sheet</td>
<td></td>
<td>The ID of each Magic Sheet. Cannot be changed.</td>
</tr>
<tr>
<td>Text</td>
<td>[MODIFY]</td>
<td>Press MODIFY to activate and end text input. This text is shown in the lower right corner of the channel views.</td>
</tr>
<tr>
<td>Auto Selectable</td>
<td>[MODIFY]</td>
<td>Enables Auto-Select*</td>
</tr>
<tr>
<td>Insert a new Magic Sheet #</td>
<td>[#] [INSERT]</td>
<td>Inserts a new Magic Sheet**</td>
</tr>
<tr>
<td>Copy a Magic Sheet</td>
<td>[COPY]</td>
<td>Copies the selected Magic Sheet</td>
</tr>
<tr>
<td>Paste a Magic Sheet</td>
<td>[#] [PASTE]</td>
<td>Pastes a copied Magic Sheet to a new layout #</td>
</tr>
</tbody>
</table>

*If you select a channel that is included in a layout marked as "Auto-selectable", this layout will be selected. If the same channel is included in several layouts, the first Auto-Selectable one will be selected.
Channel Partitions

A channel partition is a definition of a limited set of channels and attributes. When activated, only these channels can be accessed.

This chapter contains the following sections:

- Partitions - Introduction
- Partitions - List
- Partitions - Create
- Partitions - Activate
**Partitions - Introduction**

A partition is a definition of a set of channels/devices. Every Partition has a permission mask which defines if the Partition is applied to

- IFCB
- Intensity
- Intensity/Color
- Intensity/Focus/Beam/Other

Partitions can only be activated by users that have permission to activate them. Once a Partition is active, it limits the access to these channels. The following functions are filtered through the Active Partition:

- The channel selection (only allowed channels can be selected and viewed)
- Parameter access (non-allowed attributes are not shown in Attribute Views)
- Recording of attributes or intensities

Non-allowed Partitions for the current logged in User are indicated with --- in the Partition List. Every partition can have a text label.

**NOTE**

The default Partition "All" allows access to all functions of all channels.
**Partitions - List**

Open the Partition List from the Browser (Browser >Channels >Settings and Tools >Channel Partitions).

You can view, edit and create new Partitions in this list.

![Partition List](image)

**Partitions List - Columns**

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partition</td>
<td></td>
<td>The ID of each Partition. Cannot be changed.</td>
</tr>
<tr>
<td>Text</td>
<td>MODIFY</td>
<td>Press MODIFY to activate and end text input. This text is shown in the top bar of the channel views.</td>
</tr>
<tr>
<td>Active</td>
<td>MODIFY</td>
<td>Toggles the Partition on/off. *</td>
</tr>
<tr>
<td>Apply to</td>
<td>MODIFY</td>
<td>Opens a dropdown where it is possible to select if the Partition applies to IFCB, I, C, FB/Other.</td>
</tr>
</tbody>
</table>

* If a User is logged in that does not have permission to activate a Partition, the Active cell will show "---". See User Login.

**NOTE**
The default Partition "All" is always defined to allow access to the full system.
Partitions - Create

Partitions are created in the Channel Partition List.

1. Open the Channel Partition List (Browser > Channels > Settings and Tools > Channel Partitions)

2. Press INSERT
3. Select channels (they will show up in the Channel View part).
4. Press RECORD or UPDATE to store the channel selection.

5. Press MODIFY in the TEXT cell to give a name to this Partition
6. Press MODIFY in the APPLY TO cell to choose permission level (IFCB).
Partitions - Add Partition Wizard

There is a Wizard to assist you in creating Partitions using Play information that already has been generated.

1. Open the Partition List (BROWSER > Setup > Partition List)
2. Press WIZARD.

These are the different options.

Add by Device Type
Choose a Template corresponding to the Device Type, and what it applies for (IFCB, Intensity, Color, Focus/Beam/Other).

Add by Channel Database Text
Enter the Database Text you wish to search for, and what it applies for (IFCB, Intensity, Color, Focus/Beam/Other).

Add by Channel Number
Select a channel range from channel # to channel #, and what it applies for (IFCB, Intensity, Color, Focus/Beam/Other).

Add by Magic Sheet
Choose channels corresponding to a Magic Sheet.
Partitions - Activate

Partitions are activated from the Partition List.

1. Open the Partition List (Browser>Channels>Settings and Tools>Channel Partition)
2. Press MODIFY in the ACTIVE cell to toggle on/off. The active Partition is indicated in the yellow info banner at the top of all Channel Views.

![Preset: 6.0  Active Partitions: [All - IFCB]](image)

**NOTE**
If no Partition is active, all channels are available, and shown in the Live View.

In Live Attributes, only channels and attributes that can be controlled are shown.

**NOTE**
REFRESH with no channels selected will affect all channels in the Playback including channels outside the Partition.
A channel with any attributes (parameters) in addition to intensity is called a Device. This includes scrollers, moving lights and media servers.

Devices Node

This chapter contains the following sections

- Devices - Introduction
- Devices - Functions
- Live Attributes
- Gel Picker
- All Palettes
- Focus Palettes
- Color Palettes
- Beam Palettes
- Mask
- >Settings & Tools
**Devices - Introduction**

A Device has to be Patched before you can start controlling it. See Patch Device(s).

**Devices - Controls**

- Select a channel to get control of a Device.
- The Main Display of the console has wheels and keys for controlling Moving Device parameters.
- Position pan/tilt with the trackball or wheels.
- There is a special Device mode for testing.
- Load and change templates at any time
- There is a soft key page for lamp strike.
- Select odds and evens at any time with the Selection tool.
- Fan and align any kind of parameter
- Mask any parameter or group of parameters
- Special functions for scrollers with rolls and calibration.

**Devices - Views**

- The Live Attribute View shows all parameters for selected devices.

**Devices - Palettes**

- Store reference Palettes for Focus, Color and Beam (or All).
- Select all active devices using a palette - "all blue" or "all centre stage".
- Store palettes for "all of the same type" and reuse (for color mixing).
- Palettes are quickly accessible from the Direct Selects.
- Load Palettes to Masters and fade selected channel(s).

**Devices - Playing Back**

- Play back Devices from any playback.
- Parameters can follow the fader.
- Any device parameter can be assigned to a Master Playback
- There is a GoOnGo or GoInB function (Move while dark)
- Times can be set to follow In, to groups (FCB), devices or single parameters.

**Devices - Focusing Mode**

- Next & Last Mode
- Highlight Mode
- Palette Focusing Mode

**Devices - Effects**

- Use Effects to create patterns of intensity, color or movement such as circles or fly-outs.
- Define your own Effects
Devices - Templates

- Edit a template at any time
- Create your own templates
- Change a template (device) for another

Devices - Multicell Devices (7.1)

A device that has more than one set of intensities or color sources. The challenge in controlling this type of devices is that there may be several intensity controls, and multiple cells of color mixing light sources that can be controlled both individually and as a group.

Sometimes these fixtures are controlled as one unit, with pan/tilt and overall intensity - and at the same time it is desirable to have individual control of each cell to be able to create effects, fanned intensities, or pixel mapping.

Examples of multicell devices.

- A moving device with individually controllable cells of LEDs, such as the Clay Paky B-Eye.
- A multicell striplight, like the ETC Selador 63.
- An LED-array such as the Martin EvenLED.

Channel Selection of multicell devices

There are a number of channel selection functions to optimize selecting channels and subchannels in a multicell or decimal device. Three Auto groups are created: xxx (all), xxx (base) and xxx (decimal).

Selection logic for touch screen/mouse operation

- Clicking on a base channel will now select the base channel, not the related decimal ones.
- Holding SELECT while clicking on a base channel will expand the related selection operation to include the associated sub channels.
- Holding THRU when clicking on a channel after selecting one, will select a range of channels
Selection logic for channel selection from numerical keypad with default Cobalt syntax (**RPN mode**). See also [Select Channels >>](#).

<table>
<thead>
<tr>
<th>Select Function</th>
<th>Key</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select complete device</td>
<td>1 CHANNEL</td>
<td>Selects the base channel and all decimal channels</td>
</tr>
<tr>
<td>Select only base channel</td>
<td>1 . 0 CHANNEL</td>
<td>Selects only the base channel.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Works with PLUS/MINUS/THRU</td>
</tr>
<tr>
<td>Select only decimal channels</td>
<td>1 . 1 CHANNEL</td>
<td>Selects only the decimal channel.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Works with PLUS/MINUS/THRU</td>
</tr>
<tr>
<td>Invert base/decimal</td>
<td>INVERT &amp; .</td>
<td>Inverts the current selection between base channels and decimal channels</td>
</tr>
<tr>
<td>Clear selected channels</td>
<td>C/Alt C/Alt</td>
<td>Clear</td>
</tr>
</tbody>
</table>
Selection logic for channel selection from numerical keypad with **AT Mode**. Note that a channel will not appear to be selected on the screen until the next command is pressed, such as @LEVEL.

<table>
<thead>
<tr>
<th>Select Function</th>
<th>Key</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select complete device</td>
<td>[1]</td>
<td>Selects the base channel and all decimal channels</td>
</tr>
<tr>
<td>Select only base channel</td>
<td>[1] . 0</td>
<td>Selects only the base channel.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Works with PLUS/MINUS/THRU</td>
</tr>
<tr>
<td>Select only decimal channels</td>
<td>[1] . 1</td>
<td>Selects only the decimal channel.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Works with PLUS/MINUS/THRU</td>
</tr>
<tr>
<td>Invert base/decimal</td>
<td>[INVERT] &amp; .</td>
<td>Inverts the current selection between base channels and decimal channels</td>
</tr>
<tr>
<td>Terminate a selection command</td>
<td>. .</td>
<td>To terminate a channel selection without pressing @LEVEL, press the decimal point twice.</td>
</tr>
<tr>
<td>Clear selected channels</td>
<td>C/Alt C/Alt</td>
<td>Clear</td>
</tr>
</tbody>
</table>
This is what the template for a multicell device such as the Martin EvenLED looks like in the Device List (Browser>Patching>Device List)

In the Channel Views there is a tool for toggling how decimal channels are shown

**Devices - Compound Devices**

A compund device is a device made up of several separate devices, for example a moving light yoke with a fixture and a separate color changer. You may also say, that any single device that has more than one DMX address and that you wish to control as if it were one device - is a compound device.
In the case of a scroller, this is handled automatically by assigning the scroller to the dimmer controlling the intensity of the fixture. In any other case, use a compound device template.

All parameters of all parts of a compound device will be shown as attributes when this device is selected.

This is what the template for a compound device can look like

![Device List Screenshot](image)

### Devices - Media Servers (8.1)

Cobalt can download media names and thumbnails from Media Servers that support CITP/MSEX, eg Arkaos and Hippotizer.

To use this

1. First patch the media server as normal.
2. To connect and download/update, type the channel number of the first layer, and press modify on the media server in the Browser.

This download process will take some time, depending on how much media there is.

Each time you connect, the media names and thumbnails will be updated and stored in the media server layer personality template in your showfile.

Cobalt assumes that all the media servers of a given type in a show have the same set of media. If you have multiple media servers with different media, make a copy of the Layer template for each server
Devices - Functions

These are the general device functions.

This chapter contains the following sections:

- Device Control
- Device Views
- Device Recording
- Device Palettes
- Device Times
- Device Playback
Device Control

The Main Display section of the console is optimized for working with functions in moving devices.

These are the sections in this chapter

- Device Control - Introduction
- Device Control - Lamp Control
- Device Control - Home Positioning
- Device Control - U1-U2-U3
- Device Control - Align
- Device Control - Fan
- Device Control - Fetch/Copy
- Device Control - Highlight Mode
- Device Control - Flip
- Device Control - Moving Light Dock Area
- Device Control - Select Changed
Device Control - Introduction

When you select the channel(s) of a moving device(s) (see Channels - Command Syntax) - all controls are automatically mapped to this section (and to the Device Controls Tab).

1. Parameter group
2. Parameter name
3. Parameter wheel
4. Parameter wheel key
## Device Controls - Functions

<table>
<thead>
<tr>
<th>Number</th>
<th>Function</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Parameter Groups*</td>
<td>Parameters are divided into three categories, Focus, Color and Beam. Select category by pressing one of these keys. All available Device Parameters within this category are mapped to the Wheels and shown in the display above them (2). If there are more than four parameters, press the category key again for the next set.</td>
</tr>
<tr>
<td>2</td>
<td>Parameter name</td>
<td>Each wheel has a section of the display dedicated to it. In this section the parameter type is displayed on top, and the current value (or Palette name) under. If there is a range number it is displayed.</td>
</tr>
<tr>
<td>3</td>
<td>Parameter Wheel</td>
<td>Move the parameter wheel to set a value. For 16-bit control move slowly, for 8-bit control move fast.</td>
</tr>
<tr>
<td>4</td>
<td>Wheel key with value</td>
<td>Press to toggle between zero and full. Enter a number and press the key to set a value.</td>
</tr>
<tr>
<td></td>
<td>Wheel key with list</td>
<td>Hold wheel key to get the sublist in the display. Use the wheel to select, and let go to activate. Enter a number and press the key to select a range.</td>
</tr>
</tbody>
</table>

*All parameters of a moving device are grouped into four groups of functions.*

**Focus** = *Pan and tilt*

**Color** = *all color functions such as CMY, color wheels etc*

**Beam** = *everything else*

**Intensity** = *is stored in Presets*

**Control parameters** = *are usually not stored, but can be included or excluded by using Masks.*
Device Control - Lamp Control

The LAMP CONTROL key in the programming section activates the Lamp Control Soft Key Page with functions which are defined in the template of each device.
Control Soft Key Page - Functions

In Cobalt hardware there is no need to hold ENABLE with lamp control functions, in older hardware the following rules apply:

<table>
<thead>
<tr>
<th>Action</th>
<th>Soft Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable</td>
<td>ENABLE</td>
<td>This key has to be pressed together with Lamp On/Off/Reset to activate them (as a safety measure).</td>
</tr>
<tr>
<td>Lamp Idle</td>
<td>ENABLE &amp; Lamp Idle</td>
<td>The Device is set to it's Lamp idle value</td>
</tr>
<tr>
<td>Lamp On</td>
<td>ENABLE &amp; Lamp On</td>
<td>A lamp strike is set to the selected channel(s)</td>
</tr>
<tr>
<td>Lamp Off</td>
<td>ENABLE &amp; Lamp Off</td>
<td>A lamp off is set to the selected channel(s)</td>
</tr>
<tr>
<td>Reset</td>
<td>ENABLE &amp; Reset</td>
<td>A lamp reset is set to the selected channel(s)</td>
</tr>
</tbody>
</table>

NOTE
These functions are Device and Template Specific. Check the manual and template of each Device.

Control parameters are not stored in Presets.

Press HOME ATTRIB after a Lamp On/Off/Reset, or lamp idle, to avoid sending control commands to the lights forever.
Device Control - Home Positioning

The HOME ATTRIB key in the programming section allows you to set devices or parts of devices to their home position. Home positioning of a device means setting all parameters (or part of them) to the default values defined in the template of this device. Normally this means setting pan and tilt to 50%, color to white and all other parameters to neutral. (See Devices - Templates)

These functions apply to the currently selected channel(s)

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>All attributes</td>
<td>HOME ATTRIB &amp; HOME ATTRIB</td>
<td>All parameters are set to home</td>
</tr>
<tr>
<td>Focus</td>
<td>HOME ATTRIB &amp; FOCUS</td>
<td>Focus parameters are set to home</td>
</tr>
<tr>
<td>Color</td>
<td>HOME ATTRIB &amp; COLOR</td>
<td>Color parameters are set to home</td>
</tr>
<tr>
<td>Beam</td>
<td>HOME ATTRIB &amp; BEAM</td>
<td>Beam parameters are set to home</td>
</tr>
<tr>
<td>Single parameters</td>
<td>HOME ATTRIB &amp; Wheel Key</td>
<td>Parameter # is set to home</td>
</tr>
</tbody>
</table>

Another way of doing the same thing

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Focus</td>
<td>0 FOCUS</td>
<td>Focus parameters are set to home</td>
</tr>
<tr>
<td>Color</td>
<td>0 COLOR</td>
<td>Color parameters are set to home</td>
</tr>
<tr>
<td>Beam</td>
<td>0 BEAM</td>
<td>Beam parameters are set to home</td>
</tr>
<tr>
<td>All attributes</td>
<td>Ctrl/Alt ATTRIBUTES</td>
<td>All parameters are set to home</td>
</tr>
</tbody>
</table>
Device Control - U1-U2-U3

The parameter group keys U1-U3 in the programming section can be set up with any mix of device parameters. Each of them have three sub-pages. This makes a total of nine user definable parameter pages.

This editor is opened by holding MODIFY and pressing U1-U3 or a Wheel key when a bank (U1-U3) is selected.

NOTE
Each User Bank (U1-U3) has three parameter pages (1-3). They are shown in the same editor.
# U1-U3 - Setting Up Parameters

<table>
<thead>
<tr>
<th>Column</th>
<th>Function</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page</td>
<td>No function</td>
<td>This is the number of the Page (1-3) under this User Bank (U1-U3)</td>
</tr>
<tr>
<td>Wheel</td>
<td>No function</td>
<td>This is the number of the Wheel, and cannot be changed.</td>
</tr>
<tr>
<td>Parameter</td>
<td>[MODIFY]</td>
<td>Opens a dropdown with all parameters. Select one and press MODIFY to confirm*</td>
</tr>
</tbody>
</table>

*The letter (FCB) after a parameter indicates it's parameter group.

**NOTE**
Parameters in U1-U3 are still stored in the original palette types (Focus, Color, Beam).
**Device Control - Align**

The Align key in the programming section copies parameters from one Device to several others.

1. Select all involved devices, including the one you want to copy parameters from
2. Use Next/Last to select the device you are copying from
3. Hold ALIGN and then press the key corresponding to the parameter or parameter group you want to copy:

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Align FOCUS</td>
<td>ALIGN &amp; FOCUS</td>
<td>All Focus parameters are copied*</td>
</tr>
<tr>
<td>Align COLOR</td>
<td>ALIGN &amp; COLOR</td>
<td>All Color parameters are copied*</td>
</tr>
<tr>
<td>Align BEAM</td>
<td>ALIGN &amp; BEAM</td>
<td>All Beam parameters are copied*</td>
</tr>
<tr>
<td>Align single parameters</td>
<td>ALIGN &amp; Wheel Key</td>
<td>The parameter assigned to the wheel is copied.</td>
</tr>
</tbody>
</table>

*If Palettes are used, the palettes will be aligned, not the values.
**Device Control - Fan**

The FAN key in the programming section is used to distribute values of a parameter evenly around a centre point.

There are four shapes of fan:

- Linear
- \( S = S \) shaped
- \( V = V \) shaped
- \( U = U \) shaped

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select channels</td>
<td>Channel Select</td>
<td>Selected channels are highlighted in the Channel View</td>
</tr>
<tr>
<td>2. Select base channel</td>
<td>[NEXT]</td>
<td>The focused channel is highlighted in red</td>
</tr>
<tr>
<td>3. Fan parameter #</td>
<td>[FAN] &amp; [Wheel]</td>
<td>Parameter # is fanned according to the shape in the Settings, around the channel focused by NEXT/LAST.</td>
</tr>
</tbody>
</table>

*If no base channel is selected, the centre channel of the selection is used.*
Fan Settings

Hold SETUP and press FAN to open the Fan Settings

Select with arrow keys, and press MODIFY to confirm.
Device Control - Fetch/Copy

The ON/FETCH key in the programming section is used to copy parameter values for devices from any Preset. Fetching from Presets in the Main Sequence will copy the STATE of those devices including any tracked values from presets earlier in the Sequence.

1. First select the devices you wish to copy values to.
2. Select function from the table below:

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>FOCUS values</td>
<td># ON/FETCH &amp; FOCUS</td>
<td>Focus values from Preset # are copied to the selected channel(s).</td>
</tr>
<tr>
<td>COLOR values</td>
<td># ON/FETCH &amp; COLOR</td>
<td>Color values from Preset # are copied to the selected channel(s).</td>
</tr>
<tr>
<td>BEAM values</td>
<td># ON/FETCH &amp; BEAM</td>
<td>Beam values from Preset # are copied to the selected channel(s).</td>
</tr>
<tr>
<td>Parameter values</td>
<td># ON/FETCH &amp; Wheel Key</td>
<td>Parameter values from Preset # are copied to the selected channel(s).</td>
</tr>
<tr>
<td>All values</td>
<td># ON/FETCH &amp; ATTRIB</td>
<td>All parameter values from Preset # are copied to the selected channel(s).</td>
</tr>
</tbody>
</table>

NOTE
If the Preset specified is in the Main Sequence, you will fetch the ACTUAL STATE of the attributes in the specified preset. This is not necessarily the same values that are stored in that preset, since some of them may be tracking into it from previous presets.

HINT
You can fetch intensity values as well. See Presets - Fetch Intensities.
Device Control - Highlight Mode

The HIGHLIGHT key in the programming section is used to set Devices to a temporary Highlight mode. It will set all intensity channels to the ID level in Cobalt Settings (default 100%) and all device channels to the values defined in their templates, with the highlighted device to white.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate Highlight</td>
<td>HIGHLIGHT</td>
<td>All channels in the current selection are highlighted. The LED in the key is lit. Highlight is indicated at the top of the screens Highlight</td>
</tr>
<tr>
<td>Step forward</td>
<td>NEXT</td>
<td>Channels are focused, and Highlighted in the order they were selected.</td>
</tr>
<tr>
<td>Step backwards</td>
<td>LAST</td>
<td>Channels are focused, and Highlighted in the order they were selected.</td>
</tr>
<tr>
<td>Leave Highlight mode</td>
<td>HIGHLIGHT</td>
<td>Highlight mode is deactivated. The LED in the key is off. All Devices return to their last CB values.</td>
</tr>
</tbody>
</table>

NOTE
Highlighted Intensity channels are indicated in the channel views with a highlighted background.
Device Control - Flip

If a moving head reaches its end position for Pan - it is possible to press FLIP to invert the pan and tilt values so that the end position is "passed". Observe that the result of a flip depends on the pan range of a device, and will not always be the same position as before the flip.

(Soft Key Pages are commands in the lower right corner of screen 2)

Select the device(s) you wish to flip, and press FLIP. To undo press FLIP again.
Device Control - Device Control Tab

As soon as a device is selected, all parameters can be accessed from the Device Control tab. (See Cobalt Device Control Tab)
Device Control - Select Changed

The SET CHANGED soft key allows you to select all devices that have manually changed attributes other than intensity, since the current preset was loaded to the A field.

(Soft Key Pages are commands in the lower right corner of screen 2)
Device Control - Device Mode

Press DEVICE to activate Device Mode. The top potentiometers in the masters section will provide direct access to a definable number of device parameters. There is a default Device Mode page (1) that is assigned to all templates, and you can configure 19 more (2-20) and assign to any templates. This way you can make sure you have the optimal parameters automatically at hand when a particular type of device is selected. An example is if you have a number of different LED fixtures and want them all to use the same Device Mode page, while your profiles with framing shutters, or media servers will have a different Device Mode page.

The easiest way to edit the parameters in a Device Mode Page is to hold the console wheel parameter key for a parameter and press the yellow potentiometer you want to assign it to. You can change and edit the parameters of each page in the Device Mode Page List.
The parameters are definable in the Device Mode settings.

In Cobalt 10: Press RANGE to the other upper/lower bank.

**Device Mode Settings and Device Mode Page List**

The parameters for each of the 20 Device Mode pages are defined in the Device Mode Page List.

Hold SETUP and press DEVICE to open the Device Mode Page List or open it from (Browser>Devices>Settings and Tools>Device Mode Pages...). It will open focused on the currently active Device Mode Page.

Press MODIFY or touch/click in a parameter to change
You can assign the Device Mode Page to each template in the Templates List (Browser>Patching>Setting and Tools>Templates...).
Device Views

Attributes for devices can be shown in any channel view.

This chapter contains the following sections

- Device Views - Introduction
- Device Views - Live
- Device Views - Filtering
- Device Views - Editing
- Device Views - Presets
- Device Views - Data
Device Views - Introduction

A device view with attributes can be opened in any channel view by pressing ATTRIB.

They are all edited in the same way. In the Live tab attribute view you can set times. See Devices - Times.

General Facts

- Devices are listed by type
- You can set attribute values directly (depending on the Attribute Setup)
- You can set Palettes directly (depending on the Attribute Setup)
- You can filter parameter groups
- Changed values are shown with a purple background (Live)
- You can view/edit attribute times

NOTE
Hold FORMAT and press @LEVEL to toggle levels between 100% and full 8/16 bit values.

HINT
In the browser Preset items have a sub node called “Attribute Editor” for presets with attributes. Pressing MODIFY on this node opens the attribute editor (v5.0).
**Device Views - Live**

The Device view is viewed in the Live tab by pressing ATTRIB.

You can toggle between these formats by pressing FORMAT

- Selected devices
- Non-zero devices
- Selected and changed devices
- All devices

The currently selected format is indicated in the top right corner of each Channel View

You can open cells for setting parameter times and delays directly by holding FORMAT and pressing the DOWN ARROW.
<table>
<thead>
<tr>
<th>Mac</th>
<th>35016EX</th>
<th>Pan</th>
<th>Tilt</th>
<th>Focus Sp</th>
<th>Color</th>
<th>Color 2</th>
<th>Color Sp</th>
<th>Focus</th>
<th>Iris</th>
</tr>
</thead>
<tbody>
<tr>
<td>31</td>
<td>S</td>
<td>F Centre</td>
<td>F Centre</td>
<td>F Centre</td>
<td>Purple</td>
<td>Purple</td>
<td>50</td>
<td>Normal</td>
<td></td>
</tr>
<tr>
<td>32</td>
<td>S</td>
<td>F Centre</td>
<td>F Centre</td>
<td>F Centre</td>
<td>Purple</td>
<td>Purple</td>
<td>50</td>
<td>Normal</td>
<td></td>
</tr>
<tr>
<td>33</td>
<td>S</td>
<td>F Centre</td>
<td>F Centre</td>
<td>F Centre</td>
<td>Purple</td>
<td>Purple</td>
<td>50</td>
<td>Normal</td>
<td></td>
</tr>
<tr>
<td>34</td>
<td>S</td>
<td>F Centre</td>
<td>F Centre</td>
<td>F Centre</td>
<td>Purple</td>
<td>Purple</td>
<td>50</td>
<td>Normal</td>
<td></td>
</tr>
</tbody>
</table>
Device Views - Filtering

Hold the FORMAT key and press FOCUS, COLOR or BEAM to select which parameter group to hide/show in a Moving Device View. Below only COLOR is shown.
Device Views - Editing

When you open a device view you can use all palette and wheel controls to edit attributes.

**NOTE**
All attribute views need to be unlocked for screen editing by holding SETUP & TAB and activating in the popup.

If you unlock the view for screen editing you can enter a value or a Palette reference, depending on the Attribute Editor Default Settings. The default setting is Palette. See Attribute Settings.

This is how you can enter values for the selected cell(s). To save changes press UPDATE.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter a value*</td>
<td># MODIFY</td>
<td>The Palette # is assigned to the selected cell(s)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>All available Palettes (FCB) for the selected cell(s) are opened in a dropdown</td>
</tr>
<tr>
<td>Open a dropdown</td>
<td>MODIFY</td>
<td>All available Palettes (FCB) for the selected cell(s) are opened in a dropdown</td>
</tr>
<tr>
<td>Set an absolute value</td>
<td># C/Alt &amp; MODIFY</td>
<td>The absolute value is set to the selected cell(s) (not 16 bit values)</td>
</tr>
<tr>
<td>Delete the content of</td>
<td>DELETE</td>
<td>The content is deleted for these cells.</td>
</tr>
<tr>
<td>selected cell(s)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Changed values get a purple background in the Live Attributes View
NOTE
If the Attribute Editor Default Setting is set to Absolute, you can select Palettes in the same way as setting absolute values in Palette mode: enter the number, hold C/ALT and press MODIFY.
Device Views - Presets

You can view and edit all device parameters for a Preset in the Preset Attribute Editor (\# PRESET & ATTRIB).

**NOTE**
Select format by pressing FORMAT.

Hold FORMAT and press Down Arrow to open up Time and Delay rows. See Device Times - Attribute Time Editor
Preset Attribute Editor - Columns

These are the different Device parameters that are displayed for each with their current values. For editing see **Device Views - Editing**.

<table>
<thead>
<tr>
<th>Function group</th>
<th>Parameters</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Channel &amp; Level</strong></td>
<td>No input</td>
<td>The number of the device is highlighted when selected, and red when focused with NEXT/LAST. The level is indicated to the right.</td>
</tr>
<tr>
<td><strong>Device</strong></td>
<td>Delete Device</td>
<td>Press DELETE to delete this device completely*</td>
</tr>
<tr>
<td><strong>GoOnGo</strong></td>
<td>AutoMark, GoOnGo or GoblnB per Device</td>
<td>Overrides the Sequence Step GoOnGo setting for this particular Device.</td>
</tr>
<tr>
<td><strong>FOCUS parameters</strong></td>
<td>Pan, Tilt, Focus Speed</td>
<td>The parameters that exist for the selected device are shown with their values.</td>
</tr>
<tr>
<td><strong>COLOR parameters</strong></td>
<td>Cyan, Magenta, Yellow, Color, Color2, CTO, Color speed etc...</td>
<td>The parameters that exist for the selected device are shown with their values.</td>
</tr>
<tr>
<td><strong>BEAM parameters</strong></td>
<td>Focus, Iris, Zoom, Strobe, Gobo, Gobo &lt;&gt;, Gobo rot, etc...</td>
<td>The parameters that exist for the selected device are shown with their values.</td>
</tr>
<tr>
<td><strong>CONTROL parameters</strong></td>
<td>Aux 1, Control, Dummy ch's etc...</td>
<td>The parameters that exist for the selected device are shown with their values.</td>
</tr>
</tbody>
</table>

*There is a popup to confirm deleting a device.
Preset Attribute Editor - Times

You can toggle the format of the Preset Attribute Editor to show Times and Delays by holding FORMAT and pressing arrow DOWN or arrow UP.
Device Views - Data

Press DATA to toggle attributes to show in absolute values or referenced values (palettes).

Absolute values are preceded by a # character to show that they are absolute values in stead of palettes.

Show Palette

Show Values

Live Effects/Preset Attribute Editors show Absolute/Palette in the header depending on the current setting.

In Congo hardware this is a soft key in the Channels Soft Key Page.
Device Recording

Attributes are stored in Presets just like intensities. There are different recording modes.

This chapter contains the following sections

- Device Recording - Introduction
- Device Recording - Modes
- Device Recording - Block Cues
- Device Recording - Delete
- Device Recording - Cue Only
**Device Recording - Introduction**

There are four recording modes for recording device parameters:

- Active (default)
- Changed
- All
- Popup

If only **changed** device parameters are recorded it is important to record all parameters (a block cue) in the beginning of each Sequence. There is a check box for this in the Advanced Tab of the Recording Popup.

Regardless of these settings it's always possible to record attributes

- All attributes manually
- Selected device(s) only
- Selected device(s) to any Preset
- Set all or selected parameters to Changed (to record as Changed).

**NOTE**

If you are working with Changed, there is a SET CHANGED softkey in the Devices soft key page of the Main Display that allows you to force the flag changed for any parameter or parameter group. See Device Recording - Modes.
Device Recording - Modes

There are four different Recording modes for recording Device attributes.

They are set in the RECORD SETTINGS (Hold SETUP and press RECORD). You will get this popup

![Play Settings](image)

These are the modes

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changed</td>
<td>All changed attributes are recorded automatically*</td>
</tr>
<tr>
<td>Popup</td>
<td>A popup is provided to confirm recording all changed attributes</td>
</tr>
<tr>
<td>All</td>
<td>All attributes are recorded</td>
</tr>
<tr>
<td>Active (default)</td>
<td>All attributes of devices with an intensity over zero are recorded.</td>
</tr>
</tbody>
</table>

*This means that it is necessary to record all attributes for the first step in a Sequence manually. See Record All Attributes for selected channels

Changed mode

Attributes are tagged as Changed when they have been altered since they were last recorded. This indication is a purple background in Channel and Attribute views.
If you are recording "Changed" attributes you may wish to force this flag manually. This is done with the soft key SET CHNGED in the **Devices** soft key of monitor 2.
All commands are executed to the currently selected Devices.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set all parameters to changed</td>
<td>Set Chnged &amp; PALETTE</td>
<td>All parameters are flagged as changed (purple background).</td>
</tr>
<tr>
<td>Set Focus parameters to changed</td>
<td>Set Chnged &amp; FOCUS</td>
<td>Focus parameters are flagged as changed (purple background).</td>
</tr>
<tr>
<td>Set Color parameters to changed</td>
<td>Set Chnged &amp; COLOR</td>
<td>Color parameters are flagged as changed (purple background).</td>
</tr>
<tr>
<td>Set Beam parameters to changed</td>
<td>Set Chnged &amp; BEAM</td>
<td>Beam parameters are flagged as changed (purple background).</td>
</tr>
<tr>
<td>Set a specific parameter to changed</td>
<td>Set Chnged &amp; Wheel Key</td>
<td>Specific parameters are flagged as changed (purple background).</td>
</tr>
</tbody>
</table>

The changed device indication is cleared when you fade or step in the Sequence.

See Channel Information - Detailed
For more information see Presets - Record

**Active Mode & Mark**

Active Mode (default) means that all devices with an intensity over 0% will be recorded with all parameters.

To be able to record parameters when an intensity is at 0% there is a special intensity state called "Mark" which is indicated with an "M" where the level is normally shown.

To set a Mark level, select the channels press MARK.

**Active Mode & Attribute Tracking**

This is a mode that is automatically set to ON when you select Active mode for recording attributes (5.1).
Hold UPDATE & ATTRIB to update changed attribute values in multiple presets (useful in record if Active mode) similar to Intensity tracking.

Use the check box to activate track-editing through a series of sequence steps of the main sequence (stopping at Blocks) and select forward, backward or both in the direction dropdown.
**Device Recording - All Attributes**

In Changed mode, only changed (purple) parameters are recorded for devices. The opposite of this is to record all attributes.

When you record devices directly to a Master Playback all attributes are always recorded. In the sequence it is an option in the advanced Recording Popup. See The [Recording Popup](#).

Check the box "Record all attributes" to record all attributes.
Device Recording - Delete

You can delete device data from a Preset in the Preset editor, in the Organizer or in the Preset Attribute editor. See Device Views - Editing.

1. Open the Preset List for the Preset.
   - Enter the number of the Preset, hold MODIFY and press PRESET
   - OR open the List from the Browser (Browser >Main Show Data >Presets)

2. Select the Attributes column.

3. Select the channels you wish to delete. If no channels are selected, attributes for all channels will be deleted.
4. Press DELETE. A popup will appear for confirmation.

5. Press MODIFY to confirm.
**Device Recording - Cue Only**

When this option in the Advanced tab of the Record dialog is activated all the attribute values that were active in the previous sequence step (regardless of where they were coming from) will be copied into the Preset in the sequence step following the newly inserted preset. This is useful when you want to record a new state within a series of tracked values.

Cue Only is an option in the advanced Recording Popup. See The [Recording Popup](#).

Check the box "Attributes: Cue only" to record Cue only.
Device Palettes

Moving Device values can be stored in Palettes, that are used to recall these values. Palettes can be stored in Presets, as references to the stored values. Palettes are organized in parameter groups (Focus, Color, Beam, All).

This chapter contains the following sections

- Device Palettes - Introduction
- Device Palettes - Record
- Device Palettes - Update
- Device Palettes - Edit
- Device Palettes - Lists
- Device Palettes - Activate By Number
- Device Palettes - Direct Mode
- Device Palettes - In Masters
- Device Palettes - Select Active Channels
- Device Palettes - Select Stored Channels
- Device Palettes - Display List
- Device Palettes - Focusing Mode
- Device Palettes - Renumber
Device Palettes - Introduction

A Palette is a memory for all or some parameters of a Moving Device. A Palette is used to load these parameters quickly, and stored as a reference in Presets for playback.

Direct selects are important for accessing Palettes. See Direct Selects.

There are four kinds of Palettes

<table>
<thead>
<tr>
<th>Type</th>
<th>Key</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Focus Palettes</td>
<td>FOCUS</td>
<td>Position parameters like pan, tilt...</td>
</tr>
<tr>
<td>Color Palettes</td>
<td>COLOR</td>
<td>Color parameters like cyan, magenta, yellow, color wheel...</td>
</tr>
<tr>
<td>Beam Palettes</td>
<td>BEAM</td>
<td>Beam parameters like gobo, shape, shutter, focus, iris...</td>
</tr>
<tr>
<td>All Palettes</td>
<td>PALETTE</td>
<td>All parameters</td>
</tr>
</tbody>
</table>

"By device" or "By device type"

Palettes usually store individual values for all devices. Color and Beam Palettes can be stored for one device, and reused for all devices of the same type. This choice is available in the recording popup.

Palettes in Presets

When a Palette is used to position a Device before recording a Preset - the Palette is referenced, not the individual values for each Device. This means that changing the Palette will update this reference in the whole Play.

Palettes in Direct Selects

- Palettes can be accessed from the Direct Selects
Device Palettes - Record

To record a device palette hold RECORD and press the PALETTE, FOCUS, COLOR or BEAM key (see below).

- Palettes are stored for the currently selected channel(s).
- To re-record a Palette, store it with the same number again.
- In the recording popup for Palettes there is a Text field to label each Palette. This is displayed every time the Palette is used.

NOTE
When you record a Palette, it is also activated and will be recorded into the next Preset.

To recall a Palette once it has been recorded:

1. Select the device channel(s).
2. Enter the number of the palette and press FOCUS, COLOR, BEAM or ALL PALETTE

Each Device or Each Device Type

In the Palette recording popup there is a choice to store the values individually for Each Device, or for Each Device Type.

- Positions (FOCUS) are best stored for Each Device, since they always are unique for each Device (channel).
- Color and Beam values are best stored for a Each Device Type, since color and beam parameter levels are the same for each Device (channel), and can be reused.

NOTE
If several Device Types are selected, the highest selected channel of each type will be recorded.

An "Each Device Palette" (individual) will override an "Each Device Type Palette" (General).
Record A Focus Palette

1. Select channel(s)

2. Initiate recording of next free Palette or Palette #

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>RECORD &amp; FOCUS</td>
<td>Records the next free Focus palette. You will get a popup*</td>
</tr>
<tr>
<td>Record as...</td>
<td># RECORD &amp; FOCUS</td>
<td>Records as palette #. You will get a popup*</td>
</tr>
<tr>
<td>Record Direct</td>
<td>RECORD &amp; direct select</td>
<td>Records to a direct select in palette mode. You will get a popup*</td>
</tr>
</tbody>
</table>

*Popup

3. Enter a text (optional)

4. Select Recording mode. For Focus Palettes this is usually "Each Device". See Each Device or Each Device Type.

5. Press MODIFY to confirm recording.

NOTE
The MASK function can be used to filter out unwanted parameters when recording a Palette. See Device Control - Mask.
Record A Color Palette

1. Select channel(s)

2. Initiate recording of next free Palette or Palette #

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>RECORD &amp; COLOR</td>
<td>Records the next free Color palette. You will get a popup*</td>
</tr>
<tr>
<td>Record as...</td>
<td># RECORD &amp; COLOR</td>
<td>Records as palette #. You will get a popup*</td>
</tr>
<tr>
<td>Record Direct</td>
<td>RECORD &amp; direct select</td>
<td>Records to a direct select in palette mode. You will get a popup*</td>
</tr>
</tbody>
</table>

*Popup

3. Enter a text (optional)

4. Select Recording mode. For Color Palettes this is default set to "Each Device Type". See Each Device or Each Device Type.

5. Press MODIFY to confirm recording.

NOTE
The MASK function can be used to filter out unwanted parameters when recording a Palette. See Device Control - Mask.
Record A Beam Palette

1. Select channel(s)

2. Initiate recording of next free Palette or Palette #

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>RECORD &amp; BEAM</td>
<td>Records the next free Beam palette. You will get a popup*</td>
</tr>
<tr>
<td>Record as...</td>
<td>[#] RECORD &amp; BEAM</td>
<td>Records as palette #. You will get a popup*</td>
</tr>
<tr>
<td>Record Direct</td>
<td>RECORD &amp; direct select</td>
<td>Records to a direct select in palette mode. You will get a popup*</td>
</tr>
</tbody>
</table>

*Popup

3. Enter a text (optional)

4. Select Recording mode. For Focus Palettes this is usually "Each Device Type". See Each Device or Each Device Type.

5. Press MODIFY to confirm recording.

NOTE
The MASK function can be used to filter out unwanted parameters when recording a Palette. See Device Control - Mask.
Record An All Palette

1. Select channel(s)

2. Initiate recording of next free Palette or Palette #

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record</td>
<td>RECORD &amp; PALETTE</td>
<td>Records the next free All palette. You will get a popup*</td>
</tr>
<tr>
<td>Record as...</td>
<td># RECORD &amp; PALETTE</td>
<td>Records as all palette #. You will get a popup*</td>
</tr>
<tr>
<td>Record Direct</td>
<td>RECORD &amp; direct select</td>
<td>Records to a direct select in palette mode. You will get a popup*</td>
</tr>
</tbody>
</table>

*Popup

3. Enter a text (optional)

4. Select Recording mode. For All Palettes this is usually Each Device. See Each Device or Each Device Type.

5. Press MODIFY to confirm recording.

When an All Palette is assigned to a device, and no other palette type (FCB), the name of the All Palette is displayed in the channel view.
NOTE
The MASK function can be used to filter out unwanted parameters when recording a Palette. See Device Control - Mask.
Device Palettes - Update

The fastest way to update all changed palettes when working in the sequence loaded to the main playback is to use the UPDATE PALETTE function in the soft keys on screen 1.

1. Press <--- to reach the top menu.

2. Press DEVICE to select the Device Soft Key page.

3. Press UPDATE PALETTE to update all changed Palettes for the selected channel(s).

2. You will get a popup confirming which ones are involved.
Device Palettes - UPDATE direct key

If a Palette is loaded to a Direct Select section, or to a Master Playback - it is possible to update it by selecting the involved channels, holding UPDATE and pressing the corresponding Direct Select or Master key.

NOTE
This shortcut is not available when an Editor is focused that uses UPDATE for something else. For example the Preset List.

Re-record A Palette - Merge Or Replace

When you re-record a preset or palette where attribute information already exists, you will get a choice of merging or replacing the existing attributes.

- Merge with existing will add the changes for the selected channel(s)
- Replace existing will replace all values in this Palette with those of the selected channel(s)
Device Palettes - Edit

Open the Device Palette Attribute Editor from the Browser >Devices >Focus Palette... (Color, Beam, All).

Device Palettes are edited and filtered in the same way as the Live Attributes and Preset Attribute views.

See Device Views - Editing and Device Views - Filtering.
**Device Palettes - Lists**

Hold MODIFY and press FOCUS, COLOR, BEAM or PALETTE to open a Palette list where you can edit palettes.

The Palette Lists are also opened from the Browser (Browser >Devices >Palettes >Focus Palettes).

![Palette List](image)

**NOTE**
Palettes that have been recorded "per type of device" are shown first in these lists. Most often these are Color Palettes. See Each Device or Each Device Type

**Palette List - Columns & Functions**

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Palette</td>
<td></td>
<td>The ID of each Palette. Cannot be changed.</td>
</tr>
<tr>
<td>Text</td>
<td>MODIFY</td>
<td>Press MODIFY to activate and end text input.</td>
</tr>
<tr>
<td>Attribute</td>
<td>MODIFY</td>
<td>Opens the Palette Attribute Editor. The number indicates how many Devices are stored in this Palette.</td>
</tr>
</tbody>
</table>
# Device Palettes - Activate By Number

Activate a Palette for the selected channel(s) by number.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Focus Palette</td>
<td>[#] FOCUS</td>
<td>Values are set from Palette #.</td>
</tr>
<tr>
<td>Color Palette</td>
<td>[#] COLOR</td>
<td>Values are set from Palette #.</td>
</tr>
<tr>
<td>Beam Palette</td>
<td>[#] BEAM</td>
<td>Values are set from Palette #.</td>
</tr>
<tr>
<td>All Palette</td>
<td>[#] PALETTE</td>
<td>Values are set from Palette #.</td>
</tr>
</tbody>
</table>

**NOTE**
Only selected channel(s) that are referenced in Palette # will be affected.
## Device Palettes - Direct Mode

When a Palette key (FOCUS, COLOR, BEAM, PALETTE) is held the first 40 Palettes can be activated from the Direct Select keys, or the Direct Select keys 1-10 in a Congo Jr/Kid.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Activate Direct Mode</td>
<td>Hold a Palette key</td>
<td>Direct Select display shows the first 40</td>
</tr>
<tr>
<td>2. Select Palette</td>
<td>Direct Select key</td>
<td>When the key is pressed that Palette is activated.</td>
</tr>
</tbody>
</table>
Device Palettes - In Masters

Enter the number of a palette, hold the palette type key (FOCUS, COLOR, BEAM, PALETTE) and press a Master key to load to that master.

The Device Palettes can now be played back from Master Playbacks by pressing the master key. See Master Playbacks - Palettes.
Device Palettes - Select Active Channels

All channels currently referencing a Palette can be selected using the Direct Select keys for Palettes (FOCUS, COLOR, BEAM, PALETTE), in combination with CHANNEL and ALL.

Palettes are selected from the Direct Selects for this function. See Direct Selects.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select channels</td>
<td>[CHANNEL] &amp; Direct Select#</td>
<td>All channels stored in Palette # are selected in the active Channel View.</td>
</tr>
<tr>
<td>Select channels over</td>
<td>ALL &amp; Direct Select#</td>
<td>All channels with a level in the active Channel View are selected.</td>
</tr>
<tr>
<td>zero%</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Device Palettes - Select Stored Channels

You can Select all channels that are stored in a Palette as Each Device.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Focus channels</td>
<td># CHANNEL &amp; FOCUS</td>
<td>All channels stored in Palette # are selected in the active Channel View.</td>
</tr>
<tr>
<td>Color channels</td>
<td># CHANNEL &amp; COLOR</td>
<td>All channels stored in Palette # are selected in the active Channel View.</td>
</tr>
<tr>
<td>Beam channels</td>
<td># CHANNEL &amp; BEAM</td>
<td>All channels stored in Palette # are selected in the active Channel View.</td>
</tr>
<tr>
<td>Palette channels</td>
<td># CHANNEL &amp; PALETTE</td>
<td>All channels stored in Palette # are selected in the active Channel View.</td>
</tr>
</tbody>
</table>
Device Palettes - Focusing Mode

Focusing mode is designed for quickly focusing and updating palettes. It is activated from the FOCUS MODE soft-key in the DEVICE Soft page.

Start by activating Focus Mode from the soft key under the soft key Device.

The Focus Palettes - Focusing mode tab will open and Highlight Mode will be activated.
1. Select Palette from the list
   - Action: Mouse, touch screen or arrow keys.
   - Feedback: The corresponding channels are selected and displayed in the Channel Display list. The palette is activated and Highlight mode is turned on.

2. Focus one by one with NEXT/LAST
   - Key: NEXT & LAST
   - Feedback: Each focused channel is mapped to the channel controls.

3. Update the Palette
   - Key: UPDATE_PALETTE
   - Feedback: The Palette is updated and you are returned to the Focus Palette list to the next Palette.

4. Exit Focus Mode
   - Key: FOCUS MODE
   - Feedback: Focusing mode is exited and the Focus Palette tab is closed.
Device Palettes - Renumber

You can renumber a Palette of any type (FCBP) in the Organizer.

1. Open the Organizer for the type of palette you wish to renumber by holding LOAD and pressing the palette key (FOCUS, COLOR, BEAM, PALETTE).

![Organizer Screenshot]

2. Enter the new number and press MODIFY
Device Times

Times for Moving Devices can be set in seconds or as a percentage of the Sequence Step In-times.

This chapter contains the following sections

- Device Times - Introduction
- Device Times - Individual or FCB
- Device Times - Attribute Editor Times
- Device Times - Fan Times
**Device Times - Introduction**

A Moving Device can have Times and Delays in the following ways.

- **No time** - follows the Sequence Step In-time.
- **Parameter group times** - an attribute time for FOCUS, COLOR or BEAM parameters.
- **FCB times** - Same as above, but there is a shortcut for setting all three
- **Device parameter times** - A time for each attribute of a Moving Device.

**NOTE**

All times are set to the Preset in the A or B field depending on the setting of the parameter "Set Times To Field" in the Cobalt Settings.

All attribute times are stored with a Preset.

There is a default Attribute Time that is used when Moving Devices are positioned manually or with GoInB. See [Moving Device Times - Default Attribute Time](#).

**Percent times, or seconds?**

Times for Moving Devices are set in seconds (absolute) or as a percentage of the IN time of a Sequence Step.

The default setting is percent. This means that all FCB-Times will equal the IN time of a Sequence Step, and all FCB-Delay Times will execute as a percentage of the IN time of a Sequence Step.

In the example above, the FCB Times are 100% of the In time (5 seconds).
If the FCB Times are set to 50% of the IN-time they will be 2.5 seconds at an in time of 5 seconds.

If the In-time is changed to 10 seconds, the FCB-times will be 50% of 10 (= 5 seconds).

**NOTE**

In Congo plays files earlier than Version 4.2, the FCB Delay time was set to 100% due to the fact that Delay Times were inherited from the Delay In time. These plays (pre-4.2) with FCB Delays set to 100% will be converted to use a delay of 0s instead.

**Default Attribute Time**

The Default Attribute Time (3 seconds) is used mainly to keep noise and unnecessary mechanical friction down when a Moving Device is positioned in the following situations:

- When attributes are executed from Independents
- When copying Blind attributes to Live
- When using Stop table for an old dynamic
- When you press Home Attributes
- When jumping in the sequence
- Using REFRESH in the Main Playback
To change this time see Attribute Settings.

**NOTE**
The Default Attribute Time does not affect how fast a palette is activated from direct selects or directly. This time can be set on the fly - for example #(s) DIRECT SELECT PALETTE.

See Shortcuts - Device Palette Activating
Device Times - Individual or FCB

Device times can be set to individual parameter of selected devices, or to a parameter group like Focus, Color or Beam for all devices in the preset.

FCB times are defaulted to run in 100% of the main In and Delay times for a step. You can change this percentage or set an absolute time in seconds. An individual parameter time always wins over a general FCB time.

Times are shown in the playback view. Individual parameter times are shown as a red dot at the end of FCB timelines - See Color in the example below.

Setting times in the advanced recording popup
You can set these times directly in the Advanced tab of the Recording Popup when you record a new preset.
Setting times with key shortcuts
You can set times with a key shortcut by entering the time, holding TIME and pressing a destination key (see table).

You will get a popup asking if you want to set the times on a general FCB -level for all devices, or as individual Parameter Times for the selected devices.
### Key Shortcuts for device times

<table>
<thead>
<tr>
<th>Function</th>
<th>Key Shortcut</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Focus time</td>
<td>[#] TIME Å &amp; FOCUS</td>
<td>Popup (see above)</td>
</tr>
<tr>
<td>Color time</td>
<td>[#] TIME Å &amp; COLOR</td>
<td>Popup (see above)</td>
</tr>
<tr>
<td>Beam time</td>
<td>[#] TIME Å &amp; BEAM</td>
<td>Popup (see above)</td>
</tr>
<tr>
<td>Parameter time</td>
<td>[#] TIME Å &amp; Parameter Key</td>
<td>An individual time is set to this parameter for the selected device(s)</td>
</tr>
<tr>
<td>Focus delay time</td>
<td>[#] DELAY Å &amp; FOCUS</td>
<td>Popup (see above)</td>
</tr>
<tr>
<td>Color delay time</td>
<td>[#] DELAY Å &amp; COLOR</td>
<td>Popup (see above)</td>
</tr>
<tr>
<td>Beam delay time</td>
<td>[#] DELAY Å &amp; BEAM</td>
<td>Popup (see above)</td>
</tr>
<tr>
<td>Parameter delay time</td>
<td>[#] DELAY Å &amp; Parameter Key</td>
<td>An individual delay time is set to this parameter</td>
</tr>
</tbody>
</table>

You can edit FCB times in the [Preset List](#).

**NOTE**
There is a shortcut for setting both F, C and B-Times to the same value. Enter the time and hold TIME or DELAY and press ATTRIBUTE.

In the Times soft key page there are keys for setting FCB time and delay directly. See [Times Soft Key Page](#).
**Device Times - Attribute Editor Times**

Times can be set and edited in the Live Attributes and Preset Attribute Editors. *Please note that times are set to A working in this editor, regardless of all other settings.*

- Press ATTRIB to open the Live Attribute Editor.
- Enter a Preset number, hold PRESET and press ATTRIB to open the Preset Attribute Editor.

Hold FORMAT and press the down arrow to open Time and Delay rows.
Hold FORMAT and press TIME or DELAY to do the same thing.
Hold FORMAT and press the up arrow to close these rows.

In this editor press FORMAT to toggle between

- Selected devices
- Non-zero devices
- Changed devices
- All devices
- Devices with attributes

The current format is indicated in the upper right corner ("Selected devices" in the example above).

**NOTE**
Times can be set default as % or in seconds. See [Device Times - Percent Or Seconds](#).
Attribute Times

These functions will work in the Live Attribute Editor and the Preset Attribute Editor.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Open the Time row</td>
<td>[FORMAT] + &amp;</td>
<td>The Time row is opened under each cell</td>
</tr>
<tr>
<td></td>
<td>[Down arrow]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>or</td>
<td></td>
</tr>
<tr>
<td></td>
<td>[FORMAT] + TIME</td>
<td></td>
</tr>
<tr>
<td>2. Select Attribute time</td>
<td>Arrow keys</td>
<td>The cell(s) is highlighted</td>
</tr>
<tr>
<td>cell(s)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3. Set time #</td>
<td>[#] + MODIFY</td>
<td>The time # is set to the selected cell(s)</td>
</tr>
</tbody>
</table>

NOTE
Times can be set to the selected devices also by holding TIME and pressing FOCUS, COLOR or BEAM.

Set Time to Devices popup.

![Set attribute times](image-url)
### Attribute Delay Times

These functions will work in the Live Attribute Editor and the Preset Attribute Editor.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Open the Delay row</td>
<td>FORMAT &amp; Down arrow or FORMAT &amp; DELAY</td>
<td>The Delay row is opened under each cell</td>
</tr>
<tr>
<td>2. Select Attribute delay cell(s)</td>
<td>Arrow keys</td>
<td>The cell(s) is highlighted</td>
</tr>
<tr>
<td>3. Set delay time #</td>
<td># MODIFY</td>
<td>The delay time # is set to the selected cell(s)</td>
</tr>
<tr>
<td>4. Update Preset</td>
<td>UPDATE</td>
<td>Only needed in Live Attributes Editor.</td>
</tr>
</tbody>
</table>

**NOTE**

Delay times can be set to the selected devices also by holding DELAY and pressing FOCUS, COLOR or BEAM.
Device Times - Fan Times

In the Live and Preset Attribute Views there is a wizard for fanning parameter times. This Wizard will only open when a Time or Delay cell is selected. The selected cells are fanned between the devices.

1. Open an Attribute view. See Device Views - Live and Device Views - Presets.
2. Open the Time and Delay rows by holding FORMAT and pressing the Down Arrow. See Device Times - Attribute Time Editor.
3. Select the Time or Delay cells for the parameters and devices intended.

4. Press WIZARD. The Fan Time Wizard popup will open.

5. Select values and confirm.
Device Play Back

When moving Devices are played back from the Main Playback and the Master Playbacks there are different modes for when and how attributes are triggered.

This chapter contains the following sections

- Device Play back - Introduction
- Device Play back - Attributes Follow Faders
- Device Play back - Attrib Move
Device Play back - Introduction

Attributes will be trigged during playback in the following situations

- A Preset is faded in a Sequence or Chase
- A Preset is faded in on a Master Playback fader
- A Preset is faded out on a Master Playback fader
- A Master is flashed
- A Dynamic effect is started

In a Sequence Step attributes can be set to move with Auto Mark (5.0), OnGo (live) or InB (move while black, preposition).
**Device Play back - Attributes Follow Faders**

Attributes will follow the manual movement of masters depending on the Master Settings. These are some general rules. See [Master Settings](#).

The always follow the B fader of the Main Playback.

- They start moving at 1%.
- Snap parameters also trig at 1%.

Master Playbacks behave different from the crossfaders of the Main Playback.

**Masters And Attributes - General**

When a master leaves its 0% position, the corresponding attribute parameters are trigged and follow the fader.

During a timed fade in a Master, attributes will follow the FCB-times of the Preset in that Master.

If another master with overlapping attribute parameters is activated, (leaves 0%), it will take control of the corresponding attributes. To re-gain control from any Master, move it to 0% and up again.

How attributes behave when moving the Master fader down depends on the settings for the fader.

**Crossfaders And Attributes**

When a manual crossfade is made, the attribute positions will follow the B fader. If the fader is moved slower than the time assigned to the attributes, the fader has control. If the fader is moved faster than the assigned time, the time will take control to make a smooth movement.
**Device Play back - Attrib Move**

Attributes can be executed in three ways

- AutoMark
- On Go
- In B

Depending on this setting Attributes will be executed when a step is faded in live (On Go) or when a Step is loaded to be faded in (In B). See [System Settings - Attribute](#).

You can choose a setting as default depending on the style of your show - and then change individually for any step or device. See [Sequence List](#).

**NOTE**

GoInB attributes follow the times recorded in the preset.

The old (pre v5.0) dynamics can be set to start on GO always - See [Settings - Crossfade](#).

**AutoMark**

The default setting is AutoMark but you can change this on the sequence step or in the Preset Attribute editor. In AutoMark mode, attributes are automatically activated In B or On Go based on the level in Live and in B.

- If the device intensity is >0% in Live, attributes are On Go.
- If the device intensity is 0% in Live and >0% in B, attributes are In B.
- If the device intensity is 0% in Live and 0% in B, attributes are On Go.)

Live view: Channels that are auto-marking are indicated with a blue background on the FCB indicators. This indicator remains until you press GO.
Live Attributes

In addition to the Attribute format of the Live tab you can view all moving device parameters in the Live Attribute Editor.

This tab can only be opened from the Browser (Browser > Devices > Live Attributes). The functions are the same as in any channel view with attributes.

NOTE
All attribute views need to be unlocked for screen editing by holding SETUP & TAB and activating in the popup.

PARK works against selected cells when an Attribute View is open.

Hold FORMAT and press Right Arrow to show all parameters listed over each other, blanking out the ones not relevant. Hold FORMAT and press Left Arrow to change back.

Running attributes are shown with yellow progress bars.
NOTE
Select format by pressing FORMAT.

Hold FORMAT and press Down Arrow to open up Time and Delay rows. See
Device Times - Attribute Time Editor

Live Attributes - Columns

These are the different Moving Device parameters that are displayed for each with their current values. For editing see Device Views - Editing

<table>
<thead>
<tr>
<th>Function group</th>
<th>Parameters</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel &amp; Level</td>
<td>No input</td>
<td>The number of the device is highlighted when selected, and red when focused with NEXT/LAST. The level is indicated to the right.</td>
</tr>
<tr>
<td>FOCUS</td>
<td>Pan, Tilt, Focus Speed</td>
<td>Current parameter values are shown.</td>
</tr>
<tr>
<td>COLOR</td>
<td>Cyan, Magenta, Yellow, Color, Color2, CTO, Color speed etc...</td>
<td>Current parameter values are shown.</td>
</tr>
<tr>
<td>BEAM</td>
<td>Focus, Iris, Zoom, Strobe, Gobo, Gobo &lt;&gt;, Gobo rot, etc...</td>
<td>Current parameter values are shown.</td>
</tr>
<tr>
<td>CONTROL*</td>
<td>Aux 1, Control, Dummy ch's etc...</td>
<td>Current parameter values are shown.</td>
</tr>
</tbody>
</table>
*Control parameters labelled "control" can be edited, but will not be stored. Aux values are stored.

**NOTE**
Hold COLUMN and move wheel to change column sizes.
Gel Picker

There is a Gel Picker that uses the data for each moving device with CMY/RGB mix to generate the values for gels of each type.

It is opened from the Browser > Devices > Gel Picker. Tap or use arrow keys and MODIFY to select a color.

If you know the exact gel brand and number you can select a gel from the Direct Selects as well. (See Virtual controls tabs: ColorMixer and GelPicker)
**All Palettes**

This node opens the list of All Palettes.

Press MODIFY in the Attribute cell to open the corresponding Palette editor. See [Device Palettes](#).
**Focus Palettes**

This node opens the list of Focus Palettes.

Press MODIFY in the **Attribute** cell to open the corresponding Palette editor. See [Device Palettes](#).

![Focus Palettes](image)
**Color Palettes**

This node opens the list of Color Palettes.

Press MODIFY in the Attribute cell to open the corresponding Palette editor. See [Device Palettes](#).

![Color Palettes](image-url)
**Beam Palettes**

This node opens the list of Beam Palettes.

Press MODIFY in the **Attribute** cell to open the corresponding Palette editor. See [Device Palettes](#).
Mask

You can mask whole groups of parameters (FCB) or single parameters in a group with the MASK key.

- When mask is active it is indicated in the LED of the MASK key, and at the top of the screens.
- The mask is used when recording Presets, Palettes and Dynamics.
- Masked parameters are displayed in Live tab Attributes view and in the ML LCD on the facepanel with "--".
- When you record a Preset or Palette, masked parameters are NOT recorded.
- You can prepare and store 999 Mask templates and activate as the global mask anytime.
- User Masks can be accessed as content in the Direct Selects.

Global Mask - Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable/Disable Mask</td>
<td>[MASK]</td>
<td>The LED in MASK is lit. In the Main Display you can see &quot;Mask: and &quot;.-&quot; for nothing, &quot;fcb&quot; for partial and &quot;FCB&quot; for full masking. On the top of every screen you can see:</td>
</tr>
<tr>
<td>Mask FOCUS</td>
<td>[MASK] &amp; [FOCUS]</td>
<td>Toggles the Mask for the all FOCUS parameters</td>
</tr>
<tr>
<td>Mask COLOR</td>
<td>[MASK] &amp; [COLOR]</td>
<td>Toggles the Mask for the all COLOR parameters</td>
</tr>
<tr>
<td>Mask BEAM</td>
<td>[MASK] &amp; [BEAM]</td>
<td>Toggles the Mask for the all BEAM parameters</td>
</tr>
<tr>
<td>Mask parameter</td>
<td>[MASK] &amp; [Wheel Key]</td>
<td>Toggles the Mask for any single parameter</td>
</tr>
<tr>
<td>Open Mask editor</td>
<td>[MODIFY] &amp; [MASK]</td>
<td>Opens the Mask editor (see below).</td>
</tr>
</tbody>
</table>
**Masking indication**
When Mask is enabled, a summary of active masks is shown in the ML display. Each parameter category is indicated with a dash, lowercase or uppercase letter.

"-" (Dash) means the category is unmasked - all parameters are available for control and recording.

"fcb" (Lowercase lettering) means the category is partially masked - some parameters have been masked and are unavailable for control or recording.

"FCB" (Uppercase lettering) means the entire category is masked and no parameters from that category are available for control or recording.

**Mask - Editor**

Hold MODIFY and press MASK to open the editor.

In the Mask Editor, single parameters can be toggled on/off by pressing MODIFY in the Allow column. This also means that, if you want to toggle a parameter column on/off, you can select the top cell, press COLUMN to select the whole column, and then press MODIFY.

**User Masks - Functions**

You can save and label up to 999 different combinations of masked parameters. These Masks can then be applied to masters as playback masks, or to the Global Mask for use when recording Palettes or Presets. They are stored in the Mask List (Browser > Devices > Masks).

**To record a user Mask:**

1. Set up the Global Mask any way you want (See [Global Mask - Functions])
2. Enter a number, hold RECORD and press MASK (with no preceding number the next free Mask is recorded)

To recall a user Mask:

1. Enter a number and press MASK or
2. Press a Direct Select for this Mask.

To load a user Mask to a master:

1. Enter the number, hold MASK and press the Master key.
   - This will load this mask as a playback mask for the content of this master.

You can use # INSERT and DELETE to add or remove masks from this list, and you can edit them by pressing MODIFY in the Mask cell - which will open the Mask Editor for that Mask.
>Settings & Tools

These are the settings and tools for Devices.

This chapter contains the following sections

- Scroller Rolls
- See Device Mode Settings and Device Pages
**Scroller Rolls**

Scroller Rolls are defined in the Scroller Roll Editor. It is opened from the Browser (Browser >Devices >Settings & Tools >Scroller Rolls)

![Scroller Rolls Editor](image)

### Scroller Rolls Editor - Columns

<table>
<thead>
<tr>
<th>Function</th>
<th>Value</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scroller Roll</td>
<td>1-999</td>
<td>The ID of each Template. Press MODIFY to open the Editor</td>
</tr>
<tr>
<td>Fan = Intensity</td>
<td>On/Off</td>
<td>Press MODIFY to toggle if Fan should follow intensity channel of the scroller Device to keep down noise when not in use (providing the scroller and template have a fan parameter).</td>
</tr>
<tr>
<td>Default Time</td>
<td>0s-45min</td>
<td>This is the default time per frame the scroller will use when changed manually, to keep down noise, and save the gel string.</td>
</tr>
<tr>
<td>Text</td>
<td></td>
<td>Press MODIFY to activate and end text input.</td>
</tr>
</tbody>
</table>
Create a Scroller Roll

1. Open the Scroller Rolls List from the Browser (Browser > Devices > Settings and Tools > Scroller Rolls).

2. Press INSERT to create a new Roll (a number of standard Rolls are created by default when you open a new Play).

3. Set Fan=Intensity, Default Time and TEXT for this roll.

4. Press MODIFY in the Scroller Roll cell to open the Scroller Roll Editor. A Wizard is opened where you can define the number of frames and the default Fan value (can be edited later).

5. This is what the scroller roll editor looks like with five frames defined.
You can define the following functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Value</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position</td>
<td>1-999</td>
<td>The ID of each Position. Cannot be changed.</td>
</tr>
<tr>
<td>Text</td>
<td></td>
<td>Press MODIFY to activate and end text input.</td>
</tr>
<tr>
<td>Fan %</td>
<td>0-100%</td>
<td>It is possible to set a Fan value for each color (to keep noise down).</td>
</tr>
<tr>
<td>AutoMove</td>
<td>0-10</td>
<td>The scroller will move slowly forth and back 0-10 bits when the corresponding color is selected. It will not take individual calibration into account.</td>
</tr>
<tr>
<td>Value</td>
<td>0-255</td>
<td>This is the 8 bit value (0-255) that will be output when this frame is selected.</td>
</tr>
</tbody>
</table>

6. Exit with ESC.

Assign A Scroller Roll

Scroller Rolls can be assigned from the Device List. They can also be assigned when a scroller is patched, from the Patch Wizard.

1. Open the Device List (Browser >Patching >Device List). (You can also hold MODIFY and press DEVICE).

2. Use arrow keys to select the Scroller Roll Cell for a channel.

3. Press MODIFY to get a dropdown with all defined Rolls.
4. Select a roll with arrow keys.

5. Press MODIFY to confirm.

The currently selected color will be shown in the black box under the level in the Channel Views.

Calibrate Individual Scroller Rolls

Each scroller roll can be calibrated individually. This is done in the Scroller Calibration Editor that is opened from the Device List.

1. Open the Device List (Browser >Patching >Device List).

2. Use arrow keys to select the Calibration Editor cell to the far right.

3. Press MODIFY to open the Calibration Editor for the selected channel.

4. Select Adjusted Position, enter a new value (confirm with MODIFY). It is updated live.

5. Press ESC to exit. Changes are stored automatically.

NOTE

(v5.0) If you change the scroller calibration for a device and close the Scroller Calibration Editor, recorded data (presets, palettes) for the previous frame values will be updated to the new frame values. Values between frames will not be affected.

To "clear" calibrations from a device/scroller: Re-select the same scroller roll in the Device list
Scroller Fan override

In the Attribute setup (SETUP & ATTRIBUTE) it is possible to specify an Override value for all Scroller Fans. If you set a value > 0%, this value will be used instead of the Fan values programmed in the Scroller Roll. This is useful for making a temporary and absolute override of all fans, for example during long rehearsals when heat is higher than during a performance.
Effects

In Cobalt v6 there are four different kinds of effects:

- Intensity Chase (step based)
- Dynamic (relative waveforms)
- Content (Absolute)
- Image (mapped)

There are two slightly different types of effects, which are Sequences in Chase mode, and Direct Dynamics.

Effects Node

This chapter contains the following sections:

- Effects - Introduction
- Channel Distribution Wizard
- Live Effects
- Effect Playbacks
- Effect Overview
- Beat Bosses
- Chase Effects
- Content Effects
- Dynamic Effects
- Image Effects
- Channel Sets
Effects - Introduction

The effects in Cobalt are powerful devices that allow you to create and play with effects in a very intuitive and fast way, regardless the size or nature of your rig. All effects are defined in, and can be tested in the demo shows, which is a good way to become acquainted with them. See Try out the effects in a Demo Play >>

There are four types of effects

<table>
<thead>
<tr>
<th>Chase</th>
<th>Content</th>
<th>Dynamic</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="Chase" alt="E1" /></td>
<td><img src="Content" alt="E2" /></td>
<td><img src="Dynamic" alt="E3" /></td>
<td><img src="Image" alt="E4" /></td>
</tr>
<tr>
<td>Chase Flicker</td>
<td>Content Move</td>
<td>Dynamic Dynos</td>
<td>Image LED wall</td>
</tr>
<tr>
<td>267%</td>
<td>M500 A Empty</td>
<td>ALL ML &gt; circle</td>
<td>10x10 Image</td>
</tr>
<tr>
<td></td>
<td>100%</td>
<td>100%</td>
<td>Square</td>
</tr>
</tbody>
</table>

Stepped intensity effects with live control of tap tempo. The effect is edited into parts with individual timing and hi/low levels per part.

Step based effects with comprehensive live control over channel distributions, directions and timing. Apply to groups or sets.

Dynamic Templates (waveforms) are applied to parameters to create movement effects relative to a base point, such as circles, rainbows, etc. Apply to groups or sets.

An image (jpg/gif) or text is mapped to intensity or color in a Magic Sheet pixel grid, with comprehensive live control over channel distributions, directions and timing.

Control

To control an effect you create an Effect Playback from which you can control, record and edit it like a moving device into presets and palettes from the Device Controls tab.

- When the intensity is over zero the effect will run.
- Effect intensities are recorded, edited, copied and tracked like any other channel intensity.
- Effect parameters are stored into palettes and presets just like any moving device parameters.
- There is a Live Effects tab, and you can open a tab to show active effect playbacks.
NOTE
Effects are controlled, recorded and edited like any moving device with an intensity. The only difference is that you select them with # EFFECT.

LIMITATIONS
Current limitations are:

- Number of effect channels: 100
- Number of outputs used by effects: 2 x 512
- Number of groups that can be used in effects: 256

Try out the effects in a Demo Play

One way of understanding the simple, and powerful features of the effects is to try them out in one of the demo plays.

1. Open Demo Tour (Browser >Files >Open >Demo Plays >Demo_Tour)
2. Open the Demo_Tour Training Project (Browser >File>Training Projects >Demo_Tour)

Now you can test the pre-programmed effects of each type.

Chase Effect

1. Enter 1, press EFFECT and move the level wheel to full. You should now have a chase effect shown in the training tab.
2. In the Device dock, you have two parameters, Chase: (symmetrical), Rate (100%). Tap on the rate to change the tempo.
3. Hold C and press LIVE LIIVE to clear all output.

**Content Effect**

This is a content effect, it uses steps defined in a Series. A Series can contain palettes, presets and parameters. Note that the Groups used are those already recorded, and the number of the Group is used by the effect.

1. Enter 2, press EFFECT and move the level wheel to full. You will see nothing until you select a **ChSource**, **Group**, **Series** and **GrpParts** in the Device Control Dock.
2. Touch or click and set
   
   ChSource = **Group**
   Group = **All VL**
   Series = **Intensity**
   GrpParts = **Parts 2**

   You should now see an intensity chase with two parts on all varilites in the rig. You can change the rate and distribution. Play around with the parameters.
3. Now select Series = RGB - and you will have a color effect instead. Play around with the parameters. Explore.
4. To store in a preset, record one as usual. What you see is what you get.
5. Hold C and press LIVE LIIVE to clear all output.

**Dynamic Effect**

This is a Dynamic Effect, it uses wave-tables to create movements around the current focus point of the lights. Note that the Groups used are those already recorded, and the number of the Group is used by the effect.

1. Enter 3, press EFFECT and move the level wheel to full. You will see nothing until you select a **ChSource**, **Group** and **DynTemplate** in the Device Control Dock.
2. Touch or click and set
   
   ChSource = **Group**
   Group = **All VL**
   Dynseries = >**Circle** (default)

   You should now have a circle effect running on all varilites in the rig. You need light to see the beams.
3. Set the intensities to full in the group All VL by clicking and dragging on group 3 in the Direct Selects. Now you should see the circle effect.
4. Reselect the effect with 3 EFFECT.
5. Play around with the parameters. Explore.
6. To store in a preset, record one as usual. What you see is what you get.
7. Hold C and press LIVE LIIVE to clear all output.
Effects - Functions

These are the general effect functions.

This chapter contains the following sections

- Effect - Views
- Effects - Command syntax
- Effects - Soft Key Page
- Effects - Edit
- Effects - Record
- Effects - Channel Distribution Wizard
**Effects - Views**

Effects can be viewed in three views

- *Effects* tab
- *Selected channels - Live* tab area
- *Live Effects* tab

There are two ways to display an effect

- As a channel handle (in tabs)
- As a device (in Live Effects)

**Channel handle**

The effect handle in the *Effects* and *Selected Channels - Live* dock have four levels of detail. Hold FORMAT and press up/down arrow to select them.

**Device**

In the Live Effects tab all attributes are displayed just like a moving device. See [Live Effects](#).
## Effects in Tabs

Effects are shown in Live, Effects and Live Effects tabs. See [Live - Introduction](#). See [Live Effects](#).

### Live Effects

![Live Effects - Current: 4.0 Next: 5.0 - Absolute mode](image)

<table>
<thead>
<tr>
<th>Effect Type</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Chase Effect</strong></td>
<td>Chase*</td>
<td>Rate/Tap</td>
<td>C1</td>
<td>100</td>
</tr>
<tr>
<td><strong>Content Effect</strong></td>
<td>Rate/Tap</td>
<td>ChSource</td>
<td>Set/Grou</td>
<td>GrpParts</td>
</tr>
<tr>
<td>E1</td>
<td>100</td>
<td>Set</td>
<td>S:Empty</td>
<td>Not used</td>
</tr>
<tr>
<td><strong>Dynamic Effect</strong></td>
<td>ChSource</td>
<td>Set/Grou</td>
<td>DynTem</td>
<td>OffsetRel</td>
</tr>
<tr>
<td>E3</td>
<td>Set</td>
<td>S:Empty</td>
<td>&gt;circle</td>
<td>Evenly sp</td>
</tr>
<tr>
<td><strong>Image Effect</strong></td>
<td>Layout*</td>
<td>Type*</td>
<td>MapTo*</td>
<td>Index*</td>
</tr>
<tr>
<td>E4</td>
<td>No Layout</td>
<td>Image</td>
<td>Intensity</td>
<td>No Imag</td>
</tr>
</tbody>
</table>
Effects

Selected channels - Live

Using a mouse or trackball
Click to select and use the mouse wheel, or hold the right key and move to set levels. Click to add more, double-click to deselect all but the last clicked.
Effects - Command syntax

Effects are selected and adjusted one by one or in groups in the same way as moving devices. Instead of using the CHANNEL key there is an EFFECT key.

As soon as an effect is selected you can control the intensity with all level functions, and attributes with attribute controls and palettes.

Select and activate effects

An effect is activated as soon as the level of the Effect Playback is over zero. Please note that you must create an Effect Playback before you can control it. See Effect Playbacks.

Default Cobalt syntax (RPN)

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select effect</td>
<td># EFFECT</td>
<td>Effect # is selected and can be controlled with level wheel and attribute controls</td>
</tr>
<tr>
<td>Add an effect</td>
<td># +</td>
<td>Effect # is added to the current selection</td>
</tr>
<tr>
<td>Subtract an effect</td>
<td># -</td>
<td>Effect # is subtracted from the current selection</td>
</tr>
<tr>
<td>Add multiple effects</td>
<td># THRU</td>
<td>Up to effect # is added to the current selection</td>
</tr>
<tr>
<td>Add a channel</td>
<td># CHANNEL &amp; +</td>
<td>Channel # is added to the current selection</td>
</tr>
<tr>
<td>Add a group</td>
<td># GROUP &amp; +</td>
<td>Group # is added to the current selection</td>
</tr>
<tr>
<td>Add an effect to a channel selection</td>
<td># EFFECT &amp; +</td>
<td>Effect # is added to the current selection</td>
</tr>
<tr>
<td>Subtract a channel</td>
<td># CHANNEL &amp; -</td>
<td>Channel # is subtracted from the current selection</td>
</tr>
<tr>
<td>Subtract a group</td>
<td># GROUP &amp; -</td>
<td>Group # is subtracted from the current selection</td>
</tr>
<tr>
<td>Subtract an effect</td>
<td># EFFECT &amp; -</td>
<td>Effect # is subtracted from the current selection</td>
</tr>
</tbody>
</table>
At mode syntax

If your Cobalt is set to use At Mode for channel commands, effects are selected in the following ways. You can terminate a selection in At Mode pressing @Level or the decimal point.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select effect</td>
<td>EFFECT #</td>
<td>Effect # is selected</td>
</tr>
<tr>
<td>Add an effect</td>
<td>+ EFFECT #</td>
<td>Effect # is added to the current selection</td>
</tr>
<tr>
<td>Subtract an effect</td>
<td>- EFFECT #</td>
<td>Effect # is subtracted from the current selection</td>
</tr>
<tr>
<td>Add multiple effects</td>
<td>THRU #</td>
<td>Up to effect # is added to the current selection</td>
</tr>
<tr>
<td>Add a channel</td>
<td>+ CHANNEL #</td>
<td>Channel # is added to the current selection</td>
</tr>
<tr>
<td>Add a group</td>
<td>+ GROUP #</td>
<td>Effect # is added to the current selection</td>
</tr>
<tr>
<td>Subtract a channel</td>
<td>- CHANNEL #</td>
<td>Channel # is subtracted from the current selection</td>
</tr>
<tr>
<td>Subtract a group</td>
<td>- GROUP #</td>
<td>Effect # is subtracted from the current selection</td>
</tr>
</tbody>
</table>

Select channels from effect

These functions make it possible to select channels involved in an effect.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select active channels</td>
<td>EFFECT &amp; CHANNEL</td>
<td>All channels involved in effects that are active are selected.</td>
</tr>
<tr>
<td>Select all in effect...</td>
<td># EFFECT &amp; CHANNEL</td>
<td>All channels involved in effect playback # are selected.</td>
</tr>
<tr>
<td>Select active effects</td>
<td>EFFECT &amp; ALL or ALL &amp; EFFECT</td>
<td>All active effect playbacks are selected. Pressing ALL alone will never select effect playbacks.</td>
</tr>
<tr>
<td>Toggle between selecting an effect and the channels assigned to it.</td>
<td>Inv Eff/Ch or C/Alt &amp; INV GROUP</td>
<td>The soft key Inv Eff/Ch in the Effects soft key meny allow you to toggle the channel selection between the selected effect playback and the channels assigned to it.</td>
</tr>
</tbody>
</table>
Home functions for effects

A very useful function for effects is Home. You can store a home position for all parameters.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record HOME</td>
<td><strong>RECORD</strong> &amp; <strong>HOME_ATTRIB</strong></td>
<td>All current parameters of the selected effect(s) are recorded as a home position.</td>
</tr>
<tr>
<td>HOME</td>
<td><strong>HOME</strong> &amp; <strong>EFFECT</strong></td>
<td>All Effect Playbacks move to their Home position. By default, this will stop all Content, Dynamic and Image effects but does not stop Chases.</td>
</tr>
</tbody>
</table>

Load an effect to a master

A single effect playback can be loaded to a master. This allows you to control the effect intensity with the master fader. If you press the master key you will select the effect.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load effect</td>
<td>[#] <strong>EFFECT</strong> &amp; <strong>master_key</strong></td>
<td>Effect # is loaded to master #</td>
</tr>
</tbody>
</table>
Effects - Soft Key Page

The EFFECT soft key provides direct keys for functions related to Effect Playbacks.

(Soft Key Pages are commands in the lower right corner of screen 2)

<table>
<thead>
<tr>
<th>Function</th>
<th>Softkey</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel Set List</td>
<td>[Channel Set]</td>
<td>Opens the Channel Set List. See Channel Sets.</td>
</tr>
<tr>
<td>Chase</td>
<td>[Chase]</td>
<td>Opens the Chase Editor. See Chase Editor.</td>
</tr>
<tr>
<td>Dynamics</td>
<td>[Dynamics]</td>
<td>Opens the Dynamics Soft key menu. See Dynamic Effects.</td>
</tr>
</tbody>
</table>
Effects - Edit

Effects are edited in the same way as moving devices.

Attribute wheels
A soon as an effect is selected the effect parameters are available on live attribute controls in parameter banks U1-U3. On Cobalt jr these can be found under the Device softkey or by using [C/Alt & [FOCUS], [COLOR], [BEAM] respectively.

Palettes
All effect attributes can be stored and played back from All Palettes. Hold RECORD and press PALETTE.

Home
You can store a home position for every effect playback. Hold RECORD and press HOME.

Fetch
You can fetch attribute values for any parameter from any preset. Hold FETCH and press the parameter wheel key, or PALETTE.

Mask
You can mask attribute values for any parameter from any effect playback. Hold MASK and press the parameter wheel key.

See Devices.
**Effects - Record**

Effects are stored in Presets in the same way devices are stored.

1. *Select the effect*
2. *Set a level*
3. *Record*

If you have the default device setting "store if active" all effect parameters are stored automatically when the intensity is over zero%.

The level of the effect playback shown and edited in the same way as channel intensities.
**Effects - Channel Distribution Wizard**

The Channel Distribution Wizard is used for **Sets** and **Chase effects**. It allows you to distribute a selection of channels into a number of parts (steps) in eight different ways.

There are two ways to open this wizard

- Press MODIFY in the PARTS cell in a channel set list or chases list.
- Create a Chase Object.

1. Select channels
2. Select number of parts
3. Select distribution method for the channels into the parts

These are the different distribution methods. Note that if the number of channels cannot be divided by the number of parts, the results will be different when using inverted distribution, since the odd channels will end up in the last part. Also, the order in which the channels are selected is the order in which they are distributed.
**Live Effects**

Press EFFECT to open Live Effects. This is where you can view and edit the parameters of all running effect playbacks in the screens. In the consoles you can control the same parameters in the Main Display over the parameter wheels.

Things to think about in this view

- Use arrow keys to navigate.
- Press MODIFY to get a drop down choice for a cell.
- Hold SELECT and use arrow keys to select several cells for data entry.
- Select effect with # EFFECT and set levels in live (A) with level wheel & functions.
- Depending on the Play Setting (Attributes) Attribute Editor Default - all entries directly in cells with # MODIFY will be treated as Absolute OR Palettes. The same goes for drop down choices (MODIFY). Hold C/ALT to get the alternate data when pressing MODIFY. See Play Settings - Attribute.
Effect Playbacks

An effect playback is the control handle for an effect, similar to a channel controlling a moving device.

All Effect Playbacks are listed and can be inserted/deleted from the Effect Playbacks list Browser >Effects >Effect Playbacks.

Create an Effect Playback

Effects can be created from the Effect Playbacks list, or as a key command.

1. Create an Effect Playback

   - Press INSERT in the Effect Playback list
   - Hold INSERT & EFFECT

2. Select type of Playback (Cannot be changed once inserted, to change you need to delete and reinsert the playback).
3. Done. You can now control the effect. See Select & Activate Effects.
**Effect Overview**

The effect overview tab lists all types of data objects that can be involved in creating and editing effects. It's opened from the Browser > Effects > Effect Overview.

- Groups
- Series
- Channel Sets
- Playbacks
- Chases
- Dynamic templates

Press MODIFY in any cell to open the corresponding editor.
Chase Effects

This is a step based, defined intensity effect. A chase is what you use when you want lights to chase on/off in a specific pattern.

Each step contains channels, step times and step levels.

You can define a high level for all channels in a step, and a low level which will be the background level of these channels in all steps.

Components
To start a Chase effect you need

- A Chase Object
- A Chase Effect Playback

Chase object
• Contains the channel list and the high/low intensity levels and timing values.
• It has a number of steps, with channels, up, dwell and down times.
• Intensities per step have a Max (high) and Min (low) value.
• Once a Chase object is programmed it will replay in the exact same way.

Playback

• The effect will run as soon as the effect playback intensity is over zero.
• The intensity level of the effect playback also masters the high level of the output of the effect.
• The intensities will contribute to the Live output on a HTP basis.

Live Parameters
A single Chase Effect Playback can be associated with any Chase object. To play back more than one Chase object simultaneously you need to insert multiple Chase Effect Playbacks.

• Change direction (Forward, Backward, Bounce, Random)
• Change every step time and content
• Change playback style (Positive, Negative, Build)

Create a Chase

Chases are created in the chase channel distribution wizard.

1. Open the Channel Distribution Wizard. This can be done in two ways.

   • # INSERT & EFFECT.
   • Press INSERT in the Chase List
   • In the Chase List, press MODIFY in the STEPS cell.
2. Select channels, parts, name and distribution. See Channel Distribution Wizard.

3. You can now start the chase, by selecting it and setting a level over zero. See Select & Activate Effects.

It will use the default times and values. These can be edited in the Chase Editor and the Chase Step Editor.

Copy a chase effect

You can use the COPY function to duplicate a chase effect.

1. Open the chase editor and select the chase you wish to copy

2. Press PASTE to create a copy at the end of the chase editor list.

Control a Chase Effect

As soon as a Chase Effect playback is selected, you can control it in two ways:
• From the console parameter wheels using U1-U3. In Cobalt jr these can be found under the Device softkey or by using [C/Alt & [FOCUS], [COLOR], [BEAM] respectively.
• From the Live Effects view.

Live Effects looks like this:

![Live Effects](image)

Press MODIFY to get a dropdown to change chase, or enter a number and press MODIFY.

**NOTE**
When you press MODIFY or enter a number it will be an absolute value or a Palette value - depending on the setting in Attribute Settings. See Play Settings - Attribute.

---

**Chase Tap Tempo**

When you select a Chase Playback, you will have two parameters, Chase # and Rate/Tap.

Press the Rate/Tap parameter key in the main display of the console to set a Rate/Tap. You can also edit this parameter in the Live Effects view.

**Chase Beat Boss**

You can assign a Beat Boss to a Chase and Content effect. It will scale the rate of the effect through a master rate that can be shared with other Chase and Content effects. The BPM will be set to 120 with the fader at 50%, 240 at the top and 0 at the bottom. To tap a BB on a fader set the FLASH key to TAP manually.

There are 9 Beat Bosses and they can be assigned to a master (see Masters - Beat Boss) and run in the Beat Boss tab(See Tab - Beat Boss).
The related Beat Boss is added as a parameter in All/U3 tabs when effects with active Beat Boss is selected.

<table>
<thead>
<tr>
<th>Chase*</th>
<th>Rate/Tap*</th>
<th>BeatBoss*</th>
<th>BB 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>C1</td>
<td>1</td>
<td>Beat boss 1</td>
<td>120</td>
</tr>
</tbody>
</table>
Chase Effect Parameters

A Chase object is never adjusted live - it is defined in two editors

- The Chase Editor
- The Chase Step Editor

CHASE EDITOR PARAMETERS

It's possible to edit a symmetrical Chase object from the Editor, without opening the Chase Step editor. However, if you want to edit the steps, or the individual step timing, you need to open the Chase Step Editor.

**Direction**

Sets the direction in which the steps are played back.

- Forward
- Backward
- Bounce
- Random

**Style**

The style decides the starting level.

- Positive (channels go from Low int to High int)
- Negative (channels go from High int to Low int)
- Build (channels go from Low int to High int and stay at High int until all steps have been executed)

**Loop Time**

This time will force a value to all Step Times = Loop Time/Steps. See Step Time further down.

**In, Dwell & Out times**

These times will force a value to all individual In, Dwell & Out times of the Chase Steps. See In, Dwell & Out times further down.

**Rate Min & Rate Max**

RateMin and RateMax work together to set the playback rate of the chase. When these values are the same, the chase is adjusted evenly. When these rates differ, the chase will play back randomly using rate values between the Min and Max value. This is a good way to create more organic chases for things like lightning and water reflections.

CHASE STEP EDITOR PARAMETERS

If you need to edit individual step times, or channels, you do this in the Chase Step Editor.

**Step Time**

This is when this step will execute in relation to the previous Step.

**In, Dwell & Out times**

These are the times for each Step.
**NOTE**
If the Step time is shorter than the sum of In+Dwell+Out you will get a "ripple" effect.

**High & Low**
Each Step has a High intensity and a Low intensity that is used by the Chase.

**Chase Editor**

The chase editor is a summary and editor of all chases. You can create (INSERT) and edit chases here.

- Press the soft key CHASE in the EFFECTS soft key menu
- Press MODIFY in the Browser node Browser >Effects >Chase.
### Chase Editor - Functions

The Chase can only be edited from the Chase Editor and the Chase Step Editor. This ensures that a Chase will always play back in the way it is defined.

<table>
<thead>
<tr>
<th>Column</th>
<th>Action</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chase</td>
<td>No Input</td>
<td>The number of this chase, cannot be edited.</td>
</tr>
<tr>
<td>Text</td>
<td>[MODIFY]</td>
<td>Enter a label.</td>
</tr>
<tr>
<td>Steps</td>
<td>[MODIFY]</td>
<td>Shows the number of steps, press MODIFY to open the Channel Distribution Wizard.</td>
</tr>
<tr>
<td>Direction</td>
<td>[MODIFY]</td>
<td>Choose between forward, backward, bounce and random.</td>
</tr>
<tr>
<td>Style</td>
<td>[MODIFY]</td>
<td>Choose between positive, negative and build.</td>
</tr>
<tr>
<td>Loop Time</td>
<td># [MODIFY]</td>
<td>Sets a total Loop time *</td>
</tr>
<tr>
<td>In</td>
<td># [MODIFY]</td>
<td>Sets an In time for all steps**</td>
</tr>
<tr>
<td>Dwell</td>
<td># [MODIFY]</td>
<td>Sets a Dwell time for all steps**</td>
</tr>
<tr>
<td>Out</td>
<td># [MODIFY]</td>
<td>Sets an Out time for all steps**</td>
</tr>
<tr>
<td>RateMin</td>
<td># [MODIFY]</td>
<td>Defines a random minimum variation for Step times***</td>
</tr>
<tr>
<td>RateMax</td>
<td># [MODIFY]</td>
<td>Defines a random maximum variation for Step times ***</td>
</tr>
</tbody>
</table>
*The Default times are applied until you define a different time in the Chase Steps Editor.
**Loop Time = the amount of time it takes to pass through all the steps of the chase once. Edit the loop time and all step times will be adjusted to evenly fit within this time value.
***RateMin and RateMax work together to set the playback rate of the chase. When these values are the same, the chase is adjusted evenly. When these rates differ, the chase will play back randomly using rate values between the Min and Max value. This is a good way to create more organic chases for things like lightning and water reflections.

### Chase Step Editor

The Chase Step Editor allows you to edit channels, levels and times for each step separately.

- Press MODIFY in the STEPS cell of the Chase Editor.
# Chase Step Editor - Functions

The Chase can only be edited from the Chase Editor and the Chase Step Editor. This ensures that a Chase will always play back in the way it is defined. Timing information on a step level overrides timing information on the Chase Editor top level.

<table>
<thead>
<tr>
<th>Column</th>
<th>Action</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step</td>
<td></td>
<td>Shows the number of each steps.</td>
</tr>
<tr>
<td>Step time</td>
<td># MODIFY</td>
<td>Sets a Step time.</td>
</tr>
<tr>
<td>In Dwell</td>
<td># MODIFY</td>
<td>Sets an In time for all steps*</td>
</tr>
<tr>
<td>Out</td>
<td># MODIFY</td>
<td>Sets a Dwell time for all steps*</td>
</tr>
<tr>
<td>High</td>
<td># MODIFY</td>
<td>Sets the High level for this step, which is applied to all channels when the step is active.</td>
</tr>
<tr>
<td>Low</td>
<td># MODIFY</td>
<td>Sets the Low level for this step, which is applied to all channels when the step is active.</td>
</tr>
<tr>
<td>Channels</td>
<td></td>
<td>Displays the channels in this step.</td>
</tr>
</tbody>
</table>

*Times set from the Chase Editor top level are edited per step here.*
Content Effects

Content effects are simply speaking simply a series of steps containing show content like palettes and presets or even raw parameter levels that you can apply to any existing group (or set) in your show.

The simplest form of content effect is the intensity series (on/off) that is created automatically when you make a new play. By applying this to a group of channels you can create chase, ripple and pulsating intensity effects on the fly. There is a default intensity content effect when you create a new play from v6.0.

Try this

1. Open Demo Tour
2. Open the Files > Training project > Demo Tour
3. Select Effect 2 (2 EFFECT)
4. In the Device Control tab set the following parameters
   - ChSource = Group
   - Group = G:1 VL Spot
   - GrpParts = Parts 6
   - Series = Intensity
5. Bring the level wheel to full - Channels 51-56 should be performing an intensity chase now.
6. Change Group to G:2 VL Wash - Channels 57-60 should be performing the same chase now.

To record press RECORD and create a preset.

A more complex example of a content effect could be "set all devices in the target group that have a color mix to blue, then pop to white two by two from sides to center" and it's easy to add two lines of code to the series to make them "fly out when they pop to white".

General

The content effect separates the channel source (group or channel set) from the actions within the
effect (series). Actions are defined using steps that can contain palettes, presets or parameters. Content effects can switch channel lists and/or series of steps independently and can be run in three different modes to change how the channel lists and steps interact with each other.

Content effects can be run in three different modes to change how the channel source and Series interact with each other.

- Break
- Continuous
- Build

See Content Effect Modes.

Components
To start a Content effect you need

- A channel source (a Group or Channel Set)
- A Series
- An Effect Playback

Playback

- All parameters can be controlled live, similar to how a device is controlled
- The effect is applied to any predefined set or group of channels.
- The effect will run as soon as the effect playback intensity is over zero.
- The intensities will contribute to the Live output on a HTP basis.
- Attributes will replay on an LTP basis with the rest of the playbacks.

Live Parameters

- Change channels (set/group)
- Change distribution of groups (parts, symmetrical, interlaced, random)
- Change Part direction (forward, reverse)
- Change Play mode (Stop, Pause, Play forward, Random etc)
- Change Mode (Continuous, Break, Build)
- Change Rate plus times (attack, release, step, etc)
- Change Rate with the wheel or with tap
Create a Content Effect Playback

1. Create a Content Effect Playback. This can be done in two ways.

- # INSERT & EFFECT and select Content.
- Press INSERT in the Effect Playbacks List, and select Content.

Now that the effect playback is created you can apply it to any channel group, or you can create channel sets and select them. You have to have a Series defined, since it is the engine of the content effects.

2. You can now start the effect, by selecting it and setting a level over zero. See Activate & Control Effects.

NOTE
The Effect playback is controlled similar to how a moving device channel is controlled. A level above 0 starts the non-intensity content and the intensity level of the playback masters the intensity levels within the effect.

Control Content Effects

As soon as a Content Effect playback is selected, you can control it in three ways:

- From the Device Controls tab- this is the absolutely easiest way.

- From the console parameter wheels using U1-U3 (In Congo Jr/Kid these are found in the Effect soft key page, or by using [C/Alt & [FOCUS], [COLOR], [BEAM] respectively).

- From the Live Effects view (if editing is enabled). <Press EFFECT.
Step around with arrow keys, press MODIFY to get a dropdown, or enter a number and press MODIFY.

NOTE
When you press MODIFY or enter a number it will be an absolute value or a Palette value - depending on the setting in Attribute Settings. See Play Settings - Attribute.

Content Effect Parameters

Besides the necessary channel source (Group or Channel Set) and Series, a number of parameters are combined to define the result of a Content effect. You can adjust all of them live by selecting the Effect Playback.

The Parameters are divided into two main groups:

- Content & Play Mode
- Timing

CONTENT & PLAY MODE PARAMETERS

Channel Source
The Channel Source that the effect is applied to can be a Set or a Group. See Channel Sets and Groups.

- The advantage with a Set is that you can define any type of custom channel distribution over the parts, and they will always replay in the same way.
- The advantage with Groups is that you can reuse all Groups you have already recorded, and create distribution and number of parts on the fly with the GrpParts and GrpDistri parameters.
Set/Group
Select a Set or Group as the Channel Source.

NOTE: There is a special option named Groups (Auto) which will set the number of parts to a selected group to the number of channels in this group - allowing for a single step chase effect.

GrpParts
If you have selected a Group as the Channel Source, this parameter defines how many parts the Group is divided into.

NOTE: There is a special option named Groups (Auto) which will set the number of parts to a selected group to the number of channels in this group - allowing for a single step chase effect.

GrpDistri
If you have selected Groups as the Channel Source, this parameter defines the channel distribution over the Group Parts. The options are the same that are available in the Channel Distribution Wizard used to create Sets. See Channel Distribution Wizard.

PartDirec
Allows you to run the Set or Group parts Forward or Backward.

Series
A list of steps that execute specific kinds of play content or parameter settings. Each step may have 4 kinds of content - Intensity + three variable slots that can contain palettes, presets or direct parameter data. Each of those four pieces of content may have their own "Attack" (fade) time within the step.

Play Mode
There are a number of play modes:

- Stop
- Pause
- Play Forward
- Play Reverse
- Bounce
- Random

The Play mode generally refers to the way the Series gets played back, so between PartDirec and PlayMode you can change the direction of the channel source but have the steps play back as written, or vice versa.

Mode
Content Effect can play back it's Series in three modes, Continuous, Break and Build. The result differs quite a lot. Some Series are set to a default mode, because they are designed to be played back this way.

- In a Continuous mode content effect, parts are always executing a step. In a three color Red-Green-Blue effect, all channels would be in one of those three colors all the time the effect is running.
- In a Build mode content effect, all parts execute step 1 before they execute step 2. Using the same series as above, all parts would become red using the step and attack times until all
channels are red, then they would each step into green until all are green, then they would start stepping into blue.

- **In a Break mode** content effect, assuming you have more parts than steps, then part 1 will execute the "active" portion of the series and when done it will fade into the Background state (step 0) and wait there (take a "break") until all the other parts have executed the active steps in the series. When using Break mode, the "sustain" and "release" times on the active steps come into play - if you think about the stadium "wave" phenomenon at football matches you'll know what I mean - the active step is to "Stand up and raise your arms" and the background state is "sit down". The attack time is how long it takes you to stand up, the sustain time is how long you remain standing, and the release time is how long it takes you to sit back down again. The background state has no timing of its own, as it is used when the channel is not doing anything else.

As you see in the example, the step time will control if each step goes into the background between steps.

![Diagram of attack, sustain, release, and background step](image)

**TIMING PARAMETERS**

**Loop Time**
This time equals how long it takes all the parts to run through the effect once. If you lengthen this time, you will impose a gap before the next pass through the effect begins. If you shorten this time, you will cause the next pass to start before the first pass is completed.

**Rate/Tap**
Use this value to scale the whole timing scheme faster or slower. Tapping the wheel key will adjust the timing of the effect to match your tapped in rate. Fade times will scale appropriately when you use tap.

**Entry**
The Entry mode decides how channels will enter into the effect.
**Step Time**
The tempo of the effect - this time determines when each step will be executed.

**Attack Time**
The fade time of the associated step or individual piece of content.

**Sustain & Release times (Break mode only)**
This time determines how long a step remains active before starting the release to the background state. If a break mode effect has more than one active step, each step may execute a sustain and release to the background only if the step time is greater than the combined attack+sustain+decay times of the step, otherwise you will only see attack times executed until the last active step.

---

**Content Effect Beat Boss**

You can assign a Beat Boss to a Chase and/or Content effect.

A Beat Boss provides a base tempo value that can be scaled by the TapRate parameter of the effect playback. Effect playbacks may share a Beat Boss, providing a way to synchronize different effects. It is not recommended to group chase and content effect playbacks together onto the same Beat Boss.

There are 9 Beat Bosses and they can be assigned to a master (see Masters - Beat Boss) and run in the Beat Boss tab (see Tab - Beat Boss).

The related Beat Boss is added as a parameter in All/U3 tabs when effects with active Beat Boss is selected.
Content Effect Return To Parameter

There is a **Return To** parameter in the Device Controls tab to specify a specific position that the effect should return when it fades out.

Select

- Master 1-80
- Main Playback field A
- Main Playback field B

When the effect handle fades out to zero, the corresponding preset will be executed with 0 time. To generate a differently timed exit from the effect in a sequence, use channel times or delay times to craft the specific behavior you need.
Series List

The engine of a content effects is a Series. Browser >Effects >Content Effect >Series.

- You can think of a series as a number of place holders for parameter and intensity data.
- Each place holder has timing data that applies when it is called upon.
- There is a special place holder called background, that is used when effects are played back in Break mode.
- The place holders are general, and can be applied to any type of channel or moving device with the same parameters.

This is the Series List, press INSERT to create a new one.
## Series List - Functions

<table>
<thead>
<tr>
<th>Column</th>
<th>Action</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Series</td>
<td>No Input</td>
<td>This item can not be changed.</td>
</tr>
<tr>
<td>Text</td>
<td>MODIFY</td>
<td>Label for this Series.</td>
</tr>
<tr>
<td>Steps</td>
<td>No Input</td>
<td>Shows the number of steps.</td>
</tr>
<tr>
<td>Def. Mode</td>
<td>MODIFY</td>
<td>Opens A dropdown where you can choose default mode Continuous, Break or Build*</td>
</tr>
<tr>
<td>Def. StepTime</td>
<td># MODIFY</td>
<td>Sets a top level Step Time for all Serie Steps**</td>
</tr>
<tr>
<td>Def. AttackTime</td>
<td># MODIFY</td>
<td>Sets a top level Attack Time for all Serie Steps**</td>
</tr>
<tr>
<td>Def. SustainTime</td>
<td># MODIFY</td>
<td>Sets a top level Sustain Time for all Serie Steps**</td>
</tr>
<tr>
<td>Def. ReleaseTime</td>
<td># MODIFY</td>
<td>Sets a top level Release Time for all Serie Steps**</td>
</tr>
</tbody>
</table>

*Often Series are written that will be used most often in a specific mode. The Default mode is applied within the Content Effect Playback automatically when the series is selected. The mode can be changed within the playback as needed.

**The Default times are applied until you define a different time in the Series Steps Editor.
**Series Step Editor**

The Series Step Editor is opened by pressing MODIFY in the Series or Steps cell of the Series List (above).

![Series Step Editor](image)

**NOTE**

When Palettes/Presets are used as content, the values will reference only to the numbers of these Palettes/Presets (not the names) - this is so that you can reuse the same series in other plays easily.

If you are doing a lot of series creation, the Groups/Palettes Overview tab is a good way to know what you have already recorded.
## Series Step Editor - Functions

<table>
<thead>
<tr>
<th>Column</th>
<th>Action</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step</td>
<td>No Input</td>
<td>This item can not be changed.</td>
</tr>
<tr>
<td>Text</td>
<td>MODIFY</td>
<td>Enter a Step Text.</td>
</tr>
<tr>
<td>Step Time</td>
<td># MODIFY</td>
<td>This is the Step Time*</td>
</tr>
<tr>
<td>Intensity</td>
<td># MODIFY</td>
<td>Set an intensity level 0-100 or nothing. A hard 0 is indicated with &quot;M&quot;.</td>
</tr>
<tr>
<td>Attack</td>
<td># MODIFY</td>
<td>Sets an Attack time for Intensity in this Step*</td>
</tr>
<tr>
<td>1. Content</td>
<td>MODIFY</td>
<td>Opens a dropdown where you can select the first content type for this step</td>
</tr>
<tr>
<td>Attack</td>
<td># MODIFY</td>
<td>Sets an Attack time for this Content in this Step*</td>
</tr>
<tr>
<td>2. Content</td>
<td>MODIFY</td>
<td>Opens a dropdown where you can select the second content type for this step**</td>
</tr>
<tr>
<td>Attack</td>
<td># MODIFY</td>
<td>Sets an Attack time for this Content in this Step*</td>
</tr>
<tr>
<td>3. Content</td>
<td>MODIFY</td>
<td>Opens a dropdown where you can select the third content type for this step**</td>
</tr>
<tr>
<td>Attack</td>
<td># MODIFY</td>
<td>Sets an Attack time for this Content in this Step*</td>
</tr>
</tbody>
</table>

*All Step timing is set to 100% of the Default times in the Series (one level up).
Content Effect Modes

A Content Effect can play back its Series in three different modes:

- Break
- Continuous
- Build

In the Series Editor you can define a default mode that is set every time the Series is activated. It's possible to change this mode on the fly when you edit the Effect Playback parameters. See Series List.

What mode do I use?

The modes allow you to get completely different results, using the same Series. The beauty of the Content Effect is that it allows you to get very specific results with little programming effort. We can provide some examples, but the whole idea is that you create your own unique effects using this powerful tool.

EXAMPLES OF APPLICATIONS

"All in blue, then pop to white one by one"
This can be done with a Content Effect in Break mode, with just a Background state (blue) and one step (white).

In this example color palettes 1 (blue) & 2 (white) were used. It could have been absolute values for Cyan, Magenta and Yellow as well.

"A fly out"
This can be done with a Content Effect in Break mode with a starting point (usually pointing down with no intensity and two steps, 1) to turn the intensity on and move to the "away" position and 2) to turn the channels off again before they return to the background state.
A fly out can be done with a Dynamic Effect, but you have no control over the specific start and end points for each device. Here this is easy to change at any time by re-recording either of the two focus palettes used.

"An RGB chase"
This can be done with a Content Effect in **Continuous** mode with three steps, (color palettes "red", "green", "blue").

In this example Color Palettes are used, although we could have used absolute values for CMY just as well.

"An intensity ripple chase"
This can be done with a Content Effect in **Break** mode, with just a Background state (intensity = 0) and one step (intensity = full).
It is the combination of the parts distribution and the step timing that creates the overlapping ripple behavior. If the Attack+Sustain+Decay time is greater than the step time, you get ripple (overlapping) behavior. The number of Parts in the Channel Source will define how "wide" the ripple is.

## Content Effect Times

Timing information is set in two levels

- In the Series List
- In the Series Step Editor

In the **Series list**, the default times are

- Default Step Time
- Default Attack Time
- Default Sustain Time (Break mode only)
- Default Release Time (Break mode only)

See **Series List**.

In the **Series Step editor**, the times are

- Step Time
- Attack Time (separate for Intensity and each content 1-3 in each step)
- Sustain Time (Break mode only) per step
- Release Time (Break mode only) per step

See **Series Step Editor**.
**Dynamic Effect**

A dynamic effect is a relative effect that uses a dynamic template which applies wave-forms around a base point to create a movement, for example a circle or ballyhoo. In the same way as the content effect, it is applied to any group or set.

### Components

To start a Dynamic effect you need

- A Group or a Channel Set
- A Dynamic Template (many are supplied default)
- An Effect Playback

### Playback

- All parameters can be controlled live, similar to how a device is controlled
- Once programmed you can also change the Dynamic Template (circle, ballyhoo) or create your own.
- The effect is applied to any predefined set or group of channels.
- The effect will run as soon as the effect playback intensity is over zero.
- The intensities will contribute to the Live output on a HTP basis.
- Attributes will replay on an LTP basis with the rest of the playbacks.

### Live Parameters

- Change channels (set/group)
- Change distribution (offset, delay, distribution)
- Change Rate & Size
- Store and recall all settings into palettes and presets, similar to how any device is controlled.

A number of common Dynamic Effect Templates are included in the Effect Library of the Browser. It is possible to create new ones as well. If you are acquainted with SmartFade effects, you will find that SFML style tables and effects have been added to the library.

### Waveforms - Dynamic Templates & Tables

Dynamics are a way of creating effects by assigning *waveforms* (sinus, saw etc) to intensity, color, movement or any other parameter. you can define custom tables. See [Dynamic - Tables](#).
Examples:

![Sine Wave](image1.png) ![Saw Tooth Wave](image2.png)

The waveform will "run" the parameter it is assigned to, but you can still move the "base value" of the parameter that the Dynamic is working with.

**NOTE**

To create a movement, like a "Circle" for a moving Device, two sinus waves are applied to pan and tilt, and one of them is offset 25%.

---

**Create a Dynamic Effect Playback**

1. Create a Dynamic Effect Playback. This can be done in two ways.
   - # INSERT & EFFECT and select Dynamic.
   - Press INSERT in the Effect Playbacks List, and select Dynamic.

   Now that the effect playback is created you can apply all existing Dynamic templates to any channel group, or you can create channel sets and select them. The Effect playback is controlled similar to how a moving device is controlled. Select the effect and use the parameter wheels or the Live Effects editor.

2. Select the Effect, to start is set a level over zero. See [Select & Activate Effects](#).

---

**Control a Dynamic Effect**

As soon as a Dynamic Effect playback is selected, you can control it in two ways:

- From the console parameter wheels using U1-U3. On Cobalt jr these can be found under the Device softkey or by using [C/Alt & [FOCUS], [COLOR], [BEAM] respectively.
- From the Live Effects view.
Live Effects looks like this:

![Live Effects screenshot]

Step around with arrow keys, press MODIFY to get a dropdown, or enter a number and press MODIFY.

**NOTE**

When you press MODIFY or enter a number it will be an absolute value or a Palette value - depending on the setting in Attribute Settings. See Play Settings - Attribute.

---

**Dynamic Effect Parameters**

A number of parameters are combined to define the result of applying a Dynamic Template to a channel Set or Group. You can trim all of them live by selecting the Effect Playback.

- **Channel Source**
  This can be a Set or a Group. See Channel Sets and Groups.

- **Set/Group**
  Select which Set or Group.

- **Dynamic Template**
  Templates are pre-defined in the Dynamic Templates editor. You can create your own as well. See Dynamic Templates.

- **Size and Rate**
  The Size relates to how much the values will vary in relation to the base point. Rate defines fast the result is. See Dynamics - Size & Rate.
Offset
The offset parameter distributes the channels along the waveform. See the example with 5 channels on a sine wave. See Dynamics - Relations & Distance.

Delay Relation & Distance
The Delay Relation defines when each channel starts in relation to the next. The Distance defines how long each channel will travel before the next is started. These two work together. If Delay Relation is set to ALL there will be no change, since distance needs at least two parts. See Dynamics - Relations & Distance.
**Dynamic Templates**

Dynamic Templates are definitions of waveforms applied to parameters used for Dynamic Effects.

Open from the Browser >Effects >Dynamic Effect > Dynamic Templates.

---

**Dynamic Effect Library - Columns & Functions**

<table>
<thead>
<tr>
<th>Column</th>
<th>Input</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Effect</td>
<td>MODIFY</td>
<td>Starts the selected Effect for the currently selected channel(s).</td>
</tr>
<tr>
<td>Text</td>
<td>MODIFY</td>
<td>Press MODIFY to activate and end text input.</td>
</tr>
<tr>
<td>Parameters</td>
<td>MODIFY</td>
<td>Opens the Dynamic Template editor. See <strong>Dynamic Template Editor - Create</strong>.</td>
</tr>
<tr>
<td>OffsRel</td>
<td>MODIFY</td>
<td>See <strong>Relations &amp; Distance</strong></td>
</tr>
<tr>
<td>DelayRel</td>
<td>MODIFY</td>
<td>See <strong>Relations &amp; Distance</strong></td>
</tr>
<tr>
<td>Distance</td>
<td>#, MODIFY</td>
<td>See <strong>Relations &amp; Distance</strong></td>
</tr>
</tbody>
</table>

---

**Dynamic Template Editor - Create**

1. Open the Effect Library from the Browser >Effects >Dynamic Effect > Dynamic Templates

2. Go to the last step using the arrow keys.

3. Press INSERT to create a new Template.
4. Go to **TEXT** and press MODIFY to enter a name. Press MODIFY again to confirm.

5. Go to **Parameters** and press MODIFY to open the Template Editor.

6. Press INSERT to create a step. Each step contains the settings for a single parameter - for example, a pan/tilt effect would have two steps.

![Dynamic Template Editor](image)

See [Dynamic Template Editor - Functions](#).

**Dynamic Template Editor - Functions**

<table>
<thead>
<tr>
<th>Column</th>
<th>Input</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ch.Index</td>
<td>#</td>
<td>0 means all selected channels are affected by this step. For numbers &gt;0 only channels that match this index number will be activated. For example &quot;2&quot; means that only every second channel will be affected (of the selected channels).</td>
</tr>
<tr>
<td>Parameter</td>
<td>MODIFY</td>
<td>Opens a dropdown. Select which parameter this step shall affect.</td>
</tr>
<tr>
<td>Table</td>
<td>MODIFY</td>
<td>Opens a dropdown. Select which table this step should apply. See <a href="#">Dynamics - Tables</a>.</td>
</tr>
<tr>
<td>Delay</td>
<td>MODIFY</td>
<td>A delay in % before the step starts to move</td>
</tr>
<tr>
<td>Offset</td>
<td>MODIFY</td>
<td>An Offset in % where in the table this step starts</td>
</tr>
<tr>
<td>Size</td>
<td>#</td>
<td>See <a href="#">Size &amp; Rate</a></td>
</tr>
<tr>
<td>Rate</td>
<td>#</td>
<td>See <a href="#">Size &amp; Rate</a></td>
</tr>
<tr>
<td>Wait</td>
<td>#</td>
<td>A wait time, in percent (1-1000%) for this step before it is repeated. The Wait time is relative to all other steps.</td>
</tr>
</tbody>
</table>
Dynamic Tables

The basic element of a Dynamic effect is a wave-form, or "table", that is assigned to the intensity or any other attribute parameter of a channel.

A Sine wave, for example, will fade a parameter up/down continuously over/under the current Base Value.

By changing the Rate and Size of this Sine Wave, you will affect the speed and value range of the result.

Although the idea of tables is very technical, it really requires little technical understanding: most designers prefer to experiment with different tables and parameters to understand - the effect of a Sine Wave is too different on a color parameter, compared to pan or intensity, to explain in detail here.

These are the tables

<table>
<thead>
<tr>
<th>Table</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stop</td>
<td>A &quot;Stop Dynamics&quot; table</td>
</tr>
<tr>
<td>Sine</td>
<td>A normal sinus wave</td>
</tr>
<tr>
<td>Step</td>
<td>An &quot;on-off&quot; wave</td>
</tr>
<tr>
<td>Sawtooth</td>
<td>A linear &quot;fade up - fade down&quot; wave</td>
</tr>
<tr>
<td>Ramp</td>
<td>A &quot;fade up-cut down&quot; wave</td>
</tr>
<tr>
<td>RampInv</td>
<td>A &quot;cut up - fade down&quot; wave</td>
</tr>
<tr>
<td>MarkOn</td>
<td>&quot;On-longer-than-off&quot; used for fly-in or fly-outs</td>
</tr>
<tr>
<td>MarkOff</td>
<td>&quot;Off-longer-than-on&quot; used for fly-in or fly-outs</td>
</tr>
<tr>
<td>Spiral</td>
<td>A sinus wave with varying amplitude</td>
</tr>
<tr>
<td>Tangent</td>
<td>A sinus wave with a &quot;sharp top&quot;</td>
</tr>
<tr>
<td>Random1</td>
<td>Random curve 1</td>
</tr>
<tr>
<td>Random2</td>
<td>Random curve 2</td>
</tr>
<tr>
<td>Random3</td>
<td>Random curve 3</td>
</tr>
</tbody>
</table>

**NOTE**

If you are used to working with for example WholeHog (tm) Tables, a Sine + 90 degrees is a Sine with an offset of 25% here.

Table Editor

Press INSERT to create new tables at the end of the table list in the Browser, but not delete existing ones since this would mess up the indexing of existing tables used by effects.
Pressing MODIFY on a table opens the Dynamic Table Editor where you can insert and delete table values. You cannot have more than 64 points in a table.

This is the Dynamic Table editor with a Step table.
**Live Dynamics (old)**

This tab is used with the old Dynamic Effects package from Congo. See [Dynamics (old)](#).

All parameters of running Dynamic Effects can be edited in the Live Dynamic Effects tab. This tab can be opened from the Browser (Browser > Live Dynamic Effects).

The top right corner shows a pan/tilt monitor with a dot representing each channel. This is a visualisation for the Offset Relation, Delay Relation and Distance values.

NOTE

If you start to select channels in Live Dynamics, you will get a popup if you want the selection to affect the running effect or not. Once you have said yes to this, all channel selection will update the running effect until you close and reopen Live Dynamics.

RECORD and UPDATE cannot be used when this tab is focused. Select LIVE to use them.
# Live Dynamic Effects - Columns

<table>
<thead>
<tr>
<th>Column</th>
<th>Input</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Library</td>
<td>[MODIFY]</td>
<td>Opens a dropdown to select a Dynamic Effect from the Effect Library.</td>
</tr>
<tr>
<td>Status</td>
<td>No input</td>
<td>Running status. Cannot be edited.</td>
</tr>
<tr>
<td>Channels</td>
<td>No input</td>
<td>The amount of channels assigned to this Dynamic Effect.</td>
</tr>
<tr>
<td>Size</td>
<td>[MODIFY]</td>
<td>Set the size from 1-1000%. See Size &amp; Rate</td>
</tr>
<tr>
<td>Size Channel</td>
<td>[MODIFY]</td>
<td>Assign a size channel. See Size &amp; Rate</td>
</tr>
<tr>
<td>Rate</td>
<td>[MODIFY]</td>
<td>Set the rate from 1-1000%. See Size &amp; Rate</td>
</tr>
<tr>
<td>Rate Channel</td>
<td>[MODIFY]</td>
<td>Assign a rate channel. See Size &amp; Rate</td>
</tr>
<tr>
<td>Offset Relation</td>
<td>[MODIFY]</td>
<td>See Relations &amp; Distance</td>
</tr>
<tr>
<td>Delay Relation</td>
<td>[MODIFY]</td>
<td>See Relations &amp; Distance</td>
</tr>
<tr>
<td>Distance</td>
<td>[MODIFY]</td>
<td>See Relations &amp; Distance</td>
</tr>
<tr>
<td>Text</td>
<td>[MODIFY]</td>
<td>Press MODIFY to activate and end text input.</td>
</tr>
<tr>
<td>Fade</td>
<td>[MODIFY]</td>
<td>See Fade</td>
</tr>
<tr>
<td>Loop Count</td>
<td>[MODIFY]</td>
<td>See Loop Count</td>
</tr>
<tr>
<td>Form</td>
<td>[MODIFY]</td>
<td>See Form</td>
</tr>
</tbody>
</table>

733
Old Dynamic Effects

The old Dynamic Effects prior to Cobalt v5 are still compatible and work in the same way. They are much more limited, so we recommend you to use the new ones unless you are importing an older Play.

This chapter contains the following sections

- Dynamics - Base Value
- Dynamics - Start
- Dynamics - Control
- Dynamics - Stop
- Dynamics - Record
- Dynamics - Preset Dynamics
- Dynamics - Size & Rate
- Dynamics - Relations & Distance
- Dynamics - Loop Count
- Dynamics - Fade
- Dynamics - Form
- Dynamics - Fetch from A Preset
- Dynamics - Playing Back
- Dynamics - Store Running
**Dynamics - Base Value**

When a Dynamic Effect is activated, it will run with the current position of the corresponding attribute or intensity as a Base Value.

If you change this Base Value, the Dynamic Effect will follow. If you run a Preset with a Dynamic Effect and then run another Preset with a new base value, the default action is for the Dynamic Effect to fade out. Use the Keep Dynamics setting to allow the Dynamic Effect to play through Presets. See Record Keep Dynamics.

If a pan/tilt effect such as Circle is running for a moving Device, you can change the Base Value by moving Pan and Tilt, or by selecting a Focus Palette.

**NOTE**
If the Base Value is too small, some effects will not be visible, for example color mix and intensity effects. Set the Base Value to 50% for maximum effect.
Dynamics - Start

Dynamics are activated for the currently selected channel(s). The current attribute and intensity values are used as the Base Value for the Dynamic Effect.

A "D" will appear in the top right corner of the channel symbol.

NOTE
Activating a Dynamic Effect will "lock" the attributes and intensities of the selected channels to the Dynamic Effect. See Dynamics - Stop.

Start Dynamics By Number

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Dynamic Effect #</td>
<td># DYN EFFECT</td>
<td>Dynamic Effect # is activated for the currently selected channel(s).</td>
</tr>
</tbody>
</table>

Start Dynamics From The Effect Library Tab

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Open Effect Library</td>
<td>MODIFY A DYN EFFECT</td>
<td>The Effect Library tab is opened.</td>
</tr>
<tr>
<td>2. Select Effect</td>
<td>Arrow Keys Up/Down</td>
<td>The selected Effect is highlighted.</td>
</tr>
<tr>
<td>3. Start Effect</td>
<td>MODIFY</td>
<td>The selected Effect is activated for the currently selected channel(s).</td>
</tr>
<tr>
<td>4. Exit Effect Library</td>
<td>ESC</td>
<td>The Effect Library tab is closed.</td>
</tr>
</tbody>
</table>
Start Dynamics From The Effect Library Node

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select the Browser</td>
<td>[BROWSER]</td>
<td>The Browser is selected and highlighted. If it was already selected it is closed. Press again to open.</td>
</tr>
<tr>
<td>2. Go to the Effect Library node</td>
<td>Arrow keys Up/Down</td>
<td>The Effect Library node is highlighted.</td>
</tr>
<tr>
<td>3. Open the Effect Library node</td>
<td>Right arrow</td>
<td>The Effect Library node is opened.</td>
</tr>
<tr>
<td>4. Select an Effect</td>
<td>Down arrow</td>
<td>The selected Effect is highlighted</td>
</tr>
<tr>
<td>5. Start the Effect</td>
<td>[LOAD]</td>
<td>The selected Effect is activated for the currently selected channel(s).</td>
</tr>
</tbody>
</table>

Start Dynamics From The Direct Selects

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select Dynamics for a section</td>
<td>[TYPE] &amp; Dynamics</td>
<td>When TYPE is held you can select Dynamics for a section. The first ten dynamics are displayed in the section immediately.</td>
</tr>
<tr>
<td>2. Activate a Dynamic</td>
<td>Section keys 1-10</td>
<td>The selected Effect is activated for the currently selected channel(s).</td>
</tr>
</tbody>
</table>

See Direct Selects.

Start Dynamics With Direct Mode

1. Hold DYN EFFECT (don't let go until the Dynamics are started).

   - When this is held, the first 40 Dynamic Effects in the Effect Library are displayed on the Direct Select keys.

2. Activate a Dynamic by pressing the corresponding key

3. Let go of DYN EFFECT.
Dynamics - Control

The Dynamics Soft Key Page in the Main Display of the console facepanel is opened by pressing DYNAMICS in the Effects soft key page.

It has the following functions for controlling live Dynamics:

- Clear Dynamics Soft Keys
- Dynamic Wheels
- Delete Selected Dynamics in Display List (soft key)
- Keep Dynamics in next Preset (soft key)
- Set Distance in % (soft key)

Clear Dynamics Soft Keys

The Clear Dynamics soft keys are used to clear and/or stop running Dynamics.

- Select All active Dynamics (SELECT ALL)
- Clear all Selected Dynamics (CLEAR SELECT)
- Delete All running Dynamics (DELETE ALL)

See Dynamics - Stop.
Dynamic Wheels - Size, Rate, Offset & Delay

Wheels 1 and 2 are used to set Size and Rate for Live Dynamics. See Dynamics - Size & Rate.

- Select channels and set values.
- Set numerical values with # and Wheel Key.

Wheels 3 and 4 are used to set Offset and Delay relations. See Dynamics - Relations & Distance.

- Hold the key and use the wheel.

Keep Dynamics In Next Preset

The KEEP DYNAM soft key is used to record a new base position for a running Dynamic Effect. See Record Keep Dynamics (New Base Value).

Set Distance In %

The DISTANCE soft key is used to set the Distance % parameter for the selected running Dynamics directly. See Dynamics - Relations & Distance.
Dynamics - Stop

Dynamic Effects can be stopped in the following ways.

- Stop Dynamics manually
- Activate A Dynamic Stop Table
- Delete the Dynamic from Live Dynamic Effects
- Delete the Dynamic using the Dynamics display
- Fade in a Preset in the Main Playback
- Load a new Sequence to the Main Playback*

*Providing the Auto-Stop parameter in the System Settings is set to ON. See System Settings.

Moving Device attributes are stopped automatically when a new value is played back from any Playback or Master. Intensity Dynamics can only be stopped with the Stop Dynamics table of the manual stop functions.

NOTE
Dynamic Effects act like Attributes - they are executed in A or B depending on the GoOnGo or GoInB flag of the step.
See Device Playback - GoOnGo or GoInB.

There is also an option in Settings to have them always start on GO. See Settings - Crossfade.

Stop Dynamics Manually

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Select channels</td>
<td>Channel</td>
<td>The selected channels are highlighted in the Channel View</td>
</tr>
<tr>
<td>2. Stop Dynamics</td>
<td>C/Alt &amp; DYN EFFECT</td>
<td>All Dynamics are cleared for the selected channel(s)</td>
</tr>
</tbody>
</table>

This is a shortcut to select all channels with Dynamics assigned to them.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select all channels with dynamics</td>
<td>CHANNEL &amp; DYN EFFECT</td>
<td>All selected channels are highlighted in the Channel View</td>
</tr>
</tbody>
</table>
Activate A Dynamic Stop Table

Intensity Dynamics can only be stopped by assigning a Stop Intensity Table. There is a STOP I Dynamic in the Effect Library for this.

1. Select the channels

2. Assign the "STOP I" Effect (See Dynamics - Start)

You can record this to the Preset in the A field of the Main Playback. When the Preset with this Stop Table is activated, the Intensities will fade the size of the Dynamic Effect using the IN time of this Preset.

Delete A Dynamic From Running Dynamics

1. Open the Live Dynamic Effects Tab from the Browser.

2. Select a Dynamic effect with the arrow keys

3. Press DELETE to stop (a popup will ask for confirmation)
4. Press MODIFY to confirm.

Fade In A Preset In The Main Playback

When a Preset with new attribute values is faded in the Main Playback, any active Dynamics for those attributes will be stopped.

Load a new Sequence to the Main Playback

When a new Sequence is loaded to the Main Playback, all running Dynamics are stopped the next time GO is pressed.
**Dynamics - Record**

Dynamic Effects are recorded in Presets for playback.

- Only Dynamics that have changed or are started since you last pressed RECORD will be stored.
- Record Mode should be set to AUTOMATIC for attributes.
- A "Keep Dynamic" flag can be set to a Preset. This will allow the Dynamic to move to new base values without stopping the Dynamic.

**Record Changed Dynamics**

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record* Dynamics to Preset #</td>
<td>[#] [RECORD]</td>
<td>All channels are recorded including all running Dynamics to Preset #</td>
</tr>
</tbody>
</table>

*Record Mode has to be set to Automatic for Attributes - See Devices - Recording Modes.

**Record Dynamics To Another Preset**

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record* Dynamics to Preset #</td>
<td>[#] [RECORD] &amp; [DYN EFFECT]</td>
<td>All changed and/or selected channels are recorded with running Dynamics to Preset #</td>
</tr>
</tbody>
</table>

*Record Mode has to be set to Automatic for Attributes - See Devices - Recording Modes.

**Record Dynamics To A Master**

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record* Dynamics to Master #</td>
<td>[RECORD] &amp; [Master Key]</td>
<td>Selected channels are recorded including running Dynamics to Master # as the next free Preset.</td>
</tr>
</tbody>
</table>

*Record Mode has to be set to Automatic for Attributes - See Devices - Recording Modes.
Record Keep Dynamics (New Base Value)

**Keep Dynamics** will set a Keep Dynamics flag to an existing Preset. When this Preset is played back in a Sequence it will change the Base Values for a running Dynamic Effect without stopping it.

There are two ways of setting this. From a checkbox in the Recording Popup, or from the Dynamics Soft Key page (described below). See [The Recording Popup](#).

1. **Select the Dynamics Soft Key Page in the Main Display of the console facepanel by pressing DYNAMICS in the top menu.**

![Dynamics Soft Key Page](image)

2. **Press KEEP DYNAM.**

The Currently running dynamics are stored with a Keep Dynamics flag in the Preset active in the A field of the Main Playback. Keep dynamics is shown with a waved line under the value in the Preset Attribute Editor.

You can store to a different Preset by entering a number before Keep Dynam. The Preset has to be recorded first.

**NOTE**

You can set a Keep Dynamics flag for a parameter group (Focus, Color, Beam) by holding KEEP DYNAM and pressing either of these keys.
Dynamics - Preset Dynamics Editor

The Preset Dynamics Editor is identical to the Live Dynamics Editor. All editing functions are the same. See Dynamics - Edit Live Dynamic Effects.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Preset Dynamics Editor for Preset #</td>
<td># [PRESET] &amp; [DYN_EFFECT]</td>
<td>Dynamic Editor for Preset # is opened.</td>
</tr>
<tr>
<td>Open Preset Dynamics Editor for the Preset in A</td>
<td>PRESET &amp; [DYN_EFFECT]</td>
<td>Dynamic Editor for the Preset in A is opened</td>
</tr>
<tr>
<td>Open Preset Dynamics Editor for the Preset in A</td>
<td>[DYN_EFFECT] &amp; [A]</td>
<td>Dynamic Editor for the Preset in A is opened</td>
</tr>
<tr>
<td>Open Preset Dynamics Editor for the Preset in B</td>
<td>[DYN_EFFECT] &amp; [B]</td>
<td>Dynamic Editor for the Preset in B is opened  (4.2)</td>
</tr>
</tbody>
</table>

NOTE
You can open this editor in two more ways

- Double-click on "Dyn:#" in the Sequence Playback View
- Press MODIFY in the Dynamics Column of a Preset List
Dynamics - Size & Rate

Each Dynamic Effect has a Size (amplitude) and Rate (frequency) value. It is possible to assign an intensity channel to each of them.

You can set Size and Rate for running Dynamic Effects with the wheels in the Dynamics Soft Key Page. See Dynamics - Control.

NOTE
From 4.2 it is no longer possible to modulate the size or rate of a dynamic effect using another intensity dynamic effect on the size/rate channel. This may change the behaviour of existing plays if this rare feature has been programmed.

Size

Sets the size (amplitude) of the waveforms in a Dynamic Effect. It is set from 0-1000%.

Size Channel

Any channel can be set to control the Size of a Dynamic Effect. At 50% it does not affect the programmed Size at all. At 0% the Effect is stopped, and at 100% the Size is doubled.

The channel is marked with SIZE in the Channel Views.
Rate

Sets the rate (frequency) of the waveforms in a Dynamic Effect. It is set from 0-1000%.

You can also change this parameter with the second parameter wheel in the Dynamics Soft Key Page (press DYNAMICS in the Index Page).

It can also be set in the Preset- and Live Dynamic Effects tabs. See Live Dynamic Effects and Preset Dynamic Effects

Rate Channel

Any channel can be set to control the Rate of a Dynamic Effect. At 50% it does not affect the Rate at all. At 0% the Effect is stopped, and at 100% the Rate is doubled.

The channel is marked with RATE in the Channel Views.
Dynamics - Relations & Distance

Offset Relation, Delay Relation and Distance set all channels to perform a Dynamic one after the other, or overlapping.

These parameters can be set in the Live Attribute editor and from the Dynamic Display soft key page.

Offset Relation

Specifies when channels start in relation to the table assigned to them

Offset is set in the Dynamic Effect views (Live and Preset). Press MODIFY in either for a dropdown with the following options

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>All devices start at the same point in the table.</td>
</tr>
<tr>
<td>Evenly Spread</td>
<td>The starting point (offset) is evenly spread.</td>
</tr>
<tr>
<td>1:2-1:9</td>
<td>The selected devices are divided in # groups (1:#).</td>
</tr>
</tbody>
</table>

Offset Relation - Dynamics Display

In the Dynamics Display the Offset Relation for the selected Dynamic Effect is mapped to wheel 3.

Activate the Dynamics Soft Key Page in the Main Display of the console facepanel by pressing DYNAMICS in the top menu.

1. Hold wheel key 3 to get a list of Offset Relations in the display.

2. Select a relation using the wheel.
3. Let go of the Key to activate the current selection.

Delay Relation & Distance

Specify when channels start in relation to each other.

<table>
<thead>
<tr>
<th>Delay Relation</th>
<th>Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>100 %</td>
</tr>
<tr>
<td>Evenly Spread</td>
<td></td>
</tr>
<tr>
<td>1:2</td>
<td></td>
</tr>
<tr>
<td>1:3</td>
<td></td>
</tr>
<tr>
<td>1:4</td>
<td></td>
</tr>
<tr>
<td>1:5</td>
<td></td>
</tr>
<tr>
<td>1:6</td>
<td></td>
</tr>
<tr>
<td>1:7</td>
<td></td>
</tr>
<tr>
<td>1:8</td>
<td></td>
</tr>
<tr>
<td>1:9</td>
<td></td>
</tr>
</tbody>
</table>

Delay Relation and Distance are set in the Dynamic Effect views (Live and Preset). Press MODIFY in Delay Relation for a dropdown with the following options:

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>All devices start at the same time.</td>
</tr>
<tr>
<td>Evenly Spread</td>
<td>The starting time is evenly delayed.</td>
</tr>
<tr>
<td>1:2-1:9</td>
<td>The selected devices are divided in # groups (1:__).</td>
</tr>
</tbody>
</table>

Distance specifies the time (in percent) between the starting point of each channel when the Delay Relation is used.

Delay Relation & Distance - Dynamics Display

In the Dynamics Display the Delay Relation is mapped to wheel 4. There is a soft key for setting the Distance parameter directly with a numeric value.

Activate the Dynamics Soft Key Page in the Main Display of the console facepanel by pressing DYNAMICS in the top menu.

1. Hold wheel key 4 to get a list of Delay Relations in the display.

2. Select a relation using the wheel.

3. Let go of the key to activate the current selection.

Enter a number and press DISTANCE to set the Distance value 0-100%.
**Dynamics - Loop Count**

A Dynamic Effect can be set to run a specific number of loops and then stop automatically. If set to 0 it will run forever.

This is done in the *Loop Count* column of the Dynamic Effects tabs.

See [Dynamics - Live Dynamic Effects](#) and [Dynamics - Preset Dynamic Effects](#)
Dynamics - Fade

A Dynamic Effect can fade in size, rate or both when played back in a Sequence. When faded manually in a Master Playback, size will follow the fader (0-100%).

The Fade parameter is set in the Live and Preset Dynamic Effect tabs in the Fade column.

<table>
<thead>
<tr>
<th>Action</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size (default)</td>
<td>MODIFY</td>
<td>Size will fade in (and out) on the time for the corresponding attribute.</td>
</tr>
<tr>
<td>Rate</td>
<td>MODIFY</td>
<td>Rate will fade in (and out) on the time for the corresponding attribute.</td>
</tr>
<tr>
<td>S &amp; R</td>
<td>MODIFY</td>
<td>Size &amp; Rate will fade in (and out) on the time for the corresponding attribute.</td>
</tr>
<tr>
<td>None</td>
<td>MODIFY</td>
<td>Size and Rate will snap directly to the values of the dynamic effect. Activating a new attribute value will stop a corresponding dynamic directly.</td>
</tr>
</tbody>
</table>

Intensity Dynamics

When a Stop Table is activated, the Dynamic Effect will fade out on the in time of the corresponding sequence step. If the Stop Table is assigned manually, the effect will snap out.

Attribute Dynamics

When new attribute values are played back from the Sequence, they will fade from the Dynamic in the attribute time of that Sequence Step. When they reach zero the Dynamic is deleted automatically.

See Dynamics - Live Dynamic Effects
See Dynamics - Preset Dynamic Effects
**Dynamics - Form**

Form specifies the relation between the size for the Pan and Tilt parameters. It is used to control the behaviour of Pan/Tilt combinations like a Circle.

Normal value is 100 (displayed as "F:F") which means that both Pan and Tilt are equal in size.

- If you enter a value between 0 and 99, this will be used as the size for the Pan parameter showed as "0:F" to "99:F".
- If you enter a value between 101 and 200, this will be used as the size for the Tilt parameter showed as "F:99" to "F:0".

Think of it as a continuous scale from a vertical movement through the full circle to a horizontal movement.

This is done in the Form column of the Live- and Preset Dynamic Effects tab.

![Form](F:F)

See [Dynamics - Live Dynamic Effects](#)

See [Dynamics - Preset Dynamic Effects](#)
Dynamics - Fetch From A Preset

Dynamics can be copied from any Preset. All channels with Dynamics in that Preset will be copied.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fetch Dynamics from Preset #</td>
<td>[#] ON/FETCH &amp; DYN EFFECT</td>
<td>Dynamics in Preset # are activated. A &quot;D&quot; will appear next to the involved channels in the Channel View.</td>
</tr>
</tbody>
</table>
Dynamics - Playing Back

A Preset with Dynamic Effects can be played back in any of these ways:

- The Preset is faded in on a Sequence Step
- A Master with the Preset is faded up (size follows the Master fader).
- A Master with the Preset is Flashed

General Facts

- When activated, Dynamic Effects fade to the initial value including the Offset.
- If the attributes are masked, the Dynamic will start anyhow.
- Dynamics run until Deleted or Size is set to zero.
- Device Dynamics will stop if new attributes are faded in a Sequence Step.
- IMPORTANT SETTING: *Always Start Dyn On Go* (Crossfade Settings) =>*When activated from a Sequence Step, dynamic effects are always started on Go regardless of the GoOnGo setting for the sequence step.*

See Dynamics - Stop.
Dynamics - Store Running To Library

Running Dynamics can be stored as a Dynamic Template in the Effect Library and be reused with different channels.

1. Open the Dynamic Effect Library by holding MODIFY and pressing DYN EFFECT, or from the Browser (Browser >Effects >Dynamic Effects >Dynamic Templates)

2. Go to the end of the list (arrow keys).

3. Press INSERT. You will get the question "Record running dynamics as a Dynamic Template?".

If you answer OK, the dynamics for the currently selected channels (in the selection order) will be used as a base for creating the new Dynamic Template.

If you answer CANCEL you will get an empty Dynamic Template.

4. Enter a name in the text column (press MODIFY to activate, enter text and press MODIFY to confirm).

5. Exit by pressing ESC.
Image Effects

Image effects allow you to map a text, an image (jpg/gif) or an animation (supplied) to the intensity or color of a predefined effect layout of channels. This can be used to create abstract or absolute patterns.

The result of mapping an image, animation or text will depend on the resolution of your effect layout.

**Image** mapped to intensity and then color in a 10x10 layout.

**Text** effect with the letter "E" mapped to intensity and then color in a 10x10 layout.

There are controls for adjusting the playback of the image or text live. You can position, scroll, rotate and change colors. You can map to intensity, color mix, iris or zoom.

**Effect Layout**
The effect layout is a "pixel map" of channels in your rig that the effect is applied to. You can define it up to 128x128.

**Effect Types**
The effect types are **image**, **animation** (gif) or **text**. A library of animations are loaded when you create a new play.

**Components**
To start an image effect you need

- An image or text
- An effect layout
- An Image effect playback

**Create an image effect playback**

Creating an image effect playback can be done in two ways.

- # INSERT & EFFECT and select Image.
- Press INSERT in the Effect Playbacks List, and select Image.

Now that the effect playback is created you need an Effect Layout to apply it to.

**Control image effects**

As soon as an Image effect is selected, you can control it in two ways:

- From the console parameter wheels using U1-U3.
- From the Live Effects view.

Image effects look like this in Live Effects

![Live Effects](image)

If you unlock the spreadsheet for screen editing (SETUP & TAB) you can step around with arrow keys, press MODIFY to get a dropdown, or enter a number and press MODIFY.

**NOTE**

When you press MODIFY or enter a number it will be an absolute value or a Palette value - depending on the setting in Attribute Settings. See Play Settings - Attribute.
Image effect parameters

These are the image effect parameters divided into Content, Position, Color & Effect.

CONTENT
The content can be image, animation or text. It needs a layout to be mapped to, and you have to set if it is applied to intensity, color mix, iris or zoom.

Layout
Layouts are created in the Effect Layout editor. This is the "projection screen" of an image effect.

Type
Choose between image, animation or text.

Index
This is the index number of the image, animation or text chosen.

MapTo
The image, animation or text can be mapped to intensity, color mix, iris or zoom of the channels in the effect layout.

POSITION
The position of the content defines where it is placed and how in the effect layout.

X-pos & Y-pos
The default position is "middle" of the effect layout. You can offset this +/- 128 increments.

Scale
The size of the content can be scaled from 0-1000. 100 is "normal".

Aspect
The aspect will adjust the shape of the content by adjusting X size against Y size.

Rotation
Rotates the content.

Speed
Sets the speed of an animation.

COLOR & EFFECT
Both color and effect are "filters" applied on top of the content and all previous parameters.

Red, green & Blue
Colorization.
Effect, size and speed
The effect parameter allows you to scroll, shake and scale the content. You can adjust size and speed of the applied effect. Size and speed 50% is stopped and normal.

The effects are

- None
- Scroll X
- Scroll X ><
- Scroll Y
- Scroll Y <>
- Rotation
- Scale
- Aspect
- Shake

Animation effects

Animation effects are great for creating abstract intensity or color patterns, similar to old school video effect generators. A number of digital animations are supplied with Cobalt. These are a few.

![Image Effects](image_url)
**Effect layouts (8.0)**

An effect layout is the "projection screen" for an image effect. It defines the number of channels in the layout. The layout is in turn set as target to a Pixel Grid in a Magic Sheet that determines how pixels from a source image will apply to these channels. See Magic Sheets.

This is what a 10 x 10 Pixel Grid will look like with 100 channels in it.

---

**Create a new effect layout (8.0)**

1. Open the effect layout editor (*Browser >Effects >Image Effects >Effect Layouts...*).

2. Press INSERT. You will get a popup where you can define the width and height in "pixels". One pixel is the smallest possible resolution, and usually a single light source.
3. You have now created the layout. Go to the Magic Sheet editor to set this as a target for a Pixel Grid. See Magic Sheets.

Copy an effect layout

You can copy effect layouts to make alternative versions.

1. Open the effect layout list (Browser > Effects > Image Effects > Effect Layouts...)

2. Select the layout you want to copy and press COPY/CUT.

3. Press PASTE.

Connect an Effect Layout with a Pixel Grid (8.0)

This is a step by step example of how you can connect an Effect layout to a Pixel Grid in a Magic Sheet, to be able to use and display image effects connected to, for example, intensity.

1. Open the Effect Layout list (Browser > Effects > Image Effects > Effect Layouts...).

2. Press INSERT to insert a new layout, set width and height to 10 pixels.

3. Go to a Live tab (press LIVE).

5. Activate editing and select the LED pixel object

6. Set target to Channel and Start number 1, increment 1

7. Place first pixel
8. Open grid tool and set to 10x10 and spacing 2, press OK

9. The pixels are laid out. Selext the pixels (drag left over them) and set a fill to white and connect to intensity. If they are all 100% this is what they will look like - otherwise they will be black inside.
10. Now it is time to connect to a pixel grid. Set target to Pixel Grid and Start number 1.

11. Insert the Pixel Grid object in the middle of the grid of pixels.
12. Resize sides of the Pixel Grid so they align with the pixels on the sides (see two small arrows on outside above). Make sure that the pixel grid object is at the back of all RGB-pixels so it won't be selected by default when clicking on it.

14. Close the Magic Sheet editor (click on the arrow on the side bar). You are done!

You can now create an image effect playback and assign it to the intensity of this pixel grid and use text, images and movies to play back over the grid. See Image effects.
**Effect Images**

Effect images are jpg or gif images that you can create with the Image tool, or import from a USB memory.

They are mapped pixel by pixel to the effect layout when selected. In other words, if the effect layout consists of 100 light sources that are aligned 10x10 - you can create an image that is 10x10 to fit exactly, or 128x128 if you want to be able to scale and zoom in the image.

Simple black & white image mapped to intensities, and color in a 10x10 effect layout

![Image and Effect Layouts](image.png)

**Create a new image**

1. Open the Effect Images tool (Browser >Effects >Image Effects >Effect Images...)

![Effect Image List](image2.png)
2. Press INSERT to create a new image. You will get a popup

3. Enter the size of the image. The size is relevant to the size of the effect layout it will be applied to. We recommend 128x128 which you can scale to a lot of layouts.

4. Press MODIFY in the Image column of the new image. This opens the layout editor tool.
Edit an image

The Effect Image Editor can be used to create new images and to edit imported images. It offers some simple drawing tools. All of them are mouse operated.

**Drawing tools**

![Pen and Select Tool Images]

The drawing tools are the pen and the select tool. The pen will draw with the selected colors and the select tool can be used to select an area and drag it to a different location.

**Zoom tool**

![Zoom Tool Images]

Click on the zoom tools to zoom in/out.

**Color tools**

There are two ways to select color:

- Color picker (click on a color to select)
  ![Color Picker Image]

- Color sampler (click in image to sample)
  ![Color Sampler Image]

**Kaleidoscope tool**

Anything you draw is mirrored on the other side of the lines. Makes it easy to make symmetrical patterns.
Copy an effect image

You can copy effect images to make alternative versions.

1. Open the effect image list (Browser > Effects > Image Effects > Effect images...)

2. Select the image you want to copy and press COPY/CUT.

3. Press PASTE.
Effect Texts

You can create a text and apply it to an effect layout with the image effect. The text can be applied to intensity, color mix, iris or zoom.

This is an example of the letter "E" applied to intensity and then color mix in a 10x10 effect layout.

Create an effect text

1. Open the Effect Text tool (Browser > Effects > Image Effect > Effect Texts...)

2. Press INSERT to create a new text.

3. Press MODIFY in the Text column, write a text and press MODIFY to confirm.
Import Effect Images

You can import images (jpg/bmp/gif) from a USB memory.

1. Connect the USB memory to Cobalt

2. Open the Import Effect Images function (Browser >Effects >Image Effects >Import Effect Image). This will open the import image popup where you can select the image you want to import.

3. Press MODIFY. You will get a popup

4. Enter the target size of the image. The size is relevant to the size of the effect layout it will be applied to. We recommend 128x128 which you can scale to a lot of layouts.

5. Press MODIFY in the Image column of the new image. This opens the layout editor tool.

Once the image is imported you can access it from the Image Effect controls.
**Channel Sets**

A Channel Set is a defined set of channels distributed into a number of parts so that you can distribute effects over a rig in a specific order, regardless if it is symmetrical or not.

Sets can be used as an alternative to groups, in both content and dynamic effects. The advantage of a Channel Set compared to a group is that you can create very specific distribution models. See Channel Distribution Wizard.

The Channels Sets editor can be opened in two ways.

- SET (soft key in the Effects Soft Key menu)
- Browser >Effects > Channel Sets
Create a Set

Sets are created in the Channel Sets editor. You can use the Channel Distribution Wizard, or create them one by one using all channel selection and Group features in Cobalt as a help.

1. Open the Channel Sets Editor. See above.

<table>
<thead>
<tr>
<th>Column</th>
<th>Action</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel set</td>
<td>No Input</td>
<td>The number of this Set. Can't be changed.</td>
</tr>
<tr>
<td>Text</td>
<td>MODIFY</td>
<td>Opens the text cell for labeling.</td>
</tr>
<tr>
<td>Parts</td>
<td>MODIFY</td>
<td>Opens the Channel Distribution Wizard.</td>
</tr>
</tbody>
</table>

2. Press INSERT in the Channel Sets List to create a new set. Name it if you want to.

3. Press MODIFY in the Parts cell to open the Channel Distribution Wizard.

NOTE
Helpful hint: Groups can be used to enter channel selections within parts, if desired. If you are making a very complicated Channel Set distribution, it may be easier to first create a Group that corresponds to the contents of each individual Part, and then use the Groups on masters or Direct Selects to simplify the entry of the channels in each part.

You can now use this set in any Content or Dynamic Effect Playback.

Edit a Set

Select the set using arrow keys. The channels and parts are shown in the top of the editor.

<table>
<thead>
<tr>
<th>Function</th>
<th>Keys</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a Part</td>
<td>NEXT, LAST</td>
<td>The channels will be selected and the number of the part is indicated in red over the channels.</td>
</tr>
<tr>
<td>Edit a Part</td>
<td>NEXT, LAST</td>
<td>Select/deselect channels. No save or record required. To add a new part select the last EMPTY one and select channels.</td>
</tr>
<tr>
<td>Delete a Part</td>
<td>DELETE</td>
<td>Press DELETE to delete the selected part.</td>
</tr>
</tbody>
</table>
Main Playback

The Main Playback is a "theatre style" playback for sequences.

Main Playback Node

This chapter contains the following sections

- Main Playback - Introduction
- Main Playback - Functions
- Playback View
- Sequence Editor
- Load Sequence
- Goto List
Main Playback - Introduction

The Main Playback is the theatrical playback section of Cobalt. You can play back any of the 999 sequences, or any of the 9999.999 presets in random order.
Main Playback - Functions

The Main Playback can play back a Sequence in normal/chase mode, or random presets. While a crossfade is being executed the "Playback" status at the lower right corner of all screens will be red.

The main playback has the following controls.

1. **GO TO** (live) and **JUMP TO B** (blind) will accept a numeric argument for going directly to any part of the sequence.
2. **REFRESH** to refresh values to those of the Playback.
3. **PLAYBACK** for assigning sequences and selecting the Main Playback Tab.
4. A/B buttons for direct access to the CURRENT (A) and NEXT (B) parts of the playback.
5. **Seq +/-** for stepping without times
6. **Manual crossfaders**
7. Split speed controls for in and outgoing channels.
8. **Transport keys** for timed fades with default or pre-programmed times.
Main Playback - Transport Keys

These are the transport keys of the Main Playback.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start a crossfade*</td>
<td>[GO]</td>
</tr>
<tr>
<td>Start a new crossfade during an ongoing crossfade</td>
<td>[GO]</td>
</tr>
<tr>
<td>Pause a crossfade</td>
<td>[PAUSE]</td>
</tr>
<tr>
<td>Crossfade to the previous step</td>
<td>[GO BACK]</td>
</tr>
<tr>
<td>Reverse an ongoing crossfade by making a crossfade to the previous step</td>
<td>[GO BACK]</td>
</tr>
<tr>
<td>Step (without times) to the next step</td>
<td>[SEQ+]</td>
</tr>
<tr>
<td>Step (without times) to the previous step</td>
<td>[SEQ-]</td>
</tr>
<tr>
<td>Open the GOTO list**</td>
<td>[GOTO]</td>
</tr>
<tr>
<td>Crossfade to any recorded preset on the stored or default times</td>
<td>[# GOTO]</td>
</tr>
<tr>
<td>Relocate the sequence from preset # in B (Next)</td>
<td>[# JUMP TO B]</td>
</tr>
</tbody>
</table>

*When a crossfade is completed there is a beep. Turn this off in the System Settings - System.
**See The Goto List
NOTE
Device parameters are executed as LTP, independent of the playback that once started them. This means that you cannot use (for example) PAUSE to stop attributes.
Main Playback - Manual Crossfades

Move the crossfaders from the down position to the up position to perform a manual crossfade. When both reach the top position the crossfade is terminated and the next sequence step is advanced. (See Main Playback - Introduction).

General Facts

- Take over timed fades manually.
- Press GO during a manual fade.
- Set the crossfaders to fade in both directions in the Settings for the Playback (Hold SETUP and press PLAYBACK).
- When you make a manual crossfade to a step with attributes, the attribute values that are GoOnGo will follow the movement of the B-fader.
- You can record the actual manual movement of the crossfaders using a Crossfade Profile. See Sequences - Crossfade Profiles
## Main Playback - Edit Keys

A, B and PLAYBACK are the main editing keys of the Main Playback, they can be used in conjunction with numerical entries and other prefix keys.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect the Active (A) field to the channel controls, and open the A Tab</td>
<td>A</td>
</tr>
<tr>
<td>Connect the Next (B) field to the channel controls, and open the B Tab</td>
<td>B</td>
</tr>
<tr>
<td>Load Preset # to A.</td>
<td># PRESET &amp; A</td>
</tr>
<tr>
<td>Load Preset # to B.</td>
<td># PRESET &amp; B</td>
</tr>
<tr>
<td>Load a sequence to the Main Playback</td>
<td># SEQ &amp; PLAYBACK</td>
</tr>
<tr>
<td>Clear the Main Playback</td>
<td>C/Alt &amp; PLAYBACK</td>
</tr>
<tr>
<td>Activating the Playback Tab connects the A field to the channel controls and selects the Playback tab.</td>
<td>PLAYBACK</td>
</tr>
</tbody>
</table>
Main Playback - Time Settings

Hold SETUP and press TIME to open the Settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set times to</td>
<td>Times are set to the step in B (default). You can set them to the step in A as well.</td>
</tr>
<tr>
<td>Time: Use % as default</td>
<td>Times for FCB will be set in % of the main fade time.</td>
</tr>
<tr>
<td>Default Go time</td>
<td>The default time that is only used if no time is set, is set to 5 seconds.</td>
</tr>
<tr>
<td>Default Go Back time</td>
<td>The default time is set to 2 seconds.</td>
</tr>
<tr>
<td>Default Out/In time</td>
<td>The default out/in time will be set and stored as # seconds.</td>
</tr>
</tbody>
</table>
Main Playback - Default Settings

Hold SETUP and press PLAYBACK to open these settings.

- **Modify Sequence**: When active, this mode will suppress all wait times and master links.
- **Build Sequence**: When active (default) all presets recorded in A (Live) will be added to the sequence.
- **Followon**: Wait times will be treated as Followon times, counting from GO instead of from the completion of the last fade.
- **GOTO jumps to**: The default is PRESET, you can set it to STEP.
- **Crossfade both ways**: The default setting for a manual crossfade is upwards. You can set it both ways.
- **Don't Advance Playback**: When this is checked, the sequence in the main playback will not advance automatically.

These are the default settings for the functions of the Main Playback.
## Main Playback - Refresh Functions

The REFRESH key in the Main Playback can be used to refresh any part of a channel to the resulting state of the current Sequence Step in the Main Playback.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Everything</td>
<td>REFRESH</td>
</tr>
<tr>
<td>Attributes of all device(s)</td>
<td>REFRESH &amp; ATTRIB</td>
</tr>
<tr>
<td>Levels of all device(s) and channel(s)</td>
<td>REFRESH &amp; @LEVEL</td>
</tr>
<tr>
<td>Focus parameters of the selected device(s)</td>
<td>REFRESH &amp; FOCUS</td>
</tr>
<tr>
<td>Color parameters of the selected device(s)</td>
<td>REFRESH &amp; COLOR</td>
</tr>
<tr>
<td>Beam parameters of the selected device(s)</td>
<td>REFRESH &amp; BEAM</td>
</tr>
<tr>
<td>Wheel parameters of the selected device(s)</td>
<td>REFRESH &amp; Wheel key</td>
</tr>
<tr>
<td>U1-U3 of the selected device(s)</td>
<td>REFRESH &amp; U1-U3</td>
</tr>
<tr>
<td>Intensities AND attributes for the selected device(s).</td>
<td>REFRESH &amp; CHANNEL</td>
</tr>
</tbody>
</table>

**NOTE**

The changed flags are cleared for what you refresh.

The Refresh function will take the currently focused channel into account if you are using NEXT/LAST.
### Playback View

Press PLAYBACK in the [Main Playback section](#) to open the Playback tab. The Playback views normally have a packed format like this. There is an unpacked format as well (see below).

1. **Current sequence step**, on stage.
2. **Next sequence step** to be faded in.
3. A **graphical representation** of the times in the next step to be faded in.
4. **Notes** are shown with a yellow flag and displayed to the left of the graphical view for the next step. There are progress bars for A/B at the top.
5. **Sequence step number**.
6. **Preset number** in this step.
7. **Sequence** or **Preset text**.
8. **Times**
Standard Times are described like this
Out: #
In: #
Time (In=Out): #
Delay In: # (with a "d", for example d2 >3)
Delay Out: # (with a "d", for example d2 >3)
TimeCode: ##.##.##.##
Channel Times - are summarised as ChT: #. The # indicates how many different time groups there are in a step.

9. Header box, showing information about the currently loaded sequence (click to change)
10. On screen transport keys
11. Settings.
12. Mode indicators.
13. Extras in this sequence step.

Devices - are summarised as Dev: #. The # indicates how many moving devices are affected by the step.
Master Links - are indicated as ML: #. The # indicates how many Masters are linked to the step.
Master Pages - are indicated as MP: #. The # indicates which Master Page is linked to the step.
Effects - are indicated as Eff: #. The # indicates the number of effects linked to the step.

NOTE
Touch and mouse functionality: You can click on many objects in the Playback View to open the corresponding editor directly. For example PRESET or DEV or MASTER LINK.

Sequence Playback Views - The Graphical Representation

The graphical representation of the next crossfade shows the in and outgoing fade times as arrows, and FCB times and channel times as progress bars.

You can toggle this view on/off at the settings (12) or by holding FORMAT and pressing the UP or DOWN arrow.
Sequence Playback Views - Column Format

It is possible to show the information in the Playback view in a traditional columnised format, instead of the packed default format.

You can toggle this view on/off by holding FORMAT and pressing the RIGHT or LEFT arrow.

Delay Times
An < or > character points to the time that will be delayed. If there are two delay times, the out delay is shown and < > characters indicate that there are two delay times defined.
**Sequence Editor**

Hold MODIFY and press PLAYBACK in the Main Playback section to open the Sequence Editor for the sequence in the Main Playback. See Sequences - Sequence List.
**Load Sequence**

The node **Browser >Main Playback >Load Sequence** opens a dialogue that allows you to load any recorded Sequence to the Main Playback. Tap or press MODIFY to activate.

![Load sequence dialog](image)

You can also touch or click on the Playback view in the top left part, where the number of the currently loaded sequence is displayed.
Goto List

The node Browser >Main Playback >Goto List opens a dialogue that allows you to crossfade directly (Goto) any recorded Sequence step in the Main Playback by selecting a step with arrow keys or some other way, and pressing MODIFY.

You can also right click on any step of the sequence in the Playback tab and open the context menu that allows you to Goto that step.
There are 80 Master Playbacks that can be used to playback any type of content such as channels, groups, effects, presets, sequences or console keys, macros and moving device parameters.

Masters Node

This chapter contains the following sections

- Masters - Introduction
- Masters - Functions
- Master View
- Master List
- Master Pages
Masters - Introduction

The masters are incredibly flexible and powerful. You can set them up individually in a number of different modes and play back virtually any type of content that can be programmed in Cobalt.

All of the 80 master playbacks can be controlled virtually by number. Physically you can access them depending on your choice of hardware.

1. Master screens - shared for each section of controls
2. Endless RGB pot master, with Master key and part of display
3. Fader modes
4. Fader functions
5. Master Playback with two Master keys and part of display
6. Expanded Master/Effect/Sequence mode
7. Master Playback controls (assignable to any playback)

Important master control keys

There are three categories of keys that apply to master playbacks.

Fader keys
The two master keys belonging to each fader can be set up to control playback functions related to the type of content loaded to the master.

Master Playback
You can connect any master to the Master Playback controls. This gives you functions like GO, GO BACK, STEP and TAP.

- In the Cobalt console this is done with the Master Playback
• In the Congo Jr console, this is done with the Main Playback

**Additional keys**
Other keys that control important functions for the masters are:

- **MASTER** = Opens the master view and selects masters
- **FADER MODE** = Select operational mode for the faders
- **RANGE** = Select which range of master playbacks the faders control
- **SWAP** = Swaps upper/lower master row
- **CH ONLY MOD** = Turns masters and console into channel handles for a single scene console
- **PAGE** = Control Master pages
- **FLASH MODE** = Configurates master buttons
- **START** = Can be used to start fades
- **SETUP** = Used in combination with the Master key to open individual settings
- **MODIFY** = Used in combination with the Master key to open the Master Editor
- **CLEAR** = Used in combination to clear content.
Masters - Functions

These are the master functions.

This chapter contains the following sections

- Masters - Playback Keys
- Masters - Settings
- Masters - Commands
- Masters - Clear
- Masters - Times
- Masters - Channels
- Masters - Presets
- Masters - Groups
- Masters - Effects
- Masters - Palettes
- Masters - Sequences
- Masters - Chase mode sequence
- Masters - Dynamics
- Masters - Magic Sheets
- Masters - Attribute parameters
- Masters - Console keys
- Masters - Macros
- Masters - Drag and Drop
- Masters - Two Scene Masters
- Masters - Swap upper/lower
- Masters - Select Playback Range
- Masters - Fader Modes
- Masters - Beat Boss
Master Playback - Functions

These are the transport keys for the Master Playback in the masters section.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start a chase (or crossfade)</td>
<td>[GO]</td>
<td>Starts a stopped Chase or a Crossfade for a Sequence</td>
</tr>
<tr>
<td>Start a crossfade from step #</td>
<td># [GO]</td>
<td>Starts a Crossfade to step #</td>
</tr>
<tr>
<td>Pause a chase (or crossfade)</td>
<td>[PAUSE]</td>
<td>Pauses a running Chase or Crossfade</td>
</tr>
<tr>
<td>Reverse a fade</td>
<td>[STOP]</td>
<td>This key is the equivalent of GO BACK to the previous step of the Main Playback</td>
</tr>
<tr>
<td>Step without times</td>
<td>&lt;&lt; or &gt;&gt;</td>
<td>These keys are the equivalent of SEQ+ and SEQ- in the Main Playback.</td>
</tr>
<tr>
<td>Change Chase direction</td>
<td>&lt;&lt; or &gt;&gt;</td>
<td>The currently connected Chase will change direction</td>
</tr>
<tr>
<td>Connect a Master Playback (7.2)</td>
<td># [CONNECT]</td>
<td>The Chase or Sequence in this Master is connected to the Playback keys. Also, the Master Playback tab is focused.</td>
</tr>
<tr>
<td>or [CONNECT] &amp; Master Key</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disconnect a Master Playback (7.2)</td>
<td>[0] [CONNECT]</td>
<td>The Master is disconnected from the Playback keys.</td>
</tr>
<tr>
<td>Set a tap tempo to a Master Playback or Page.</td>
<td>[TAP] &amp; Master Key</td>
<td>Hold TAP and press at least twice on a Master or Page key to set a BPM tempo.</td>
</tr>
</tbody>
</table>
Masters - Settings

You can define master settings from the Master Settings popup or directly from the console if you have the full wing or big Cobalt.

See Master Settings from the console. All settings for masters are individual per master.

You can define behaviours for the

- Fader
- Flash key
- Master key
- Contribution to the Live output
- Contribution to recording functions
- Priorities against other playbacks

Master settings are described per content type in this chapter.

Reset Master Settings
To reset Master settings to default hold C and press the Master key twice.

Open Master Settings
Hold SETUP and press a master key for a fader.

- To open settings for several masters select the first master (# MASTER) and add master with + and THRU, then hold SETUP & press MASTER.
- To open settings for a specific master enter the master number, then hold SETUP and press MASTER.

The dialog has three tabs: Basic, Buttons and Faders.
Master Mode

These are the main modes that define the basic behaviour of a master playback.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Screen</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exclusive</td>
<td>Blue level</td>
<td>Blackout, GrandMaster, Capture or any other channel function will not affect this channel(s).</td>
</tr>
<tr>
<td>Inclusive</td>
<td>No indication</td>
<td>Works as an additional Master Playback</td>
</tr>
<tr>
<td>Inhibit</td>
<td>Red level</td>
<td>Is an Inhibit Master - works as a Grand Master for the selected channel(s).*</td>
</tr>
</tbody>
</table>

*If you have several Independent Functions set to Inhibit and they have overlapping channels, the highest Special Function will be in control. The result on stage can be recorded.

NOTE
When you are in "exclusive" mode, the attributes will still be "stolen" back by any function calling them from the rest of the console, even if the intensity is "exclusive". If you wish to stop this from happening enable Active Parameter Lock. See Master fader settings.
Exclude Int From Record

This setting (see image in previous post) excludes the contribution of this master to the live output, from recording functions. This is useful for worklights and effects that are on, but you don't want to include in new presets.

Master button

The master button is the single key in all master modules that is used to assign content to the master. The different modes apply to specific content types - which is described closer in the sections of these contents.
<table>
<thead>
<tr>
<th>Mode</th>
<th>Applies to</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Channels</td>
<td>All content</td>
<td>Selects the channels in this master as a group</td>
</tr>
<tr>
<td>GO</td>
<td>Chase, sequence</td>
<td>Start the next crossfade</td>
</tr>
<tr>
<td>GO/PAUSE</td>
<td>Chase, sequence</td>
<td>Start/pause</td>
</tr>
<tr>
<td>Start</td>
<td>Ch, group, preset, effect, palette, chase, Sequence</td>
<td>Sets fader to full or a level</td>
</tr>
<tr>
<td>Tap</td>
<td>Chase</td>
<td>Sets tap tempo</td>
</tr>
<tr>
<td>Execute Attributes</td>
<td>Preset, effect, palette</td>
<td>Sets if attributes are executed by the button</td>
</tr>
<tr>
<td>Flash</td>
<td>Ch, group, preset, effect, chase, Sequence</td>
<td>Sets to function like a momentary flash key</td>
</tr>
<tr>
<td>Seq +</td>
<td>Sequence</td>
<td>Sets to function like Seq +</td>
</tr>
<tr>
<td>Seq -</td>
<td>Sequence</td>
<td>Sets to function like Seq -</td>
</tr>
<tr>
<td>Go Back</td>
<td>Sequence</td>
<td>Sets to function like GoBACK</td>
</tr>
<tr>
<td>Master Editor</td>
<td>Ch, group, preset, effect, chase, Sequence</td>
<td>Opens the corresponding editor for the master content</td>
</tr>
</tbody>
</table>
Master fader settings

The fader settings define the behaviour of intensities and attributes for the fader. The different modes apply to specific content types - which is described closer in the sections of these contents.
<table>
<thead>
<tr>
<th>Mode</th>
<th>Applies to</th>
<th>Feedback</th>
</tr>
</thead>
</table>
| Fader type          | Ch, group, preset, effect         | **Add** = Intensities are piled (HTP) on top of the output. Attributes are LTP.  
Solo = The content of this fader replaces all other master faders, but does not affect levels coming from the Main Playback. |
| Fader intensity     | Ch, group, preset, effect, chase, Sequence | **Disabled** = intensity is not affected by moving the fader  
Follow manual fader = Intensities will follow the fader  
Follow master time = follows master times |
| Fader Attributes    | Preset, effect, palette           | **Disabled** = attributes are not affected by moving the fader  
Follow manual fader = Attributes will follow the fader  
Execute at #% = attributes are executed when the fader passes #%. |
| Active parameter lock | Preset, effect                  | Attributes cannot be stolen by another master or the Main Playback. Manual control is still possible.                                    |
| Return to (FCB)     | Preset, effect                    | Defines what attributes will return to at fade down.  
None  
Previous = last LTP values  
Preset = a specified preset  
Main Pb = sequence step in A |
| Preset              | Preset, effect                    | Return to preset (see above)                                                                                                                                                                         |

**NOTE**  
If several masters have Fade type = Solo, the last Solo master that leaves its 0% position will have priority over the other Solo masters. To take control with another Solo master, move it down to 0% and up again.
Flash settings

The flash button is the lower key in all master modules. Some modules and the large Cobalt only have flash keys for the lower row of faders.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Applies to</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>-</td>
<td>Flash button is disabled</td>
</tr>
<tr>
<td>Momentary</td>
<td>Ch, group, preset, effect, chase, Sequence</td>
<td>Sets the fader to full or the defined flash level when pressed and returns the fader to zero when the key is released.</td>
</tr>
<tr>
<td>Latching</td>
<td>Ch, group, preset, effect, chase, Sequence</td>
<td>Toggles the fader to full or the defined flash level when pressed, leaving the fader at that level until the flash key is pressed again</td>
</tr>
<tr>
<td>GoBack</td>
<td>Chase, Sequence</td>
<td>GoBack to previous step</td>
</tr>
<tr>
<td>Tap</td>
<td>Chase</td>
<td>Sets tap tempo</td>
</tr>
</tbody>
</table>
Flash type

<table>
<thead>
<tr>
<th>Mode</th>
<th>Applies to</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Ch, group, preset, effect</td>
<td>Intensities are piled (HTP) on top of the output. Attributes are LTP.</td>
</tr>
</tbody>
</table>
| Solo (7.3)| Ch, group, preset, effect| The content of this fader replaces all other master faders and returns other faders based on the Momentary/Latching mode setting. 

NOTE: From 7.3 there is a check box to allow this function to affect also the Main Playback. See Master Settings.

Flash mode

<table>
<thead>
<tr>
<th>Mode</th>
<th>Applies to</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Preset, effect, chase, Sequence</td>
<td>Flash executes intensity and attributes</td>
</tr>
<tr>
<td>Intensity</td>
<td>Ch, group, preset, effect, chase, Sequence</td>
<td>Flash executes intensities only</td>
</tr>
<tr>
<td>Attributes</td>
<td>Preset, effect, palette</td>
<td>Flash executes attributes only</td>
</tr>
</tbody>
</table>

Flash time and level

<table>
<thead>
<tr>
<th>Mode</th>
<th>Applies to</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flash: Use time</td>
<td>Ch, group, preset, effect, chase, Sequence</td>
<td>Flash functions will use in-wait-out times</td>
</tr>
<tr>
<td>Flash level</td>
<td>Ch, group, preset, effect, palette, chase, Sequence</td>
<td>Target level for flash functions</td>
</tr>
</tbody>
</table>

Disable Flash Keys

The top area of all screens will indicate that flash is disabled by showing the Flash disabled indicator pictured below.

![Flash disabled indicator](image)
Hold C/ALT and press FLASH MODE. Repeat to toggle on/off.

The top of the monitor screens will indicate the Flash is Disabled like this

**Flash disabled**

**Master Settings From the Console**

Hold FLASH MODE and use the page keys to step through the settings per master.

Use the Master key to toggle the settings per master.

You can check and set master settings directly from the Cobalt console or Congo Jr Master Playback Wing. Universal Fader Wings and Congo Kid do not support this feature.
Masters - Commands

Enter the number of a master and press MASTER to control this master on the level wheel. This will open the Master view - and this view has to be open for all the master commands to work.

You can select a group of masters and set levels numerically from the keypad, similar to how channels, effects and groups can be selected.

Select masters and set levels

It is possible to select masters and set levels with the MASTER key providing a Master View is open and active (selected).

Keyboard shortcut = F8.

<table>
<thead>
<tr>
<th>Function</th>
<th>Keys</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open the Master view</td>
<td>MASTER</td>
<td>The Master View is opened.</td>
</tr>
<tr>
<td>Select a Master</td>
<td>[#] MASTER</td>
<td>Master # is selected and highlighted in the Master View.</td>
</tr>
<tr>
<td>Add</td>
<td>[#] +</td>
<td>Master # is added to the selection.</td>
</tr>
<tr>
<td>Add a range</td>
<td>[#] THRU</td>
<td>Up to Master # are added to the selection.</td>
</tr>
<tr>
<td>Subtract</td>
<td>[#] -</td>
<td>Master # is subtracted.</td>
</tr>
<tr>
<td>Set a level</td>
<td>[#] @LEVEL</td>
<td>The levels are set to #.</td>
</tr>
<tr>
<td>Set a level</td>
<td>Wheel</td>
<td>The levels are set to #.</td>
</tr>
<tr>
<td>Deselect all</td>
<td>[0] MASTER</td>
<td>All are deselected.</td>
</tr>
</tbody>
</table>

Master single field editor

Hold MODIFY and press aMaster key to open a single field master editor for channel intensities. All channel functions plus UPDATE are available.
NOTE
Adjustments made in this field are live if the master's fader is above zero. When there is an unsaved change the grey title bar will be purple and you will get an option of saving before closing or leaving this tab.

To edit attributes in this tab, press ATTRIB. If the master level is above 0%, the changes in the attribute view will be executed on stage (7.2)

Select channels in a master

Press a Master key to select all channels in the Ch, Preset, Effect or Group of that Master.

<table>
<thead>
<tr>
<th>Function</th>
<th>Keys</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select channels</td>
<td>Master Key</td>
<td>All channels in Master # are selected in the Channel Control.</td>
</tr>
<tr>
<td>Select channels in with a level</td>
<td>ALL &amp; Master Key</td>
<td>All channels in Master # with a level in the Channel Control are selected.</td>
</tr>
<tr>
<td>Add channels</td>
<td>+ &amp; Master Key</td>
<td>All channels in Master # are added to the selection in the Channel Control.</td>
</tr>
<tr>
<td>Subtract channels</td>
<td>- &amp; Master Key</td>
<td>All channels in Master # are subtracted from the selection in the Channel Control.</td>
</tr>
</tbody>
</table>
Mask in masters

A mask is either set up from the Master List in the Mask column, or by copying the global Mask to a master by holding MASK and pressing the Master key.

Every master has a mask that you can define per parameter. The mask will inhibit the playback of those parameters from that master. The same content on a different unmasked master will play back all of its content. You can use playback masks to reuse content for different purposes, or to keep parameters from playing back, without having to edit those parameters out of the content.

You can also assign any user mask from the Mask list by entering # holding MASK and pressing the Master Key. See Device Control - Mask.

The mask is indicated in the master display and the Masters tab.

Masters - Clear

Hold C/ALT and press a Master Key to clear its content.
These are more functions to clear content and fader levels in master playbacks.

<table>
<thead>
<tr>
<th>Function</th>
<th>Keys</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear</td>
<td>C/Alt &amp; Master Key</td>
<td>The content of the Master Playback is cleared.</td>
</tr>
<tr>
<td>Clear all</td>
<td>C/Alt &amp; PAGE</td>
<td>The Master Playbacks are cleared.</td>
</tr>
<tr>
<td>Set all to zero</td>
<td>C/Alt &amp; MASTER OR C/Alt &amp; LIVE</td>
<td>All Master Playbacks are set to zero, no content is cleared.</td>
</tr>
<tr>
<td>Clear settings</td>
<td>C/Alt &amp; Master key</td>
<td>Master content is cleared AND settings are reset to default.</td>
</tr>
</tbody>
</table>
Masters - Times

Masters can have In, wait and out times. These times can be used by

- Flash on time
- Master Links
- The START function
- Manual fades

Set In-Wait-Out times for a Master

In times can be set with a key shortcut. Wait and out times are set from the master editor.

In Time

<table>
<thead>
<tr>
<th>Function</th>
<th>Keys</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set In time</td>
<td>#</td>
<td>TIME</td>
</tr>
</tbody>
</table>

In, Wait and Out time

These times can only be assigned from the Master List.

1. Open the master list using [MODIFY] & [MASTER] or from the Browser >Masters >MasterList.
2. Set In, Wait and Out times.

Master settings for times

These are the settings you can set individually for master times.

Hold SETUP and press the Master key to open the settings. See Masters - Settings.

These are the settings that affect times, and only for content where times apply.

<table>
<thead>
<tr>
<th>Function</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fader Intensity</td>
<td>With &quot;Follow Master Time&quot; Fader will never fade faster than the fade time</td>
</tr>
<tr>
<td>Flash: Use time</td>
<td>Flash will use master time</td>
</tr>
</tbody>
</table>
Flash On Time

When Flash On Time is activated, the Master Playbacks will flash on the time assigned to each playback. See Master Playbacks - Times.

<table>
<thead>
<tr>
<th>Function</th>
<th>Keys</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Open the Master Setup</td>
<td>SETUP &amp; Master Key</td>
<td>The Master Settings are opened</td>
</tr>
<tr>
<td>2. Select Flash On Time</td>
<td>Arrow keys</td>
<td>Flash On Time box is highlighted</td>
</tr>
<tr>
<td>3. Activate</td>
<td>MODIFY</td>
<td>Flash On Time box is checked</td>
</tr>
<tr>
<td>4. Exit Settings</td>
<td>MODIFY</td>
<td>Settings are closed</td>
</tr>
</tbody>
</table>
Masters - Channels

Hold CHANNEL and press a Master Key to load and play back single channels (Ch#) so several masters starting from the first pressed, or GROUP and Master key to load a group of channels (Chs) to any master playback. They are stored in the current Master Page.

Once a channel is loaded to a master you can

- Use the master fader to set the level
- Use the flash key to flash the channel
- Use the master key to select the channel

Load channels to masters

These functions are used to load channels (with levels) to masters.

<table>
<thead>
<tr>
<th>Function</th>
<th>Keys</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channels</td>
<td>GROUP &amp; Master Key</td>
<td>The selected channel(s) are loaded with current level to the Master, which is set to full to avoid a Black Out of these channels on stage. The channel levels are also cleared from A.</td>
</tr>
<tr>
<td>Single channels</td>
<td>CHANNEL &amp; Master Key</td>
<td>The selected channel(s) are loaded at 100% to the Master Playbacks, starting at the one pressed. The master level will be set to the level from stage and this level will be cleared from the A field.</td>
</tr>
<tr>
<td>Ch # at 100%</td>
<td># CHANNEL &amp; Master Key</td>
<td>Channel # is loaded at 100% to the Master.</td>
</tr>
</tbody>
</table>
Master Settings for channels

These are the settings you can change for masters with channel content.

Hold SETUP and press the Master key to open the settings.
Please note that some settings will make other settings invalid - for example, if you set a master to Inhibit, the main function will be inhibit.

<table>
<thead>
<tr>
<th>Function</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mode</td>
<td>Inclusive = playback interacts with other playbacks</td>
</tr>
<tr>
<td></td>
<td>Inhibit = fader limits the output of the ch's</td>
</tr>
<tr>
<td></td>
<td>Exclusive = fader &quot;owns&quot; channel intensities</td>
</tr>
<tr>
<td>Exclude Int From Record</td>
<td>Excludes intensity from recording.</td>
</tr>
<tr>
<td>Master button</td>
<td>Default = Select channels in master as group</td>
</tr>
<tr>
<td></td>
<td>Start = Toggles fader to full/zero</td>
</tr>
<tr>
<td></td>
<td>Flash = Flashes the content</td>
</tr>
<tr>
<td>Include intensity</td>
<td>Playback will control intensities</td>
</tr>
<tr>
<td>Attributes follow fader</td>
<td>Not used</td>
</tr>
<tr>
<td>Fader type</td>
<td>Add = Adds intensities HTP</td>
</tr>
<tr>
<td></td>
<td>Solo = Replaces the content of all other masters</td>
</tr>
<tr>
<td>Fader: Use time</td>
<td>Fader will never fade faster than the fade time</td>
</tr>
<tr>
<td>Return to (FCB)</td>
<td>Not used</td>
</tr>
<tr>
<td>Preset</td>
<td>Not used</td>
</tr>
<tr>
<td>Active Parameter Lock</td>
<td>Not used</td>
</tr>
<tr>
<td>Flash button</td>
<td>Off = No function</td>
</tr>
<tr>
<td></td>
<td>Momentary = Flash when pressed</td>
</tr>
<tr>
<td></td>
<td>Latching = Toggles flash off/on</td>
</tr>
<tr>
<td>Flash type</td>
<td>Add = Adds intensities HTP</td>
</tr>
<tr>
<td></td>
<td>Solo = Replaces the content of all other masters</td>
</tr>
<tr>
<td>Flash mode</td>
<td>Intensity = Intensities only</td>
</tr>
<tr>
<td>Flash: Use time</td>
<td>Flash will use master time</td>
</tr>
<tr>
<td>Flash Level</td>
<td>Sets the target level for flash</td>
</tr>
</tbody>
</table>
Masters - Presets

Enter the number, hold PRESET and press a Master Key to load to that Master.

You can record, load and play back presets from master playbacks. Since these are the most common type of content they are displayed only with the number in the master displays.

Once a preset is loaded to a master you can

- Use the master fader to set the level
- Use the flash key to flash the preset
- Use the master key to select the channels in the preset

A preset can contain device and effect attributes. These can be set to

- Follow the fader up
- Follow the fader down (rubberband)
- Have a defined return status (previous, main pb, preset #)
- Not follow the fader at all
- Be activated on flash

See Master settings for presets.

**NOTE**
If a change is made to a Preset or Group that is loaded to a Master which is active - the change will be pending until the Master is brought to zero and back up. Pending content indicated with inverted colors on the master LCD.
Load a preset to a master

These functions are used to load presets to masters.

<table>
<thead>
<tr>
<th>Function</th>
<th>Keys</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load a preset</td>
<td>[#] PRESET &amp; Master Key</td>
<td>Preset # is loaded. The number and name is shown in the master display</td>
</tr>
<tr>
<td>Load several presets</td>
<td>[#] PRESET &amp; Master Keys</td>
<td>Hold Preset and keep pressing new Master keys to load the next stored Preset</td>
</tr>
</tbody>
</table>

Record a preset to a master

Recording a preset to a master you will be able to choose to record the current channel selection or all channels on stage (if no channel is selected).

There are three options when you record a preset.

- Record as a preset
- Record as a return to preset
- Record as a preset in a sequence

Record a preset to a master

1. Select channels (selection) or select none (all) to record.

   OPTION: Enter a preset number. If you don't the next free last used for masters will be suggested.

2. Hold RECORD & Master key.
3. Enter a preset text (optional) and press RECORD again. The return to preset is shown in the master display and master view.

**Record a return preset to a master**

1. Select channels (selection) or select none (all) to record.
   
   OPTION: Enter a preset number. If you don’t the next free last used for masters will be suggested.

2. Hold RECORD & Master key. Use the right arrow to select Return To.
3. Enter a preset text (optional) and press RECORD again.

**Record a preset to a sequence in a master**

1. Select channels (selection) or select none (all) to record.
   OPTION: Enter a preset number. If you don’t the next free last used for masters will be suggested.

2. Hold RECORD & Master key. Use the right arrow to select Sequence.
3. Enter a preset text, Sequence name, and step text (optional) and press RECORD again.

**Master settings for presets**

These are the settings you can change for masters with preset content.

Hold SETUP and press the Master key to open the settings.
Master Settings

Basic   | Button settings | Fader settings

Master: 2 - ()

Master button settings
Master button: Select Channels

Flash button settings
Flash button: Momentary
Flash type: Add
Flash mode: All
Flash: Use time: unchecked
Flash level: 100%  

What the master button does

Close
Please note that some settings will make other settings invalid - for example, if you set a master to Inhibit, the main function will be inhibit.

<table>
<thead>
<tr>
<th><strong>Function</strong></th>
<th><strong>Function</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mode</strong></td>
<td>Inclusive = playback interacts with other playbacks</td>
</tr>
<tr>
<td></td>
<td>Inhibit = fader limits the output of the preset ch's</td>
</tr>
<tr>
<td></td>
<td>Exclusive = fader &quot;owns&quot; preset intensities</td>
</tr>
<tr>
<td>Exclude Int from Record</td>
<td>Excludes intensity from this master from recording</td>
</tr>
<tr>
<td>Master button</td>
<td>Default = Select channels in preset as group</td>
</tr>
<tr>
<td></td>
<td>Start = Toggles fader to full/zero</td>
</tr>
<tr>
<td></td>
<td>Execute Attributes = Only executes attributes</td>
</tr>
<tr>
<td></td>
<td>Flash = Flashes the content</td>
</tr>
<tr>
<td>Include intensity</td>
<td>Playback will control intensities</td>
</tr>
<tr>
<td>Attributes follow fader</td>
<td>Playback fader will control attributes</td>
</tr>
<tr>
<td>Fader type</td>
<td>Add = Adds intensities HTP</td>
</tr>
<tr>
<td></td>
<td>Solo = Replaces the content of all other masters</td>
</tr>
<tr>
<td>Fader: Use time</td>
<td>Fader will never fade faster than the fade time</td>
</tr>
<tr>
<td>Return to (FCB)</td>
<td>Specifies where attributes return to when the fader is faded down</td>
</tr>
<tr>
<td></td>
<td>Off = No return target</td>
</tr>
<tr>
<td></td>
<td>Previous = Status before the fade</td>
</tr>
<tr>
<td></td>
<td>Preset = To a specified preset</td>
</tr>
<tr>
<td></td>
<td>MainPB = To the preset in A of the main playback</td>
</tr>
<tr>
<td>Preset</td>
<td>Return to preset, if selected in previous choice</td>
</tr>
<tr>
<td>Active Parameter Lock</td>
<td>Attributes can not be stolen by any other playback. Manual override is possible.</td>
</tr>
<tr>
<td>Flash button</td>
<td>Off = No function</td>
</tr>
<tr>
<td></td>
<td>Momentary = Flash when pressed</td>
</tr>
<tr>
<td></td>
<td>Latching = Toggles flash off/on</td>
</tr>
<tr>
<td>Flash type</td>
<td>Add = Adds intensities HTP</td>
</tr>
<tr>
<td></td>
<td>Solo = Replaces the content of all other masters</td>
</tr>
<tr>
<td>Flash mode</td>
<td>All = Intensities and attributes</td>
</tr>
<tr>
<td></td>
<td>Intensity = Intensities only</td>
</tr>
<tr>
<td></td>
<td>Attributes = Attributes only</td>
</tr>
<tr>
<td>Flash: Use time</td>
<td>Flash will use master time</td>
</tr>
<tr>
<td>Flash Level</td>
<td>Sets the target level for flash</td>
</tr>
</tbody>
</table>
Masters - Groups

Enter the number, hold GROUP and press a Master Key to load to that Master.

You can load and play back groups from master playbacks. They are displayed with a "Gr" before the number in the master displays.

Once a group is loaded to a master you can

- Use the master fader to set the level
- Use the flash key to flash the group (if it has levels)
- Use the master key to select the channels in the group

**NOTE**

If a change is made to a Preset or Group that is loaded to a Master which is active - the change will be pending until the Master is brought to zero and back up. Pending content indicated with inverted colors on the master LCD.

Load a group to a master

These functions are used to load groups to masters.

<table>
<thead>
<tr>
<th>Function</th>
<th>Keys</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load a group</td>
<td>[GROUP] &amp;</td>
<td>Group # is loaded. The number and name are shown in the master display</td>
</tr>
<tr>
<td>Load several groups</td>
<td>[GROUP] &amp;</td>
<td>Hold Group and keep pressing Master keys to load the next stored Groups</td>
</tr>
</tbody>
</table>

Master settings for groups

These are the settings you can change for masters with group content.

Hold SETUP and press the Master key to open the settings.
Please note that some settings will make other settings invalid - for example, if you set a master to Inhibit, the main function will be inhibit.

<table>
<thead>
<tr>
<th>Function</th>
<th>Function</th>
</tr>
</thead>
</table>
| **Mode**               | Inclusive = playback interacts with other playbacks  
                          | Inhibit = fader limits the output of the group  
                          | Exclusive = fader "owns" group intensities       |
| **Exclude Int. from Record** | Excludes intensity from this master from recording |
| **Master button**      | Default = Select channels in master as group  
                          | Start = Toggles fader to full/zero  
                          | Flash = Flashes the content                      |
| **Include intensity**  |Playback will control intensities               |
| **Attributes follow fader** | *Not used*                                    |
| **Fader type**         | Add = Adds intensities HTP  
                          | Solo = Replaces the content of all other masters |
| **Fader: Use time**    | Fader will never fade faster than the fade time |
| **Return to (FCB)**    | *Not used*                                    |
| **Preset**             | *Not used*                                    |
| **Active Parameter Lock** | *Not used*                                    |
| **Flash button**       | Off = No function  
                          | Momentary = Flash when pressed  
                          | Latching = Toggles flash off/on                   |
| **Flash type**         | Add = Adds intensities HTP  
                          | Solo = Replaces the content of all other masters |
| **Flash mode**         | Intensity = Intensities only                   |
| **Flash: Use time**    | Flash will use master time                     |
| **Flash Level**        | Sets the target level for flash                 |
Masters - Effects

Enter the number, hold EFFECT and press a Master Key to load to that Master.

You can load and play back effects from master playbacks. They are displayed with a "E" before the number in the master displays.

Once an effect is loaded to a master you can

- Use the master fader to set the level
- Use the flash key to flash the group (if it has levels)
- Use the master key to select the effect

An effect contains effect attributes. These will always be dependent upon the last played back settings for that Effect Playback, or manual control.

The Effect Playback on the Master does not contain any recorded settings at all but If the effect is stored to a preset that is assigned to a master, the effect attributes can be set to

- Follow the fader up
- Follow the fader down (rubberband)
- Have a defined return status (previous, main pb, preset #)
- Not follow the fader at all
- Be activated on flash

See Master settings for effects.

Load an effect to a master

These functions are used to load effects to masters.

<table>
<thead>
<tr>
<th>Function</th>
<th>Keys</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load an effect</td>
<td>[#] EFFECT &amp; Master Key</td>
<td>Effect # is loaded. The number and name are shown in the master display</td>
</tr>
<tr>
<td>Load several effects</td>
<td>CHANNEL &amp; Master Keys</td>
<td>This loads the selected effects into Masters one-by-one at current intensities.</td>
</tr>
</tbody>
</table>
Master settings for effects

These are the settings you can change for masters with effect content.

Hold SETUP and press the Master key to open the settings.
Please note that some settings will make other settings invalid - for example, if you set a master to Inhibit, the main function will be inhibit.

<table>
<thead>
<tr>
<th>Function</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mode</strong></td>
<td><strong>Function</strong></td>
</tr>
<tr>
<td>Inclusive</td>
<td>playback interacts with other playbacks</td>
</tr>
<tr>
<td>Inhibit</td>
<td>fader limits the output of the preset ch's</td>
</tr>
<tr>
<td>Exclusive</td>
<td>fader &quot;owns&quot; preset intensities</td>
</tr>
<tr>
<td><strong>Exclude Int from Record</strong></td>
<td>Excludes intensity from this master from recording.</td>
</tr>
<tr>
<td><strong>Master button</strong></td>
<td><strong>Function</strong></td>
</tr>
<tr>
<td>Default</td>
<td>Select effect channel as a group</td>
</tr>
<tr>
<td>Start</td>
<td>Toggles fader to full/zero</td>
</tr>
<tr>
<td>Execute Attributes</td>
<td>Only executes attributes</td>
</tr>
<tr>
<td>Flash</td>
<td>Flashes the content</td>
</tr>
<tr>
<td><strong>Include intensity</strong></td>
<td>Playback will control intensity</td>
</tr>
<tr>
<td><strong>Attributes follow fader</strong></td>
<td><strong>Function</strong></td>
</tr>
<tr>
<td>Not used</td>
<td></td>
</tr>
<tr>
<td><strong>Fader type</strong></td>
<td><strong>Function</strong></td>
</tr>
<tr>
<td>Add</td>
<td>Adds intensities HTP</td>
</tr>
<tr>
<td>Solo</td>
<td>Replaces the content of all other masters</td>
</tr>
<tr>
<td><strong>Fader: Use time</strong></td>
<td>Fader will never fade faster than the fade time</td>
</tr>
<tr>
<td><strong>Return to (FCB)</strong></td>
<td><strong>Function</strong></td>
</tr>
<tr>
<td>Not used</td>
<td></td>
</tr>
<tr>
<td><strong>Preset</strong></td>
<td><strong>Function</strong></td>
</tr>
<tr>
<td>Not used</td>
<td></td>
</tr>
<tr>
<td><strong>Active Parameter Lock</strong></td>
<td><strong>Function</strong></td>
</tr>
<tr>
<td>Not used</td>
<td></td>
</tr>
<tr>
<td><strong>Flash button</strong></td>
<td><strong>Function</strong></td>
</tr>
<tr>
<td>Off</td>
<td>No function</td>
</tr>
<tr>
<td>Momentary</td>
<td>Flash when pressed</td>
</tr>
<tr>
<td>Latching</td>
<td>Toggles flash off/on</td>
</tr>
<tr>
<td><strong>Flash type</strong></td>
<td><strong>Function</strong></td>
</tr>
<tr>
<td>Add</td>
<td>Adds intensities HTP</td>
</tr>
<tr>
<td>Solo</td>
<td>Replaces the content of all other masters</td>
</tr>
<tr>
<td><strong>Flash mode</strong></td>
<td><strong>Function</strong></td>
</tr>
<tr>
<td>All</td>
<td>Intensities and attributes</td>
</tr>
<tr>
<td>Intensity</td>
<td>Intensities only</td>
</tr>
<tr>
<td>Attributes</td>
<td>Attributes only</td>
</tr>
<tr>
<td>Tap</td>
<td>Tap tempo for the effect</td>
</tr>
<tr>
<td><strong>Flash: Use time</strong></td>
<td>Flash will use master time</td>
</tr>
<tr>
<td><strong>Flash Level</strong></td>
<td><strong>Function</strong></td>
</tr>
<tr>
<td>Sets the target level for flash</td>
<td></td>
</tr>
</tbody>
</table>
Masters - Palettes

Enter the number, hold FOCUS, COLOR, BEAM, PALETTE and press a Master Key to load to that Master.

You can load and activate palettes from master playbacks. They are displayed with a "Fo,Co, Be, Pa" before the number in the master displays.

Once a palette is loaded onto a master you can use the master to activate the palette for selected channels:

- Use the master fader to fade manually to the palettes levels
- Use the master key to snap to the palettes levels
- Use #, then press the Master Key to fade to the palette's levels in # seconds
- Hold MODIFY and press the master key to open the Palette Editor

NOTE
The fader will fade the attributes of the selected channels to the palette values when moved up. What happens when you move the fader down depends on the setting of Return To in the Master Settings.

Load palettes to masters

This are the functions for loading palettes to masters.

<table>
<thead>
<tr>
<th>Function</th>
<th>Keys</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load Palette</td>
<td># [FOCUS] &amp; [Master Key]</td>
<td>Focus Palette # is loaded with name and number. You can do the same with COLOR, BEAM and ALL PALETTE's.</td>
</tr>
<tr>
<td>Load several Palettes</td>
<td># [FOCUS] &amp; [Master Keys]</td>
<td>Hold FOCUS and keep pressing master keys to load all existing of the same type. You can do the same with COLOR, BEAM and ALL PALETTE's.</td>
</tr>
</tbody>
</table>
Play back palettes from a master

Palettes are activated with the master key or the fader, for the currently selected channel(s).

<table>
<thead>
<tr>
<th>Function</th>
<th>Keys</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fade into palette</td>
<td>Fader</td>
<td>Selected channel(s) are faded into the palette</td>
</tr>
<tr>
<td>Activate Palette</td>
<td>Master Key</td>
<td>The Palette is activated for the selected channel(s)</td>
</tr>
<tr>
<td>Activate Palette on time</td>
<td># Master Key</td>
<td>The Palette is activated for the selected channel(s) in # seconds</td>
</tr>
</tbody>
</table>
Masters - Sequences

Enter the number, hold SEQUENCE and press a Master Key to load to that Master.

You can record, load and play back sequences from master playbacks. They are displayed with an "S" before the number in the master displays.

Once a sequence is loaded to a master you can

- Use the master fader to control the output level
- Use the flash key to flash the sequence
- Use the master key as a GO or Go/Pause key
- Use the flash key as a GoBack key
- Hold MODIFY and press the master key to open the sequence editor

Attributes are executed only when the fader is over zero.

Load a sequence to a master

These functions are used to load sequences to masters..

<table>
<thead>
<tr>
<th>Function</th>
<th>Keys</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load a sequence</td>
<td>[#] SEQ &amp; Master Key</td>
<td>Sequence # is loaded. The number and name is shown in the master display. If the sequence doesn't exist it is created.</td>
</tr>
<tr>
<td>Load several sequences</td>
<td>[#] SEQ &amp; Master Keys</td>
<td>Hold SEQ and keep pressing new Master keys to load the next stored Sequences.</td>
</tr>
</tbody>
</table>

NOTE
You can load a Sequence directly from the Sequences List as well. See Sequences List - Insert/Delete/Load.
Record a sequence to a master

When you record a second step to a master, or if a sequence is loaded to a master - you will get the option to continue to record to that sequence using the same recording logic as when you record to the sequence in the Main Playback.

Record a preset to a sequence in a master

1. Select channels (selection) or select none (all) to record.
   OPTION: Enter a preset or cue number. If you don't the next free last used for masters will be suggested.

2. Hold RECORD & Master key. Use the right arrow to select Sequence.

3. Enter a preset (or cue) text, Sequence name, and step text (optional) and press RECORD again.

In "Use master as general recording target" you have the option of selecting this master as the general recording target, which means that all new presets or cues recorded in the Live tab will be added to the sequence in this master.

Master settings for sequences

These are the settings you can change for masters with sequence content.

Hold SETUP and press the Master key to open the settings.
Please note that some settings will make other settings invalid - for example, if you set a master to Inhibit, the main function will be inhibit.

<table>
<thead>
<tr>
<th>Function</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mode</td>
<td>Inclusive = playback interacts with other playbacks</td>
</tr>
<tr>
<td></td>
<td>Inhibit = fader limits the output of the group</td>
</tr>
<tr>
<td></td>
<td>Exclusive = fader &quot;owns&quot; intensities</td>
</tr>
<tr>
<td>Exclude Int from Record</td>
<td>Excludes Intensity from this master from recording</td>
</tr>
<tr>
<td>Master button</td>
<td>Default = Select channels in current step as group</td>
</tr>
<tr>
<td></td>
<td>GO = Same as GO in the main playback</td>
</tr>
<tr>
<td></td>
<td>GO/Pause = Go and Pause</td>
</tr>
<tr>
<td></td>
<td>Start = Toggles fader to full/zero</td>
</tr>
<tr>
<td></td>
<td>Flash = Flashes the content</td>
</tr>
<tr>
<td>Include intensity</td>
<td>Playback will control intensities</td>
</tr>
<tr>
<td>Attributes follow fader</td>
<td>Not used</td>
</tr>
<tr>
<td>Fader type</td>
<td>Add = Adds intensities HTP</td>
</tr>
<tr>
<td></td>
<td>Solo = Not used</td>
</tr>
<tr>
<td>Fader: Use time</td>
<td>Fader will never fade faster than the fade time</td>
</tr>
<tr>
<td>Return to (FCB)</td>
<td>Not used</td>
</tr>
<tr>
<td>Preset</td>
<td>Not used</td>
</tr>
<tr>
<td>Active Parameter Lock</td>
<td>Not used</td>
</tr>
<tr>
<td>Flash button</td>
<td>Off = No function</td>
</tr>
<tr>
<td></td>
<td>Momentary = Flash when pressed</td>
</tr>
<tr>
<td></td>
<td>Latching = Toggles flash off/on</td>
</tr>
<tr>
<td></td>
<td>GoBack = Same as Go Back in the main playback</td>
</tr>
<tr>
<td>Flash type</td>
<td>Add = Adds intensities HTP</td>
</tr>
<tr>
<td></td>
<td>Solo = Not used</td>
</tr>
<tr>
<td>Flash mode</td>
<td>Intensity = Intensities only</td>
</tr>
<tr>
<td>Flash: Use time</td>
<td>Flash will use master time</td>
</tr>
<tr>
<td>Flash Level</td>
<td>Sets the target level for flash</td>
</tr>
</tbody>
</table>

**Dual Fader mode for Sequences**

When this mode is active, there are two modes involving two masters for controlling the sequence loaded to the first master, and there are more configurable buttons for controlling the sequence.

**Setting a master pair to A/B mode**

To be able to access these settings a sequence has to be loaded to the master. Hold SETUP and press the Master Key. This will open Master Settings with this option:
You can select the following options

**A+B**
The sequence master and the next higher master will control the sequence as an A/B playback providing a crossfader pair, just like when a sequence is controlled from the Main Playback.

**Int + A/B**
The first master controls the intensity of the sequence, and the second is a combined A/B crossfader.

The default button settings (press MODIFY on "Button settings for dual fader mode) are those listed in the dialog above.

The Master View will change to show these button settings and some more information for the A/B pair like this:
Simpler master wing displays: The linked A/B master shows the sequence number in parenthesis to indicate that the master is occupied.

NOTE
The Dual Fader mode setting can be selected also in the Master List (Browser >Masters >Master List).
Masters - Chase mode sequences

Enter the number, hold SEQUENCE and press a Master Key to load to that Master.

Once a chase is loaded to a master you can

- Use the master fader to control the output level
- Use the flash key to flash the chase
- Use the master key as a GO or Go/Pause key
- Use the flash key as a GoBack key

Attributes are executed only when the fader is over zero. The Chase will start from the first step every time the fader is brought over 0%.

Time Master
A special feature available for sequences in chase mode is a Time Master. By creating a time master you can control the speed of a chase.

A Time Master can only be assigned from the Master List.

1. Open the master list using [MODIFY] & [MASTER] or from the Browser >Masters >MasterList.

2. Set "Content Type" to "Time Master"

3. Set "Content" to the number of the chase you wish to control.
Load a chase sequence to a master

These functions are used to load chase mode sequences to masters.

<table>
<thead>
<tr>
<th>Function</th>
<th>Keys</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load a chase</td>
<td>[#] SEQ &amp; Master Key</td>
<td>Chase # is loaded to the Master Playback. The number and name are shown in the master display.</td>
</tr>
<tr>
<td>Load several chases</td>
<td>[#] SEQ &amp; Master Keys</td>
<td>Hold SEQ and keep pressing new Master keys to load the next stored Sequence/Chase.</td>
</tr>
</tbody>
</table>

**NOTE**
You can load a Chase directly from the Sequences List as well. See Sequences List - Insert/Delete/Load.

**NOTE**
Connect a Master to the Master Playback controls to get more control over the Chase. See Master Playback.

Master settings for chase mode sequences

These are the settings you can change for masters with sequence content.

Hold SETUP and press the Master key to open the settings.
Master: 2 - ()

Master button settings
Master button: Select Channels

Flash button settings
Flash button: Momentary
Flash type: Add
Flash mode: All
Flash: Use time: [unchecked]
Flash level: 100%

What the master button does
Please note that some settings will make other settings invalid - for example, if you set a master to Inhibit, the main function will be inhibit.

<table>
<thead>
<tr>
<th>Function</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mode</td>
<td>Inclusive = playback interacts with other playbacks</td>
</tr>
<tr>
<td></td>
<td>Inhibit = fader limits the output of the group</td>
</tr>
<tr>
<td></td>
<td>Exclusive = fader &quot;owns&quot; intensities</td>
</tr>
<tr>
<td>Exclude Int. from Record</td>
<td>Excludes intensity from this master from recording</td>
</tr>
<tr>
<td>Master button</td>
<td>Default = Select channels in current step as group</td>
</tr>
<tr>
<td></td>
<td>GO = Same as GO in the main playback</td>
</tr>
<tr>
<td></td>
<td>GO/Pause = Go and Pause</td>
</tr>
<tr>
<td></td>
<td>Start = Toggles fader to full/zero</td>
</tr>
<tr>
<td></td>
<td>Flash = Flashes the content</td>
</tr>
<tr>
<td>Include intensity</td>
<td>Playback will control intensities</td>
</tr>
<tr>
<td>Attributes follow fader</td>
<td>Not used</td>
</tr>
<tr>
<td>Fader type</td>
<td>Add = Adds intensities HTP</td>
</tr>
<tr>
<td></td>
<td>Solo = Not used</td>
</tr>
<tr>
<td>Fader: Use time</td>
<td>Fader will never fade faster than the fade time</td>
</tr>
<tr>
<td>Return to (FCB)</td>
<td>Not used</td>
</tr>
<tr>
<td>Preset</td>
<td>Not used</td>
</tr>
<tr>
<td>Active Parameter Lock</td>
<td>Not used</td>
</tr>
<tr>
<td>Flash button</td>
<td>Off = No function</td>
</tr>
<tr>
<td></td>
<td>Momentary = Flash when pressed</td>
</tr>
<tr>
<td></td>
<td>Latching = Toggles flash off/on</td>
</tr>
<tr>
<td></td>
<td>GoBack = Same as Go Back in the main playback</td>
</tr>
<tr>
<td></td>
<td>Tap = Tap mode for the chase Bpm</td>
</tr>
<tr>
<td>Flash type</td>
<td>Add = Adds intensities HTP</td>
</tr>
<tr>
<td></td>
<td>Solo = Not used</td>
</tr>
<tr>
<td>Flash mode</td>
<td>Intensity = Intensities only</td>
</tr>
<tr>
<td>Flash: Use time</td>
<td>Flash will use master time</td>
</tr>
<tr>
<td>Flash Level</td>
<td>Sets the target level for flash</td>
</tr>
</tbody>
</table>
Masters - Dynamics

Enter the number, hold DYN EFFECT and press a Master Key to load to that Master.

You can load and activate dynamic templates direct from master playbacks. These are temporary data stored in the current Master Page. They are displayed with an "Dy" before the number in the master displays.

Once a dynamic template is loaded to a master you can

- Use the master key to activate the dynamic effect for the currently selected channel(s).

**NOTE**
This is an old version of dynamic effects in Cobalt. We recommend you to use the new Dynamic Effect playback instead, since it offers much more control.

Load a dynamic template to a master

These functions are used to load dynamic effect templates to masters.

<table>
<thead>
<tr>
<th>Function</th>
<th>Keys</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load a dynamic</td>
<td>[#] DYN EFFECT &amp; Master Key</td>
<td>The number and name are shown in the master display</td>
</tr>
<tr>
<td>Load several dynamics</td>
<td>[#] DYN EFFECT &amp; Master Keys</td>
<td>Hold DYN EFFECT and keep pressing new Master keys to load the next dynamic template.</td>
</tr>
</tbody>
</table>
Masters - Magic Sheets (8.0)

From the CONTENT column in the Master List (Browser) you can load a Magic Sheet to a Master to be able to select it from the Master button.

You can load and activate Magic Sheets directly from master playbacks. These are temporary data stored in the current Master Page. They are displayed with an "La" before the number in the master displays.

Once a Magic Sheet is loaded to a master you can

- Use the master key to activate it for the currently selected channel view.

Load a Magic Sheet to a master

Magic Sheets can only be assigned from the Master List.

1. Open the master list (Browser >Masters >MasterList).

2. Set "Content Type" to "Layout"

3. Set "Content" to the number of the layout you wish to assign.
Masters - Attribute parameters

Hold a Wheel Parameter key and press a Master Key to load to that Master.

You can load and activate attribute parameters from master playbacks. This is very useful for parameters that map well to faders, like iris, focus, shutters and color mixing.

Once an attribute parameter is loaded to a master, and depending on the nature of the parameter, you can

- Use the master fader as the "parameter wheel"
- Use the master key as the "parameter wheel key"
- Hold the Master key and use the level wheel to change the value relatively

The result is applied to the selected channel(s).

Load a parameter to a master

To load a parameter to master select a device with that parameter, hold the parameter wheel key and press a master key.

To be able to do this you must have a device selected that has the parameter you wish to load, and the parameter page (Focus, Color, Beam) has to be selected so the parameter is active on one of the wheels.

To remove a parameter from a master, hold C and press the master or potentiometer key.
Masters - Console keys

From the CONTENT column in the Master List (Browser) you can load any console key to a Master.

You can assign any console key to a master playback. This is useful if there is a soft key you are using a lot like "select 2nd" or "DATA", so you have fast access to it. Console keys are displayed with a "Ke" and the key function, in the master displays.

Once a console key is loaded to a master you can

- Use the master key as the console key

NOTE
You cannot clear a console key from a master by holding C and pressing the master key - since C is used in combination with console keys. To clear, go to the Master List.
Load a console key to a master

Console keys can only be assigned from the Master List.

1. Open the master list using [MODIFY] & [MASTER] or from the Browser >Masters >MasterList.

   ![Master List Image]

2. Set "Content Type" to "key"

3. Set "Content" to the key of your choice.
Masters - Macros

From the CONTENT column in the Master List (Browser) you can load a Macro to a Master.

You can assign a macro key to a master playback so you have fast access to it. Macro keys are displayed with a "Ma" and its text, in the master displays.

Once a macro key is loaded to a master you can

  • Use the master key as the macro key

Load a macro to a master

Macros can only be assigned from the Master List.

1. Open the master list (Browser >Masters >MasterList).

2. Set "Content Type" to "Macro"

3. Set "Content" to the macro number of your choice.
Masters - Drag and Drop Data

There are many ways of moving around data between masters. Drag and drop is one of them. It can be useful if you want to reorganize the content of your masters.

- You can drag a channel selection from any channel view to a master.
- You can drag any type of object that can be loaded to a master from the Browser
- You can move content between masters. Note that all master settings will be moved along with the content.

If there is content in a master field, you will get a dialogue for overwriting:
Drag and Drop Master Links

You can create a master link in a sequence by dragging the master from the master view to the sequence step.

The master will be linked with a target level or 100% if it is over 50% when linked, and a target level of 0% if it is under 50% when linked. You can double-click the master link in the Playback view to edit it.

See Sequence Step Links - Master Playbacks.
**Masters - Swap upper/lower**

Press SWAP to interchange the content and levels of the upper row of master faders with the lower row.

Playback content and fader levels are matched with the motorized faders. Press again to swap back.
Masters - Select Playback Range

Press and hold RANGE to be able to select which bank, or range of master playbacks you wish to control from the physical faders and pots. There are 80 master playbacks available at all times in the system.

You can also enter the number of a master, hold RANGE and press MASTER to assign this range to the master faders.

The principle of Fader Ranges:

You can press the keys above/under the displays.
**Masters - Fader Modes**

Press and hold FADER MODE to be able to select different operational modes for the master section.

You can press the keys above/under the displays.

These are the modes available:

- **Masters** (default operation)
- **Two Scene** (for busking)
- **Expanded Masters**
- **Expanded Effects** (all/active)
- **Expanded Sequence** (all/active)
Fader Mode - Masters

Press FADER MODE to select default Masters mode. You can press the keys above/under the displays.

In Masters mode the lower row of motorized faders control masters 1-20, and the upper row of pots control masters 21-40.
**Fader Mode - Two Scene Masters**

Hold FADER MODE and select TWO SCENE to activate Two Scene Masters. You can press the keys above/under the displays.

Two scene masters takes old school improvisation where channels could be preset blind and then faded onto stage to a new level.

- The top twenty master faders are blind (1)
- The lower twenty masters are live (2)

You can set up and record anything on the top masters, and then fade on your choice of fade time into these settings. Once the fade is complete, all settings in the top masters have been loaded to the lower masters - which means that you have live control of them.
Fading Two Scene Masters

To fade the settings and content of the top row of masters (blind) into the bottom row of masters (live) press START or GO on the Masters Playback.

You can enter a time before pressing START or GO. This time will continue to be used until a new time is entered.

NOTE
Any changes you make to content in the top masters will be loaded to the bottom live masters, but ONLY if the fader of the master is over zero %.

It is possible to modify the Live masters at all times except when there is a crossfade running between Live and Blind because of the dipless calculation.

In Cobalt 10: Press RANGE to the other upper/lower bank.

Create new looks in Blind and record to masters

One way of improvising on the fly in two-scene masters mode is to use the Blind field to create new looks, record them to the top masters and fade into them.

1. Press BLIND to activate the blind tab.

2. Select the channels and moving devices you want to modify blind, and use the parameter wheels and palette functions to create a look.
3. Hold RECORD and press a Master key for a master in the top row to record to that master. A popup will ask you to confirm.

4. Bring up the master fader to activate the look. Press START to fade into that look and load it to the corresponding master in the lower "live" row.
Fader Mode - Expanded Masters

Hold FADER MODE and select EXPANDED MASTERS to activate. You can press the keys above/under the displays.

Expanded Masters will use the whole "strip of controls" for one master playback - providing expanded control for 20 masters at a time. See Masters - Introduction.
In Expanded Masters mode you can set the buttons and faders and pots to the functions of your choice. See Masters - Settings.
**Fader Mode - Expanded Effects**

Hold FADER MODE and select EXPANDED EFFECTS to activate. You can press the keys above/under the displays.

Select ALL for all effect playbacks and ACTIVE for all active effect playbacks at the moment of selecting this mode.

Expanded Effects will use the whole "strip of controls" for one master playback - providing expanded control for 20 masters at a time. See Masters - Introduction.
In Expanded Effects mode you get more buttons and faders and pots to control the functions of your choice (fixed).

These are the settings:

- Pot = rate
- Pot click = tap tempo
- Button over display = Source
- Button under display = Set/Group (source target)
- Flash button = Flash
Fader Mode - Expanded Sequences

Hold FADER MODE and select EXPANDED SEQUENCES to activate. You can press the keys above/under the displays.

Select ALL for all sequence playbacks and ACTIVE for all active sequence playbacks at the moment of selecting this mode.

Expanded Sequences will use the whole "strip of controls" for one master playback - providing expanded control for 20 masters at a time. . See Masters - Introduccion.
In Expanded Sequences mode you can set the buttons and faders and pots to the functions of your choice. See Masters - Settings.
Masters - Beat Boss

In the Master List (Browser>Masters>Master List) open the Content Type and select Beat Boss and Content number 1-9. Beat Bosses can be applied to Chase and Content effects. The top row of masters in Cobalt hardware with the potentiometers is by far the best control surface for a Beat Boss. See Chase Beat Boss and Content Effect Beat Boss.

When a master is assigned a Beat Boss, the slider or potentiometer will change the value. To tap a BB on a fader set the FLASH key to TAP manually.

- The BPM will be set to 120 with the fader at 50%, 240 at the top and 0 at the bottom.
- Chase/Content effects: Added Beat Boss parameter that links an effect to a beat boss.
- Current beat boss BPM values are stored in the show file.

When a Beat Boss is assigned to several effects and runs on a master, you can select all effects by pressing the master key.
Master View

Press MASTER to open the Master View tab. The Master View is a graphical view of the content in the master playbacks. It has several formats and is zoomable. (Browser >Masters >Master View)

1. Indication of Master View mode (see 3)
2. Context menu for viewing format
3. Master View settings and view modes
4. Master Page name and number
5. Master Page keys
6. Master symbol
7. Context menu for master symbol

NOTE
Master Views can be opened in any screen area as a tab content.
Using a mouse or trackball

<table>
<thead>
<tr>
<th>Function</th>
<th>Keys</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using a mouse</td>
<td>click</td>
<td>Click to select and hold right key and move to set levels. Click to add more, double-click to deselect all but the last clicked.</td>
</tr>
<tr>
<td>Open the Master Editor</td>
<td>MODIFY &amp; click</td>
<td>The Master Editor is opened.</td>
</tr>
</tbody>
</table>

Master View - Formats

You can toggle between viewing formats by pressing FORMAT

- All Masters
- Selected Masters
- Active Masters
- Masters with content

You can toggle what is shown for a sequence or chase by holding FORMAT and pressing right/left arrows

- Preset/text
- Preset/time
- Text

You can zoom the level of detail by holding FORMAT and pressing the up/down arrows.
You can zoom the size of the masters by holding FORMAT and using the level wheel.

The currently selected format is indicated in the top right corner of each Master View.

**NOTE**
In the All format there is a header bar visible for each row of masters that shows information about the currently selected master page.
**Master List**

Hold MODIFY and press MASTER to open the Master List, a spreadsheet editor for all master fields where you can change settings and assign content to several fields at the same time. (Browser >Masters >Master List)
Master list - Columns & Functions (8.0)

All of these are explained per content type in **Masters - Functions**.

<table>
<thead>
<tr>
<th>Column</th>
<th>Input</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master</td>
<td></td>
<td>The number of this Master, cannot be edited.</td>
</tr>
<tr>
<td>Content Type</td>
<td>MODIFY</td>
<td>Press MODIFY to open a dropdown with choices of content. See Masters - Content</td>
</tr>
<tr>
<td>Content</td>
<td>#</td>
<td>Sets the number # for the content type.</td>
</tr>
<tr>
<td>In</td>
<td>MODIFY</td>
<td>Used by START, Flash on time, Use Master Times and Master links. If only an In time is set, it will function as an Out time as well.</td>
</tr>
<tr>
<td>Wait</td>
<td>MODIFY</td>
<td>Used by START and Master links. It is how long the master will stay up before the Out time fades out.</td>
</tr>
<tr>
<td>Out</td>
<td>MODIFY</td>
<td>Used by START and Master links. It is how fast the master fade out after a Wait time.</td>
</tr>
<tr>
<td>Mode</td>
<td>MODIFY</td>
<td>Set Master Mode Inclusive, Inhibit or Exclusive. See Masters - Modes.</td>
</tr>
<tr>
<td>Master Button</td>
<td>MODIFY</td>
<td>Set behavior for the Master Button - choose from dropdown. See Master Button.</td>
</tr>
<tr>
<td>Fader Type</td>
<td>MODIFY</td>
<td>Toggles Add (default) and Solo mode. See Solo Mode.</td>
</tr>
<tr>
<td>Fader Intensity Mode</td>
<td>MODIFY</td>
<td>Set behavior for controlling intensities (Disabled, Follow Manual Fader, Follow Time). See Master Fader Settings.</td>
</tr>
<tr>
<td>Fader Attribute Mode</td>
<td>MODIFY</td>
<td>Set behavior for controlling attributes(Disabled, Follow Manual Fader, Execute at #%). See Master Fader Settings.</td>
</tr>
<tr>
<td>Return to (FCB)</td>
<td>MODIFY</td>
<td>Set behavior for Return to FCB (Off, Previous, Preset, Main Pb). See Master Fader Settings.</td>
</tr>
<tr>
<td>Preset</td>
<td>MODIFY</td>
<td>Set Preset for Return to FCB. See Master Fader Settings.</td>
</tr>
<tr>
<td>Active Parameter Lock</td>
<td>MODIFY</td>
<td>Attributes are locked to fader. See Master Fader Settings.</td>
</tr>
<tr>
<td>Flash Button</td>
<td>MODIFY</td>
<td>Sets behavior for Flash button. See Master Fader Settings.</td>
</tr>
<tr>
<td>Column</td>
<td>Input</td>
<td>Function</td>
</tr>
<tr>
<td>----------------</td>
<td>-------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Flash mode</td>
<td>MODIFY</td>
<td>Toggles between All/Intensities/Attributes. See Flash Settings.</td>
</tr>
<tr>
<td>Flash use time</td>
<td>MODIFY</td>
<td>Toggles if flash uses time. See Flash Settings.</td>
</tr>
<tr>
<td>Flash level</td>
<td>#</td>
<td>Sets flash level #. See Flash Settings.</td>
</tr>
<tr>
<td>Exclude Record</td>
<td>MODIFY</td>
<td>Toggles Exclude intensity from recording. See Exclude Int From Record.</td>
</tr>
<tr>
<td>Dual Fader Mode</td>
<td>MODIFY</td>
<td>Sets dual fader mode setup for this master. See Dual Fader Mode For Sequences.</td>
</tr>
<tr>
<td>Mask</td>
<td>MODIFY</td>
<td>Assigns a Mask. See Mask in masters.</td>
</tr>
<tr>
<td>Page Time</td>
<td></td>
<td>Shows the Master Page time that affects all In-Wait-Out times set in %. See Master Page Times - Page Time</td>
</tr>
</tbody>
</table>

**NOTE**
Times can be set in % or in seconds. This is selected in the Settings Attributes - you can always toggle this by holding C before pressing MODIFY in the In/Wait/Out columns.
## Masters - Content

You can play back almost any kind of content from a Master Playback. The content can be loaded directly or from the Master Editor. See Load/Clear & Master Editor.

<table>
<thead>
<tr>
<th>Content</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prs</td>
<td>Play back Preset from fader, select channels with Master key. Flash with Flash key.</td>
</tr>
<tr>
<td>Chs</td>
<td>Single channels or several channels as a temporary selection (previously called Grp).</td>
</tr>
<tr>
<td>Device</td>
<td>Single devices can be loaded and selected.</td>
</tr>
<tr>
<td>Seq</td>
<td>Play back Sequences. The Master key is Go. The fader is a Grand Master for that Sequence. Connect to the Master Playback for more functions.</td>
</tr>
<tr>
<td>Chases (old)</td>
<td>Play back Sequences in Chase mode. The Master key is Go. The fader is a Grand Master for that Sequence. Connect to the Master Playback for more functions.</td>
</tr>
<tr>
<td>Focus, Color, Beam, Pal</td>
<td>Activate any kind of Palette (F, C, B, All) for the selected channels.</td>
</tr>
<tr>
<td>Macro</td>
<td>Assign a Macro to activate with the master key.</td>
</tr>
<tr>
<td>Dynamic</td>
<td>Activate a Dynamic Effect for the selected channels.</td>
</tr>
<tr>
<td>Mask (obsolete)</td>
<td>This feature is obsolete - it is still visible to be backwards compatible.</td>
</tr>
<tr>
<td>Key</td>
<td>A master can be set as any console key. The master key will function as this key.</td>
</tr>
<tr>
<td>Group</td>
<td>Play back Groups from fader, select channels with Master key. Flash with Flash key.</td>
</tr>
<tr>
<td>Layout</td>
<td>Any MAagic Sheet can be assigned to a Master Playback with this feature.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Any parameter of a moving device can be assigned to a Master Playback*</td>
</tr>
<tr>
<td>Time Master</td>
<td>Any Master can be assigned as a Time Master for a Sequence in Chase mode. See Chases (old).</td>
</tr>
<tr>
<td>Beat Boss</td>
<td>Any master can be a control for a Beat Boss 1-9. See Masters - Beat Boss.</td>
</tr>
</tbody>
</table>

*Can be assigned by holding a Parameter key and pressing the Master key, or from the Master List.
Master Pages

Master Pages store all content for 20 masters and can be used used in any row of 20 Master Playback Faders, eg the upper (21-40) or lower (1-20) rows.

This chapter contains the following sections:

- Master Pages - Introduction
- Master Pages - Record
- Master Pages - Functions
- Master Pages - List
- Master Pages - Editor
- Master Pages - Times
- Master Pages - Auto-update Mode
- Master Pages - Display List
Master Pages - Introduction

You can store all content of 20 Master Playbacks into a Master Page. Master Pages can be stepped through, or loaded.

General Functionality

- Master Pages are stored for 20 Master Playbacks.
- Page 1 & 2 are automatically loaded when creating a new Play.
- You can store up to 999 Master Pages.
- Each Page can have a text label.
- A Page can be Transparent - meaning empty Master Playbacks are not cleared when this page is loaded.
- Each Page can have a Time and BPM affecting all chasers, presets and palettes.

NOTE
Loading a new Master Page puts the new content in a pending state if the master is above 0%. When the Master is faded to 0% the new information is loaded.
# Master Pages - Record (8.0)

All content changes in the affected Master Range (1-20 or 21-40) are automatically recorded. They can be recorded manually to the same Page or to another Page as well.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record to the currently loaded Master Page in masters 1-21.</td>
<td>RECORD &amp; PAGE</td>
<td>You will get a confirmation in the message window at the bottom of the screens.</td>
</tr>
<tr>
<td>Record what is in masters 1-21 to Master Page #</td>
<td># RECORD &amp; PAGE</td>
<td>You will get a confirmation in the message bar at the bottom of the screens.</td>
</tr>
</tbody>
</table>

**NOTE**

In Congo Jr and Kid you can record to a Master Page using the Page #(#) buttons in the Soft Key Displays.
Master Pages - Functions

It is possible to load and change Master Pages separately to any bank (1-20, 21-40, 41-60, 61-80) of Master Playbacks. When a new play is created Page 1-4 are automatically loaded.

Press PAGE to activate the page direct select keys in the master displays.

More ways to use the PAGE key:

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load Master Page #</td>
<td># [PAGE] Master Key</td>
<td>Master Page # is loaded* to the row of masters of the Master Key (upper/lower)</td>
</tr>
<tr>
<td>Step to next Master Page for the lower bank.</td>
<td>PAGE [+]</td>
<td>Loads the next Master Page.</td>
</tr>
<tr>
<td>Step to previous Master Page for the lower bank.</td>
<td>PAGE [-]</td>
<td>Loads the previous Master Page.</td>
</tr>
</tbody>
</table>

*The corresponding Masters are cleared. If the Page does not exist it will be created

NOTE
PENDING - If a master fader is over 0% when new content is loaded - it will load the new content after fading to 0%.
Master Pages - List

You can view, edit and create Master Pages directly in the Master Page List (BROWSER >Masters >Master Pages).

NOTE
The system always creates 10 empty Master Pages when a new Play is opened.

Master Pages List - Columns

<table>
<thead>
<tr>
<th>Column</th>
<th>Input</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page</td>
<td>No input</td>
<td>The number of this Page - cannot be edited.</td>
</tr>
<tr>
<td>Text</td>
<td>ABCDE...</td>
<td>Press MODIFY to activate and end text input.</td>
</tr>
<tr>
<td>Transparent</td>
<td>[MODIFY]</td>
<td>When ON this Master Page will only load the stored masters.</td>
</tr>
<tr>
<td>Time</td>
<td>[MODIFY]</td>
<td>This time can be set to affect all percent times in this Master Page. See Master Page Times.</td>
</tr>
<tr>
<td>BPM</td>
<td>[MODIFY]</td>
<td>This value can be set to affect all chase rates in this Master Page. See Master Page Times.</td>
</tr>
</tbody>
</table>
Master Pages List - Functions

These are the functions in the Master Pages List

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert a Master Page</td>
<td>INSERT</td>
<td>Inserts a new Master Page with the next free number</td>
</tr>
<tr>
<td>Insert Master Page #</td>
<td>#</td>
<td>INSERT</td>
</tr>
<tr>
<td>Delete the selected Master Page</td>
<td>DELETE</td>
<td>Deletes the selected Master Page. Cannot be undone.</td>
</tr>
</tbody>
</table>
**Master Pages - Editor**

In the Master Page Editor you can view and edit the content and times of Master Pages. Open in Browser> Masters >Master Pages> Master Page #.

You can use copy and paste to make a copy of an existing master page.

**Master Page - Columns**

<table>
<thead>
<tr>
<th>Column</th>
<th>Input</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master</td>
<td></td>
<td>The number of this Master, cannot be edited.</td>
</tr>
<tr>
<td>Content Type *</td>
<td>MODIFY</td>
<td>Press MODIFY to open a dropdown with choices of content.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>See Masters - Content</td>
</tr>
<tr>
<td>Content</td>
<td>#</td>
<td>Sets the number # for the content type.</td>
</tr>
<tr>
<td>In</td>
<td>#</td>
<td>Used by START, Flash on time, Use Master Times and Master links. If only an In time is set, it will function as an Out time as well.</td>
</tr>
<tr>
<td>Wait</td>
<td>#</td>
<td>Used by START and Master links. It is how long the master will stay up before</td>
</tr>
<tr>
<td>Column</td>
<td>Input</td>
<td>Function</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>the Out time fades out.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Out</td>
<td>#</td>
<td>Used by START and Master links. It is how fast the master fade out after a Wait time.</td>
</tr>
<tr>
<td>Mode</td>
<td>MODIFY</td>
<td>Set Master Mode Inclusive, Inhibit or Exclusive. See Masters - Modes.</td>
</tr>
<tr>
<td>Master Button</td>
<td>MODIFY</td>
<td>Set behavior for the Master Button - choose from dropdown. See Master Button.</td>
</tr>
<tr>
<td>Fader Type</td>
<td>MODIFY</td>
<td>Toggles Add (default) and Solo mode. See Solo Mode.</td>
</tr>
<tr>
<td>Fader Intensity Mode</td>
<td>MODIFY</td>
<td>Set behavior for controlling intensities (Disabled, Follow Manual Fader, Follow Time). See Master Fader Settings.</td>
</tr>
<tr>
<td>Fader Attribute Mode</td>
<td>MODIFY</td>
<td>Set behavior for controlling attributes(Disabled, Follow Manual Fader, Execute at #%). See Master Fader Settings.</td>
</tr>
<tr>
<td>Return to (FCB)</td>
<td>MODIFY</td>
<td>Set behavior for Return to FCB (Off, Previous, Preset, Main Pb). See Master Fader Settings.</td>
</tr>
<tr>
<td>Preset</td>
<td>MODIFY</td>
<td>Set Preset for Return to FCB. See Master Fader Settings.</td>
</tr>
<tr>
<td>Active Parameter Lock</td>
<td>MODIFY</td>
<td>Attributes are locked to fader. See Master Fader Settings.</td>
</tr>
<tr>
<td>Flash Button</td>
<td>MODIFY</td>
<td>Sets behavior for Flash button. See Flash Settings.</td>
</tr>
<tr>
<td>Flash mode</td>
<td>MODIFY</td>
<td>Toggles between All/Intensities/Attributes. See Flash Settings.</td>
</tr>
<tr>
<td>Flash use time</td>
<td>MODIFY</td>
<td>Toggles if flash uses time. See Flash Settings.</td>
</tr>
<tr>
<td>Flash level</td>
<td>#</td>
<td>Sets flash level #. See Flash Settings.</td>
</tr>
<tr>
<td>Exclude Record</td>
<td>MODIFY</td>
<td>Toggles Exclude intensity from recording. See Exclude Int From Record.</td>
</tr>
<tr>
<td>Dual Fader Mode</td>
<td>MODIFY</td>
<td>Sets dual fader mode setup for this master. See Dual Fader Mode For Sequences.</td>
</tr>
<tr>
<td>Mask</td>
<td>MODIFY</td>
<td>Assigns a Mask. See Mask in masters.</td>
</tr>
<tr>
<td>Column</td>
<td>Input</td>
<td>Function</td>
</tr>
<tr>
<td>------------</td>
<td>-------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Page Time</td>
<td></td>
<td>Shows the Master Page time that affects all In-Wait-Out times set in %. See Master Page Times - Page Time.</td>
</tr>
</tbody>
</table>

*Content dropdown*
Master Pages - Times

Master Playback times can be stored in Master Pages. Times are set from 0.1 seconds to 49.59 minutes (0.1-4959).

General Facts

- A Master Playback can have an in/wait/out time.
- A Master Page can have a general time used for all Palettes and Presets.
- A Master Page can have a BPM time for all Chases.

Master Page Times - In, Out, Wait

Fade times for a Master Playback can be stored in a Master Page.

The times are activated in the following situations

- When the master is linked from a Sequence Step.
- When you hold START and press the Master Key.
- When Flash On Time is active (SETUP & Master Key).

<table>
<thead>
<tr>
<th>Function</th>
<th>Keys</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Activate the Master Pages List</td>
<td>Browser &gt; Master Pages</td>
<td>The Master Pages List is opened.</td>
</tr>
<tr>
<td>2. Activate a Master Page List</td>
<td>Arrow keys</td>
<td>The Master Page List is opened.</td>
</tr>
<tr>
<td>3. Go to In-Wait-Out Times</td>
<td>Arrow keys</td>
<td>Each selected cell is highlighted</td>
</tr>
<tr>
<td>4. Set a time*</td>
<td>[#] MODIFY</td>
<td>A time of # is set</td>
</tr>
</tbody>
</table>

Master Page Times - Page Time

The Master Page Time is used for Palettes (content= palette) and Presets with In times set in %.

<table>
<thead>
<tr>
<th>Function</th>
<th>Keys</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Master Page Time*</td>
<td>[#] TIME PAGE</td>
<td>A Master Page Time # is set to the currently loaded Master Page.</td>
</tr>
</tbody>
</table>

*The Master Page Time can be set from the Master Page List as well.
Master Page Times - BPM

The Master Page BPM will affect all chasers running in that Master Page.

<table>
<thead>
<tr>
<th>Function</th>
<th>Keys</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Master Page BPM*</td>
<td>TAP &amp; PAGE</td>
<td>Tap at least two times to set a BPM. You can edit it in the Master Page List.</td>
</tr>
</tbody>
</table>

*If chases have a rate, it will be scaled by the BPM.
The independents are potentiometers and keys that can be set up to control lights that you want to separate from the main controls - such as houselights, work lights etc.

Independents Node

This chapter contains the following sections

- Independents - Introduction
- Using the Independents
- Independent Modes
**Independents - Introduction**

The Independents offer a control surface for potentiometers and keys to which you can assign channels that can be excluded from normal control and recording.

In Cobalt there are six independent potentiometers. These can be used for

- Adding light (inclusive mode)
- Removing light (inhibit mode)
- Independent lights (Exclusive mode)

There are three independent keys. These can be used as toggle or flash for

- Houselights
- Smoke machines
- Relays
**Using the Independents**

<table>
<thead>
<tr>
<th>Action</th>
<th>Console</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Open the Setup*</td>
<td>Hold Setup and move the potentiometer or press a key**</td>
<td>A popup will appear with a channel view***</td>
</tr>
<tr>
<td>2. Set channels, levels and attributes</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3. Select Mode</td>
<td>MODIFY</td>
<td>See Independent Modes</td>
</tr>
<tr>
<td>4. Select Execute</td>
<td>Arrow key</td>
<td>Execute is highlighted</td>
</tr>
<tr>
<td>5. Store</td>
<td>MODIFY</td>
<td>The popup is closed</td>
</tr>
</tbody>
</table>

*The Setup can be opened from the Browser as well (Browser >Independents)*

**Keys have the option to be toggling on/off.**

***The Independent popup
Step 1: Select the channels/levels to operate on in the Channel View
Step 2: Select options and Execute
- Function: Exclusive
- Text: Housetlights
- Include attributes: [ ]

Execute
## Independent Modes

<table>
<thead>
<tr>
<th>Mode</th>
<th>Screen</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exclusive</td>
<td>Blue level</td>
<td>Blackout, GrandMaster, Capture or any other channel function will not affect this channel(s).</td>
</tr>
<tr>
<td>Inclusive</td>
<td>No indication</td>
<td>Works as an additional Master Playback</td>
</tr>
<tr>
<td>Inhibit</td>
<td>Red level</td>
<td>Is an Inhibit Master - works as a Grand Master for the selected channel(s).*</td>
</tr>
</tbody>
</table>

*If you have several Independent Functions set to Inhibit and they have overlapping channels, the highest Special Function will be in control. The result on stage can be recorded.

**NOTE**
Only Intensities can be Exclusive. Attributes remain LTP, and thus may be 'stolen' back by the rest of the console.
Independents Tab

Independents allow you to set up houselights and other show content that you wish to control separately.

Symbol in the Tab Selector

The Independents tab

It is possible to select Independents and set levels from the tab with the MASTER key.

<table>
<thead>
<tr>
<th>Function</th>
<th>Keys</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select an Independent</td>
<td>[#] MASTER</td>
<td>Independent # is selected and highlighted.</td>
</tr>
<tr>
<td>Add</td>
<td>[#] +</td>
<td>Independent # is added.</td>
</tr>
<tr>
<td>Add a range</td>
<td>[#] THRU</td>
<td>Up to Independent # are added.</td>
</tr>
<tr>
<td>Subtract</td>
<td>[#] -</td>
<td>Independent # is subtracted.</td>
</tr>
<tr>
<td>Set a level</td>
<td>[#] @LEVEL</td>
<td>The Independent levels are set to #.</td>
</tr>
<tr>
<td>Set a level</td>
<td>Wheel</td>
<td>The Independent levels are set to #.</td>
</tr>
<tr>
<td>Step to next/previous</td>
<td>+ -</td>
<td>Steps to next/previous</td>
</tr>
</tbody>
</table>

Using a mouse or trackball
Click to select and hold right key and move to set levels. Click to add more, double-click to deselect all but the last clicked.
Remote Controls

There are different remote control systems for Cobalt. Each one has its own working field. This is where you can set/edit and clear these fields, and rename the remotes.

Remote Controls node

This chapter contains the following sections

- Clear Remotes
- Remote Control List

All different types of remote controls are described in Accessories - Remote Control.

Clear Remotes

Select this node and press MODIFY to clear all intensities set in remote fields.

This function is available in the Misc Soft Key Menu as well.
Remote Control List

Open from BROWSER >Remote Controls >Remotes List. This editor shows all active remote controls.

You have the possibility to give names to each Remote control (currently only possible on Net3 RFR devices) and disable the contribution from specific remotes. In Settings: System, you can set all remote input to off. See Play Settings - System.

- If you press MODIFY in the Clear Levels column, you can quickly clear all levels from that remote.
- The channels and levels in each remote field can be edited directly in the channel view in the top of the editor.
- The Online column is just an indicator for network RFR's.
- To set this remote to work in A instead of it's unique remote field activate this cell.
### 3. Remote Control List

<table>
<thead>
<tr>
<th>Remote</th>
<th>Name</th>
<th>Enabled</th>
<th>Remote uses A field</th>
<th>Clear Levels</th>
<th>Online</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>RFR (USB)</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Available choices: Modify
This Chapter is about the console key functions, keyboard equivalents and shortcuts. Its a very useful chapter.

This chapter contains the following sections

- [Console Key Quick Help](#)
- [Console Key Shortcuts](#)
Console Key Quick Help

These are all console keys with a short explanation and a summary of functions, in alphabetical order.

- This text is linked to each key in the console and opens if you hold [?] and press a key.
- There are links to the corresponding chapters of the manual.
- The keyboard equivalent in an alphanumeric keyboard is listed.

Console Key - ?

This is the HELP function. It activates the online help system, which is a complete electronic copy of the user manual.

- [HELP] - Activates Help.
- [HELP] & [KEY] - Activates help for that key.
- [HELP] - after opening an editor or list opens help for that editor.

For more information see This Manual.

Keyboard equivalent: [F1]

Console Key - <-- (Disp Mode)

Press this key to move one level up in the main display soft key menus of the console.

For more information see Main Playback - Edit Keys.

No keyboard equivalent

Console Key - @LEVEL

This key is used to set levels to channels. It can also be used in combination with other keys for specific level functions.

- [#] [LEVEL] - Set level # to the currently selected channels.
- [LEVEL] = 70%
- [LEVEL] [LEVEL] = 100%
- [LEVEL] [LEVEL] [LEVEL] = 0%
- [CHANNEL] & [LEVEL] - Sets a temporary ID level 0-100% to the currently selected channels.
- [SETUP] & [LEVEL] - Opens the level settings.
- [ON/FETCH]&[LEVEL] - Revert (undo) changes to channel level.
NOTE
If the console is set to operate in At Mode this key has a slightly different syntax. See Channels - Command Syntax.

For more information see Set Channel levels.

Keyboard equivalent: [+]

Console Key - A

Opens the channel view for the A field of the Main Playback. The channel control will be connected to the A field.

- [A] - Opens and selects the A tab.
- [TIME] & [A] - Forces the setting "Times to A"

For more information see Main Playback - Edit Keys.

Keyboard equivalent: [A]

Console Key - ALIGN

This key is used to align device parameters to the one currently selected with NEXT/LAST.

- [ALIGN] & [parameter key] (CYAN, or FOCUS for example) - Aligns these parameters.

For more information see Device Control - Align.

Keyboard equivalent: [Alt] & [A]

Console Key - ALL

The ALL key is used for selecting channels with levels over 0% in different targets.

- [ALL] - Selects all channels with a level over 0% in any channel view.
- [ALL] [ALL] - In the Live view the first press will select all channels over 0% in A, the second press will select channels in all Master Playbacks as well.
- [ALL] & [PALETTE KEY] - Hold ALL and press a Direct Select key for a palette to select all channels with an intensity over 0% using that palette.

For more information see Select Channels.

Keyboard equivalent: [SHIFT] & [-]
**Console Key - Arrow Keys**

The arrow keys are a vital part of all navigating functions, and are used a lot in combination with the silver colored navigating keys, and the level wheel.

- **[Arrow keys]** - Move in the direct of that key in the Browser, or a spreadsheet view. In dialogue boxes the side arrows will move between tabs, and up and down will select input areas. In the Browser the right arrow will open the current node, and the left arrow will close and jump to the top of any list.
- **[Arrow key] & [level wheel]** - Speed scroll in any list view.
- **[TAB] & [side arrows]** - Moves the current tab to the next screen.
- **[TAB] & [down arrow]** - Splits the screens, the same command with the up arrow will undo the current split.
- **[FORMAT] & [down arrow]** - Opens more detailed information when available.
- **[FORMAT] & [up arrow]** - Selects less detailed information when available.

For more information see [Navigating - The Arrow Keys](#).

*Keyboard equivalent: [Arrow keys]*

**Left Arrow**

Scroll to top of this page.

**Right Arrow**

Scroll to top of this page.

**Up Arrow**

Scroll to top of this page.

**Console Key - ATTRIB**

The ATTRIB key is used to record, edit and view attributes for moving devices.

- **[ATTRIB]** - Opens the Live Attribute view.
- **[#] [RECORD] & [ATTRIB]** - Record all attributes for the currently selected channels to preset #.
- **[#] [PRESET] & [ATTRIB]** - Opens the attribute editor for that preset.
- **[SETUP] & [ATTRIB]** - Opens the attribute settings.

For more information see [Device Views - Live](#), [Device Views - Presets](#), [Record All Attributes For Selected Channels](#).
**Console Key - B**

This key opens the channel view for the B field of the Main Playback. The channel control will be connected to the B field.

- [B] - Opens and selects the B tab.
- [TIME] & [B] - Forces the setting "Times to B"

For more information see [Main Playback - Edit Keys](#).

**Keyboard equivalent: [B]**

---

**Console Key - BALANCE**

The BALANCE key is a soft key in the CHANNELS menu of the console main display. It is used to mute all channel intensities except the current selection, temporarily.

- [BALANCE] - Temporarily mutes all channel intensities except the current selection. Press again to return.
- [SETUP] & [REM DIM] - Opens the dialogue to set this key as BALANCE.

For more information see [Channels - Balance Mode](#).

*There is no keyboard equivalent.*

---

**Console Key - BANK**

The BANK key is used to change bank of data in the Direct Select key sections.

Hold [BANK] - When this key is held, you can use the direct select keys to select a bank (1-10, 11-20 etc) for each section of direct select keys.

For more information see [Direct Select - Content](#).

*There is no keyboard equivalent.*

---

**Console Key - BEAM**

This key is used to record and recall Beam palettes for moving devices.

- [RECORD] & [BEAM] - Record the next free palette for the currently selected devices.
- [#][RECORD] & [BEAM] - Record a new palette for the currently selected devices.
- [#] [BEAM] - Recall a recorded palette for the currently selected devices.
- [MODIFY] & [BEAM] - Open the Beam palette list.
- Hold [BEAM] - When BEAM is held, all existing palettes 1-40 can be accessed from the
direct select keys.

For more information see Devices - Palettes, Record A Beam Palette, Device Palettes - Direct Mode.

Keyboard equivalent: [ALT] & [B]

**Console Key - BLIND**

The BLIND key is used to edit and load content to the blind editing field. You can edit and record
channels in BLIND independently from all other fields.

- [BLIND] - Open the Blind view, and set channel control to this field.
- [LIVE] & [BLIND] - Move the values of the current channels over 0% into BLIND.
- [BLIND] & [A] or a [master key] - Move the values of the currently selected channels from
BLIND to that field.
- [BLIND] & [level wheel] - Fade the content of BLIND into the output of the console.

For more information see Blind - Blind Tab.

Keyboard equivalent: [F3]

**Console Key - BROWSER**

The Browser is a fundamental part of the Cobalt system. This is where all functions are located, all
data can be viewed, and where you can access settings, files and the Help system.

- [BROWSER] - Select the Browser. If it is already selected, it will be closed. Press again to open.
  - Use the [up/down arrows] to navigate, and in combination with the level wheel to speed scroll.
  - Use the [right arrow] to open an item.
  - Use the [left arrow] to jump to the top of the current item and close it.
  - Press [MODIFY] to open the editor for an item.
  - Press [LOAD] to activate items like Groups, Palettes etc.

For more information see Navigating - Browser, Dock Areas.

Keyboard equivalent: [F10]

**Console Key - C/ALT**

This key is used to clear numeric entries. When it is held it can be combined with other keys for
clearing information, and for Macro style functions like channel check mode.
• [C/Alt] - Clear the last numeric entry.
• [C/Alt] [C/Alt] - Deselect all channels.
• [C/Alt] & [CHANNEL] - Clear the current channel selection and levels in the selected channel view.
• [C/Alt] & [master key] - Clear that field.
• [C/Alt] & [PLAYBACK] - Clear the A field.
• [C/Alt] & [PAGE] - Clear the current master page.
• [C/Alt] & [+\%] - Set 100%.
• [C/Alt] & [-\%] - Set 0%.
• [C/Alt] & [+ or -] - Activate channel check mode with the current level.
• [ESC] & [C/Alt] - Lock/Unlock the console.

For more information see Channels - Clear Functions, Master Playbacks - Load/Clear/Modify.

Keyboard equivalent: [Backspace]

**Console Key - CAPTURE**

This key is used to activate Capture mode, in which any channel that is manually altered will be Captured, and cannot be controlled from any other function until it is released from Capture mode. Captured channels are indicated with a red background in the channel views. When you record a captured channel, the captured levels are stored.

• [CAPTURE] [CAPTURE] - Activate and deactivate Capture mode.
• [#][CAPTURE] & [CHANNEL] - Capture that channel without activating Capture mode.
• [CAPTURE] & [ATTRIB] - Capture all attributes for the selected channel(s).
• [CAPTURE] & [parameter key] - Capture that attribute for the selected channel(s).

For more information see Channels - Capture Mode.

Keyboard equivalent: [C]

**Console Key - CH ONLY MODE**

The CH ONLY MODE key is used to activate the Channels Only Mode for the console, providing a single scene single channel control for simple hands on. The patch is active. 

• [CH_ONLY_MODE] - Toggles Channels Only Mode on/off.

For more information see Channels - Ch Only Mode.

Keyboard equivalent: [-] & [+] on the numerical keypad
**Console Key - CHANNEL**

The CHANNEL key is used to select channels, and in combination with other keys for additional channel functions.

- [#] [CHANNEL] - Select that channel (if you are operating in At Mode, this key is not used in the same way).
- [C/Alt] & [CHANNEL] - Clear levels and channel selection in the selected channel view.
- [CHANNEL] & [up/down arrow] - Scroll in the selected channel view.
- [CHANNEL] & [@LEVEL] - Set the levels of the selected channel(s) temporarily to 100% for identifying.
- [#] [CHANNEL] & [TIME] - Record a channel time for the selected channel(s).
- [#] [CHANNEL] & [DELAY] - Record a channel Delay for the selected channel(s).
- [ON/FETCH]&[CHANNEL] - Revert (undo) level changes back to value at initial selection.

For more information see Select Channels.

*Keyboard equivalent: [-]*

**Console Key - CHANNEL SET**

The CHANNEL SET soft key in the EFFECTS soft key menu, is used to open the Channel Set editor for effects.

- [CHANNEL SET] - Opens the Channel Set editor.

For more information see Channel Sets

*There is no keyboard equivalent*

**Console Key - CHAN DELAY**

CH DELAYT is a soft key in the TIME menu of the console main display. It is used to record individual channel delay times. Times are recorded to the Sequence Step in A or B depending on the setting of Times.

- [#] [CH DELAY] - Record that time to the currently selected channel(s).

For more information see Sequence Times - Channel Times.

*There is no keyboard equivalent.*

**Console Key - CHAN TIME**

CH TIME is a soft key in the TIME menu of the console main display. It is used to record individual channel times. Times are recorded to the Sequence Step in A or B depending on the setting of Times.
•  [#] [CH TIME] - Record that time to the currently selected channel(s).

For more information see Sequence Times - Channel Times.

There is no keyboard equivalent.

**Console Key - CHASE**

The CHASE soft key in the EFFECTS soft key menu, is used to open the editor for chase effects.

-  [CHASE] - Opens the CHASE editor.
-  [#] [CHASE] - Opens the CHASE editor focused at chase #.

For more information see Chase Effects

There is no keyboard equivalent

**Console Key - CHECK +**

The CHECK + key is used for the Channel Check function.

-  [CHECK +] - Make a channel check to the next channel with the current level.

No keyboard equivalent

**Console Key - CHECK -**

The CHECK - key is used for the Channel Check function.

-  [CHECK -] - Make a channel check to the previous channel with the current level.

No keyboard equivalent

**Console Key - CLEAR CHANGED**

CLEAR CHANGED is a soft key in the DEVICE menu of the console main display. It is used together with the attribute record setting "Changed" to clear the Set Changed flag on parameters that have been changed, so they will not be recorded.

-  [SET CHANGED] & [PALETTE] - Set all parameters for the selected channels to not changed.
-  [SET CHANGED] & [FOCUS] - Set Focus parameters for the selected channels to not changed.
- [SET CHANGED] & [COLOR] - Set Color parameters for the selected channels to not changed.
- [SET CHANGED] & [BEAM] - Set Beam parameters for the selected channels to not changed.
- [SET CHANGED] & [wheel parameter key] - Set this parameter for the selected channels to changed.

For more information see Devices - Recording.

There is no keyboard equivalent.

Console Key - Cobalt Encoder

The COBALT ENCODER keys are endless encoders that allow you to set values AND there is a click in them that sets the field/parameter to zero/full or a value (#) similar to the Parameter Wheel Keys.

- [ENCODER] (press) - set to 100/zero.
- [ENCODER] (turn) - set value.
- [#] [ENCODER] (press) - set to value.

For more information see Masters - Introduction

There is no keyboard equivalent

Console Key - COLOR

This key is used to record and recall Color palettes for moving devices.

- [RECORD] & [COLOR] - Record the next free palette for the currently selected devices.
- [#] [COLOR] - Recall a recorded palette for the currently selected devices.
- [MODIFY] & [COLOR] - Open the Color palette list.
- Hold [COLOR] - When COLOR is held, all existing palettes 1-40 can be accessed from the direct select keys.

For more information see Devices - Palettes, Record A Color Palette, Device Palettes - Direct Mode.

Keyboard equivalent: [ALT] & [C/Alt]

Console Key - COLUMN

The COLUMN key is used for various functions in spreadsheet views.

- [COLUMN] - Select all cells downward in the current column.
- [COLUMN] & [up/down arrows] - Sort the spreadsheet by the content of this column.
• [COLUMN] & [right/left arrows] - Move a column.

For more information see Navigating - Lists, Change The List View, Sort By Column.

Keyboard equivalent: [F9]

Console Key - COMPARE

COMPARE is a soft key in the CHANNELS menu of the console main display. It is used to compare the intensities in a channel view with any other Preset. It is a mode that has to be exited before returning to normal operation.

• [COMPARE] - Load the last recorded preset that was loaded to this channel view. Press again to return.
• [#] [COMPARE] - Load that preset to this channel view. Press again to return.

For more information see Presets - Compare Mode.

There is no keyboard equivalent.

Console key - CONNECT

The CONNECT key is used to connect a Master with a Sequence to the Master Playback controls of the console frontpanel. A Playback tab will be opened for this master. If the master is empty a dialogue will open for choosing to create a Preset or Cue Sequence.

• [CONNECT] & [master key] - Connect.
• # [CONNECT] - Connects master #
• 0 [CONNECT] - Disconnects currently connected master
• [CONNECT] - Opens the playback view for the currently connected master

For more information see Master Playback - Playback Keys.

There is no keyboard equivalent.

Console Key - COPY/CUT

The COPY/CUT key is used to copy and cut information for pasting. Information that can be copied, cut and pasted is Text, Sequence Steps (Sequence List), Groups (Group List), Presets (Preset List), Device Templates (Device Template List) and Attributes in the Preset List.

• [COPY/CUT] - Copy the selected object.
• [COPY/CUT] [COPY/CUT] - Cut the selected object.

For more information see Copy, Cut & Paste.
Keyboard equivalent: [CTRL] & [C/Alt]

Console Key - CURSOR

The CURSOR key is only available in the big Cobalt console to set the built in trackball to mouse mode.

- [CURSOR] - Set the trackball to mouse mode. Trackball will be red.

For more information see Facepanel - Trackball.

There is no keyboard equivalent

Console Key - DATA

The DATA key is a soft key in the CHANNELS menu of the console main display. It is used to set toggle how attribute data is displayed in the channel views and the console displays.

When DATA is active absolute data is shown, for example Pan 50%.
When DATA is off, referenced data is shown, for example F1 (focus palette 1)

- [DATA] - Toggle Data on/off.

Keyboard equivalent: none

Console Key - DELAY

The DELAY key is used to set delay times to the sequence step in the A or B field of the Main Playback (depending on the Time Settings).

- [DELAY] & [IN] - Set a Delay In time.
- [#] [DELAY] & [OUT] - Set a Delay out time.
- [#] [CHANNEL] & [DELAY] - Set a channel delay time to the selected channel(s).
- [#] [DELAY] & [FOCUS] - Set an attribute delay time for the selected channel(s).
- [#] [DELAY] & [COLOR] - Set an attribute delay time for the selected channel(s).
- [#] [DELAY] & [BEAM] - Set an attribute delay time for the selected channel(s).

For more information see Sequences - Times, Sequence Times - Set To A or B.

Keyboard equivalent: [CTRL] & [D]

Console Key - DELETE

The DELETE key is used to delete data permanently in lists.
**Console key - DEVICE**

The DEVICE key is used to activate Device Mode, and to open the Device List, where you can edit the settings for all moving devices.

- [DEVICE] - Activate Device Mode for the pots.

For more information see [Device Control - Device Mode, Patch - Device List](#).

*Keyboard equivalent: [D]*

**Console Key - Direct Select Pages**

The five Direct Select Page keys will activate a user setup that is auto-stored for the Direct Selects.

- Press any of the five keys to access that page.

For more information see [Direct Select - User Setups](#).

*There is no keyboard equivalent*

**Console Key - EFFECT**

The EFFECT key is used to operate the effect playbacks for chase, content, image and dynamic effects.  
**NOTE** that the command syntax for effects is different when operating in At Mode. See [Effects - Command Syntax](#).

- [EFFECT] - Open the Live Effects tab.
- [#] [EFFECT] - Select effect playback #.
- [#] [EFFECT] & [CHANNEL] - Select all channels in effect #.
- [EFFECT] & [ALL] - Select all effects over zero %.

For more information see [Effects](#).

Example: [Build a Chase effect](#).
Keyboard equivalent: [E]

**Console Key - EFFECT OVERVI**

The EFFECT OVERVI soft key in the EFFECTS soft key menu, is used to open the Effects Overview tab with a summary of all data available to use for effects.

- [EFFECT OVERVI] - Opens the Effects Overview tab.

For more information see [Effect Overview](#).

*There is no keyboard equivalent*

---

**Console Key - ESC**

The ESC key is used to close and exit all tabs and dialogues.

- [ESC] - Exit the current dialogue.
- [ESC] - Close the currently selected tab.
- [ESC] & [C/Alt] - Lock/Unlock the console.

For more information see [Navigating The Tabs](#).

Keyboard equivalent: [ESC]

---

**Console Key - FADER MODE**

The FADER MODE key is used to change mode for the Master Playbacks.

- [FADER_MODE] (held) - toggles the master display so that the master keys above/under the displays can be used to select fader mode.

*No keyboard equivalent*

---

**Console Key - FAN**

The FAN key is used to fan (distribute around a centre point) attributes and times. The distribution can be set to U, V and S shape in the Fan Settings.

- [FAN] & [level wheel] - Select devices, use NEXT/LAST to set the centre point. Then hold FAN and move the wheel of the parameter you wish to fan. Attribute times are fanned with a wizard that opens when you select an attribute time or delay in an attribute view and press WIZARD.
Console Key - FCB DELAY

The FCB DELAY soft key in the Times soft key page, is used to set a delay time to FCB for the moving device channels.

- `[#] [FCB_Delay]` - Sets the FCB times to `#` for the moving device channels, in the A or B field of the main playback depending on the settings for times.

For more information see Sequence Times - FCB Times.

There is no keyboard equivalent

Console Key - FCB TIME

The FCB TIME soft key in the Times soft key page, is used to set a time to FCB for the moving device channels.

- `[#] [FCB_Time]` - Sets the FCB times to `#` for the moving device channels, in the A or B field of the main playback depending on the settings for times.

For more information see Sequence Times - FCB Times.

There is no keyboard equivalent

Console Key - FLASH

The lower row of masters in the Cobalt console and the large fader wing of the Congo Jr are equipped with two keys per master. The top key is the master key used to load content, and the lower key is a flash key. The flash key can be set to different modes and levels.

- `[Flash key]` - Flash the content of a master.

For more information see Master Playbacks - Flash Keys.

There is no keyboard equivalent
Console Key - FLASH MODE

The lower row of masters in the Cobalt console and the Congo Jr Master Playback Wing, the Universal wings and Congo Kid masters are equipped with two keys per master. The top key is the master key used to load content, and the lower key is a flash key. The flash key can be set to different modes and levels.

- [FLASH MODE] (held) - Shows master settings in console display, use page +/- to step through and press the Master Key to toggle settings.
- [C/Alt] & [FLASH MODE] - Disable flash mode (toggles)

For more information see Master Playbacks - Flash Keys.

*Keyboard equivalent: [F]*

Console Key - FLIP

The FLIP key will flip the pan and tilt values of the selected moving devices.

- [FLIP] - Flips pan and tilt.

For more information see Device Control - Flip.

*Keyboard equivalent: None*

Console Key - FOCUS

This key is used to record and recall Focus palettes for moving devices.

- [RECORD] & [FOCUS] - Record the next free palette for the currently selected devices.
- [#] [FOCUS] - Recall a recorded palette for the currently selected devices.
- [MODIFY] & [FOCUS] - Open the Focus palette list.
- Hold [FOCUS] - When FOCUS is held, all existing palettes 1-40 can be accessed from the direct select keys.

For more information see Devices - Palettes, See Record A Focus Palette, Device Palettes - Direct Mode.

*Keyboard equivalent: [ALT] & [F]*

Console Key - FOCUS MODE

The Focus Mode soft key in the Device Soft key page is used activate a specific focus mode for quickly adjusting palettes.
• [FOCUS_MODE] - Enters Focus mode.

For more information see Device Palettes - Focusing Mode.

There is no keyboard equivalent.

Console Key - FORMAT

The FORMAT key is a vital part of controlling what is shown in all views except spreadsheets (lists). It is used a lot in combination with the arrow keys, and the level wheel.

• [FORMAT] - Change channel sorting (all channels, non-zero channels etc) for the current channel view.
• [FORMAT] & [level wheel] - Zoom in channel and attribute views.
• [FORMAT] & [up/down arrows] - Compress/expand information in a view.

For more information see Navigating - Channel Views.

Keyboard equivalent: [F4]

Console Key - GO

The GO key starts the next crossfade in the Main Playback.

• [GO] - Start a crossfade in the Main Playback. Press GO during an ongoing crossfade in the Main Playback to start the next one.

For more information see Main Playback - Transport Keys.

Keyboard equivalent: [CTRL] & [G]

Console Key - GO (Master Playback)

This GO key in the Master Playback starts the next crossfade in the master/sequence connected to the Master Playback.

• [GO] - Start a crossfade in the connected master. Press GO during an ongoing crossfade in the connected master to start the next one.

For more information see Master Playback - Playback Keys.

There is no keyboard equivalent
Console Key - GO BACK

The GO BACK key starts a crossfade to the previous sequence step in the Main Playback.

- [GO BACK] - Start a crossfade to the previous sequence step in the Main Playback. Press GO BACK during an ongoing crossfade to reverse it.
- [SETUP] & [GO BACK] - Change default times.

For more information see Main Playback - Transport Keys.

Keyboard equivalent: [CTRL] & [B]

Console Key - GO BACK (Master Playback)

The GO BACK key starts a crossfade to the previous sequence step in the master/sequence connected to the Master Playback.

- [GO BACK] - Start a crossfade to the previous sequence step in the connected master. Press GO BACK during an ongoing crossfade to reverse it.

For more information see Master Playback - Playback Keys.

No keyboard equivalent

Console Key - GOTO

The GOTO key is used to crossfade into any existing preset in the Main Playback.

- [#] [GOTO] - Start a crossfade to that preset. If the preset exists in the current sequence, the step times will be used.

For more information see Main Playback - Transport Keys and the Goto List.

Keyboard equivalent: [CTRL] & [G]

Console Key - GROUP

The GROUP key is used to store and recall channel selections stored into Groups.
NOTE that the command syntax for selecting groups is different when operating in At Mode. See Groups - Select channels.

- [RECORD] & [GROUP] - Record the currently selected channels and levels into the next free group.
• [GROUP] & [GROUP] - Record the currently selected channels and levels to that group.
• [GROUP] - Select the channels of that group.
• [GROUP] & [level wheel] - Fade the channels of that group in proportionally.
• [GROUP], or [MODIFY] & [GROUP] - Open the Group List.

For more information see Groups - Select Channels.

Keyboard equivalent: [ALT] & [G]

Console Key - GROUP WHEEL MODE

GROUP WHEEL MODE is a soft key in the Channels menu of the console main display. In Group Wheel Mode you can assign a channel group to each wheel under the Main Display.

• [GROUP WHEEL MODE] - Activate Group Wheel Mode.

For more information see Channels - Group Wheel Mode.

There is no keyboard equivalent

Console Key - HIGHLIGHT

The HIGHLIGHT key will activate highlight mode for the currently selected devices.

• [HIGHLIGHT] - Toggles Highlight mode.

For more information see Device Control - Highlight Mode.

Keyboard equivalent: [Alt] [H]

Console Key - HOME ATTRIB

The HOME ATTRIB key will set all or some parameters for the currently selected devices to their default home position. The home position can be re-recorded at any time.

• [HOME ATTRIB] [HOME ATTRIB] - Home all parameters for the selected devices.
• [HOME ATTRIB] & [FOCUS, COLOR, BEAM] - Home these parameters.
• [HOME ATTRIB] & [wheel parameter key] - Home only this parameter.
• [RECORD] & [HOME ATTRIB] - Record the current values as the new HOME position for the selected devices.
• [C/Alt] & [HOME ATTRIB] - Home all parameters for all devices.
• [C/Alt] & [HOME ATTRIB] [HOME ATTRIB] - Home all parameters for all devices and set intensities to zero.

For more information see Device Control - Home positioning.
**Console Key - ID**

The ID key is used to set a temporary ID level to the selected channel(s).

- `[ID]` - Set the levels of the selected channel(s) temporarily to 100% for identifying.
- `[#][ID]` - Set 100% to channel #

For more information see [Select Channels](#).

_Keyboard equivalent: [F5]_

---

**Console Key - IN**

The IN key is used to set In times to the sequence step in the A or B field of the Main Playback (depending on the Time Settings).

- `[#][IN]` - Set an in time.
- `[#][DELAY ] & [IN]` - Set a Delay In time.

For more information see [Sequences - Times](#), [Sequence Times - Set To A or B](#)

_Keyboard equivalent: [CTRL] & [I]_

---

**Console Key - INDEPENDENTS 7,8,9**

The three keys and potentiometers in the Independents area of the consoles are used to control lights outside the main functionality of the console - for example houselights or worklights. They can operate in three modes: Inclusive, Inhibit and Exclusive.

- `[SETUP] & [independent key]` - Open the settings.
- `[SETUP] & [independent pot]` - Hold SETUP, then move and let go of an independent potentiometer to open the settings.

For more information see [Independents](#)

_There is no keyboard equivalent_

---

**Console Key - INSERT**

The INSERT key is used to insert new data in a list. In some lists a number is required, in some not. A new item is usually inserted after the current item.
• [INSERT] - Insert a new item in a list.
• [#] [INSERT] - Insert a new item with this number in a list.
• [INSERT] & [Master Key] - Insert that master as a master link in the sequence in the main playback.

For more information see Editing In Lists.

Keyboard equivalent: [INS]

Console Key - INV GROUP

The INV GROUP key is used to invert the current channel selection and select all other channels with a level over 0% in a channel view.

• [INV GROUP] - Invert the current channel selection.

For more information see Select Channels.

Keyboard equivalent: [H]

Console Key - JUMP TO B

The JUMP TO B key is used to reposition the sequence in the main playback blindly to continue from a different sequence step.

• [#] [JUMP TO B] - Enter the number of a preset or sequence step (depending on the settings for this function) and press JUMP TO B to move that item to the B field of the Main Playback.

For more information see Main Playback - Transport Keys, Crossfade Settings.

Keyboard equivalent: [SHIFT] & [/]

Console Key - LAMP CONTROL

The LAMP CONTROL key is used to activate the soft keys menu for lamp control functions.

• [LAMP CONTROL] - activates the soft key page. You can now press the lamp control keys, in Cobalt there is no need to hold Enable - in older hardware there is.

For more information see Device Control - Lamp Control

No keyboard equivalent
**Console Key - LAST**

The LAST key is used to select the previous channel within the current channel selection. This is useful for adjusting single moving devices within a selection, and also for selecting a specific device as reference point for the Fan and Align functions.

- [LAST] - Press LAST with more than one channel selected to activate Next/Last mode. Press SELECT ALL to exit.

For more information see [Device Control - Next & Last Mode](#).

*Keyboard equivalent: [L]*

**Console Key - LEARN ALERT**

LEARN ALERT is a soft key in the TIMES > LEARN soft key menu of the console main display. It is used to activate Learn Alert mode in which alert times are auto-stored when a sequence is played back.

- [LEARN ALERT] - toggles learn alert mode.

For more information see [Sequence Times - WFA Alert Times](#).

*There is no keyboard equivalent.*

**Console Key - LEARN MACRO**

The LEARN MACRO soft key in the Misc soft key page, is used to record Macros.

- [#] [Learn_Macro] - Starts recording a new macro, click with mouse in top right corner of the screen on "Recording Macro" to stop.

For more information see [Macros - Record & Playback](#).

*There is no keyboard equivalent*

**Console Key - LEARN PROFILE**

LEARN PROFILE is a soft key in the TIMES soft key menu of the console main display. It is used to activate Learn Profile mode in which the actual fader movement is stored during a manual crossfade in the main playback.

- [LEARN PROFILE] - activates learn profile mode.

For more information see [Sequences - Crossfade Profiles](#)
There is no keyboard equivalent.

**Console Key - LEFT**

The Left key, in the big Cobalt only, is the left mouse key of the trackball.

- **[LEFT]** - Activate a mouse click in cursor mode (red).

For more information see [Facepanel - Trackball](#).

**Keyboard equivalent:** [Mouse left key]

**Console Key - LIVE**

The LIVE key is fundamental. It selects the Live tab and sets the channel control to the live output, through the A field of the Main Playback.

- **[LIVE]** - Select the Live tab.
- **[LIVE] & [BLIND]** - Move the channel levels from LIVE to BLIND.
- **[C/Alt] & [LIVE]** - Bring all channel levels from Live (A) to zero.

For more information see [Live](#).

**Keyboard equivalent:** [F2]

**Console Key - LOAD**

The LOAD key activates items in the Browser, like Groups, Palettes & Effects. This is an older function key and is only available on the frontpanel of the Congo Jr, Kid and Sr, however it can be set up in a Magic Sheet or on a master. All the organizer functions are available from the ORGANIZER key in other hardwares. See [Organizer](#).

- **[LOAD]** - Select an object in the Browser and press LOAD to activate. See [Browser Functions](#).
- **[LOAD]** - Select an object in a list and open in the Organizer
- **[LOAD] & [SEQ]** - Open Sequences in Organizer
- **[LOAD] & [PRESET]** - Open Presets in Organizer
- **[LOAD] & [GROUP]** - Open Groups in Organizer
- **[LOAD] & [FOCUS]** - Open Focus Palettes in Organizer
- **[LOAD] & [COLOR]** - Open Color Palettes in Organizer
- **[LOAD] & [BEAM]** - Open Beam Palettes in Organizer
- **[LOAD] & [PALETTE]** - Open All Palettes in Organizer

For more information see [Browser Functions](#) and [Organizer](#).
**Console Key - LOCAL MENU**

The LOCAL MENU key is used to open the Local Menu for the currently selected area/object on the screens.

- [LOCAL_MENU] - opens the Local Menu for the currently selected area/object on the screens.
- [LOCAL_MENU] & [TOUCH] - opens the Local Menu for that area on screen.

For more information see [Context Menus](#).

*Keyboard equivalent: [LOCAL MENU] (sometimes a symbol)*

**Console Key - LOCK**

The LOCK key is used to lock the console frontpanel, so no key input will work.

- [LOCK] - Opens the Lock dialog.
- SETUP & [LOCK] to setup PIN
- ESC & C/ALT locks older Congo consoles

For more information see [Lock Console](#).

*Keyboard equivalent: None*

**Console Key - MACRO**

The MACRO key in the MISC soft key page is used to activate macros.

- [#] [MACRO] - Enter the number of a macro and press MACRO to activate.

For more information see [Macro List](#).

*There is no keyboard equivalent.*

**Console Key - MARK**

MARK is a soft key in the CHANNELS menu of the console main display. It is used to set a "mark" level (less than 1%) to the selected device(s) to enforce a move command without having intensities.

- [MARK] - Sets a mark intensity level to the selected device(s).
For more information see Active Mode & Mark.

There is no keyboard equivalent.

Console Key - MASK

The MASK key is used in combination with other keys to toggle the mask functions that mask device parameters from recording.

- [MASK] - Activate the mask.
- [MASK] & [FOCUS, COLOR, BEAM] - Toggle these parameter groups on/off.
- [MASK] & [wheel parameter key] - Toggle this specific parameter on/off.
- [MODIFY] & [MASK] - Open the Mask editor.
- [RECORD] & [MASK] - Records the next free user mask
- [#][RECORD] & [MASK] - Records user mask 
- [#] & [MASK] - Recalls the settings of Mask # to the global mask
- [MASK] & [Master_key] - Assign global mask to a master.

For more information see Device Control - Mask.

Keyboard equivalent: [K]

Console Key - MASTER

The MASTER key is used to open the Master List editor where you can see and control the master fields.

- [MASTER] - Open the Master view. When the Master view is open, you can enter a number and press MASTER to control that master with the level wheel.
- [SETUP] & [MASTER] - Opens settings for this key.
- [MODIFY] & [MASTER] - Opens the master list.

For more information see Master View - Select And Set Levels.

Keyboard equivalent: [ALT] & [M]

Console Key - MASTER KEYS

Every master has a master key that is used to load content to the master, and for some settings.

- [#][PRESET] & [master key] - Load this content to master 
- [#][GROUP] & [master key] - Load this content to master 
- [#][CHANNEL] & [master key] - Load this content to master 
- [#][SEQ] & [master key] - Load this content to master 
- [#][FOCUS] & [master key] - Load this content to master 
- [#][COLOR] & [master key] - Load this content to master 

913
• [#] [BEAM] & [master key] - Load this content to master #.
• [#] [PALETTE] & [master key] - Load this content to master #.
• [C/Alt] & [master key] - Clear the contents of that master (with the exception of console key functions).
• [MODIFY] & [master key] - Open the master editor.
• [SETUP] & [master key] - Opens the master settings.
• [master key] - Select the channels in the group or preset loaded to that master.

For more information see Master Playbacks - Load/Clear/Modify.

*Keyboard equivalent: [1]-[9] and [0] over the letter keys correspond to master keys 1-10*

**Console Key - MASTER PAGE**

The MASTER PAGE key (Congo hardware only) is used to load a page of 20 masters to a master row.

• [#] [MASTER PAGE ] - Load this page.
• [C/Alt] & [MASTER PAGE] - Clear the masters.

For more information see Master Pages.

*Keyboard equivalent: [M] (upper row) [CTRL] & [M] (lower row)*

**Console Key - MINUS**

The MINUS key (-) is part of the channel select keys. It is used to subtract a channel from the current selection. It is also used for the Channel Check function.

• [#] [-] - Deselect the channel,(if the console is set to operate in At Mode press MINUS and then enter the number).
• [C/Alt] & [-] - Make a channel check to the previous channel with the current level.
• Hold [-] & [master key] - Subtract the channels in that master from the current selection.
• [#] [GROUP] & [-] - Subtract the channels in that Group from the current selection
• [#] [PRESET] & [-] - Subtract the channels in that Preset from the current selection

For more information see Select Channels.

*Keyboard equivalent: [CTRL] & [<]*

**Console Key - MINUS PERCENT (-%)**

The MINUS PERCENT key (-%) is part of the channel level keys. It is used to subtract 5% (default) from the current selection. It is also used for setting a selection to zero in combination with the C/ALT key.
- Subtract 5% from the current channel selection.
- Select a channel and subtract 5%.
- Flash the current selection to 0% (master content will not be affected).
- Subtract that level from the current channel selection.
- Change the default level.

For more information see Set Channel levels.

Keyboard equivalent: [CTRL] & [MINUS]

**Console Key - MODIFY**

The MODIFY key is central for a lot of functions. It is both the equivalent of an ENTER key and part of a syntax in combination with other keys.

- Answer dialogues, activate choices, enter numbers, open lists, activate text input in text cells.
- Opens the Preset List.
- Opens the Group List.
- Opens the Sequences List.
- Opens the Effect List.
- Opens the Focus Palette List.
- Opens the Color Palette List.
- Opens the Beam Palette List.
- Opens the All Palette List.
- Opens the Wheel Parameter Lists.
- Opens the Park List.
- Opens the Notes List.
- Opens the Master Editor.

This key is so fundamental it is described everywhere in this manual.

Keyboard equivalent: [ENTER]

**Console Key - MODIFY SEQ**

The MODIFY SEQ key is a soft key in the MISC menu of the main display. It is used to toggle the Modify Sequence mode on or off (default). When Modify Sequence is on, you can advance the sequence in the main playback without triggering auto times or wait times and master links.

- Toggle this mode on/off.

For more information see Sequences - Build & Modify Modes.

There is no keyboard equivalent
Console Key - MUTE

The MUTE key is used to inhibit the output of a Master Playback.

- [MUTE] & [master key] - Temporarily mutes the output of that master playback.

For more information see Mute & Solo - Mute.

Keyboard equivalent: None

Console Key - NEXT

The NEXT key is used to select the next channel within the current channel selection. This is useful for adjusting single moving devices within a selection, and also for selecting a specific device as reference point for the Fan and Align functions.

- [NEXT] - Press NEXT with more than one channel selected to activate Next/Last mode. Press SELECT ALL to exit.

For more information see Device Control - Next & Last Mode.

Keyboard equivalent: [N]

Console Key - NOTE

The NOTE key is used to set a note for the selected item in some lists and the Playback view. It can also be used to store favorites for the HELP system.

- [NOTE] - Press NOTE in a list or the playback view to set a note to the selected item.
- [NOTE] - Press NOTE in the help system to create a favorite.
- [MODIFY] & [NOTE] - Opens the Notes list.

For more information see Notes Editor.

Keyboard equivalent: none

Console Key - Numerical Keypad

The numerical keypad is where numbers are input. This is also where you have the decimal point, and the C/ALT key (clear numerical entry). The C/ALT key is also a prefix key for clearing Playbacks, and for some console Macros.

NOTE that in an alphanumerical keyboard, the number keys 1-9 and 0 over the keys are master keys, and cannot be used to enter numbers. In a notebook computer the numerical keypad is integrated into the alphanumerical keyboard, and you have to activate the NUM LOCK function to access it.
**Keyboard equivalent:** [Numerical keypad]

### Console Key - ON/FETCH

The ON/FETCH key is used to set channels on at the last used level, and to fetch levels for intensities or attributes for the selected channels from any presets.

- [ON/FETCH] - Set the last recorded level to the current channel selection.
- [ON/FETCH] & [LEVEL] - Revert (undo) changes to channel level.
- [#] [ON/FETCH] - Fetch the level from Preset # to the current channel selection.
- [#] [ON/FETCH] & [ATTRIB] - fetch attribute information from Preset # to the current channel selection.
- [#] [ON/FETCH] & [parameter key] - fetch attribute information from Preset # to the current channel selection.

For more information see [Presets - Fetch Intensities](#), [Device Control - Fetch/Copy](#).

**Keyboard equivalent:** [CTRL] & [+]

### Console Key - ORGANIZER

The ORGANIZER key is used to open the Organizer editor.

- [ORGANIZER] - opens the Organizer editor.

For more information see [Organizer (1 tab)](#)

**Keyboard equivalent:** [F6]

### Console Key - OUT

The OUT key is used to set Out times to the sequence step in the A or B field of the Main Playback (depending on the Time Settings).

- [#] [OUT] - Set an in time.
- [#] [DELAY] & [OUT] - Set a Delay Out time.

For more information see [Sequences - Times](#), [Sequence Times - Set To A or B](#).

**Keyboard equivalent:** [CTRL] & [U]
**Console Key - OUTPUT**

The OUTPUT key is used to select outputs directly, regardless if they are patched or not. It will open the Output editor where it is possible to patch by channel or output.

- [#] [OUTPUT] - Open the Output editor, and select that output. Use the level wheel to set a level.
- [MODIFY] & [OUTPUT] - Open the Output editor with no output selected.

For more information see Patch - Output Editor.

Example: Patch by Output, Patch by Channel.

*Keyboard equivalent: [O]*

**Console Key - PAGE**

The PAGE key in Cobalt is used to load a page of 20 masters to a master row.

- [#] [PAGE ] - Load this page to masters 1-20
- [#] [PAGE ] & [Assign] - Load this page to the row of masters the assign key belongs to.
- [C/Alt] & [PAGE] - Clear masters 1-20
- [TAP] & [PAGE ] - Set a Master Page BPM.

For more information see Master Pages.

*Keyboard equivalent: None*

**Console Key - Page+**

The PAGE+ key is used to load the next page of 20 masters to a master row.

- [PAGE+] - Load the next page.

For more information see Master Pages.

*There is no keyboard equivalent.*

**Console Key - Page-**

The PAGE- key is used to load the previous page of 20 masters to a master row.

- [PAGE-] - Load the previous page.
For more information see Master Pages.

There is no keyboard equivalent.

Console Key - PAUSE

The PAUSE key is used to pause an ongoing crossfade in the Main Playback.

- [PAUSE] - Pauses the ongoing crossfade (intensities and attributes) in the main playback.

For more information see Main Playback - Transport Keys.

Keyboard equivalent: [CTRL] & [P]

Console Key - PAUSE (in Master Playback)

The PAUSE key is used to pause an ongoing crossfade in the Master Playback.

- [PAUSE] - Pauses the ongoing crossfade in the connected master playback.

For more information see Master Playback - Playback Keys.

There is no keyboard equivalent

Console Key - PALETTE (Alt P)

The PALETTE key is used for recording and recalling All Palettes, containing information from all parameters in a device.

- [RECORD] & [PALETTE] - Record the next free palette for the currently selected devices.
- [#][RECORD] & [PALETTE] - Record a new palette for the currently selected devices.
- [#][PALETTE] - Recall a recorded palette for the currently selected devices.
- [MODIFY] & [PALETTE] - Open the All palette list.
- Hold [PALETTE] - When PALETTE is held, all existing palettes 1-40 can be accessed from the direct select keys.

For more information see Devices - Palettes, Record An All Palette, Device Palettes - Direct Mode.

Keyboard equivalent: [ALT] & [P]

Console Key - PARAMETER

The PARAMETER key in the big Cobalt console is used to set the trackball to Parameter mode, controlling pan & tilt.
• [PARAMETER] - Set the trackball to parameter mode. Trackball will be blue.

For more information see Facepanel - Trackball.

There is no keyboard equivalent

Console Key - PARK

The PARK key is used to park a channel or part of a channel.

• [PARK] & [CHANNEL] - Parks intensity and attributes of the selected channel(s).
• [PARK] & [@LEVEL] - Parks intensity of the selected channel(s).
• [PARK] & [ATTRIB] - Parks attributes of the selected channel(s).
• [PARK] & [FOCUS] - Parks focus attributes of the selected channel(s).
• [PARK] & [COLOR] - Parks color attributes of the selected channel(s).
• [PARK] & [BEAM] - Parks beam attributes of the selected channel(s).
• [PARK] & [Wheel_Key] - Parks the attribute of the selected channel(s).
• [MODIFY] & [PARK] - Opens the Park list

For more information see Park - Parked values.

Keyboard equivalent: None

Console Key - PASTE

The PASTE key is used to paste information that has been copied or cut. Information that can be copied, cut and pasted is Text, Sequence Steps (Sequence List), Groups (Group List), Presets (Preset List), Device Templates (Device Template List) and Attributes in the Preset List.

• [PASTE] - Paste the last copied or cut object. In the Preset List a numerical argument is needed first.

For more information see Copy, Cut & Paste.

Keyboard equivalent: [CTRL] & [V]

Console Key - PLAYBACK

The PLAYBACK key selects the Playback tab and sets the channel control to the live output, through the A field of the Main Playback.

• [PLAYBACK] - Select the Playback tab.
• [#] [SEQ ] & [PLAYBACK ] - Load a sequence to the Main Playback.
• [MODIFY] & [PLAYBACK ] - Open the Sequence editor for the sequence in the Main Playback.
• [C/Alt] & [PLAYBACK ] - Bring all channel levels from the Playback (A and B) to zero.
- [#] [PLAYBACK] - Open the Sequence editor for the sequence in the Main Playback at Preset/Step #.
- [#] [MODIFY] [PLAYBACK] - Open the Sequence editor for the sequence in the Main Playback at Preset/Step #.

For more information see Live.

*Keyboard equivalent: [X]*

**Console Key - PLAYLIST**

The PLAYLIST key is used to activate the Playlist for the Main Playback.

- [PLAYLIST] - toggles the Playlist on/off.

For more information see Playlist.

*Keyboard equivalent: None*

**Console Key - PLUS**

The PLUS key (+) is part of the channel select keys. It is used to add a channel to the current selection. It is also used for the Channel Check function.

- [#] + - Add the channel to the current selection, (if the console is set to operate in At Mode press MINUS and then enter the number).
- [C/Alt] & + - Make a channel check to the next channel with the current level.
- Hold + & [master key] - Add the channels in that master from the current selection.
- [#] [GROUP] & + - Add the channels in that Group from the current selection
- [#] [PRESET] & + - Add the channels in that Preset from the current selection

For more information see Select Channels.

*Keyboard equivalent: [CTRL] & [>]*

**Console Key - PLUS PERCENT (+%)**

The PLUS PERCENT key (+%) is part of the channel level keys. It is used to add 5% (default) from the current selection. It is also used for setting a selection to full in combination with the C/ALT key.

- +% - Add 5% from the current channel selection.
- [#] +% - Select a channel and add 5%.
- [C/Alt] & +% - Flash the current selection to 100% (master content will not be affected).
- [#] [.] & +% - Add that level from the current channel selection.
- [SETUP] & +% - Change the default level.
For more information see Set Channel levels.

*Keyboard equivalent: [CTRL] & [UP]*

**Console Key - PRESET**

The PRESET key is used to store and recall channel levels and moving device attributes. Presets are fundamental building blocks and can be played back in masters, in sequences and randomly in the main playback using GOTO. Every Sequence Step uses a Preset to hold the level and attribute information for that step. The same Preset can be repeated any number of times in any playback or sequence.

IMPORTANT: For moving devices there are different recording modes. All, Active or Changed. This will decide what is stored in a preset. Also, there is a difference between recording to the main playback and to a master.

- [PRESET] - Open the Preset list.
- [#] [PRESET] - Select the channels in Preset #.
- [#] [PRESET] & [CHANNEL] - Select the channels and levels in Preset #.
- [#] [PRESET] & [master key] - Load preset # to that master.

For more information see Presets - Load To Playbacks.

*Keyboard equivalent: [P]*

**Console Key - PRINT SCREEN**

The PRINT SCREEN Soft Key (Misc) is used to Print the selected Tab.

- [PRINT SCREEN] - Prints the selected tab to a jpg file in the Printout node of the Browser >Files >Print... >Printouts.

For more information see Print.

*Keyboard equivalent: None*

**Console Key - RANDOM**

The RANDOM key in the Selects Soft key page allows you to randomize the order of the channels within the current selection.

- [RANDOM] & [SELECT_2nd] - Selects every 2nd random channel
- [RANDOM] & [SELECT_3rd] - Selects every 3rd random channel
- [RANDOM] & [SELECT_Nth] - Selects every Nth random channel

For more information see Channels - Random Select.
There is no keyboard equivalent.

**Console Key - RANGE**

Hold the RANGE key and select which part of the fader range 1-80 you want to control with the master playbacks, from the keys over and under the display.

- [RANGE] (held) - allows you to select which bank from the fader range 1-80 to assign to the physical faders.
- [#] [RANGE] & [Master key] - assigns the range in which this master exists.

For more information see Masters - Select Playback Range

No keyboard equivalent

**Console Key - REM DIM**

The REM DIM key is part of the channel select and level keys. It is used to set all channels in the A field to zero except the current selection. It can be set to perform the BALANCE function as well which holds the cleared levels in a temporary memory bank.

- [REM DIM] - Set all channels except the current selection to zero.
- [SETUP] & [REM DIM] - Opens settings for this key.

If set to Balance Mode:
Press REM DIM to activate Balance mode and set all channels except the current selection to zero. Press REM DIM again to bring them back at their previous levels.

For more information see Channels - Rem Dim, Channels - Balance Mode.

There is no keyboard equivalent

**Console Key - RECORD**

The RECORD key is fundamental in that it is used for recording all types of data into Presets, Groups and Palettes. What is recorded depends on your Settings, where you are recording, and what your record target is.

In Live:

- [RECORD] - Opens the recording dialogue to record the current look on stage into the next free Preset.
- [#] [RECORD] - Opens the recording dialogue to record the current look on stage into that Preset.
- [RECORD] [ATTRIB] - Record all attributes for the currently selected channels to the Preset in the A field of the main playback.
• [#] [RECORD] & [ATTRIB] - Record all attributes for the currently selected channels to Preset #.
• [RECORD] & [FOCUS, COLOR, BEAM or PALETTE] - Record the next free palette for the currently selected channels.
• [#] [RECORD] & [FOCUS, COLOR, BEAM or PALETTE] - Record palette # for the currently selected channels.
• [RECORD] & [CHANNEL] - Record all attributes and levels for the currently selected channels.
• [#] [RECORD] & [CHANNEL] - Record all attributes and levels for the currently selected channels to Preset #.

Anywhere:

• [RECORD] & [master key] - Record all data for the currently selected channels to that master as the next free 800-Preset.
• [#] [RECORD] & [master key] - Record all data for the currently selected channels to that master as Preset #.
• [RECORD] & [GROUP] - Record the currently selected channels as the next free Group.
• [#] [RECORD] & [GROUP] - Record the currently selected channels as Group #.
• [SETUP] & [RECORD] - Opens the Record Settings dialogue.
• [C/ALT] & [RECORD] - Sets the Record Target to the default Main Playback (7.3)

For more information see Presets - Record, Device - Recording, Groups - Record, Device Palettes - Record.

Keyboard equivalent: [R]

Console Key - REFRESH

The REFRESH key is used to refresh channels that have been manually adjusted since the last crossfade in the main playback back to the intensity and parameter values of the previous crossfade.

• [REFRESH] - Refresh the content in A to the last crossfaded levels.
• [REFRESH] & [@LEVEL] - Refresh intensities only.
• [REFRESH] & [FOCUS, COLOR, BEAM] - Refresh these values only.
• [REFRESH] & [ATTRIB] - Refresh all parameter values.
• [REFRESH] & [CHANNEL] - Refresh all intensities and parameter values
• [REFRESH] & [Parameter_Key] - Refresh that parameter value
• [REFRESH] & [Master_Key] - Refresh all intensities and parameter values that are manually changed and not updated on that master in the currently loaded Preset or Sequence Step.

For more information see Main Playback - Refresh Functions.

Keyboard equivalent: [CTRL] & [Y]
**Console Key - RELEASE**

The RELEASE key is used to release channels that have been Captured. Captured channels are indicated with a red background in the channel views.

- **[RELEASE]** - Release the currently selected channels.
- **[RELEASE] [RELEASE]** - Release all captured channels.

For more information see [Channels - Capture Mode](#).

*Keyboard equivalent: [CTRL] & [R]*

**Console Key - RIGHT (DispSel)**

The Right key, in the big Cobalt only, is the right mouse key of the trackball.

- **[RIGHT]** - Activate a mouse right click in cursor mode (red).

For more information see [Facepanel - Trackball](#).

*Keyboard equivalent: [Mouse right key]*

**Console Key - SAVE**

The SAVE key is used to save the current play.

- **[SAVE]** - opens the save play dialog.

For more information see [Save & Save As...](#).

*Keyboard equivalent: [BACKSPACE] & [R] and [Ctrl] & [S]*

**Console Key - SAVE COPY**

The SAVE COPY key is used to save a copy of the current play to a USB memory stick or File Server.

- **[SAVE_COPY]** - opens the save copy dialog.

For more information see [Save & Save As...](#).

*No keyboard equivalent*
**Console Key - SCALE**

SCALE is a soft key in the CHANNELS menu of the console main display. It is used to scale the output level of the selected channel(s)

- [SCALE] (held) - activates temporary scale mode.

For more information see Channels - Scale channel levels.

*There is no keyboard equivalent.*

**Console Key - SELECT**

The SELECT key is used to select more than one cell for editing in spreadsheet views.

- [SELECT] & [down/right arrow keys] - Select multiple cells.

For more information see Navigating - Lists.

*Keyboard equivalent: [SHIFT]*

**Console Key - SELECT 2ND**

The SELECT 2ND key in the Selects Soft key page allows you select every 2nd channel within the current selection.

- [SELECT_2nd] - Selects every 2nd channel
- [RANDOM] & [SELECT_2nd] - Selects every 2nd random channel

For more information see Shortcuts - Select Nth Functions.

*There is no keyboard equivalent.*

**Console Key - SELECT 3RD**

The SELECT 3RD key in the Selects Soft key page allows you select every 3rd channel within the current selection.

- [SELECT_3rd] - Selects every 3rd random channel

For more information see Shortcuts - Select Nth Functions.

*There is no keyboard equivalent.*
**Console Key - SELECT ALL**

The SELECT ALL key is used to return to the current channel selection after using NEXT or LAST.

- [SELECT ALL] - Reselects all channels after using NEXT or LAST.

For more information see [Device Control - Next & Last Mode](#).

*Keyboard equivalent: [F7], [CTRL] & [N] or [CTRL] & [L]*

**Console Key - SELECT CHANGE**

The SELECT CHANGE key in the Select soft key page is used to select all device channels that have manually changed attributes other than intensity since the current Preset was loaded to the A field.

- [Select_Change] - Selects all changed device channels.

For more information see [Select - Change (softkey)](#).

*Keyboard equivalent: None*

**Console Key - SELECT NTH**

The SELECT NTH key in the Selects Soft key page allows you select every Nth channel within the current selection.

- [#] [SELECT_NTH] - Selects every NTH random channel

For more information see [Channels - Select Functions](#).

*There is no keyboard equivalent.*

**Console Key - SERIES**

The SERIES soft key in the EFFECTS soft key menu, is used to open the Series editor for Content effects.

- [SERIES] - Opens the SERIES editor.

For more information see [Content Effects](#)

*There is no keyboard equivalent*
**Console Key - SETUP**

The SETUP key is used to open the system settings summary tab, or in combination with keys to open the settings for that key.

- [SETUP] - Open system settings.
- Hold [SETUP] and press a key to open the settings for that key

A
ATTRIBUT
B
CHANNEL
GO
MASTER PAGE
RECORD
TIME
PLAYBACK

For more information see [System Settings](#).

*K Keyboard equivalent: [F11]*

**Console Key - SET CHANGED**

SET CHANGED is a soft key in the DEVICE menu of the console main display. It is used together with the attribute record setting "Changed" to force the Set Changed flag on parameters that have not been changed, so they will be recorded.

- [SET CHANGED] & [PALETTE] - Set all parameters for the selected channels to changed.
- [SET CHANGED] & [FOCUS] - Set Focus parameters for the selected channels to changed.
- [SET CHANGED] & [COLOR] - Set Colorparameters for the selected channels to changed.
- [SET CHANGED] & [BEAM] - Set Beam parameters for the selected channels to changed.
- [SET CHANGED] & [wheel parameter key] - Set this parameter for the selected channels to changed.

For more information see [Devices - Recording](#).

*There is no keyboard equivalent.*

**Console Key - SEQ**

The SEQ key is used to load and administrate Sequences and Chases.

- [SEQ] - Open the Sequences list.
- [#] [SEQ] - Open that Sequence editor.
- [#] [MODIFY] [SEQ] - Open that Sequence editor.
- [#] [SEQ] [PLAYBACK] - Load Sequence # to the main playback.
- [#] [SEQ] [master key] - Load Sequence # to the master.
For more information see Sequences - List, Sequences - Sequence List, Sequences - Load.

*Keyboard equivalent: [S]*

**Console Key - SEQ +**

The SEQ + key is used to step to the next step in the sequence of the main playback, without using times.

- [SEQ +] - Step to the next step.

For more information see Main Playback - Transport Keys.

*Keyboard equivalent: [X] & [down arrow]*

**Console Key - SEQ -**

The SEQ - key is used to step to the previous step in the sequence of the main playback, without using times.

- [SEQ -] - Step to the previous step.

For more information see Main Playback - Transport Keys.

*Keyboard equivalent: [X] & [up arrow]*

**Console Key - >> (Master Playback)**

The >> key in the master playback is used to step to the next step in the connected sequence, without using times.

- [>>] - Step to the next step.

For more information see Main Playback - Transport Keys.

*There is no keyboard equivalent*

**Console Key - << (Master Playback)**

The << key in the master playback is used to step to the previous step in the connected sequence, without using times.

- [<<] - Step to the previous step.
For more information see Main Playback - Transport Keys.

There is no keyboard equivalent

**Console Key - SOLO**

The SOLO key is used to solo the output of a playback, temporarily muting the rest.

- [SOLO] & [PLAYBACK] - Toggles solo mode for the main playback.
- [SOLO] & [MasterKey] - Toggles solo mode for a master playback.

For more information see Mute & Solo - Solo.

*Keyboard equivalent: None*

**Console Key - START**

The START key is used to start fades in any master playback.

- [#] [START] - Fade master # to full.
- [#] [START] & [master key] - Fade to this level.
- [START] & [master key] - Fade this master to full or zero.

For more information see Master Playbacks - Start Fades.

*There is no keyboard equivalent*

**Console Key - SWAP**

Press the SWAP key to swap the top row with the lower row.

- [SWAP] - swaps fader content and levels between the upper and lower row.

For more information see Masters - Swap Upper/Lower.

*No keyboard equivalent*

**Console Key - TAB**

The TAB key is a fundamental part of the Cobalt navigation. All views are opened in tabs, and the tab key is used to select, move, organize and record these.

- [TAB] - Step between all open tabs.
- [#] [TAB] - Select this tab.
• [TAB] & [down arrow] - Split the screen vertically, press again to split horizontally. Hold TAB and press the up arrow to exit the split.
• [TAB] & [right/left arrow] - Move the selected tab to the next screen.
• [TAB] & [level wheel] - Resize the lower part of a spreadsheet view.
• [SETUP] & [TAB] - Open a dialogue to park a tab so it can't be closed with ESC.
• [C/Alt] & [TAB] - Reset all Tabs to default (Live and Playback).

For more information see Navigating - Tabs.

*Keyboard equivalent: [TAB]*

**Console Key - TAP**

The TAP key is used to set a tempo to an effect.

• [TAP] & [master key] [master key] - Hold [TAP] and press a [master key] twice to set a tempo to a chase in that master.

For more information see Master Playback - Playback Keys.

*There is no keyboard equivalent*

**Console Key - TEXT**

The TEXT key is used to set text labels to items.

• [TEXT] - Open the text input for the sequence step in the A field of the main playback.
• [TEXT] & [master key] - Activate text input for the content for that master playback.
• [TEXT] & [direct select key] - Activate text input for the content for that direct select key.

For more information see Entering Texts.

*Keyboard equivalent: [ALT] & [T]*

**Console Key - THRU**

The THRU key is used to select a range of channels, and in combination with other keys for additional channel functions.

• [#] [CHANNEL] [#] [THRU] - Select all channels between # and #.

**NOTE**
If you are operating in At Mode the syntax is "ch number - THRU - ch number".

For more information see Select Channels.
Console Key - TIME

The TIME key is used to set In/Out times to the sequence step in the A or B field of the Main Playback (depending on the Time Settings).

- [#] [TIME] - Set an In/Out time to the next fade in the main playback.
- [#] [CHANNEL] & [TIME] - Set a channel time to the selected channel(s).
- [MODIFY] & [TIME] - Open the Time Editor for the step in A or B of the main playback. Enter a number to open for a specific sequence step.
- [TIME] & [A] - Forces the setting "Times to A"
- [TIME] & [B] - Forces the setting "Times to B"
- [#] [TIME] & [Master_Key] - Set an In time to a Preset in that master.

For more information see Sequences - Times, Sequence Times - Set To A or B, Master Playbacks - Times, The Time Editor Popup.

Keyboard equivalent: [/]

Console Key - TRACK

The TRACK key is used to open the Track list for the selected channel(s). It is used in combination with RECORD and UPDATE for track recording.

- [TRACK] - Open the Track list for the selected channels. You can change the channel selection. Use FORMAT & FOCUS, COLOR, BEAM to open parameter columns.
- [TRACK] & [GROUP] - Track the current selection in all Groups.
- [TRACK] & [PRESET] - Track the current selection in all Presets.
- [TRACK] & [SEQ] - Track the current selection in all Sequences.
- [TRACK] & [PALETTE, FOCUS, COLOR, BEAM] - Track the current selection in all corresponding palettes.
- TRACK & [CHANNEL] - Track the current selection in the whole show.

For more information see Track List.

In the Browser and Organizer:

- [TRACK] - Tracks the selected preset or palette in the Sequence loaded to the Main Playback...

For more information see Navigate - Browser and Organizer.
Keyboard equivalent: [F12]

Console Key - TYPE

The TYPE key is used to change type of data in the Direct Select key sections.

- Hold [TYPE] - When this key is held, you can use the direct select keys to select a type (Group, Focus, Color, Beam, Auto Group, Screens, etc) for each section of direct select keys.

For more information see Direct Select - Content.

There is no keyboard equivalent.

Console Key - U1-U3

The U1-U3 soft keys in the EFFECTS soft key menu, and in the frontpanel of Cobalt, are used to select user parameters for the selected channels or effects.

- [U1-U3] - Selects this parameter set.

For more information see Device Control - U1-U2-U3

There is no keyboard equivalent

Console Key - UNPARK

UNPARK is used to unpark a channel or part of a channel.

- [UNPARK] & [CHANNEL] - Unparks intensity and attributes of the selected channel(s).
- [UNPARK] & [@LEVEL] - Unparks intensity of the selected channel(s).
- [UNPARK] & [ATTRIB] - Unparks attributes of the selected channel(s).
- [UNPARK] & [FOCUS] - Unparks focus attributes of the selected channel(s).
- [UNPARK] & [COLOR] - Unparks color attributes of the selected channel(s).
- [UNPARK] & [BEAM] - Unparks beam attributes of the selected channel(s).
- [UNPARK] & [Wheel_Key] - Unparks the attribute of the selected channel(s).

For more information see Park- Un-parking values.

Keyboard equivalent: None
**Console Key - UPDATE**

The UPDATE key is used to quickly update Presets, Groups and Palettes without a numeric entry.

- [UPDATE] to open the update dialogue for the Preset loaded to the A field of the main playback.
- [UPDATE] & [direct select key] - Update a Palette or Group.
- [UPDATE] & [@LEVEL] - Open the intensity tracking dialogue.
- [UPDATE] & [ATTRIB] - Open the attributes tracking dialogue.

For more information see [Presets - Update](#), [Track - Track Editing](#).

*Keyboard equivalent: [U]*

**Console Key - UPDATE PALETTE**

The UPDATE PALETTE key is used to quickly update all currently active palettes for the selected channel(s).

- [UPDATE_PALETTE] - Updates all active palettes for the selected channel(s).

For more information see [Device Palettes - Update](#).

*Keyboard equivalent: None*

**Console Key - WAIT**

The WAIT soft key in the Times soft key menu, is used to set Wait times to the sequence step in the A or B field of the Main Playback (depending on the Time Settings).

- [#] [WAIT] - Set a Wait time.

For more information see [Sequences - Times](#), [Sequence Times - Set To A or B](#), [The Time Editor Popup](#).

*There is no keyboard equivalent*

**Console Key - WIZARD**

The WIZARD key is used to activate the Wizard function (if appropriate) for the current editor.

- See [Channel Editor Wizard](#).
- See [Import Wizard](#).
- See [Patch Wizard](#).
- See [Scroller Item Wizard](#).
• See Text Wizard.
• See Track To Wizard.
• See Template Range Wizard.

Keyboard equivalent: [W]

Soft Key Menu - Channels

The CHANNELS soft key, is used to open the Channels soft key page with channel tools.

• [Channels] - Opens the Channels soft key page.

For more information see Channels - Soft key page.

There is no keyboard equivalent

Soft Key Menu - Device

The DEVICE soft key, is used to open the Device soft key page with device tools for control and editing.

• [Device] - Opens the Device soft key page.

For more information see Devices - Functions.

There is no keyboard equivalent

Soft Key Menu - Effect

The EFFECT soft key, is used to open the Effect soft key page with tools for editing effects.

• [Effect] - Opens the Effect soft key page.

For more information see Effect Soft Key Page.

There is no keyboard equivalent

Soft Key Menu - Learn

The LEARN soft key, is used to open the Learn soft key page with tools for learning times and fade profiles.

• [Learn] - Opens the Learn soft key page.
Soft Key Menu - Misc

The Misc soft key, is used to open the Miscellaneous soft key page.

- [Misc] - Opens the Miscellaneous soft key page.

For more information see Misc Soft Key Page.

There is no keyboard equivalent

Soft Key Menu - Select

The SELECT soft key, is used to open the Select soft key page with tools for selecting a sub-set of channels from the current selection.

- [Select] - Opens the Select soft key page.

For more information see Select - Sub-selection Functions.

There is no keyboard equivalent

Soft Key Menu - Times

The Times soft key, is used to open the Times soft key page.

- [Times] - Opens the Times soft key page.

For more information see Sequences - Times.

There is no keyboard equivalent

Soft Key Menu - Wheel Keys

The wheel keys are used together with parameter control on the wheels.

- [Wheel_Key] - toggles the parameter value 0/100%
- [#] [Wheel_Key] - sets a value to the parameter
- [Wheel_Key] & [Master_key] - assigns the parameter to the master key

For more information see Moving Device Controls - Explanation.
There is no keyboard equivalent

Console Key - FIND

The FIND key is used to open the SEARCH feature in a focuse Help Tab.

[FIND] - Open free text search.

For more information see This Manual - Using The Help System.

There is no keyboard equivalent
Console Key Shortcuts

This is a summary of all keys and shortcuts, organised by the type of function.

This chapter contains the following sections

- Shortcuts - Select Channels
- Shortcuts - Channel Levels
- Shortcuts - Channel Modes
- Shortcuts - Select Nth Functions
- Shortcuts - Channel Views
- Shortcuts - Dynamics
- Shortcuts - HELP
- Shortcuts - Channels Only Mode
- Shortcuts - General Editing Keys
- Shortcuts - Navigation Keys
- Shortcuts - Master Playbacks
- Shortcuts - Masters & Channels
- Shortcuts - Master Pages
- Shortcuts - Devices To Home Position
- Shortcuts - Device Attribute Editors
- Shortcuts - Device Masking
- Shortcuts - Device Palette Recording
- Shortcuts - Device Palette Activating
- Shortcuts - Device Palette Specials
- Shortcuts - Device Palette Views
- Shortcuts - Device Palettes In Masters
- Shortcuts - Device Align & Fetch
- Shortcuts - Patch & Outputs
- Shortcuts - Main Display, General
- Shortcuts - Times
- Shortcuts - Track
- Shortcuts - Presets
- Shortcuts - Groups
- Shortcuts - Live & blind
- Shortcuts - Record Functions
- Shortcuts - Update Functions
- Shortcuts - Channel Text Wizard
- Shortcuts - Main Playback
- Shortcuts - Sequence Editor
- Shortcuts - Direct Selects
- Shortcuts - Notes
Shortcuts - Select Channels

These are the keys and shortcuts for selecting channels. Some of them assume the Command Syntax is set to RPN - see Channels - Command Syntax.

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a channel</td>
<td>[#] CHANNEL</td>
</tr>
<tr>
<td>Add channel to the channel selection</td>
<td>[#] +</td>
</tr>
<tr>
<td>Subtract channel from the channel selection</td>
<td>[#] -</td>
</tr>
<tr>
<td>Select a range of channels</td>
<td>[#] THRU</td>
</tr>
<tr>
<td>Step to the next channel</td>
<td>+</td>
</tr>
<tr>
<td>Step to the previous channel</td>
<td>-</td>
</tr>
<tr>
<td>Select all channels with a level in the Main Playback.</td>
<td>ALL</td>
</tr>
<tr>
<td>Select all channels with a level in any Playback.</td>
<td>ALL ALL</td>
</tr>
<tr>
<td>Deselect all channels</td>
<td>C/Alt C/Alt</td>
</tr>
<tr>
<td>Invert the channel selection</td>
<td>INV GROUP</td>
</tr>
<tr>
<td>Invert the channel selection</td>
<td>C/Alt &amp; THRU</td>
</tr>
<tr>
<td>Enter Next/Last mode for the next channel within the channel selection</td>
<td>NEXT</td>
</tr>
<tr>
<td>Enter Next/Last mode for the previous channel within the channel selection</td>
<td>LAST</td>
</tr>
<tr>
<td>Leaves Next/Last mode and focuses all selected channels</td>
<td>ALL CHANNELS</td>
</tr>
<tr>
<td>Open the Channel Select wizard</td>
<td>WIZARD &amp; CHANNEL</td>
</tr>
<tr>
<td>Set all channels in all playbacks to zero</td>
<td>C/Alt &amp; LIVE</td>
</tr>
</tbody>
</table>
Shortcuts - Channel Levels

These are keys and shortcuts for setting levels to the currently selected channels. Some of them assume the Command Syntax is set to RPN - see Channels - Command Syntax.

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set the selected channels to 70%, second press sets 100%</td>
<td>@LEVEL</td>
</tr>
<tr>
<td>Clear and deselect the selected channels</td>
<td>C/Ait &amp;@LEVEL</td>
</tr>
<tr>
<td>Set 100%</td>
<td>C/Ait +%</td>
</tr>
<tr>
<td>Set 0%</td>
<td>C/Ait -%</td>
</tr>
<tr>
<td>Increase the level of selected channels 5%</td>
<td>+%</td>
</tr>
<tr>
<td>Decrease the level of selected channels 5%</td>
<td>-%</td>
</tr>
<tr>
<td>Increase the level of channel # with 5%</td>
<td># +%</td>
</tr>
<tr>
<td>Decrease the level of channel # with 5%</td>
<td># -%</td>
</tr>
<tr>
<td>Increase the level of selected channels #%</td>
<td># . +%</td>
</tr>
<tr>
<td>Decrease the level of selected channels #%</td>
<td># . -%</td>
</tr>
<tr>
<td>Set level in internal resolution (0-255)</td>
<td># . &amp;@LEVEL</td>
</tr>
<tr>
<td>Fetch values to the selected channels from a preset</td>
<td># ON/FETCH</td>
</tr>
<tr>
<td>Increase level in 1 bit steps</td>
<td>. &amp; +%</td>
</tr>
<tr>
<td>Decrease level in 1 bit steps</td>
<td>. &amp; -%</td>
</tr>
<tr>
<td>Set the last recorded level for the selected channel(s).</td>
<td>ON/FETCH</td>
</tr>
</tbody>
</table>
Shortcuts - Channel Modes

Functions for checking, balancing & comparing channels.

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compare* the light in the Channel Control with its recorded version</td>
<td>COMPARE</td>
</tr>
<tr>
<td>Compare* the light in the Channel Control with preset #</td>
<td># COMPARE</td>
</tr>
<tr>
<td>Toggle Balance* mode on/off</td>
<td>BALANCE</td>
</tr>
<tr>
<td>Step with Check mode to the next channel</td>
<td>C/Alt +</td>
</tr>
<tr>
<td>Step with Check mode to the previous channel</td>
<td>C/Alt -</td>
</tr>
</tbody>
</table>

*COMPARE and BALANCE are soft keys in the Channels Soft Key Page of the Main Display of the console. BALANCE can be set instead of REM DIM in the console settings. See Channels - Compare Mode and Channels - Balance Mode.

Shortcuts - Select Nth Functions

Functions for selecting every Nth channels from the current channel selection. All these functions are Soft Keys in the Channels - Random Select Soft Key Page of the Main Display in the console.

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the SELECT Soft Key Page in the Main Display</td>
<td>SELECT</td>
</tr>
<tr>
<td>Select every # nth channel</td>
<td># Select Nth</td>
</tr>
<tr>
<td>Select every 2nd channel</td>
<td>Select 2nd</td>
</tr>
<tr>
<td>Select every 3rd channel</td>
<td>Select 3rd</td>
</tr>
<tr>
<td>Select every 2nd channel randomly</td>
<td>RANDOM &amp; Select 2nd</td>
</tr>
<tr>
<td>Select every 3rd channel randomly</td>
<td>RANDOM &amp; Select 3rd</td>
</tr>
<tr>
<td>Select every Nth channel randomly</td>
<td>RANDOM &amp; Select Nth</td>
</tr>
<tr>
<td>Select devices that have changed.</td>
<td>SELECT CHANGE</td>
</tr>
</tbody>
</table>
Shortcuts - Channel Views

These shortcuts control the channel views.

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scroll in the active channel view</td>
<td>[CHANNEL] &amp; [Arrow_Keys]</td>
</tr>
<tr>
<td>Scroll in the active channel view</td>
<td>[CHANNEL] &amp; Wheel</td>
</tr>
<tr>
<td>Toggles Channel View formats.</td>
<td>[FORMAT]</td>
</tr>
<tr>
<td>Selects Channel Layout #.</td>
<td># [FORMAT]</td>
</tr>
<tr>
<td>Zooms the Channel View.</td>
<td>[FORMAT] &amp; Wheel</td>
</tr>
<tr>
<td>Show temporary Captured format.</td>
<td>[FORMAT] &amp; [CAPTURE]</td>
</tr>
<tr>
<td>Show temporary Parked format.</td>
<td>[FORMAT] &amp; [PARK]</td>
</tr>
<tr>
<td>Select All Channels format.</td>
<td>[FORMAT] &amp; [ALL]</td>
</tr>
<tr>
<td>Select non-zero channel format</td>
<td>[FORMAT] &amp; [CHANNEL]</td>
</tr>
</tbody>
</table>

Shortcuts - HELP

These are the keys and shortcuts used for the online HELP function.

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open the help index. If a menu or editor is open it will open help for that.</td>
<td>[?]</td>
</tr>
<tr>
<td>Opens help for that key</td>
<td>[?] &amp; Any Key</td>
</tr>
<tr>
<td>Open the free text Search Function</td>
<td>[TEXT]</td>
</tr>
</tbody>
</table>

Navigating in the help pages

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next page</td>
<td>Down Arrow</td>
</tr>
<tr>
<td>Page before this page</td>
<td>Up Arrow</td>
</tr>
<tr>
<td>Last visited page</td>
<td>Left Arrow</td>
</tr>
<tr>
<td>Previously visited page</td>
<td>Right Arrow</td>
</tr>
</tbody>
</table>
Creating a Favourite

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a Favourite from a HELP tab</td>
<td>[NOTE]</td>
</tr>
<tr>
<td>Delete a Favourite from the Browser</td>
<td>[DELETE]</td>
</tr>
</tbody>
</table>

Shortcuts - Channels Only Mode

Channels Only Mode is activated by the three position Fader Mode switch in the top middle of the console. It turns the console into a single field manual desk.

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch Direct Ch mode on/off.</td>
<td>Fader Mode Switch</td>
</tr>
<tr>
<td>Select a channel range for the manual faders</td>
<td>The master keys over and under the displays.</td>
</tr>
</tbody>
</table>
**Shortcuts - General Editing Keys**

These keys are central in the general editing functions of the console. They are mostly used in combination with the navigation keys.

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Closes popups and tabs without executing.</td>
<td>ESC</td>
</tr>
<tr>
<td>Clears numerical input, and is used in combination with other keys as an ALT key.</td>
<td>C/Alt</td>
</tr>
<tr>
<td>Works as an ENTER key for popups and in spreadsheet cells. Is used in combination with a lot of keys to open editors.</td>
<td>MODIFY</td>
</tr>
</tbody>
</table>

**Shortcuts - Spreadsheet Editing**

These functions are for editing in Spreadsheets.

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>The arrow keys are used to navigate in a spreadsheet or list, but also in combination with all the other navigation keys for different functions.</td>
<td>Arrow Keys</td>
</tr>
<tr>
<td>Will insert a new entry in most spreadsheet lists</td>
<td>INSERT</td>
</tr>
<tr>
<td>Will insert the entry # in most spreadsheet lists</td>
<td># INSERT</td>
</tr>
<tr>
<td>Will delete the focused entry in most window lists</td>
<td>DELETE</td>
</tr>
<tr>
<td>Selects all items (down) in the column of a spreadsheet.</td>
<td>COLUMN</td>
</tr>
<tr>
<td>Scrolls the size of a column.</td>
<td>COLUMN &amp; Wheel</td>
</tr>
<tr>
<td>Sorts by the content of a column.</td>
<td>COLUMN &amp; Up/Down Arrow</td>
</tr>
<tr>
<td>Moves a column.</td>
<td>COLUMN &amp; Left/Right Arrow</td>
</tr>
<tr>
<td>Select cells to the right of the current cell</td>
<td>SELECT &amp; Right Arrow</td>
</tr>
<tr>
<td>Select cells below the current cell(s)</td>
<td>SELECT &amp; Down Arrow</td>
</tr>
</tbody>
</table>
Shortcuts - Navigation Keys (8.0)

The top four Navigation keys are central in the Navigating functions of the console. They are mostly used in combination with the General Editing keys.

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Opens the Browser. If the Browser is already focused, it will be closed.</td>
<td>Browser</td>
</tr>
<tr>
<td>Toggles through all open tabs.</td>
<td>Tab</td>
</tr>
<tr>
<td>Focuses Tab #.</td>
<td># Tab</td>
</tr>
<tr>
<td>Moves the focused tab to the next/last screen or split area.</td>
<td>Tab &amp; Right Arrow</td>
</tr>
<tr>
<td>Moves the focused tab to the next/last screen or split area.</td>
<td>Tab &amp; Left Arrow</td>
</tr>
</tbody>
</table>

Shortcuts - Master Playbacks

These are the main keys and shortcuts for managing content in the Master Playbacks. See also Shortcuts - Recording Functions.

Basic loading and clearing of content

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load Preset # to a master</td>
<td># PRESET &amp; Master Key</td>
</tr>
<tr>
<td>Load Sequence # to a master</td>
<td># SEQ &amp; Master Key</td>
</tr>
<tr>
<td>Load Group # to a master</td>
<td># GROUP &amp; Master Key</td>
</tr>
<tr>
<td>Load Focus Palette # to a master</td>
<td># FOCUS &amp; Master Key</td>
</tr>
<tr>
<td>Load Color Palette # to a master</td>
<td># COLOR &amp; Master Key</td>
</tr>
<tr>
<td>Load Beam Palette # to a master</td>
<td># BEAM &amp; Master Key</td>
</tr>
<tr>
<td>Load All Palette # to a master</td>
<td># PALETTE &amp; Master Key</td>
</tr>
<tr>
<td>Load Dynamic Effect # to a master</td>
<td># DYN EFFECT &amp; Master Key</td>
</tr>
<tr>
<td>Load a Parameter to a master</td>
<td>Wheel Key &amp; Master Key</td>
</tr>
<tr>
<td>Clear a master</td>
<td>C/Alt &amp; Master Key</td>
</tr>
<tr>
<td>Clear all Master Levels</td>
<td>C/Alt &amp; LIVE</td>
</tr>
<tr>
<td>Set text to preset or group in a master field</td>
<td>TEXT &amp; Master Key</td>
</tr>
<tr>
<td>Set a Time # to a Master with a Preset</td>
<td># TIME &amp; Master Key</td>
</tr>
</tbody>
</table>
Master control functions

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate the Master View*</td>
<td>MASTER</td>
</tr>
<tr>
<td>Open the Master Editor.</td>
<td>MODIFY &amp; Master Key</td>
</tr>
<tr>
<td>Set an individual flash level (in flash mode)</td>
<td>[#] FLASH MODE &amp; Master Key</td>
</tr>
<tr>
<td>Toggle a master on/off</td>
<td>START &amp; Master Key</td>
</tr>
<tr>
<td>Toggle master # on/off</td>
<td>[#] START</td>
</tr>
<tr>
<td>Fade a master to a specific level</td>
<td>[#] START &amp; Master Key</td>
</tr>
<tr>
<td>Hold FLASH MODE and press master keys to toggle modes. Use PAGE +/- to select functions.</td>
<td>FLASH MODE &amp; Master Key</td>
</tr>
<tr>
<td>Connect a master playback to the Master playback</td>
<td>CONNECT &amp; Master Key</td>
</tr>
<tr>
<td>Tap tempo for sequence on a master (hold tap and tap Master key).</td>
<td>TAP &amp; Master Key</td>
</tr>
</tbody>
</table>

*You can also click on the Master View node in the Browser.

Shortcuts - Masters & Channels

Functions for selecting channels to and from Master Playbacks.

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select the channels of a Preset/Group in a Master Playback.</td>
<td>Master Key</td>
</tr>
<tr>
<td>Add channels of a Preset/Group in a Master Playback to the channel selection</td>
<td>+ &amp; Master Key</td>
</tr>
<tr>
<td>Subtract channels of a Preset/Group in a Master Playback from the channel selection</td>
<td>- &amp; Master Key</td>
</tr>
<tr>
<td>Select channels of a Preset/Group in a Master Playback which are active on stage</td>
<td>ALL &amp; Master Key</td>
</tr>
<tr>
<td>Load the selected channels and levels one by one to Master Playbacks.</td>
<td>CHANNEL &amp; Master Key</td>
</tr>
<tr>
<td>Load the selected channels and levels as a group to a Master Playback.</td>
<td>GROUP &amp; Master Key</td>
</tr>
</tbody>
</table>
Shortcuts - Master Pages (8.0)

Main keys and shortcuts for handling Master Pages. Master pages are recorded/loaded separately for masters in banks of 20. The functions of the PAGE key are default routed to masters 1-20.

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load a Master Page # to masters 1-20</td>
<td>[#] PAGE</td>
</tr>
<tr>
<td>Load a Master Page # to masters 21-40</td>
<td>[#] PAGE &amp; Master key</td>
</tr>
<tr>
<td>Clear masters 1-20</td>
<td>[C/Alt] &amp; PAGE</td>
</tr>
<tr>
<td>Record changes to current Master Page*</td>
<td>[RECORD] &amp; PAGE</td>
</tr>
<tr>
<td>Record master content to Master Page #</td>
<td>[#] RECORD &amp; PAGE</td>
</tr>
<tr>
<td>Load next Master Page</td>
<td>PAGE &amp; +</td>
</tr>
<tr>
<td>Load previous Master Page</td>
<td>PAGE &amp; -</td>
</tr>
<tr>
<td>Tap tempo for a Master Page</td>
<td>TAP &amp; PAGE</td>
</tr>
<tr>
<td>Set a Master Page time</td>
<td>[#] TIME &amp; PAGE</td>
</tr>
<tr>
<td>Next Page</td>
<td>PAGE +</td>
</tr>
<tr>
<td>Previous Page</td>
<td>PAGE -</td>
</tr>
</tbody>
</table>

*This function is valid for all consoles except Cobalt 10/20/Programming Wing. It also depends on the Master Page Settings. See System Settings - Master.

**It is also possible to hold DISPLAY LIST and press the Direct Select key Mast Page.
### Shortcuts - Devices To Home Position

Functions for recording & setting Home positions to the selected Devices.

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set Home All</td>
<td>HOME ATTRIB &amp; HOME ATTRIB</td>
</tr>
<tr>
<td>Set Home All (shortcut)</td>
<td>C/Alt &amp; ATTRIBUTE</td>
</tr>
<tr>
<td>Set Home Focus</td>
<td>HOME ATTRIB &amp; FOCUS</td>
</tr>
<tr>
<td>Set Home Color</td>
<td>HOME ATTRIB &amp; COLOR</td>
</tr>
<tr>
<td>Set Home Beam</td>
<td>HOME ATTRIB &amp; BEAM</td>
</tr>
<tr>
<td>Set Home Focus</td>
<td>0 &amp; FOCUS</td>
</tr>
<tr>
<td>Set Home Color</td>
<td>0 &amp; COLOR</td>
</tr>
<tr>
<td>Set Home Beam</td>
<td>0 &amp; BEAM</td>
</tr>
<tr>
<td>Set Home All</td>
<td>0 &amp; PALETTE</td>
</tr>
<tr>
<td>Set Home to a Parameter</td>
<td>HOME ATTRIB &amp; Wheel Key</td>
</tr>
<tr>
<td>Record current attribute values as</td>
<td>RECORD &amp; HOME ATTRIB</td>
</tr>
<tr>
<td>the home position for the selected</td>
<td></td>
</tr>
<tr>
<td>channels</td>
<td></td>
</tr>
</tbody>
</table>

### Shortcuts - Device Attribute Editors

Keys and shortcuts for opening Attribute Editors for Devices.

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open Live Attribute Editor for the selected tab</td>
<td>ATTRIB</td>
</tr>
<tr>
<td>Open Attribute Editor for the Preset in field A</td>
<td>ATTRIB &amp; A</td>
</tr>
<tr>
<td>Open Attribute Editor for the Preset in field A</td>
<td>PRESET &amp; ATTRIB</td>
</tr>
<tr>
<td>Open Attribute Editor for the Preset in field B</td>
<td>ATTRIB &amp; B</td>
</tr>
<tr>
<td>Open Attribute Editor for a Preset on a Master</td>
<td>ATTRIB &amp; Master Key</td>
</tr>
<tr>
<td>Open Attribute Editor for Preset #</td>
<td># &amp; PRESET &amp; ATTRIB</td>
</tr>
</tbody>
</table>
### Formats
Keys and shortcuts for toggling information on/off in the Attribute Editors

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toggle Focus information</td>
<td>FORMAT &amp; FOCUS</td>
</tr>
<tr>
<td>Toggle Color information</td>
<td>FORMAT &amp; COLOR</td>
</tr>
<tr>
<td>Toggle Beam information</td>
<td>FORMAT &amp; BEAM</td>
</tr>
<tr>
<td>Toggle Time information</td>
<td>FORMAT &amp; up/down arrows</td>
</tr>
<tr>
<td>Toggle Single Parameter</td>
<td>FORMAT &amp; wheel key</td>
</tr>
<tr>
<td>Zoom</td>
<td>FORMAT &amp; wheel</td>
</tr>
</tbody>
</table>

### Shortcuts - Device Masking
Keys and shortcuts for masking Device Attributes from recording.

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear global Mask</td>
<td>C/Alt &amp; MASK</td>
</tr>
<tr>
<td>Toggle global Mask on/off</td>
<td>MASK</td>
</tr>
<tr>
<td>Toggle Focus parameters in global Mask</td>
<td>MASK &amp; FOCUS</td>
</tr>
<tr>
<td>Toggle Color parameters in global Mask</td>
<td>MASK &amp; COLOR</td>
</tr>
<tr>
<td>Toggle Beam parameters in global Mask</td>
<td>MASK &amp; BEAM</td>
</tr>
<tr>
<td>Toggle single parameter in global Mask</td>
<td>MASK &amp; Wheel Key</td>
</tr>
<tr>
<td>Open the Mask Editor tab</td>
<td>MODIFY &amp; MASK</td>
</tr>
<tr>
<td>Save the current mask to a Direct Select</td>
<td>RECORD &amp; Direct Sel</td>
</tr>
<tr>
<td>Recall a mask setting from a Direct Select</td>
<td>Direct Sel</td>
</tr>
<tr>
<td>Record the current mask to a master</td>
<td>MASK &amp; Master Key</td>
</tr>
</tbody>
</table>
# Shortcuts - Device Palette Recording

Keys and shortcuts for handling Device Palettes.

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record selected Devices to the first free Focus Palette</td>
<td>RECORD &amp; FOCUS</td>
</tr>
<tr>
<td>Record selected Devices to the first free Color Palette</td>
<td>RECORD &amp; COLOR</td>
</tr>
<tr>
<td>Record selected Devices to the first free Beam Palette</td>
<td>RECORD &amp; BEAM</td>
</tr>
<tr>
<td>Record selected Devices to the first free All Palette</td>
<td>RECORD &amp; PALETTE</td>
</tr>
<tr>
<td>Record selected Devices to Focus Palette #</td>
<td># RECORD &amp; FOCUS</td>
</tr>
<tr>
<td>Record selected Devices to Color Palette #</td>
<td># RECORD &amp; COLOR</td>
</tr>
<tr>
<td>Record selected Devices to Beam Palette #</td>
<td># RECORD &amp; BEAM</td>
</tr>
<tr>
<td>Record selected Devices to All Palette #</td>
<td># RECORD &amp; PALETTE</td>
</tr>
<tr>
<td>Record Palette # from the Direct Selects</td>
<td>RECORD &amp; direct select</td>
</tr>
</tbody>
</table>
Shortcuts - Device Palette Activating

Keys and shortcuts for activating values in Device Palettes for the currently selected device(s).

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate values from a Focus palette</td>
<td>[#] FOCUS</td>
</tr>
<tr>
<td>Activate values from a Color palette</td>
<td>[#] COLOR</td>
</tr>
<tr>
<td>Activate values from a Beam palette</td>
<td>[#] BEAM</td>
</tr>
<tr>
<td>Activate values from an All palette</td>
<td>[#] PALETTE</td>
</tr>
<tr>
<td>Activate a single parameter from a Focus palette</td>
<td>[#] FOCUS &amp; Wheel Key</td>
</tr>
<tr>
<td>Activate a single parameter from a Color palette</td>
<td>[#] COLOR &amp; Wheel Key</td>
</tr>
<tr>
<td>Activate a single parameter from a Beam palette</td>
<td>[#] BEAM &amp; Wheel Key</td>
</tr>
<tr>
<td>Activate a single parameter from an All palette</td>
<td>[#] PALETTE &amp; Wheel Key</td>
</tr>
<tr>
<td>Activate a Palette from a Direct select</td>
<td>Direct Select Key</td>
</tr>
<tr>
<td>Activate a Palette from a Direct select on time</td>
<td>[#] Direct Select Key</td>
</tr>
<tr>
<td>Activate a Palette from a Master</td>
<td>Master Key</td>
</tr>
<tr>
<td>Activate a Palette from a Master on time</td>
<td>[#] Master Key</td>
</tr>
</tbody>
</table>

Shortcuts - Device Palette Updating

Keys and shortcuts for updating Device Palettes. Some of these keys are softkeys in the Device soft key page of the Main Display.

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toggle Focusing mode on/off (soft key)</td>
<td>FOCUSING MODE</td>
</tr>
<tr>
<td>Select Palette in Display List</td>
<td>Right Click</td>
</tr>
<tr>
<td>Step to the next channel in palette selection</td>
<td>NEXT</td>
</tr>
<tr>
<td>Step to the previous channel in palette selection</td>
<td>LAST</td>
</tr>
<tr>
<td>Update the current palettes for the selected channel(s) (soft key)</td>
<td>UPDATE PAL</td>
</tr>
<tr>
<td>Toggle Highlight mode on/off</td>
<td>HIGHLIGHT</td>
</tr>
</tbody>
</table>
Shortcuts - Device Palette Specials

Keys and shortcuts for special Device Palette functions.

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select channels recorded in a Focus palette</td>
<td>[#] CHANNEL &amp; FOCUS</td>
</tr>
<tr>
<td>Select channels recorded in a Color palette</td>
<td>[#] CHANNEL &amp; COLOR</td>
</tr>
<tr>
<td>Select channels recorded in a Beam palette</td>
<td>[#] CHANNEL &amp; BEAM</td>
</tr>
<tr>
<td>Select channels recorded in an All palette</td>
<td>[#] CHANNEL &amp; PALETTE</td>
</tr>
<tr>
<td>Direct Select mode for Focus Palettes</td>
<td>FOCUS</td>
</tr>
<tr>
<td>(as long as the key is held)</td>
<td></td>
</tr>
<tr>
<td>Direct Select mode for Color Palettes</td>
<td>COLOR</td>
</tr>
<tr>
<td>(as long as the key is held)</td>
<td></td>
</tr>
<tr>
<td>Direct Select mode for Beam Palettes</td>
<td>BEAM</td>
</tr>
<tr>
<td>(as long as the key is held)</td>
<td></td>
</tr>
<tr>
<td>Direct Select mode for All Palettes</td>
<td>PALETTE</td>
</tr>
<tr>
<td>(as long as the key is held)</td>
<td></td>
</tr>
</tbody>
</table>

Shortcuts - Device Palette Views (8.0)

Keys and shortcuts for Device Palettes views and lists.

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open the Focus Palette Editor</td>
<td>MODIFY &amp; FOCUS</td>
</tr>
<tr>
<td>Open the Color Palette Editor</td>
<td>MODIFY &amp; COLOR</td>
</tr>
<tr>
<td>Open the Beam Palette Editor</td>
<td>MODIFY &amp; BEAM</td>
</tr>
<tr>
<td>Open the All Palette Editor</td>
<td>MODIFY &amp; PALETTE</td>
</tr>
</tbody>
</table>
Shortcuts - Device Palettes In Masters

Keys and shortcuts for handling Device Palettes in Master Playbacks.

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load a Focus palette to a master*</td>
<td>[#] FOCUS &amp; Master Key</td>
</tr>
<tr>
<td>Load a Color palette to a master*</td>
<td>[#] COLOR &amp; Master Key</td>
</tr>
<tr>
<td>Load a Beam palette to a master*</td>
<td>[#] BEAM &amp; Master Key</td>
</tr>
<tr>
<td>Load an All palette to a master*</td>
<td>[#] PALETTE &amp; Master Key</td>
</tr>
</tbody>
</table>

*If you keep the Palette key pressed and continue pressing Master keys, you will continue loading the next recorded Palette of each kind to the following Masters.

Shortcuts - Device Align & Fetch

Functions for aligning & fetching values for the selected Devices. Align uses the first selected Device, or the Device focused with NEXT/LAST as the argument.

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Align parameters for Focus</td>
<td>ALIGN &amp; FOCUS</td>
</tr>
<tr>
<td>Align parameters for Color</td>
<td>ALIGN &amp; COLOR</td>
</tr>
<tr>
<td>Align parameters for Beam</td>
<td>ALIGN &amp; BEAM</td>
</tr>
<tr>
<td>Align a single Parameter</td>
<td>ALIGN &amp; Wheel Key</td>
</tr>
<tr>
<td>Fetch Focus values from a preset</td>
<td>[#] ON/FETCH &amp; FOCUS</td>
</tr>
<tr>
<td>Fetch Color values from a preset</td>
<td>[#] ON/FETCH &amp; COLOR</td>
</tr>
<tr>
<td>Fetch Beam values from a preset</td>
<td>[#] ON/FETCH &amp; BEAM</td>
</tr>
<tr>
<td>Fetch Parameter values from a preset</td>
<td>[#] ON/FETCH &amp; Wheel Key</td>
</tr>
<tr>
<td>Fetch all attributes from a preset</td>
<td>[#] ON/FETCH &amp; ATTRIB</td>
</tr>
</tbody>
</table>
Shortcuts - Patch & Outputs

Keys and shortcuts for patch and output functions.

Select outputs and open Patch lists

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select an output for temporary direct control - opening the Output Editor.</td>
<td></td>
</tr>
<tr>
<td>Add an output to the current selection</td>
<td></td>
</tr>
<tr>
<td>Subtract an output from the current selection</td>
<td></td>
</tr>
<tr>
<td>Add an Output range to the current selection</td>
<td></td>
</tr>
<tr>
<td>Open the Channel List</td>
<td>MODIFY &amp; CHANNEL</td>
</tr>
<tr>
<td>Open the Device List</td>
<td>MODIFY &amp; DEVICE</td>
</tr>
<tr>
<td>Open the Output Editor</td>
<td>MODIFY &amp; OUTPUT</td>
</tr>
<tr>
<td>Toggle level information the Output Editor</td>
<td>FORMAT &amp; Up–Down arrows</td>
</tr>
</tbody>
</table>

Patching in the Output Editor

It is possible to patch multiple outputs and channels directly in the Output Editor (only in default Cobalt Commans syntax, RPN, mode).

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Patch output # to channel #</td>
<td></td>
</tr>
<tr>
<td>Patch outputs # - # to, or from, channel # (popup)</td>
<td></td>
</tr>
<tr>
<td>Patch outputs consecutively to channels # - # from output # (popup)</td>
<td></td>
</tr>
</tbody>
</table>

Shortcuts - Track

Track is applied to the current channel selection. See Select Channels.

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Track in the Sequence of the Main Playback.</td>
<td>TRACK</td>
</tr>
<tr>
<td>Track in all Sequences</td>
<td>TRACK &amp; SEQ</td>
</tr>
<tr>
<td>Track in the Sequence of a Master Playback.</td>
<td>TRACK &amp; Master Key</td>
</tr>
<tr>
<td>Track in Presets.</td>
<td>TRACK &amp; PRESET</td>
</tr>
<tr>
<td>Track in Groups.</td>
<td>TRACK &amp; GROUP</td>
</tr>
<tr>
<td>Track in Focus Palettes.</td>
<td>TRACK &amp; FOCUS</td>
</tr>
<tr>
<td>Track in Color Palettes.</td>
<td>TRACK &amp; COLOR</td>
</tr>
<tr>
<td>Track in Beam Palettes.</td>
<td>TRACK &amp; BEAM</td>
</tr>
<tr>
<td>Track in All Palettes.</td>
<td>TRACK &amp; PALETTE</td>
</tr>
<tr>
<td>Track in All Play Data.</td>
<td>TRACK &amp; CHANNEL</td>
</tr>
</tbody>
</table>

Track Preset and Palette in Main Playback

In the Browser and Organizer you can track the selected preset or palette in the sequence loaded to the Main Playback.

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Track selected preset or palette</td>
<td>TRACK</td>
</tr>
</tbody>
</table>

Formats

Keys and shortcuts for toggling information on/off in the Track lists with attributes.

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toggle Focus information</td>
<td>FORMAT &amp; FOCUS</td>
</tr>
<tr>
<td>Toggle Color information</td>
<td>FORMAT &amp; COLOR</td>
</tr>
<tr>
<td>Toggle Beam information</td>
<td>FORMAT &amp; BEAM</td>
</tr>
<tr>
<td>Toggle Parameter information</td>
<td>FORMAT &amp; Wheel Key</td>
</tr>
<tr>
<td>Toggle Intensity information</td>
<td>FORMAT &amp; @LEVEL</td>
</tr>
</tbody>
</table>
Shortcuts - Presets

Presets can be loaded and recorded in many ways. There are shortcuts also for selecting all channels in a Preset, or fetching the levels.

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record a Preset in a Channel View</td>
<td>RECORD</td>
</tr>
<tr>
<td>Record a Preset directly to a Master Playback</td>
<td>RECORD &amp; [Master Key]</td>
</tr>
<tr>
<td>Select all channels in Preset #</td>
<td># PRESET</td>
</tr>
<tr>
<td>Fetch levels from a Preset # for the selected channels</td>
<td># ON/FETCH</td>
</tr>
<tr>
<td>Add channels from Preset #</td>
<td># PRESET &amp; +</td>
</tr>
<tr>
<td>Subtract channels from Preset #</td>
<td># PRESET &amp; -</td>
</tr>
<tr>
<td>Add a range of Presets until Preset #</td>
<td># PRESET &amp; THRU</td>
</tr>
<tr>
<td>Levels from Preset # are fetched</td>
<td># PRESET @LEVEL</td>
</tr>
<tr>
<td>Bring Preset in proportionately on the wheel</td>
<td># PRESET &amp; Wheel</td>
</tr>
<tr>
<td>Load Preset # to LIVE, clearing all previous light</td>
<td># PRESET &amp; LIVE</td>
</tr>
<tr>
<td>Add Preset # to BLIND</td>
<td># PRESET &amp; BLIND</td>
</tr>
<tr>
<td>Load Preset # to a Master Playback</td>
<td># PRESET &amp; Master Key</td>
</tr>
<tr>
<td>Open the Preset List</td>
<td>PRESET</td>
</tr>
<tr>
<td>Open Preset List focused at Preset #</td>
<td># MODIFY &amp; PRESET</td>
</tr>
</tbody>
</table>
Shortcuts - Groups

Groups can be loaded and recorded in many ways. There are shortcuts also for selecting all channels in a Group, or fetching the levels. See also Shortcuts - Recording Functions.

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record a Group in a Channel View</td>
<td>[#] GROUP &amp; RECORD</td>
</tr>
<tr>
<td>Select all channels in a Group</td>
<td>[#] GROUP</td>
</tr>
<tr>
<td>Fetch levels from a Group</td>
<td>[#] ON/FETCH &amp; GROUP</td>
</tr>
<tr>
<td>Add channels from Group</td>
<td>[#] GROUP &amp; +</td>
</tr>
<tr>
<td>Subtract channels from Group</td>
<td>[#] GROUP &amp; -</td>
</tr>
<tr>
<td>Add a range of Groups</td>
<td>[#] GROUP &amp; THRU</td>
</tr>
<tr>
<td>Levels from Group are fetched</td>
<td>[#] GROUP &amp; @LEVEL</td>
</tr>
<tr>
<td>Load selection to master</td>
<td>GROUP &amp; Master Key</td>
</tr>
<tr>
<td>Bring Group in proportionately on the wheel</td>
<td>[#] GROUP &amp; Wheel</td>
</tr>
<tr>
<td>Add Group # to LIVE</td>
<td>[#] GROUP &amp; LIVE</td>
</tr>
<tr>
<td>Add Group # to BLIND</td>
<td>[#] GROUP &amp; BLIND</td>
</tr>
<tr>
<td>Load Group # to a Master Playback</td>
<td>[#] GROUP &amp; Master Key</td>
</tr>
<tr>
<td>Open the Group List</td>
<td>GROUP</td>
</tr>
<tr>
<td>Temporary Direct Select mode</td>
<td>GROUP hold down</td>
</tr>
<tr>
<td>Open Group List focused at Group #</td>
<td>[#] MODIFY &amp; GROUP</td>
</tr>
</tbody>
</table>
Shortcuts - Live & Blind

These are keys and shortcuts for loading and clearing the content of Live and Blind.

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sets the Channel Control to the A field of the Main Playback, and focuses the Live tab.</td>
<td>[LIVE]</td>
</tr>
<tr>
<td>Sets the Channel Control to the Blind field and focuses the Blind Tab.</td>
<td>[BLIND]</td>
</tr>
<tr>
<td>Clear all channels and levels in Live</td>
<td>[C/Alt] &amp; [CHANNEL]</td>
</tr>
<tr>
<td>Clear all channels and levels in Live</td>
<td>[C/Alt] &amp; [LIVE]</td>
</tr>
<tr>
<td>Clear all channels and levels in Blind</td>
<td>[C/Alt] &amp; [BLIND]</td>
</tr>
<tr>
<td>Copy Live to Blind</td>
<td>[LIVE] &amp; [BLIND]</td>
</tr>
<tr>
<td>Copy Blind to Live</td>
<td>[BLIND] &amp; [LIVE]</td>
</tr>
<tr>
<td>Load Preset # in Live</td>
<td>[#] [PRESET] &amp; [LIVE]</td>
</tr>
<tr>
<td>Add Preset # to Blind</td>
<td>[#] [PRESET] &amp; [BLIND]</td>
</tr>
<tr>
<td>Add Group # to Live</td>
<td>[#] [GROUP] &amp; [LIVE]</td>
</tr>
<tr>
<td>Add Group # to Blind</td>
<td>[#] [GROUP] &amp; [BLIND]</td>
</tr>
<tr>
<td>Adds the content of the Blind field to the total output.</td>
<td>[BLIND] &amp; [Wheel]</td>
</tr>
</tbody>
</table>
# Shortcuts - Record Functions

These are shortcuts for recording Presets, Groups and master pages.

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record the next free preset in a Channel View</td>
<td>RECORD</td>
</tr>
<tr>
<td>Record the preset # in a Channel View</td>
<td>[#] RECORD</td>
</tr>
<tr>
<td>Record current channel selection to a Master</td>
<td>RECORD &amp; Master Key</td>
</tr>
<tr>
<td>Record current Master Page content to a different Master Page</td>
<td>[#] RECORD &amp; PAGE</td>
</tr>
<tr>
<td>Record all attributes in this Preset for the selected channel(s)</td>
<td>RECORD &amp; ATTRIB</td>
</tr>
<tr>
<td>Record attributes for selected channels to Preset #</td>
<td>[#] RECORD &amp; ATTRIB</td>
</tr>
<tr>
<td>Record current channel selection as the next free Group</td>
<td>RECORD &amp; GROUP</td>
</tr>
<tr>
<td>Record current channel selection as Group #</td>
<td>[#] RECORD &amp; GROUP</td>
</tr>
<tr>
<td>Record only Captured channels to Preset #</td>
<td>[#] RECORD &amp; CAPTURE</td>
</tr>
</tbody>
</table>

# Shortcuts - Update Functions

These are shortcuts for updating Presets.

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update changes in the preset loaded to this Channel View</td>
<td>UPDATE</td>
</tr>
<tr>
<td>Update Palette # in a Direct Select</td>
<td>UPDATE &amp; Direct Select Key</td>
</tr>
<tr>
<td>Update level changes tracking</td>
<td>UPDATE &amp; @LEVEL</td>
</tr>
<tr>
<td>Update attributes at source</td>
<td>UPDATE &amp; ATTRIB</td>
</tr>
</tbody>
</table>
Shortcuts - Channel Text Wizard

This is the shortcut for opening the Channel Text Wizard that sets texts to the Channel Database directly from a Channel View.

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open the Channel Text Wizard for the current channel selection.</td>
<td>CHANNEL &amp; TEXT</td>
</tr>
</tbody>
</table>

Shortcuts - Main Playback

These are shortcuts for the Sequence in the Main Playback.

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load/Create Sequence #</td>
<td>[#] SEQ &amp; PLAYBACK</td>
</tr>
<tr>
<td>Load Preset # to A</td>
<td>[#] PRESET &amp; A</td>
</tr>
<tr>
<td>Load Preset # to B</td>
<td>[#] PRESET &amp; B</td>
</tr>
<tr>
<td>Focus the Main Playback TAB and connect the Channel Control to Live</td>
<td>PLAYBACK</td>
</tr>
<tr>
<td>Goto Preset #</td>
<td>[#] GOTO</td>
</tr>
<tr>
<td>Goto Preset # in B</td>
<td>[#] JUMP TO B</td>
</tr>
<tr>
<td>Step to the next Preset in Sequence</td>
<td>SEQ+</td>
</tr>
<tr>
<td>Step to the previous Preset in Sequence</td>
<td>SEQ-</td>
</tr>
<tr>
<td>Start the next crossfade</td>
<td>GO</td>
</tr>
<tr>
<td>Start the next crossfade during an ongoing fade</td>
<td>GO</td>
</tr>
<tr>
<td>Insert a Master Link to the current Step</td>
<td>INSERT &amp; Master Key</td>
</tr>
<tr>
<td>Insert a Master Link with Target # to the current Step</td>
<td>[#] INSERT &amp; Master Key</td>
</tr>
<tr>
<td>Open the Sequence List at the current step</td>
<td>MODIFY &amp; PLAYBACK</td>
</tr>
<tr>
<td>Open the Sequence List at step #</td>
<td>[#] MODIFY &amp; PLAYBACK</td>
</tr>
</tbody>
</table>

Refresh functions
The Refresh Functions are used to reset any intensity or attribute that has been altered since the last crossfade in the Main Playback - back to where it would have been if the sequence had been run from the start.
### DESCRIPTION | SYNTAX
---|---
Refresh all channels | **REFRESH**
Refresh the intensity of selected channel(s) | **REFRESH** & **@LEVEL**
Refresh the attributes of all or selected channel(s) | **REFRESH** & **ATTRIB**
Refresh a parameter of all or selected channel(s) | **REFRESH** & **Wheel key**
Refresh Focus Parameters of selected channel(s) | **REFRESH** & **FOCUS**
Refresh Color Parameters of selected channel(s) | **REFRESH** & **COLOR**
Refresh Beam Parameters of selected channel(s) | **REFRESH** & **BEAM**

### Shortcuts - Sequence Editor

These are shortcuts in the Sequence List that will set times directly to the focused step.

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set an In/Out Time</td>
<td>[#] <strong>TIME</strong></td>
</tr>
<tr>
<td>Set an In Time</td>
<td>[#] <strong>IN</strong></td>
</tr>
<tr>
<td>Set an Out Time</td>
<td>[#] <strong>OUT</strong></td>
</tr>
</tbody>
</table>

### Shortcuts - Direct Selects

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Type of content (hold key)</td>
<td><strong>TYPE</strong> &amp; <strong>Direct Key</strong></td>
</tr>
<tr>
<td>Select Bank of content (hold key)</td>
<td><strong>BANK</strong> &amp; <strong>Direct Key</strong></td>
</tr>
<tr>
<td>Record a Palette directly</td>
<td><strong>RECORD</strong> &amp; <strong>Direct Key</strong></td>
</tr>
<tr>
<td>Update a Palette directly</td>
<td><strong>UPDATE</strong> &amp; <strong>Direct Key</strong></td>
</tr>
<tr>
<td>Change User Setup</td>
<td>User Setup key 1-5</td>
</tr>
<tr>
<td>Record a Screen Setting</td>
<td><strong>TAB</strong> &amp; <strong>Direct Key</strong></td>
</tr>
<tr>
<td>Activate a Palette in time #</td>
<td>[#] <strong>Direct Key</strong></td>
</tr>
<tr>
<td>Select all channels in a Palette</td>
<td><strong>CHANNEL</strong> &amp; <strong>Direct Key</strong></td>
</tr>
<tr>
<td>Select all channels with an intensity over zero, that are set to a Palette</td>
<td><strong>ALL</strong> &amp; <strong>Direct Key</strong></td>
</tr>
</tbody>
</table>
Shortcuts - Notes

You can set a Note directly to the current Sequence Step or the focused step in a spreadsheet.

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a Note for the current sequence step when in the Main Playback or Live tab</td>
<td>NOTE</td>
</tr>
<tr>
<td>Create a Note for a focused item in a spreadsheet</td>
<td>NOTE</td>
</tr>
<tr>
<td>Open the NOTE Editor directly</td>
<td>MODIFY &amp; NOTE</td>
</tr>
</tbody>
</table>

Shortcuts - Capture & Release

Functions for capturing & releasing channels.

Capture functions

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate permanent Capture mode</td>
<td>CAPTURE</td>
</tr>
<tr>
<td>Capture intensity and attributes for the selected channel in Capture mode</td>
<td>Wheel</td>
</tr>
<tr>
<td>Capture intensity and attributes for the selected channel(s)</td>
<td>CAPTURE &amp; CHANNEL</td>
</tr>
<tr>
<td>Capture the intensity of selected channel(s)</td>
<td>CAPTURE &amp; @LEVEL</td>
</tr>
<tr>
<td>Capture the attributes of selected channel(s)</td>
<td>CAPTURE &amp; ATTRIB</td>
</tr>
<tr>
<td>Capture a parameter of selected channel(s)</td>
<td>CAPTURE &amp; Wheel key</td>
</tr>
<tr>
<td>Capture Focus Parameters of selected channel(s)</td>
<td>CAPTURE &amp; FOCUS</td>
</tr>
<tr>
<td>Capture Color Parameters of selected channel(s)</td>
<td>CAPTURE &amp; COLOR</td>
</tr>
<tr>
<td>Capture Beam Parameters of selected channel(s)</td>
<td>CAPTURE &amp; BEAM</td>
</tr>
</tbody>
</table>
## Release functions

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Releases the selected ch from Capture Mode</td>
<td><code>RELEASE</code></td>
</tr>
<tr>
<td>Release all Captured channels</td>
<td><code>RELEASE RELEASE</code></td>
</tr>
<tr>
<td>Release all Captured in # seconds</td>
<td><code># RELEASE</code></td>
</tr>
<tr>
<td>Release intensity and attributes for the selected channel(s)</td>
<td><code>RELEASE CHANNEL</code></td>
</tr>
<tr>
<td>Release the intensity of selected channel(s)</td>
<td><code>RELEASE @LEVEL</code></td>
</tr>
<tr>
<td>Release the attributes of selected channel(s)</td>
<td><code>RELEASE ATTRIB</code></td>
</tr>
<tr>
<td>Capture a parameter of selected channel(s)</td>
<td><code>RELEASE Wheel key</code></td>
</tr>
<tr>
<td>Release Focus Parameters of selected channel(s)</td>
<td><code>RELEASE FOCUS</code></td>
</tr>
<tr>
<td>Release Color Parameters of selected channel(s)</td>
<td><code>RELEASE COLOR</code></td>
</tr>
<tr>
<td>Release Beam Parameters of selected channel(s)</td>
<td><code>RELEASE BEAM</code></td>
</tr>
</tbody>
</table>
Shortcuts - Dynamics (old)

These Dynamics functions can be used to start/stop and control older Dynamic Effects. Many of them are soft keys in the Dynamics Soft Key Page. See Dynamics - Control.

Start and stop Dynamics

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate an Dynamic Template for the selected channels</td>
<td># DYN EFFECT</td>
</tr>
<tr>
<td>Open the Live Dynamics List</td>
<td>DYN EFFECT</td>
</tr>
<tr>
<td>Select the DYNAMICS Soft Key Page in the Main Display</td>
<td>DYNAMICS</td>
</tr>
<tr>
<td>Select all channels with a running dynamic (softkey)</td>
<td>SELECT ALL</td>
</tr>
<tr>
<td>Select all channels with a running dynamic</td>
<td>CHANNEL &amp; DYN EFFECT</td>
</tr>
<tr>
<td>Clear running dynamics for the selected channels (softkey)</td>
<td>CLEAR SELECTED</td>
</tr>
<tr>
<td>Clear running dynamics for the selected channels</td>
<td>C/Alt &amp; DYN EFFECT</td>
</tr>
<tr>
<td>Load a Dynamic Template to a master</td>
<td># DYN EFFECT &amp; Master_key</td>
</tr>
<tr>
<td>Delete the selected Dynamic from the Live Dynamic Effect</td>
<td>DELETE DYNAM</td>
</tr>
<tr>
<td>Delete all running Dynamics (softkey)</td>
<td>DELETE ALL</td>
</tr>
<tr>
<td>Delete all running Dynamics (softkey)</td>
<td>ALL &amp; DELETE DYNAM</td>
</tr>
<tr>
<td>Activate Direct Select for Dynamics (hold key for 2secs to get display)</td>
<td>DYN EFFECT</td>
</tr>
<tr>
<td>Open the Dynamic Effect List</td>
<td>MODIFY &amp; DYN EFFECT</td>
</tr>
</tbody>
</table>
## Record and edit Dynamic Effects

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record running Dynamics to the current Preset in A</td>
<td>RECORD &amp; DYN EFFECT</td>
</tr>
<tr>
<td>Record running Dynamics for the selected channels to Preset #</td>
<td># RECORD &amp; DYN EFFECT</td>
</tr>
<tr>
<td>Fetch dynamics for the selected channels from a preset*</td>
<td># ON/FETCH &amp; DYN EFFECT</td>
</tr>
<tr>
<td>Open the Dynamics Editor for the current preset</td>
<td>PRESET &amp; DYN EFFECT</td>
</tr>
<tr>
<td>Keep the Dynamics in the next Preset (softkey)</td>
<td>KEEP DYNAM</td>
</tr>
</tbody>
</table>

*Dynamics are always fetched for all channels in the target Preset, even if only one is selected.*
Shortcuts - Times

Keys and shortcuts for setting times. Times are set to the Active Sequence Step (in A) or the Next Sequence Step (in B) depending on the Time Settings. See System Settings - Crossfade.

<table>
<thead>
<tr>
<th>DESCRIPTION</th>
<th>SYNTAX</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set an In/Out time</td>
<td># TIME</td>
</tr>
<tr>
<td>Set an In time</td>
<td># IN</td>
</tr>
<tr>
<td>Set an Out time</td>
<td># OUT</td>
</tr>
<tr>
<td>Set a Delay In time</td>
<td># DELAY &amp; IN</td>
</tr>
<tr>
<td>Set a Delay Out time</td>
<td># DELAY &amp; OUT</td>
</tr>
<tr>
<td>Set a Channel time (to the selected channels)</td>
<td># CHANNEL &amp; TIME</td>
</tr>
<tr>
<td>Set a Parameter time</td>
<td># TIME &amp; Wheel key</td>
</tr>
<tr>
<td>Set a Channel Delay time (to the selected channels)</td>
<td># CHANNEL &amp; DELAY</td>
</tr>
<tr>
<td>Set a FOCUS time</td>
<td># TIME &amp; FOCUS</td>
</tr>
<tr>
<td>Set a COLOR time</td>
<td># TIME &amp; COLOR</td>
</tr>
<tr>
<td>Set a BEAM time</td>
<td># TIME &amp; BEAM</td>
</tr>
<tr>
<td>Set a FOCUS Delay time</td>
<td># DELAY &amp; FOCUS</td>
</tr>
<tr>
<td>Set a COLOR Delay time</td>
<td># DELAY &amp; COLOR</td>
</tr>
<tr>
<td>Set a BEAM Delay time</td>
<td># DELAY &amp; BEAM</td>
</tr>
<tr>
<td>Set a Parameter delay time</td>
<td># DELAY &amp; Wheel key</td>
</tr>
<tr>
<td>Set an FCB time</td>
<td># TIME &amp; ATTRIB</td>
</tr>
<tr>
<td>Set an FCB Delay time</td>
<td># DELAY &amp; ATTRIB</td>
</tr>
</tbody>
</table>
This Chapter is about accessories and options, such as remote control, networking, printer, fader wing panel, keyboard etc.

This chapter contains the following sections

- Accessory - Keyboard
- Accessory - Mouse Or Trackball
- Accessory - Printer
- Accessory - Remote Control
- Accessory - Visualisation Software
- Accessory - Cobalt ETCnomad - Server & Client
- Accessory - Cobalt Programming Wing
- Accessory - Net3 Remote Video Interface
- Accessory - X-keys
- Accessory - Cobalt LS
Accessories - Keyboard

An external keyboard will simulate most keys of the console. See the Console Functions Table below.

This is simple to work with, since the keyboard works exactly like the console. For example pressing R is the same as pressing RECORD, and pressing 1 is the same as pressing Master key 1.

WARNING
Multi-media keyboards may have special keys, for example SLEEP - which puts CONGO - to sleep. Avoid using these keyboards, they will trigger functions that you most probably do NOT want.

Keyboard - Numerical Input on a Notebook

If you are running the offline editor in a notebook without a numerical keypad, you can access numbers and basic channel and level functions using CTRL.

CTRL & 1-9 = Numerical input
CTRL & F1 = CH
CTRL & F2 = CH+
CTRL & F2 = CH-
CTRL & F4 = THRU
CTRL & F5 = LEVEL
CTRL & F6 = ALL

NOTE
The CTRL & F-commands may not work in a Mac notebook, depending on the setup of F-keys.

Keyboard - Standard Functions

Standard keyboard functions available in all situations are:

ESC = Escape, closes open tabs and exits dialogs.
INSERT = Inserts data in all lists (in Mac computers use CTRL & DELETE)
DELETE = Deletes data in all lists.
NUMBERS (in the numeric keypad) = Numeric entries.
HOME = Jumps to the first line of the list or editor.
END = Jumps to the last line of the list or editor.
ARROW KEYS = Arrow keys.

968
Console Keys in a Keyboard - Hotkeys (8.0)

These are the keyboard equivalents of the console keys. If you are using an offline editor they allow you to access most of the functionality directly, as if you had a console.

**NOTE**

Mac Note, especially MacBook users: Apple offers many different keyboards on their products. On Macs with a CONTROL key, this key often takes the place of the key shown above. To use the keyboard shortcuts in the best possible way, an external expanded keyboard is required. On the MacBook this reduces the conflicts with the many features associated with the Function keys (F1-F12).

The external keyboard will control Cobalt regardless of Exposé/Spaces settings while the internal keyboard will continue to perform special functions like brightness/volume/etc. Additionally, the expanded DELETE key (not Backspace) is required for the INSERT command in Cobalt and the numeric keypad is required for channel selection and level setting.

If you are using a desktop or a laptop without an external keyboard, please adjust your Keyboard settings to use Function keys as normal function keys (not special functions) and use the Console Mimic tab.

We recommend Apple-compatible keyboards with Apple symbols/layout and the expanded arrow/navigation keys and numeric keypad.

<table>
<thead>
<tr>
<th>Console Key</th>
<th>PC Equivalent</th>
<th>Mac Equivalent</th>
</tr>
</thead>
<tbody>
<tr>
<td>-</td>
<td>Ctrl Left Arrow or Keypad Ctrl *</td>
<td>Keypad Cmd *</td>
</tr>
<tr>
<td>+</td>
<td>Ctrl Right Arrow or Keypad Ctrl *</td>
<td>Keypad *</td>
</tr>
<tr>
<td>-%</td>
<td>Ctrl Down Arrow</td>
<td></td>
</tr>
<tr>
<td>+%</td>
<td>Ctrl Up Arrow</td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>A</td>
<td>A</td>
</tr>
<tr>
<td>ALIGN</td>
<td>Ctrl A</td>
<td>Ctrl A</td>
</tr>
<tr>
<td>ALL</td>
<td>Ctrl F6</td>
<td>Ctrl F6</td>
</tr>
<tr>
<td>AT LEVEL</td>
<td>Ctrl L or Keypad +</td>
<td>Ctrl L or Keypad +</td>
</tr>
<tr>
<td>ATTRIBUTE</td>
<td>I</td>
<td>I</td>
</tr>
<tr>
<td>B</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>BEAM (B)</td>
<td>Alt B</td>
<td>Option B</td>
</tr>
<tr>
<td>BLIND</td>
<td>F3</td>
<td>F3</td>
</tr>
<tr>
<td>BROWSER</td>
<td>F10</td>
<td>F10</td>
</tr>
<tr>
<td>C/ALT</td>
<td>Backspace</td>
<td>Backspace</td>
</tr>
<tr>
<td>CAPTURE</td>
<td>C</td>
<td>C</td>
</tr>
<tr>
<td>Console Key</td>
<td>PC Equivalent</td>
<td>Mac Equivalent</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>CH</td>
<td>Ctrl H or Keypad -</td>
<td>Ctrl H or Keypad -</td>
</tr>
<tr>
<td>COLOR (C)</td>
<td>Alt C</td>
<td>Option C</td>
</tr>
<tr>
<td>COLUMN COPY</td>
<td>F9</td>
<td>F9</td>
</tr>
<tr>
<td></td>
<td>Ctrl C</td>
<td>Ctrl C</td>
</tr>
<tr>
<td>CUT</td>
<td>Ctrl X</td>
<td>Ctrl B</td>
</tr>
<tr>
<td>DELAY</td>
<td>Ctrl D</td>
<td>Ctrl D</td>
</tr>
<tr>
<td>DELETE</td>
<td>DELETE</td>
<td>DELETE (not backspace)</td>
</tr>
<tr>
<td>DEVICE</td>
<td>D</td>
<td>D</td>
</tr>
<tr>
<td>DISPLAY LIST</td>
<td>J</td>
<td>J</td>
</tr>
<tr>
<td>EFFECT</td>
<td>E</td>
<td>E</td>
</tr>
<tr>
<td>ESC</td>
<td>ESC</td>
<td>ESC</td>
</tr>
<tr>
<td>EXIT Cobalt</td>
<td>Alt X</td>
<td>Option X</td>
</tr>
<tr>
<td>FAN</td>
<td>Ctrl F</td>
<td>Ctrl F</td>
</tr>
<tr>
<td>FOCUS (F)</td>
<td>Alt F</td>
<td>Option F</td>
</tr>
<tr>
<td>FETCH/ON</td>
<td>F or Keypad Ctrl +</td>
<td>F or Keypad Ctrl +</td>
</tr>
<tr>
<td>FORMAT</td>
<td>F4</td>
<td>F4</td>
</tr>
<tr>
<td>GO</td>
<td>Ctrl G</td>
<td>Ctrl G</td>
</tr>
<tr>
<td>GO BACK</td>
<td>Ctrl B</td>
<td>Ctrl B</td>
</tr>
<tr>
<td>GOTO</td>
<td>G</td>
<td>G</td>
</tr>
<tr>
<td>GROUP</td>
<td>F7 or Alt G</td>
<td>Ctrl G</td>
</tr>
<tr>
<td>HELP (?)</td>
<td>F1</td>
<td>F1</td>
</tr>
<tr>
<td>HIGHLIGHT</td>
<td>Alt H</td>
<td>Option H</td>
</tr>
<tr>
<td>HOME ATTR</td>
<td>F5</td>
<td>F5</td>
</tr>
<tr>
<td>IN</td>
<td>Ctrl I</td>
<td>Ctrl I</td>
</tr>
<tr>
<td>IND 7</td>
<td>Ctrl F7</td>
<td>N/A</td>
</tr>
<tr>
<td>IND 8</td>
<td>Ctrl F8</td>
<td>N/A</td>
</tr>
<tr>
<td>IND 9</td>
<td>Ctrl F9</td>
<td>Ctrl F9</td>
</tr>
<tr>
<td>INSERT</td>
<td>INSERT</td>
<td>Ctrl DELETE</td>
</tr>
<tr>
<td>JUMP TO B</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>LAST</td>
<td>L</td>
<td>L</td>
</tr>
<tr>
<td>LIVE</td>
<td>F2</td>
<td>F2</td>
</tr>
<tr>
<td>LOAD</td>
<td>F6</td>
<td>F6</td>
</tr>
<tr>
<td>Console Key</td>
<td>PC Equivalent</td>
<td>Mac Equivalent</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------</td>
<td>----------------</td>
</tr>
<tr>
<td>MACRO</td>
<td>Q</td>
<td>Q</td>
</tr>
<tr>
<td>MASK</td>
<td>K</td>
<td>K</td>
</tr>
<tr>
<td>MASTER</td>
<td>F8</td>
<td>F8</td>
</tr>
<tr>
<td>Master Keys 1-10</td>
<td>1-0 along top of keyboard</td>
<td>1-0 along top of keyboard</td>
</tr>
<tr>
<td>MODIFY</td>
<td>ENTER</td>
<td>RETURN</td>
</tr>
<tr>
<td>MUTE</td>
<td>Y</td>
<td>Y</td>
</tr>
<tr>
<td>NEXT</td>
<td>N</td>
<td>N</td>
</tr>
<tr>
<td>NOTE</td>
<td>Alt N</td>
<td>Option N</td>
</tr>
<tr>
<td>Number input</td>
<td>Ctrl 1-0 or keypad</td>
<td>Ctrl 1-0 or keypad</td>
</tr>
<tr>
<td>OUT</td>
<td>Ctrl O</td>
<td>Ctrl O</td>
</tr>
<tr>
<td>OUTPUT</td>
<td>O</td>
<td>O</td>
</tr>
<tr>
<td>PAGE (M1-20)</td>
<td>M</td>
<td>M</td>
</tr>
<tr>
<td>PAGE (M21-40)</td>
<td>Ctrl M</td>
<td>Ctrl M</td>
</tr>
<tr>
<td>PALETTE</td>
<td>Alt P</td>
<td>Option P</td>
</tr>
<tr>
<td>PARK</td>
<td>P</td>
<td>P</td>
</tr>
<tr>
<td>PASTE</td>
<td>Ctrl V</td>
<td>Ctrl V</td>
</tr>
<tr>
<td>PAUSE</td>
<td>Ctrl P</td>
<td>Ctrl P</td>
</tr>
<tr>
<td>PLAYBACK</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>PRESET</td>
<td>P</td>
<td>P</td>
</tr>
<tr>
<td>RECORD</td>
<td>R</td>
<td>R</td>
</tr>
<tr>
<td>REFRESH</td>
<td>V</td>
<td>V</td>
</tr>
<tr>
<td>RELEASE</td>
<td>Ctrl R</td>
<td>Ctrl R</td>
</tr>
<tr>
<td>SAVE</td>
<td>Backspace U</td>
<td>Backspace U</td>
</tr>
<tr>
<td>SELECT</td>
<td>Shift</td>
<td>Shift</td>
</tr>
<tr>
<td>SELECT ALL</td>
<td>Ctrl N</td>
<td>Ctrl N</td>
</tr>
<tr>
<td>SEQ</td>
<td>S</td>
<td>S</td>
</tr>
<tr>
<td>SEQ -</td>
<td>X Up arrow</td>
<td>X Up arrow</td>
</tr>
<tr>
<td>SEQ +</td>
<td>X Down arrow</td>
<td>X Down arrow</td>
</tr>
<tr>
<td>SETUP</td>
<td>F11</td>
<td>F11</td>
</tr>
<tr>
<td>START</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>TAB</td>
<td>TAB</td>
<td>TAB</td>
</tr>
<tr>
<td>TEXT</td>
<td>Alt T</td>
<td>Option T</td>
</tr>
<tr>
<td>Console Key</td>
<td>PC Equivalent</td>
<td>Mac Equivalent</td>
</tr>
<tr>
<td>-------------</td>
<td>------------------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>THRU</td>
<td>Ctrl T or Keypad /</td>
<td>Ctrl T or Keypad /</td>
</tr>
<tr>
<td>TIME</td>
<td>T</td>
<td>T</td>
</tr>
<tr>
<td>TRACK</td>
<td>F12</td>
<td>F12</td>
</tr>
<tr>
<td>U1</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>U2</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>U3</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>UPDATE</td>
<td>U</td>
<td>U</td>
</tr>
<tr>
<td>WIZARD</td>
<td>W</td>
<td>W</td>
</tr>
</tbody>
</table>

**Keyboard - Level Wheel**

You can use a mouse wheel (or right click held) to emulate the level wheel for setting levels and navigating. See [Ext. Mouse Or Trackball](#).

**Keyboard - CH Step**

You can hold CTRL and use the left/right arrows to emulate CH+ and CH-.
Accessories - Mouse or Trackball

You can use an external USB mouse or trackball in the same way as the built in trackball. Connect it to the USB port.

Cobalt is designed to be used without a mouse as button pressing is faster and does not force you to look at the screen cursor. However, there are a lot of useful mouse functions for situations where you find it practical. For example, working in a workstation without a console facepanel, or while using an offline editor.

Here is some of the mouse functionality:

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Views: Context Menu</td>
<td>Right click</td>
<td>Opens the context menu</td>
</tr>
<tr>
<td>All Views: Drag and drop</td>
<td>Left click, hold and drag</td>
<td>Drags and drops content</td>
</tr>
<tr>
<td>Channel Views: Select channels</td>
<td>Left click</td>
<td>Selects and deselects channels</td>
</tr>
<tr>
<td>Channel Views: Set channel levels</td>
<td>Mouse wheel</td>
<td>Same as the Level wheel of Cobalt</td>
</tr>
<tr>
<td>Channel Views: Set channel levels</td>
<td>Right click and mouse</td>
<td>Same as the Level wheel of Cobalt</td>
</tr>
<tr>
<td>Browser: Open Browser objects</td>
<td>Left doubleclick</td>
<td>Opens the corresponding editor tab</td>
</tr>
<tr>
<td>Spreadsheet Lists: Select a cell in a list for editing</td>
<td>Left click</td>
<td>Selects the cell for editing</td>
</tr>
<tr>
<td>Spreadsheet Lists: Select a column</td>
<td>Left click on column header</td>
<td>Selects the whole column</td>
</tr>
<tr>
<td>Spreadsheet Lists: Toggle sort order</td>
<td>Double-click on column header</td>
<td>Toggles sort order for the column</td>
</tr>
<tr>
<td>Spreadsheet Lists: Resize column</td>
<td>Left click, hold and drag column header</td>
<td>Resizes column</td>
</tr>
<tr>
<td>Playback views: Open editors.</td>
<td>Right click or double click</td>
<td>Opens the context menu to open the editor. Try doing this on a step, time, device link etc.</td>
</tr>
</tbody>
</table>
Accessories - Remote Control

This system can connect optional remote controls for controlling channels and levels. Note that each remote control has its own working field. Also see Remote Controls.

This chapter contains the following sections

- Remote Control - Introduction
- Remote Control - RFR Radio Remote
- Remote Control - Phone Remote
- Remote Control - iRFR
- Remote Control - cRFRU Radio Remote
Remote Control - Introduction

There are a number of options for remote controlling a Cobalt system.

There are three main kinds of wireless remote controls.

<table>
<thead>
<tr>
<th>RFR</th>
<th>Phone Remote</th>
<th>iRFR</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="RFR Radio/USB" /></td>
<td><img src="image" alt="Phone Remote" /></td>
<td><img src="image" alt="iRFR" /></td>
</tr>
</tbody>
</table>

The RFR Radio/USB Remote is equipped with a display and bi-directional communication.

A wireless phone can be connected to the RJ11 connector in the back and be used for basic remote functions.

iRFR is a software for iPhone and iPod that provides bi-directional communication over a wireless LAN.

NOTE
To clear input from the Remote Fields go to the Clear Remote Fields node in the Remote Controls Node.
See Remote Controls.

Remote Control are enabled in the System Settings for remotes to work.
There is a specific setting to enable recording from the Remotes. Both are ON by default.
See System Settings - System.

Remote Controls and at mode

If your console is set to operate channels in at mode, the remote will also function in at mode. See System Settings - General and Channels - Command Syntax.

HINTS

- 100%/0%/+/-% will now complete pending at mode operations.
- C will abort pending two-digit level entries.
- Decimal point will complete pending at mode operations without pressing @.
Remote Control - RFR Radio Remote

The RFR Radio Remote provides bi-directional remote control with a hardware designed for stage environment. All of the RFR functions are the same for iRFR.

The RFR works within its own field and this field can be cleared from the console. All channel intensity levels generated by the remote can only be recorded into targets from the remote control itself.

Connecting the RFR

It's possible to connect the RFR in the following ways to a Cobalt.

- Directly with USB
- To a base station connected with USB
- To a base station connected with Net3, which requires ACN protocol to be turned on.

Hold the decimal point when starting the RFR to get a choice of connection methods.

Group and frequency can be changed if necessary or if you have multiple units. The HF (frequency) and Network ID (group) are changed in the remote from the remote menu, and in the base station from the system settings. See System Settings - RFR.

RFR - General Functionality

The upper display line shows information about the selected channel(s). The labels for the soft buttons are on the two lower rows of the display. In all displays the wheel controls the level of selected channels - except in the parameter controls display where the two encoders control the displayed two parameters (like pan/tilt, etc...
Top Level
Soft1-6 give direct access to basic channel functionality. Pressing MORE SK will always return to this level. Pressing MORE SK from the Top Level will show the other menus.

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>100%</td>
<td>Check+</td>
</tr>
<tr>
<td>Group</td>
<td>0%</td>
<td>Check-</td>
</tr>
</tbody>
</table>

In all displays, the wheel controls the level of the selected channel(s).

RFR Channel functionality

The most common channel functions can be used to select channels and set levels (At Mode Command Syntax is supported from v5.1). This includes the console shortcut C & CHANNEL to clear all channels in A.

- CH
- +
- -
- THRU
- @LEVEL

RFR Group List

Press MORE SK and then GROUP to get a list of recorded Groups to select from. Use the wheel(s) to focus the item you want and click the wheel button to activate it. # GROUP selects the item directly without showing the list.

Normally the wheel scrolls one step per click. If you hold the wheel button and scroll, it will step in complete pages instead for faster navigation.
Pressing MORE SK will display the other available display pages.

<table>
<thead>
<tr>
<th>Device</th>
<th>Playback</th>
<th>Patch</th>
</tr>
</thead>
<tbody>
<tr>
<td>Palette</td>
<td>Focusing</td>
<td>CalibSer</td>
</tr>
</tbody>
</table>

**RFR Devices**

Press MORE SK and then DEVICE to enter the Device sub menu. When you have selected the Device sub menu, pressing ParamF/ParamC/ParamB will select the parameter pages for the selected devices. Two parameters at a time will be displayed in the middle of the display and controlled by the two wheels. Press a wheel to toggle between coarse and fine for parameters.

<table>
<thead>
<tr>
<th>Last</th>
<th>SelAll</th>
<th>Next</th>
</tr>
</thead>
<tbody>
<tr>
<td>ParamF</td>
<td>ParamC</td>
<td>ParamB</td>
</tr>
</tbody>
</table>

Next, Last and Select All functions are used to step within the current selection, Select All will return to the original selection.

ParamF, ParamC and ParamB keys are used like Focus, Color and Beam keys on the console. These will cycle thru the available parameter pages for the selected device(s). Use the wheels to adjust parameter values. Clicking the wheel will toggle coarse/fine mode on the wheels. Fine mode is indicated with a "." symbol before the parameter value.
RFR Playback

Playback
Press MORE SK and then PLAYBACK to enter the Playback sub menu. The Playback functions are

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go</td>
<td>Go</td>
<td>Next crossfade is started</td>
</tr>
<tr>
<td>GoBack</td>
<td>GoBack</td>
<td>Crossfades back to the previous step</td>
</tr>
<tr>
<td>Goto preset/step</td>
<td># Goto</td>
<td>Crossfades to preset # or step # (depending on the GOTO jumps to setting in Setup)</td>
</tr>
<tr>
<td>Record preset</td>
<td># Record</td>
<td>Records Preset # into the Preset List. Only the levels set from the remote are recorded</td>
</tr>
<tr>
<td>Update preset</td>
<td>Update</td>
<td>The selected preset (indicated as &quot;Prt:#&quot; on the display) is updated with levels from the remote field</td>
</tr>
<tr>
<td>Select Preset and levels</td>
<td># Preset</td>
<td>Levels from Preset # are loaded into the remote field and channels of Preset # are selected</td>
</tr>
<tr>
<td>Select Preset and levels</td>
<td>Preset</td>
<td>Shows a list of Presets. Use encoder to focus a Preset and click the encoder to select Preset and load levels into the remote field.</td>
</tr>
</tbody>
</table>

When recording or updating a preset a confirmation message is shown on the RFR display.

To enable recording/updating from remote, check the setup option "Allow recording from remote"
RFR Patch

Press MORE SK and then PATCH to enter the Patch sub menu.

<table>
<thead>
<tr>
<th>Output Universe</th>
<th>Goto Preset</th>
<th>Patch DvAddr</th>
</tr>
</thead>
</table>

The Patch functions are

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select channel</td>
<td>[#] Chan</td>
<td>Channel # is selected</td>
</tr>
<tr>
<td>Select output</td>
<td>[#] Output</td>
<td>Output # is selected</td>
</tr>
<tr>
<td>Select output universe</td>
<td>[#] Univ</td>
<td>Universe # is selected</td>
</tr>
<tr>
<td>Patch channel to output</td>
<td>[#] Chan [#] Patch</td>
<td>Channel # is patched to output #</td>
</tr>
<tr>
<td>Patch output to channel</td>
<td>[#] Output [#] Patch</td>
<td>Output # is patched to channel #</td>
</tr>
<tr>
<td>Re-patch a device</td>
<td>[#] Chan [#] DvAddr</td>
<td>Device on channel # is patched to output #</td>
</tr>
</tbody>
</table>

- Outputs can be selected in address.universe format. For example [10.3] [Output] will select output 10 on universe 3.
- Use the left wheel to jump to next output and the right wheel to set a level to the selected output.
- Use a number and the @ button to set a channel or output level directly (instead of the right wheel).
- Use +/- to step outputs as well as channels.

RFR Palettes

Press MORE SK and then PALETTE to enter the Palette sub menu.

<table>
<thead>
<tr>
<th>Focus</th>
<th>Color</th>
<th>Beam</th>
</tr>
</thead>
</table>

- The FCB buttons can be pressed without a number to present a palette list or with a number to select a palette directly.
• In the palette list, use one of the wheels to scroll and press the wheel to select the focused palette.
• Entering 0 and selecting a palette type will home the values of this palette type.

RFR Focus Mode

Focus mode is intended for updating palettes, mainly Focus palettes. See Device Palettes - Focusing mode.

Press MORE SK and then FOCUSING to enter focusing mode.

<table>
<thead>
<tr>
<th>Focus</th>
<th>Color</th>
<th>Beam</th>
<th>Update</th>
</tr>
</thead>
</table>

1. Select a palette from the FCB list buttons. This will enter channel/parameter mode.
2. Use Next/Last/SelAll buttons to select channels. Use ParamFCB buttons to select the parameter. Use wheels to change.
3. Press the Mode button to go back to palette select/update screen.
4. Use Update to update the palette or select a new palette with the FCB palette list buttons.
5. Press MORE SK will leave focusing mode.

RFR Scroller Calibration

Press MORE SK and then CALIBSCR to enter Scroller calibration mode. In Scroller Calibration you can calibrate each scroller roll individually, like on the console. Also see Scroller rolls.

1. First, turn on the channels for which you wish to calibrate the scrollers, so you can see when the scroller is in full frame.
2. When pressing CALIBSCR a list of channels with scrollers is shown. Select a channel to calibrate it's scroller.
3. A list of the colors in the scroller is shown on the display. Use the left wheel to focus a color and use the right wheel to adjust the value so that the whole frame is shown. Changes are updated automatically (values are kept within the current frame).
4. Use the MORE SK button to exit Scroller Calibration.
Remote Control - Phone Remote

The Phone Remote option allows you to use a standard phone - without a phone line - to remote control channels and levels.

Connect the base station of a standard wireless phone directly to get a low-level remote control solution. Activate the handset for an internal call (depends on the system how this is done) and use the numeric keypad to control channels and levels directly.

Phone Remote - Functions

The handset has two available commands for each key on the unit. Numbers are accessed directly. The *-key is used as Shift to access the functions. Press the *-key first (do not press and hold) and then press the function. The #-key when pressed once is decimal point and when pressed twice clears the number input.

These are the basic functions you can access from the phone remote.

In the table below # means a numbers input, while [#] equals the key # on the handset.
<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a channel</td>
<td># [SHIFT] CHANNEL</td>
<td>Channel is selected</td>
</tr>
<tr>
<td>Add channels</td>
<td># [SHIFT] THRU</td>
<td>Channels are added to selection</td>
</tr>
<tr>
<td>Select a group</td>
<td># # [SHIFT] CHANNEL</td>
<td>Channels in Group # are selected</td>
</tr>
<tr>
<td>Select All</td>
<td>[SHIFT] ALL</td>
<td>Selects all channels with a level that were set from the remote</td>
</tr>
<tr>
<td>Set to Full</td>
<td>[SHIFT] 100%</td>
<td>Levels for the selected channels are set to full</td>
</tr>
<tr>
<td>Set to 0%</td>
<td>[SHIFT] 0%</td>
<td>Levels for the selected channels are set to zero</td>
</tr>
<tr>
<td>Set to level #</td>
<td># [SHIFT] @LEVEL</td>
<td>Level # is set for selected channels</td>
</tr>
<tr>
<td>Check mode</td>
<td>[SHIFT] CHECK+</td>
<td>Steps to the Next/Last channel using level.</td>
</tr>
<tr>
<td>Load levels from Preset #</td>
<td>[SHIFT] PRESET</td>
<td>Levels from Preset # are loaded</td>
</tr>
<tr>
<td>Clear number input</td>
<td># #</td>
<td>Clears number input</td>
</tr>
<tr>
<td>Decimal point</td>
<td>#</td>
<td>Decimal point</td>
</tr>
<tr>
<td>GO</td>
<td>[SHIFT] Goto/Go</td>
<td>Next crossfade is started</td>
</tr>
<tr>
<td>Goto preset/step</td>
<td># [SHIFT] Goto/Go</td>
<td>Crossfades to preset # or step # (depending on the GOTO jumps to setting in Setup)</td>
</tr>
<tr>
<td>Record preset</td>
<td># [SHIFT] Record</td>
<td>Records Preset # into the Preset List. Only the levels set from the remote are recorded</td>
</tr>
</tbody>
</table>

**Examples**

Turn on channels 2 thru 5 at Full.

```
2 [SHIFT] CHANNEL 5 [SHIFT] THRU [SHIFT] 100%
```

Using the decimal point it is also possible to select and turn on channels recorded in groups.

To set Group 1 at Full
If a console is set to work in At Mode, channel selection functions on the remote behave differently. For example:

Set channels 1 thru 5 to 55%

```
1 # SHIFT CHANNEL SHIFT 100%
```

```
1 SHIFT THRU 5 SHIFT @Level 5 5
```

Set channels 1 thru 6 at full

```
1 SHIFT THRU 6 SHIFT 100%
```

Note: When recording from the remote, only levels set from the remote are recorded, not the whole stage output.

Note: To enable recording from remote, check the setup option "Allow recording from remote"
Remote Control - iRFR

The iRFR Remote option allows you to use an iPhone or an iPod Touch with a wireless network as a remote for Cobalt.

The iRFR works within its own field and this field can be cleared from the console. All channel intensity levels generated by the remote can only be recorded into targets from the remote control itself.

Requirements: iPhone or iPod touch and a wireless network.
More information online:

Using the iRFR

This is how you launch the application. How to set up and configure the network is described below.

At the Welcome screen, select Virtual RFR.
The functionality of iRFR is the same as RFR. See Remote Control RFR Radio Remote.

**Tip 1**
To turn the encoder wheels, simply drag with your finger. To press the encoder wheels, one quick tap will do the trick.

**Tip 2**
Tap the Virtual RFR screen to cycle through different interface layouts. (You can also lock the layout in the Settings screen)

### iRFR Color Picker

With the iRFR Color Picker you can select colors for your color mixing devices. Select the Color Picker button at the top of the Virtual RFR screen to open the Color Picker screen. You can return to the Virtual RFR anytime by pressing the Virtual RFR button in the top left corner.
The current color for the first selected channel is displayed by a small rotating indicator. Press anywhere on the color wheel to change the color, and the indicator will then move to the new color.

**iRFR Settings**

These are the settings you can define in the iRFR.

**Settings**

- **Quick Start**: when this is turned ON, the iRFR skips past the splash screens and attempts to connect to the console automatically. If a connection is made, it goes straight into the Virtual RFR screen.
- **Sounds**: when this is turned ON, you will hear various sound effects (button presses, wheel turns, encoder ticks, etc...)
- **Lock RFR Layout**: when this is turned ON, you cannot cycle through the RFR interface layouts. Instead it remains locked on the chosen layout, and you will see a small padlock icon indicating that the lock is enabled.
- **Sleep Disabled**: when this is turned ON, your iPhone/iPod will not automatically go to sleep after a period of inactivity. (This may decrease battery life)

**Flashlight**

At the Welcome screen, select the Flashlight for some quick light. Tap the screen to reveal 2 sliders which control the hue & brightness of the screen.

**About**

Here you will find a link to the charity's website, a link to the iRFR Wiki, and the version of your iRFR app.

**Network configuration for iRFR**

The iRFR requires that your console be on a wireless network. Below are a couple examples of how you may choose to configure your wireless network. If you are using a wireless router, make sure you connect to the WAN port.
Default Static IP Addresses

<table>
<thead>
<tr>
<th>Cobalt</th>
<th>Congo Jr</th>
<th>Cobalt Light Server</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Address</td>
<td>IP Address</td>
<td>IP Address</td>
</tr>
<tr>
<td>10.101.80.101</td>
<td>10.101.81.101</td>
<td>10.101.82.101</td>
</tr>
<tr>
<td>Subnet Mask</td>
<td>Subnet Mask</td>
<td>Subnet Mask</td>
</tr>
<tr>
<td>255.255.0.0</td>
<td>255.255.0.0</td>
<td>255.255.0.0</td>
</tr>
<tr>
<td>IP Gateway</td>
<td>IP Gateway</td>
<td>IP Gateway</td>
</tr>
<tr>
<td>10.101.80.101</td>
<td>10.101.81.101</td>
<td>10.101.82.101</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>RVI</th>
<th>Wireless Router/AP</th>
<th>iPhone/iPod</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Address</td>
<td>IP Address</td>
<td>IP Address</td>
</tr>
<tr>
<td>Subnet Mask</td>
<td>Subnet Mask</td>
<td>Subnet Mask</td>
</tr>
<tr>
<td>255.255.0.0</td>
<td>255.255.0.0</td>
<td>255.255.0.0</td>
</tr>
<tr>
<td>IP Gateway</td>
<td>IP Gateway</td>
<td>IP Gateway</td>
</tr>
</tbody>
</table>

**iPhone and iPod Configuration**

Once your wireless network is setup, you must configure your iPhone/iPod to connect to it:

1. **On your iPhone/iPod press the Settings icon.**
2. At the Settings screen, select Wi-Fi.

3. At the Wi-Fi Networks screen, find the wireless network your console is on and select it. Once connected, you will see a check mark to the left of the network name. Now press the round blue arrow button to configure your network settings.

4. Now you must configure your iPhone/iPod's network settings so that it can connect to the console. The recommended IP address is as follows for a standard static network configuration.
Testing iRFR network connectivity

Once your iPhone/iPod is configured to be on the same wireless network as your console, here's a quick test to make sure the iRFR and your console can talk.

1. Launch the iRFR app on your iPhone/iPod.

2. At the Welcome screen, click Settings.

3. Fill in the Host field with the IP address of your console (see the tip below if you don't know how to locate your console's IP address).
4. Now, press the magnifying glass to test communication between your iPhone/iPod and the console. You will see either a green checkmark for YES or a red circle with a line through it for NO.

5. If the communication test FAILS, double-check that you have entered the correct IP address of your console in the Host field at the Settings screen. If the test still fails, exit the iPhone/iPod home screen and verify that you are still connected to your console's WiFi network.

You can find the IP address of your console in Browser > About > About Cobalt and in System Settings > Network.
Connecting iRFR to your console

If you have tested your network you are ready to connect to Cobalt.

1. You need to have Remote Controls and ACN enabled in your Cobalt. No other settings or protocols need to be turned on for the iRFR to work.
2. Launch the iRFR app on your iPhone/iPod. At the Welcome screen, select Settings.

3. At the Settings screen, enter your console's IP address in the Host field (this is different for Cobalt, Jr and Light Server, see above). If you do not see a green checkmark after entering the IP, you won't be able to connect. That means you have either entered the wrong IP address or there is a problem with your wireless network configuration. The Password is not used with Cobalt and CobaltJr consoles. Only with Eos/Ion/Element. Leave the Password field blank.
4. Press the Welcome button at the top left to return to the Welcome screen, and then press Connect.

5. Once connected, you will see a that you are connected to a Cobalt, and the version of software it is running. The Virtual RFR menu item will also become available.
Remote Control - cRRFU Radio Remote

All instructions for connecting and operating the older, compatible ETC CRRFU Radio Remote control are packaged and delivered with this unit.

Crrfu Remote Functions

The transmitter has two available commands for each key on the unit.

Direct commands are displayed above each key. To access the commands that are displayed vertically to the left of each key, press the [FUNC] key first (do not press and hold [FUNC]).

An example of mixing direct and [FUNC] commands to record channels 1-5 at 75% into Preset 5 follows:

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select a channel</td>
<td>[#]</td>
<td>Channel is selected</td>
</tr>
<tr>
<td>Add channels</td>
<td>[#] THRU</td>
<td>Channels are added to selection</td>
</tr>
<tr>
<td></td>
<td>[#] FUNC</td>
<td></td>
</tr>
<tr>
<td>Subtract channels</td>
<td>[#] FUNC</td>
<td>Channels are subtracted from selection</td>
</tr>
<tr>
<td></td>
<td>[-]</td>
<td></td>
</tr>
<tr>
<td>Select Group</td>
<td>[#] FUNC</td>
<td>Channels in Group # are selected</td>
</tr>
<tr>
<td></td>
<td>Group</td>
<td></td>
</tr>
<tr>
<td>Select All</td>
<td>FUNC All</td>
<td>Selects all channels with a level that were set from the remote</td>
</tr>
<tr>
<td>Set to Full</td>
<td>FUNC</td>
<td>Levels for the selected channels are set to</td>
</tr>
</tbody>
</table>
### Function | Key | Feedback
--- | --- | ---
Set to 0% | FUNC 0% | Levels for the selected channels are set to zero
Set to level | # @Level | Level # is set for selected channels
Increase/decrease levels | FUNC +% FUNC -% | Levels for the selected channels are changed up/down. Hold the [+%] or [-%] keys to have the channel fade up/down.
Check mode | FUNC | Steps to the next/last channel using the level
| Check+ FUNC Check- | See Check mode (add link to "Channels - Check Mode" chapter)
GO | FUNC Go/Goto | Next crossfade is started
GO Back | FUNC Go Back | Crossfades to the previous step
GOTO a preset/step | # FUNC Go/Goto | Crossfades to preset # or step # (depending on the GOTO jumps to setting in Setup)
Record preset | # FUNC Record | Records Preset # into the Preset List. Only the levels set from the remote are recorded
Update | Update | Updates the preset that was last activated from the remote
Load levels from Preset | # FUNC Preset | Levels from Preset # are loaded into A
Clear number input | C/Alt | Clears numbers input
Clear remote field | FUNC All FUNC 0% | Clears all channels turned on from remote

Using Check mode from channel 1 onward:

1 FUNC 100% then FUNC Check+ then FUNC Check+

### At Mode
If a console is set to work in At Mode, channel selection functions on the remote behave differently. For example:

- Set channels 1 thru 5 to 55%: [1] [THRU] [5] [@Level] [5] [5]
- Set channels 11 thru 14 at full: [11] [THRU] [14] [FUNC] [100%]
Number entry after [@Level] is a two digit entry. If you only enter one number, you can press [C/Alt] to end level entry.

NOTE
When RECORDING only levels from the remote are recorded, not the whole stage output.

Transmitter Setup

The transmitter unit has a slide switch (on/off) and 16 keys for console commands. The unit has a “sleep” feature that helps to conserve battery life when the switch is left in the “on” position. Set the switch to the “off” position to guard against accidental key presses.

The keys of the transmitter unit are illuminated. The keys are brightly lit while keys are pressed and the unit is transmitting. After the key is released, the keys remain dimly lit for a period of time before the unit sleeps. The sleep delay can be programmed at the transmitter unit as described below.

Set the transmitter unit sleep delay

**Step 1:** Move the slide switch to the “off” position.

**Step 2:** Press and hold

- [FUNC] for a 5 second sleep delay.
- [THRU] for a 12 second sleep delay.
- [Ch] for a 25 second sleep delay.
- [@ Level] for no sleep delay (the unit does not turn off).

**Step 3:** While pressing one of the keys above, slide the switch to the “on” position and wait until the keys are blinking (about 5 seconds).

**Step 4:** Release the key you are pressing. The sleep delay time is now programmed to the setting you selected above.

Replacing the transmitter battery

The transmitter unit requires a single 9V alkaline battery (provided) for power. This battery should provide approximately one year of normal usage before requiring replacement. To replace the battery, remove the two M3x4mm screws at the bottom of the unit to access the battery compartment and replace with a 9V alkaline battery. Replace the lid and secure it with the same two screws. Dispose of the old battery as is appropriate in your local area.
Accessories - Connecting Cobalt to a Visualizer

These are the Cobalt Family Console Settings including ETCnomad.

Supported protocols
Cobalt Family consoles can output Net2 (EDMX), Net3 (sACN/E1.31), and ArtNet levels via Ethernet. Computers running Cobalt ETCnomad (PC or Mac) can output Net3 (sACN/E1.31) or ArtNet.

To change settings:
1. Ensure the correct network is enabled in System Settings

2. If your PC has multiple network cards, you will also need to select the correct network card in System Settings. This must match your choice in the visualization software.

3. Enable the correct Output Protocol for your visualizer. If you are using Capture, ensure that sACN is enabled. (Note: ETCnomad does not support Net2 and this choice is not visible on devices running ETCnomad.)
4. The enabled Ethernet protocol(s) and the IP address(es) are shown top-right of the Welcome screen.

Visualization - WYSIWYG

WYSIWYG can receive Net2 (EDMX) levels via ethernet.

In the Options menu of Wysiwyg, select Application Options and then navigate to the ETC Interface tab. Ensure that "Allow EDMX reception" is ticked, and that the ETCNet2 Version is set to V4. Note: You must restart Wysiwyg after making this change. You also must be an Administrator on the computer.
You may need to run an application called NICPicker, which may or may not be packed with Wysiwyg. This application sets which of your network adaptors is used for Net2 traffic. It is available as part of the free download of Network Configuration Editor (NCE) from ETC.

Note: There are ETCNet2 devices in the Device Manager in Wysiwyg, but these do not function. Allow EDMX reception as shown above to see EDMX levels.

WYWISYG Link: You can send the patch in WYSIWYT to Cobalt. Make sure you have imported the templates involved first. Clear patch clears the dimmer patch as well as the device patch.

Visualization - Capture

Capture can receive many protocols including Net2 (EDMX) and Net3 (sACN/E1.31) levels via ethernet. Capture Polar and Capture Argo receive "ratified" sACN/E1.31.

In the Tools menu of Capture, select Options. Navigate to the Connectivity tab, and select your network interface card if required. Note that depending upon your PC's configuration, a setting of Automatic may not work; in this case select the appropriate adapter.
In Capture Argo, each protocol can have its own IP address selection. Be sure to set the proper IP address for each of the protocols that you are using.

A valid network link is required to receive sACN, even if the source is another application on the same PC. This means a standalone PC will require either an active connection to an ethernet switch or the "Loopback Adapter" to be installed.

Following a restart, open your existing project or start a new one.

In the Project Window, you will see a tab showing Universes. You should see both BSR E1.31 and ETCNet2 Universes, assuming you have any dimmers patched on your console.
Capture executable (presentation) files should also receive these network levels. Note that you may need to install the Capture application in order to use its network adaptor selection tools.

**Example - getting started**

1. Start Capture and open the demo play Sketching.

2. Open the demo play Sketching in Cobalt.

**NOTE**
There is a plug-in for Training Projects powered by Capture. See Media - Training Projects.

Capture can be downloaded from www.capturesweden.com

**Visualisation - Other Visualizers**

Any visualizer that can receive the supported network protocols listed above should be compatible. The visualizer program that you choose may also support receiving DMX via a DMX-USB converter, though computers running Eos ETCnomad or Cobalt ETCnomad will only transmit DMX via an ETC Gadget DMX-USB interface.

Consult your visualizer's documentation for supported receiving devices.
Accessories - Cobalt ETCnomad - Server & Client

Using the same graphic displays as the Cobalt console, the Cobalt ETCnomad software provides an operating environment identical to the console itself. With a complete set of alphanumeric-keyboard shortcuts for commonly used commands, Cobalt ETCnomad can be used to view console data or to interact with your Cobalt console. See Network - Client.

Cobalt ETCnomad software can be run on a PC with the Windows® XP or Windows® 7 operating system. A dongle is required to connect to the Cobalt console over an Ethernet network. When not connected to the network, or without the dongle attached, the system can be used as a Cobalt Offline Editor workstation or as a live server/backup.

We recommend the use of X-keys. See X-keys.
Using ETCnomad Puck

When you launch ETCnomad Puck software for the first time, you will need to choose between two console operating modes: Eos and Cobalt. Your computer will remember your selection for all subsequent launches. When choosing the Eos family mode, you will subsequently need to select either the Eos or Element console platform.

Changing console operating modes

From Cobalt to Eos

- From the Cobalt login screen, select {System Settings}. The “System Settings” dialog will display.
- Locate and select the {Switch to Eos} button from within the “System settings” dialog. “Enable Eos Mode” will display along with a new screen display.
- Click the green check mark in the bottom right hand corner of the screen to commit to the change or click the red X to cancel the operation. When you have committed to the change, the ETCnomad Puck will reboot to the newly selected operating mode.

From Eos to Cobalt

- From the Eos Configuration Utility start up screen, select {Settings}. System settings dialog displays.
- Select the {Maintenance} button from the options on the right side of the dialog. A complete list of maintenance options will display.
- Locate and select the {Switch to Cobalt Client} button from within the maintenance dialog. The Cobalt logo will display in a new dialog and you will be requested to confirm whether you would like to “Enable Cobalt Mode”.
- Click the green check mark in the bottom right hand corner of the dialog to commit to the change or click the red X to cancel the operation. When you have committed to the change, the ETCnomad Puck will reboot to the newly selected operating mode.
Accessories - Cobalt Programming Wings

The Cobalt Programming Wing provides a portable base allowing you to travel with a physical control surface to supplement a ETCnomad Puck or PC/Mac-based system.

The Programming Wing has the same programming layout as the Cobalt 10 face panels, so users can transition without altering workflows or hunting for keys. Each wing contains playback and fader controls, parameter encoders and level and rate controls, along with DMX512-A/RDM and MIDI In/Out outputs, a Contact Closure Trigger, and Litlllite connectors.

Wings are VESA-mountable for temporary or permanent installation backstage, in a rack or on a tech table. It measures approximately 50cm x 36cm and weighs 4.3kg.

Motorized Fader Wing

The Motorized Fader Wing has the same layout as the Cobalt 10 and 20. A single Motorized Fader Wing can be used as a playback surface with with ETCnomad systems running under MacOSX or Window 7, 8 and 10. The Motorized Fader Wing can also be used with Cobalt Remote Video (RVI and RVI3) and Cobalt Light Server hardware. The wing provides power sensing and automatically turns on when both an active USB data connection and mains power are provided via the external 12V power supply.
Any Cobalt system will support up to 80 Master Playbacks.

**Examples**
Cobalt 10 has 20 Master Playbacks, you can add an additional 60 Master Playbacks in any combination of wings.
Cobalt 20 has 40 Master Playbacks, you can add an additional 40 Master Playbacks in any combination of wings.
With Congo jr and ETCnomad you can add an additional 80 Master Playbacks in any combination of wings.

**Order of connection and SWAP**
When using SWAP with connected wings, each wing will swap in the order it was connected to the system. This order can be determined by the daisy chain order when wings are connected one to the next. The console swaps first, then the first connected wing, then the wing next in line, and so on. If wings are connected to a hub and then connected to a console, the wings will swap in their enumerated order. This order can be determined by the masters numbering on startup of the system.
Accessories - Net3 Remote Video Interface

The Remote Video Interface – a 2U 19” rack mount device - provides remote video and local programming functions for Cobalt and Cobalt jr. control systems.

Controls on the front of the unit include the power switch, USB port and 20 buttons for commonly used functions. These buttons have default mapping – specific to the Cobalt product line, reflecting commonly used features for the designer or assistant designer.

The RVI also supports a dual video output for two DVI/SVGA high-resolution monitors.

An alpha-numeric keyboard and/or pointing devices can be connected to the RVI to provide remote programming capability using the Cobalt keyboard shortcuts. X-Keys can also be attached via USB.

See X-Keys.
Accessories - X-keys

ETC recommends the use of PI Engineering's X-Keys® panel with Cobalt Client software. X-Keys is a panel of user-definable keys.

We have provided a file that defines the X-Keys Professional 58-key panel with the Cobalt hotkey shortcuts most used in offline programming and editing. The X-Keys Professional 58-key panel is very similar to the layout of the Cobalt keypad, so frequently used functions appear in relative positions between the actual console and the offline editor.

See www.etcconnect.com/Cobalt for more details.
Facepanel - Cobalt LS

The Cobalt Light Server’s 19”-design packs the identical features, channel and output counts as the Cobalt console into a stand-alone, rack-mountable enclosure suitable for permanently installed applications. Running Cobalt’s operating software, the Cobalt Light Server is a fully independent lighting playback controller or a convenient back-up option. There are twenty keys with a shift function in the front panel that make it possible to run a lot of functions. An external mouse is supplied and recommended.

Button functions - unshifted

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ch</td>
<td>Thru</td>
<td>All</td>
<td>+</td>
<td>@</td>
<td>Output</td>
<td>Master</td>
<td>Point</td>
<td>C</td>
<td>Shift</td>
</tr>
</tbody>
</table>

Button functions - shifted

<table>
<thead>
<tr>
<th>Esc</th>
<th>Up</th>
<th>Modify</th>
<th>Insert</th>
<th>Live</th>
<th>Format</th>
<th>Tab</th>
<th>Browser</th>
<th>Macro</th>
<th>Load</th>
<th>Play</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left</td>
<td>Down</td>
<td>Right</td>
<td>Delete</td>
<td>Goto</td>
<td>GO</td>
<td>Pause</td>
<td>Go Back</td>
<td>Record</td>
<td>Shift</td>
<td></td>
</tr>
</tbody>
</table>
APPENDIX

The Appendix contains information about control interfaces, fuses, key shortcuts etc.

This chapter contains the following sections

- Connectors
- MIDI
Connectors

These are the connectors in the back of the console.

This chapter contains the following sections

- Connector - DMX512
- Connector - DVI/sVGA Monitor
- Connector - Phone remote
- Connector - MIDI
- Connector - External Trig 1-9
- Connector - Ethernet
- Connector - Keyboard, Printer & Mouse
- Connector - Desk Light

Connector - DMX512

There are two DMX512A/RDM ports

Pin 1 Gnd
Pin 2 Data-
Pin 3 Data+

<table>
<thead>
<tr>
<th>DMX512 pinout for five-pin XLR female</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
</tbody>
</table>

Connector - DVI/sVGA Monitor

These connectors support DVI/sVGA external displays (1280x1024 minimum resolution) with optional single or multi-touch screen control.
Connector - Phone Remote

Pin 4 Data+
Pin 5 Data -

The Remote Control Setting must be turned on for the remote to work. See Settings - System.

Connector - MIDI

MIDI in/out (MIDI timecode, MIDI notes, MIDI Show Control (MSC). (MIDI timecode, MIDI Show Control through Net3 Gateway, SMPTE timecode through Net3 Gateway).

MIDI In

Pin 4 Data +
Pin 5 Data -

MIDI Out, Thru

Pin 2 Gnd
Pin 4 Data +
Pin 5 Data -

<table>
<thead>
<tr>
<th>MIDI pinout for Din 5-pin female</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
<tr>
<td>5</td>
</tr>
</tbody>
</table>
**Connector - External Trig 1-9**

The external trig can be used for any console function by assigning appropriate Triggers in Event Lists.

The external trig also allows the following functions directly.

1: Go  
2: Pause  
3: Go Back  
4: Toggles Master 40 On/Off.

The Remote Control Setting must be turned on for the remote to work. See Settings - System.

**Connector - Ethernet**

Two individually configurable Ethernet ports, 802.3af compliant PoE. Transmitting ETCNet2™, Net3™ (powered by ACN), sACN and ArtNet output protocols

- Pin 1 TX+  
- Pin 2 TX-  
- Pin 3 RX+  
- Pin 4 NC  
- Pin 5 NC  
- Pin 6 RX-  
- Pin 7 NC  
- Pin 8 NC
Connector - USB Multipurpose

There are 11 USB multipurpose ports for keyboard and mouse. They are located in the drawer of Cobalt20, in the back and on the front panel, under the power switch.

Connector - Desk Light

You can connect a standard desk light to the connectors in the top corners of Cobalt.

Pinout for Littlite XLR 3-pin female

<table>
<thead>
<tr>
<th>Pin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Chassis ground</td>
</tr>
<tr>
<td>2</td>
<td>Dimming leg</td>
</tr>
<tr>
<td>3</td>
<td>+12 Vdc</td>
</tr>
</tbody>
</table>

Connect the lamp between pins 2 and 3.
MIDI allows you to interface with Time Code and other MIDI equipment.

This chapter contains the following sections

- MIDI - Introduction
- MIDI - Standard MIDI
- MIDI - MIDI Show Control
- MIDI - Time Code
- MIDI - Implementation Chart
**MIDI - Introduction**

MIDI stands for Musical Instrument Digital Interface. The reason you can find it in a lighting console is that MIDI today is being used for a lot more than having synthesizers to speak to each other as was intended originally.

Basically MIDI is a standard for transmitting notes 0—127 (on/off) with velocity (how hard they are played) and continuous controllers such as faders (volume for example). There are more parameters but these are the basic ones. In Cobalt all keys correspond to a note and all faders to a controller.

MIDI is transmitted serially in up to 16 individual MIDI channels in one three-lead cable. The communication is unidirectional, which means there is no feedback or intelligent bi-directional contact between MIDI units (DMX512 is also unidirectional, while a pair of walkie talkies (for example) are bi-directional, allowing communication both ways).

There is support for three sorts of MIDI.

**Standard MIDI**
Send and receive Notes, Controllers and Program Change.

**MIDI Show Control**
A standard set of commands is supported.

**MIDI Time Code**
Trig Sequence Steps by time code. There is a Learn Mode.

Once you have connected a MIDI Device to the Cobalt with the MIDI connectors in the back of the console, you have to set up the console to receive and/or transmit MIDI, and define which MIDI commands it will recognize.

There is a MIDI Setup where you can configure how the console will function with MIDI. See [System Settings - MIDI](#).
MIDI - Standard MIDI

All MIDI functions need to be activated in the MIDI Setup. See System Settings - MIDI.

MIDI NOTES & CONTROLLERS
All keys and faders can send notes and controllers when this is activated in the MIDI Settings. You can use MIDI notes and controllers to remote control any key or fader of the Console. If you connect a MIDI Sequencer you can record all key presses and fader movements in real time and play back in real time.

PROGRAM CHANGE
The Cobalt can be set to activate a specific crossfade when receiving a Program Change command through MIDI. When the Program Change parameter (in MIDI Settings) is set to "On" the board will activate a crossfade to step 0-127 when receiving Program Change 0-127.

NOTE
You have to have a Sequence Step recorded in the board to be able to jump to it.

You have to send both ON and OFF for notes.
MIDI - MIDI Show Control

Cobalt supports sending and receiving of MIDI Show Control (MSC) commands. GO and Pause/Resume are commands that Cobalt sends when MIDI Show Control is enabled in the setup. GO, Stop, Resume and Set commands can be sent to Cobalt from other devices to control playback actions.

Enable MSC and Device ID settings
In the Show Control setup there are parameters for turning MSC on/off and setting the device ID. See Play Settings - Show Control.

When MSC is enabled Cobalt both sends and can receive MSC commands. Device IDs 00-7E (0-126 in decimal) are for individual receivers and Device ID 7F (127 in decimal) is meant for all receivers. The default setting for Device ID is 1 (01 in hexadecimal).

Cobalt supports reception of the following MSC commands. All example command strings are shown in hexadecimal values.

GO
Executes the next crossfade in the same way as pressing GO in the console. If GO is pressed in the console, the number of the Preset is automatically transmitted as well. This is sent automatically when GO is pressed and MSC is active.

Preset numbers in the GO command are encoded using ASCII and 2E is the decimal point. For example preset 10 equals 31 30.

GO (Main Playback):
F0 7F 01 02 01 01 F7

GOTO preset 105:
F0 7F 01 02 01 01 31 30 35 F7

GOTO preset 86.4:
F0 7F 01 02 01 01 38 36 2E 34 F7

NOTE
MSC GO commands in Cobalt support only one decimal number. Presets with more then one decimal number will not send an MSC GO command and these presets cannot be triggered with MSC from other sources.

STOP
Pauses the current crossfade. This is sent automatically when PAUSE is pressed and MSC is active.

Stop/Pause (Main Playback):
F0 7F 01 02 01 02 F7

RESUME
Resumes the current crossfade. This is sent automatically when PAUSE is pressed after PAUSE and MSC is active.
Resume (Main Playback):
F0 7F 01 02 01 03 F7

**SET**
The SET command allows setting Cobalt's faders to specific levels. An MSC SET command packet looks like this:

```
F0 7F <id> 02 01 06 <cc> <cc> <vv> <vv> F7
```

<table>
<thead>
<tr>
<th>SysEx YYYY</th>
<th>Device ID-------/</th>
</tr>
</thead>
<tbody>
<tr>
<td>Packet type is MSC---/</td>
<td></td>
</tr>
<tr>
<td>Command format----/-</td>
<td></td>
</tr>
<tr>
<td>SET command---------/-</td>
<td></td>
</tr>
<tr>
<td>Controller number (14-bit value)-/</td>
<td></td>
</tr>
<tr>
<td>Level value (14-bit value)--------------/-</td>
<td></td>
</tr>
<tr>
<td>End of system exclusive flag ---------------/-</td>
<td></td>
</tr>
</tbody>
</table>

Where `<cc>` `<cc>` defines the Controller number and `<vv>` `<vv>` defines the level. These are both 14-bit values, a combination of two 7-bit values. Both in `<cc> `<cc>` and `<vv>` `<vv>` the first value is the LSB and the second value is the MSB. For `<vv>` `<vv>` fader values Cobalt uses the most significant 8-bits of the 14-bit value for the level, giving a resolution of 256 steps.

Some examples of how percent value convert to `<vv>` `<vv>` values in Cobalt:

<table>
<thead>
<tr>
<th>Percent Level</th>
<th><code>&lt;vv&gt;</code> <code>&lt;vv&gt;</code> Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>0%</td>
<td>00 00</td>
</tr>
<tr>
<td>10%</td>
<td>00 0D</td>
</tr>
<tr>
<td>20%</td>
<td>7F 19</td>
</tr>
<tr>
<td>30%</td>
<td>7F 26</td>
</tr>
<tr>
<td>40%</td>
<td>00 33</td>
</tr>
<tr>
<td>50%</td>
<td>00 40</td>
</tr>
<tr>
<td>60%</td>
<td>7F 4C</td>
</tr>
<tr>
<td>70%</td>
<td>7F 59</td>
</tr>
<tr>
<td>80%</td>
<td>00 66</td>
</tr>
<tr>
<td>90%</td>
<td>00 73</td>
</tr>
<tr>
<td>100%</td>
<td>7F 7F</td>
</tr>
</tbody>
</table>
The `<cc>` Controller numbers used in Cobalt are:

<table>
<thead>
<tr>
<th>Fader</th>
<th><code>&lt;cc&gt;</code> Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master 1</td>
<td>00 00</td>
</tr>
<tr>
<td>Master 2</td>
<td>01 00</td>
</tr>
<tr>
<td>Master 3</td>
<td>02 00</td>
</tr>
<tr>
<td>...</td>
<td></td>
</tr>
<tr>
<td>Master 39</td>
<td>26 00</td>
</tr>
<tr>
<td>Master 40</td>
<td>27 00</td>
</tr>
<tr>
<td>Grandmaster</td>
<td>7E 03</td>
</tr>
</tbody>
</table>

**Examples**

Master 1 at 100%
F0 7F 01 02 01 06 00 00 7F 7F F7

Master 20 at 50%
F0 7F 01 02 01 06 13 00 00 40 F7

Master 33 at 0%
F0 7F 01 02 01 06 20 00 00 00 F7

Grandmaster at 20%
F0 7F 01 02 01 06 7E 03 7F 19 F7

**NOTE**
For more info about MIDI, MSC and other Show Control commands a good book to have is Control Systems for Live Entertainment by John Huntington (ISBN: 978-0-240-80937-3)
MIDI - Time Code

Every sequence step can be triggered both manually, and by a specific MIDI Time Code time on the MIDI port.

In the Sequence Editor, this time can be set or edited in a column to the far right. It is possible to enter a time code timestamp for each sequence step. When the specific time code position is reached, the sequence step will be executed providing Time Code is set to on. See System Settings - MIDI.

- Time Code is edited from the keyboard (display or external) in all Cobalt consoles. In the bigger Cobalt it can be edited from the numerical console keypad as well.
- If there is MIDI Time Code coming into the system, the running time will be shown on top of the monitor instead of the normal date and time.

Manual and Time Code trig
You can combine sequence steps with Time Code times with normal manual or automatic crossfade. The Time Code time is just an additional trigger that can activate a sequence step. If there is a problem with the MIDI Time Code input, you can always start the crossfade by pressing GO.

Time Code On/Off
There is an overall parameter "Read MIDI Time Code" that switches on or off time code in general. See System Settings - MIDI.

Time Code Format
Time code must be entered in this format: hh:mm:ss:ff.

Time code is shown in the Playback view like this
Learn mode
Each time GO is pressed, the current time code timestamp will be recorded in the current sequence step. See System Settings - MIDI.

Trig in B or Auto Mode
Normally, only Sequence steps that are in the B field will be triggered by incoming MIDI Time Code. Other Steps will not be trigged, even if the times match.

It is also possible to run the system so that any Sequence Step matching a specific Time Code time is run automatically regardless if it is in the B field or not. If the "Auto-locate step" parameter is set to "On", any step that is matching the incoming MIDI Time Code will be executed. See System Settings - MIDI.

Edit time code in the sequence list
When you press MODIFY in the Time Code column, you will be presented with a Time Code Editor. In this editor you can Set, Add and Subtract time code values. All sequence steps that are selected before you open the Time Code Editor will be affected by the change. Also see Sequences - Sequence List.

It is possible to enter timecode in a short form format. Entered digits will be assigned from right-to-left to frames, seconds, minutes and hours. Leading 0’s can be omitted. Example: 123 would be 00.00.01.23.
**MIDI - Implementation Chart**

All MIDI messages described below can be sent or received on any MIDI Channel between 1 and 16.

The values shown in parenthesis (like this = 144) all refer to MIDI channel 1. To be able to use other MIDI channels, you have to add the channel number and subtract 1.

*Example*
NOTE ON on channel 4 = 144 + 4 — 1 = 147.

**Keys**
All keys are transmitted as Note On and Note Off messages.

When a key is pressed, the following MIDI Message will be transmitted:
NOTE ON (=144), Key number, 64

When a key is released, the following MIDI Message will be transmitted:
NOTE OFF (=128), Key number, 64

By sending the corresponding command to the MIDI In port, the Cobalt will execute the key.

Since standard MIDI Notes only can accept a maximum of 127 individual notes and the Cobalt uses far more buttons than that, a special coding had to be introduced for the buttons above 127.

In the table below, these are shown as x, y. The first value is used as the note number and the second value is used for the velocity.

*Example*
Sending the Align key would look like this:
144, 125, 98 (key pressed) followed by 128, 125, 98 (key released).

**Console Keys - MIDI Chart**

<table>
<thead>
<tr>
<th>Key</th>
<th>MIDI Code (Hex)</th>
<th>MIDI Code (Dec)</th>
</tr>
</thead>
<tbody>
<tr>
<td>-%</td>
<td>3C</td>
<td>60</td>
</tr>
<tr>
<td>[]</td>
<td>75</td>
<td>117</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>+%</td>
<td>3D</td>
<td>61</td>
</tr>
<tr>
<td>&lt;------</td>
<td>7D, 21</td>
<td>125, 33</td>
</tr>
<tr>
<td>&lt;&lt;</td>
<td>7E, 5C</td>
<td>126, 92</td>
</tr>
<tr>
<td>&gt;</td>
<td>73</td>
<td>115</td>
</tr>
<tr>
<td>Key</td>
<td>MIDI Code (Hex)</td>
<td>MIDI Code (Dec)</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>&gt;&gt;</td>
<td>7E, 5D</td>
<td>126, 93</td>
</tr>
<tr>
<td>0</td>
<td>01</td>
<td>1</td>
</tr>
<tr>
<td>1</td>
<td>02</td>
<td>2</td>
</tr>
<tr>
<td>2</td>
<td>03</td>
<td>3</td>
</tr>
<tr>
<td>3</td>
<td>04</td>
<td>4</td>
</tr>
<tr>
<td>4</td>
<td>05</td>
<td>5</td>
</tr>
<tr>
<td>5</td>
<td>06</td>
<td>6</td>
</tr>
<tr>
<td>6</td>
<td>07</td>
<td>7</td>
</tr>
<tr>
<td>7</td>
<td>08</td>
<td>8</td>
</tr>
<tr>
<td>8</td>
<td>09</td>
<td>9</td>
</tr>
<tr>
<td>9</td>
<td>0A</td>
<td>10</td>
</tr>
<tr>
<td>A</td>
<td>0B</td>
<td>11</td>
</tr>
<tr>
<td>Align</td>
<td>7D, 62</td>
<td>125, 98</td>
</tr>
<tr>
<td>All</td>
<td>0C</td>
<td>12</td>
</tr>
<tr>
<td>AtLevel</td>
<td>22</td>
<td>34</td>
</tr>
<tr>
<td>Attrib</td>
<td>7D, 27</td>
<td>125, 39</td>
</tr>
<tr>
<td>B</td>
<td>23</td>
<td>35</td>
</tr>
<tr>
<td>Bank</td>
<td>7E, 41</td>
<td>126, 65</td>
</tr>
<tr>
<td>Beam</td>
<td>7D, 1C</td>
<td>125, 28</td>
</tr>
<tr>
<td>Blind</td>
<td>7E, 62</td>
<td>126, 98</td>
</tr>
<tr>
<td>Browser</td>
<td>7E, 71</td>
<td>126, 113</td>
</tr>
<tr>
<td>C</td>
<td>24</td>
<td>36</td>
</tr>
<tr>
<td>Capture</td>
<td>7D, 65</td>
<td>125, 101</td>
</tr>
<tr>
<td>Ch</td>
<td>25</td>
<td>37</td>
</tr>
<tr>
<td>Ch—</td>
<td>26</td>
<td>38</td>
</tr>
<tr>
<td>Ch+</td>
<td>27</td>
<td>39</td>
</tr>
<tr>
<td>Color</td>
<td>7D, 1B</td>
<td>125, 27</td>
</tr>
<tr>
<td>Column</td>
<td>7E, 53</td>
<td>126, 83</td>
</tr>
<tr>
<td>Connect</td>
<td>7E, 55</td>
<td>126, 85</td>
</tr>
<tr>
<td>Copy/Cut</td>
<td>7D, 5A</td>
<td>125, 90</td>
</tr>
<tr>
<td>DecimalPoint</td>
<td>3E</td>
<td>125, 90</td>
</tr>
<tr>
<td>Delay</td>
<td>7D, 22</td>
<td>125, 34</td>
</tr>
<tr>
<td>Delete</td>
<td>51</td>
<td>81</td>
</tr>
<tr>
<td>Key</td>
<td>MIDI Code (Hex)</td>
<td>MIDI Code (Dec)</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Device</td>
<td>7D, 26</td>
<td>125, 38</td>
</tr>
<tr>
<td>Direct Select 1</td>
<td>7D, 6D</td>
<td>125, 109</td>
</tr>
<tr>
<td>Direct Select 40</td>
<td>7E, 1C</td>
<td>126, 28</td>
</tr>
<tr>
<td>Direct Select page 1</td>
<td>7E, 6B</td>
<td>126, 107</td>
</tr>
<tr>
<td>Direct Select page 5</td>
<td>7E, 6F</td>
<td>126, 111</td>
</tr>
<tr>
<td>Down</td>
<td>4D</td>
<td>77</td>
</tr>
<tr>
<td>Esc</td>
<td>2C</td>
<td>44</td>
</tr>
<tr>
<td>Fan</td>
<td>7D, 0A</td>
<td>125, 10</td>
</tr>
<tr>
<td>Fetch</td>
<td>2F</td>
<td>47</td>
</tr>
<tr>
<td>Flash 1</td>
<td>7E, 2D</td>
<td>126, 45</td>
</tr>
<tr>
<td>Flash 20</td>
<td>7E, 40</td>
<td>126, 64</td>
</tr>
<tr>
<td>FlashMode</td>
<td>30</td>
<td>48</td>
</tr>
<tr>
<td>Focus</td>
<td>7D, 1A</td>
<td>125, 26</td>
</tr>
<tr>
<td>Format</td>
<td>7E, 61</td>
<td>126, 97</td>
</tr>
<tr>
<td>GO</td>
<td>31</td>
<td>49</td>
</tr>
<tr>
<td>GoBack</td>
<td>32</td>
<td>50</td>
</tr>
<tr>
<td>Goto</td>
<td>33</td>
<td>51</td>
</tr>
<tr>
<td>Group</td>
<td>7E, 56</td>
<td>126, 86</td>
</tr>
<tr>
<td>Help</td>
<td>34</td>
<td>52</td>
</tr>
<tr>
<td>Highlight</td>
<td>7D, 34</td>
<td>125, 52</td>
</tr>
<tr>
<td>In</td>
<td>7D, 46</td>
<td>125, 70</td>
</tr>
<tr>
<td>Independent 1</td>
<td>7E, 63</td>
<td>126, 99</td>
</tr>
<tr>
<td>Independent 2</td>
<td>7E, 64</td>
<td>126, 100</td>
</tr>
<tr>
<td>Independent 3</td>
<td>7E, 65</td>
<td>126, 101</td>
</tr>
<tr>
<td>Insert</td>
<td>50</td>
<td>80</td>
</tr>
<tr>
<td>Inv Group</td>
<td>7D, 66</td>
<td>125, 102</td>
</tr>
<tr>
<td>Last</td>
<td>7D, 2A</td>
<td>125, 42</td>
</tr>
<tr>
<td>Left</td>
<td>4E</td>
<td>78</td>
</tr>
<tr>
<td>Live</td>
<td>7E, 5E</td>
<td>126, 94</td>
</tr>
<tr>
<td>Load</td>
<td>7E, 74</td>
<td>126, 116</td>
</tr>
<tr>
<td>Macro</td>
<td>35</td>
<td>53</td>
</tr>
<tr>
<td>Mask</td>
<td>7D, 28</td>
<td>125, 40</td>
</tr>
<tr>
<td>Master</td>
<td>7D, 2B</td>
<td>125, 43</td>
</tr>
<tr>
<td>Key</td>
<td>MIDI Code (Hex)</td>
<td>MIDI Code (Dec)</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Master Page- (lower)</td>
<td>7D, 5D</td>
<td>125, 93</td>
</tr>
<tr>
<td>Master Page (upper)</td>
<td>7E, 1D</td>
<td>126, 29</td>
</tr>
<tr>
<td>Master Page- (upper)</td>
<td>7D, 5F</td>
<td>125, 95</td>
</tr>
<tr>
<td>Master Page+ (lower)</td>
<td>7D, 5C</td>
<td>125, 92</td>
</tr>
<tr>
<td>Master Page+ (upper)</td>
<td>7D, 5E</td>
<td>125, 94</td>
</tr>
<tr>
<td>MasterKey1</td>
<td>0E</td>
<td>14</td>
</tr>
<tr>
<td>MasterKey20</td>
<td>21</td>
<td>33</td>
</tr>
<tr>
<td>MasterKey21</td>
<td>56</td>
<td>86</td>
</tr>
<tr>
<td>MasterKey40</td>
<td>69</td>
<td>105</td>
</tr>
<tr>
<td>MasterPage</td>
<td>36</td>
<td>54</td>
</tr>
<tr>
<td>Modify</td>
<td>37</td>
<td>55</td>
</tr>
<tr>
<td>Mute</td>
<td>7E, 47</td>
<td>126, 71</td>
</tr>
<tr>
<td>Next</td>
<td>7D, 29</td>
<td>125, 41</td>
</tr>
<tr>
<td>Note</td>
<td>7E, 45</td>
<td>126, 69</td>
</tr>
<tr>
<td>Out</td>
<td>7D, 45</td>
<td>125, 69</td>
</tr>
<tr>
<td>Output</td>
<td>38</td>
<td>56</td>
</tr>
<tr>
<td>Palette</td>
<td>7D, 23</td>
<td>125, 35</td>
</tr>
<tr>
<td>Park</td>
<td>7E, 46</td>
<td>126, 70</td>
</tr>
<tr>
<td>Paste</td>
<td>7D, 5B</td>
<td>125, 91</td>
</tr>
<tr>
<td>Pause</td>
<td>3B</td>
<td>59</td>
</tr>
<tr>
<td>Playback</td>
<td>6D</td>
<td>109</td>
</tr>
<tr>
<td>Preset</td>
<td>3F</td>
<td>63</td>
</tr>
<tr>
<td>Record</td>
<td>40</td>
<td>64</td>
</tr>
<tr>
<td>Refresh</td>
<td>7D, 33</td>
<td>125, 51</td>
</tr>
<tr>
<td>Release</td>
<td>7E, 70</td>
<td>126, 112</td>
</tr>
<tr>
<td>Rem Dim</td>
<td>7E, 52</td>
<td>126, 82</td>
</tr>
<tr>
<td>Right</td>
<td>4F</td>
<td>79</td>
</tr>
<tr>
<td>Select</td>
<td>7E, 58</td>
<td>126, 88</td>
</tr>
<tr>
<td>Select All</td>
<td>7D, 30</td>
<td>125, 48</td>
</tr>
<tr>
<td>Seq</td>
<td>44</td>
<td>68</td>
</tr>
<tr>
<td>Seq-</td>
<td>6B</td>
<td>107</td>
</tr>
<tr>
<td>Seq+</td>
<td>6C</td>
<td>108</td>
</tr>
<tr>
<td>Setup</td>
<td>46</td>
<td>70</td>
</tr>
<tr>
<td>Key</td>
<td>MIDI Code (Hex)</td>
<td>MIDI Code (Dec)</td>
</tr>
<tr>
<td>-------</td>
<td>----------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Solo</td>
<td>7E, 48</td>
<td>126, 72</td>
</tr>
<tr>
<td>Start</td>
<td>45</td>
<td>69</td>
</tr>
<tr>
<td>Tab</td>
<td>7E, 5F</td>
<td>126, 95</td>
</tr>
<tr>
<td>Tap</td>
<td>7E, 54</td>
<td>126, 84</td>
</tr>
<tr>
<td>Text</td>
<td>7D, 64</td>
<td>125, 100</td>
</tr>
<tr>
<td>Thru</td>
<td>47</td>
<td>71</td>
</tr>
<tr>
<td>Time</td>
<td>48</td>
<td>72</td>
</tr>
<tr>
<td>Track</td>
<td>7D, 63</td>
<td>125, 99</td>
</tr>
<tr>
<td>Type</td>
<td>7E, 42</td>
<td>126, 66</td>
</tr>
<tr>
<td>U1</td>
<td>7D, 1D</td>
<td>125, 29</td>
</tr>
<tr>
<td>U2</td>
<td>7D, 1E</td>
<td>125, 30</td>
</tr>
<tr>
<td>U3</td>
<td>7D, 1F</td>
<td>125, 31</td>
</tr>
<tr>
<td>Up</td>
<td>4C</td>
<td>76</td>
</tr>
<tr>
<td>Update</td>
<td>7E, 4F</td>
<td>126, 79</td>
</tr>
<tr>
<td>Wizard</td>
<td>7D, 32</td>
<td>125, 50</td>
</tr>
</tbody>
</table>

**Console Faders - MIDI Chart**

<table>
<thead>
<tr>
<th>Fader</th>
<th>MIDI Code (Hex)</th>
<th>MIDI Code (Dec)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lower_1</td>
<td>41</td>
<td>65</td>
</tr>
<tr>
<td>Lower_2</td>
<td>42</td>
<td>66</td>
</tr>
<tr>
<td>Lower_3</td>
<td>43</td>
<td>67</td>
</tr>
<tr>
<td>Lower_4</td>
<td>44</td>
<td>68</td>
</tr>
<tr>
<td>Lower_5</td>
<td>45</td>
<td>69</td>
</tr>
<tr>
<td>Lower_6</td>
<td>46</td>
<td>70</td>
</tr>
<tr>
<td>Lower_7</td>
<td>47</td>
<td>71</td>
</tr>
<tr>
<td>Lower_8</td>
<td>48</td>
<td>72</td>
</tr>
<tr>
<td>Lower_9</td>
<td>49</td>
<td>73</td>
</tr>
<tr>
<td>Lower_10</td>
<td>4A</td>
<td>74</td>
</tr>
<tr>
<td>Lower_11</td>
<td>4B</td>
<td>75</td>
</tr>
<tr>
<td>Lower_12</td>
<td>4C</td>
<td>76</td>
</tr>
<tr>
<td>Lower_13</td>
<td>4D</td>
<td>77</td>
</tr>
<tr>
<td>Fader</td>
<td>MIDI Code (Hex)</td>
<td>MIDI Code (Dec)</td>
</tr>
<tr>
<td>------------</td>
<td>----------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Lower_14</td>
<td>4E</td>
<td>78</td>
</tr>
<tr>
<td>Lower_15</td>
<td>4F</td>
<td>79</td>
</tr>
<tr>
<td>Lower_16</td>
<td>50</td>
<td>80</td>
</tr>
<tr>
<td>Lower_17</td>
<td>51</td>
<td>81</td>
</tr>
<tr>
<td>Lower_18</td>
<td>52</td>
<td>82</td>
</tr>
<tr>
<td>Lower_19</td>
<td>53</td>
<td>83</td>
</tr>
<tr>
<td>Lower_20</td>
<td>54</td>
<td>84</td>
</tr>
<tr>
<td>Upper_1</td>
<td>55</td>
<td>85</td>
</tr>
<tr>
<td>Upper_2</td>
<td>56</td>
<td>86</td>
</tr>
<tr>
<td>Upper_3</td>
<td>57</td>
<td>87</td>
</tr>
<tr>
<td>Upper_4</td>
<td>58</td>
<td>88</td>
</tr>
<tr>
<td>Upper_5</td>
<td>59</td>
<td>89</td>
</tr>
<tr>
<td>Upper_6</td>
<td>5A</td>
<td>90</td>
</tr>
<tr>
<td>Upper_7</td>
<td>5B</td>
<td>91</td>
</tr>
<tr>
<td>Upper_8</td>
<td>5C</td>
<td>92</td>
</tr>
<tr>
<td>Upper_9</td>
<td>5D</td>
<td>93</td>
</tr>
<tr>
<td>Upper_10</td>
<td>5E</td>
<td>94</td>
</tr>
<tr>
<td>Upper_11</td>
<td>5F</td>
<td>95</td>
</tr>
<tr>
<td>Upper_12</td>
<td>60</td>
<td>96</td>
</tr>
<tr>
<td>Upper_13</td>
<td>61</td>
<td>97</td>
</tr>
<tr>
<td>Upper_14</td>
<td>62</td>
<td>98</td>
</tr>
<tr>
<td>Upper_15</td>
<td>63</td>
<td>99</td>
</tr>
<tr>
<td>Upper_16</td>
<td>64</td>
<td>100</td>
</tr>
<tr>
<td>Upper_17</td>
<td>65</td>
<td>101</td>
</tr>
<tr>
<td>Upper_18</td>
<td>66</td>
<td>102</td>
</tr>
<tr>
<td>Upper_19</td>
<td>67</td>
<td>103</td>
</tr>
<tr>
<td>Upper_20</td>
<td>68</td>
<td>104</td>
</tr>
<tr>
<td>AFader</td>
<td>69</td>
<td>105</td>
</tr>
<tr>
<td>BFader</td>
<td>6A</td>
<td>106</td>
</tr>
<tr>
<td>GrandMaster</td>
<td>6C</td>
<td>108</td>
</tr>
</tbody>
</table>
RDM Functionality

The idea of RDM (Remote Device Management) is to make it possible for devices in a control network to communicate with the lighting control system. It can be used to simplify patching, addressing, and controlling modes of a device or supervising temperature via embedded sensors (when provided).

There is a setting in Console Settings where you can disable "RDM Discovery" - Browser >General Settings >Console Settings.

Cobalt is one of the world's most advanced RDM controllers of today.

ABOUT RDM
DMX communicates levels to devices. RDM adds communication back from the devices to allow us to remotely observe (sensors) control (setups) and configure (modes) these devices. The level of RDM functionality depends on the features of the controller and on the features of the device. It is possible that some devices do not support all the features available in Cobalt, or that Cobalt does not yet support all the RDM features of a device. RDM data is sent back over the DMX line.

"It's not in the right mode, it doesn't have the right address, and you don't have to bring out the ladder...."

PINS USED
The DMX512 specification requires DMX connectors to be a 5-pin XLR type, with only the first 3 pins being used (pins 4 and 5 were reserved for "future use"). RDM uses the same pins as DMX (pins 2 and 3) to make it possible for all manufacturers to implement it.
**RDM Patching**

These are the basics of working with RDM and Cobalt. These steps assume you have RDM functioning, you have hung and cabled all of your devices, and that this is the first time you are working with the system:

1. The outputs of the Net3 ACN DMX/RDM Gateway must have RDM Discovery enabled to allow Cobalt to communicate with connected RDM devices. Please consult the Net3 ACN DMX/RDM Gateway User Manual for directions on enabling and disabling RDM Discovery. Remember that only equipment with RDM will talk back to Cobalt.

2. As soon as an RDM device is discovered on the network this will be indicated at the top of the monitors, with a red "RDM:" and a number. The number indicates the quantity of discovered new devices on the network. A new device is one that has not yet been patched in the current show file. (Note: if you have already patched all of your RDM devices, you will not see the number again (when restarting or reopening this show file). Only unpatched devices are indicated here.

3. SEE LIST: Open the RDM Device List (Browser>Patching>RDM Device List), where you can see all discovered devices and their current addresses and settings. They are still not patched to congo - only discovered. You now have to actively make some decisions about to which Cobalt channel you want to patch them, and with which template. See the RDM Device List section below.
4. IDENTIFY: Press MODIFY in the Identify cell to tell the light to "identify itself". Depending on the type of device, this may mean the light flashes on and off, or the LCD display may flash its backlight. Consult the user manual of the device to see how the device will identify itself using RDM.

5. PATCH: In the "Patched to channel" column, enter a channel number of Cobalt and press MODIFY. You will get a dialogue that will show if the device is known and will match a template in Cobalt, or if you wish to force a basic template from the data the device can provide over RDM. At most times you will find that the template is known and matched in the extended library of Cobalt. The advantage of using the known template is that it (usually) contains additional information, like text names for ranges and color calibration data for use with the Color Picker and Gel Picker. If it doesn't work the way you want you always have the option of creating a template manually.

RDM Indicators

RDM information about mismatches, communication, discovered devices and feedback is shown at the top of all screens. It will blink during RDM communication.

Shows unpatched devices on top "RDM: #"

Error messages will show as a triangle with a number

Mismatch errors will show as "MISMATCH". Mismatch errors include patched settings not matching device settings, patch overlaps, and so on.
RDM Device List

The RDM Device List is the main RDM Window. This is a standard list of purely standard RDM information. It is the same for all devices.

This list allows you to identify devices, change basic settings of the device (like start address, personality or mode) patch to Cobalt channels and access deeper settings of devices, if that functionality is supported by those devices.

This list also shows conflict or mismatch states in red. In the case of overlapping device addresses, you must solve these overlaps manually by choosing and entering new starting addresses for those fixtures. RDM will send the new address setting to the fixture for you.
Note that in the Browser there is a command to "Clear offline RDM", use this command to clean up the list if you have removed devices, or moved devices from port to port on the Gateway.

The information displayed is the standard information within the RDM Specification:

MANUFACTURER:
MODEL:
LABEL:
DMX PERSONALITY: This displays the actual device setting and will match to a template in Cobalt
DMX FOOTPRINT: The number of outputs needed

PARAMETERS: This is the number of settings within the device that can be displayed or edited using RDM. This is not the same as the DMX controllable parameters (attributes) of the device.

SENSORS: Device Sensors

SUB DEVICES: If the device has more devices associated with it, for example, you have one RDM-capable dimmer rack that contains 6 individual dimmers, the rack settings would be found under Parameters and individual dimmer settings would be seen in the Sub Devices tab.

SOFTWARE LABEL: Text from the device manufacturer

**RDM Device List Cache**

Normally RDM cache is something you don't have to worry about. In some rare situations you may want to force a re-query.

There is a column that shows cache status. The Cache contains stored information discovered about a device over RDM and this indicator shows if Cobalt has cached data about a fixture so Cobalt no longer needs to query about the device structure.

Press MODIFY in this cell to re-query or store the cache (see options below)

![RDM Device List Cache](image)

**Options (press MODIFY to activate)**
"Querying device structure..."
- This is a status that a query is going on

"Device structure available. Save to cache?"
- There is a structure, you can save it to cache manually (it is done at shutdown automatically). It will be loaded at the next restart of Cobalt.

"Using cached device structure. Delete cache?"
- Will delete the cached structure, and allow a re-query. It will be done at the next restart of Cobalt.

"Restart to use cache"
- The cache is now stored and at the next restart Cobalt will start using it automatically.

"Restart to re-query"
- At the next restart of Cobalt, a new query will be performed.

RDM Device Parameter List

The Device Parameter List provides access to the settings of each device that can be seen and controlled over RDM. This list is only available when there are discovered RDM devices. It is opened from the RDM Device List by pressing MODIFY in the Parameter cell of the device you wish to adjust. Note that regardless of which device you use to open this tab, it will show all devices of that model in the same table.

All data in this tab is generated by the RDM device and is then displayed by Cobalt. Parameters you can edit are shown in white text. Changes you make in this tab are sent directly to the device and are not stored in any way by Cobalt. The valid data for a parameter is wholly dependent on the way the device manufacturer has developed their RDM functionality. Valid input may be numerical (type the new value and press MODIFY) or may be entered using a drop down menu (usually shown in text). Consult the user manual for the device to understand the impact of changing parameters in this tab.
RDM Device Sensor List

The Device Sensor List provides access to the sensor information an RDM Device transmits (read-only). This list is only available when there are discovered RDM devices. It is opened from the RDM Device List by pressing MODIFY in the Sensors cell of the device whose sensor data you wish to view. Regardless of which device you use to open this tab, it will show all devices of that model in the same table.
OSC Functionality

Open Sound Control (OSC) is a content format for messaging among computers, sound synthesizers, and other multimedia devices. You can remotely control Cobalt using OSC. You can remotely control OSC devices using Cobalt.

OSC is often used as an alternative to MIDI, when higher performance, higher resolution and a richer parameter space is desired. OSC messages are commonly transported across networks using (UDP/IP, Ethernet). OSC messages between gestural controllers such as the Wii Remote are usually transmitted over serial endpoints of USB by being wrapped in the SLIP protocol. OSC gives developers more flexibility in the kinds of data they can send over the wire, enabling new applications that can communicate with each other at a high level (Source Wikipedia).

To explore more about OSC on the www see http://opensoundcontrol.org/introduction-osc.

**EXAMPLE**

- Use OSC to create a remote interface for Cobalt, for example in an iPad, using a standard third party OSC software such as TouchOSC.
- Use third party developer software such as Max or Isadora to integrate Cobalt with other OSC devices.

See also Receive - OSC Input and Transmit - OSC Output.

**NOTE**
Be aware that for OSC to work you need to activate OSC control and relevant settings in the Play Settings.
See Play Settings - Show Control.

**NOTE**
OSC is not intended to be used as remote control for Cobalt over any open Internet connection. ETC recommends strongly that lighting networks remain separate from the Internet.

**Receive - OSC Input**

To receive OSC commands you have to activate reception of OSC and select the appropriate Port number (default 7000) in Play Settings - Show Control.

The device transmitting OSC needs both this port number and the IP address of your Cobalt system. You can check your IP address in Browser >About >About Cobalt.

**About OSC commands**
OSC is primarily used to press and release keys, move faders and adjust parameters.

An OSC command consists of two parts:
1. A command Path. This starts with a "/" and looks similar to a URL web address that you would type into your browser. Eg: /cobalt/param/pan/wheel

2. Zero or more Values. (Sometimes called Parameters or Arguments) Some OSC commands have optional values, while others require one, two or even more values. These are shown in angle brackets, with the range if applicable: Eg: <palette 1-999>

**How do I use it?**

OSC apps have various different ways to specify the OSC Path and the OSC Value (where needed) Be sure to check the manual for your OSC app to see how to type in the Path and the Values.

In many OSC applications, the values may be specified as a range. For example, an OSC fader will need a Minimum and a Maximum value. If you are having trouble, check with whether you've entered the Path and the Value(s) for the command correctly for the software you are using.

**TouchOSC:**

TouchOSC always sends at least one value, set by the Value Range.

For example, the console [Go] button:

All Cobalt OSC commands also support the additional press (1.0)/release (0.0) value syntax used by TouchOSC buttons. To convert the normal OSC command into this format, move the Values into the Path and use Value Range 0.0-1.0.

Example TouchOSC Buttons:

- To send the OSC Command "/cobalt/playback/goto" with the value 3: "/cobalt/playback/goto/3" with Value Range 0.0-1.0
- To send the OSC Command "/cobalt/chan/at" with the value 75: "/cobalt/chan/at/75" with Value Range 0.0-1.0
- To send the OSC Command "/cobalt/directselect" with the values 1, 2, 1: "/cobalt/directselect/1/2/1" with Value Range 0.0-1.0

Example TouchOSC Fader:

- To send the OSC Command "/cobalt/chan/at" with the values 0-100: "/cobalt/chan/at" with Value Range 0.0-100.0

This is what a GO key will look like in TouchOSC:
QLab:
OSC Commands are entered as a Custom OSC Message of single text string of both the Path and the Values (called Arguments in QLab). Values in a QLab custom OSC message are separated by spaces.

Example QLab Custom OSC Messages:

- To send the OSC Command "/cobalt/playback/3/level" with the value 0.5: /cobalt/playback/3/level 0.5
- To send the OSC Command "/cobalt/param/panTilt" with Pan value 0.5, Tilt value 0.75: /cobalt/param/panTilt 0.5 0.75

In the tables below, the example column shows this command syntax.

**NOTE (7.3)**
New OSC commands from 7.3 and forward starting with "/cobalt...", added below. The old commands are still supported.

**OSC Commands**

Remember that OSC commands may be input differently in different softwares such as TouchOSC, Max or Q-Lab, but the principles are the same - there is a path with one or more values, usually expressed as numbers.

**Refresh**
A command to force an update of all labels and fader values

<table>
<thead>
<tr>
<th>OSC path</th>
<th>Value</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>/refreshstatus</td>
<td></td>
<td>/refreshstatus</td>
</tr>
</tbody>
</table>

**Channels**

<table>
<thead>
<tr>
<th>OSC Path</th>
<th>Value</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>/cobalt/chan/select</td>
<td>&lt;channel #&gt;</td>
<td>/cobalt/chan/select 1</td>
</tr>
<tr>
<td>/cobalt/chan/add</td>
<td>&lt;channel #&gt;</td>
<td>/cobalt/chan/add 2</td>
</tr>
<tr>
<td>/cobalt/chan/subtract</td>
<td>&lt;channel #&gt;</td>
<td>/cobalt/chan/subtract 3</td>
</tr>
<tr>
<td>/cobalt/chan/thru</td>
<td>&lt;channel #&gt;</td>
<td>/cobalt/chan/thru 5</td>
</tr>
<tr>
<td>/cobalt/chan/at</td>
<td>&lt;level 0-100&gt;</td>
<td>/cobalt/chan/at 75</td>
</tr>
<tr>
<td>/cobalt/chan/wheel</td>
<td>&lt;increment&gt;</td>
<td>/cobalt/chan/wheel -2</td>
</tr>
<tr>
<td></td>
<td></td>
<td><em>Wheel down by 2 ticks</em></td>
</tr>
</tbody>
</table>
### Groups

<table>
<thead>
<tr>
<th>OSC Path</th>
<th>Value</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>/cobalt/group/</td>
<td>&lt;group #&gt;</td>
<td>/cobalt/group 3</td>
</tr>
</tbody>
</table>

### Masters

"x" is the Master number

<table>
<thead>
<tr>
<th>OSC Path</th>
<th>Value</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>/cobalt/playback/x/level</td>
<td>&lt;level 0.0-1.0&gt;</td>
<td>/cobalt/playback/2/level 0.50</td>
</tr>
<tr>
<td>/cobalt/playback/x/go</td>
<td></td>
<td>/cobalt/playback/3/go</td>
</tr>
<tr>
<td>/cobalt/playback/x/goto</td>
<td>&lt;preset or cue ####.####&gt;</td>
<td>cobalt/playback/2/goto 3</td>
</tr>
<tr>
<td>/cobalt/playback/x/jumpto</td>
<td>&lt;preset or cue ####.####&gt;</td>
<td>cobalt/playback/2/jumpto 4.1</td>
</tr>
<tr>
<td>/cobalt/playbacks/changePage</td>
<td>&lt;bank 1-4&gt;</td>
<td>/cobalt/playbacks/changePage 2 1 Master Bank 2, up one page</td>
</tr>
<tr>
<td>/cobalt/playbacks/selectPage</td>
<td>&lt;bank 1-4&gt;</td>
<td>/cobalt/playbacks/selectPage 1 5 Master Bank 1, select page 5</td>
</tr>
</tbody>
</table>

### Main Playback

<table>
<thead>
<tr>
<th>OSC Path</th>
<th>Value</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>cobalt/playback/go</td>
<td></td>
<td>cobalt/playback/go</td>
</tr>
<tr>
<td>cobalt/playback/pause</td>
<td></td>
<td>cobalt/playback/pause</td>
</tr>
<tr>
<td>cobalt/playback/goback</td>
<td></td>
<td>cobalt/playback/goback</td>
</tr>
<tr>
<td>cobalt/playback/goto</td>
<td>&lt;preset or cue ####.####&gt;</td>
<td>cobalt/playback/goto 3</td>
</tr>
<tr>
<td>cobalt/playback/jumpto</td>
<td>&lt;preset or cue ####.####&gt;</td>
<td>cobalt/playback/jumpto 4.1</td>
</tr>
</tbody>
</table>

### Beat Boss

"x" is the Beat Boss number

<table>
<thead>
<tr>
<th>OSC Path</th>
<th>Value</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>/cobalt/beatboss/x/bpm</td>
<td>&lt;beat-per-minute&gt;</td>
<td>/cobalt/beatboss/3/bpm 120</td>
</tr>
<tr>
<td>/cobalt/beatboss/x/bpm/wheel</td>
<td>&lt;increment&gt;</td>
<td>/cobalt/beatboss/1/bpm/wheel 1</td>
</tr>
<tr>
<td>/cobalt/beatboss/x/tap</td>
<td></td>
<td>/cobalt/beatboss/2/tap</td>
</tr>
</tbody>
</table>
Parameter and color control

<table>
<thead>
<tr>
<th>OSC Path</th>
<th>Value</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>/cobalt/param/panTilt</td>
<td>&lt;pan 0-255&gt;</td>
<td>/cobalt/param/panTilt 127 255</td>
</tr>
<tr>
<td></td>
<td>&lt;tilt 0-255&gt;</td>
<td></td>
</tr>
<tr>
<td>/cobalt/param/pan/wheel</td>
<td>&lt;increment&gt;</td>
<td>/cobalt/param/pan/wheel 1</td>
</tr>
<tr>
<td>/cobalt/param/tilt/wheel</td>
<td>&lt;increment&gt;</td>
<td>/cobalt/param/tilt/wheel 1</td>
</tr>
<tr>
<td>/cobalt/color/hs</td>
<td>&lt;hue 0-360&gt;</td>
<td>/cobalt/color/hs 120 100</td>
</tr>
<tr>
<td></td>
<td>&lt;sat 0-100&gt;</td>
<td></td>
</tr>
<tr>
<td>/cobalt/color/rgb</td>
<td>&lt;red 0-100&gt;</td>
<td>/cobalt/color/rgb 30 22 45</td>
</tr>
<tr>
<td></td>
<td>&lt;green 0-100&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;blue 0-100&gt;</td>
<td></td>
</tr>
</tbody>
</table>

Palettes
All palette commands can have an added press/release value (press = 1, release = 0)

<table>
<thead>
<tr>
<th>OSC Path</th>
<th>Value</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>/cobalt/focuspalette</td>
<td>&lt;palette 1-999&gt;</td>
<td>/cobalt/focuspalette 9</td>
</tr>
<tr>
<td>/cobalt/colorpalette</td>
<td>&lt;palette 1-999&gt;</td>
<td>/cobalt/colorpalette 11</td>
</tr>
<tr>
<td>/cobalt/beampalette</td>
<td>&lt;palette 1-999&gt;</td>
<td>/cobalt/beampalette 6</td>
</tr>
<tr>
<td>/cobalt/allpalette</td>
<td>&lt;palette 1-999&gt;</td>
<td>/cobalt/allpalette 7</td>
</tr>
</tbody>
</table>

Independents
"x" is the Independents number

<table>
<thead>
<tr>
<th>OSC Path</th>
<th>Value</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>/independents/fader/x</td>
<td>&lt;level 0.0-1.0&gt;</td>
<td>/independents/fader/1 0.5</td>
</tr>
<tr>
<td>Independents 1-6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>/independents/key/x</td>
<td>&lt;level 0/1&gt;</td>
<td>/independents/key/7 1</td>
</tr>
<tr>
<td>Independents 7-9</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Direct Selects

<table>
<thead>
<tr>
<th>OSC Path</th>
<th>Value</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>/cobalt/directselect</td>
<td>&lt;page 1-5&gt;</td>
<td>/cobalt/directselect 1 2 1</td>
</tr>
<tr>
<td></td>
<td>&lt;block 1-4&gt;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;item 1-100&gt;</td>
<td></td>
</tr>
</tbody>
</table>
**Action Macro**

<table>
<thead>
<tr>
<th>OSC Path</th>
<th>Value</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>/cobalt/actionmacro</td>
<td>&lt;Action Macro string&gt;</td>
<td>/cobalt/actionmacro &quot;GO PB&quot;</td>
</tr>
</tbody>
</table>

If your OSC application uses space-separated values, make sure that the whole Action Macro is sent as one string parameter. In most cases this means using "" around the Action macro string.

**Console Keys**

All key commands have an optional value for press (1) and release (0). No value means a normal press-and-release in a single command.

"x" is the key name, see table below

<table>
<thead>
<tr>
<th>OSC Path</th>
<th>Value</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>/cobalt/key/x</td>
<td>&lt;press/release 1/0&gt;</td>
<td>/cobalt/key/go 1</td>
</tr>
<tr>
<td>/cobalt/key/x</td>
<td>/cobalt/key/go</td>
<td></td>
</tr>
</tbody>
</table>

**Console Key Names**

<table>
<thead>
<tr>
<th>Key names</th>
<th>Key names</th>
<th>Key names</th>
</tr>
</thead>
<tbody>
<tr>
<td>@Level</td>
<td>Dynamics</td>
<td>Master32</td>
</tr>
<tr>
<td>+</td>
<td>Effect</td>
<td>Master33</td>
</tr>
<tr>
<td>-</td>
<td>EffectOverview</td>
<td>Master34</td>
</tr>
<tr>
<td>+%</td>
<td>Enable</td>
<td>Master35</td>
</tr>
<tr>
<td>-%</td>
<td>End</td>
<td>Master36</td>
</tr>
<tr>
<td>.</td>
<td>Esc</td>
<td>Master37</td>
</tr>
<tr>
<td>0</td>
<td>ExternalClockenable</td>
<td>Master38</td>
</tr>
<tr>
<td>1</td>
<td>FaderMode</td>
<td>Master39</td>
</tr>
<tr>
<td>2</td>
<td>Faders</td>
<td>Master40</td>
</tr>
<tr>
<td>3</td>
<td>Fan</td>
<td>ModifySeq</td>
</tr>
<tr>
<td>4</td>
<td>Fetch</td>
<td>Modify</td>
</tr>
<tr>
<td>5</td>
<td>FFMasterPB</td>
<td>Mute</td>
</tr>
<tr>
<td>6</td>
<td>FlashMode</td>
<td>Next</td>
</tr>
<tr>
<td>7</td>
<td>FocusFocusingmode</td>
<td>Note</td>
</tr>
<tr>
<td>8</td>
<td>Format</td>
<td>Off</td>
</tr>
<tr>
<td>9</td>
<td>Full</td>
<td>Organizer</td>
</tr>
<tr>
<td>A</td>
<td>GelPicker</td>
<td>Out</td>
</tr>
<tr>
<td>Align</td>
<td>GO</td>
<td>Output</td>
</tr>
<tr>
<td>All</td>
<td>GOMasterPB</td>
<td>Page</td>
</tr>
<tr>
<td>Attrib</td>
<td>GoBack</td>
<td>PageDown</td>
</tr>
<tr>
<td>AutoLocatestep</td>
<td>GoBackMasterPB</td>
<td>PageUp</td>
</tr>
<tr>
<td>B</td>
<td>Goto</td>
<td>Palette</td>
</tr>
<tr>
<td>BackupClockenable</td>
<td>Group</td>
<td>Park</td>
</tr>
<tr>
<td>Balance</td>
<td>GroupWheelMode</td>
<td>Paste</td>
</tr>
<tr>
<td>Beam</td>
<td>GroupsPalettesOverview</td>
<td>Pause</td>
</tr>
<tr>
<td>Blind</td>
<td>Help</td>
<td>PauseMasterPB</td>
</tr>
<tr>
<td><strong>Key names</strong></td>
<td><strong>Key names</strong></td>
<td><strong>Key names</strong></td>
</tr>
<tr>
<td>--------------</td>
<td>--------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Browser</td>
<td>Highlight</td>
<td>PlaybackPlaylist</td>
</tr>
<tr>
<td>BuildSeq</td>
<td>HomeAttrib.</td>
<td>Preset</td>
</tr>
<tr>
<td>C</td>
<td>Home</td>
<td>RangeRate</td>
</tr>
<tr>
<td>Capture</td>
<td>Id</td>
<td>Record</td>
</tr>
<tr>
<td>ChDelay</td>
<td>In</td>
<td>Refresh</td>
</tr>
<tr>
<td>Ch'Time</td>
<td>Independent7</td>
<td>Release</td>
</tr>
<tr>
<td>Ch</td>
<td>Independent8</td>
<td>RemDim</td>
</tr>
<tr>
<td>ChannelSet</td>
<td>Independent9</td>
<td>RemoteCtrls</td>
</tr>
<tr>
<td>Chase</td>
<td>Insert</td>
<td>ResetInternalClock</td>
</tr>
<tr>
<td>ClearChanged</td>
<td>InternalClockenable</td>
<td>RewMasterPB</td>
</tr>
<tr>
<td>ClearRemotes</td>
<td>InternalClockStartStop</td>
<td>Right</td>
</tr>
<tr>
<td>Client</td>
<td>InvertGroup</td>
<td>Scale</td>
</tr>
<tr>
<td>Color</td>
<td>JumptoB</td>
<td>Select2nd</td>
</tr>
<tr>
<td>Column</td>
<td>LampOff</td>
<td>Select3rd</td>
</tr>
<tr>
<td>Compare</td>
<td>LampOn</td>
<td>SelectAll</td>
</tr>
<tr>
<td>Connect</td>
<td>LampReset</td>
<td>SelectNth</td>
</tr>
<tr>
<td>Copy</td>
<td>Last</td>
<td>SelectRandom</td>
</tr>
<tr>
<td>Cut</td>
<td>Layout1</td>
<td>Seq</td>
</tr>
<tr>
<td>Data</td>
<td>Layout2</td>
<td>Seq-</td>
</tr>
<tr>
<td>Delay</td>
<td>Layout3</td>
<td>Seq+</td>
</tr>
<tr>
<td>DelayIn</td>
<td>Layout4</td>
<td>Series</td>
</tr>
<tr>
<td>DelayOut</td>
<td>Layout5</td>
<td>Setup</td>
</tr>
<tr>
<td>Delete</td>
<td>Layout6</td>
<td></td>
</tr>
<tr>
<td>Device</td>
<td>LearnAlert</td>
<td></td>
</tr>
<tr>
<td>DirectSelectBank</td>
<td>LearnMacro</td>
<td>SoftL1</td>
</tr>
<tr>
<td>DirectSelectPage1</td>
<td>LearnProfile</td>
<td>SoftL2</td>
</tr>
<tr>
<td>DirectSelectPage2</td>
<td>Left</td>
<td>SoftL3</td>
</tr>
<tr>
<td>DirectSelectPage3</td>
<td>Live</td>
<td>SoftR1</td>
</tr>
<tr>
<td>DirectSelectPage4</td>
<td>Load</td>
<td>SoftR2</td>
</tr>
<tr>
<td>DirectSelectPage5</td>
<td>LocalMenu</td>
<td>SoftR3</td>
</tr>
<tr>
<td>DirectSelectType</td>
<td>Lock</td>
<td>SoftmenuChannel</td>
</tr>
<tr>
<td>DirectSelect1</td>
<td>Macro</td>
<td>SoftmenuControl</td>
</tr>
<tr>
<td>DirectSelect2</td>
<td>Mark</td>
<td>SoftmenuDevices</td>
</tr>
<tr>
<td>DirectSelect3</td>
<td>Mask</td>
<td>SoftmenuDynamics</td>
</tr>
<tr>
<td>DirectSelect4</td>
<td>MasterMode</td>
<td>SoftmenuEffect</td>
</tr>
<tr>
<td>DirectSelect5</td>
<td>MasterPage</td>
<td>SoftmenuFocusMode</td>
</tr>
<tr>
<td>DirectSelect6</td>
<td>MasterPage-</td>
<td>SoftmenuLearn</td>
</tr>
<tr>
<td>DirectSelect7</td>
<td>MasterPage+</td>
<td>SoftmenuMasters</td>
</tr>
<tr>
<td>DirectSelect8</td>
<td>MasterPageupper</td>
<td>SoftmenuMisc</td>
</tr>
<tr>
<td>DirectSelect9</td>
<td>MasterPage-upper</td>
<td>SoftmenuSelects</td>
</tr>
<tr>
<td>DirectSelect10</td>
<td>MasterPage+upper</td>
<td>SoftmenuTimes</td>
</tr>
<tr>
<td>DirectSelect11</td>
<td>Master</td>
<td>Solo</td>
</tr>
<tr>
<td>DirectSelect12</td>
<td>Master1</td>
<td>Start</td>
</tr>
<tr>
<td>DirectSelect13</td>
<td>Master2</td>
<td>Startupper</td>
</tr>
<tr>
<td>DirectSelect14</td>
<td>Master3</td>
<td>Swap</td>
</tr>
<tr>
<td>DirectSelect15</td>
<td>Master4</td>
<td>Tab</td>
</tr>
<tr>
<td>DirectSelect16</td>
<td>Master5</td>
<td>Tap</td>
</tr>
<tr>
<td>DirectSelect17</td>
<td>Master6</td>
<td>Text</td>
</tr>
<tr>
<td>DirectSelect18</td>
<td>Master7</td>
<td>Thru</td>
</tr>
<tr>
<td>DirectSelect19</td>
<td>Master8</td>
<td>Time</td>
</tr>
<tr>
<td>DirectSelect20</td>
<td>Master9</td>
<td>TimecodeLearnmode</td>
</tr>
<tr>
<td>DirectSelect21</td>
<td>Master10</td>
<td>TrackballDisplaymode</td>
</tr>
<tr>
<td>Key names</td>
<td>Key names</td>
<td>Key names</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>DirectSelect22</td>
<td>Master11</td>
<td>TrackballLeft</td>
</tr>
<tr>
<td>DirectSelect23</td>
<td>Master12</td>
<td>TrackballMousemode</td>
</tr>
<tr>
<td>DirectSelect24</td>
<td>Master13</td>
<td>TrackballParametermode</td>
</tr>
<tr>
<td>DirectSelect25</td>
<td>Master14</td>
<td>TrackballRight</td>
</tr>
<tr>
<td>DirectSelect26</td>
<td>Master15</td>
<td>Tracklist</td>
</tr>
<tr>
<td>DirectSelect27</td>
<td>Master16</td>
<td>U1</td>
</tr>
<tr>
<td>DirectSelect28</td>
<td>Master17</td>
<td>U2</td>
</tr>
<tr>
<td>DirectSelect29</td>
<td>Master18</td>
<td>U3</td>
</tr>
<tr>
<td>DirectSelect30</td>
<td>Master19</td>
<td>Unpark</td>
</tr>
<tr>
<td>DirectSelect31</td>
<td>Master20</td>
<td>Up</td>
</tr>
<tr>
<td>DirectSelect32</td>
<td>Master21</td>
<td>UpdatePalette</td>
</tr>
<tr>
<td>DirectSelect33</td>
<td>Master22</td>
<td>Update</td>
</tr>
<tr>
<td>DirectSelect34</td>
<td>Master23</td>
<td>Wait</td>
</tr>
<tr>
<td>DirectSelect35</td>
<td>Master24</td>
<td>Wheel1</td>
</tr>
<tr>
<td>DirectSelect36</td>
<td>Master25</td>
<td>Wheel2</td>
</tr>
<tr>
<td>DirectSelect37</td>
<td>Master26</td>
<td>Wheel3</td>
</tr>
<tr>
<td>DirectSelect38</td>
<td>Master27</td>
<td>Wheel4</td>
</tr>
<tr>
<td>DirectSelect39</td>
<td>Master28</td>
<td>Wizard</td>
</tr>
<tr>
<td>DirectSelect40</td>
<td>Master29</td>
<td></td>
</tr>
<tr>
<td>Distance</td>
<td>Master30</td>
<td></td>
</tr>
<tr>
<td>Down</td>
<td>Master31</td>
<td></td>
</tr>
</tbody>
</table>

**Older (7.2 and earlier) OSC Commands:**

**Masters**
- /masters/fader/1-80 <0.0-1.0>
- /masters/key/1-80 <0.0-1.0>
- /masters/flash/1-80 <0.0-1.0>
- /masters/pagePlus/1-4 = Page+ for master block (1-4)
- /masters/pageMinus/1-4 = Page- for master block (1-4)
- /masters/page/1-999 = Master page (1-999)

**Main Playback**
- /mainplayback/go
- /mainplayback/pause
- /mainplayback/goback
- /mainplayback/seq+
- /mainplayback/seq-
- /mainplayback/refresh

**Effect Tap/Rate**
- /effects/bpm/X
- /effects/tap/X

**Parameter Controls**
- /parameter/pan <0.0-1.0>
- /parameter/tilt <0.0-1.0>
- /parameter/hue <0.0-1.0>
- /parameter/saturation <0.0-1.0>
/parameter/intensity <0.0-1.0>
/parameter/pantilt <0.0-1.0> <0.0-1.0>
/parameter/huesaturation <0.0-1.0> <0.0-1.0>

**Direct Selects**
Only supported on older Congo hardware (not recommended)
/directselects/page/X, X = 1-5
/directselects/key/X, X = 1-40

**Transmit - OSC Output**

OSC output can be transmitted from an Action Macro, or from a template. In addition, sequence texts and master levels are transmitted to remote devices - see Receive - OSC Input.

To transmit OSC commands you have to activate transmission of OSC and select a port (default 8000) and IP address(es) of the devices to send to in Play Settings - Show Control.

**Action Macro OSC**
See Cobalt Action Macros.

**Template OSC**
It is possible to define any parameter in a template to send optional OSC data. In the Template editor, there is now a new column called OSC. It will open a dialog where OSC parameters can be defined. Scaling through Max value is supported.

Press MODIFY or double-click on OSC
TRANSMIT COMMANDS

Direct Selects
Cobalt will send bank labels and direct select labels when they change:
/directselects/page/label/x
/directselects/label/x

Masters
/masters/fader/X <0.0-1.0> = transmission when a fader value changes
/masters/label/X <string> = Sends master label changes
/masters/page/label/X <string> = Sends master page label changes
Cobalt in Congo Jr/Kid Hardware (8.0)

Cobalt 8.0 will run in any Congo Jr and Congo Kid that has two network ports. If there is only one network port contact ETC Tech Support for an upgrade path. Cobalt 8.0 will not run in the larger old Congo hardwares - they support up to version 7.3.1.

Congo hardware is limited to 3072 channels and up to 12 universes of output, but may be used as a client/backup to a Cobalt system, up to the capacity of the console in question (Congo Kid is limited to 1024 channels spread over 12 universes).

The main difference in the hardware compared to Cobalt 20/10 are

- There are no fader ranges.
- There are no expanded masters modes.

These are the chapters about specific hardware issues - other functions are the same as described in the complete manual.

- Congo Jr/Kid - Facepanel
- Congo Jr/Kid - Main display
- Congo Jr/Kid - Direct Selects
- Congo Jr/Kid - Soft key pages
- Congo Jr/Kid - Mouseless navigation
- Congo Jr/Kid - Main playback
- Congo Jr/Kid - Master Display Keyboard
- Master fader mode switch
- Congo Jr/Kid - Fader wings
Congo Jr/Kid - Facepanel

NOTE
Cobalt Kid & Cobalt JR share the exact same layout of the Programming Section.

These two hardwares will allow you to run the Cobalt software under Win 7. If you are using screens without touch control you may wish to connect a mouse or trackball for full access to all features. There is a main display with keys and wheels that provides access to device parameters, Direct Selects and soft keys.

Congo Jr

Congo Kid
General Facts

- To the right of the numeric keypad there is a column with keys for selecting groups of channels, and to the right of that is a column with keys for setting levels in different ways.
- There are keys for setting times to the sequence in the Main Playback.
- There are keys for recording and updating the current preset.
- There are direct keys to open editors for play data (SEQ, PRESET, GROUP etc)
- The Navigation pad includes the round navigating keys, the arrow keys, the level wheel and ESC and MODIFY.
**Congo Facepanel - Congo Jr**

This is the facepanel. The Master Playbacks is an optional wing. The Master Playback functionality is integrated into the Main Playback.

**Monitors**
1x DVI-I (DVI or a DVI to VGA adapter)
1x DVI-D (DVI only)
1x DisplayPort
Can use any two.
Congo Facepanel - Congo Kid

The Congo Kid is similar to Congo Jr in facepanel layout and display functionality.

**Channels/outputs**
The Kid has a maximum control capacity of 256 channels/devices and 1024 outputs spread across 12 universes by direct output or Ethernet.

**Masters**
The Master Playback functionality is integrated into the Main Playback. The functions of the Master Switch are available in the soft key pages. See [Master Soft Key page for Jr & Kid](#)

**Monitors**
1x DVI-I (DVI or a DVI to VGa adapter)
1x DVI-D (DVI only)
1x DisplayPort
Can use any two.
Congo Jr/Kid - Main Display

This section has different programming functions.

- The Display has soft key menus with different sets of functions for the keys around it.
- The wheels can be used for parameters when a device is selected, there is a button in each key.
- The keys to the left activate Direct Selects.

Main display area
Congo Jr/Kid - Direct Selects

The Direct Selects tab provides extremely fast and hands on access to all kinds of data. In the Jr and Kid consoles there are ten Direct Select keys for quick access to content in the DS tab. You can also use a touch screen or mouse to access these functions directly from the Direct Selects tab. See Direct Selects tab.

- Press the Direct Select keys 1-4 to the left to connect **DS section 1-4** in the DS tab
- Hold the Direct Select key to select **type** of content for that section
- Hold **Bank** to select range for the content within each section

**NOTE**
You can exit Direct Select Mode by pressing the same Direct Select key again.

**Type of content (hold TYPE)**

![Type of content](image)

When TYPE is held the different types are displayed over each section. Press the key corresponding to the Type you want, without letting go of TYPE. Press More to get those that don't fit. You can hold the GROUP key and use the level wheel to change levels for this group directly.

**Bank (hold BANK)**

![Bank](image)

When BANK is held the different banks are displayed over each section. Press the key corresponding to the Bank you want, without letting go of BANK.

**NOTE**
A bank contains the content that has been stored to those numbers. For example Focus Palette 11 is in bank 11-20.
Content Types

These are the possible Types of content for the Direct Selects and the corresponding keys in the Congo Jr/Kid when they are activated for the display.

<table>
<thead>
<tr>
<th>Type</th>
<th>Function</th>
<th>Read More</th>
</tr>
</thead>
<tbody>
<tr>
<td>Focus</td>
<td>Activates a Focus Palette for the selected channel(s)*</td>
<td>Moving Device - Palettes</td>
</tr>
<tr>
<td>Color</td>
<td>Activates a Color Palette for the selected channel(s)*</td>
<td>Moving Device - Palettes</td>
</tr>
<tr>
<td>Beam</td>
<td>Activates a Beam Palette for the selected channel(s)*</td>
<td>Moving Device - Palettes</td>
</tr>
<tr>
<td>Pal</td>
<td>Activates an all Palette for the selected channel(s)*</td>
<td>Moving Device - Palettes</td>
</tr>
<tr>
<td>Gel</td>
<td>Select a Gel color for a moving device from the gel picker.</td>
<td>Device Views - Gel Picker</td>
</tr>
<tr>
<td>Group</td>
<td>Selects the channels in a Group***</td>
<td>Groups</td>
</tr>
<tr>
<td>Param</td>
<td>Ranges for a parameter (gobo wheel)</td>
<td>First select Param, then press the wheel key for a moving device parameter to connect that range to the Direct Select keys.</td>
</tr>
<tr>
<td>Auto Group</td>
<td>Auto Groups generated from the Channel Database**</td>
<td>Channel Database &amp; Auto Groups</td>
</tr>
<tr>
<td>Screen</td>
<td>Press to select the stored screens</td>
<td>Screens</td>
</tr>
<tr>
<td>Mast (jr/Kid)</td>
<td>Master keys (1-80)</td>
<td>The keys will correspond to master keys in a wing.</td>
</tr>
<tr>
<td>Masks</td>
<td>Masks</td>
<td>User Masks - Functions</td>
</tr>
<tr>
<td>Section</td>
<td>Sections</td>
<td>Sequences - Section Markers</td>
</tr>
</tbody>
</table>

* You can enter a time # before pressing a key to activate the change in this time.
** Auto Groups are sorted by Text Column from the Channel Database.
*** You can hold the GROUP key and use the level wheel to change levels for this group directly.

Direct Selects - Record & Update

The data in the Direct Selects is loaded as it is recorded, regardless of how it is recorded. It is also possible to record and update directly to the direct select keys, which is a very fast working method requiring few keystrokes.
These content types can be recorded and updated directly holding [RECORD] or [UPDATE] and pressing a [direct select key] for that content type.

- Focus
- Color
- Beam
- Pal (All Palette)
- Group
- Screen
Congo Jr/Kid - Soft Key Pages

The Soft Key pages provide direct access to the soft keys to the right of screen 2 in a Cobalt 10/20 or Nomad. The Soft Menu exit key (←) moves one step back up to the top menu level each time it is pressed.

These are the soft menu keys in the top menu

<table>
<thead>
<tr>
<th>Soft Key Menus</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Times</td>
<td>Shortcuts for setting times. See The Times Soft Key Page</td>
</tr>
<tr>
<td>Dynamics</td>
<td>Controls for running Dynamics. See Dynamics - Control</td>
</tr>
<tr>
<td>Channels</td>
<td>Channel functions. See Channels - Balance Mode See Channels - Group Wheel Mode See Presets - Compare Mode</td>
</tr>
<tr>
<td>Device</td>
<td>Device control and special functions. See Device Control - Flip See Device Palettes - Focusing Mode See Only &quot;Changed&quot; are recorded See Device Palettes - Update</td>
</tr>
<tr>
<td>Select</td>
<td>Select functions. See Channels - Select Functions</td>
</tr>
<tr>
<td>Misc</td>
<td>Miscellaneous functions. See Navigating - Misc Soft Key Page</td>
</tr>
</tbody>
</table>

Master Soft Key page for Congo Jr/Kid

Since Cobalt jr and Congo Kid support masters without dedicated paging controls, there is a Masters soft key page with master functions. The Masters soft key page is selected with the soft key MASTERS in the Main Display of the Cobalt jr and Congo Kid.
Display

Page keys (PAGE 1-20, PAGE 21-41, PAGE 41-60, PAGE 61-80)
These keys are the PAGE key for each master section. Master pages may be assigned to banks of masters even when no wings are attached to Cobalt jr. Congo Kid has physical faders for masters 1-20 and 21-40, and masters 41-60 and 61-80 may still be used with the Masters tab or dock and the keypad for selection and control.

- Enter a number and press a Page #‐# key to select a page for masters #‐#
- Hold a Page #‐# key and press PAGE‐ or PAGE+ to change page last/next
- Hold C and press a Page #‐# key to clear this section.
- Hold RECORD and press a Page #‐# to record to this section

Channels Only mode keys
These two keys are used to operate Channels Only mode for Cobalt jr when used with Universal Fader Wings and Congo Kid.

- CHAN. ONLY MODE: Toggles Channels Only mode on/off
- CHAN. RANGE: Steps through all possible channel ranges for the faders.
Congo Jr/Kid - Main Playback

In Congo Jr & Kid there is only one playback, which serves both the main playback and any of the Master playbacks.

The CONNECT key is used in combination with any Master key to control that playback. Once a master is connected, it is sufficient to press CONNECT.

The PLAYBACK key is used to set the controls to the main playback.

The main difference for the main playback compared to the large Cobalt console is that there is no split rate control for in/outgoing fades. Instead TAP is held together with the wheel to control rates. In Jr, this playback is used also as the Master Playback.

See Main Playback.
Congo Jr/Kid - Master Display Keyboard

In the Congo Jr/Kid there is a keyboard function layered in the main display of the console. You need to use the three keys to the left side of the display to select the desired line of letters to use with the top ten keys. Anytime text input is activated the display is converted into a qwerty keyboard. The soft keys correspond to the key in the display.

Hold the SHIFT key to get Capital letters.

<table>
<thead>
<tr>
<th>Function</th>
<th>Key</th>
<th>Feedback</th>
</tr>
</thead>
<tbody>
<tr>
<td>Special characters</td>
<td>[SHIFT] &amp; #</td>
<td>Hold keyboard SHIFT and press 1-9 to get special characters</td>
</tr>
<tr>
<td>DELETE</td>
<td>DELETE</td>
<td>Console key is part of keyboard functions.</td>
</tr>
<tr>
<td>INSERT</td>
<td>INSERT</td>
<td>Console key is part of keyboard functions.</td>
</tr>
<tr>
<td>BACKSPACE</td>
<td>[C/Alt]</td>
<td>Console key is part of keyboard functions.</td>
</tr>
<tr>
<td>Numbers</td>
<td>Numerical keypad</td>
<td>Console keys are part of keyboard functions.</td>
</tr>
</tbody>
</table>

See Accessories - Ext. Keyboard
Master Fader Mode Switch (Master Playback Wing)

The Switch with three positions sets the 80 Master playbacks into one of three modes.

<table>
<thead>
<tr>
<th>Position</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channels Only</td>
<td>Masters 1-80 will control the first 80 intensities in the system. Select range of channels with the Direct Selects.</td>
</tr>
<tr>
<td>Masters</td>
<td>The normal position. Masters 1-80 are Masters 1-80.</td>
</tr>
<tr>
<td>Jam</td>
<td>Two Scene Fader mode for busking shows with different functions. See Fader Mode - Two Scene Masters.</td>
</tr>
</tbody>
</table>
Congo Jr/Kid - Fader Wings

A Cobalt system supports up to 80 Master Playbacks. These can be accessed physically by connecting fader wings. In Congo Kid you can access all 80 numerically but you cannot connect a wing for physical control of the last 40.

There are two kinds of fader wings.

- Cobalt Master Wing
- Universal fader wings (additional faders for any Cobalt system)

Any combination wings may be attached to a system, for a total of up to 80 master playback faders. An external power supply, provided, is required when used stand-alone.

See Facepanel - Congo Jr.

Master Playback Wing

The Cobalt Master Playback Wing provides physical access to 40 Cobalt Master Playbacks, including the LCD displays for labelling and all master, flash and paging keys. Additionally, the Wing can be switched into Direct Select Mode, providing access to the 40 direct selects. It also features the Channels-Only/Masters/Jam switch, giving the Congo Jr all the flexibility of the Cobalt console in a significantly smaller footprint.

The Master Playback Wing is a modular accessory for the Cobalt jr lighting control console. It may be connected physically to either side of the Cobalt jr, or it may be used as a stand-alone wing connected to the console with a provided USB cable. An external power supply, provided, is required when used stand-alone.

The functionality is the same as in the large Cobalt - since there are only two graphical displays, you have to switch between Direct Selects mode and Masters mode. This is done with the DIRECT SELECT key to the right.
1. Direct Select pages
2. Displays
3. BANK and TYPE keys for operating the Direct Selects are incorporated between the displays with the PAGE keys.
4. Function keys - same as in Cobalt plus Direct Select Mode.
Universal Fader Wings

Besides the Cobalt Master Wing, there are three Universal fader wings. They can be connected with a USB cable, and with Congo Jr they can be mounted on the sides or top of the console. An external power supply, provided, is required when used stand-alone.
EXAMPLES

This is a collection of examples that you can follow step by step with this help tab open.

- Build a chase effect
- Patch by output
- Patch by channel
- Record in the Main Sequence
- Clear and Reset Patch
- Using a Beat Boss for a Chase Effect
- Select all running effects
Example: Build a chase effect

This is an example of the workflow for building a simple chase effect from the current channel selection, and creating an effect playback to run it from.

1. Select the Live tab by pressing LIVE
2. Select channels 1-10 (no levels)
   1 CH 10 THRU
3. Create Effect Playback with these channels
   Hold INSERT and press EFFECT
4. Check box "Create Chase from selected channels"
   (Use arrow keys and MODIFY or click screen)
5. Confirm with EXECUTE.
6. Bring level of effect up with the level wheel

The chase effect should now be running in Live. All channels will be at full. You can adjust these levels in the Chase Effect Editor. You can change the timing with the Rate/tap parameter in the Device Controls Tab or with parameter wheel 2. Read more in the chapter Chase Effect Parameters. You can set up a Beat Boss, see Using a Beat Boss for a chase effect.

Quit Example
Example: Patch by Output

This is an example of the workflow for patching by output.

1. Select the Output tab by pressing OUTPUT
2. Select output 1
   1 OUTPUT
3. Patch this output to channel 5
   5 MODIFY
4. You will get a dialog asking if you patch channel 5 to output 1. You will have the option of checking a box to replace the currently patched channel.
5. Confirm with OK

You can continue to do this for any other output, and read more about it in Patch Introduction. To clear the Patch press WIZARD to open the Patch Wizard.

Quit Example
Example: Patch by Channel

This is an example of the workflow for patching by channel. This requires you to be in RPN (default) channel command syntax.

1. Select the Output tab by pressing OUTPUT
2. Select channel 5
   5 CHANNEL
3. Patch this output to output 1
   1 MODIFY
4. You will get a dialog asking if you patch output 1 to channel 5. You will have the option of checking a box to replace the currently patched output(s).
5. Confirm with OK

You can continue to do this for any other channel, and read more about it in Patch Introduction. To clear the Patch press WIZARD to open the Patch Wizard.

Quit Example
Example: Record in the Main Sequence

This is an example of the workflow for recording a new look in the sequence of the Main Playback.

1. Select the Live tab by pressing LIVE
2. Select channels 1-10 (no levels)
   1 CH 10 THRU
3. Set a level with the level wheel
4. Press RECORD

   This will give you the Record dialogue. The next free preset # will have been chosen automatically for you. You can write a text label.

5. Confirm with RECORD

Depending on how your system is set up the lights on stage will be recorded in a preset or cue in the sequence of the Main Playback.

Press GO BACK to fade to the previous look.
Press GO to fade back into the look you recorded.

Quit Example
Example: Clear and Reset Patch

Clear and Reset Patch is done from the Patch Wizard.

1. Select the Output tab by pressing OUTPUT
2. Open the Patch Wizard by pressing WIZARD
3. Select the Set/Clear tab with arrow keys or touch.
4. Choose action in the Operation dropdown
5. Check "Apply to all" if you want to affect the whole patch
6. Confirm with EXECUTE
7. Confirm the dialogue with OK
8. Press ESC to exit the dialogue

You can read more in Patch Introduction.
**Example: Using a Beat Boss for a chase effect**

This is an example of the workflow for using a Beat Boss for a simple chase effect. Start by building a simple chase effect from the current channel selection. See [Build a chase effect](#).

1. If you have just built a chase effect in the example link above, it is selected, otherwise select it.

2. In the Device Controls tab, click on Beat Boss and select Beat Boss 1.

3. Start the effect by bringing the level to full.

The chase effect should now be running in live.

You have the options of changing the Rate/Tap for this chase, or changing the Beat Boss that will scale through the local Rate/Tap.

You can control the Beat Boss from the Beat Boss Tab (See [Tab - Beat Boss](#)) or by setting up a master to control the Beat Boss (See [Masters - Beat Boss](#)).

With a single chase effect there is no great advantage to this, but if you have several chase effects and you wish them to follow a central rate the Beat Boss will allow you to control them at once.

[Quit Example](#)
Example: Select all running effects

It is easy to select all currently running effects.

1. Select the Live tab by pressing LIVE
2. Select all running effects
   Hold ALL and press EFFECT

You will now have selected all currently running effects and can regulate the intensity with the level wheel, or adjust any of the effect parameters in the Device Control tab.

Quit Example
## INDEX

16 Bit Control - Fine Step, 308
8 bit 256 Step Levels, 468
8/16 bit control, 306
About, 137
ACCESSORIES, 967
Action Macro, 263
Action Macros, 254
Active Mode & Attribute Tracking, 621
Active Mode & Mark, 621
Align, 595
Align & Distribute Objects, 555
All Attributes, 623
All Palette, 633
Animation effects, 759
Array, 555
At Mode, 463
Attribute Editor Times, 654
Attributes Follow Faders, 660
Auto Groups, 540
Auto-create Content Wizard, 450
AutoMark, 661
Auto-Save, 363
B.O. Mode, 126
Backup, 233
Balance Mode, 476
Beam Palette, 632
Beat Boss, 100, 861
Blind, 506
BPM, 415
Break mode, 714
Browser, 76
Bugs, 66
Build & Modify Modes, 405
Build mode, 713
Capture Mode, 469
Ch Only Mode, 467
Changed mode, 619
Channel Check Mode, 273
Channel Database, 537
Channel Editor Wizard, 360
Channel List, 288
Channel Partitions, 573
<table>
<thead>
<tr>
<th>Channel Sets, 772</th>
<th>Color Palette, 631</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel Symbols, 502</td>
<td>ColorMixer, 90</td>
</tr>
<tr>
<td>Channel Time Editor, 390</td>
<td>Command Syntaxes, 463</td>
</tr>
<tr>
<td>Channel Times, 389</td>
<td>Compare Mode, 365</td>
</tr>
<tr>
<td>Channel View Zoom, 497</td>
<td>Compound Devices, 584</td>
</tr>
<tr>
<td>Channel viewing formats, 496</td>
<td>Congo Jr/Kid, 1047</td>
</tr>
<tr>
<td>Channels, 452</td>
<td>Connectors, 1011</td>
</tr>
<tr>
<td>Channels - Clear Functions, 473</td>
<td>Console Facepanel, 72</td>
</tr>
<tr>
<td>Channels - Soft key page, 485</td>
<td><strong>Console Key Names, 1042</strong></td>
</tr>
<tr>
<td>Channels - Used &amp; Unused, 481</td>
<td>Console Key Quick Help, 890</td>
</tr>
<tr>
<td>Channels - Views, 455</td>
<td>Console Key Shortcuts, 938</td>
</tr>
<tr>
<td>Chase - Wizard, 416</td>
<td>CONSOLE KEYS, 889</td>
</tr>
<tr>
<td>Chase Beat Boss, 702</td>
<td>Console Keys in a Keyboard, 969</td>
</tr>
<tr>
<td>Chase Effects, 699</td>
<td>Console Mimic, 83</td>
</tr>
<tr>
<td>Chase Mode, 410</td>
<td>Content Effect Beat Boss, 715</td>
</tr>
<tr>
<td>Chase mode sequences, 835</td>
<td>Content Effect Return To, 716</td>
</tr>
<tr>
<td>Chase Tap Tempo, 702</td>
<td>Content Effect Times, 723</td>
</tr>
<tr>
<td>Check Mode, 475</td>
<td>Content Effects, 709</td>
</tr>
<tr>
<td>Clear Dynamics Soft Keys, 738</td>
<td>Context Menus, 119</td>
</tr>
<tr>
<td>Clear patch, 279</td>
<td>Continuous mode, 713</td>
</tr>
<tr>
<td>Clone Device, 280</td>
<td>Control Hierarchy, 54</td>
</tr>
<tr>
<td>Cobalt ETCnomad, 1003</td>
<td>Copy Log files to USB, 176</td>
</tr>
<tr>
<td>Cobalt LS, 1009</td>
<td>Copy, Cut &amp; Paste, 127</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Crashes, 66</td>
<td></td>
</tr>
<tr>
<td>Crossfade, 385</td>
<td></td>
</tr>
<tr>
<td>Crossfade Profiles, 397</td>
<td></td>
</tr>
<tr>
<td>Crossfaders And Attributes, 660</td>
<td></td>
</tr>
<tr>
<td>cRRFU Radio Remote, 995</td>
<td></td>
</tr>
<tr>
<td>Cue Only, 626</td>
<td></td>
</tr>
<tr>
<td>Cues, 430</td>
<td></td>
</tr>
<tr>
<td>Data, 616</td>
<td></td>
</tr>
<tr>
<td>Default Play, 165</td>
<td></td>
</tr>
<tr>
<td>Delete Wizard, 448</td>
<td></td>
</tr>
<tr>
<td>Designer Summary, 84</td>
<td></td>
</tr>
<tr>
<td>Desk Light, 1014</td>
<td></td>
</tr>
<tr>
<td>Device Control, 587</td>
<td></td>
</tr>
<tr>
<td>Device Control Tab, 601</td>
<td></td>
</tr>
<tr>
<td>Device Controls, 89</td>
<td></td>
</tr>
<tr>
<td>Device List, 283</td>
<td></td>
</tr>
<tr>
<td>Device Mode, 603</td>
<td></td>
</tr>
<tr>
<td>Device Palettes, 627</td>
<td></td>
</tr>
<tr>
<td>Device Palettes - Renumber, 646</td>
<td></td>
</tr>
<tr>
<td>Device Times, 647</td>
<td></td>
</tr>
<tr>
<td>Device Views, 607</td>
<td></td>
</tr>
<tr>
<td>Devices, 579</td>
<td></td>
</tr>
<tr>
<td>Dialogues, 121</td>
<td></td>
</tr>
<tr>
<td>Dimmer Check Mode, 273</td>
<td></td>
</tr>
<tr>
<td>Dimmer Curve, 319</td>
<td></td>
</tr>
<tr>
<td>Dimmer/Device Feedback, 141</td>
<td></td>
</tr>
<tr>
<td>Direct Mode MIDI, 220</td>
<td></td>
</tr>
<tr>
<td>Direct Selects, 93</td>
<td></td>
</tr>
<tr>
<td>Disable Flash Keys, 803</td>
<td></td>
</tr>
<tr>
<td>Disclaimer, 44</td>
<td></td>
</tr>
<tr>
<td>Displays Lighting, 226</td>
<td></td>
</tr>
<tr>
<td>DMX Input, 189</td>
<td></td>
</tr>
<tr>
<td>DMX Settings, 228</td>
<td></td>
</tr>
<tr>
<td>DMX512, 1011</td>
<td></td>
</tr>
<tr>
<td>Drag and Drop, 113</td>
<td></td>
</tr>
<tr>
<td>Dual Fader mode, 832</td>
<td></td>
</tr>
<tr>
<td>DVI/sVGA Monitor, 1011</td>
<td></td>
</tr>
<tr>
<td>Dynamic Effect, 724</td>
<td></td>
</tr>
<tr>
<td>Dynamics - Size &amp; Rate, 746</td>
<td></td>
</tr>
<tr>
<td>Editing In Blind, 509</td>
<td></td>
</tr>
<tr>
<td>Editing in Live, 500</td>
<td></td>
</tr>
<tr>
<td>Effect Images, 766</td>
<td></td>
</tr>
<tr>
<td>Effect layouts, 760</td>
<td></td>
</tr>
<tr>
<td>Effect Overview, 698</td>
<td></td>
</tr>
<tr>
<td>Effect Playbacks, 696</td>
<td></td>
</tr>
<tr>
<td>Effect Texts, 770</td>
<td></td>
</tr>
<tr>
<td>Effects, 679</td>
<td>Find Highest Level, 492</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>-------------------------</td>
</tr>
<tr>
<td>Effects - Soft Key Page, 690</td>
<td>Flash On Time, 810</td>
</tr>
<tr>
<td>ETCnomad Puck, 1004</td>
<td>Flash settings, 802</td>
</tr>
<tr>
<td>Ethernet, 1013</td>
<td>Flip, 600</td>
</tr>
<tr>
<td>Event List, 252</td>
<td>Focus Palette, 630</td>
</tr>
<tr>
<td>Events, 259</td>
<td>Focusing Mode, 644</td>
</tr>
<tr>
<td>EXAMPLES, 1064</td>
<td>Freeze Mode, 126</td>
</tr>
<tr>
<td>Excel, 542</td>
<td>Gel Picker, 665</td>
</tr>
<tr>
<td>Exclude Int From Record, 798</td>
<td>GelPicker, 90</td>
</tr>
<tr>
<td>Exclusive, 797</td>
<td>GENERAL FUNCTIONS, 71</td>
</tr>
<tr>
<td>Expanded Effects, 857</td>
<td>General Info, 46</td>
</tr>
<tr>
<td>Expanded Masters, 855</td>
<td>General Record Target, 349</td>
</tr>
<tr>
<td>Expanded Sequences, 859</td>
<td>General Settings, 203</td>
</tr>
<tr>
<td>External Trig 1-9, 1013</td>
<td>GETTING STARTED, 45</td>
</tr>
<tr>
<td>Fade Curves, 442</td>
<td>Goto List, 790</td>
</tr>
<tr>
<td>Fade With Intensity, 315</td>
<td>Grand Master, 125</td>
</tr>
<tr>
<td>Fader Modes, 850</td>
<td>Group Wheel Mode, 482</td>
</tr>
<tr>
<td>Fader Wings, 1061</td>
<td>Groups, 329</td>
</tr>
<tr>
<td>Fan, 596</td>
<td>Groups - Fetch Intensities, 335</td>
</tr>
<tr>
<td>Fan Times, 657</td>
<td>Groups/Palettes Overview, 439</td>
</tr>
<tr>
<td>FCB Times, 395</td>
<td>GrpDistri, 713</td>
</tr>
<tr>
<td>Fetch/Copy, 598</td>
<td>GrpParts, 713</td>
</tr>
<tr>
<td>Files, 143</td>
<td>Help Companion, 38</td>
</tr>
<tr>
<td>Master fader settings, 800</td>
<td>News In This Version, 39</td>
</tr>
<tr>
<td>--------------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>Master List, 865</td>
<td>Next &amp; Last Mode, 487</td>
</tr>
<tr>
<td>Master Mode, 797</td>
<td>Notes Editor, 445</td>
</tr>
<tr>
<td>Master Pages, 869</td>
<td>Numerical Input on a Notebook, 968</td>
</tr>
<tr>
<td>Master Playback Wing, 1061</td>
<td></td>
</tr>
<tr>
<td>Master View, 87, 862</td>
<td>Object Libraries, 561</td>
</tr>
<tr>
<td>Masters, 791</td>
<td>Object Target, 552</td>
</tr>
<tr>
<td>Masters - Times, 809</td>
<td>Open, 151</td>
</tr>
<tr>
<td>Merge Or Replace, 636</td>
<td>Organizer, 323</td>
</tr>
<tr>
<td>MIDI, 218, 1015</td>
<td>OSC Functionality, 1037</td>
</tr>
<tr>
<td>MIDI - Implementation Chart, 1024</td>
<td>OSC Output, 1045</td>
</tr>
<tr>
<td>MIDI Show Control, 1018</td>
<td>Output Control, 125</td>
</tr>
<tr>
<td>Misc Soft Key Page, 133</td>
<td>Output Editor, 267</td>
</tr>
<tr>
<td>Monitor, 190</td>
<td>Output List, 293</td>
</tr>
<tr>
<td>Mouse, 973</td>
<td>Parameter Definitions, 317</td>
</tr>
<tr>
<td>Movefade, 385</td>
<td>Parked, 295, 528</td>
</tr>
<tr>
<td>Multiconsole Sessions, 235</td>
<td>Parking values, 530</td>
</tr>
<tr>
<td>Mute, 129</td>
<td>Partitions, 574</td>
</tr>
<tr>
<td>Net3 Remote Video Interface, 1007</td>
<td>Patch by Channel/Dimmer, 266</td>
</tr>
<tr>
<td>Net3/ACN Device List, 240</td>
<td>Patch Device, 278</td>
</tr>
<tr>
<td>Network, 181, 229</td>
<td>Patch Wizard, 277</td>
</tr>
<tr>
<td>Network nodes, 239</td>
<td>Patching, 264</td>
</tr>
<tr>
<td>New, 146</td>
<td>Phone Remote, 982</td>
</tr>
<tr>
<td>Cobalt 8.1 - 20181029</td>
<td></td>
</tr>
<tr>
<td>----------------------</td>
<td></td>
</tr>
<tr>
<td>Playback View, 785</td>
<td></td>
</tr>
<tr>
<td>Playlist, 436</td>
<td></td>
</tr>
<tr>
<td>Power Off, 202</td>
<td></td>
</tr>
<tr>
<td>Power-up, 122</td>
<td></td>
</tr>
<tr>
<td>Presets, 339</td>
<td></td>
</tr>
<tr>
<td>Presets - Fetch Intensities, 359</td>
<td></td>
</tr>
<tr>
<td>Presets - Import &amp; Undo, 369</td>
<td></td>
</tr>
<tr>
<td>Presets - Renumber, 367</td>
<td></td>
</tr>
<tr>
<td>Presets - Times, 364</td>
<td></td>
</tr>
<tr>
<td>Print, 166</td>
<td></td>
</tr>
<tr>
<td>Programming Wings, 1005</td>
<td></td>
</tr>
<tr>
<td>Quick-load Presets to Masters, 356</td>
<td></td>
</tr>
<tr>
<td>Range, 849</td>
<td></td>
</tr>
<tr>
<td>Ranges, 310</td>
<td></td>
</tr>
<tr>
<td>Rate, 414</td>
<td></td>
</tr>
<tr>
<td>RDM Functionality, 1030</td>
<td></td>
</tr>
<tr>
<td>Record a preset to a master, 815</td>
<td></td>
</tr>
<tr>
<td>Record Directly To A Master, 348</td>
<td></td>
</tr>
<tr>
<td>Recording Popup, 342</td>
<td></td>
</tr>
<tr>
<td>Refresh Functions, 784</td>
<td></td>
</tr>
<tr>
<td>Releasing Captured Channels, 472</td>
<td></td>
</tr>
<tr>
<td>Rem Dim, 484</td>
<td></td>
</tr>
<tr>
<td>Remote Control, 974</td>
<td></td>
</tr>
<tr>
<td>Remote Controls, 886</td>
<td></td>
</tr>
<tr>
<td>Rename Channels, 291</td>
<td></td>
</tr>
<tr>
<td>Re-record A Palette, 636</td>
<td></td>
</tr>
<tr>
<td>Reset, 69</td>
<td></td>
</tr>
<tr>
<td>RFR Radio Remote, 976</td>
<td></td>
</tr>
<tr>
<td>RPN, 463</td>
<td></td>
</tr>
<tr>
<td>Save &amp; Save as..., 152</td>
<td></td>
</tr>
<tr>
<td>Save Copy to..., 155</td>
<td></td>
</tr>
<tr>
<td>Scale channel levels, 478</td>
<td></td>
</tr>
<tr>
<td>Screens, 74, 241</td>
<td></td>
</tr>
<tr>
<td>Scroller Fan override, 678</td>
<td></td>
</tr>
<tr>
<td>Scroller Rolls, 674</td>
<td></td>
</tr>
<tr>
<td>Section Markers, 426</td>
<td></td>
</tr>
<tr>
<td>Select Active Channels, 642</td>
<td></td>
</tr>
<tr>
<td>Select Changed, 602</td>
<td></td>
</tr>
<tr>
<td>Select Stored Channels, 643</td>
<td></td>
</tr>
<tr>
<td>Selected Live, 86</td>
<td></td>
</tr>
<tr>
<td>Sequence and Preset texts, 384</td>
<td></td>
</tr>
<tr>
<td>Sequence Times - Set To A or B, 387</td>
<td></td>
</tr>
<tr>
<td>Sequences, 373</td>
<td></td>
</tr>
<tr>
<td>Sequences - Block Values, 407</td>
<td></td>
</tr>
<tr>
<td>Sequences - Delete Step, 400</td>
<td></td>
</tr>
<tr>
<td>Sequences - Insert Step, 398</td>
<td></td>
</tr>
</tbody>
</table>
Sequences - Times, 387
Serial COM data, 256
Series, 717
Server, 233
Sessions, 180
Setup Guide, 48
Show Control, 222
Snap or Fade, 309
Soft Key Pages, 75
Software & Update, 56
Solo, 129
Sound Settings, 227
Split Fade, 419
Standard MIDI, 1017
Swap upper/lower, 848
System Settings, 177
Tab Setup and Lock, 82
Tabs, 79
Tap Tempo, 415
Technical Services, 70
Templates, 297
Terminology, 43
TEXT, 128
Time Code, 88, 1021
Times (in/out/delay/wait), 388
Times Soft Key Page, 394
Track Editing, 525
Track List, 409, 511
Track To Wizard, 518
Trackball, 973
Training Projects, 168
Triggers for Events, 260
Troubleshooting, 63, 70
Two Scene Masters, 852
U1-U2-U3, 593
UDP data, 257
 Unblock Attributes, 527
Universal Fader Wings, 1063
Un-parking Values, 533
Update, 192, 351
USB RFR, 194
Used In Play, 460
User Library, 276
User List, 249
User Templates, 316
Utilities, 195
Visualizer, 998
WAF Alert Times, 395
Welcome Screen, 200

Workflow, 57
X-keys, 1008